User Guide,
iControl for AC Elevators

August 2008 Release
Copyright
© 2014, Motion Control Engineering. All Rights Reserved.
This document may not be reproduced, electronically or mechanically, in whole or in part, without written permission from Motion Control Engineering.

Trademarks
All trademarks or registered product names appearing in this document are the exclusive property of the respective owners.

Warning and Disclaimer
Although every effort has been made to make this document as complete and accurate as possible, Motion Control Engineering and the document authors, publishers, distributors, and representatives have neither liability nor responsibility for any loss or damage arising from information contained in this document or from informational errors or omissions. Information contained in this document shall not be deemed to constitute a commitment to provide service, equipment, or software by Motion Control Engineering or the document authors, publishers, distributors, or representatives.

Limited Warranty
Motion Control Engineering (manufacturer) warrants its products for a period of 15 months from the date of shipment from its factory to be free from defects in workmanship and materials. Any defect appearing more than 15 months from the date of shipment from the factory shall be deemed to be due to ordinary wear and tear. Manufacturer, however, assumes no risk or liability for results of the use of the products purchased from it, including, but without limiting the generality of the forgoing: (1) The use in combination with any electrical or electronic components, circuits, systems, assemblies or any other material or equipment (2) Unsuitability of this product for use in any circuit, assembly or environment. Purchasers’ rights under this warranty shall consist solely of requiring the manufacturer to repair, or in manufacturer's sole discretion, replace free of charge, F.O.B. factory, any defective items received at said factory within the said 15 months and determined by manufacturer to be defective. The giving of or failure to give any advice or recommendation by manufacturer shall not constitute any warranty by or impose any liability upon the manufacturer. This warranty constitutes the sole and exclusive remedy of the purchaser and the exclusive liability of the manufacturer, AND IN LIEU OF ANY AND ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR STATUTORY AS TO MERCHANTABILITY, FITNESS, FOR PURPOSE SOLD, DESCRIPTION, QUALITY PRODUCTIVENESS OR ANY OTHER MATTER. In no event will the manufacturer be liable for special or consequential damages or for delay in performance of this warranty.

Products that are not manufactured by MCE (such as drives, CRTs, modems, printers, etc.) are not covered under the above warranty terms. MCE, however, extends the same warranty terms that the original manufacturer of such equipment provide with their product (refer to the warranty terms for such products in their respective manual).
End User License Agreement
This End User License Agreement ("Agreement") grants you the right to use the software contained in this product (the "Software") subject to the following restrictions: You may not: (i) copy the Software, except for archive purposes consistent with your standard archive procedures; (ii) transfer the Software to a third party apart from the entire product; (iii) modify, decompile, disassemble, reverse engineer or otherwise attempt to derive the source code of the Software; (iv) export the Software or underlying technology in contravention of applicable U.S. and foreign export laws and regulations; and (v) use the Software other than in connection with operation of the product.

"LICENSOR'S SUPPLIERS DO NOT MAKE OR PASS ON TO END USER OR ANY OTHER THIRD PARTY, ANY EXPRESS, IMPLIED OR STATUTORY WARRANTY OR REPRESENTATION ON BEHALF OF SUCH SUPPLIERS, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, TITLE, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE."

Important Precautions and Useful Information
This preface contains information that will help you understand and safely maintain MCE equipment. We strongly recommend you review this preface and read this manual before installing, adjusting, or maintaining Motion Control Engineering equipment. This preface discusses:

- Safety and Other Symbol Meanings
- Safety Precautions
- Environmental Considerations

Safety and Other Symbol Meanings

Danger
This manual symbol is used to alert you to procedures, instructions, or situations which, if not done properly, might result in personal injury or substantial equipment damage.

Caution
This manual symbol is used to alert you to procedures, instructions, or situations which, if not done properly, might result in equipment damage.

Note
This manual symbol is used to alert you to instructions or other immediately helpful information.
Safety Precautions

Danger

This equipment is designed to comply with ASME A17.1, National Electrical Code, CE, and CAN/CSA-B44.1/ASME-A17.5 and must be installed by a qualified contractor. It is the responsibility of the contractor to make sure that the final installation complies with all local codes and is installed in a safe manner.

This equipment is suitable for use on a circuit capable of delivering not more than 10,000 rms symmetrical amperes, 600 volts maximum. The three-phase AC power supply to the Drive Isolation Transformer used with this equipment must originate from a fused disconnect switch or circuit breaker sized in conformance to all applicable national, state, and local electrical codes in order to provide the necessary motor branch circuit protection for the Drive Unit and motor. Incorrect motor branch circuit protection will void the warranty and may create a hazardous condition.

Proper grounding is vitally important to safe and successful operation. Bring your ground wire to the system subplate. You must choose the proper conductor size and minimize the resistance to ground by using the shortest possible routing. See National Electrical Code Article 250 or the applicable local electrical code.

Before applying power to the controller, physically check all the power resistors and other components located in the resistor cabinet and inside the controller. Components loosened during shipment may cause damage.

For proper operation of the AC Drive Unit in your controller, you must make sure that: 1) A direct solid ground is provided in the machine room to properly ground the controller and motor. Indirect grounds such as the building structure or a water pipe may not provide proper grounding and could act as an antenna to radiate RFI noise, thus disturbing sensitive equipment in the building. Improper grounding may also render any RFI filter ineffective. 2) The incoming power to the controller and the outgoing power wires to the motor are in their respective, separate, grounded conduits.

This equipment may contain voltages as high as 1000 volts. Use extreme caution. Do not touch any components, resistors, circuit boards, power devices, or electrical connections without ensuring that high voltage is not present.

Environmental Considerations

- Keep the machine room clean.
- Controllers are generally in NEMA 1 enclosures.
- Do not install the controller in a dusty area.
- Do not install the controller in a carpeted area.
- Keep room temperature between 32 and 104 degrees F (0 to 40 degrees C).
- Prevent condensation on the equipment.
- Do not install the controller in a hazardous location or where excessive amounts of vapors or chemical fumes may be present.
- Make certain that power line fluctuations are within plus or minus 10% of proper value.
Air Conditioned Equipment Cabinets

If your control or group enclosure is equipped with an air conditioning unit, it is very important to observe the following precautions. (Failure to do so can result in moisture damage to electrical components.)

- Maintain the integrity of the cabinet by using sealed knockouts and sealing any holes made during installation.
- Do not run the air conditioning while the cabinet doors are open.
- If you turn the air conditioner off while it is running, wait at least five minutes before restarting it. Otherwise, the compressor may be damaged.
- Observe the recommended thermostat setting (75 degrees) and follow recommended maintenance schedules.
- Make certain that the air conditioning drain tube remains clear to avoid water accumulation in the unit.
Contents

Section Intro. Introduction

iControl - August 2008 Release ........................................ Intro-1
In This User Guide: ................................................ Intro-2
What’s New ...................................................... Intro-3
Using iView On-line Help ........................................ Intro-6
Using the Installation Checklist ................................. Intro-7
  Installation Checklist (page 1 of 3) ................................ Intro-7
  Installation Checklist (page 2 of 3) ................................ Intro-8
  Installation Checklist (page 3 of 3) ................................ Intro-9

Section 1. iControl Description

About iControl ...................................................... 1-1
iControl Features ................................................. 1-3
iControl Function ................................................ 1-4
iControl ........................................................... 1-5
  Easy Installation ............................................... 1-6
  iBox ................................................................. 1-7
    LCD Display and Keypad .................................. 1-8
    iBox Inputs and Outputs ................................ 1-9
    AC Flux Vector Drives .................................. 1-10
iView Programming and Diagnostic Software .................. 1-11
  Controller Screen ........................................... 1-11
  Parameter Entry Screens .................................. 1-13
    Active Displays .......................................... 1-14
System Interconnect ............................................... 1-15
iLand Landing System ........................................... 1-17
iLink Car Top Communication .................................. 1-18
iCue Intelligent Dispatching ................................... 1-19
  Local/Dispatcher ........................................... 1-20
iMonitor Central Monitoring ................................... 1-21
iReport Logging and Report Generating ......................... 1-22
Optional Load Weighing System .................................. 1-23
Section 2. Construction Mode

In This Section ................................................................. 2-1
Before You Begin ............................................................. 2-2
Overview of Construction Mode ......................................... 2-2

Machine Room Preparation ............................................... 2-4
Equipment Location ....................................................... 2-4
Environmental Considerations .......................................... 2-4
Ethernet and Internet Considerations ................................. 2-5

Recommended Tools and Test Equipment ........................... 2-6

About MCE Job Prints ...................................................... 2-7
Symbols ........................................................................ 2-8
Nomenclature ................................................................ 2-8

Controller Cabinet Installation ......................................... 2-9
Overview of Typical Connection Locations .......................... 2-11
Peripheral Inputs and Outputs .......................................... 2-12

Equipment Grounding ...................................................... 2-14

Check for Shorts to Ground ............................................... 2-16

AC Voltage Verification and Wiring ................................... 2-17
Verifying Main Line Power and Wiring the Controller .......... 2-18
Initial Controller Power Up ............................................... 2-19

AC Hoist Motor, Brake, and Velocity Encoder ........................ 2-21
Checking the Hoist Motor ............................................... 2-21
Wiring the Hoist Motor to the Controller ............................. 2-21
Verifying Brake Current Resistance .................................... 2-22
Wiring the Brake ............................................................. 2-23
Velocity Encoder Installation and Wiring ............................. 2-24
Encoder Mounting ............................................................ 2-24
Encoder Isolation .............................................................. 2-25
Encoder Wiring ................................................................. 2-25

Basic Safety String and Associated Wiring .......................... 2-27
Cartop Safety Switches ................................................... 2-27
Hoistway Safety Switches ............................................... 2-28
Temporary CTS Relay Bypass ........................................... 2-28
Access Locks and Contacts ............................................. 2-28
Rope Gripper Wiring ....................................................... 2-29
Temporary Rope Gripper Bypass ...................................... 2-29
Temporary Cartop Inspection Wiring ................................. 2-29

Applying Power .............................................................. 2-29

Setting Initial Operating Parameters ................................. 2-30
Connecting the iTView PC ............................................... 2-30
Direct Connections ......................................................... 2-35
Verifying Initial Parameter Settings .................................... 2-43
Learning the Safety Configuration .................................... 2-46
AC Drive Parameters ...................................................... 2-47
Drive Keypad ................................................................. 2-47
Section 3. Inspection Mode

In This Section ........................................... 3-1

iLand Landing System .................................... 3-2
  Position Feedback ...................................... 3-2
  Direction ............................................... 3-2
  Position ............................................... 3-2
  Landing Accuracy .................................... 3-2
  Logic .................................................. 3-2
  Cartop Mounting ..................................... 3-3
    Positioning ......................................... 3-3
    Pedestal Fabrication and Mounting ............... 3-4

Installing iLand .......................................... 3-5
  Floor Leveling Magnets ............................... 3-9
  Installing the Floor Leveling Magnets ............ 3-10
  Cabling Connections .................................. 3-11
  iLand Status LEDs .................................. 3-12
  Setting the Position Encoder Resolution parameter .......................... 3-12
  Calibrating the Floor Offsets ....................... 3-12

Installing iLink .......................................... 3-13
  Installing the iLink Enclosure ...................... 3-14
  iLink Wiring .......................................... 3-15
    Front and Rear Door and Leveling Signals ....... 3-16
    Leveling Signals ................................... 3-16
    Cartop Inspection Switches ....................... 3-17
    Cartop Safety ..................................... 3-17
    Landing System Pulse Streams to iControl ...... 3-17
    iLink to iControl Serial Connection .......... 3-17
    iLink Power Connections ......................... 3-18
    Car Operating Panel Connections ............... 3-18
    iLink Cartop Wiring Verification ............... 3-19

Drive Offsets Calibration ................................ 2-48
  Automated Drive Setup Procedure .................. 2-48
  Manual Drive Setup Procedure ................... 2-49

Brake Calibration ........................................ 2-50
  Rollback Compensation ................................ 2-50
  Calibration .......................................... 2-51
  Verify Brake Picking ................................ 2-53

Running on Machine Room Inspection ................ 2-54
  Verifying Car Direction and Motor Control (TORQMAX) .................... 2-54
  Calibrating Actual Car Speed ................................ 2-55
  Auto-tuning for Induction Motors .......................... 2-56
  Verify Pattern Command and Drive Speed Feedback ...................... 2-57
  Following Error Margin ................................ 2-58
    Tach Error Tripping Threshold Adjustment ............. 2-59
  Electronic Motor Overload Protection Verification ................. 2-60
  Additional Adjustments and Checks .................. 2-61
Section 4. Final Adjustment

In This Section ................................................. 4-1

Learning the Floor Heights .................................. 4-2
Floor Height Learn Procedure .............................. 4-2

Verifying One Floor Run Operation ....................... 4-3
Verifying Correction, Run, and Stop ..................... 4-3
If the Car Does Not Stop and Correct Properly .......... 4-4
Initiating a One Floor Run ................................. 4-4
If Initiation is not Successful .............................. 4-4
Verifying a One Floor Run ................................... 4-5
Verify Releveling .............................................. 4-6

Reaching Contract Speed .................................... 4-7
Final Adjustment Before Running at Contract Speed .... 4-7
Speed Pick Delay .............................................. 4-7
Pattern Scaling ............................................... 4-8

Learning Normal & Emergency Terminal Limit Switches 4-9
Fine Tuning the TORQMAX Drive ......................... 4-11
Up/Down High Speed Difference .......................... 4-11
Car Does Not Reach High Speed ......................... 4-11
Shaping the Speed Profile ................................................................. 4-12
Profile Parameters ........................................................................... 4-12
Profiles ............................................................................................. 4-13
Setting Pattern Parameters ............................................................... 4-14

Controlling Initial Start of Car Motion .............................................. 4-16
Pre-torque Adjustments ................................................................. 4-16
  Load Weigher Sensor Adjustment .................................................. 4-16
  Pretorque Gain Adjustments ......................................................... 4-17
Drive Control Adjustments ............................................................. 4-19
Brake Parameter Adjustments ......................................................... 4-20
Calibrating the Floor Offsets ............................................................ 4-23
  Floor offset calibration procedure .............................................. 4-23

Adjusting Leveling and Final Stop .................................................. 4-26
Final Approach and Leveling ........................................................... 4-26
Final Stop ......................................................................................... 4-26
Releveling Operation ....................................................................... 4-29
Ride Quality ...................................................................................... 4-30

Load Weigher Adjustment for Dispatching ....................................... 4-30

Load Weigher Configuration ............................................................ 4-32
Load Weigher Selection and Threshold Settings ............................... 4-32
Learning Load Values ..................................................................... 4-33
  Load Weigher Learn Procedure .................................................. 4-34

Pre-Start Sequence ......................................................................... 4-35
  Allow machine to be energized: After doors are locked .............. 4-36
  Allow the machine to be energized:
    When the door position monitor is activated ................................ 4-37
  Allow the machine to be energized:
    While doors are closing with motor only .................................. 4-38
  Allow the machine to be energized:
    While doors are closing with motor and partially picked brake .... 4-39
  Allow the machine to be energized:
    While doors are closing with motor and fully picked brake ....... 4-40

Calibration and Verification of Safety Functions ................................ 4-41
Tach Error Tripping Threshold Adjustment .................................... 4-41
Verify Tach Error Does Not Trip on Emergency Stop ..................... 4-42

Safety Tests ...................................................................................... 4-43
Running a Test ................................................................................ 4-44
Car/Counterweight Safety Test ....................................................... 4-45
Electrical Governor Test .................................................................. 4-46
Car/Counterweight Buffer Test ....................................................... 4-46
Inspection Overspeed Test ............................................................. 4-47
Contract Overspeed Test .................................................................. 4-47
Leveling Overspeed Test ................................................................. 4-48
Emergency Brake Test - Unintended Motion - Rope Brake ........... 4-48
Emergency Brake Test - Unintended Motion - Machine Brake ........ 4-49
Ascending Car Overspeed Test - Rope Brake .................................. 4-51
Ascending Car Overspeed Test - Machine Brake ............................ 4-52
Section 5. System Options

About System Options ........................................ 5-1
iCentral - Central Dispatcher ................................. 5-2
  Switching Between iCue & iView PCs ..................... 5-2
  iCue Dispatching Capabilities ............................. 5-3
  System Interconnect ........................................ 5-4
  Cabinet Installation ....................................... 5-6
  Check for Shorts to Ground ............................... 5-7
  AC Voltage Verification and Wiring ....................... 5-7
  Initial Power Up and Bus Verification .................... 5-9
iControl Ethernet Overview .................................. 5-10
  System TCP/IP .............................................. 5-11
  LAN TCP/IP ................................................ 5-11
  System Hub .................................................. 5-12
  LAN Hub ...................................................... 5-13
  External Connections ..................................... 5-14
  Ethernet Addresses ........................................ 5-14
  TCP/IP Reference .......................................... 5-15
  System Ethernet ............................................ 5-18
  LAN Ethernet ............................................... 5-18
  Setting iView PC LAN IP Addresses ....................... 5-18
  Setting iCue PC LAN IP Addresses ......................... 5-21
  Pinging ..................................................... 5-24
  iCue User Interface ....................................... 5-25
  Write Permission ......................................... 5-26
  iCue Watchdog ............................................. 5-27
Comm-connect Cabinet - Local/Dispatcher .................. 5-28
Serial Hall Call ............................................... 5-30
  Hall Call Installation .................................... 5-32
  Pulling Serial Bus Wiring ................................ 5-32
  Setting Node Board Addresses ............................ 5-33
  Checking Serial to IP Connections ....................... 5-35
  Troubleshooting .......................................... 5-36
  Serial/Ethernet Translation ................................ 5-36
  SC-HCE Assemblies ....................................... 5-36
  Trouble Indications ....................................... 5-39
  Hall Call Driver ......................................... 5-43
Flexible I/O .................................................. 5-45
  SC-ION Boards ............................................. 5-46
  I/O Connections .......................................... 5-47
  Board Programming ....................................... 5-47
Section 6. Troubleshooting

About Troubleshooting ................................................. 6-1
Troubleshooting Tools ................................................. 6-2
Safety String Bypass Jumper .................................... 6-3
Message Tables ......................................................... 6-4
iControl Messages ......................................................... 6-13
Circuit Boards and Assemblies ...................................... 6-72
Circuit Board Removal and Replacement .................. 6-72
iBox Removal and Replacement .................................... 6-73
iBox Configuration File .................................................. 6-73
iBox Removal ................................................................. 6-73
iBox Installation .............................................................. 6-74
iBox File Upload .............................................................. 6-74
iControl Circuit Board Quick References .................. 6-75
ICE-COP Serial Car Operating Panel Board ........... 6-76
Normal Operation ............................................................. 6-76
Board Diagnostics ............................................................ 6-76
Software Version Query .................................................. 6-76
ICE-CTP Cartop Processor Board ........................... 6-78
ICE-CTP Cartop Diagnostics ........................................... 6-81
ICE-EB Emergency Brake Board .................................. 6-84
ICE-FML Field Module Logic Board ...................... 6-85
ICE-IEQ Earthquake Board ................................................................. 6-88
ICE-IMP Main Processor Board ......................................................... 6-90
ICE-IRB-2 Relay Board ................................................................. 6-92
  Checking TM Triac on ICE-IRB Board ............................................ 6-94
ICE-IRD Rear Door Board .............................................................. 6-95
ICE-LCB Low Current Brake Board .................................................. 6-96
ICE-MIAC (-24V) Multiple Input Board .............................................. 6-97
ICE-MOR Multiple Output Relay Board .............................................. 6-99
  Output Connections ........................................................................ 6-99
ICE-RG Rope Gripper Board ............................................................. 6-101
ICE-SAF Safety Board ....................................................................... 6-102
ICE-SF-x Serial Fixtures Board .......................................................... 6-107
SC-HCDA-ISO Serial Hall Call Driver Isolation Board ......................... 6-108
SC-HCE-ME Serial Hall Call Ethernet - Digi ME Board ....................... 6-109
SC-HCNT Serial Hall Call Node Board ................................................. 6-110
SC-ION: Serial Control I/O Board ..................................................... 6-111
  I/O Connections ............................................................................. 6-111

Section 7. iBox Front Panel Controls

About the iBox Front Panel ............................................................... 7-1
LCD Display and Keypad ................................................................. 7-3
  Keypad Controls ............................................................................ 7-4
  LCD Display .................................................................................. 7-4
  Parameter Entry ............................................................................ 7-5
  Editing a Controller Parameter ....................................................... 7-6
Setting iBox Ethernet Port Addresses .............................................. 7-9
  IP Address Verification/Setting ....................................................... 7-10
System Status Display ..................................................................... 7-11
  LED Status Display ....................................................................... 7-11
  LCD Status Display ....................................................................... 7-12
  System Control Switches ................................................................. 7-12
Safety Bypass Jumper and Fuses ....................................................... 7-13
Section 8. Using iView

About iView .......................................................... 8-1
How iView Works ................................................. 8-2
Installing iView ..................................................... 8-3

Getting Started ..................................................... 8-4
Direct Connections ............................................... 8-5
LAN Connections .................................................. 8-13
Creating a New LAN Connection ......................... 8-13

Working Online ...................................................... 8-17
Viewing and Adjusting Settings ......................... 8-18
Sending Adjustments to the Controller ............... 8-19
Saving Parameters to a Configuration File ........ 8-20
Save to File ......................................................... 8-20
Saving Default Parameters to a Configuration File 8-21
Loading Parameters from a Configuration File ...... 8-22

Working Offline ....................................................... 8-23
Accessing Online Help ........................................... 8-24

iView Windows and Tabs ......................................... 8-25
Controller - Configuration Tabs ....................... 8-25
Controller - Diagnostic Tabs .............................. 8-25
Controller - Setup Tabs ....................................... 8-25
Additional Windows ............................................. 8-25
Controller - Layouts ............................................. 8-30
System View Windows and Tabs ...................... 8-31
System - Configuration Tabs ............................. 8-31
System - Diagnostic Tabs .................................... 8-31
Additional Windows ............................................. 8-31
Pinning and Unpinning Windows ..................... 8-33
Resizing Windows ................................................. 8-34
Docking and Undocking Windows .................... 8-35
Printing Screens .................................................. 8-38
Setting the System’s Date and Time ................. 8-38
Editing Dynamic Displays ................................. 8-39

Updating Controller Firmware ............................... 8-41
Upgrade Options .................................................. 8-43
Bootrom Recovery via OBD ................................. 8-44
Section 9. iView - Controller View

About this Section ................................................................. 9-1
Selecting Controller View .................................................. 9-1

Controller View Windows and Tabs ...................................... 9-2
iView Button Bar ................................................................. 9-3
iView Status Bar ................................................................. 9-3
Hoistway window ............................................................... 9-4
Mode of Operation ............................................................. 9-5

Operational Status tab ....................................................... 9-8
Speed ................................................................. 9-8
Processor health ............................................................. 9-8
In-service ................................................................. 9-8
Time Remaining for ....................................................... 9-8
Motion ................................................................. 9-9
Position ................................................................. 9-9
Machine ................................................................. 9-9
Door lock ................................................................. 9-10
Leveling sensor ............................................................ 9-10
Pattern ................................................................. 9-10
Faults ................................................................. 9-10
Car status ................................................................. 9-10

Diagnostics Tabs ............................................................... 9-11
Diagnostics - Data Trap ................................................... 9-11
Diagnostics - Diagnostic Flags ........................................ 9-12
Diagnostics - Diagnostic Outputs .................................... 9-13
Diagnostics - Event Log .................................................. 9-14
Diagnostics - Fault Bypass ............................................... 9-17
Diagnostics - Terminal Switches Status ............................ 9-19
Diagnostics - Virtual Oscilloscope .................................... 9-21
Display Editing ............................................................. 9-22

Configuration Tabs ............................................................ 9-24
Configuration - Brake Tab ................................................. 9-24
Brake - Control Tab - Voltage ........................................ 9-25
Brake - Control Tab - Filter ............................................ 9-25
Brake - Control Tab - Switch ........................................... 9-25
Brake - Control Tab - Timers .......................................... 9-26
Brake - Configuration Tab ............................................... 9-27

Configuration - Car Call Enable ........................................ 9-28

Configuration - Car Operation ............................................ 9-29
Car Operation - Doors tab ............................................... 9-30
Car Operation - Devices Tab ........................................... 9-34
Car Operation - Passenger Tab ....................................... 9-38
Passenger - Door operation tab ...................................... 9-41
Passenger - Door operation - Front / Rear tabs ................. 9-43
Car Operation - Fire Service Tab ....................................... 9-45
Fire Service - Fire Code .................................................. 9-46
### Section 10. iView - System View

#### About this Section
- Selecting System View

#### System View Windows and Tabs
- Button Bar
- iView Status Bar
- An Overview of System Options

#### System Configuration tab
- Building
- CFSS (Commandeer for Special Services)
- Dispatching - Options
- Dispatching - Configurations
- Hall Call Eligibility
- Mode of Operation
  - Select a Configuration
  - Mode of Operation
  - Automatic
  - Balanced
  - Lobby Peak
  - Demand Up Peak
  - Demand Down Peak
- Parking
  - Parking Configurations
  - Set Parking Delay Timers
  - Choose Dynamic or User-Defined Parking
  - Sector Dispatching
  - Sending Changes to iControl
- Parking Eligibility
- Split Bank Operation
- Management
  - Remote Monitoring Authorization
  - Local Dispatcher
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Tabs - Emergency Power</td>
<td>10-33</td>
</tr>
<tr>
<td>Defining Emergency Power Behavior</td>
<td>10-34</td>
</tr>
<tr>
<td>Configuration Tabs - Legacy Group Interface</td>
<td>10-36</td>
</tr>
<tr>
<td>Cross-registration</td>
<td>10-36</td>
</tr>
<tr>
<td>Cross-cancellation</td>
<td>10-37</td>
</tr>
<tr>
<td>Configuration Tabs - Security</td>
<td>10-38</td>
</tr>
<tr>
<td>General - Status</td>
<td>10-38</td>
</tr>
<tr>
<td>General - Configuration</td>
<td>10-39</td>
</tr>
<tr>
<td>General - Manage Passwords</td>
<td>10-40</td>
</tr>
<tr>
<td>Security - General</td>
<td>10-41</td>
</tr>
<tr>
<td>Hall Calls</td>
<td>10-42</td>
</tr>
<tr>
<td>Per-Floor Security</td>
<td>10-42</td>
</tr>
<tr>
<td>Per-Car Lockout</td>
<td>10-44</td>
</tr>
<tr>
<td>Car Calls - Configuration</td>
<td>10-45</td>
</tr>
<tr>
<td>Car Calls - Mode Overrides</td>
<td>10-47</td>
</tr>
<tr>
<td>Car Calls - Passcodes</td>
<td>10-48</td>
</tr>
<tr>
<td>Car Calls - Passcodes - Floor</td>
<td>10-48</td>
</tr>
<tr>
<td>Car Calls - Passcodes - Passenger</td>
<td>10-49</td>
</tr>
<tr>
<td>Configuration Tabs - System I/O</td>
<td>10-51</td>
</tr>
<tr>
<td>System Tab</td>
<td>10-51</td>
</tr>
<tr>
<td>Default Calls Button</td>
<td>10-52</td>
</tr>
<tr>
<td>Configure Button</td>
<td>10-52</td>
</tr>
<tr>
<td>Configuring System I/O</td>
<td>10-53</td>
</tr>
<tr>
<td>System I/O - Bus Tab</td>
<td>10-60</td>
</tr>
<tr>
<td>Configuration Tabs - Timer Tables (System)</td>
<td>10-62</td>
</tr>
<tr>
<td>Features</td>
<td>10-62</td>
</tr>
<tr>
<td>Timer Details</td>
<td>10-63</td>
</tr>
<tr>
<td>Timers</td>
<td>10-63</td>
</tr>
<tr>
<td>Configuration Tabs - User Events</td>
<td>10-65</td>
</tr>
<tr>
<td>Configuration Tabs - Remote Outputs</td>
<td>10-66</td>
</tr>
<tr>
<td>Diagnostic Tabs - Event Log</td>
<td>10-68</td>
</tr>
<tr>
<td>System - Hoistway</td>
<td>10-70</td>
</tr>
<tr>
<td>Per Car Display</td>
<td>10-72</td>
</tr>
<tr>
<td>Call Registration</td>
<td>10-73</td>
</tr>
<tr>
<td>System Performance</td>
<td>10-74</td>
</tr>
<tr>
<td>System - Layouts</td>
<td>10-75</td>
</tr>
</tbody>
</table>
Section 11. Reference

About this Section .......................................................... 11-1
iControl AC Specifications .............................................. 11-2
Software Test Point Signals ............................................. 11-3
iBox Field Connections .................................................... 11-7
System and LAN Ethernet ................................................. 11-15
  MCE Direct-Connect Port (Links one iBox to one Laptop with iView) .......... 11-15
  Elevator LAN Network .................................................. 11-16
Summary ................................................................. 11-19
Summary by Group ......................................................... 11-20
TORQMAX F5 Drive Parameters Quick Reference ................. 11-27
PowerBack R6 Regenerative Drive Quick Reference .............. 11-31
Introduction

iControl - August 2008 Release

Welcome! This user guide is intended for use with the August 2008 release of iControl. It includes additional features and capabilities which are outlined in this section and described in detail elsewhere in this guide. If you are viewing this document on a PC, click the hyperlinks to jump to the topics shown in blue.

What’s in this Introduction?

- In this User Guide (Intro page 2)
- What’s New (Intro page 3)
- Using iView On-line Help (Intro page 6)
- Using the Installation Checklist (Intro page 7)

If you are an experienced iControl user:

- See “In This User Guide:” on Intro page 2. The material in this guide is arranged in a slightly different order from previous editions.
- See “What’s New” on Intro page 3. There you will learn about the new features and capabilities that have been added in this release.
- See “Using the Installation Checklist” on Intro page 7. For future installations you may only need to refer to this checklist or, at most, look up the detailed instructions for a few items on the checklist.
In This User Guide:

This is the installation, adjustment, and troubleshooting guide for iControl AC traction elevators. When viewed online as a PDF file, hyperlinks link to related topics and informational websites. The user guide includes:

- **Contents**: Table of Contents. When viewed online as a pdf file, hyperlinks in the Contents link to the associated topic in the body of the manual.
- **Introduction**: Introduction. Provides an overview of what’s in this user guide and what’s new in this release.
- **Section 1**: iControl Description. Provides an overview and introductory information about iControl, the iBox, the iView graphical user interface, and other system options.
- **Section 2**: Construction Mode. Complete instructions on installing iControl and bringing the elevator up on Construction Mode.
- **Section 3**: Inspection Mode. Complete instructions on continuing the elevator installation and adjustment up to Inspection Mode.
- **Section 4**: Final Adjustment. Step-by-step instructions on making the final adjustments necessary to release the elevator to normal passenger operation.
- **Section 5**: System Options. Installation instructions for various system options including Central Dispatching, Local/Dispatching, Serial Hall Call, Serial COP, EMCO Load Weigher and MCE Load Weigher.
- **Section 6**: Troubleshooting. Information about diagnosing and correcting improper system operation.
- **Section 7**: iBox Front Panel Controls. Detailed information about the parameter displays/adjustments and function switches on the front panel of the ibox.
- **Section 8**: Using iView. Detailed information about the iView graphical user interface. iView software runs on any PC running Windows 2000 or Windows XP and is the primary tool used to view and adjust iControl parameters, diagnose problems, and monitor system health.
- **Section 9**: iView - Controller View. Detailed information about the adjustable “Controller” parameters, screen-by-screen and parameter-by-parameter.
- **Section 10**: iView - System View. Detailed information about the adjustable “System” parameters, screen-by-screen and parameter-by-parameter.
- **Section 11**: Reference. Additional technical information provided for elevator mechanics and adjusters.
- **Index**: Index. Alphabetical index to help you find information in the manual. When viewed online as a PDF file, index entry page references are hyperlinks to the associated information in the body of the manual.
What’s New

Many new features and capabilities have been added to iControl in the most recent releases. The following is a list of many of the new features:

**Alternate Dispatcher - Local/Dispatcher**  
Previously iControl included the capability for one of a group’s car controllers to assume dispatching responsibilities (Backup Dispatcher) when the Central Dispatcher is not available. With this release, any or all of the Local car controllers can be designated as an *Alternate Dispatcher* and can assume dispatching responsibilities for the group. In many instances a Central Dispatcher is not required. For more information see “An Overview of System Options” on page 10-4 and see “Alternate Dispatcher” on page 10-8.

**Status Bar - Controller Type**  
The status bar, at the bottom-left of the iView window, indicates the type of controller to which iView is connected (see “iView Status Bar” on page 9-3).

**Split Bank Dispatching**  
Split Bank operation allows some of the cars in a group to be dispatched as a separate group and to respond to hall calls from an alternate riser. For more information see “Split Bank Operation” on page 10-29.

**Third Party Authorization**  
In order to control access to iControl data, this tool is used to authorize a third party monitoring tool to connect to the iControl system (see “Management” on page 10-31).

**System I/O Status Indicators**  
LEDs indicate the current status, On or Off, of the input and/or output at each node address (see “System I/O - Bus Tab” on page 10-60).

**Per-car Hall Call Security**  
Hall call lock out can now be applied per-car, per-floor and per-direction (see “Per-Car Lockout” on page 10-44).

**Per-Passenger Car Call Security**  
Unique car call enable passcodes may be assigned to individual passengers. Activity associated with the use of these passcodes may be viewed using iReport (see “Car Calls - Passcodes - Passenger” on page 10-49).

**System - User Events**  
Users can assign a name to an Input / User Event. Up to 10 Input / Event Names can be programmed. This event name can then be assigned to a hardware input. An event is logged, on the System Event Log, when the input is activated and again when it is deactivated (see “Configuration Tabs - User Events” on page 10-65).

**System - Remote Outputs**  
Users can configure system outputs which can be wired to an input or other device. The outputs can be turned on and off remotely via iView or iMonitor or via a timer (see “Configuration Tabs - Remote Outputs” on page 10-66).

**System Event Log**  
An Event Log has been created to record the System events (see “Diagnostic Tabs - Event Log” on page 10-68).

**Enhanced Controller Event Log**  
An event filter has been added to the controller Event Log to allow the user to select which events are logged (see “Diagnostics - Diagnostic Outputs” on page 9-14). Troubleshooting Tips for each event can be displayed with the click of a button.
**Clear Event Log**  The data stored in the event logs, controller and system, can be easily cleared using the Clear all button on the event log's button bar.

**Data Trap**  This diagnostic tool automatically records controller data including input and output states, internal flags and parameter values (see “Controller - Safety Tests” on page 9-156).

**Hoistway Access Recall**  To facilitate ease of gaining hoistway access, controls have been added to allow the activation of a hoistway access switch/input to also recall the car (see “Hoistway Access Recall” on page 9-65).

**Shuttle Service**  The Shuttle Service option allows a local car to provide express service for a subset of the building’s floors. For more information see “Car Operation - Shuttle Service” on page 9-86.

**I/O Assertion**  This troubleshooting tool allows the user to bypass the current state of a terminal on an I/O board and assert a desired state (on or off) via iView (see “I/O Assert” on page 9-104).

**System I/O for Simplex and Swing Cars**  The inputs and outputs normally supplied to the dispatcher via the Serial Hall Call system are now available on the MIAC and MOR boards.

**Controller - User Events**  Users can assign a name to an Input / User Event. Up to 10 Input / Event Names can be programmed. This event name can then be assigned to a hardware input. An event is logged, on the Controller Event Log, when the input is activated and again when it is deactivated (see “Configuration - Advanced - User Events” on page 9-141).

**Controller - Custom Outputs**  Custom Outputs is an advanced feature that allows existing controller inputs, outputs and internal flags to be used in custom logic equations which can then generate controller outputs (see “Configuration - Advanced - Custom Outputs” on page 9-142).

**Rope Tension Load Weigher**  An additional load weighing option, which measures tension of the wire ropes, is now available for use with iControl (see “EMCO Load Weigher Installation and Calibration” on page 5-51).

**Default Configuration File**  The Controller and/or System default parameter settings can be saved to a configuration (.cfg) file. The default parameter values can then be loaded onto the controller (see “Saving Parameters to a Configuration File” on page 8-20).

**Brake Contact Input**  Controls have been added to allow the polarity of the brake contact input to be set to either active high or low (see “Brake - Control Tab - Switch” on page 9-26).

**TAPS Interface**  Controls and logic have been added to allow iControl with AC Drive to use the new Traction Auxiliary Power Supply (TAPS) (see “Car Operation - Emergency Power Tab” on page 9-72).
Serial Drive Control  An option has been added to allow iControl to communicate speed commands and receive speed feedback from the AC drive via a serial link.

Car Statistics  iControl accumulates statistical data which can be used in maintaining the elevator. The statistics include distance traveled (odometer), power up cycles, front and rear door cycles, motion cycles, floor time, floor runs, inspection runs, auto runs and auto relevals. This data can be viewed on the iBox onboard display (Car menu), which also allows the data to be cleared.

Write Privilege Time-Out   Controls have been added to the iBox OBD Mgmt menu to set the write privilege time-out time and to cancel write privilege (see “Mgmt Menu Parameters” on page 7-9).

Clone Controller Data  Allows the controller’s parameter settings to be saved to flash memory in order to facilitate easy field replacement of an iBox (see “Mgmt Menu Parameters” on page 7-9).

Upgrade Wizard   A special utility has been created facilitate field upgrade of iBox firmware programs.
Using iView On-line Help

iView is a graphical user interface which runs on a Windows PC or laptop computer. The computer is typically connected to iControl through a Local Area Network. The iView program provides the main user interface to iControl. It allows the user to view and set Controller and System operating parameters.

On-line help is incorporated into iView to provide information about iControl screens and parameters. You can access iView On-line Help in the following ways:

**Context Sensitive Help**

You can view On-line Help information about any screen or tab by pressing function-key one (F1) while a screen or tab has focus. Do the following:

- Click the title bar of a window, e.g., the Hoistway window, to bring focus to the window. The background color of the window’s title bar darkens indicating that the window has focus. Then press the F1 key. iView Help will display the topic that describes the window.
- Click a tab (title). An outline will appear around the tab title indicating that the tab has focus. Then press the F1 key. iView Help will display the topic that describes the tab.

**Context Sensitive Event Help**

iControl logs status and error information in the Controller - Event Log (see “Diagnostics - Diagnostic Outputs” on page 9-14). To view the Event Log, Event Properties and Context Sensitive Event Help:

1. In the Controller view, click View > Diagnostics > Event Log to display the Event Log.
2. Double click an event in the Event Log to display the Event Properties dialog.
3. Click the Help button in the Event Properties dialog to display the Troubleshooting Tips dialog which provides a description of the event, an indication of what action is taken, and troubleshooting tips if appropriate.

**Help Viewer**

iView On-line Help provides three additional ways of locating information. The Contents and Index tabs let you find general information. The Search tab lets you look up specific words or phrases.

To start iView On-line Help:

1. On the iView menu bar, click Help.
2. On the Help menu, click iView Help. The help viewer is displayed. Use the Contents, Index or Search tabs to locate the desired information.

iView On-line Help provides the following kinds of information:

- Using iView Help - A description of the many options, capabilities and ways of using iView On-line Help.
- Using iView - Provides information and instructions on how to use the iView graphical user interface.
- iView Windows and Tabs - Lists all of the iView windows and tabs and provides links to descriptions of the parameters on each tab.
- Message Reference - An alphabetical listing of iControl status and error messages. Each listing includes a description, an indication of what action is taken, and troubleshooting tips.
- Parameter Reference - a tab by tab listing of all of the Controller and System parameters including a description of each parameter.
Using the Installation Checklist

This checklist provides general instructions to help experienced personnel install an iControl AC elevator controller. Should you need detailed information for any item on the checklist, refer to the specific sections of the User Guide suggested.

**Installation Checklist (page 1 of 3)**

- Review the job prints. They are always the controlling document (see “About MCE Job Prints” on page 2-7).
- Review the machine room preparation guidelines (see “Machine Room Preparation” on page 2-4).
- Check the controller visually. Verify that nothing has been damaged or dislodged during shipment.
- Review the controller installation guidelines (see “Controller Cabinet Installation” on page 2-9).
- Open cable access holes in the areas indicated by the stickers. Ensure that no metal filings get into the electronics (see “Cable Access” on page 2-10).
- Review the typical connection locations (see “Overview of Typical Connection Locations” on page 2-11 and see “iBox Field Connections” on page 11-7).
- Ground all equipment according to the job prints and local code (see “Equipment Grounding” on page 2-12).
- Install the field wiring as shown on the job prints.
- Check for shorts to ground (see “Equipment Grounding” on page 2-12).
- Verify the main line power wiring (see “AC Voltage Verification and Wiring” on page 2-15).
- Verify proper bus voltages (see “Initial Controller Power Up” on page 2-17).
- Install and verify the wiring to the hoist motor (see “Checking the Hoist Motor” on page 2-19 and see “Wiring the Hoist Motor to the Controller” on page 2-19).
- Verify the brake current resistance and install the brake wiring (see “Verifying Brake Current Resistance” on page 2-20 and see “Wiring the Brake” on page 2-21).
- Install the encoder / tachometer (see “Velocity Encoder Installation and Wiring” on page 2-22).
- Verify the safety string wiring (see “Basic Safety String and Associated Wiring” on page 2-25).
- Install the temporary cartop inspection controls (see “Temporary Cartop Inspection Wiring” on page 2-27).
- Apply power and verify that the iBox is functioning (see “Applying Power” on page 2-27).
- Connect / verify the iView PC connection (see “Connecting the iView PC” on page 2-28).
- Verify the initial parameter settings (see “Verifying Initial Parameter Settings” on page 2-41).
- Learn the safety configuration (see “Learning the Safety Configuration” on page 2-44).
- Perform the automated drive setup procedure (see “Automated Drive Setup Procedure” on page 2-46).
Installation Checklist (page 2 of 3)

- Calibrate the brake (see “Brake Calibration” on page 2-48).
- Verify that the brake is picking properly (see “Verify Brake Picking” on page 2-51).
- Verify proper car movement on inspection (see “Verify Pattern Command and Drive Speed Feedback” on page 2-55).
- Verify pattern command and drive speed feedback (see “Verify Pattern Command and Drive Speed Feedback” on page 2-55).
- Calibrate the car speed (see “Following Error Margin” on page 2-56).
- Set the following error parameter - tach error tripping threshold (see “Following Error Margin” on page 2-56 and see “Tach Error Tripping Threshold Adjustment” on page 2-57).
- Verify electronic motor overload protection (see “Electronic Motor Overload Protection Verification” on page 2-58).
- Verify proper mounting of iLand landing system (see “Cartop Mounting” on page 3-3).
- Verify proper installation of the floor magnets (see “Floor Leveling Magnets” on page 3-9).
- Verify iLand connection to iLink (see “Cabling Connections” on page 3-11).
- Verify proper installation of iLink (see “Installing iLink” on page 3-13).
- Install the hoistway limit switches per the job prints (see “Installing Hoistway Limit Switches” on page 3-19).
- Install the Load Weigher, if applicable (see “Installing the Load Weigher” on page 3-19 and see “EMCO Load Weigher Installation and Calibration” on page 5-51 or see “MCE Load Weigher” on page 5-61).
- Install the optional Brake Pick Switch, if applicable (see “Installing Brake Monitoring” on page 3-20).
- Install the earthquake sensor, if applicable (see “Installing the Earthquake Sensor” on page 3-21).
- Install the serial hall call system (see “Installing the Serial Hall Call System” on page 3-22).
- Install the serial COP system, if applicable (see “Installing the Serial COP System” on page 3-22).
- Verify the cartop voltages (see “Verifying Cartop Voltages” on page 3-23).
- Verify door operation (see “Verifying Door Operation” on page 3-24).
- Verify the safety configuration (see “Verifying the Safety Configuration” on page 3-25).
- Exit construction mode / begin running on inspection (see “Exit Construction Mode” on page 3-25 and see “Running on Machine Room Inspection” on page 3-26).
- Verify the quadrature pulse sequence (see “Verifying Quadrature Pulse Sequence and Encoder Resolution” on page 3-27).
- Perform final door operator checks (see “Door Operator” on page 3-28).
- Perform the counterweight learn and counterweight balancing procedures (see “Counterweight Learn Procedure” on page 3-28).
- Perform the run and empty car tests (see “Run Testing” on page 3-30 and see “Empty Car Tests” on page 3-31).
- Learn the building floor heights (see “Learning Floor Heights” on page 4-2).
- Verify proper one-floor run operation (see “Verifying One Floor Run Operation” on page 4-3).
Installation Checklist (page 3 of 3)

- Verify proper releveling (see “Verify Releveling” on page 4-6).
- Verify proper speed pick delay and pattern scaling (see “Final Adjustment Before Running at Contract Speed” on page 4-7).
- Learn the terminal slowdown and limit switches (see “Learning Normal & Emergency Terminal Limit Switches” on page 4-9).
- Fine tune the TORQMAX drive (see “Fine Tuning the TORQMAX Drive” on page 4-11).
- Verify the pattern parameter settings with regard to contract speed overshoot and current limiting, the slope of acceleration and deceleration, final approach to the floor, excessive motor noise and bunching up of deceleration rate (see “Setting Pattern Parameters” on page 4-14).
- Verify the parameter settings that control the initial start of car motion, e.g. load weigher sensor and pretorque gain adjustments and motor control and brake parameter adjustments (see “Controlling Initial Start of Car Motion” on page 4-16).
- Calibrate the floor offsets (see “Calibrating the Floor Offsets” on page 4-22).
- Verify the parameter settings related to final approach, leveling, final stop and releveling (see “Adjusting Leveling and Final Stop” on page 4-25).
- Verify the load weigher adjustments for dispatching and load weigher configuration, if applicable (see “Load Weigher Adjustment for Dispatching” on page 4-29 and see “Load Weigher Configuration” on page 4-31).
- Verify the pre-start sequence parameters, if applicable (see “Pre-Start Sequence” on page 4-34).
- Verify the parameter settings relating to tach error tripping threshold and armature over-current overload protection (see “Calibration and Verification of Safety Functions” on page 4-40).
- Perform the safety tests (see “Safety Tests” on page 4-42).
- Verify that no safety function or circuit remains bypassed prior to releasing the car for normal passenger operation (see “Before Release to Passenger Operation” on page 4-56).
About iControl

*iControl* from MCE intelligently integrates and coordinates every element of your elevator installation. iControl includes:

- **iController** — *iBox* intelligence for control logic and safety process management (see page 1-5).
- **iView** — A Windows-native, graphical user interface for direct system analysis, diagnostics, and parameter adjustment (see page 1-11).
- **iLand** — An innovative landing system unencumbered by tape, struts, or switches (see page 1-17).
- **iLink** — Cartop, single-point interconnect, converting discrete car signals to serial communications. Optional serial COP available (see page 1-18).
- **iCue** — Powerful, adaptable dispatching engine (see page 1-19).
- **iMonitor** — Centralized, on site or remote system monitoring capability (see page 1-21).
- **iReport** — System logging and report generating tool (see page 1-22).
The system overview diagram below provides a high-level view of an iControl installation, including peripheral devices and associated iControl equipment.

**Figure 1.1  iControl Overview**
iControl Features
MCE designed iControl to provide:

- Compliance: ASME A17.1 / CSA B44.
- Safety: Independent processors verify all safety checks.
- Support: MCE Technical Support at regional and factory level, electronically or on site.
- Reduced Installation Expense: Simplified installation for minimum time and expense.
- Reliability: Solid-state construction, minimized point-to-point wiring, integrated design, and non-volatile FLASH memory.
- Scalability: Flexible capacity and system configuration, scalable control, networked communications capability, and expandable I/O adapt to future requirements.

Serviceability:
- All user parameters fully field programmable.
- Secure on site and remote access to user parameters.
- Supports multiple, simultaneous iView connections for near real-time, diagnostic coordination and support.
- Real-time status display.
- Single point location for system control switches.
- At-a-glance, LED display of 15 most important system functions.
- Virtual oscilloscope iView display.
- Informative, near real-time, iView hoistway display.
- Report generation.
- On line help for iView.
- Complete hard copy and electronic (pdf) documentation.

Reduced Maintenance Requirements:
- Minimal point-to-point wiring.
- Reliable, D-subminiature component interconnection.
- Slide-track mounted boards for easy addition or substitution.
- Cartop, single-point wiring interconnect.
- Tuned Acceleration/Deceleration Pattern for passenger comfort and maximum efficiency.
- Self-optimizing technology — adapts without intervention, fine-tuning performance over time as use patterns are learned.
iControl Description

iControl Function

iControl provides the modular building blocks required to efficiently address elevator installations ranging from a single car servicing only a few floors to those requiring elevator groups operating according to sophisticated dispatching functionality and servicing up to a design maximum 150 floors. In all cases, MCE can provide iControl components to support system capabilities including remote elevator controller diagnosis and support (iView), remote monitoring capabilities (iMonitor) and a system logging and report generating tool (iReport). iControl components include:

- iController enclosure containing iBox elevator controller, motor drive, and peripherals
- Cartop-mounted iLand precision landing system
- Cartop-mounted iLink wiring and interconnect system
- MCE Serial Hall Call system
- Dispatching — iCue dispatching allows a single group controller to accommodate up to a design maximum 20 cars and 150 floors. iCue can handle myriad dispatching configurations, enabled manually or by automation, and allow configuration of variables sufficient to meet virtually any dispatching need including multiple lobbies, intelligent hall call assignment, parking variations, and automated response to changing traffic conditions within the building. Dispatching can be configured with redundancy for protection against individual system failure or disconnect. Elevator security and emergency power operation are also important iCue capabilities.
- **Graphical User Interface** — The MCE iView application runs on Windows PCs or laptops. Through a standard 10/100 Base-TX Ethernet connection, iView lets you:
  - View and adjust over 500 controller, motor, and brake parameters
  - Copy controller configurations to files on the computer hard drive
  - Send some or all parameters from a computer file to a controller
  - Monitor system performance in real time
  - Send car and hall calls to evaluate system response
  - Configure extremely flexible dispatching behaviors
  - Use the iView virtual oscilloscope to tune acceleration and deceleration patterns
  - Configure elevator response to fire, earthquake or other emergency or alternative operating modes
  - With internet access, connect to one controller port while MCE support technicians simultaneously connect to that same controller through a separate port for factory-assisted diagnosis or performance monitoring.
  - Access and print extensive controller logs where important system events are automatically recorded
- **Central Monitoring** — MCE iMonitor software allows personnel at local or remote monitoring sites extensive capability to monitor and control safety and security aspects of your installation. Refer to the iMonitor manual, 42-02-S025.
- **Logging and Reporting** - iReport is a system logging and report generating tool that allows local or remote analysis of iControl elevator groups from a personal computer running the iReport client software. Because iControl dispatchers are Ethernet capable, you can use iReport to connect to them through a local area network or remotely through internet/modem technology. Refer to the iReport manual, 42-02-S026.
**iControl**

iControl provides the latest in integrated digital elevator control. iControl brings premium performance to elevators using AC motors. Controller parameters can be easily adjusted using MCE iView software running on any Windows 2000 or better personal computer. All parameters can be saved to a file on your computer hard drive, providing a secure archive. iView even allows you to work “offline” in a saved controller file and easily write that data to a controller later.

The sophisticated iControl distance and velocity feedback system is continuously aware of exact car position and speed. The 32-bit processor provides smooth pattern generation for any application—easily accommodating irregularities like short floors. Each iControl includes:

- The iBox, including onboard diagnostics
- Flux Vector Drive

The illustration below shows a typical iControl layout.

**Figure 1.2  Cabinet Layout (typical)**

Standard cabinet dimensions:
- Height = 62 inches (157.5 cm)
- Width = 42 inches (107 cm)
- Depth = 16 inches (41 cm)

Measurements are approximate.
Easy Installation

iControl is designed to make installation and adjustment as simple as possible. Before shipment, each controller is carefully tested against specific job requirements. iControl is shipped from MCE with preset, default adjustment values that generally require little additional adjustment.

Detailed MCE job prints, specifically engineered for each installation, provide connection-by-connection instruction for mechanics and electricians. Elevator adjusters will find that iControl has the intelligence to automatically “learn” many previously tedious, adjuster-intensive operations including:

- All floor heights to within 0.0469” (1.191mm)
- All Normal and Emergency Terminal switch positions
- High-current brake modulation across the calibration range
- Empty and full car, analog load weigher values at every landing served
- Elevator safety device configuration
- Hoist motor control across the calibration range

iControl makes specific code-compliance as easy as possible too, providing automated fire and earthquake presets for:

- Title 8
- New York
- Nebraska
- Chicago
- CSA B44-00
- Australia

If necessary for specific job requirements, adjusters have access to detailed, decision-making adjustments within the compliant defaults for various jurisdictions.
**iBox**

The iBox is an efficient, powerful elevator controller and supports Simplex (Group control parking and dispatching subset) functionality as well. Configured for iControl, the iBox includes:

- Onboard diagnostics display and keypad
- System I/O, control and communications ports (serial, discrete, and Ethernet)

**Figure 1.3  iBox**

![iBox Diagram](image)

- **LCD Display and Keypad**
- **System Status Display**
- **System Control Switches**
- **Safety Bypass Jumper (Please refer to “Safety Bypass Jumper and Fuses” on page 7-13.)**
### LCD Display and Keypad

The LCD display and keypad allow you to:

- View the status of inputs and outputs
- View and change limited parameter settings
- View and register calls
- View error messages and the system event log

Typically, when you need to view or change system parameters in an iControl, you connect to the iBox through the PC or LAN Ethernet port and use the iView graphical user interface running on a Windows OS PC to easily access, view, or edit any desired parameter.

However, during initial system setup, parameters that allow PC access to your system can be directly accessed and edited through the keypad and LCD display located on the front panel of every iBox. (For detailed information about keypad parameter entry, please refer to Section 7.)

**Figure 1.4  iBox Data Entry Keypad and LCD Display**

![iBox Data Entry Keypad and LCD Display](image)
### iBox Inputs and Outputs

Most controller field wiring connects directly to the iBox or to expansion boards plugged into buses at the top and bottom of the iBox. Field connections are primarily along the left side of the iBox (when facing it). Connections to other iControl components (i.e., braking control, motor drive, Ethernet, serial, etc.) are primarily along the right edge of the iBox.

Connections to the iBox are all on pluggable connectors. Serial, Ethernet, and Serial Hall Call connections on the right side of the iBox are primarily pre-molded cable assemblies with “D” or RJ-45 connectors. Connections on the left side of the iBox (position encoder, cartop link, code-mandated car, limit, hoistway, and other field connections) are also pluggable — primarily individual conductors, terminated and locked into connectors that plug into mating connectors on the iBox.

Field wiring (wiring completed by the installer) is addressed in Sections 2 and 3 of this guide. The illustration below is only intended to provide an overview of the inputs and outputs to the iBox. A description of every input and output is in Section 11.
AC Flux Vector Drives

The AC Drive control uses flux vector technology. Flux vector technology (sometimes referred to as Field Oriented Control) is a closed loop scheme using an algorithm to adjust the frequency and phase of the voltage and current applied to a three phase induction motor to produce maximum torque from base speed down to and including zero speed. The illustration below shows examples of the TorqMax drives used in MCE iControl AC systems.

Figure 1.5  AC Flux Vector Drives
iVIEW Programming and Diagnostic Software

iView is a graphical user interface running on a Windows PC or laptop computer. The computer may be connected directly to the iBox PC Ethernet port or, through a Local Area Network, to the iBox LAN Ethernet port. iView provides a wealth of information about the operation of the system and speeds adjustment and troubleshooting.

This section provides an overview of iView. Section 8 of this manual provides a more complete description of the iView screens. iView on-line Help and Section 9 provide the most complete description of the screens.

Controller Screen

When you start iView, a splash screen appears for a few seconds, followed by the iView Controller screen. From the File menu, select Connection and click Open. The Open dialog is displayed.

Previously created connections appear in the iControl Connections folder. To connect to a controller, double-click one of the listed connections or select the connection and click Open.
Once the connection has been established, the Operational Status tab and Hoistway window are displayed.

To access controller configuration parameters, click View on the menu bar. Select Configuration tabs and click one of the listed tabs.
Parameter Entry Screens

Parameter entry screens allow you to view and edit all user-adjustable controller parameters. Where appropriate, real time diagnostics capabilities and virtual test equipment facilitate fine performance adjustments and local or remote troubleshooting.

A typical parameter screen, the Pattern/Common tab, is shown below. Before you can edit controller parameters, you must request write privileges (click Write privilege on the menu bar, then click Acquire) and must be granted those privileges at the controller. (The iBox will display your request and a “yes” response must be entered by pressing the iBox #1 softkey.)

<table>
<thead>
<tr>
<th>Operational Status</th>
<th>Pattern</th>
<th>Common</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position synchronization</td>
<td><img src="image1" alt="Terminal" /></td>
<td><img src="image2" alt="Floor" /></td>
<td><img src="image3" alt="Preset" /></td>
</tr>
<tr>
<td>General</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pattern scaling</td>
<td>100.000</td>
<td>%</td>
<td></td>
</tr>
<tr>
<td>Lag delay</td>
<td>0.10</td>
<td>sec</td>
<td></td>
</tr>
<tr>
<td>Door pre-opening distance</td>
<td>3.00</td>
<td>in</td>
<td></td>
</tr>
<tr>
<td>Leveling</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Leveling speed</td>
<td>4.000</td>
<td>ft/min</td>
<td></td>
</tr>
<tr>
<td>Releveling speed</td>
<td>4.000</td>
<td>ft/min</td>
<td></td>
</tr>
<tr>
<td>Leveling distance</td>
<td>0.50</td>
<td>in</td>
<td></td>
</tr>
<tr>
<td>Releveling distance</td>
<td>0.70</td>
<td>in</td>
<td></td>
</tr>
<tr>
<td>Dead zone</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dead zone distance</td>
<td>0.20</td>
<td>in</td>
<td></td>
</tr>
<tr>
<td>Relevel dead zone distance</td>
<td>0.13</td>
<td>in</td>
<td></td>
</tr>
</tbody>
</table>

Position encoder resolution parameter

Position encoder resolution parameter (pulses/ft)

<table>
<thead>
<tr>
<th>Landing System</th>
<th>Position Encoder Resolution Parameter (pulses/ft)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Land-H</td>
<td>256</td>
</tr>
<tr>
<td>Land-C</td>
<td>348</td>
</tr>
<tr>
<td>LS-Edge</td>
<td>256</td>
</tr>
<tr>
<td>LS-MBCF</td>
<td>672.269</td>
</tr>
</tbody>
</table>

Position Encoder Resolution in Pulses Per Foot (PPF)

\[
\text{PPR} = 4 \times \left( \frac{1056}{\text{Diameter}} \right) (\text{in} \times \frac{2}{12} \text{ft})
\]

- PPR = Encoder pulses per revolution
- Diameter = Governor sheave diameter in feet
- \( \pi = 3.1416 \)

Apply | Calculate
Active Displays

The Virtual Oscilloscope allows you to display and track two signals over time simultaneously. The selected signal values are shown on the Test point 1 and 2 displays and output on the STP 1 and STP 2 physical test points on the iBox. Please refer to “Controller - Layouts” on page 9-157.

Active Displays may also be relabeled and modified to suit your immediate needs. Once an edited display is closed, it reverts to its default values. Edit a display by right-clicking on a graph or scale and selecting Edit from the popup menu. A wide variety of editing choices are available.

You may also choose to enable/disable graph animation (tracking) or zoom the display.
System Interconnect

It can be helpful to have a general understanding of the way the entire iControl system is interconnected. This section contains high-level interconnection drawings for:

- **System Interconnection**: Basic car control and dispatcher interconnections.
- **iControl Interconnection**: More detail for car controller interconnections.
- **Cartop Interconnection**: More detail for cartop interconnections.
- **Dispatcher Interconnection**: More detail for dispatcher interconnections.

**Figure 1.6  iControl System Interconnection**
Figure 1.7 Car Control Interconnection

Figure 1.8 Cartop Interconnection
iLand Landing System

The iLand landing system provides the feedback required by the controller to determine car direction, speed, and hoistway position. iLand is a rugged, highly accurate landing system. iLand uses an encoder to gauge precise hoistway position and three separate Hall-effect sensors to level the elevator car accurately at each landing. iLand is designed for easy installation and adjustment and to provide maintenance-free service.

Figure 1.9  iLand Compact Landing System
iLink Car Top Communication

The iLink car top system:

- Provides power to keep the Car Top Processor and Landing System operational during a power failure until the car comes to a stop, thereby retaining car position information.
- Sends landing System quadrature, door zone, and gate switch status to the iBox.
- Sends load weigher information to the iBox.
- Sends Car Operating Panel status to the iBox.
- Receives door open/close commands from the iBox and provides them to the door operator.
- Prevents the doors from opening unless car speed is within acceptable limits.
- Provides a communication link to the iBox for optional car inputs and outputs, e.g., rear door signals and talking and visual position indicators.
- Optional: Relays serial signals between Car Operating Panel and iBox.

Note

An insulator is installed to disconnect the microprocessor/memory battery to prevent it from running down during storage or shipment. During installation, remove the insulator to activate the battery. (An insulator on the microprocessor/memory battery in the iControl cabinet must also be removed prior to running the controller.)
iCUE Intelligent Dispatching

iCue dispatching software runs on a central dispatcher (iCentral), which is a dedicated PC or embedded micro controller, or on a Local/Dispatcher, which is an iController (iBox) that performs both car control and dispatching functions. Please refer to “An Overview of System Options” on page 10-4. The iCentral option is used for the most demanding installations. iCue dispatching features include:

- Design maximum 150 floors and 20-car group.
- Artificial intelligence to adapt to and anticipate changing traffic demands.
- Definition of up to eight independent configurations each to control Hall Call Eligibility, Parking Assignment, Parking Eligibility, and Operating Mode — and to independently assign control of those configurations across as many as 100 automated timers.
- Use parallel processing to simultaneously evaluate multiple dispatching scenarios, ensuring that every decision maximizes efficiency.
- Dedicated 100 Megabaud network to efficiently handle large data loads.
- Intelligent parking system that allows users to define automated or hybrid operation.
- SmartLINK hall call system, MCE-ready fixtures, and predictive hall-call gong service.

Figure 1.10 Central Dispatch (iCentral) Interconnection
Local/Dispatcher

iControllers can assume full dispatching responsibilities for a group of elevators. MCE uses the term *Local* to refer to an individual car that is part of a group, hence the term Local/Dispatcher. One or more Local cars can be designated as an *Alternate Dispatcher*, meaning that they can act as a backup for a central dispatcher or as one of several potential dispatchers for a group that has no central dispatcher. An iController that is currently performing the dispatching functions is called the Local/Dispatcher.

Figure 1.11  Local/Dispatcher (Comm-connect) Interconnections
iMonitor Central Monitoring

iMonitor central monitoring software runs on a Windows personal computer. Through an on-site Local Area Network or remotely through the World Wide Web, iMonitor allows users to immediately gather status from and monitor the performance and safety of any i product elevator installation to which they have been granted access, anywhere in the world.

iMonitor:

- Provides local or remote viewing and control of elevator groups.
- Provides a graphical representation of elevator groups, allowing their activity and status to be quickly and easily viewed.
- Provides remote control. The user may register car and hall calls, control many group security functions, and enable or disable certain elevator operating modes.
**IREPORT Logging and Report Generating**

iReport is a system logging and report generating tool that allows local or remote analysis of iControl elevator groups from a personal computer running the Windows operating system and iReport client software. Because iControl dispatchers are Ethernet capable, you can use iReport to connect to them through a local area network or remotely through internet/modem technology.

**System Description**

iReport consists of the iReport server and iReport clients. iControl dispatchers may be connected to iReport directly through a local area network or they may be connected remotely through a DSL or other high-speed ethernet connection and the internet. The dispatcher provides iReport with hall call and car operating mode information. The individual car controllers provide iReport with event and fault notifications.

You connect to and use iReport through the iReport client program on your PC. The block diagram below illustrates a possible system interconnection. Various local and remote connections are possible depending upon system requirements.

**Figure 1.12 iReport Simplified Block Diagram**
Optional Load Weighing System

iControl uses load weighing information to make intelligent dispatching decisions. If the load weight is very light, the controller can be programmed to limit the number of car calls allowed (anti-nuisance). The controller can be programmed so that at a certain load weight the lobby landing door timer is reduced, thereby initiating the process of moving the car out of the lobby. When the load weight exceeds a preprogrammed value, the controller can be instructed to bypass hall calls. And, if the load weight exceeds a predefined maximum, above which it is considered unsafe to move the elevator, the controller can prevent movement. This application typically includes a visual or audible warning to the passengers that the elevator is overloaded.

MCE has three load weigher options:

- Rope Tension (LW-EMCO) from EMCO - measures the tension of the elevator's wire ropes (see “EMCO Load Weigher Installation and Calibration” on page 5-51).
- Isolated Platform (LW-MCEIP) - measures the movement of the car's isolated platform and can only be used for elevators with isolated platform cars (see “MCE Load Weigher” on page 5-61).
- Cross Head Deflection (from K-Tech International) - measures the deflection of the cross head beam.
In This Section

This section provides the information you need to install iControl and get the elevator running in Construction Mode:

- Machine Room Preparation (see page 2-4).
- Recommended Tools and Test Equipment (see page 2-6).
- About MCE Job Prints (see page 2-7).
- Controller Cabinet Installation (see page 2-9).
- Equipment Grounding (see page 2-12).
- Check for Shorts to Ground (see page 2-14).
- AC Voltage Verification and Wiring (see page 2-15).
- Motor and Brake Wiring (see page 2-19).
- Velocity Encoder Installation (see page 2-22).
- Safety String Wiring (see page 2-25).
- Applying Power (see page 2-27).
- LAN Connections (see page 2-30).
- Initial Parameter Settings (see page 2-41).
- Drive Parameter Adjustments (see page 2-45).
- Brake Calibration (see page 2-48).
- Running on Machine Room Inspection (see page 2-52).
- Calibration Actual Car Speed (see page 2-56).
Construction Mode

Before You Begin

Review the following warnings and become familiar with this manual section before beginning work.

Danger

This equipment contains voltages of up to 1000V, rotating motor parts, and driven machinery. The combination of high voltage and moving parts can cause serious or fatal injury. Only qualified personnel who are familiar with this manual and driven machinery should attempt to start up or troubleshoot this equipment. Please observe the following:

- USE EXTREME CAUTION — Do not touch circuit boards, resistors, or motor electrical connections without ensuring that the unit is properly grounded and no high voltage is present. Do not apply AC power before grounding the equipment in accordance with applicable local codes, the job prints, and instructions contained in this manual.
- BE CERTAIN that any possible violent motion of the motor shaft and driven machinery, caused by improper control operation, will not cause personal injury or damage. Peak torques of up to ten times rated motor torque can occur during a control failure.
- HIGH VOLTAGE may be present on the motor and drive whenever AC power is applied, even if the motor is not rotating.
- BEFORE BEGINNING WORK, read these instructions all the way through to become familiar with the procedures. Proceed cautiously. These instructions assume adequate electrical troubleshooting experience. Follow the procedures carefully and, if the elevator does not respond correctly, check the circuits and obtain necessary assistance.

Overview of Construction Mode

Construction mode operation allows the car to be run on Machine Room Inspection and Cartop Inspection with a bare minimum of field wiring installed. For Construction Mode operation, only the following are needed to run the car:

- Motor, brake, and drive
- Velocity encoder/tachometer
- Safety String
- Normal limit switches
- Door locks and door position monitor (if used)
- The Construction Mode option (iView > View > Setup > Safety > Configuration tab) must be enabled to run the controller in Construction mode.

The cartop wiring interconnect box (iLink) is not required for Construction mode operation. Instead, temporary wiring may be used to “bypass” the cartop safety string.
**Required Connections**  
The following connections are necessary to run the car on Construction Mode:

- Motor, Brake, and Drive
- Velocity Encoder or Tachometer
- SAFH, GOV, ESC, Rope Gripper (if enabled)
- SAFC (provide temporary Emergency stop switch between SAFH and SAFC if iLink is not yet installed)
- UNTD and DNTD (Up and Down Normal Limit Switches)
- GS, DLMS, DLAT, DLAB, DPM (Verify the iView/Safety Configuration screen settings for these options)
- INCT, ICTU, and ICTD
- Emergency Power Input

Connections not required for Construction Mode operation include:

- Cartop Communication (TX, RX)
- Quadrature signal (DP1, DP2)
- EQ signal
- Terminal Switches (U/DNTx and U/DETS)
- Fire Sensor
- DZ, ULM, DLM

Please refer to “iBox Field Connections” on page 11-7 for definitions of iBox inputs and outputs.

**Faults**  
While operating in Construction Mode, faults may be generated because the installation is not yet complete. These may be disregarded in this phase and include:

- Invalid Front and/or Rear Doors
- Terminal Sync
- System Sync
- Floor Sync
Machine Room Preparation

When preparing the machine room for elevator controller installation, consider:

- Equipment location
- Machine room environment
- Ethernet and internet access

Equipment Location

When choosing equipment location, consider:

- Adequate working space for comfort and efficiency.
- Logical arrangement, taking into consideration other equipment in the machine room and routing of electrical power, control, and Local Area Network (10/100 Base TX) wiring.
- Do not install equipment in a hazardous location.
- Installing a telephone in the machine room is desirable as it makes remote diagnostics and adjustment assistance more readily available.
- Wiring the machine room for internet access will allow MCE technical support to use the iView application to remotely view system parameters, diagnose problems, and assist you in adjusting elevator controller settings.
- If any areas in the machine room are subject to vibration, they should be avoided or reinforced to prevent equipment from being adversely affected.
- Provide adequate lighting for the control cabinets and machines. A good working space such as a workbench or table should also be provided.

Environmental Considerations

- Ambient temperature should remain within 32° to 104° Fahrenheit (0° to 40° Celsius). Temperatures outside these guidelines may be tolerated, but will shorten equipment life. Adequate ventilation may be necessary.
- The air in the machine room should be free of excessive dust, corrosive elements, and excessive moisture. A NEMA 4 or NEMA 12 enclosure can help meet these requirements if machine room conditions are inadequate. If the machine room has open or unglazed windows or other direct outside openings, place equipment cabinets far enough from them so that severe weather does not damage the equipment.
- Very high levels of radio frequency (RF) radiation from nearby sources should be avoided. RFI may interfere with controller components, degrading elevator performance. Using hand-held communication devices close to the controller may also cause interference. Interference from permanently installed radio transmitting antennas is not common.
- Power line fluctuation should not be greater than ±10%.
Ethernet and Internet Considerations

iControl takes maximum advantage of the reliability and remote support benefits afforded by Ethernet and internet technologies. The iBox supports three Ethernet connections:

- The #3 port is for direct local connection of a laptop or desktop PC for elevator control configuration, program uploading, system diagnosis, or parameter adjustment using MCE iView software. Fixed IP address: 192.168.193.001
- For multi-car, centrally dispatched installations, the #2 port provides dedicated, fast 100 Base-TX connection between iBoxes. In these installations, the required Ethernet hub is provided by MCE and mounted in the iCentral cabinet. See the table below for the factory default.
- The #1 port allows the elevator controller to be connected to a 10/100 Base-TX Local Area Network (if available). This allows a single PC to be used to administer and monitor multiple elevator controllers using iView software. See the table below for the factory default address for this port.

Through a net modem, ISDN, DSL or other internet access, this port may provide remote access to the controller. This access allows MCE technical support staff to view controller parameters at the same time you view them through your LAN or direct/local connection. Elevator parameters are protected from meddling or accidental change because in order to write data to a controller, permission must be granted in the machine room.

For installations not requiring a central dispatching capability or for single car installations, Ethernet or internet connectivity may not be required.

If you want to take advantage of Ethernet or internet connectivity benefits, the machine room must be appropriately wired. Most commercial buildings use Ethernet Local Area Networks that can readily be extended to accommodate machine room access.

Table 2.1 System, LAN, & 3=PC TCP/IP Addresses

<table>
<thead>
<tr>
<th>Hub</th>
<th>Group</th>
<th>Group IP, Primary &amp; Backup</th>
<th>Car ID</th>
<th>Car IP</th>
<th>System/Serial Hall Call Bus 1 - 4</th>
<th>iView PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #3 = PC (iBox ONLY), NO HUB</td>
<td></td>
<td></td>
<td></td>
<td>192.168.193.001</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*192.168.191.101 is typically used for the iView PC.
Recommended Tools and Test Equipment

For proper installation, we recommend that the following tools or their equivalents be used:

- Digital multi-meter, Fluke series 75, 76, 77 or equivalent.
- Oscilloscope, preferably storage-type (a storage scope is mandatory for high speed gearless adjustment).
- Hand-held tachometer.
- AC clamp-on ammeter.
- Assorted soldering tools, rosin flux solder, electronic side cutters, long-nose pliers, flashlight and the MCE screwdriver provided with controller.
- Test weights.
- Telephone connections and hand-held radios to support any necessary communication.
About MCE Job Prints

MCE Job Prints are technical drawing and instruction sets specifically generated for and accompanying each MCE installation. The job prints provide technical information and instruction specific to the installation using the survey information collected when the job was specified and initiated. Job prints are frequently referenced by installation instructions and are a critical resource for elevator installation and maintenance technicians.

Become familiar with the following information as well as the wiring prints provided with this control system.

Drawing Number Format - Each print has a drawing number in the title block. The drawing number contains the job number, car number and page number (see examples). In this manual the drawings will often be referred to by the last digit of the drawing number (page number).

![Diagram of drawing number format]

* Car Number “G” = Group Controller
** Page Number “D” = Drive Page, CT = iLink
** An “X” after the page number = auxiliary page

Note: Some drawings have a drawing name directly above the title block or at the top of the drawing. The drawing name may also be used to refer to a particular drawing.

MCE job print drawing numbers use the format “Job Number — Car Number — Drawing Identifier.” Thus they are specifically “keyed” to particular installations. It makes using and understanding job prints much easier if you take some time to review the job prints package before beginning controller installation. Drawing identifiers and the information you can expect to find on that job print drawing are listed below:

- **N**: Nomenclature drawing — schematic symbols, wire gauge information, circuit board names and symbols.
- **INT**: iLink cartop wiring interconnect box to controller connections.
- **CVR**: iBox controls and indicators.
- **1**: AC power connections, power bus information.
- **2 through nn**: iBox/controller wiring.
- **CC**: Contact Count drawing — System contact/relay information.
- **SH**: Serial Hall Call wiring.
- **CT**: Cartop wiring (iLink cartop wiring interconnect box).
- **COP**: Car Operating Panel to cartop box (iLink) wiring.
- **CW**: Car to cartop box (iLink) wiring.
- **MRW1, -MRW2**: Machine Room and Hoistway wiring.
- **D1, -D2, -D3, -D4**: Controller and drive wiring.
Note

Depending on your installation, you may have extra sheets of particular drawings. Extra sheets are indicated by an “x” following the drawing identifier. You may also have different or additional equipment in your installation accompanied by different or additional drawings in your job prints. In any case, take the time to become familiar with the job prints before beginning work.

Symbols

Every job print set contains a drawing depicting and describing schematic and other symbols used in the job prints. Review this page to acquaint yourself with symbols and their meanings.

Nomenclature

MCE documentation may refer to PC boards and other components by MCE part number. The following table lists these numbers and provides a brief description of each. Your installation may not use all of the boards listed.

Table 2.2 Component Nomenclature

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>ICE-IMP</td>
<td>iBox primary microprocessor board.</td>
</tr>
<tr>
<td>01</td>
<td>ICE-SAF</td>
<td>iBox safety board.</td>
</tr>
<tr>
<td>02</td>
<td>ICE-IRB</td>
<td>iBox Relay board.</td>
</tr>
<tr>
<td>03</td>
<td>ICE-I EQ</td>
<td>Earthquake and counterweight derailment sensor board.</td>
</tr>
<tr>
<td>04</td>
<td>ICE-SF-X</td>
<td>Serial Fixtures interface board (displays, annunciators, etc.).</td>
</tr>
<tr>
<td>05</td>
<td>ICE-IRD</td>
<td>Rear Door board.</td>
</tr>
<tr>
<td>06</td>
<td>ICE-RG</td>
<td>Rope gripper board. Used when a rope gripper is supported.</td>
</tr>
<tr>
<td>07</td>
<td>ICE-COP</td>
<td>Serial Car Operating Panel board.</td>
</tr>
<tr>
<td>08</td>
<td>ICE-CTP</td>
<td>iLink (Cartop) primary microprocessor board.</td>
</tr>
<tr>
<td>09</td>
<td>ICE-EB</td>
<td>Emergency Brake Board</td>
</tr>
<tr>
<td>32</td>
<td>ICE-MIAC</td>
<td>Input expansion board. Used as needed in iControl and the iLink cartop box to support equipment inputs.</td>
</tr>
<tr>
<td>50</td>
<td>ICE-MOT</td>
<td>Output expansion board (not currently used).</td>
</tr>
<tr>
<td>51</td>
<td>ICE-MOR</td>
<td>Output expansion board. Used as needed in iControl and the iLink cartop box to support equipment outputs.</td>
</tr>
<tr>
<td>80</td>
<td>ICE-L CB</td>
<td>Low Current Brake board, used in low current braking applications.</td>
</tr>
<tr>
<td>85</td>
<td>SC-ION</td>
<td>Serial Control I/O Node board.</td>
</tr>
</tbody>
</table>
Controller Cabinet Installation

Note
It is very important that you review the wiring guidelines in this section before bringing wires into the controller.

Caution
When drilling or cutting access holes or during other machining, do not allow any metal chips to fall into the electronics. Keep drive or other covers in place while wiring to prevent damage to components.

1. Mount cabinets securely to the machine room floor.
2. Cut holes to permit bringing wires in as shown in the following illustration.

MCE applies labels inside the cabinet to identify suggested wiring hole locations. The MCE controller cabinet does not require rear access.

• Field wiring should enter the cabinet from the side at the lower left corner or from the bottom directly under the wiring trough. **The wires must be routed through the wiring trough on the left side of the controller cabinet in a way that allows the power box door to open fully.**

• All conductors entering or leaving the controller cabinet must be through conduit. High voltage, high current conductors, such as power conductors from the fused disconnect or isolation transformer, must be separated from control wires. It is essential that Tachometer/Velocity Encoder control wires be routed through a separate conduit away from high current conductors.

• The traveling cable must have at least four twisted shielded pairs to be used for the position pulser quadrature signal and the **iLINK** communication link from the Car Top Processor board (ICE-CTP) to the **iBox** Safety Processor board (ICE-SAF). The shielded cable should be used all the way to the controller. If there are more shielded pairs still available, route the ULM, DLM and DZ signals from the iLink Car Top Processor board through a shielded pair (especially if the building has more than eight floors). The shields must be grounded at both ends by connecting them to a “SHLD” terminal.
PC boards can be easily damaged by electrostatic discharge (ESD). Use a properly grounded wrist strap or other static protection when handling, touching, or making connections to PC boards.
Overview of Typical Connection Locations

The following diagram provides a general overview of component and connection locations inside iControl. Because circuit boards in iControl are connected along a common bus, they may be arranged differently or different boards may be used in different installations. Therefore, specific connections might be in a location other than the one shown. This is only a general overview. This is only a general overview. Use it in conjunction with the job prints when making electrical connections. Please refer to “iBox Field Connections” on page 11-7 for a list of specific inputs and outputs.

Field wiring for hoistway, car, landing and load weighing systems, and discrete hall calls are all on the left edge of the controller.

High voltage connections are primarily on the right side of the cabinet under the motor drive.

Outputs used to drive customer peripherals. Signal/Pin assignments made in iView screens.

Customer peripheral inputs (card readers, etc.) Signal/Pin assignments made in iView screens.

CE serial fixture interface. Floor indicators, etc.

Earthquake sensor I/O.

Tachometer, position encoder, velocity encoder, and serial link from cartop processor.

Discrete car connections, limit switches, hoistway, and door system connections.

Safety I/O. Spare I/O. Common, 120VAC, and 110VDC buses.

Emergency Brake connection

Rear door processing
Equipment Grounding

For good grounding, quality wiring materials and methods must be used. Grounding must conform to all applicable codes. Proper grounding is essential for system safety and helps to reduce noise-induced problems.

General grounding guidelines include:

- Provide equipment grounding in accordance with NEC Article 250 and/or the local electrical code, as applicable.
- The grounding wire between equipment cabinets may follow a branching or daisy-chain configuration, but the wire must terminate at the last controller and NOT loop back.
- You must provide a direct, solid ground to the controller and motor. An indirect ground, such as the building structure or a water pipe, may not provide proper grounding and could act as an antenna — radiating RFI noise and interfering with electronic equipment in the building.
- The conduit containing the AC power feeders must not be used for grounding.

Figure 2.2 Controller Cabinet Ground Wiring
Equipment Grounding

Figure 2.3   Isolation Transformer, Drive, and AC Motor Ground Wiring

[Diagram showing the connection between Drive Isolation Transformer (if used), AC Drive, AC Motor, and Ground Lug in the MCE Controller Cabinet.

Note: Grounding of the WYE secondary of the Drive Isolation Transformer should be accomplished according to the drive manufacturer recommendation.

The grounding instructions provided in the job prints are specific to your job and are the controlling document if any question arises.
Check for Shorts to Ground

Check for shorts to ground before powering up the system. **Power must be OFF at the main disconnect.** If any shorts to ground are discovered, they must be corrected before proceeding. A short to ground is defined as having a resistance of less than 20 ohms between the #1 (Common) bus and the terminal being tested.

**Danger**
Be certain that power is OFF at the main disconnect before proceeding.

**Caution**
Typically, the iLink cartop box has not been installed at this point. If the cartop box has been installed **and connected**, it MUST be disconnected before checking for shorts in the controller cabinet. This is easily done by simply unplugging all field-wired connectors in the cartop box before checking for shorts to ground.

1. Using a standard screwdriver, temporarily disengage all fuses at the top of the iPower box by turning them counterclockwise until they pop up. **Don’t place a cap on a fuse holder without a fuse in it. The cap can get stuck and be hard to remove.**

2. Disengage all fuses at the bottom of the iBox (just below the logo).
3. Release the screws that hold the iPower box closed and open the enclosure. Disengage all the fuses from the fuse block inside (towards the top of) the iPower box by lifting them clear of their sockets at one end.
4. Measure the resistance between the iBox #1 (Common) bus and terminals that have a field connection (DZ down to SP4 on the left side of the iBox).
5. Measure the resistance between the #2 (120VAC) bus terminals and the #1 bus.
6. Measure the resistance between the #3 (110VDC) bus terminals and the #1 bus.
7. Check for shorts to ground on motor power terminals L1, L2, and L3.
8. Check for shorts to ground on brake terminals B1 and B2.
9. If no shorts to ground are discovered, re-engage the fuses. Refer to the job prints for fuse location if necessary.
AC Voltage Verification and Wiring

Instructions in this section describe wiring from commercial power to iControl. Most of the technical information is in the MCE job prints and referenced here as necessary. As shown in the job prints, an isolation transformer may be used to clean up “dirty” commercial power, shift voltage levels, and prevent noise from electrical equipment from being introduced back into the building power system. Isolation transformers are specified in some, but not all, installations.

AC Voltage Verification and Wiring instructions include:

- Verifying main line power and wiring the controller
- Initial power up

Note

All conductors entering or leaving the controller cabinet must be in conduit. High voltage, high current conductors, such as power conductors from the fused disconnect or isolation transformer, must be separated from control wires. It is essential that tachometer/velocity encoder control wires be routed through a separate conduit away from high current conductors.

Incoming power to the controller and outgoing power wires to the motor must be in their respective grounded conduit.

Most iControl AC installations use an iField Brake Module to provide selective voltages to precisely control brake picking, brake hold, brake application, and brake timing. In these cases, the job print details for AC input wiring from the transformer may include auxiliary connections specifically for the brake input power connections. Read and follow the job prints carefully.
Verifying Main Line Power and Wiring the Controller

1. Consult the job prints. Verify that AC supply is as specified.

Note

Proper motor branch circuit protection in the form of a fused disconnect switch or circuit breaker must be provided for each elevator according to applicable electrical code. Each disconnect or breaker must be clearly labeled with the elevator number. The electrical contractor must determine the wire size for the main AC power supply and for the wiring from the disconnect or breaker to the drive isolation transformer.

2. If the car is part of a group, the cars in the group must also be wired to provide power to the group cabinet. If this is the case, refer to the Group Supervisor Field Wiring Print in the job prints. Group power is provided by the car controllers as shown in drawing -2. The main AC power supply wiring size must be determined by the electrical contractor.

2a. Check the phase-offset of the individual car ST2-bus lines before connecting them to the Group cabinet. Use a voltmeter set to AC volts to measure between adjacent car ST2-bus terminals in the Group cabinet. The meter must read less than 10VAC. If the reading is higher, reverse the power leads going to the car T1 transformer at L1 and L2 and measure again.

Caution

All 2 bus power from car to Group cabinets must be in phase. Connecting out-of-phase power WILL cause damage.

2b. A separate conduit or wiring trough must be provided for the System (car-to-car) Ethernet network. Wiring is fully detailed in the job prints. These details must be followed exactly.

2c. If applicable, also wire according to the Group Interconnects to Individual Car Cabinets print. Be sure to ground all cabinets according to instructions.

2d. Refer to the iCentral (Group Supervisor) Field Wiring Print for Group Controller field wiring instructions.

3. If an isolation transformer is used, connect AC supply wiring to the transformer, and transformer outputs to the controller, as shown in the job prints. If required, the prints will detail auxiliary power connections for the brake iField module.

4. If no isolation transformer is used, connect AC supply wiring to the controller as shown in the job prints.
Initial Controller Power Up

After AC power is connected, you are ready to temporarily power up the controller and check to see that power buses inside the controller cabinet are providing their proper outputs.

**Caution**

This procedure assumes that no field wiring has been connected to the controller. If field wiring has been connected, disconnect it before beginning this procedure. Before applying power, physically check all power resistors and other components located in the resistor and controller compartments. Components loosened during shipment may cause damage.

1. On the iBox, verify:
   - Inspection switch UP (Inspection mode selected)
   - Controller Stop Switch DOWN (Stop selected)
   - Test switch ON
   - All other iBox slide switches DOWN (Off)

These switch settings prevent the elevator from moving when the controller is powered up.

**Note**

The controller microprocessor board has battery backup for logic retention. An insulator prevents the battery from discharging during shipment. Remove the insulator now if has not already been done.
2. Power up the controller. The system will take about sixty seconds to boot.
3. If the controller fails to power up, refer to the job prints and check supply connections and fuses.

Inside the controller cabinet, 120VAC and 110VDC output buses are presented at the lower left corner of the iBox as shown in the illustration below.

4. Measure from any #2 bus terminal to a Common (#1) terminal and verify 120VAC (+/- 10%).
5. Measure from any #3 bus terminal to a Common (#1) terminal and verify 110VDC (+/- 10%).

Power for PC board circuitry is provided through a 5-position, pluggable connector on the right side of the iBox (near the Computer and Drive Reset buttons) as shown below.

6. Measure from each of the voltage terminals to GND to verify -15VDC, +15VDC, and +5VDC respectively (+/- 2%). Note: Place meter on AC range and check each supply to ensure AC voltage does not exceed 0.050 VAC.

7. Power the controller down (in preparation to continue wiring equipment).
AC Hoist Motor, Brake, and Velocity Encoder

This section contains instructions for:

- Checking the hoist motor for insulation breakdown or short to ground
- Wiring the hoist motor to the controller
- Verifying iField module or low-current brake resistance and wiring the brake
- Installing the velocity encoder

Checking the Hoist Motor

If this job reuses existing rotating equipment, the equipment must be checked for insulation breakdown before proceeding.

1. Disconnect all motor and brake wiring.
2. Perform an insulation test between these wires and the frame of the related equipment using a Megohm meter to subject the insulation to the same high voltages that would be present during elevator operation.
3. A minimum insulation resistance of 100k Ohms is required.
4. Correct any insulation problems before proceeding with installation. Insulation problems may indicate a serious problem in the equipment.

Wiring the Hoist Motor to the Controller

Incoming power to the controller and outgoing power wires to the motor must be in their respective grounded conduit.

It is very important that AC motor wires be kept separate from control wires both inside and outside the controller cabinet. The encoder or tachometer wiring must use a separate grounded conduit. Use a shielded power cable between the motor drive and the AC Motor stator connections to reduce RFI/EMI noise (Siemens Prototflex - EMV or equivalent). The shield must be terminated to earth ground at both ends. Keep the AC power wiring separate from the control wires.

1. Refer to drawing -D1 in the job prints. This drawing shows the AC drive and connections to rotating equipment.
2. Make connections as shown in the job prints. Be certain to follow any schematic notes regarding wire sizes and any specific motor wiring connections.
**Verifying Brake Current Resistance**

High current brake systems use a brake (iField) module to control the brake.

1. With the brake leads disconnected from the controller, measure resistance through the brake coil.
2. Inside the controller cabinet, locate the screws, one at the top and one at the bottom right corner of the iPower box (the enclosure the iBox is mounted to). Turn the screws counter-clockwise to their stops and open the enclosure (it is hinged on the left).
3. Refer to job print drawing D2. Toward the right-top of the enclosure, locate the large ceramic resistor labeled RB.
4. Check the resistance across RB. As an initial working value, RB resistance should be about three times (3 X) the resistance measured across the brake coil.

**Note**

During adjustment, the resistance across RB may be further adjusted to achieve smooth setting of the brake. Too little resistance causes the brake to remain picked for too long. Refer to your job prints for instructions.

5. If necessary, adjust RB resistance by loosening and sliding the center-tap up or down. When the resistance is correct, retighten the center tap.
Wiring the Brake

1. Refer to job print drawing D3. Connect brake wires to terminals B1 and B2 located just below the iPWR box.

Note

Brake wires must not be routed in the same conduit with AC motor wires or velocity encoder wires.
Velocity Encoder Installation and Wiring

The velocity encoder reports hoist motor speed to the controller. The encoder must be mounted and wired according to the drawings. When installed, the encoder must be electrically isolated from the motor or any other ground. (Resistance between the encoder casing and the motor or other ground should be “infinite.”)

Do not place the encoder or its wiring close to a magnetic field (the motor or brake coils). Magnetic fields can induce AC into the encoder signal. This can cause the Drive to miscount, producing erratic control at lower speeds.

Note

The encoder wiring must use a separate grounded conduit. Inside the controller cabinet, if control wires must cross power wires, they must cross at right angles to reduce the possibility of interference. Some cables, like the EnDat encoder cable, require a one inch or larger conduit due to the size of the connector.

Encoder Mounting

The following illustration shows two typical encoder installations.

Figure 2.4 Typical Encoder Installations
It is very important that the encoder does not slip, wobble, bounce, or vibrate due to poor installation of the shaft extension, coupling, or encoder mounting. It is also important that the encoder housing be electrically insulated from the motor, machine or other grounds if the encoder is manufactured by BEI. An insulated encoder mount has been furnished with the BEI encoder. However, this type of mounting may not be practical for all applications, therefore, the best method for mounting the encoder and coupling it to the motor must be determined at the job site.

**Encoder Isolation**

The encoder housing must be electrically isolated from the machine (ground). To check this:

1. Measure the resistance between the encoder case and the frame of the motor.

The measured value must be “infinite” for complete isolation.

**Encoder Wiring**

A shielded cable with an appropriate connector at the encoder end is provided. Please refer to “Encoder Cables” on page 2-24. The controller end of the cable exposes trimmed and tinned individual conductors. The encoder cable must be routed into the controller cabinet in a separate conduit.

1. Connect the cable to the encoder using the cable/connector provided.
2. Route the cable through a separate conduit to the controller cabinet. Inside the controller cabinet, if the encoder wires must cross power wires, they must cross at right angles to reduce the possibility of interference.
3. Connect the controller end of the cable to the TORQMAX F5 drive as shown in the job prints.

**Caution**

Do not coil excess encoder cable near high voltage components — noise may be induced. If the cable must be shortened, trim it at the controller end. Do not cut and re-splice in the middle of the cable or shorten at the encoder end (see also caution below).

**Caution**

The cable supplied with the Heidenhain ENC1313 EnDat encoder must not be altered, cut or shortened. Therefore, a 1.5 inch conduit is required to accommodate the cable connector.

**Caution**

Permanent magnet (PM) AC Gearless Machines must by synchronized with the AC Drive. Please refer to *PM Synchronous Motors > Motor Data* and *Loading motor data from encoder* in the *Initial Start Up* section of the TORQMAX F5 drive manual.
**Encoder Cables**

The following illustration shows typical encoder wiring. These connections are shown for illustration purposes only. Follow the job print instructions for your specific encoder connections — they may be different than those shown here.

**Induction Machine**

**PM Machine**

- No connection for shield at this end
- Encoder is mounted on the motor shaft

---

2-24 Manual # 42-02-2222
Basic Safety String and Associated Wiring

This section contains wiring instructions for basic safety string switches (in Construction Mode, before the iLink cartop interconnect is installed). A safety string is essentially a number of normally-closed switches connected in series such that, should any one of the switches open, power to the motor and brake will immediately drop to stop the car. Depending upon your installation, you may not have the exact switches described here. The job prints for your installation accurately show the safety string elements at your site. In any event, the elevator must not be run until the safety string is connected. Safety string wiring includes:

- Emergency Stop switch
- Hoistway safety switches
- Cartop safety CTS Relay temporary bypass (for Construction Mode use only)

The location and number of safety switches varies from job to job. MCE job prints indicate exact job wiring as determined during the job survey. Please refer to “Safety Bypass Jumper and Fuses” on page 7-13 for bypass related information.

Cartop Safety Switches

Depending upon the job, cartop safety switches may include:

- Safety Clamp Switch
- Emergency Exit Contact
- Emergency Stop Switch
- CTS Relay (iLink)

The wiring instructions for these switches are on the job prints.

1. Refer to the job prints.
2. Wire the cartop safety switches as shown.

Note

The Cartop Safety Relay is located in the cartop interconnect box. If the cartop box is not yet installed, it will need to be temporarily bypassed to get the car operating in construction mode. For now, using the switches and terminals available to you, wire as much of the string as you are able.
**Construction Mode**

**Hoistway Safety Switches**
Depending upon the job, hoistway safety switches may include:
- Final Limit Switches
- Buffer Switches
- Pit Door Switch
- Pit Stop Switch
- Governor Switch

The wiring instructions for these switches are on the job prints.
1. Refer to the job prints.
2. Wire the hoistway safety string switches as shown.

**Temporary CTS Relay Bypass**
Because the iLink cartop interconnect box which contains the Cartop Safety (CTS) Relay is not yet installed, it is necessary to bypass the CTS relay temporarily (for Construction Mode only). (If you in fact are installing the iLink cartop box already, please refer to the iLink instructions in Section 3 of this guide.)
1. Refer to the job prints.
2. Connect the safety string in series between the iBox SAFH and SAFC terminals.
3. You must provide an Emergency Stop switch in series between SAFH and SAFC.

⚠️ **Danger**
Make sure the Emergency Stop switch is wired in series between SAFH and SAFC to allow emergency stopping while working on the cartop.

**Access Locks and Contacts**
Door switches include:
- Car door: GS (Gate Switch).
- Hall doors: DLMS (Door Lock Main String), DLAT (Door Lock Access Top), DCAT (Door Contact Access Top), DLAB (Door Lock Access Bottom), DCAB (Door Contact Access Bottom).

1. Refer to the job prints.
2. Connect the switches for front and rear (if present) doors as shown.
Rope Gripper Wiring
An “emergency brake” may be connected between iControl terminals RG1 and RG2 to stop unexpected car motion. A rope gripper is used to apply braking pressure to the hoist ropes. After it is triggered, press the iBox Fault Reset button or the Rope Gripper board reset button to reset the rope gripper.

1. Refer to the job prints (MRW- machine room wiring sheets).
2. Connect the rope gripper to iControl RG1, RG2, RG5, and RG7 terminals as shown.

Temporary Rope Gripper Bypass
If a Rope Gripper will be installed later, you may temporarily bypass the input by installing a jumper between RG5 and RG7.

Temporary Cartop Inspection Wiring
Four cartop switches control car motion:
An Inspection Enable switch, a Safe switch, an Up switch, and a Down switch.

1. Refer to job print drawing -CW, Cartop Inspection Station.
2. Connect the (Normally Closed) Cartop Inspection Enable switch between the #3 bus and the iControl INCT terminal as shown. (This is the switch used to put the controller on cartop inspection. INCT is active low.)
3. Connect a Safe push button switch between the #3 bus and the direction push buttons.
4. Connect a Down push button switch between the Safe switch and the iControl ICTD terminal as shown (active high).
5. Connect an Up push button switch between the Safe switch and the iControl ICTU terminal as shown (active high).

Applying Power
1. Set the iBox Inspection switch to the Inspection position.
2. Set the Controller Stop switch to the Stop position.
3. Set the Test switch to On.
4. Turn on power at the main disconnect.
5. Watch the front panel displays of the iBox, the controller will take about 60 seconds to initialize.
6. Check the iBox Computer, Safety A, and Safety B status LEDs. The LEDs should be lighted solid green.
Setting Initial Operating Parameters

Once all Construction mode connections are complete, certain iControl parameters must be set or verified. These settings must be accomplished using a computer running iView software.

The iBox may be accessed using iView or the iBox keypad. However, both are not allowed to make changes at the same time. By default, the iBox keypad has control but once an iView user has acquired write privileges (*Privilege/Acquire*) the keypad is prevented from making changes until the iView user relinquishes the write privilege.

Connecting the iView PC

Please refer to “Installing iView” on page 8-3 if you have not yet installed iView on your PC.

There are two ways to connect the iBox to a PC:

- **Direct Connection:** Connect the PC directly to the iBox through the iBox 3=PC port. Please refer to “Direct Connections” on page 2-33.
- **Peripheral LAN Connection:** Connect the PC to the LAN hub supporting one or more iBox controllers (iBox #1 port). If you are connecting to multiple iControls, please refer to the *iCue User Guide* that accompanied the group controller for LAN instructions.

The illustration and table on the following pages provide examples of the factory default Ethernet addresses used by iControl and iCue groups.

Note

About LANs: LAN stands for Local Area Network. A LAN is basically several computers (or smart equipment with a computer inside — like the iBox) all connected to a common point (the hub) so they can communicate with each other. In order for a message from one computer to reach the computer (or iControl/iBox) it wants to talk to, all the computers connected to the LAN have to have their own address. The address is called a TCP/IP number. Please refer to “System and LAN Ethernet” on page 11-15 for more detail.
Caution

Before connecting the “System” ethernet cable to the iBox:

1. Verify that the Car ID, in the upper right corner of the iBox display, is correct. Press the iBox “Computer Reset” button and when the display returns, verify that Car ID is still correct. The Car identifier is set on the iView > Controller > Configuration > General tab (see “Configuration - General” on page 9-97).
2. Verify that no other iBox in this group of controllers has the same Car ID (see Figure 2.8).
3. Check the “Alternate Dispatcher” settings on the iView > System > System Configuration > Building tab (see “System Configuration tab” on page 10-6). Verify that the “Auto-select Preference Order” settings are identical on every car in this group of controllers (see Figure 2.8).

Figure 2.5 Check before connecting the “System” ethernet cable to the iBox

Check for correct Car ID. Verify that no two Car IDs in the group are the same.

On the iView > System > System Configuration > Building tab, verify that the Alternate Dispatcher “Auto-select Preference Order” settings are identical for all cars in the group.
Figure 2.6 Controller and Group Ethernet Examples

GROUP 1 ETHERNET ADDRESS EXAMPLES

CAR A
192.168.193.001
3 = PC

CAR B
192.168.192.001
2 = SYSTEM

CAR C
192.168.191.001
1 = LAN

CAR D
192.168.193.001
3 = PC

CAR E
192.168.193.001
3 = PC

192.168.193.001
192.168.192.001
192.168.191.001

CAR A
192.168.193.001
3 = PC

CAR B
192.168.192.002
2 = SYSTEM

CAR C
192.168.191.002
1 = LAN

CAR D
192.168.193.001
3 = PC

CAR E
192.168.193.001
3 = PC

192.168.193.001
192.168.192.002
192.168.191.002

CAR A
192.168.193.001
3 = PC

CAR B
192.168.192.003
2 = SYSTEM

CAR C
192.168.191.003
1 = LAN

CAR D
192.168.193.001
3 = PC

CAR E
192.168.193.001
3 = PC

192.168.193.001
192.168.192.003
192.168.191.003

CAR A
192.168.193.001
3 = PC

CAR B
192.168.192.004
2 = SYSTEM

CAR C
192.168.191.004
1 = LAN

CAR D
192.168.193.001
3 = PC

CAR E
192.168.193.001
3 = PC

192.168.193.001
192.168.192.004
192.168.191.004

CAR A
192.168.193.001
3 = PC

CAR B
192.168.192.005
2 = SYSTEM

CAR C
192.168.191.005
1 = LAN

CAR D
192.168.193.001
3 = PC

CAR E
192.168.193.001
3 = PC

192.168.193.001
192.168.192.005
192.168.191.005

Swing Car Hall Calls

Serial Hall Call Driver

Isolation Board

Serial Hall Call

Serial to Ethernet

Hall Call Driver

Serial to Ethernet

Hall Call Driver

Serial to Ethernet

Hall Call Driver

Group 1 SYSTEM HUB

192.168.192.211
192.168.192.212
192.168.192.213
Setting Initial Operating Parameters

SYSTEM HUB

LAN HUB

ORANGE CABLES

BLUE CABLES

iView, Direct
PC used for Direct Connection
192.168.193.2
255.255.255.0 Subnet Mask
0.0.0.0 ( . . . ) Gateway

iCue Group Controller
iCue SYSTEM
192.168.192.201
255.255.255.0 Subnet Mask
192.168.191.254 Gateway

iView, LAN
PC used for LAN Connection
192.168.191.101
255.255.255.0 Subnet Mask
192.168.191.254 Gateway

192.168.192.214
Serial to Ethernet

Hall Call Driver
The table below lists the factory default addresses for elevator and group controllers. The #3 iBox port (PC=Direct) is set to 192.168.193.001 and should not be changed. Do not use leading zeros when setting IP Addresses on a PC (i.e., .021 is entered as .21). (When entering IP Addresses on the iBox keypad, you must use leading zeros.)

Table 2.3 System, LAN, & 3=PC TCP/IP Addresses

<table>
<thead>
<tr>
<th>Hub</th>
<th>Group</th>
<th>Group IP Primary &amp; Backup</th>
<th>Car ID</th>
<th>Car IP</th>
<th>System/Serial Hall Call Bus 1 - 4</th>
<th>Free</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port #3 = PC (iBox ONLY), NO HUB</td>
<td></td>
<td></td>
<td></td>
<td>192.168.193.001</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* 192.168.191.101 is typically used for the iView PC.
The default Subnet Mask for all ports is 255.255.255.000.
Please refer to “Setting iBox Ethernet Port Addresses” on page 7-9 for instructions on checking IP settings on the iBox.
Direct Connections

Unless a Local Area Network (Ethernet) hub has already been installed, you will find it easiest to connect a PC to the iBox using the #3 PC port on the iBox (direct connection). To make a direct connection:

1. Connect the iView PC to the controller 3=PC port using only a standard Ethernet cable. (Do not connect the #3 port through a hub or router.)

Figure 2.8 Ethernet Cable and iBox Ethernet Ports

![Diagram of Ethernet cable and iBox ports]

Typical ethernet CAT-5 shielded cable. RJ45 connectors at each end.

Note

The iBox #3 Ethernet port address, gateway, and mask are set to default values by MCE. If you have used your PC to connect to other iBoxes, you probably only need to connect the cable, launch iView, and select the connection with the appropriate IP information and use that to connect. When creating direct connections in the iView connections folder, it is a good practice to name them clearly so they are easy to distinguish (i.e., “CarA Direct”). The instructions here are intended to help a first-time user make a direct Ethernet connection between a PC and the iBox.
2. Start the PC.
3. From the Windows XP Start menu, click Control Panel.
4. Double-click Network and Internet Connections to open the Network and Internet Connections dialog.
5. Double-click Network Connections to open the Network Connections dialog.
6. Double-click the Local Area Connection icon to open the Local Area Connection Status dialog.
7. Click Properties to open the Local Area Connection Properties dialog.

Note

Sample screens are Windows XP™ operating system.
8. In the Local Area Connection Properties dialog, select *Internet Protocol (TCP/IP).*
9. Click *Properties* to open the Internet Protocol (TCP/IP) Properties dialog.
10. Set the IP Address to match the iBox EXCEPT FOR the last set of numbers. The #3 iBox port is defaulted to 192.168.193.1. Typically, you can set your PC’s IP address to 192.168.193.2.

![Internet Protocol (TCP/IP) Properties]

11. Set the Subnet Mask to 255.255.255.0.
12. Click OK and follow any instructions to save the changes you made.

**Note**

Sample screens are Windows XP™ operating system.

**Note**

It is important that a PC have only one IP address assigned. Click the Advanced button and verify that the PC is configured for only a single IP address (192.168.193.2). If there is more than one IP address, highlight the additional IP address and then click Remove.
Creating a Direct Connection in iView

Once you have set your computer TCP/IP as described previously, you need to create a connection in iView.

1. Double-click on the iView icon on your computer screen to launch iView.
2. Click File on the menu bar.
3. Select Connection and click New to open the Connection dialog.

![iView interface]

4. Type in a name for the connection.
5. Enter the direct connection IP Address for the iBox (192.168.193.1).
6. Select Controller/Simplex. If creating a connection to an iCue PC, select Group and PC.
7. Click OK. The Save As dialog opens.
8. Enter a *File name* for this connection in the Save As dialog.

9. The suggested (default) location for connections is the *Connections* folder (My Documents > Motion Control Engineering > iView > Connections). You may choose another location using standard windows methods. You may also create sub-folders inside the iController Connections folder in which groups of connections can be stored.

10. Click *Save* to save the connection.
Connecting to the iBox Once the connection is created and saved, you are ready to connect.

1. Click File on the menu bar.
2. Select Connection and click Open. The Open dialog appears.

3. To connect to a controller, double click the desired connection.
4. When iView is communicating with a controller, this symbol is displayed in the bottom left corner of the iView screen.
5. When iView is not communicating with a controller, this symbol is displayed in the bottom left corner of the iView screen.
6. When the connection is established, the Operational Status tab and Hoistway window are displayed.
Verifying Initial Parameter Settings

If necessary, use the operating descriptions in Section 5 to become familiar with using iView and the iView screen descriptions in Section 9. Refer to Table 2.5 on page 2-50 for recommended initial settings.

1. Launch iView and connect to the iController.
2. Once connected, select Acquire from the Write privilege menu. This is necessary to allow iView to change parameters on the iController. (Note that, when you initially request privileges during each connection session, someone in the machine room must press the “yes” button on the iBox to grant those privileges.)
3. From the View menu, select Layouts and click Configuration.
4. Select the Pattern tab. If the Pattern tab is not displayed, select Pattern from the View > Configuration menu.
5. On the Pattern > Modes tab, verify the Common, Standard, and Inspection profile settings. Refer to Table 2.4 on page 2-42. Pattern shape preset can be used to enter preset values for the Standard profile parameters based on the high speed (contract speed) of the elevator and the selected shape type (Slow, Moderate or Fast). This provides an excellent starting point. Please refer to “Pattern shape preset” on page 9-135.
6. Edit and Send changes to iControl as needed.
7. Select the General tab. If the General tab is not displayed, select General from the View > Configuration menu.
8. On the General > General tab set the Simplex car selection as appropriate (see Table 2.4 on page 2-42). DO NOT ENABLE Simplex if the car is part of a group.
9. Edit and Send changes to iControl as needed.
10. Select the Drive tab. If the Drive tab is not displayed, select Drive from the View > Configuration menu.
11. On the Drive > General tab, verify the Drive type.
12. On the Drive > Safety tab, verify Following error (default 25%, final adjustment procedure in Section 4 of this guide). Refer to Table 2.4 on page 2-42 and the Reference section of this manual (Section 9) for detailed descriptions.
13. Edit and Send changes to iControl as needed.

Note

If you change the drive type, you must press Computer Reset on the iBox so that iControl can “detect” the change on power up.

14. Select the Setup > Safety > Configuration tab and verify that Construction Mode is checked.
15. Edit and Send changes to iControl as needed.
Table 2.4  Recommended iView Starting Values for Initial Operation

<table>
<thead>
<tr>
<th>iView Screen Settings</th>
<th>Pattern &gt;Common tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position Encoder</td>
<td>348 if iLand-x-C Compact Landing system. 256 if iLand-x-H Landing system. Otherwise, consult manufacturer documentation.</td>
</tr>
<tr>
<td>Resolution</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Job Contract Speed</th>
<th>200 fpm</th>
<th>350 fpm</th>
<th>400 fpm</th>
<th>500 fpm</th>
<th>600 + fpm</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pattern scaling</td>
<td>100%</td>
<td>100%</td>
<td>100%</td>
<td>100%</td>
<td>100%</td>
<td>%</td>
</tr>
<tr>
<td>Door pre-opening dis.</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>inches</td>
</tr>
<tr>
<td>Leveling speed</td>
<td>005</td>
<td>005</td>
<td>005</td>
<td>005</td>
<td>005</td>
<td>fpm</td>
</tr>
<tr>
<td>Releveling speed</td>
<td>008</td>
<td>008</td>
<td>008</td>
<td>008</td>
<td>008</td>
<td>fpm</td>
</tr>
<tr>
<td>Leveling distance</td>
<td>1.20</td>
<td>0.72</td>
<td>0.60</td>
<td>0.60</td>
<td>0.60</td>
<td>inches</td>
</tr>
<tr>
<td>Releveling distance</td>
<td>0.60</td>
<td>0.60</td>
<td>0.60</td>
<td>0.60</td>
<td>0.60</td>
<td>inches</td>
</tr>
<tr>
<td>Dead zone distance</td>
<td>0.25</td>
<td>0.25</td>
<td>0.25</td>
<td>0.25</td>
<td>0.25</td>
<td>inches</td>
</tr>
<tr>
<td>Relevel dead zone dis.</td>
<td>0.15</td>
<td>0.15</td>
<td>0.15</td>
<td>0.15</td>
<td>0.15</td>
<td>inches</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pattern &gt; Modes tab — Standard Profile</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Job Contract Speed</th>
<th>200 fpm</th>
<th>350 fpm</th>
<th>400 fpm</th>
<th>500 fpm</th>
<th>600 + fpm</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial jerk</td>
<td>6.00</td>
<td>6.00</td>
<td>5.00</td>
<td>5.00</td>
<td>6.0</td>
<td>ft/s³</td>
</tr>
<tr>
<td>Acceleration</td>
<td>2.40</td>
<td>3.20</td>
<td>3.40</td>
<td>3.60</td>
<td>3.80</td>
<td>ft/s²</td>
</tr>
<tr>
<td>High toll jerk</td>
<td>6.00</td>
<td>6.00</td>
<td>5.00</td>
<td>5.00</td>
<td>4.00</td>
<td>ft/s³</td>
</tr>
<tr>
<td>High speed</td>
<td>200</td>
<td>350</td>
<td>400</td>
<td>500</td>
<td>600</td>
<td>ft/min</td>
</tr>
<tr>
<td>Low roll jerk</td>
<td>6.00</td>
<td>6.00</td>
<td>5.00</td>
<td>5.00</td>
<td>4.00</td>
<td>ft/s³</td>
</tr>
<tr>
<td>Deceleration</td>
<td>2.20</td>
<td>2.90</td>
<td>3.20</td>
<td>3.30</td>
<td>3.50</td>
<td>ft/s²</td>
</tr>
<tr>
<td>Flare jerk</td>
<td>3.00</td>
<td>3.00</td>
<td>3.00</td>
<td>3.00</td>
<td>3.00</td>
<td>ft/s³</td>
</tr>
<tr>
<td>Approach deceleration</td>
<td>1.50</td>
<td>1.50</td>
<td>1.50</td>
<td>1.50</td>
<td>1.50</td>
<td>ft/s²</td>
</tr>
<tr>
<td>Approach jerk</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>ft/s³</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pattern &gt; Modes tab — Inspection Profile</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Job Contract Speed</th>
<th>200 fpm</th>
<th>350 fpm</th>
<th>400 fpm</th>
<th>500 fpm</th>
<th>600 + fpm</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial jerk</td>
<td>6.00</td>
<td>6.00</td>
<td>5.00</td>
<td>5.00</td>
<td>6.0</td>
<td>ft/s³</td>
</tr>
<tr>
<td>Acceleration</td>
<td>2.40</td>
<td>3.20</td>
<td>3.40</td>
<td>3.60</td>
<td>3.80</td>
<td>ft/s²</td>
</tr>
<tr>
<td>High roll jerk</td>
<td>6.00</td>
<td>6.00</td>
<td>5.00</td>
<td>5.00</td>
<td>4.00</td>
<td>ft/s³</td>
</tr>
<tr>
<td>High speed</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>ft/min</td>
</tr>
<tr>
<td>Low roll jerk</td>
<td>6.00</td>
<td>6.00</td>
<td>5.00</td>
<td>5.00</td>
<td>4.00</td>
<td>ft/s³</td>
</tr>
<tr>
<td>Deceleration</td>
<td>2.20</td>
<td>2.90</td>
<td>3.20</td>
<td>3.30</td>
<td>3.50</td>
<td>ft/s²</td>
</tr>
<tr>
<td>Flare jerk</td>
<td>3.00</td>
<td>3.00</td>
<td>3.00</td>
<td>3.00</td>
<td>3.00</td>
<td>ft/s³</td>
</tr>
<tr>
<td>Approach deceleration</td>
<td>1.50</td>
<td>1.50</td>
<td>1.50</td>
<td>1.50</td>
<td>1.50</td>
<td>ft/s²</td>
</tr>
<tr>
<td>Approach jerk</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>ft/s³</td>
</tr>
<tr>
<td>Low speed</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>ft/min</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>General &gt;General tab</th>
</tr>
</thead>
</table>

| Simplex car          | Set to Simplex if the car is NOT in a group to enable dispatch and parking screens (limited group functionality for a single car). |
### Setting Initial Operating Parameters

**Table 2.4  Recommended iView Starting Values for Initial Operation**

<table>
<thead>
<tr>
<th>iView Screen Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Drive &gt; General tab</strong></td>
</tr>
<tr>
<td>Drive Type</td>
</tr>
<tr>
<td>Speed Reference</td>
</tr>
<tr>
<td>Speed reference scaling</td>
</tr>
<tr>
<td>Speed ref resolution</td>
</tr>
<tr>
<td>Rated motor RPM:</td>
</tr>
<tr>
<td>Coupling rotational ratio</td>
</tr>
<tr>
<td>Normal rate limited stop</td>
</tr>
<tr>
<td>Emerg rate limited stop</td>
</tr>
<tr>
<td><strong>Drive &gt; Safety tab</strong></td>
</tr>
<tr>
<td>Following error</td>
</tr>
<tr>
<td><strong>Safety &gt; General tab</strong></td>
</tr>
<tr>
<td>Pulses Per Foot</td>
</tr>
<tr>
<td>Contract Speed</td>
</tr>
<tr>
<td>Contract Overspeed</td>
</tr>
<tr>
<td>Inspection Overspeed</td>
</tr>
<tr>
<td>Leveling Overspeed</td>
</tr>
<tr>
<td>Limit One Margin</td>
</tr>
<tr>
<td>Top Access Landing</td>
</tr>
<tr>
<td>Top Access Rear</td>
</tr>
<tr>
<td>Bottom Access Landing</td>
</tr>
<tr>
<td>Bottom Access Rear</td>
</tr>
<tr>
<td>No Main String</td>
</tr>
<tr>
<td>No Main String Rear</td>
</tr>
<tr>
<td>Frnt Door Close Contact</td>
</tr>
<tr>
<td>Rear Door Close Cntact</td>
</tr>
<tr>
<td>Rear Doors</td>
</tr>
<tr>
<td>Freight Door Option 1</td>
</tr>
<tr>
<td>Rope Gripper</td>
</tr>
<tr>
<td>Car Top Exit</td>
</tr>
<tr>
<td>Construction Mode</td>
</tr>
<tr>
<td>Door Position Monitor</td>
</tr>
<tr>
<td>In Car Panel Inspection</td>
</tr>
</tbody>
</table>

---

**Caution**

Permanent magnet (PM) AC Gearless Machines must by synchronized with the AC Drive. Please refer to *PM Synchronous Motors > Motor Data and Loading motor data from encoder* in the *Initial Start Up* section of the TORQMAX F5 drive manual.
Learning the Safety Configuration

The controller is set to match the job safety configuration, according to the job survey, before being shipped. By default, Construction Mode is also enabled before the controller is shipped. You should not have to make changes to the Safety screen until you exit Construction Mode.

The safety configuration for the job is stored in two locations in iControl (FLASH and EEPROM on the SAF board). iControl constantly checks current safety information against stored data and also compares the data in the two stored locations to make certain they continue to match. If you make a change on the Safety screen, you will need to do a “learn” operation to write the new data to iControl:

1. From the View menu select Setup and click Safety.
2. On the Setup > Safety > Configuration tab, make necessary changes.
3. Select Acquire from the Write privilege menu (if you have not yet acquired write privileges to the iBox), then click Send to save the changes to iControl.

The controller will generate a safety mismatch fault because the settings you have just sent do not match its stored information.

4. Verify that the iBox is in Inspection mode (Inspection switch set to INSP). Set the Learn switch to ON.
5. The Learn section of the Setup > Safety > Configuration tab should indicate that the controller is ready to learn.
6. Click on the Learn button. The controller will take a few seconds to learn the new information and will then confirm that the safety configurations again match.
7. Set the iBox Learn switch back to the OFF position.
   The message window on the Safety> Configuration tab should report Safety Configurations OK.

While iControl is in Construction Mode, specific safety and operational features are automatically bypassed. These are:

- All cartop signals, including DP1 and DP2 (position encoder pulse streams).
- Normal and Emergency limit switches, NTS and ETS velocity and position logic. Except Normal Limit Switches DNTD and UNTD.
- Only Machine Room and Cartop Inspection are allowed. Will not allow Hoistway Access or COP Inspection.
- EQ signals, both seismic and counterweight derailment, are absent.
- Fire sensor signals are absent.
- No cartop comm.
AC Drive Parameters

Each iController is shipped with completed drive parameter sheets and a drive manual. Based on the field survey information, all drive unit, field-adjustable parameters are set and noted on the parameter sheets. However, **it is essential to verify all drive parameter settings before startup.**

**Danger**
High voltage may be present in the motor circuit, even when the motor is not rotating. Remove AC power and wait for 5 to 10 minutes before removing the drive cover to allow capacitors to discharge. Do not touch any component without verifying that high voltage is not present.

Verify the TORQMAX parameters below before startup. Check remaining parameters using drive documentation or the Quick Reference shipped with the controller. If drive documentation is not available, a list of parameters is included in the Reference Section.

**Caution**
Do not change drive parameters while the elevator is running. Incorrect settings can cause erratic elevator operation. Please refer to the drive parameters sheet provided with the controller or see “TORQMAX F5 Drive Parameters Quick Reference” on page 11-27.

- LF.02 Operating Mode = A Spd
- LF.04 Motor-Selection = ICLSd or PgLDD (See Quick Reference in Section 11.)
- LF.05 Fault Reset = 5
- LF.10 Rated Motor Power (HP)
- LF.11 Rated Motor Speed (RPM)
- LF.12 Rated Motor Current (Amp)
- LF.13 Rated Motor Frequency (Hz)
- LF.14 Rated Motor Voltage
- LF.20 Contract Speed (FPM)
- LF.21 Traction Sheave Diameter (inches)
- LF.22 Gear Reduction Ratio
- LF.23 Roping Ratio
- LF.24 Load Weight
- LF.27 Encoder Pulse / Rev (PPR)
- LF.30 Control Method
- LF.31 Kp speed accel / decel (proportional gain)
- LF.32 Ki speed accel / decel (integral gain)
- o.LF.36 Maximum Torque (LB / ft)
- LF.42 High Speed (FPM)
- LF.78 Brake Engage Time
- LF.79 Current Hold Time

**Drive Keypad**
Become familiar with the drive keypad. Refer to the drive manual to learn how to change drive parameters.
Drive Offsets Calibration

The iBox processes drive control voltages digitally. The digital signal is converted to its analog equivalent for output to the drive (DAC). Analog input control voltages are likewise converted from analog to digital for use by the iBox (ADC). Both of these conversions should be checked and any conversion offset corrected using the Output DAC and Input ADC parameters on the Configuration > Drive > Calibration tab.

This section describes both the automated and manual procedures which can be used to calibrate the drive analog circuitry. MCE recommends using the automated procedure first and then verifying the most critical offsets using the manual procedure.

Automated Drive Setup Procedure

Before adjusting the drive, verify that:

- the CONTROLLER STOP switch is in the RUN position
- the iBox Safety OK LED is ON
- the iBox Door Locked LED is ON
- the iBox Fault LED is OFF

1. Display the Drive setup layout (View > Layouts > Drive)
2. Follow the on-screen instructions, “To perform the drive offsets calibration, ...” (calibrates Input ADC and Output DAC offset).

3. Once the calibration is Done, the offset values shown on the Setup > Drive tab should match those shown on the Drive Configuration tab (Configuration > Drive > Calibration tab).

**Manual Drive Setup Procedure**

MCE recommends first performing the Automated Drive Setup Procedure previously described and then verifying the most critical offsets (*Output DAC and Input ADC - Tachometer*) using the manual procedure. However, if the automated procedure is unsuccessful, the manual procedure must be used.

Before adjusting the drive, verify that:

- the CONTROLLER STOP switch is in the RUN position
- the iBox Safety OK LED is ON
- the iBox Door Locked LED is ON
- the iBox Fault LED is OFF
- iView is connected, write privilege has been obtained (Write Privilege > Acquire selected and “Yes” softkey on iBox pressed in response)

1. Verify that Pattern scaling is set to 100% (Configuration > Pattern > Common tab).
2. On iView, display the Drive - Offsets tab (Configuration > Drive > Calibration tab).
3. **Output DAC**: With zero speed commanded (car idle), verify that the pattern voltage applied to the AC drive unit between F5 drive terminals X2A-1 (+) and X2A-2 (—) reads 0.0 volts. If not, adjust Output DAC on the Drive/Calibration screen by entering and sending small negative or positive values until the reading is as close to 0.0 volts as possible (less than 1mV). The DAC adjustment range is from —0.25 to +0.25 units.
4. On iView, display the Drive - Offsets tab (Configuration > Drive > Calibration tab). Also display the Virtual Oscilloscope (View > Virtual Oscilloscope) and set Test point 1 = Tachometer Signal.
5. **Input ADC - Tachometer**: Adjust the Input ADC - Tachometer parameter by entering and sending small negative or positive values until the Test point 1 value is as close to 0.0 as possible (20mV). The ADC adjustment range is from —0.5 to +0.5.
6. **Input ADC - Brake current**: Set the Virtual Oscilloscope Test Point 1 = Brake Current Feedback and then adjust the Input ADC - Brake current parameter by entering and sending small negative or positive values until the Test point 1 value is as close to 0.0 as possible.
7. **Input ADC - Brake voltage**: Set the Virtual Oscilloscope Test Point 1 = Brake Voltage Feedback and then adjust the Input ADC - Brake voltage parameter by entering and sending small negative or positive values until the Test point 1 value is as close to 0.0 as possible.
Rollback Compensation

In later adjustments, drive and motor settings will be adjusted to control rollback. Since that has not yet been done, we need to control rollback by adjusting Brake Pick delay and offsetting Speed pick delay 1 so that the brake remains set until the motor builds sufficient torque.

1. From the View menu select Layouts and click Brake.

2. Set Pick delay to 0.600 seconds.
3. Set Speed pick delay 1 to 0.700 seconds.
4. Select Acquire from the Write privilege menu. Then press the “yes” button on the iBox to grant the privilege.
5. Click Send to send the changed values to the controller.
Calibration

Calibration allows iControl to learn the characteristics of the machine brake.

1. Verify that the iBox Safety OK LED is solidly on.
2. Set the iBox Learn switch to ON.
3. Place the iBox Inspection switch in the INSP position. Verify that the iBox displays Machine Room Insp.

**Note**

If the iBox does not indicate that you are in Machine Room Inspection even though the Inspection switch is in the INSP position, another inspection mode (i.e., cartop inspection) is probably active. Other inspection modes must be OFF before Machine Room Inspection can be activated.

4. Display the Brake > Control tab (Configuration > Brake > Control tab).
5. Set Pick voltage and Hold voltage as shown on your job prints.
6. For now, set Releveling voltage and Weakening voltage to the same value as Pick voltage. (This parameter can be fine tuned during final adjustment.)
7. On the Setup > Brake tab the Ready indicator should be On. The text box will indicate any steps that need to be performed.

8. With the Ready indicator lighted, click the Calibrate button. As calibration begins, watch the display on the tab. The display will report calibration progress and will also display instructions if you need to complete additional steps along the way. The Waiting LED will light while waiting for an instruction to be completed. If necessary, click Continue to continue calibration after performing an instruction.

9. When iControl is ready to begin learning, the screen will display “The controller is waiting for a direction command in order to proceed. You may command either the Up or the Down direction.” When it does, press and hold the iBox Enable and Up (or Down) buttons. (The car will not be moved during this procedure.)

10. The Calibrating LED will light as calibration begins. Continue to hold the Enable and Up (or Down) buttons pressed. The progress indicators to the left of the display will keep you informed as calibration progresses.

11. When the Done indicator lights, release the Enable and Up (or Down) buttons. Calibration is complete.

12. Set the iBox Learn switch to OFF.

The following messages may be displayed during brake calibration.

Table 2.5 Brake Calibration Status Messages

<table>
<thead>
<tr>
<th>Message/ Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>The controller is not ready for Brake Calibration. Please place the elevator on Machine Room Inspection and place the LEARN switch in the ON position.</td>
</tr>
<tr>
<td>The system is waiting for the CONTINUE button to be pushed.</td>
</tr>
<tr>
<td>The system is ready to start the calibration process. Push the START button if you wish to start calibrating the brake or push the DEFAULT button if you wish to load the default calibration values.</td>
</tr>
<tr>
<td>The controller is waiting for a Direction command in order to proceed. You may command either the UP or the DOWN direction.</td>
</tr>
<tr>
<td>The controller is done with brake calibration. Please drop direction and turn the LEARN switch OFF.</td>
</tr>
</tbody>
</table>
Verify Brake Picking

To verify that the brake is picking properly:

1. Verify that the iBox Safety OK LED is solidly on. Display the Pattern > Common tab (View > Configuration > Pattern > Common tab).
2. Set Pattern Scaling to 0% and click Send to send the changed parameter to iControl.

<table>
<thead>
<tr>
<th>Operational Status</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common</td>
<td>Modes</td>
</tr>
</tbody>
</table>

- General
  - Position Encoder resolution: 256.00 pulses/ft
  - Pattern scaling: 0%
  - Door pre-opening distance: 0.00 in

3. Display the Operational Status tab. Note that Brake voltage is charted in the Machine section of the Operational Status tab.
4. With a digital volt meter set to DC volts, measure brake output voltage across terminals B1 and B2 (located just below the iBox panel). (A typical terminal block is shown to the right. B1 and B2 will be labeled.)
5. Press the Enable and Up (or Down) buttons to lift the brake. Verify that the voltages on the volt meter are the same as the commanded voltage (Pick voltage / Hold voltage parameters on the Brake > Voltages tab) and Brake voltage on the Operational Status tab. The brake should lift but the car should not move since Pattern scaling is set to command zero speed.
6. Change the Pick and Hold voltages to one half the current value of the Pick voltage parameter and save the new values.
7. Press and hold Enable and Up (or Down) and verify brake voltage again. (The brake will probably not lift since we are outputting only half the Pick voltage.)
8. Change the Pick and Hold voltages back to their job print settings and save them.
9. Change Pattern scaling (Pattern > Common tab) to 100% and send that value to the controller.
Running on Machine Room Inspection

Once you are satisfied that the brake is picking properly, then do the following:

1. Verify car movement (direction) and motor control and troubleshoot if not correct (see “Verifying Car Direction and Motor Control (TORQMAX)” on page 2-52).

2. Calibrate actual car speed (see “Calibrating Actual Car Speed” on page 2-53).

3. Perform the auto-tuning procedure for induction motors (see “Auto-tuning for Induction Motors” on page 2-54).

4. Verify pattern command vs. drive speed feedback tracking (see “Verify Pattern Command and Drive Speed Feedback” on page 2-55).

5. Set Following error, Tach Error Tripping Threshold (see “Following Error Margin” on page 2-56 and see “Tach Error Tripping Threshold Adjustment” on page 2-57).


Verifying Car Direction and Motor Control (TORQMAX)

1. If the brake picks but the car does not move, oscillates, or trips an E.ENC fault, change the F5 drive LF.28 parameter setting. This swaps encoder channels or reverses motor rotation internally in the drive. Physically changing external encoder connections is not necessary and is not recommended. The F5 drive LF.28 options are as follows:
   - 0 = nothing reversed
   - 1 = encoder A<->B swapped
   - 2 = motor rotation reversed
   - 3 = motor rotation reversed and encoder A<->B swapped

2. If the car moves in the opposite of the intended direction while drawing normal current, turn power off and wait until there is no voltage present at the DC bus, then proceed with step 3. Motor current can be verified by displaying the F5 drive parameter LF.93.

   **Danger**

   Turn power off and wait five minutes for DC bus voltage to bleed off before taking the drive cover off. Do not touch any terminals without ensuring that high voltage is not present.

3. Interchange two of the motor leads. Turn power on.

4. Try to run the car on Inspection. If the drive still trips an E.ENC fault, again change the F5 drive parameter LF.28. (Refer to LF.28 parameter options in step 1). The car should now move in the correct direction and draw normal current.
Calibrating Actual Car Speed

If iLand and iLink are already installed, use the landing system speed (Speed/Actual on the Operational Status tab) as the speed reference for speed calibration. If not, use a hand-held tachometer to obtain the value.

If you are using a hand-held tachometer, hold it against the hoist or governor rope on the machine. The car must run at the commanded inspection speed in both directions (see Caution). If the measured inspection speed does not match the commanded value, verify the following:

1. Verify the Inspection - High Speed parameter (iView: Configuration > Pattern > Modes tab or iBox: Car/Pattern Profile/Inspection high velocity).
2. Verify that Pattern scaling is set to 100% (Configuration > Pattern > Common tab).
4. Adjust motor parameter LF.22 Gear Reduction Ratio in small increments to obtain the correct Inspection speed (see Note).

Note

Gear Reduction Ratio: If the gear reduction ratio is not available from the machine name plate, calculate the value by first measuring the motor revolutions using a marker on the motor shaft or brake drum. Reduce the inspection speed by decreasing the Inspection High speed setting, then determine the number of motor shaft revolutions required to complete one revolution of the sheave. Calculate the gear reduction ratio using the formula: Gear reduction ratio = Motor RPM / Sheave RPM. Enter the calculated value in parameter LF.22.

The drive has the capability of estimating the gear reduction ratio. Run the car on inspection and read the value of parameter LF.25, the gear ratio estimated by the drive. The value of LF.25 can be temporarily used for LF.22.

Caution

Up vs. down speed variance: If the car runs at commanded speed in one direction but less then commanded speed in the other direction, this can indicate insufficient voltage available to generate the required torque. At inspection speed this may be a little as 1 or 2 fpsm, but at contract speed this variance will be much greater. On a small percentage of jobs it is necessary to increase the value of parameter LF.14 Rated Motor Voltage. For example, for a motor rated for 480 volts it may be necessary to increase LF.14 to 500 volts.
Auto-tuning for Induction Motors

For best performance with induction motors it is recommended to first perform the auto-tuning procedure as follows:

1. Make sure that the rated motor power (LF.10), rated motor speed (LF.11), rated motor current (LF.12), rated motor frequency (LF.13), rated motor voltage (LF.14) and rated power factor (LF.15) are entered into the drive before you begin. If the power factor is not on the name plate, use 0.90 as the value.

2. On the Controller > Configuration > Brake > Control tab, record the value of Pick voltage, Hold voltage and Relevel voltage. Then set all three voltages = 15.000 to prevent the brake from picking.

3. On the Controller > Configuration > Pattern tab, set Pattern scaling = 0.000.

4. On the TORQMAX F5 drive keypad, set Drive configuration (LF.03) = $ Lrn$. This will start the learn process. The display will change to $Start$.

5. With the iBox INSPECTION switch in the INSP position, press and hold the UP and ENABLE buttons. The motor contactor should pull in and the brake should not pick. Motor current will begin to flow, an audible noise in the motor will be heard, and the drive display will change to $LS.103$.

The drive will measure various parameters in the motor as well as in the drive’s own power stage. During each measurement the display will change to signify what is being measured. In the event of problems during the measurement phase, the factory can use the codes to determine what is happening. Continue to press and hold the ENABLE and ON switches in until the drive displays $done$.

6. In the event that the drive cannot complete the measurements, two error messages may occur:
   - $FAILd$ - the drive was not able to begin measurements due to a configuration error. Consult the factory to resolve.
   - $FAIL$ - the measurement sequence was interrupted, e.g., the inspection ENABLE or UP switch was released prematurely, electrically the motor was not properly connected. Try the measurement again.

7. When $done$ is displayed, release the ENABLE and UP switches. The drive will finish making several calculations, $CALC$ is displayed, and updating the parameter values with the measured values.

8. Return the Pick voltage, Hold voltage and Relevel voltage to their previous values and set Pattern scaling = 100.000 percent.
Verify Pattern Command and Drive Speed Feedback

1. Verify/set the following iView Drive parameters (Configure > Drive > General tab > Speed Reference section):
   - Reference type = Tachometer
   - Scaling = 1.000
2. If you change any values, send them to the controller.
3. Display the Virtual Oscilloscope (View > Virtual Oscilloscope).
4. Set Test point 1 = Pattern (Command) and Test point 2 - Speed Feedback.
5. Run the car and verify the polarity (Test point 1 and 2 traces are both moving in the same direction). If they not, change the Speed Reference Direction parameter (Forward / Reverse) on the Configuration > Drive > General tab.
6. Run the car and verify that the Pattern (Command) and Speed Feedback (Test point 1 and 2 traces) are the same amplitude. On the iView oscilloscope (or a DVM connected between STP1 and STP2), compare the Pattern Command and Speed Feedback readouts. They must match within 0.050 VDC while the car is running at steady state speed. If not, adjust the TACH ADJ trimpot (upper right corner of iBox). The iPower Box door can be opened slightly to improve access to the TACH ADJ trimpot. *Turn the pot slowly.* This is a 15 turn trimpot, but the adjustment from maximum to minimum on the virtual oscilloscope is less than 1/2 turn.

*If the trimpot adjustment is insufficient,* adjust the Scaling parameter (Configuration > Drive > General tab > Speed Reference section) up or down in 0.1 increments. Remember to *Send* the value to the controller, and then re-adjust the trimpot.
Following Error Margin

The Following error is used for fault detection purposes only. The Following error parameter (Configuration > Drive > Safety tab) sets the allowed margin of deviation from commanded speed, as a percentage. A Tach Error fault is generated when the difference between intended pattern speed and speed feedback exceeds the Following error margin.

1. Verify that the Pattern (Command) and Speed Feedback signals are tracking properly. Please refer to “Verify Pattern Command and Drive Speed Feedback” on page 2-55.

2. On the Configuration > Pattern > Modes tab, verify that Standard Profile/High Speed and Inspection Profile/High Speed parameters are set correctly for this job.

3. Verify that actual car speed on Inspection is equal to the Inspection High speed setting. Please refer to “Following Error Margin” on page 2-56.

4. Set the Following error parameter (Configuration > Drive > Safety tab). It is recommended to perform the Tach Error Tripping Threshold Adjustment procedure at this time. Please refer to “Tach Error Tripping Threshold Adjustment” on page 2-57.

![Default setting](image)

Caution

**The default setting for the Following error parameter is 25%.** For a car that has been properly adjusted as described in steps 1 through 3 above, after performing the Tach Error Tripping Threshold Adjustment, a Following Error setting of 10% is fairly typical. You may choose to leave the Following error parameter at the default setting or higher, but keep in mind that Following error is a percentage of speed. On a 500fpm job a 25% Following Error allows a 125fpm contract speed deviation before a fault is generated.
**Tach Error Tripping Threshold Adjustment**

This test compares the pattern signal with the velocity feedback signal and sets the point at which the Tach Error fault trips as a result of excessive error between the Actual and intended car speed.

1. On the iView Virtual Oscilloscope, set Test point 1 to *Speed Feedback* and Test point 2 to *Tach Error Upper Limit*.
2. On Inspection, run the car several times between floors in both directions. Monitor the traces and verify that the Speed Feedback and Tach Error Upper Limit traces track but remain comfortably separated.
3. Set Testpoint 2 to *Tach Error Lower Limit*.
4. On Inspection, run the car several times between floors in both directions. Monitor the traces and verify that the Speed Feedback and Tach Error Lower Limit traces track but remain comfortably separated.
5. Estimate the smallest percentage of Following Error that would allow the Feedback and Limit traces to remain separated.
6. Increase the calculated value by 1/2 and set Following error to this value. For example, if the calculated percentage is 6%, add that to 1/2 of 6 (3) and set Following error to 9%. Remember to send the change to iControl.
7. Repeat steps 1 through 4, verifying that Feedback and Limit traces remain separated. If they do not, recalculate and reset Following error.

---

**Note**

A Following Error setting of 10% is fairly typical. Keep in mind that Following Error is a percentage of speed. On a 500fpm job a 10% Following Error allows a 50fpm contract speed deviation before a fault is generated.
**Electronic Motor Overload Protection Verification**

Provided the car is running normally on Inspection operation and is drawing normal current, perform the following test to verify the drive electronic motor overload protection is correctly set to protect the motor from overload conditions:

1. Verify LF.08 (Electronic Motor Protection) is set to ON.
2. Note (write down) the value of LF.09 (Electronic motor protection current). This value must be equal to LF.12.
3. Lower the value of LF.09 to 20% of the noted setting (LF.09 x 0.20).
4. Run the car on Inspection. After one minute the drive should trip an E.0H2 fault and shut down the car.
5. After five seconds, the fault will automatically clear and the car will be ready to run on Inspection again.
6. Set the value of LF.09 back to the noted setting (Motor FLA or LF.12).

**Additional Adjustments and Checks**

1. On the Configuration > Pattern > Common tab, set **Pattern scaling** to 100%.
2. On the Configuration > Pattern > Modes tab, set **Inspection/High Speed** to the desired value (maximum Inspection speed is 150 fpm). Set the **Inspection/Low Speed** to 25 fpm.

**Note**

If the Terminal Switches (UNT5/DNT5) have been installed, and you wish to use the reduced inspection speed option, you may enable it by checking **Reduced inspection speed** on the Configuration > Pattern > Modes tab. If not, you may enable Reduced Inspection speed after the Terminal Switches are installed. (Enabling it now, without switches, would cause the car to run at 25 fpm.)

3. Stop the car so that the car top can be accessed from the top hall door.

**Note**

**NOTE:** Car Top Inspection operation automatically overrides Car Panel Inspection operation.

4. Run the car from the Car Top Inspection station, checking the up and down buttons and the stop switch.
5. While running the car, check clearances and door locks. When all doors are locked, remove any jumpers from door lock terminals.
6. Verify directional limit switch and final limit switch operation and position according to page MRW1 or MRW2 of the job prints. The distance between the two switches should ideally be greater than the distance required to stop the car after the direction command is removed when the car is on Inspection operation.
7. Verify that the brake has sufficient tension to hold the car under all conditions likely to be encountered during the installation phase.
In This Section

This section provides the information you need to complete field wiring and prepare the elevator to operate in Inspection Mode:

- **iLand Landing System Installation** (see page 3-2).
- **iLink Interconnect Installation** (see page 3-13).
- **Hoistway Limit Switches** (see page 3-19).
- **Load Weigher Installation** (see page 3-19).
- **Brake Monitoring** (see page 3-20).
- **Earthquake Sensor** (see page 3-21).
- **Serial Hall Call** (see page 3-22).
- **Serial COP** (see page 3-22).
- **Cartop Voltage Verification** (see page 3-23).
- **Door Operation** (see page 3-24).
- **Running on Machine Room Inspection Mode** (see page 3-26).
- **Preparing for Final Adjustments** (see page 3-28).

**Caution**

Instructions in this section assume you have completed all Construction Mode instructions and that the elevator car is running safely and reliably in Construction Mode. Note that, in the course of installing the iLink cartop box, YOU MUST UNDO the temporary cartop CTS bypass used to run the car on Construction Mode (with no iLink cartop box installed).
iLand Landing System

iLand uses an encoder to gauge precise hoistway position and three separate Hall-effect sensors to level the elevator car accurately at each landing.

Position Feedback

A simple, durable wheel assembly rides the elevator rail as the car moves. Wheel-to-rail tension is maintained by two springs. Mounted with the wheel is a magnet that rotates as the wheel turns. The rotation of the magnet is detected by an encoder which generates two pulse streams, phase-offset by 90 degrees.

Direction

By monitoring both pulse streams, iControl can tell the direction of elevator travel by detecting which stream is the “first to arrive.” For example, when the elevator is moving up, DP1 leads DP2. When the elevator is moving down, DP2 leads DP1.

Position

During floor height “learn” operations, iControl counts the total number of pulses from the bottom to the top of hoistway travel and stores the floor height position (pulse count) at each landing. During normal operation, iControl uses the floor height information and the encoder pulse count to accurately track elevator car position in the hoistway. Please refer to “Learning Floor Heights” on page 4-2.

Landing Accuracy

During installation, running in Inspection mode, the elevator is manually leveled at each landing. With the car level at the landing, a six-inch strip magnet is placed near the hollow of the rail curvature, vertically aligned with a row of three sensors on the iLand landing system. If the car has both front and rear doors, a second strip magnet is placed on the opposite side of the rail and a second set of sensors is used. Placement of the magnets in vertical alignment with the sensors should be as accurate as possible.

During automatic operation, the iController uses signals from the three sensors (Up Level, Door Zone, and Down Level), factors in speed and position information, and comfortably and accurately “lands” the elevator car to within 1/32” of floor level.

Logic

If required, the Floor Offset Distance parameter may be adjusted to compensate for inexact placement of floor magnets (see Calibrating the Floor Offsets in Section 4 of the User Guide). Using this parameter, you can offset the car level-at-floor point by ± 0.5 inches.

The positions of the floor magnets are recorded during hoistway learn operations (see Learning the Floor Heights in Section 4 of the User Guide). Each time a magnet is encountered, the iController learns the position of the magnet with respect to the bottom floor. This learned height, the “floor height,” is stored in system memory.
Cartop Mounting

The iLand Compact landing system is usually mounted on a pedestal on the elevator cartop such that the encoding wheel rides the center ridge of the hoistway rail. MCE offers a mounting pedestal designed to work in most installations, which can be purchased separately (LS-PED-ESTAL-BSE), or the pedestal may be provided by the installer. Typically, the iLand mounting pedestal is bolted to the crosshead beams.

Positioning

Refer to the illustration below and to the accompanying instructions to ascertain how iLand must be positioned and mounted on the cartop.

Figure 1. iLand Pedestal and Position on Cartop
Pedestal Fabrication and Mounting
A pre-fabricated, universal mounting pedestal may be purchased from MCE. If built on site, the pedestal must be fabricated to:

- Mount securely to the elevator car crosshead beam
- Position the iLand system acceptably both vertically and horizontally (vertically so that the landing system clears obstructions like the elevator guide wheels — horizontally so that the encoder wheel is centered on, and aligned with, the raised center ridge of the rail)
- Be sturdy enough to resist flexing or excessive vibration

If the pedestal bends or moves, the encoder information might become inaccurate or be interrupted causing the controller to receive inaccurate information about the cars position, speed, and direction of travel. Figure 2 below provides the mounting footprint for the iLand chassis on the pedestal. The slots should provide clearance for 1/2” bolts.

**Figure 2. Typical Pedestal for mounting iLand**
Installing iLand

1. Attach the mounting pedestal securely to the elevator crosshead beam.

2. Place the iLand on the mounting pedestal and slide it into position so that the Position Encoder Wheel is touching the front face of the rail. If necessary, loosen the screws that adjust the position of the Leveling Sensor Bracket(s) and slide the brackets back away from the rail.

3. Move the base of the iLand Compact forward until the Parallel Arms are approximately vertical and fasten it to the pedestal using four 1/2” (or 3/8”) bolts, flat washers, lock washers, and nuts.

4. **Caution!** Leveling sensors can be damaged by collision with rail clamps and bolts, etc. Move the car cautiously until adequate clearance is verified. **Damage due to mechanical contact is NOT covered by warranty!** See Caution below.

Figure 3.

**Caution:** Loosen screws and slide the Leveling Sensor Bracket(s) back away from the rail. At points where the rails are attached or where rail sections meet, the clearance may be reduced by clamps, bolts and other hardware. Check initial floor leveling sensor adjustments at the worst of these points to make certain the sensors or other landing system hardware will not be damaged when the car runs past these points. Check along the entire rail to ensure adequate clearance. **Damage due to mechanical contact is NOT covered by warranty!**
5. Place a magnet on the rail as shown in Figures 4 and 5. below. iLand Compact must be adjusted so that the Leveling Sensors are centered on the magnet with the face of the sensor board 1/4 inch (K 1/16 inch) from the surface of the magnet. Magnets may be stacked to increase height if needed.

**Figure 4. Magnet position on the rail (side view)**

**Note:** The front door floor leveling magnet and leveling sensors are shown in this picture (left side). The rear door floor leveling magnet and sensors, if applicable, are mounted on the right side of the rail (See Figure 5).

The magnet should be on an angle of approximately 12 degrees with respect to the back surface of the rail.

The Leveling Sensors should line up with the center of the magnet with the face of the sensor board 1/4” (K 1/16”) from the surface of the magnet. Magnets may be stacked to increase height if needed.
6. For a front door only iLand Compact (iLand-1-C), adjust the guide rollers so that the Leveling Sensor is centered on the magnet (see Figures 5 and 6). Ensure that the Guide Rollers are snug against the rail.

7. For a front and rear door iLand Compact (iLand 2-C), it may be necessary to adjust both the Guide Rollers (Step 6) and the Carrier Arms in order to get both Leveling Sensors centered on their respective magnets. Loosen the Carrier Arm set screws and move the arms closer together or farther apart (see also Figure 7).

8. Once the Leveling Sensors are centered on their respective magnets, adjust the Position Encoder Wheel so that it is centered on the rail. Loosen the lock nut and adjust the screw. Then retighten the lock nut.
Figure 6. iLand Compact Installation (rear view)

- Snug the Guide Rollers against the rail
- Guide Roller adjustment screws
- Leveling sensor centered on the magnet
- Position Encoder Wheel centering adjustment
- FACTORY ADJUSTMENT DO NOT ADJUST
- Position Encoder Wheel centered on the rail
- Carrier Arms centered
Floor Leveling Magnets

In a typical, front-door only, installation, a single 6-inch strip magnet attached near the hollow of the rail curve (left side), See “Magnet position on the rail (side view)” on page 3-6, is used to indicate the level-with-floor position for each landing at which the elevator car will stop. If the car has rear (or side) doors as well, a second 6-inch strip magnet is attached on the right side of the rail and a second set of floor leveling sensors on the right side of the iLand is used.

Note

Blind Hatch - False Floors - Floor leveling magnets must also be positioned in the approximate location of all false floors. Check the Hall Fixture Location section on the Hoistway & Machine Room Wiring (MRW1) page in the job prints. Information regarding false floor settings can also be found on the iView Floor data tab (Controller > View > Configuration > General > Floor data). False floors are considered to have only front doors. False floor magnets should be installed only on the front door side.

There are three important dimensions to keep in mind when attaching the floor magnets:

- The magnet must be positioned so that, when the car is level with a floor, the magnet is lengthwise between the Up Leveling and Down Leveling sensors (See “Magnet position on the rail (side view)” on page 3-6) and centered on the Door Zone sensor with the South pole surface facing out.
- The magnet must be attached at an angle of about 12 degrees from the rail hollow (See “Magnet position on the rail (top view)” on page 3-6). (This aligns the face of the magnet with the leveling sensors.
- The “thickness” of the magnet strips (the distance from the outer magnet face to the rail behind the magnet) must be considered so that some magnets do not “stick out” farther than others. (This ensures that the gap between the sensors and the magnet face will remain consistent at different floor levels.) The iLand assembly automatically compensates for some rail distortion using the Position Encoder wheel and the two guide rollers.

Caution

At points where the rails are attached or where rail sections meet, the clearance for the sensors may be reduced by clamps, bolts, and other hardware. Check your initial floor leveling sensor adjustments at the worst of these points to make certain the sensors or other landing system hardware will not be damaged when the car runs past these points. Check along the entire rail to ensure that the clearance between the face of the sensor board and the magnets is 1/4 inch (K 1/16 inch). Magnets may be stacked to increase height if needed.

Warning! Damage due to mechanical contact is NOT covered by warranty.
Installing the Floor Leveling Magnets

1. On Inspection mode, position the elevator car so that it is **level** with a landing. Inspection speed may be reduced to help stop the car precisely at floor level (iView > Controller > View > Configuration > Pattern > Modes tab).

2. Mark the position of the top and bottom leveling sensors as shown below. Note that the sensors are slightly in from the edges of the circuit board. Accurate magnet position assures the best possible position tracking.

3. Move the car down one to two feet. Clean the hollow of the rail where the magnet will be attached to remove all grease and dirt. (Acetone, alcohol, or another industrial solvent may be used.)

4. Center the magnet vertically between the marks with the South pole facing outwards. (Magnets supplied by MCE have an adhesive strip and paper on the North face. If necessary, use a compass to check North/South polarity.)

5. Move the car back into position and verify that the face of the sensor board is within 1/4” (6 mm) K 1/16” (1.5 mm) from the face of the magnet and the sensors are centered on the magnet. If the iLand Landing System is powered (connected to a working iLink), the ULM, DLM, and DZ LEDs will all be lighted if the magnet is positioned properly. If not, adjust the magnet and re-test. Note: If the magnet is less than six inches long, only the DZ sensor may be lighted when the magnet is positioned properly.

6. When ready, attach the magnet to the rail using a good quality construction glue. Then move to the next landing, etc. (Some installers prefer to temporarily attach the magnets and, after adjusting the sensors and learning the hoistway, test their placement. Then go back and make adjustments before using a permanent glue.)
Cabling Connections
The Position Encoder and Leveling Sensors connect to the iLand Signal board (LS-IPH) through short, factory-assembled cables with an RJ45 connector at each end. These cables should already be in place and connected. If they have been removed, they need to be reconnected. Refer to Figure 7 for guidance.

Figure 7. iLand Cable Connections

![iLand Cable Connections](image)

The cables from the iLand Landing System (LS-IPH board) to the iLink Cartop Processor (ICE-CTP board) are supplied (C-ETHERENET-BGE-XX). They should be routed through flexible conduit from the iLand connectors shown in Figure 7 to the iLand Front Door and, if applicable, iLand Rear Door connectors on the ICE-CTP board in the iLink Cartop Box as shown in Figure 8 (see also “iLink Wiring” on page 3-15).

Figure 8. Cartop Interconnection

![Cartop Interconnection](image)
iLand Status LEDs

The iLand signal board enclosure reveals status LED sets for the front and rear floor leveling sensors and the position encoder sensor. Refer to the illustration below.

![iLand Status LEDs Illustration](image)

**Figure 9. iLand Status LEDs**

- Front floor leveling sensors:
  - Up Leveling Marker (ULM)
  - Door Zone (DZ)
  - Down Leveling Marker (DLM)

- Rear floor leveling sensors:
  - Up Leveling Marker (ULM-R)
  - Door Zone (DZ-R)
  - Down Leveling Marker (DLM-R)

- Position EncoderIndex:
  - LED turns on once per wheel revolution, at the zero index point.

- Position Encoder Magnet:
  - When the adjustment is correct both MAGIN and MAGDE are off.

- Position Encoder quadrature pulse indicators. When the elevator is in motion, these LEDs light alternately, 90 degrees out of phase: DP2, DP2

Setting the Position Encoder Resolution parameter

For the iLand Compact landing system, the *Position Encoder resolution* parameter must be set to 348 pulses per foot (iView Controller > View > Configuration > Pattern > Common tab).

<table>
<thead>
<tr>
<th>Operational Status</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>Common Modes</td>
<td></td>
</tr>
</tbody>
</table>

- **Position Encoder resolution**: 348.000 pulses/ft
- **Pattern scaling**: 100.000 %
- **Door pre-opening distance**: 0.00 in

Set to 348 pulses/ft.

Calibrating the Floor Offsets

This is the final step to installing the iLand Compact Landing System (see “Calibrating the floor offsets” in Section 4 of the User Guide). If this is a new installation, it is best to wait until the car has been fully adjusted so that it stops consistently and accurately at the floors. When replacing an iLand-H Landing System, the adapter kit helps bring the leveling sensors into proper position with respect to the existing leveling magnets. Perform this calibration now and make any adjustments needed to ensure that the car stops “spot-on” at every floor.
Installing iLink

iLink provides an efficient, one-stop interconnect point between car and hoistway wiring and iControl. The serial link between iLink and iControl allows the bulk of the travelling cable to be reduced. The illustration below shows a view of iLink circuitry with the cover removed.

Figure 3.1 iLink Circuitry and Wiring

This section describes:
- iLink enclosure installation
- Door signal wiring
- Cartop inspection wiring
- Cartop safety wiring
- Loadweigher wiring
- Door operator wiring

The wiring between the iLand landing system and iLink was described earlier. (Please refer to “Cabling Connections” on page 3-11.)
Installing the iLink Enclosure

The iLink enclosure is typically mounted on the left side (as you face the car) of the cartop, opposite the iLand system. The enclosure has several partially-punched knockouts to accommodate two-inch conduit connections. Mount the iLink enclosure on or between the crosshead beams.

Vertical mounting, as shown, is preferred. Mounting the iLink horizontally is acceptable only if it is well protected from metal filings or other debris that might accumulate and damage electrical components. The dimensions of the iLink enclosure depend upon how many input and/or output boards are required for a particular job.
iLink Wiring

Like iControl, the iLink cartop box has an always-present, processor board (ICE-CTP) connected through a pluggable bus to input (ICE-MIAC), output (ICE-MOR), and other optional boards as required by the installation. A typical layout is shown below.

ICE-MOR: Programmable outputs can be used for Car Operating Panel button lamps, buzzers, chimes, peripherals, etc.

ICE-MIAC: Programmable inputs can be used for Car Operating Panel and customer peripheral equipment, etc.

Connections for door operating system, load weigher, etc.

Note

The iLink microprocessor board has battery backup for logic retention. An insulator prevents the battery from discharging during shipment. Remove the insulator now if has not already been done.
A “terminal strip” is mounted in the enclosure. The job prints provide details of terminal strip wiring. A typical terminal strip is shown below.

**Front and Rear Door and Leveling Signals**
1. Refer to the -CT drawings in the job prints.
2. Connect front and rear door signals as shown.

**Note**
These instructions assume that the door operator has been installed in accordance with the manufacturer documentation.

**Leveling Signals**
1. Refer to the -CT job print drawings.
2. Connect the DZ, DLM, and ULM signals between the iLink CTP board and the iControl/iBox for front and rear (if present) doors as shown.
**Cartop Inspection Switches**

The cartop inspection switches allow you to run the car from the cartop station.

1. Refer to the -CT drawings in the job prints.
2. Connect the cartop inspection switches as shown:
   - INCT: Cartop Inspection Switch enables directional travel switches (active low)
   - ICTU: Cartop Inspection UP button (active high)
   - ICTD: Cartop Inspection DOWN button (active high)

---

**Cartop Safety**

**Caution**

The cartop safety relay may have been temporarily bypassed to run the car on Construction Mode without the iLink cartop box. If so, YOU MUST UNDO this bypass and wire the CTS contact as part of the safety string at SCT1 and SCT2. Refer to your job prints.

1. Locate SCT1 and SCT2. Refer to the -CT drawings in the job prints.
2. Connect the cartop safety switches as shown:
   - Cartop Emergency Stop switch
   - Emergency Exit contact
   - Safety Clamp

---

**Landing System Pulse Streams to iControl**

Refer to the iLand installation instructions (Cabling) for a description of the serial/power connections between iLand and the iLink cartop interconnect box. (Please refer to “Cabling Connections” on page 3-11.) The connections described here are between the iLink interconnect box and the controller.

1. Refer to the -CT drawings in the job prints.
2. Locate the DP1+, DP1-, DP2+, DP2-, and Shield connections.
3. Using the shielded, twisted pair connection specified, connect the terminals as shown.

**Note**

DP1 and DP2 are the quadrature signal from the iLand system that tells the controller the precise position of the elevator car in the hoistway.

**iLink to iControl Serial Connection**

The processors in the iLink cartop box and iControl controller cabinet communicate serially through shielded, twisted pair, connections.

1. Refer to the -CT drawings in the job prints. Locate the TX+, TX-, RX+, RX-, and Shield connections.
2. Using the shielded, twisted pair connection specified, connect the terminals as shown. (iBox TX+ and TX- terminals to CTP board RX+ and RX- terminals. iBox RX+ and RX- terminals to CTP board TX+ and TX- terminals.)

**iLink Power Connections**

The iLink cartop interconnect box receives operating power from iControl through the traveling cable. Typically, the power wires are connected to the terminal strip in the cartop box and distributed from there to the circuit boards. Connections between the terminal strip and the boards are made at MCE before shipment but must be verified during installation.

1. Refer to the initial pages of the -CT job print drawings.
2. Connect the power buses as shown, using the wire types specified. The power delivered to the cartop box depends upon the needs of the installation. Refer to the -D3 and -1 (and -2X) drawings for details.

**Car Operating Panel Connections**

The Car Operating Panel control/power connections are made to the iLink cartop box.

1. Refer to the ICE-MIAC and ICE-MOR areas in the -CT drawings of the job prints.
2. Connect all inputs and outputs as shown.

The drawing below shows terminal order used on both the ICE-MIAC and ICE-MOR boards.

**Figure 3.2 ICE-MIAC and ICE-MOR Cartop Board Field Connections**
iLink Cartop Wiring Verification
1. Examine the -CT drawings in the job prints package.
2. Carefully verify that all connections have been correctly made and are clean and secure.

Note
Each job is different. The job prints accurately reflect the survey information and are the primary source for installation and wiring information. Review them carefully.

Installing Hoistway Limit Switches
There are several kinds of limit switches available. If you are using MCE switches, consult the documentation accompanying the switches and the MCE job prints. If you are using switches other than MCE, consult the manufacturers documentation and the MCE job prints. In general (for cam-operated switches):
• Be sure that the cam operating the limit switches keeps the slowdown limit switches open until the normal direction limit switch is broken.
• Be sure that both the normal and final limit switches are held open for the entire run-by travel of the elevator.
• For faster elevators, the surface of the cam that operates the limit switches must be sufficiently gradual so that the impact of the switch rollers striking the cam is relatively silent.

Note
After Terminal Switches (UNT5/DNT5) are installed, verify Inspection Low Speed (iView/Pattern/Inspection) is set to 25 fpm and is enabled. UNT and DNT 5 switches are always used in iControl installations.

Installing the Load Weigher
If a cross-head deflection load weigher is specified for this job, please refer to the installation and calibration instructions supplied with the load weigher. If an EMCO rope tension sensing load weigher is specified, See “EMCO Load Weigher Installation and Calibration” on page 5-51. If an MCE isolated platform load weigher is specified, See “MCE Load Weigher” on page 5-61 (or the instructions shipped with the load weigher) and to the job prints for installation instructions.

Additional information regarding load weigher selection and threshold settings are provided in Section 4. Please refer to “Load Weigher Adjustment for Dispatching” on page 4-29.
Installing Brake Monitoring

Brake monitoring via an independent contact is required by code only for disc brakes. A spare iBox input (SP2D), or a programmable input (Brake Switch) on an ICE-MIAC board, may be used for the brake contact. The brake monitoring contact may be provided as part of the brake assembly. If not, a micro-switch (rated for at least 1/4 Amp, 125VDC) must be provided by the installer and mounted such that when the brake picks, the switch activates (see note below). Refer to job prints for electrical connection information.

The brake monitoring contact provides a path between the iBox 110VDC (#3) bus and the SP2D or Brake Switch input. If the brake fails to pick (or drop) at the proper time, this signal will cause the controller to generate a Brake Pick Fault (see “Brake Pick Fault, BRAKE PICK FAULT” on page 6-16) or Brake Drop Fault (see “Brake Drop Fault, BRAKE DROP FAULT” on page 6-15). The fault message is shown on the iBox LCD display, on the iView Operational Status tab and in the iView Event Log.

Note

On the iView > Controller > Configuration > Brake > Control tab, switch parameters are provided to specify the polarity of the SP2D/Brake Switch input (active high or low). In addition, parameters direct the system to monitor for a brake pick and/or brake drop fault. If neither pick or drop monitoring are checked, the controller will ignore the SP2D/Brake Switch input.

Danger

When installing the switch, take all necessary precautions not to interfere with normal brake design or operation.
Installing the Earthquake Sensor

An earthquake sensor may be part of your installation. If so, connect the counterweight derailment detector and seismic sensor as shown in your job prints. The EQ board provides a seismic sensor input (ESS), a spare sensor input (EQSP 1), and a counterweight derailment detector (CW1/CW2). The ESS input is normally at 120VAC (no earthquake detected). A low (0.0V) at the ESS input will cause the elevator to go into Earthquake Mode.

The counterweight derailment detector operates using a 24VDC “ring and string” circuit which will be grounded if excessive counterweight motion occurs. iControl also monitors the continuity of the “string” and will trigger a fault if the string breaks. The illustration below shows how the circuit operates.

Temporary Bypass

If the earthquake devices will be installed later, you may temporarily bypass the ESS input using a jumper from the ESS input to a #2 Bus (120V AC) connection. Bypass the counterweight derailment detector by placing a jumper between CW1 and CW2.

Earthquake Reset

Earthquake Operation latches when activated by the seismic sensor or the derailment detector. Press the reset button on the EQ board in iControl to reset EQ.

If the counterweight moves excessively, one or both of the (grounded) rings surrounding the +24VDC wire will cause that voltage to short, pulling the CW1/CW2 circuit low and causing the elevator to enter Earthquake (operating) Mode.
Installing the Serial Hall Call System

The MCE serial hall call system uses only two wires and is easier to install than traditional, multi-wire systems. The two wires provide both power and signal to hall calls. For simplex cars the hall call driver is located in the car controller cabinet. Please refer to “Serial Hall Call” on page 5-30.

1. Refer to job print drawings - Serial Hall Call Details (-SH).
2. Set jumpers and install hall call nodes as shown in the drawings.
3. The serial hall call inputs and outputs are programmed on the iView System > Configuration Tabs > System I/O > System tab. Please refer to “Configuration Tabs - System I/O” on page 10-51.
4. Troubleshooting and testing of the serial hall call fixtures and lamps is accomplished using the iView Configuration > Serial I/O > Bus tab. Please refer to “System I/O - Bus Tab” on page 10-60.

Note

For cars operating as part of a Group, the hall call driver is located in the Group cabinet. From the iCentral cabinet, calls are distributed to car controllers through the MCE System Ethernet network. Refer to your job prints and the iCue User Guide for installation and cabling instructions.

Installing the Serial COP System

With the Serial Car Operating Panel system, car call buttons connect directly to a serializing board located in the car station enclosure. Multiple Serial COP boards daisy-chain together to accommodate high-rise installations with a lot of call buttons. Wiring from the Serial COP board(s) to the iLink cartop box is just a short length of shielded cable with a telephone-style RJ-11 connector at each end. The iLink cartop box supports up to four serial control panel connections. Communication between iLink and the controller is also serial, thereby reducing the the traveler and hoistway cabling.

Instructions for installing the Serial COP system can be found in Section 5. Please refer to “Serial COP” on page 5-48.

1. Refer to job print drawings - Cartop Details (-CTx).
2. The Serial COP inputs and outputs are programmed on the iView Configuration > I/O Board > Configuration tab. Please refer to “Configuration - I/O Boards” on page 9-102.
Verifying Cartop Voltages

1. Set the iBox Inspection switch to the INSP position.
2. Set the Controller Stop switch to the Stop position.
3. Turn on power at the main disconnect.
4. Watch the front panel displays of the iBox, the controller will take about 60 seconds to initialize.
5. Check the Computer, Safety A, Safety B, and Cartop status LEDs. The LEDs should be lighted solid green.
6. Refer to the initial pages of the -CT drawings where power connections are primarily shown. On the cartop, verify all voltages shown are present and within acceptable levels with respect to ground.
   - +5V, +/-15V, +/-26V, +3.3V test points are on the right edge of the ICE-CTP board
   - The GND test point is in the middle of the ICE-CTP board
   - Verify 2 and 3 bus power with respect to the 1 (common) bus
7. Verify the eight diagnostic LEDs on the iLink CTP board. (On power up or reset, these LEDs will light sequentially, first in one direction, then the other, after which they will briefly clear. See the illustration below for normal operating indications.)

Figure 3.3 iLink CTP Board Diagnostic LEDs

LED 1: iBox to cartop input. Blinks approx. every 40mS. Remains OFF if input lost.
LED 2: Unintended motion indication. Normally OFF.
LED 3: Unintended motion indication. Normally OFF.
LED 4: Cartop to iBox output. Blinks approx. every 40mS. Remains OFF if output lost.
LED 5: Blinks every 40mS.
LED 6: ON for Inspection mode. OFF otherwise.
LED 7: Not used.
LED 8: Not used.

8. Install the cover on the iLink cartop interconnect box.
9. Verify that the iBox CARTOP LED is ON indicting that the iLink CTP board is communicating with the iBox. If not, verify that the CARTOP LINK wiring is connected as specified on the job prints. Additional troubleshooting information is available in Section 6. Please refer to “iControl Circuit Board Quick References” on page 6-75.
Verifying Door Operation

This section helps you verify that the door lock signal input is working properly.

1. Verify that the door related options required for this job are checked on the iView Safety screen. Please refer to “Setup - Safety - Configuration Tab” on page 9-151.
   - Top Access Landing
   - Top Access Rear
   - Bottom Access Landing
   - Bottom Access Rear
   - No Main String
   - No Main String Rear
   - Front Door Close Contact
   - Rear Door Close Contact
   - Rear Doors
   - Freight Door Option 1
   - Door Position Monitor

2. Simulate the opening of the front car gate by removing the wire from the GS terminal on the iBox.
   - The iBox status LED “Doors Locked” will turn Off.

3. Reconnect the GS terminal.

4. Run the elevator up or down at inspection speed. Remove the DLAT (Door Lock Access Top) input.
   - The elevator should immediately stop.
   - The Door Locked status LED will turn Off.

5. Reconnect the DLAT input. Repeat Step 4 for the DLAB input.

6. Reconnect the DLAB input. Repeat Step 4 for the DLMS input.

7. Reconnect the DLMS input.

8. Run the elevator at inspection speed. Move the Car Door Bypass switch to BYPASS.
   - The elevator should immediately stop since the door lock cannot be bypassed while on Machine Room Inspection.

9. Move the Car Door Bypass switch back to Off.
Verifying the Safety Configuration

Verify that the safety options required for this job are checked on the iView Safety screen. Please refer to “Setup - Safety - Configuration Tab” on page 9-151. Any options that are checked, but not operational, will require a jumper to allow the car to operate on Inspection (inputs must be high).

Exit Construction Mode

Perform the following checks before exiting construction mode:

1. On the iBox, verify that the green CARTOP LED is lighted indicating that the controller is communicating with the cartop processor board. If not, check the CARTOP LINK wiring. The terminals must be connected as follows: (iBox TX+ and TX- terminals to CTP board RX+ and RX- terminals. iBox RX+ and RX- terminals to CTP board TX+ and TX- terminals.)
2. In iView, display the Operational Status tab. Run the car and monitor the Position - Logical and Position - Cartop values. Verify that the values increase when the car is moving in the up direction. The value(s) could be negative, in which case they must become less negative when the car moves in the up direction.
3. As the car moves, monitor the Leveling Sensor indicators on the Operational Status tab. Verify that the sequence is correct. When the car is traveling in the up direction, the sequence should be, Front/Rear Up leveling marker, followed by Front/Rear Door zone, followed by Front/Rear Down leveling marker.

To exit construction mode:

1. From the iView Write privilege menu, select Acquire. The iBox LCD will display a message requesting write privileges for iView.
2. On the iBox, press the “Yes” (1) softkey to assign write privileges to iView.
3. Open the Safety screen.
4. Click the Construction Mode check box (remove check mark).
5. Click the Send button.
6. You must then re-learn the Safety Configuration. Please refer to “Learning the Safety Configuration” on page 2-44.
Running on Machine Room Inspection

When you are ready to run the elevator on Inspection:

1. Verify the iBox Computer, Safety A, Safety B, and Cartop status LEDs are lighted solidly green.
2. Move the Inspection switch to the INSP position.
3. Move the Controller Stop switch to the RUN position.
   Within 5 seconds, the Safety OK and Doors Locked LEDs should be on and the Fault LED should be off.
4. Verify that Car Door Bypass and Hall Door Bypass iBox switches are set to the OFF position.
5. Verify that the car is in Machine Room Inspection on the iBox or in iView. If the car is in another inspection mode (i.e., Cartop Inspection, In-car Inspection, or Hoistway Access), turn them off. The INCT, INA, and INCP inputs on the left edge of the iBox should be high (110VDC).
6. Press and hold the iBox Enable button, then press the Up or Down button to run the car on inspection. Run the car away from the terminal landing.
7. On the iBox or on the iView Hoistway screen, verify car speed (Actual Speed). Use the iBox or iView Actual Speed as the speed reference. Use TORQMAX drive parameter LF22 to calibrate speed if required. Please refer to “Verify Pattern Command and Drive Speed Feedback” on 2-55.
Verifying Quadrature Pulse Sequence and Encoder Resolution

Position Encoder Resolution

Verify that Position Encoder Resolution (Pattern Configuration/Common tab) is correct. When the iLand landing system is mounted on the car top with the encoder wheel against the hoistway rail, Position Encoder Resolution is 348 (256 for iLand H) pulses/ft. (Please refer to “iLand Landing System” on page 3-2.)

Quadrature Pulse Sequence

The quadrature pulse sequence must be verified before the hoistway can be learned.

1. Connect to the controller using iView.
2. Open the Hoistway screen. Display the Faults tab.
3. Move the car up the hoistway. Verify that Actual Position and Cartop Position increase.

If the quadrature pulses are reversed, the Position Quadrature Reversed fault will appear in the Faults display after the elevator moves about two feet. (The Actual position may decrease as the car moves up and increase as the car moves down.) If indications are not correct:

• Check the DP1+/DP1- and DP2+/DP2- connections to the iBox and iLink (refer to the job prints).
• If the connections are correct, use a multi-meter to test that the positive- and negative-going pulses are arriving at the terminals. The streams should pulse between -15 and +15 volts.
• If the signals are not arriving properly, check the cartop connection between the iLand landing system and the iLink interconnect box. (Note that the Front Door/Front Magnets cable must be present between the interconnect box and the landing system regardless of your door/magnet configuration because it provides power to the landing system.)

5. If iLand to iLink cabling is correct, first test the continuity of the cables, then check the traveler connection between the iLink and the iBox for correct connections and continuity.
Prepare for Final Adjustments
This section describes preparing for final adjustment.

Door Operator
The door operator must be working properly before final adjustment.

1. Verify that the door fuses are properly installed.
2. Verify that the iBox Car Door Bypass and Hoistway Door Bypass switches are OFF.
3. Check that all door equipment clutches, rollers, etc. are properly adjusted to correct running clearances.
4. Check the controller prints to make sure any door operator diode installation instructions have been followed (especially for G.A.L. door operators).
5. Verify that all hoistway and car doors are closed and locked.
6. Run the car through the hoistway on inspection mode to make sure the hoistway is completely clear.

Counterweight Learn Procedure
This procedure allows the controller to learn the hoistway position at which the car and counterweight are at the same height. It must be performed if the controller will be using Earthquake operation, and it is helpful for counterweight balancing and pre-torque gain adjustment.

1. Move the car until the car and the counterweight are at the same height in the hoistway.
2. Place the iBox Inspection switch in the INSP position.
3. Place the iBox Learn switch in the ON position.
4. Display the Counterweight setup tab (View > Setup > Counterweight).

5. If Not ready is lighted, follow the instructions in the message window until Ready is lighted.
6. With Ready lighted, click the Learn button.

The controller will learn the car/counterweight position and the Done indicator will light. The learned Counterweight position is displayed on the Setup > Counterweight tab.

7. Set the iBox Learn switch to OFF and the iBox Inspection switch to NORM.
Counterweight Balancing

On modernizations, the weight of the car is often changed but compensating adjustments to the counterweight are sometimes overlooked. This adjustment is important for achieving desired performance and ride characteristics. The following are two ways in which the car / counterweight balance can be verified:

**Option 1 (preferred method)**

1. Place a balanced load in the car (specified percentage of full load; typically 40%).
2. On Inspection, run the car to the middle of the hoistway to the position learned by performing the Counterweight Learn Procedure (see “Counterweight Learn Procedure” on page 3-28). Verify the position using the Actual Position displayed on the Operational Status tab.
3. Turn controller power OFF.
4. Use a portable supply to inject sufficient DC voltage at controller terminals B1 and B2 to lift the brake. (Or, manually lift the brake.)
5. Watch the car to see if it drifts. If not, the car and counterweight are balanced.
   - If the car drifts up, remove weight from the counterweight or add weight to the car and repeat the balancing procedure.
   - If the car drifts down, add weight to the counterweight or remove weight from the car and repeat the balancing procedure.
   - For a drum machine, follow the manufacturer counterweighting recommendations and test the drum machine limit switches.
6. When car and counterweight are balanced, record the actual weight in the car for future reference. Balanced load = _____________lbs.
7. Restore controller power

**Option 2**

1. Place a balanced load in the car (specified percentage of full load; typically 40%).
2. On Inspection, run the car to the middle of the hoistway to the position learned by performing the Counterweight Learn Procedure (see “Counterweight Learn Procedure” on page 3-28). Verify the position using the Actual Position displayed on the Operational Status tab.
3. On the TORQMAX drive keypad, monitor the phase current parameter LF.93 while the car is traveling at steady speed (not accelerating or decelerating).
4. Starting from the middle of the hoistway each time, run the car up and then down and note the current in each direction. If the currents are equal, the counterweight is close to the correct value.
   - If more current is required to run the car up, add weight to the counterweight or remove weight from the car and repeat the balancing procedure.
   - If more current is required to run the car down, remove weight from the counterweight or add weight to the car and repeat the balancing procedure.
   - For a drum machine, follow the manufacturer counterweighting recommendations and test the drum machine limit switches.
5. When the car and counterweight are balanced, record the actual weight in the car for future reference. Balanced load = _____________lbs.
Run Testing

1. Verify all landing system magnets are installed according to job prints and instructions.
2. On inspection mode, run the car to the midpoint of the hoistway.
3. Set the iBox Test switch to the ON position.
4. Place the car on Machine Room Inspection, with Cartop Inspection OFF.

At this point, the car should be on Inspection operation and running without oscillation. There may be substantial rollback when the car first starts.

5. On the iView Virtual Oscilloscope, set Test point 1 to Pattern (Command).
6. Use a digital voltmeter to check the pattern voltage on iBox test point STP1 with respect to the Common terminal.
7. Verify that Pattern scaling is at 100% (Configuration > Pattern > Common tab) and the Inspection - High speed parameter is at 10% of contract speed (Configuration > Pattern > Modes tab). Maximum value for Inspection - High speed is 150fpm. Verify that the Reduced inspection speed option is enabled and that Inspection - Low speed is set to 25 fpm.
8. Run the car on Inspection and check the voltage at iBox test point STP1. If 8.0VDC is equal to contract speed, then the reading at 10% should be 0.8VDC (+/- 5%).
9. Set Inspection - High speed to 50fpm.
10. On Inspection, run the car to, or near, the bottom landing. Use test weights to load the car to 125% of full load in preparation for checking the ability of the brake to hold this weight.

**Danger**

If the brake does not hold, the car may slide into the pit. Use extreme caution.

11. On Machine Room Inspection, run the car up the hoistway sufficiently to allow a down direction run.
12. On Machine Room Inspection, run the car down the hoistway. While the car is moving, set the iBox Controller Stop switch to STOP to force the brake to apply while the car is moving. If necessary, adjust the brake to hold the load.
13. Remove the weights from the car.
Empty Car Tests

With the car on Machine Room Inspection and with test weights removed (empty car), the following steps allow you to adjust the response of the car to reduce empty car rollback while avoiding the oscillations that can occur if too much gain is adjusted into the system. For these tests you may use a storage oscilloscope capable of a 1.0 centimeter per second sweep rate or you may use the iView Virtual Oscilloscope.

1. On the iView Virtual Oscilloscope, set Test point 1 to Speed Feedback. Adjust the Virtual Oscilloscope for greater sensitivity and shorter timer period. Please refer to “Controller - Layouts” on page 9-157. If you are using a storage oscilloscope, monitor iBox test point STP1 (lower right side of the iBox) with respect to Common.

The empty car will probably drift up due to the counterweight, even when an attempt is made to move it down. Perform the following:

- TORQMAX Drive: Verify the drive gain parameters:
  - A.LF.31 - Kp speed accel (proportional gain) = 3000
  - d.LF.31 - Kp speed decel (proportional gain) = 3000
  - A.LF.32 - Ki speed accel (integral gain) = 350
  - d.LF.32 - Ki speed decel (integral gain) = 250

2. Adjust brake Pick delay and Speed pick delay 1 (iView Configuration > Brake > Timers tab) to coordinate the application of the speed pattern with the picking of the brake to avoid movement of the car under the brake or rollback of the car. A DRO fault may occur if brake Pick delay is reduced to a value lower than 0.30. Generally, brake Pick delay is set to 0.40 and Speed pick delay 1 is set to 0.50 or slightly higher. (For TORQMAX drives, verify that LF.70 = 0.300 (Delay to turn on DRO).

3. Experiment with improving response. A little rollback at this point is not critical as later adjustments will compensate for it.

4. Verify that Pattern scaling is 100% (Configuration > Pattern > Common tab).

5. Using the iView Operational Status tab (Speed/Actual) or a hand held tachometer, verify that Machine Room Inspection car speed is 10% of Standard - High speed (contract speed) and matches the Inspection - High speed setting. Please refer to “Following Error Margin” on page 2-56 if necessary.

Danger

At this point, the Fault/Function Bypass switch on the iBox should be in the OFF position. Fix all faults so that no fault is bypassed before proceeding. If this is not possible, exercise EXTREME CAUTION while making final adjustments.
In This Section

This section describes the sequence of steps required to make final adjustments to, and complete final inspection of, the elevator system. At this point, all steps in Sections 2 and 3 should have been completed.

- **Learning the Floor Heights** (see page 4-2).
- **Verifying One-Floor Run Operation** (see page 4-3).
- **Reaching Contract Speed** (see page 4-7).
- **Learning Normal & Emergency Terminal Limit Switches** (see page 4-9).
- **Shaping the Speed Profile** (see page 4-12).
- **Controlling the Start of Car Motion** (see page 4-16).
- **Calibrating the Floor Offsets** (see page 4-22).
- **Adjusting Leveling and Final Stop** (see page 4-25).
- **Load Weigher Adjustment for Dispatching** (see page 4-29).
- **Pre-Start Sequence** (see page 4-34).
- **Calibration and Verification of Safety Functions** (see page 4-40).
- **Safety Tests** (see page 4-42).
- **Terminal Switch Faults** (see page 4-54).
Learning Floor Heights

Learning the building includes determining the location of each floor. iControl does this by counting pulses sent by the position encoder on the iLand landing system as the elevator travels the entire length of the hoistway from bottom to top. The iLand Compact position encoder produces 348 pulses per foot of travel.

Note

This is one of the procedures that must be successfully completed before running the elevator on Test or Normal operation. Before proceeding, be certain you have verified the landing system quadrature pulse sequence. Please refer to “Verifying Quadrature Pulse Sequence and Encoder Resolution ” on page 3-27.

Floor Height Learn Procedure

The speed at which the car learns the hoistway is determined by the Inspection /High Speed parameter (Configuration > Pattern > Modes tab). For learning floor heights, we recommend setting Inspection/High Speed between 50fpm and 125fpm.

1. Place the car on Inspection operation (iBox Inspection switch in the INSP position). Check the iBox LCD display to verify that it is on Machine Room Insp.
2. On Machine Room Inspection, run the car down until the car is stopped by the normal limit switch (DNTD). For floor height learning to begin, the ULM signal must be on, DLM must be off, DNTD must be off, and UNTD must be on.
3. Place the iBox Learn switch in the ON position.
4. In iView, display the Floor Heights Learn layout by selecting Floor Heights from the View > Layouts menu and then clicking the Learn tab on the Setup > Floor Heights tab.
5. On the Setup > Floor Heights > Learn tab, select Manual or Auto learn type. (On Manual, you run the car through the hoistway using the iBox Enable and Up/Down buttons. On Auto, iControl will run the car through the hoistway automatically.)
6. If Not Ready is lighted, perform the instructions shown in the message window.
   - The Ready indicator lights when the car is placed in Inspection mode (with the Learn switch ON and the ULM sensor is ON without DLM).
7. When Ready is lighted, click Learn. The In Progress indicator lights when the Learn button is clicked.
   - If Manual learn type was selected, you are prompted to press and hold the iBox Enable and Up buttons. The elevator will move up the hoistway at Inspection speed.
   - You may click Abort at any time to abort the procedure. If the learn process is aborted, the last saved complete set of values is retained.
8. The procedure is complete when the up normal limit switch (UNTD) is activated (if Manual learn type, you are prompted to release the Enable and Up buttons) and Done is lighted.
9. Set the iBox Learn switch to the OFF position.
10. Click the screen refresh button ( ) to update the learned floor height information.
11. On the Hoistway pane, verify that the learned floor heights appear accurate. Also check the iBox Safety OK status. (Occasionally, the Final Limit Switch may open at the end of a Learn run.)

   For more information about the Floor Heights Learn procedure and the Status messages see “Setup - Floor Heights - Learn Tab” on page 9-146.

Verifying One Floor Run Operation

The first step in verifying normal, one-floor run operation is to verify proper correction, run, and stopping.

Verifying Correction, Run, and Stop

1. Arrange the elevator for empty car conditions.
2. On the Configuration > Pattern > Common tab, set Pattern scaling to 50%. This setting allows the car to run at 50% of the commanded speed.
3. Move the car on Inspection to a location between floors, more than one foot away from a landing so that no leveling sensors are engaged.
4. Place the car in Test mode (iBox Test switch ON). Set the iBox Fault Bypass switch to ON.
5. Set the terminal limit switches to their default settings (View > Setup > Terminal Switches) to allow the car to run.
6. Take the car out of Inspection operation (iBox Inspection switch in the NORM position). The car will perform a Terminal Synchronization, using the learned position of the sensor to update the current position reported by the position encoder.

   If a Limits Switches Checksum Fault is generated when the car is removed from Inspection operation, it will be necessary to set the terminal switches to default values before proceeding (View > Setup > Terminal Switches tab). Perform the procedure shown in the Terminal Learn message window titled “To default terminal switches, please do the following:”.

7. If the car corrects and stops properly, proceed to Initiating a One Floor Run later in this section.
Final Adjustment

**If the Car Does Not Stop and Correct Properly**
- Check the iBox status display. Verify:
  - ULM, DLM, and DZ signals are working properly
  - Safety OK = ON - safety string is made up.
  - Doors Locked= ON - all doors are locked.
  - Inspection = OFF - not on Inspection operation.
  - Fault = OFF - no faults are active.

**Initiating a One Floor Run**

**Note**
Because we have not yet learned Normal and Emergency Terminal Limit switches, stay away from the terminals to avoid tripping faults. Remember that Fault Bypasses are on a 15-minute limit. If you need more time, set Fault Bypass quickly to OFF, then back to ON (within two seconds).

The car should now be at a floor. Avoid running the car close to a terminal landing. To initiate a one-floor run:

1. Register a car call one floor above or below the current car position:
   - Click the Car Call Registration button.
   - Select Car Calls, then Front or Rear panel.
   - Click a floor selection button.

**If Initiation is not Successful**
If the car does not move, check the iBox status display. Verify:
- Safety OK = ON - safety string is made up.
- Doors Locked = ON - all doors are locked.
- Inspection = OFF - the car is not on Inspection operation.
- Faults = OFF - there are no active faults.
Verifying a One Floor Run

During a one-floor run, observe the following:

- When the car starts, note that on the Hoistway display, the position indicator changes to the next floor just before reaching the desired floor.

- The car will decelerate to a point 6” (152.4 mm) before the destination floor where the Level Up or Level Down sensor will activate the associated indicator. This can be observed on the Setup > Floor Heights > Learn tab.

<table>
<thead>
<tr>
<th>Leveling sensor</th>
<th>Rear</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front</td>
<td></td>
</tr>
<tr>
<td>Up leveling marker</td>
<td>Up leveling marker</td>
</tr>
<tr>
<td>Door zone</td>
<td>Door zone</td>
</tr>
<tr>
<td>Down leveling marker</td>
<td>Down leveling marker</td>
</tr>
</tbody>
</table>

- The car will continue until it reaches a point 3” (76.2 mm) before the floor, then the Door Zone input will activate. The Door Zone Rear input will be active if the floor has rear doors.

- The elevator will continue to level into the floor and stop. The final leveling speed should be set from 2 to 8 fpm (0.01 to 0.04 m/s). Your actual speed will be a fraction of that since Pattern scaling is set to 50% at this time.

1. On the iView Virtual Oscilloscope:
   - Set Test point 1 to Pattern Command
   - Set Test point 2 to Speed Feedback
     (8-volts equals contract speed)

2. Run the car between floors to any intermediate landings (avoid activating terminal switches).

3. Observe that the car starts, accelerates, then decelerates into the floor and stops. If the car overruns a floor, the relevel function will be activated. The Leveling Speed on the first approach to a floor and the Releveling Speed (if releveling is necessary) are two separately programmable values. These values are set on the Configuration > Pattern > Common tab.
Verify Releveling

1. When the car is at a floor, simulate overrunning by temporarily changing the floor height Offset (Configuration > Floor Heights > Floor Offsets tab) to 0.50” and pressing the Send button.

2. Observe the releveling operation. (Return Offset to the proper setting and press Send.)

3. Monitor the brake voltage on terminals B1 to B2 (located just below the iBox). Make sure that a relevel brake voltage exists to avert stalling or excessive current draw by the AC Drive during a relevel operation. Gearless machines are intended to drag the brake during a relevel, so a partial pick is appropriate. Note, however, that if the brake did not drop fully before the relevel, the reduced brake voltage may still hold the brake fully picked.

4. Note that the relevel brake voltage is the same as pick voltage if you are using a low current brake.

Note

Do not spend a lot of time here working on the brake, just be sure the brake does not stall the motor on a relevel. Final brake adjustment is a later topic in this section. (Please refer to “Brake Parameter Adjustments” on page 4-19.)
Reaching Contract Speed

**Note**

Be sure to read this entire section before performing the following procedure. The car must be on Test operation (iBox Test switch to ON) throughout the setup procedure. This prevents the doors from operating during adjustment.

**Final Adjustment Before Running at Contract Speed**

The following adjustments must be made in preparation for contract speed operation.

**Speed Pick Delay**

To achieve proper starting, without rollback or snapping away from the floor, a variable delay in the application of the pattern signal is provided. Speed pick delay 1, on the Configuration > Brake > Control tab, determines the amount of delay from the time the drive processor activates the Run Enable signal to the time the pattern generator sends out the pattern signal.

1. The brake should just clear the brake drum as the car is beginning to accelerate. The recommended initial setting for (Brake) *Pick delay* = 0.400 and for *Speed Pick Delay 1* = 0.500. The correct settings can be determined by watching the drive sheave. Some rollback may be tolerated for now, but will be corrected later.

2. If the Drive On Fault (DRO) appears on the iBox LCD display when direction is picked, first increase Pick delay and then increase Speed pick delay 1 to coordinate the application of the pattern signal with the picking of the brake.

**Figure 4.1 Timer Diagram**
Final Adjustment

Pattern Scaling

1. Using Pattern scaling on the Configuration > Pattern > Common tab, increase contract speed in 10% increments until the car is running at 80% of contract speed. Monitor performance on the iView Virtual Oscilloscope. Set:
   - Test point 1 to Pattern Command (8V equals contract speed at 100% scaling)
   - Test point 2 to Speed Feedback (8V equals contract speed at 100% scaling)

2. Check for severe overshoot by monitoring Speed/Actual on the Operational Status tab. Excessive overshoot can trip the governor. If severe overshoot does not occur, continue to increase car speed in 10% increments by increasing Pattern scaling incrementally up to a maximum of 100%. Verify that car speed is peaking at no more than 3% over contract speed (10 fpm @ 350 fpm, 15 fpm @ 500 fpm, etc.).

3. If overshoot occurs, reducing Standard/Low roll jerk (Configuration > Pattern > Modes tab) may help, however, a Safety A (or B) Contract Overspeed Fault will occur if Standard/Low roll jerk is reduced too much. Increasing the following TORQMAX drive parameters will help to reduce overshoot:
   - A.LF.31 Kp speed accel: Proportional gain
   - d.LF.31 Kp speed decel: Proportional gain

4. Verify car speed by monitoring Speed/Actual on the Operational Status tab, or use a hand-held tachometer. If car speed is still not correct, verify the following:
   - LF.11, LF.20, LF.21, LF.22, LF.23, and LF.42 are set correctly.
   - Pattern scaling is 100%.
   - If the car is running faster than contract speed parameter LF.20, decrease the value of high speed parameter LF.42.
   - If the car is running slower than contract speed parameter LF.20, provided LF.42 is set to the same value as LF.20, then verify that Gear Ratio Reduction Parameter LF.22 is set correctly. If the gear ratio is not correct, it is possible to increase the value of LF.22 in small (0.10) increments to reach contract speed.

Once the car is running at or near contract speed, you must learn the terminal landings in order to safely run the car to the terminal landings (required before performing drive fine tuning). (Please refer to “Learning Normal & Emergency Terminal Limit Switches” on page 4-9.)

Caution

Before learning the terminal switches, you can trip on terminal position and/or velocity faults when the terminal switches (UNT1, DNT1, etc.) are activated. Avoid activating the terminal switches until they have been learned.
Learning Normal & Emergency Terminal Limit Switches

The Normal Terminal Slowdown Limit (NT) and Emergency Terminal Limit Limit (ETS) switch Learn operation records car speed and position at the time each terminal switch is activated on a normal approach to either terminal landing. This Learn operation should be performed again after all parameters have been fully adjusted.

Note

The Terminal Switches Learn procedure must be repeated whenever Pattern profile parameters are modified, since the speed at which the car passes these switches will be different.

To Learn the speeds and positions associated with each NTS and ETS switch:
1. Place the iBox Test switch in the ON position.
2. Place the iBox Inspection switch in the INSP position.
3. In iView, display the Terminal Switches layout (View > Layout > Terminal Switches)
4. Refer to the job prints to determine which Normal Terminal Limit switches (UNTn and DNTn) are required for this installation and where they should be positioned in the hoistway. Verify that the Learned position on the Diagnostics > Terminal Switches Status tab corresponds to the job prints. If not, refer to the Setup > Terminal Switches tab and perform the procedure titled “To default terminal switches, please do the following.”

5. Move the car to the bottom landing (on Inspection).

6. Place the iBox Inspection switch in the NORM position to allow the car to synchronize to a floor.

7. Place the iBox Learn switch in the ON position.

8. If the Not Ready indicator is lighted (Setup > Terminal Switches tab), perform any instructions shown in the message window.

9. When the Ready indicator is lighted, click Learn. The In Progress indicator will light.

10. You may click Abort at any time to abort the procedure. If the learn process is aborted, the last saved complete set of values is retained.

11. Place a call to the top terminal landing using the Call Registration panel.

12. When the car stops at the top landing, place a call to the bottom terminal landing.

13. When the procedure is complete, the Done indicator lights and you are prompted to return the Learn switch to the OFF position. The new NT and ETS switch speeds and positions are automatically saved to the controller.

14. The learned NT and ETS values are displayed on the Diagnostics > Terminal Switches Status tab. Verify that all of the switches required for this job have reasonable values displayed. If only UNT1 and DNT1 switches are used in addition to UNT5 and DNT5 (always present), the UNT1 and DNT1 values must be 95% of contract speed or less. If more NT switches are used, UNT1 and DNT1 may have learned speeds equal to contract speed, but all other NT switches must have learned speeds 95% of contract speed or less.

   If some limit switches have learn speeds in excess of their maximum, those switches must be moved closer to the terminal landings. Alternately, if reduced performance can be tolerated, the Standard/Deceleration parameter can be reduced.

15. Make several full hatch runs. After each run, on the Diagnostics > Terminal Switches Status tab, verify that there is a comfortable margin between the last pass speeds and the Over speed 1 tripping thresholds for the terminal switches used on this job. Also verify that there is a comfortable margin between the last pass positions and the Upper and Lower limit position thresholds.

**Danger**

This procedure must be successfully performed before any passengers are allowed to use the elevator.
Fine Tuning the TORQMAX Drive

This section describes fine adjustments to the TORQMAX drive.

Up/Down High Speed Difference
1. Verify that Pattern Scaling is set to 100%.
2. If car speed, at high speed, is not the same in the up and down directions, verify the following:
   - Drive gain parameters LF.31 and LF.32 are set properly. (If set too high, there may be oscillation in the car.)
   - Pattern voltage between (F4 terminals) X2-14 (Analog IN +) and X2-15 (Analog IN -) or (F5 terminals) X2A-1 and X2A-2 on the TORQMAX drive equals -10.00 VDC in the UP direction and +10 VDC in the DOWN direction. If the UP/DN pattern voltage is different, perform the adjustments described in Section 2. (Please refer to “Verify Pattern Command and Drive Speed Feedback” on page 2-55.)
3. Use the Actual Speed indication or a hand held tachometer to verify car speed. The elevator should now be running at or near contract speed in both up and down directions.
   - If the elevator is running at a higher speed than parameter LF.20 Contract Speed, decrease the value of parameter LF.42 High Speed.
   - If the elevator is running at a slower speed than parameter LF.20 Contract Speed, provided LF.42 is set at the same value as LF.20, increase or decrease the value of LF.22 in small increments (0.10) to reach contract speed.

Car Does Not Reach High Speed
1. Verify that there is +10 VDC between (F4 terminals) X2-14 (Analog IN +) and X2-15 (Analog IN -) or (F5 terminals) X2A-1 and X2A-2 on the TORQMAX drive. If the voltage is not correct, refer to Up/Down High Speed Difference above.
2. Verify that the following drive parameters are set correctly:
   - LF.11 Rated Motor Speed (RPM)
   - LF.20 Contract Speed (FPM)
   - LF.21 Traction Sheave Diameter (inches)
   - LF.22 Gear Reduction Ratio
   - LF.23 Roping Ratio
   - LF.42 High Speed (FPM)

Once tuning is complete, relearn the terminal switches. (Please refer to “Learning Normal & Emergency Terminal Limit Switches” on page 4-9.) Then perform the Shaping the Speed Profile procedure. (Please refer to “Shaping the Speed Profile” on page 4-12.)
Shaping the Speed Profile

The pattern graph below charts the profile of car movement between any two landings and calls out the parameters that define profile shape. The value of the pattern parameters is very important in determining the quality of the ride and the overall performance of the elevator. The most critical parameters are Deceleration, Flare Jerk, Approach Deceleration, Approach Jerk and Leveling Speed since they define the final stop and therefore greatly affect the floor to floor travel time. We describe each parameter in sequence and their relationship to problems you may encounter.

Figure 4.2 Pattern Graph

Profile Parameters

- **Initial jerk** - defines the transition from zero speed to full acceleration. As Initial Jerk increases, the profile transitions more quickly from starting to maximum acceleration. Values typically range from 4.0 to 8.0 ft/s³ (1.219 to 2.438 m/s³) with higher values resulting in a sharper start.

- **Acceleration** - determines the maximum acceleration for the profile. Determines the maximum current delivered by the AC Drive during acceleration. The maximum value is typically 4.0 ft/s² (1.219 m/s²) and the minimum is usually not less than 2.5 ft/s² (0.762 m/s²). Values higher than 4.0 ft/s² (1.219 m/s²) are possible but do not yield significant improvements in performance.

- **High roll jerk** - is used on short runs where the car is not able to reach High Speed before deceleration must begin. High Roll Jerk determines how quickly the profile transitions from maximum to zero acceleration and zero to maximum deceleration. As High Roll Jerk increases, the profile transitions more quickly. Lower values provide greater comfort but are harder to fit into the shortest one-floor-runs. We recommend that you identify the shortest full height floor and use it when testing parameter values. Typical values range from a minimum of 4.0 ft/s³ to a maximum of 8.0 ft/s³.
Shaping the Speed Profile

- **Low roll jerk** - is used on runs where the car is able to reach High Speed before deceleration must begin. Low Roll Jerk determines how quickly the profile transitions from maximum to zero acceleration (High Speed) and zero to maximum deceleration. As Low Roll Jerk increases, the profile transitions more quickly. Lower values provide greater comfort. Typical values range from a minimum of 4.0 ft/s³ to a maximum of 8.0 ft/s³.

- **High speed** - determines the maximum speed for this profile. For the Standard Profile this is usually contract speed (ft/min).

- **Deceleration** - determines the maximum deceleration for this profile. The maximum value is typically 4.0 ft/s² and the minimum is usually not less than 2.0 ft/s² with more common values ranging from 2.75 ft/s² to 3.75 ft/s² (0.838 to 1.143 m/s²). The value of Deceleration is usually slightly less than the value of Acceleration (by 0.25 to 0.5).

- **Flare jerk** - defines the transition from maximum deceleration to near zero Speed or to Approach Deceleration. As Flare Jerk increases, the profile transitions more quickly from maximum deceleration to Approach Deceleration. Reduction of this parameter is often used to reduce the tendency to spot or stall near the end of deceleration, and/or to reduce any tendency for the deceleration rate, as experienced in the car, to bunch up (increase as the car approaches the floor). The limiting factor in reducing the value of Flare Jerk is the inability to fit the profile into the shortest normal one-floor-run.

- **Approach deceleration** - determines the deceleration rate for the transition from Flare Jerk to Approach Jerk.

- **Approach jerk** - defines the transition from approach deceleration to Leveling Speed. As Approach Jerk increases, the profile transitions more quickly from Approach Deceleration to Leveling Speed.

- **Leveling speed** - determines the Speed at which the elevator will level into the floor.

- **Leveling distance** - determines the stabilized distance the elevator will travel before arriving at the destination floor.

Profiles

There are eight programmable profiles addressed on the Pattern Screen:

- **Standard Profile** - used under normal operating conditions. Unless otherwise specified, suggested profile parameter adjustments are assumed to be referring to Standard Profile parameters.

- **Earthquake Profile** - used if an earthquake is sensed by the elevator system during normal operation (EQI input activated). If you have earthquake operation, you will verify proper operation during testing.

- **Emergency Power Profile** - used when the Emergency Power input (EPI) is activated, indicating a loss of commercial power and that the car is running on generator power.

- **Emergency Slowdown Profile** - used when the system requires faster than normal deceleration. It is used in response to situations such as the normal terminal stopping device being activated or loss of the quadrature signal (positioning signal). Note that the Emergency rate limited stop parameter (Configuration > Drive > General tab) will limit how fast this profile can slow down the car. Increasing this parameter will allow higher deceleration rates to be used for the Emergency Slowdown Profile.
• **Correction Profile** - used when the system is not confident of the car position in the hoistway. The car proceeds to a known position using the Correction Profile parameters in order to synchronize its position information.

• **Inspection Profile** - used when the system is placed on Inspection/Access operation. The Inspection Profile is also used when the system is learning the building floor heights.

• **Alternate 1** - used when the Alternate Speed Profile One input (ASP1) is activated.

• **Alternate 2** - used when the Alternate Speed Profile Two input (ASP2) is activated.

### Setting Pattern Parameters

By viewing the commanded pattern and car speed feedback on the iView Virtual Oscilloscope screen as the car is running, any discontinuity in the idealized speed profile can be observed.

- On the iView Virtual Oscilloscope screen:
  - Set Test point 1 = Pattern (Command)
  - Set Test point 2 = Speed Feedback

**Note**

Unless otherwise specified, suggested parameter adjustments are assumed to be referring to Standard Profile parameters.

• **Initial Values for Pattern Parameters** - Pattern shape preset can be used to enter preset values for the Standard profile parameters based on the high speed (contract speed) of the elevator and the selected shape type (Slow, Moderate or Fast). This provides an excellent starting point. Please refer to “Pattern shape preset” on page 9-135.

• **Contract Speed Overshoot and Current Limiting** - To prevent contract speed overshoot and/or current limiting from the AC Drive, the Acceleration and Low Roll Jerk parameters can be reduced. The Low Roll Jerk rate has a slightly greater effect on overshoot at high speed than does Acceleration. The Acceleration parameter has the most effect on current limiting. Observe actual car response on iBox test point STP2 and GND (with Virtual Oscilloscope Test point 2 set to Speed Feedback) to verify that there is no overshoot.

• **Motor Current Limiting** - If running out of motor current near the end of Acceleration becomes a problem, as is evidenced by the AC motor current on the Drive keypad during a full load UP operation:
  - TORQMAX drive - set parameter LF.36 Maximum Torque = 300 (3x LF.17). This will automatically adjust the current limit.
  - If this does not help, reduce the value of Acceleration. Another possibility is to decrease the value of Low Roll Jerk so that there is a smooth transition from maximum acceleration to contract speed. Also verify that sufficient motor voltage is being developed at high speed.
Shaping the Speed Profile

• **Slope of Acceleration / Deceleration** - Ideally, the slope of acceleration in volts per second should be equal to or slightly greater than the slope of deceleration as viewed on an oscilloscope connected to iBox test point STP1 and COM (with Virtual Oscilloscope Test point 1 set to Speed Feedback Filtered). To get approximately equal acceleration and deceleration speeds in a system where tracking accuracy is very good, Acceleration can be equal to Deceleration. If tracking is less accurate, set Acceleration greater than Deceleration to get the same effective rate of deceleration as acceleration.

• **Final Approach to the Floor** - Final approach to the floor can be customized in many different ways. If tracking accuracy is very good, you can probably program as follows on the iView Pattern > Common tab:
  - Leveling speed = Your desired leveling speed. A typical number is from 2 to 4.
  - Leveling Distance = your choice. A typical number is from 0.12 to 0.25.
    If tracking is not perfect, you can begin to introduce values in Leveling Speed and Distance that allow you to mold the shape of the last few inches of approach.

• **Excessive Motor Noise** - If there is excessive motor noise or if acceleration or deceleration feels rough, reduce Acceleration and/or Deceleration to provide the desired results. Also, verify that:
  - TORQMAX Drive - At lower speeds the drive automatically selects a lower carrier frequency to produce more current from the drive. If required, adjust LF.38 Switching Frequency = 0. This will set the carrier frequency to 8 KHz. In addition, reduce drive gain value, LF.31 and LF.32. DO NOT reduce LF.31 below 1200 or LF.32 below 800 as a loss of control will result.

• **Bunching up of Deceleration Rate** - If you are observing a bunching up of deceleration rate (an increase in the deceleration rate as you reach the last few feet of approach to the floor), it is generally due to inaccurate tracking. You must improve accuracy or lower the value of the Flare Jerk and/or Approach Jerk parameters. Remember that there are very real limits to how low you can set these parameters (1.75 ft/s³ is often as low as you can go).
Controlling Initial Start of Car Motion

Some gearless machines may exhibit rollback at the start of car motion. Geared machines rarely exhibit rollback. To control rollback at the start of car motion:

• Pre-torque implementation for systems with analog load weighers
• Adjust drive control parameters specifically designed for the start of motion
• Perform a sophisticated brake adjustment (iField Brake Module only)

Pre-torque Adjustments

For installations using an analog load weigher, load information can be used to provide “pre-torquing” of the hoist motor as necessary to accommodate load changes at a floor and prevent sagging or rollback.

Note

Performing safety and buffer tests described later in this section will probably require that you repeat the pre-torque adjustment described here.

Pre-torque adjustment includes:

• Load weigher sensor adjustment
• Balanced load determination
• Pre-torque gain control adjustments

Load Weigher Sensor Adjustment

Review the installation and adjustment instructions for the load weigher and verify that all steps have been completed, including:

• Rope Tension Sensing Load Weigher - perform the procedures described in the EMCO Load Weigher section of this manual. See “Calibration” on page 5-55.
• Crosshead Deflection Load Weigher - perform the procedures described in the “Adjustments” section of the K-Weigh Instruction Manual.
• Isolated Platform Load Weigher - perform the adjustment procedures described in the MCE Load Weigher section of this manual. See “Adjust the Amplifier” on page 5-66

Next, verify that the iBox is receiving the load weigher signals properly.

1. Place the car on Independent service and move the car to the landing at which the test weights are stored.
2. Open the iView Virtual Oscilloscope screen and select Load Weigher (Raw) on Test point 1.
3. With the car empty, verify that the Test point 1 reading is at least 0.5 but not greater than 1.5.
4. Place a full load in the car. Verify that the Test point 1 value is now between 5.5 and 8.0. If necessary, adjust trimpot LW ADJ on the CTP (cartop) board in the iLink enclosure to achieve the correct reading.

Pretorque Gain Adjustments

1. Place a balanced load in the car (the balanced load weight recorded when performing the Counterweight Balancing procedure). Please refer to “Counterweight Balancing” on page 3-29.

2. With the car in Test mode (iBox TEST switch ON) move the car to the top floor.

3. On the Configuration > Drive > Pre-Torque tab, enable the Pretorque option and send the new selection to iControl.

4. On the Virtual Oscilloscope, select Load Weigher Balanced on Test point 1. If necessary, adjust the windows so that you can see the oscilloscope and the Pre-Torque parameters at the same time.

5. On the Configuration > Drive > Pre-Torque tab, adjust the Pretorque balance adjustment parameter until the digital readout for Test point 1, Load Weigher Balanced, is equal to or as close to zero (0.0) as possible.

6. If Error compensation, on the Configuration > Drive > Control tab, was increased to compensate for rollback, you may lower the value now.

7. Verify that Pretorque position compensation, on the Drive > Pre-torque tab is set to 0.0. If necessary, set it to 0.0 and Send it to the controller.

8. Verify that Pretorque gain, on the Drive > Pre-torque tab, is 0.0. If necessary, set it to 0.0 and Send it to the controller.

9. On the Configuration > Brake > Control tab, increase the value of Speed Pick Delay 1 to 2.0 seconds so that any rollback is easily detected.

10. Remove the weights from the car and move the car to one floor below the top landing.

11. Make a one-floor-run down. Check for rollback by either watching the motor or by monitoring the Speed Feedback signal on the Virtual Oscilloscope.
12. If rollback is detected, adjust the Pretorque gain parameter on the Drive > Pre-Torque tab, and again make a one-floor run down from one floor below the top landing. Repeat until rollback is no longer noticeable. Then verify that there is no rollback on a one-floor run going up from one floor below the top landing.

13. Run the car to the bottom landing. Make one-floor runs up and down, checking rollback.

14. If rollback is detected, decrease the value (less positive or more negative) of Pretorque position compensation, on the Drive > Pre-Torque tab. Repeat until no rollback is detected on one-floor runs up or down in the lower hoistway. If pull-through is detected, increase the value (more positive or less negative). Pretorque position compensation has a range of -5.000 to +5.000.

15. With an empty car, check throughout the hoistway. Verify no rollback is detected.

16. Place full load weight in the car. Check for rollback throughout the hoistway. Verify rollback is not detected. Adjust Pretorque gain, on the Drive Pre-Torque tab, if necessary.

17. Again remove all weight from the car. Check for rollback throughout the hoistway. Verify no rollback detected. If some rollback has been introduced by adjusting Pretorque gain for a full load, optimize settings for an empty car since this is a common condition.

18. Reduce Speed Pick Delay 1, on the Configuration > Brake > Control tab, to the minimum value which still allows the brake to lift fully before motion starts. You should not feel the car pulling out from under the brake. The brake should lift fully before motion starts, but avoid unnecessary delay in starting movement.

---

**Note**

If this car will be using the load weigher for dispatching functions, e.g. Light load anti-nuisance, etc., you may want to set the parameters and learn the load values at this time. Please refer to “Load Weigher Adjustment for Dispatching” on page 4-29.

---

**Drive Control Adjustments**

When Run Enable (RE) is active, the control system picks the main power contactor (PM Contactor) and enables the drive. The drive applies voltage to the AC motor to build up magnetic flux. The amount of time it takes to build up flux in the AC motor (from 200 to 500 ms) depends upon motor characteristics and temperature. AC drive logic detects the build up of flux in the motor and generates the Drive ON output. At this time, the motor may have developed enough torque to hold the load.

The motor no load current value is not high enough to hold the car at zero speed when the drive is enabled. The normal setting for no load current is 30% to 40% of full load current. Pick delay (Configuration > Brake > Control tab) is used to coordinate the picking of the brake with the build up of flux. If the delay is not sufficient, the flux will not build up fully and a DRO fault will occur. Speed pick delay 1 is used to delay the application of the pattern signal to the drive to prevent the car from moving under the brake.

- Pick delay must be adjusted to achieve smooth starts, prevent rollback, and prevent DRO faults.
- Speed pick delay 1 must be adjusted to prevent movement of the car under the brake.
Brake Parameter Adjustments

The iField braking module allows you to make some very refined brake adjustments for smooth picking to control rollback.

- First, find the level of brake excitation that results in a very gradual but complete picking of the brake:
  
  1. Place the car on Inspection (iBox Inspection switch in the INSP position). Set Pattern Scaling (Pattern/Common tab) to 10% to provide an inspection speed of about 5 to 10 fpm.

**Figure 4.3 Brake timing diagram for smooth picking**

2. Display the Configuration > Brake > Control tab and record the original parameters before making any changes. Verify the following settings:
   - Weakening delay = 0.00
   - Repick time = 0.00

3. Set the Pick voltage and the Hold voltage to ½ of the original value of Pick voltage.

4. Slowly increase both Pick and Hold voltages until the brake picks completely. The idea is to increase or decrease both Pick voltage and Hold voltage identically until the brake just barely picks all the way. Then, add 5 or 10 volts and verify that the brake still has a very slow, smooth picking motion (taking 1 to 1.5 seconds to pick). The goal is to find a brake voltage that allows the brake to transition slowly through the pressure-releasing part of the movement.

5. Set the Weakening voltage to the same value as Pick Voltage and Hold Voltage. For geared applications, if the brake holding voltage is not specified, set Weakening voltage and Hold voltage = Pick voltage.
6. Apply a maximum value of brake voltage, very briefly, at the start of movement. This gets the brake quickly to the point in the lifting process where a substantial amount of tension is released. This is done as follows:

- Set Pick voltage back to the original value to allow a high initial value of brake voltage.
- Set Repick time to 1.00 second to allow a slow transition through the pressure-releasing part of movement, after which the brake voltage briefly returns to a high value to ensure that the brake fully picks. (See the following note.)
- Increase the value of Weakening delay in 0.05 second increments until you see the brake move more quickly in the first part of its movement so it can reach the stage where the pressure is starting to be released. Typical values are between 0.10 to 0.45 seconds. The final result will often look as if the brake is lifting at a fairly constant rate, even though the initial voltage is high. This overcomes the natural tendency for a gearless brake to start lifting slowly and then faster the further it lifts.

**Note**

It is important to realize that full brake Pick voltage is automatically applied for about a second at the end of the brake Weakening delay, just after the brake has cleared the braking surface, thereby guaranteeing full lifting after a smooth transition through the zone of pressure release. After the brief return to full brake voltage, the brake voltage will automatically drop to the Hold voltage, but must not allow the brake to sag back onto the braking surface.

- Verify the manufacturers recommended value for brake holding voltage and set Hold voltage to that value. If this information is not available, experiment with Hold voltage to determine the voltage necessary to hold the brake up, and then add a little extra margin.

7. At this point, a storage oscilloscope is suggested to get the best results from adjustment. Connect the scope to iBox test points STP2 and GND (with the iView Virtual Oscilloscope Test point 2 set to Speed Feedback) to view car speed response.

8. Set the horizontal sweep to about 0.5 to 0.2 second per division and increase vertical gain until you see a microscopic view of the breakaway at the start of movement. A rough start is characterized by jaggedness at the beginning of the curve; a smooth start by a smooth transition from the horizontal line to the acceleration curve. Using this method, you can touch up parameters such as Speed pick delay 1 in the next step.

9. On the Configuration > Pattern > Common tab, set Pattern scaling to 100%.

10. Coordinate the start of the car with brake operation by increasing Speed pick delay 1 (Configuration > Brake > Control tab) until you begin to see rollback at the start of an empty car DOWN run at the top floor. Then, decrease Speed pick delay 1 until rollback just disappears.

   It may be helpful to reduce the Initial jerk parameter to 5.00 or 4.00 to help provide a smooth start. Remember that any change in the brake parameters, Initial jerk, or any of the gain parameters relating to the speed loop will probably affect the coordination of the starts. Therefore, you must readjust Speed pick delay 1 after any such changes.
Figure 4.4  Effect of Speed Pick Delay on the Start of Car Motion

Become familiar with the correlation between what is seen on the scope and what is felt in the car at the start of motion. Use the scope to adjust brake parameters to provide smooth starts. If the car has sleeve bearings, be sure to evaluate starts without letting too much time pass between runs to get accurate rollback information. Once you see the effect of the various parameter adjustments on car operation, you will see how important it is to have the brake properly adjusted.

The value of Repick time (Configuration > Brake > Control tab) can be reduced but doing so will reduce the time that the brake spends accomplishing a slow lift with Weakening voltage applied. This will eventually cause the brake to start lifting rapidly. Typically, Repick delay should not be less than 0.50 seconds.
Calibrating the Floor Offsets

iControl provides an easy and precise method of setting the parameters required to stop the car accurately at every floor. Stopping “spot on” at every floor requires three things:

1. The control system must know the exact position of the car in the hoistway and the exact position of each landing target (magnet). Without requiring any user adjustment, the extremely accurate iLand landing system allows iControl to know the car’s position in the hoistway to within 1/20 inch. And the Floor Height Learn procedure, see “Learning Floor Heights” on page 4-2, allows iControl to know the exact position of the landing target to the same accuracy.

2. The control system must know the exact position in the hoistway of each landing sill. Calibrating the floor offsets allows iControl to know this position to an accuracy limited only by the accuracy of your measurement.

3. The car must be adjusted to stop smoothly and consistently, given the limitations of controlling the machine and brake and the inevitable trade off between stopping accuracy and ride quality. These adjustments will be performed after the floor offsets are calibrated. Please refer to “Adjusting Leveling and Final Stop” on page 4-25.

Floor offset calibration procedure

This procedure requires IMP software version 002.001.001 or greater and iView software version 003.000.001 or greater.

Floor offset calibration can be performed by one or two persons. You will move the car to each floor that you want to calibrate, and the distance between the car sill and landing sill must be measured. You can use the form provided to record your measurements (See “Floor Offset Calibration Record” on page 4-24). You need not perform the calibration for all floors each time the procedure is performed.

The measured values, in decimal inches, will be entered into iView on the Setup > Floor Heights > Floor Offsets tab). You can make the measurement using a fractional inch square and then use the conversion table provided to determine the decimal value. But the better way is to use a machinist square which is marked in decimal inches.

Once the floor offsets have been entered, iControl is able to calculate the exact location of each hoistway landing sill using the known exact position of the car, known exact position of the target magnet and the measured distance from the car sill to the hoistway sill. Then, once the car is adjusted to stop smoothly and consistently, iControl can stop the car “spot on” at every landing.
To calibrate the floor offsets:

1. Display the Floor Offsets Setup tab by selecting Floor Heights from the View > Layouts menu and then clicking the Setup > Floor Offsets tab.

2. Move the car to the desired starting landing (e.g. top or bottom terminal landing). The Ready indicator should light. Follow the instructions provided in the text box.

3. Verify that the machine room INSPECTION switch is in the NORM position. It is recommended to place the car on Independent service while performing this calibration.

4. Click Calibrate to begin making offset measurements. The In progress indicator lights.

5. Run the car to each floor where you want to calibrate the floor offset and perform step #6. It is not necessary to calibrate all floors each time this procedure is performed.

6. Upon arrival at each floor, wait about 10 seconds to allow the car to settle and for iControl to acquire the car’s exact position (Acquired light turns on). Measure and record the distance the car sill is above or below the hoistway landing sill, and record the direction (car sill above or below). If the sills are not parallel, record the average measurement.

7. Return to the starting floor and measure its offset last. The Done indicator lights indicating that the measurement portion of the offset calibration procedure is completed.

8. Enter the measured value (decimal inches) in the Measured in column (Offsets table on the Setup> Floor Heights > Floor Offsets tab). If the car sill was above the landing sill, enter a plus (+) value. If the car sill was below the landing sill, enter a minus (-) value.

9. Click Send to send the new offset values to the iController.
### Table 4.1 Floor Offset Calibration Record

<table>
<thead>
<tr>
<th>Floor</th>
<th>Car Above/below landing</th>
<th>Fractional inch</th>
<th>Decimal inch</th>
<th>Floor</th>
<th>Car Above/below landing</th>
<th>Fractional inch</th>
<th>Decimal inch</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td></td>
<td></td>
<td></td>
<td>60</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td></td>
<td></td>
<td></td>
<td>59</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td></td>
<td></td>
<td></td>
<td>58</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td></td>
<td></td>
<td></td>
<td>57</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td></td>
<td></td>
<td></td>
<td>56</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
<td></td>
<td>55</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td></td>
<td></td>
<td></td>
<td>54</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
<td></td>
<td></td>
<td>53</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td></td>
<td></td>
<td></td>
<td>52</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td></td>
<td></td>
<td></td>
<td>51</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td>50</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td></td>
<td></td>
<td>49</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td></td>
<td></td>
<td>48</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
<td></td>
<td></td>
<td>47</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td></td>
<td>46</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td>45</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td>44</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td>43</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td>42</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td>41</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td>40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td>39</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>38</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td>37</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td>36</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td>35</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td>34</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td>33</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td>32</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td>31</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Table 4.2 Fractional inch to decimal inch conversion

<table>
<thead>
<tr>
<th>Fractional in.</th>
<th>Decimal in.</th>
<th>Fractional in.</th>
<th>Decimal in.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/32</td>
<td>.031</td>
<td>9/32</td>
<td>.281</td>
</tr>
<tr>
<td>1/16</td>
<td>.063</td>
<td>5/16</td>
<td>.313</td>
</tr>
<tr>
<td>3/32</td>
<td>.094</td>
<td>11/32</td>
<td>.344</td>
</tr>
<tr>
<td>5/32</td>
<td>.156</td>
<td>13/32</td>
<td>.406</td>
</tr>
<tr>
<td>3/16</td>
<td>.188</td>
<td>7/16</td>
<td>.438</td>
</tr>
<tr>
<td>7/32</td>
<td>.219</td>
<td>15/32</td>
<td>.469</td>
</tr>
<tr>
<td>1/4</td>
<td>.250</td>
<td>1/2</td>
<td>.500</td>
</tr>
</tbody>
</table>
Adjusting Leveling and Final Stop

This section describes adjusting leveling into the floor and bringing the car to a final stop.

Final Approach and Leveling

Observe elevator operation by watching the hoist motor and observing car response on iBox test point STP1 to GND (with the Virtual Oscilloscope Test point 1 parameter = Speed Feedback).

- If tracking accuracy is very good, increase Leveling speed and decrease Leveling distance to reduce floor-to-floor time. You can also increase the value of Approach jerk, Deceleration, and Flare jerk.
- If tracking is not perfect, begin to reduce Deceleration, Approach jerk, and Flare jerk parameters to mold the shape of the last few inches of approach. Some experimentation will be necessary in order to see the effect of changing parameter values. A digital storage oscilloscope is essential.
- The goal is for the speed pattern shape to flare out and blend the deceleration into the leveling speed. It is possible to modify the pattern to obtain a lot of stabilized leveling or to decelerate the elevator all the way into the floor to obtain the best brake-to-brake times. It is here that most of the performance and perceived ride quality is determined. Try the full load range to be sure the stops are consistent.

Final Stop

There are many items to consider in establishing a smooth and accurate stop. Each contributes to the final result:

- **Brake drop delay** - First adjust Brake drop delay on the Configuration > Brake > Control tab to provide too much delay in dropping the brake so you can clearly see the complete electrical stopping characteristics of the hoist motor. Keep these characteristics in mind as adjustments are made. It may be necessary to change Brake drop delay more than once to clearly see the results. It is most important to never drop the brake on a moving motor.

- **Normal rate limited stop** - Adjusting Normal rate limited stop (Configuration > Drive > General tab) will also determine how harshly the stop is felt (higher values yield harsher stops). Lower values may require a larger dead zone. To prevent the car from pulling through under the brake, do NOT set this parameter to 0.0.

- **Voltage decay time** - Adjusting Voltage decay time (Configuration > Brake > Voltages tab) determines how softly the brake drops (higher values yield softer drop). If Voltage decay time is set too high, there will be loss of control during the time between the drive “disconnecting” and the brake setting firmly.

- **Brake Release Time** - The TORQMAX drive has an adjustable parameter (LF.70 Speed Pick Delay) that determines how long the drive will keep current flowing to the motor when the car reaches zero speed and the direction input is removed. This allows the motor to hold the load while the brake engages. The normal setting for LF.70 is 0.300 second, but it should always be kept below 0.800 second.
Final Adjustment

- **Leveling Speed** - If this speed is too high, a quick transition to zero speed will occur. This results in a bump at the stop or possible overshoot at the floor resulting in a releveling operation. If the leveling speed is too slow, the car will stop very close to the edge of the dead zone, which will cause the system to relevel frequently. Reasonable values of Leveling speed (Configuration > Pattern > Common tab) range from 3 to 6 fpm. Before setting the Dead zone distance, the selection of Leveling speed must be completed so that you are satisfied with the complete final approach to the floor. If overshoot occurs frequently, adjust Dead zone distance.

- **Dead zone** - The purpose of the dead zone is to ensure that the elevator stops at the same point whether approaching a particular floor from above or below. The dead zone is a software-defined area at a floor, typically 0.25 inches (6 mm) to 0.75 inches (18 mm) in height. Ideally, the elevator stops in the center of the dead zone.

Because of the mass of the elevator system, it will not stop as soon as it is commanded to stop. It will slide slightly before stopping. The Dead zone distance should be adjusted so that the elevator stops consistently at the same position relative to the floor level from both directions. Dead zone adjustment need only be adjusted for one floor. All other floors will react in the same way.

**Note**

Dead zone distance should be adjusted before fine tuning floor height offset.

1. Choose a floor in the middle of the hoistway so that the car can reach contract speed when approaching the floor from either direction.
2. Start with the default Dead zone distance (Configuration > Pattern > General tab).
3. Put the car on Test operation. Verify that the iBox Inspection switch is in the NORM position. Verify that the iBox Test switch is in the ON position.
4. Run the car to the chosen floor from the top and make sure the car achieves contract speed. Note the position of the car when it stops at the floor (i.e., 1/4” above the floor or 1/8” below the floor, etc.).
5. Run the car to the chosen floor from the bottom and make sure the car achieves contract speed. Note the position of the car when it stops at the floor.
6. If the car consistently stops at the same position, (for example, 1/8” above the floor approaching from above or below), then Dead zone distance is properly adjusted. (Floor Offset can be adjusted later so that the car stops perfectly level with the floor.)
7. If the car overshoots and relevels, the Dead zone distance is too tight. Increase Dead zone distance and repeat steps 4 and 5.
8. Otherwise, the Dead zone distance is too wide. Decrease Dead zone distance until the car stops consistently at the same position relative to the floor, repeating steps 4 and 5.
• **Brake Coordination for Smooth Stops** - Proper operation and setting of the brake is very important to achieve a smooth stop:

1. Before starting, the brake must be operating properly. Geared machine brakes are usually very simple, however, the brake on a gearless machine requires detailed adjustment to obtain proper operation. For now, be sure to adjust brake tension to hold 125% of a rated load (or the value required by your local code authorities). To establish a holding voltage for a brake in a geared installation, refer to the manufacturers recommended value. If this information is not available, experiment with the Hold Voltage (Brake Configuration/Voltage tab) to find the voltage necessary to hold the brake and then add a little extra margin.

2. If you have already adjusted the brake to the correct mechanical clearances and the brake is still clunking down too hard when the car stops, increase Voltage Decay Time (Configuration > Brake > Control tab (iField module, high current braking only). For low current brakes, decrease the RB resistance inside the iPower Box.

3. Next, adjust **Drop Delay** (Configuration > Brake > Control tab) so that the brake drops the instant hoist motor motion stops. The primary means of coordinating brake drop with motion stop is adjusting Brake Drop Delay. The initial setting should be 0.00 seconds. Increase Drop Delay in increments of 0.10 second until the motor is clearly at zero speed when the brake drops. The goal is to avoid dropping the brake on a moving motor, but also to avoid holding the brake up longer than necessary.

   • TORQMAX drive - Adjust LF.79 Delay in turning off the drive (delay to turn off the motor current after direction is dropped), which can hold the car electrically until the brake is dropped.

4. Adjust Voltage Decay Time to determine how softly the brake drops (higher values yield softer drop). If Voltage Decay Time is set too high, there will be loss of control during the time between the drive “disconnecting” and the brake setting firmly.

![Figure 4.5 Effect of Brake Drop Delay on Stopping](image-url)
Releveling Operation

- **Relevel Dead Zone Distance** — The Relevel dead zone distance is similar to Dead zone distance except that the Relevel dead zone distance applies only while the car is releveling. During releveling, the brake is partially set and the speed is very slow (usually 4 to 8 feet per minute). Therefore, the car does not slide as much. As a result, Relevel dead zone distance should be tighter than Dead zone distance. Relevel Dead Zone adjustment need only be adjusted for one floor. All other floors will react in the same way. Brake Relevel Voltage (Brake Configuration/Voltages tab) should be adjusted properly before adjusting the Relevel dead zone distance. In general, Relevel Dead Zone must be less than Relevel Distance.

1. Put the car on Test operation. Verify that the iBox Inspection switch is in the NORM position. Verify that the iBox Test switch is in the ON position.
2. Move the car to a floor away from the terminal landing to allow releveling to the floor from both directions.
3. Put the car on Inspection Access.
4. On Inspection Access, move the car up about 3” above the floor. Turn off Inspection Access to allow the car to relevel down to the floor. Note the position of the car when it stops at the floor (i.e., 1/4” above the floor or 1/8” below the floor, etc.).
5. On Inspection Access, move the car down about 3” below the floor. Turn off Inspection Access to allow the car to relevel up to the floor. Note the position of the car when it stops at the floor (i.e., 1/4” above the floor or 1/8” below the floor, etc.).
6. If the car consistently stops at the same position, (for example, 1/8” above the floor approaching from above or below), then Relevel dead zone distance is properly adjusted. (Floor Offset can be adjusted later so that the car stops perfectly level with the floor.)
7. If the car overshoots the floor during releveling, the Relevel dead zone distance is too tight. Increase Relevel dead zone distance and repeat steps 4 and 5.
8. Otherwise, the Relevel dead zone distance is too wide. Decrease Relevel dead zone distance until the car stops consistently at the same position relative to the floor, repeating steps 4 and 5.

- **Rope Stretch Releveling** — On high-rise applications, when the car is very low in the building with hundreds of feet of cable between the machine and the elevator, substantial movement can occur when the elevator load changes, thereby causing releveling. To make the system more tolerant of this movement, the Releveling distance parameter adjusts the amount by which the elevator must be away from the floor before the releveling operation is engaged. The range of adjustment is from 0.00 to 1.00 inch, with a typical value being 0.72 inches.
Ride Quality

If you are experiencing a ride sensation that is not exactly an oscillation, but might be described as a rough texture, it might be due to:

- On the TORQMAX drive, parameter A.LF.33 - Ki speed offset accel and d.LF.33 Ki speed offset decel are used to provide a smoother transfer of the load from brake to motor, especially with high efficiency gears. The default setting is 3000 for accel and 1000 for decel. Increase in increments of 1000.
- The encoder, attached to the motor shaft, may not be mounted securely, which may cause bouncing or a slight variation in the speed feedback signal once every revolution. On a geared machine, the coupling used between the tach or encoder and the motor can also be a source of vibration. In both cases, the problem is observed by looking at the AC-coupled encoder speed signal on iBox test point STP2 (with the Virtual Oscilloscope Test point 2 set to Speed Feedback). You may see the vibration frequency increase and decrease with car speed. This is absolute proof of a mechanical problem with the speed transducer. Electrically induced oscillations will be characterized by a frequency of oscillation that is constant (does not change significantly with speed).
- If the above steps do not resolve the vibration, the motor may not have been trimmed to the machine properly. Use a dial indicator to check alignment of motor and machine.

Load Weigher Adjustment for Dispatching

Analog load weighers (isolated platform or crosshead deflection) provide a signal (analog voltage) corresponding to the measured load. The signal is conditioned, sampled and digitized by the control system. The resulting value is used to calculate the actual load inside the elevator, which is used for logical operations including:

- Overloaded car detection
- Heavy load (hall call bypass)
- Light load anti-nuisance
- Empty load detection

Each threshold is user-programmable (Load Weigher Configuration screen) to determine the load level at which each operation should be initiated.

The car is weighed only when it is stopped at a landing with doors open. (This is the only time to anticipate a change in load.) Additionally, if the car were weighed when running, acceleration and deceleration would be interpreted as weight change.

Rope Tension Load Weigher - Load cells sense the tension of the wire ropes. The load weigher provides a calibrated analog signal that accurately tracks the loading of the car. Due to the dynamics of the elevator system, the load represented by the traveling cable and compensation cables will vary with the position of the car in the hoistway. iControl must learn the empty and full car load value at each floor. The load in the car can then be determined by reading the value at a given floor and subtracting the learned empty value for that floor.

Crosshead Deflection Load Weigher - The signal generated by the load sensor represents the perceived load at the crosshead, which includes the weight of the car, the load inside the car, the traveling cable, and any compensation cables that might be attached to the car. Due to the dynamics of the elevator system, the load represented by the traveling cable and compensa-
tion cables will vary with the position of the car in the hoistway. iControl must learn the empty and full car load value at each floor. The load in the car can then be determined by reading the value at a given floor and subtracting the learned empty value for that floor.

**Isolated Platform Load Weigher** - The isolated platform load weigher measures only the weight within the car. The value is not affected by hoistway position so empty and full values can be learned without moving the car from floor to floor.

**Note:** If you are preparing to do safety testing, including governor and buffer tests, you might want to do them first, then adjust the load weigher because recalibrating the load weigher is recommended following buffer safety tests.

**Load Thresholds**

The load thresholds used in logical operations are:

- **Over load threshold (% of full load):** Used to define the load at which it is unsafe to move the elevator (iView Configuration > Load Weigher tab). If this threshold is exceeded, the car will remain at the floor with doors open. Typically some type of visual and/or audible indicator is used to alert passengers that the car is overloaded. (This operation is overridden during Fire Service operation.)

- **Heavy load threshold (% of full load):** Used to define the load value at which hall calls will be bypassed or reassigned (iView Configuration > Load Weigher tab).

- **Light load threshold (% of full load):** Used to define the load at which a limited number of car calls may be registered. If the programmed number of car calls is exceeded, all car calls will be canceled.

Example: Light Load Threshold=20%. If the measured load in the car is less than 20%, the controller will only allow a certain number of car calls to be registered (number of calls is set on the iView Configuration > Car Operation > Passenger tab/Anti-Nuisance controls shown below). If the allowed car value is set to three, only three calls may be registered if the load is less than 20%. If a fourth call is entered, all car calls will be canceled.

- **Empty load threshold (% of full load):** Used to determine when the car is empty. If the load falls below the threshold the car is considered to be empty. This can be used for CFSS (Commandeer for Special Services) calls where it is desired that the commandeered car be empty. **Please refer to “Car Operation - CFSS Tab” on page 9-75.**

**Note:** Setting a threshold value to 00% will disable the corresponding function (anti-nuisance, hall call bypass or overload). Example: setting the Heavy Load Threshold to 00% will disable the hall call bypass function.

Load weighing logical functions such as Anti-Nuisance, Heavy Load, and Overload will be inactive until both the full and empty load values have been learned and saved.
Load Weigher Configuration

Once the load weigher is installed, you need to “tell” iControl what kind of load weigher you are using and set up some basic load threshold values and learn the load values. You do this using iView.

Load Weigher Selection and Threshold Settings

1. Connect to iControl using the iView application.
2. Go to the Configuration > Load Weigher tab.

Device configuration

3. Select the load weigher device type:
   - No load weigher: Select if no load weigher is used.
   - Discrete contact closure: Select if a discrete contact closure weigher is used
   - Analog Signal: Select if an analog signal load weigher is used (rope tension, isolated platform or cross-head deflection load weigher).

Analog device configuration

4. Sensing type: Select the analog device sensing type:
   - Cross head deflection or rope tension sensing.
   - Isolated platform displacement sensing.

Setting the load thresholds

5. Load thresholds are preset by MCE based on the job specification. However, thresholds are user-adjustable and may be changed at any time. All threshold values are expressed as a percentage of full load. To adjust these thresholds:
   - Over load threshold (% of full load): Enter the percentage of full load weight above which the controller should consider the car to be in an over load condition. Typically 110% to 115% of the elevators full load capacity. A setting of 00% = OFF. See “Load Thresholds” on page 4-30.
   - Heavy load threshold (% of full load): Enter the percentage of full load weight above which the controller should consider the car to be in a heavy load condition. Typically 80% to 90% of full load. A setting of 00% = OFF. See “Load Thresholds” on page 4-30.
Final Adjustment

- Light load threshold (% of full load): Enter the percentage of full load weight below which the controller should consider the car to be in a light load condition. Typically set below 20% of full load. A setting of 00% = OFF. See “Load Thresholds” on page 4-30.
- Empty load threshold (% of full load): Enter the percentage of full load weight below which the controller should consider the car to be empty. See “Load Thresholds” on page 4-30.
- When ready, press the SEND button to send the changed values to the controller.

Learning Load Values

Learning the empty and fully loaded car values is an automated process requiring that the appropriate load be present in the car before beginning each stage. It is best to have two people available, one in the machine room at the elevator controller or iView PC and one at a floor to handle test weights and ensure there are no passengers in the elevator.

The test weights must be equal to full load value. The learn process must be performed twice, once for empty car load and once for full car load. In order to learn load weigher values, the elevator must be in normal Passenger operation. The car will not be moved from the starting floor if the load weigher is an “isolated platform displacement sensing” type. However, if the load weigher is the “rope tensions sensing” or “cross-head deflection sensing” type, the car must travel the hoistway, stopping to learn the load values at each floor.

![Caution]

Caution

The load weigher sensor must be calibrated prior learning the load values. Please refer to “Load Weigher Sensor Adjustment” on page 4-16. If you are preparing to do safety testing, including governor and buffer tests, you might want to do them first and then adjust the load weigher sensor and learn the load values, because re-calibrating the load weigher is recommended following buffer tests.
Load Weigher Learn Procedure

1. Display the Load Weigher layout (View > Layouts > Load Weigher).
2. Enter the Start floor (floor at which the test weights are located) on the Setup > Load weigher tab.
3. Acquire “Write privilege” (Write privilege > Acquire) and place the iBox Learn switch in the ON position.

Abort Calibration

If necessary during a learning process, click on Abort to immediately stop the learning process. (For example, you started a Full Load learn and realized the test weights were not in the elevator.) The car will return to the start floor where you may restart the learn procedure.

Clear Learned Values

Lighted Empty and Full Learn indicators mean that the processes have been successfully run and values stored. Clicking on the Clear button will immediately erase the stored values. You must then repeat the learning process to learn and store new values.
Pre-Start Sequence

If the car is properly adjusted and running well, but the floor to floor times are not as quick as you would like, the Pre-Start Sequence parameters (Configuration > Drive > General tab) can be used to allow the brake and/or motor to be energized while the doors are closing, thereby allowing the elevator to leave the floor as soon after the doors are locked as possible.

The Pre-Start Sequence options include:

“Allow machine to be energized”
- After doors are locked
- After door position monitor is activated
- While doors are closing:
  - with motor only
  - with motor and partially picked brake
  - with motor and fully picked brake

Regardless of the option chosen, the elevator is not allowed to move before the doors are locked and the Speed pick delay 1 timer has elapsed.

The parameters that affect the Pre-Start Sequence options are found on the Configuration > Brake > Control tab.

The following pages include descriptions of each Pre-Start Sequence option and diagrams showing the parameters that affect each option and the resulting sequence of operation.

Caution
Do not use Pre-Start Sequence options until drive control parameters have been adjusted for no rollback and good control at zero speed.
Allow machine to be energized: After doors are locked

This is the default Pre-Start Sequence option. It specifies that the doors must be locked before energizing the motor and brake. The diagram below shows the parameters that affect this option and the resulting sequence of operation.

No Prestart Sequence with or without Smooth Pick

For a detailed description of the brake parameters associated with “smooth picking” and instructions for adjusting them, see “Brake Parameter Adjustments” on page 4-19.
**Allow the machine to be energized:**
**When the door position monitor is activated**

This Pre-Start Sequence option is much the same as the “After doors are locked” option except that Door Position Monitor status is used to determine when the machine may be energized rather than the Doors Locked sensors. The following diagram shows the parameters that affect this option and the resulting sequence of operation.

Allow machine to be energized after door position monitor is activated
Allow the machine to be energized: While doors are closing with motor only

This Pre-Start Sequence option allows the motor to be energized while the doors are closing so that when the doors are locked, the brake picking sequence can be started immediately. The diagram below shows the parameters that affect this option and the resulting sequence of operation.

For a DC control, Pick Delay can be set to zero so long as the Pre-Start Sequence Delay is adjusted so that the motor is energized and able to hold the car at zero speed when the doors become locked.

For an AC control, some Pick delay may be required because it takes time for the drive to magnetize the motor once the contactor is picked and the drive enabled. A “Drive Ready On Fault” is generated if Pick delay is too short.
Allow the machine to be energized: While doors are closing with motor and partially picked brake

This Pre-Start Sequence option allows the motor to be fully energized and the brake to be partially energized while the doors are closing, so that when the doors become locked, the car can begin moving as soon as the brake is fully picked. The diagram below shows the parameters that affect this option and the resulting sequence of operation.

Prestart Sequence with Motor and Partially Picked Brake

[Diagram showing the parameters and sequence of operation]
Allow the machine to be energized: While doors are closing with motor and fully picked brake

This Pre-Start Sequence option allows the motor and brake to be fully energize while the doors are closing, so that the car can begin moving when the doors become locked and the Speed pick delay 1 timer expires. The diagram below shows the parameters that affect this option and the resulting sequence of operation.

Prestart Sequence with Motor and Fully Picked Brake
Calibration and Verification of Safety Functions

Before performing the calibration and verification of safety function please do the following:

1. Verify that the car performs the releveling operation properly. Please refer to “Verify Releveling” on page 4-6 and see “Releveling Operation” on page 4-28.

2. Perform the Normal and Emergency Terminal Limit Switches learn procedure. This is necessary if any pattern parameters have been changed since the last time the learn procedure was performed. Please refer to “Learning Normal & Emergency Terminal Limit Switches” on page 4-9.

Tach Error Tripping Threshold Adjustment

This test compares the pattern signal with the velocity feedback signal and sets the point at which the Tach Error fault trips as a result of excessive error between the Actual and intended car speed.

1. Verify that the Tach Adj. trimpot has been properly adjusted. Please refer to “Verify Pattern Command and Drive Speed Feedback” on page 2-55.

2. Arrange the car for full load condition.

3. Verify that the iBox Test switch is in the ON position.

4. On the Virtual Oscilloscope, set Test point 1 to Speed Feedback and Test point 2 to Tach Error Upper Limit. (Tach Error Upper Limit determines the upper threshold below which velocity feedback is allowed to deviate from the pattern.)

5. Start with Following error set to 1.0% (Configuration > Drive > Safety tab).

6. Set the iBox Fault/Function Bypass switch to the ON position. (Note that fault bypass is automatically disabled after a fifteen minute timer expires.)


8. Run the car up and down the hoistway. If the Speed Feedback trace on the Virtual Oscilloscope crosses the Tach Error Upper Limit trace, a Tach Error fault will normally be generated (we have it bypassed).

9. If the two traces on the oscilloscope cross, increase Following error in 5% increments, running the car with each change, until the two traces no longer cross.

10. When the two traces no longer cross, add 5% to the Following error setting as a margin.

11. Set Test point 2 to Tach Error Lower Limit. This is the lower threshold below which velocity feedback is allowed to deviate from the pattern.

12. Repeat steps 7 through 9 for Tach Error Lower Limit.
Verify Tach Error Does Not Trip on Emergency Stop

1. Set the iBox Fault/Function Bypass switch to the OFF position.
2. Make sure the Tach Error fault is no longer bypassed (Diagnostics > Fault Bypass tab).
3. With a full load in the car, run the car up and down the hoistway to verify that the Tach Error fault is not generated.
4. Enter a car call several floors below the car (so it can reach contract speed).
5. While the car is running at contract speed (Operational Status / Speed - Actual), disconnect the GS terminal from the iBox.
6. The car should trip a Door Lock Fault and make an Emergency Stop.
7. Observe that a Tach Error fault is not generated.
iControl provides highly automated safety testing. Before running any tests, the car must be properly balanced and adjusted. From the iView Safety Tests screen (View > Safety Tests), the following tests may be run:

- Car/Counterweight Safety Test
- Electrical Governor Test
- Car/Counterweight Buffer Test
- Inspection Overspeed Test
- Contract Overspeed Test
- Emergency Brake Test - Unintended Motion
- Normal Terminal Switch Overspeed Tests - Level 1
- Normal Terminal Switch Overspeed Tests - Level 2
- Normal Terminal Switch Position Tests
- Emergency Terminal Switch Overspeed Test
Running a Test

1. Put the iBox in Test mode.
2. Select the desired test on the Test screen.
3. Set the speed which the car must attain to trigger the condition being tested. (All tests except Emergency Brake Test/Unintended Motion require a speed input.)
4. Click the Select button. (Sends data to the controller and sets test conditions, including operating mode and active fault bypasses. Updates instructional display for specific test.)
5. Visually check on-screen operating mode and fault bypass status displays.
6. Perform instructions displayed on test screen.
7. Press Arm Test.
8. Place a car call as required to run the car up or down the hoistway (Call Registration panel).
9. Check Operational Status tab and Event Log (Diagnostics > Event Log) for fault verification.
10. Use the iBox Stop switch to stop the test and bring the elevator to an emergency stop if necessary.

Note

When running a test, you are allowed only one “motion cycle” of the car. If the test is not satisfactory, you will have to re-select that test to begin again. Remember that fault bypasses set for the test will time-out after 15 minutes. If you are delayed in completing a test, you may have to cycle the Fault Bypass switch to reset the fault bypasses.

Results

Faults triggered by the tests are reported on the Operational Status tab and the Event Log. Non-latching (self-clearing) faults will only appear on the Operational Status tab for a few moments. Check the Event Log if the triggered faults have already disappeared from the Operational Status tab.

The following test descriptions provide information specific to each test.

Danger

During testing, normal system safeties are disabled. Exercise extreme caution. Be prepared to take control and stop the elevator if necessary. Only QUALIFIED PERSONNEL, with adequate experience and knowledge of elevator equipment should attempt elevator adjustment and testing.
Car/Counterweight Safety Test

This is a two-part test. Car safety testing verifies operation of the car safeties. The objective of the test is to set the safeties, causing the hoist motor to break traction. The over-speed must be sufficient in magnitude to cause the governor to trip mechanically and to set the car safeties. The electrical governor switch must not prevent the cars continued acceleration to the mechanical trip speed and the safety-operated switch (plank switch) must not open the safety string. To perform the Car Safety test:

1. Place a full load in the car.
2. Position the car some distance away from the bottom landing (about 10-feet per 100-feet-per-minute of contract speed).
3. Set Test Speed to 125% of Contract Speed.
4. On the iView, Configuration > Pattern > Modes tab, verify that Deceleration and Approach deceleration are set no higher than 2ft/s² to avoid tripping the drive.
5. Place a jumper between the #3 bus and the GOV terminal on the iBox to bypass tripping the governor overspeed.
6. Place a jumper between SAFH and SAFC on the iBox to bypass the safety plank (SOS).
7. For TORQMAX F5 software v1.61 or earlier, on the drive keypad:
   • Note the existing value of LF.57. Use the drive keypad to set LF.57 Speed Following Error to 0 (Off).
   • Record the value of LF.20 Contract Speed and LF.42 High Speed. Then change LF.20 and LF.42 to 130% of Contract Speed.
   
   For TORQMAX F5 software v1.71 of later, on the drive keypad:
   • Set LF.49 Over Speed Function Test to 130% of Contract Speed.
   • Set LF.3 = Sext Over Speed Test Function. With LF.3 displayed, press FUNC to display the present value. Press UP/DOWN until OSSt is displayed, and then press ENTER to load the value. Car will over speed for one run only, after which parameters are automatically reset.
9. Place a car call distant enough to allow the car to reach the necessary speed. If necessary, you may end the test and bring the car to an emergency stop using the iBox Stop switch.
10. Remove jumpers placed for test.
11. Return TORQMAX drive parameters to original values. NOTE: TORQMAX parameter LF.57 must be reset to its original value (On) or the drive will not run.
12. Check the hoistway ropes to make sure they are still in their proper grooves before attempting to move the car.
13. Use whatever method is required to reset the safeties. For flexible quick-clamp safeties, move the car on Inspection (UP and ENABLE buttons) to release the safety and restore the safety string.

Counterweight Safety Test - The counterweight safety test verifies operation of the counterweight safeties. For this test, position the empty car near the bottom landing and arrange to over-speed in the up direction. The test is comparable to the car safety test but performed in the opposite direction. If the counterweight has a governor, remember to jumper it out. Also, remember to remove jumpers when tests are complete.
Safety Tests

Electrical Governor Test
This test verifies that the calibration of the electrical governor switch is appropriate (typically about 110% of contract speed) and that the car will execute an emergency stop once the electrical governor switch is activated. When the car trips the electrical governor switch in the down direction, it will execute an emergency stop.

1. Bring the car to the middle of the hoistway.
2. Check your mechanical governor nameplate for its tripping speed. Check the Contract Overspeed setting on the Configuration > Safety tab. Set a test speed sufficient to trigger the Contract Overspeed but not high enough to trip the mechanical governor.
4. Place a car call that will allow the car to reach the necessary speed.

Car/Counterweight Buffer Test
This is a two-part test. The car buffer test verifies that the car striking the buffer will cause the hoist motor to break traction and that the car buffer will automatically return to its fully-extended state after having been fully compressed. The car is arranged to run into the terminal landing without initiating any form of slowdown. Neither the final limit switch nor the buffer switch must stop the car.

1. Be certain that the pit is prepared, buffers ready, etc.
2. Place a full load in the car.
3. Position the car in the hoistway high enough to reach contract speed before reaching the bottom landing.
4. Place a jumper between the #3 bus and the SAFH terminal on the iBox to bypass the safety string.
5. Set Test speed to Contract Speed.
7. Use the Inspection switches to run the car. If necessary, you may end the test and bring the car to an emergency stop using the iBox Stop switch.

The car must strike the buffer, compress it fully, and cause the hoist motor to break traction.

8. Check the hoistway ropes to make sure they are still in their proper grooves before attempting to move the car.
9. Lift the car off the buffer at inspection speed. (Normally accomplished after the inspector enters the pit to observe.) The buffer must return to full extension.

Counterweight Buffer Test - The counterweight buffer test verifies that the counterweight striking the buffer will cause the hoist motor to break traction and that the counterweight buffer will automatically return to its fully-extended state after having been fully compressed. The empty car is positioned near the bottom landing and arranged to reach contract speed in the up direction. The test is comparable to the car buffer test but performed in the opposite direction. If the counterweight has a governor, remember to jumper it out.

Note
These tests may cause the load weigher to go out of calibration. Please refer to “Learning Load Values” on page 4-32.
**Inspection Overspeed Test**
This test verifies that moving the elevator on Inspection Operation at a speed greater than 150 fpm will result in an emergency stop.

1. Place the car on machine room inspection.
2. Verify that Inspection Overspeed (Controller > View > Setup > Safety > Configuration tab) is set to 150 fpm.
3. Position the car in the middle of the hoistway.
5. Select the Inspection Overspeed test. Follow on-screen instructions.
6. Use the inspection buttons to move the car when ready.

When the car exceeds 150 fpm, the overspeed condition must stop it.

**Contract Overspeed Test**
This test verifies that moving the elevator at a speed greater than the programmed contract overspeed value will result in an emergency stop.

1. Position the car in the middle of the hoistway.
2. The test speed must exceed the programmed Contract Overspeed value shown on the Controller > View > Setup > Safety tab (typically 107% of contract speed), but not high enough to cause the electrical or mechanical governor to activate. Contract Overspeed plus 15 fpm should be sufficient. You may have to physically bypass the electrical Governor switch.
   - For TORQMAX F5 software v1.61 or earlier, on the drive keypad:
     - Record the value of LF.20 Contract Speed and LF.42 High Speed.
     - Then change LF.20 and LF.42 to the test Speed determined above.
   - For TORQMAX F5 software v1.71 of later, on the drive keypad:
     - Set LF.49 Over Speed Function Test to the test Speed determined above.
     - Set LF.3 = OStSt Over Speed Test Function. With LF.3 displayed, press FUNC to display the present value. Press UP/DOWN until OStSt is displayed, and then press ENTER to load the value. Car will over speed for one run only, after which parameters are automatically reset.
4. Enter the desired test Speed determined in step 2 and then click Select.
5. Follow the on-screen instructions.
6. When the car exceeds the programmed contract overspeed value, the car must perform an emergency stop.
7. If they were changed, reset LF.20 and LF.42 to the values recorded in step 2.
Leveling Overspeed Test

This test verifies that the leveling zone does not exceed the maximum allowable distance and that the leveling speed does not exceed 150 ft/min (0.75 m/s). (NOTE: Be sure to make note of the original parameter values so they can be restored after the test):

1. On the Configuration > Drive > General tab, set Emergency rate limited stop = 25 ft/s².
2. On the Setup > Safety > Configuration tab, set Leveling overspeed = 7 fpm and click Send. Then perform the Learn operation.
3. On the Configuration > Pattern > Common tab, set Leveling distance = 4 in, set Leveling speed = 9 fpm, and click Send.
4. Place a call to any landing. Verify that when the car enters the leveling zone, the system detects a Safety A (or B) Inspection Leveling Overspeed Fault and performs an emergency stop. Following the emergency stop the car should level into the floor, if necessary. (NOTE: If the car is unable to relevel into the floor and the fault is generated 5 times, the fault will become persistent and the iBox Fault Reset button must be pressed to reset the fault. It may be necessary to restore the parameters that were changed in steps 1 through 3 in order for the car to relevel to the floor.)
5. Restore the parameters that were changed in steps 1 through 3 to their original values.

Emergency Brake Test - Unintended Motion - Rope Brake

Danger

The Emergency Brake test allows the car to leave the floor with doors open. Station personnel or use a positive means to make certain there is NO ONE in the car.

This test is to be used for installations using a rope brake for the emergency brake. This test verifies that moving the car away from a landing with both the car and hoistway doors open (termed “Unintended Motion”) will cause the Emergency Brake (Rope Brake) to be deployed and that such deployment will stop the elevator. This test also demonstrates that the emergency brake will stop the car within 48” from the floor level if it drifts. No “Test speed” entry is required for this test.

1. Load the car as required, empty car going up or 125% of full load going down.
2. Move the car to the landing where the test is to be performed.
3. For safety, station a mechanic at the landing where the test is to be performed.
4. On the iView Safety Tests tab, select the Emergency Brake Test - Unintended Motion (View > Safety Tests > Test Name parameter).
5. Follow on-screen instructions “To perform an unintended motion test-”.
6. Once the test has been armed and the car doors have been opened, place a car call to the top or bottom terminal landing. The car will start to move with it’s door open and trip an Unintended Motion Fault.
7. The emergency brake must activate and stop the car within 48” (1220 mm). Power is removed from the driving machine and brake. Place the car on Inspection and press the iBox “Fault Reset” button to reset the fault.
Emergency Brake Test - Unintended Motion - Machine Brake

**Danger**
The Emergency Brake test allows the car to leave the floor with doors open. Station personnel or use a positive means to make certain there is NO ONE in the car.

This test is to be use for installations where one or more machine brakes are used for (designated as) the emergency brake. This test verifies that moving the car away from a landing with both the car and hoistway doors open (termed “Unintended Motion”) will cause the Emergency Brake (Machine Brake(s)) to be deployed and that such deployment will stop the elevator. This test also demonstrates that the emergency brake will stop the car within 48" from the floor level if it drifts. Please refer to “Typical Brake Test Circuit: Machine Brake Emergency Brake” on page 4-49.

1. Load the car as required, empty car going up or 125% of full load going down.
2. Move the car to the landing where the test is to be performed.
3. To enable the brake test, place jumpers from terminal FB1 to FB1X and from FB2 to FB2X (see Figure 4.6).
4. To test the emergency brake, remove the brake coil wires of the main brake from their normal terminals, e.g., B1 & B2, and connect them to terminals BT1 & BT2. Note: If the machine has a set of two or more brakes designated as the emergency brake, move the brake coil wires for all brakes not being tested to terminals BT1 and BT2.
5. For safety, station a mechanic at the landing where the test is to be performed.
6. On the iView Safety Tests tab, select the Emergency Brake Test - Unintended Motion (View > Safety Tests > Test Name parameter).
7. Follow on-screen instructions “To perform an unintended motion test-”.
8. Click the “Arm Test” button. The car doors will open.
9. Press and hold the BRAKE TEST BUTTON to lift the brake(s) not being tested, and then place a car call to the top or bottom terminal landing. The car will start to move with it’s door open and trip an Unintended Motion Fault.
10. The brake(s) being tested must activate and stop the car within 48” (1220 mm). Power is removed from the driving machine and brake. Release the BRAKE TEST BUTTON once the car has fully stopped. Place the car on Inspection and press the iBox “Fault Reset” button to reset the fault.
11. Return the brake coil wires connected to terminals BT1 and BT2 to their normal terminals.
12. Repeat steps 4 through 11 for any additional emergency brakes.
13. Repeat the test for the main brake(s), leaving the brake coil wires for the main brake connected to their normal terminals and moving the brake coil wires for the brake(s) designated as the emergency brake to terminals BT1 and BT2. Repeat steps 5 through 11.
14. When the tests have been completed, return all brake coil wires to their normal terminals and remove the jumpers from terminal FB1 to FB1X and FB2 to FB2X.
Figure 4.6 Typical Brake Test Circuit: Machine Brake Emergency Brake

To enable brake test, jumper terminal FB1 to FB1X and FB2 to FB2X. Remove these jumpers when brake test is complete.

To test brake, remove brake coil wires one pair at a time. From either terminals B1 & B2 for brake #1 or B3 and B4 for brake #2 and connect them to terminals B1 & B2. Pushing the test button will lift the disconnected brake. Reconnect brake coil wires when brake test is complete.

1. Initially set the total resistance of RB to five times the total brake resistance. Then adjust for smooth setting of the brake: too little resistance causes the brake to remain locked too long.
2. Set for brake test voltage (20% above holding voltage). Fuses FB1 and FB2 are 500V rating Bussmann type FNO or Littlefuse type FLQ.
Ascending Car Overspeed Test - Rope Brake

This test is for installations using a rope brake for the emergency brake. It verifies that the emergency brake (rope brake) will stop an empty car that is over-speeding in the up direction.

1. Move the empty car to the bottom of the hoistway.
2. Check the mechanical governor nameplate for its tripping speed. Check the Contract Overspeed setting (Controller > View > Setup > Safety > Configuration tab).
3. On the iView Safety Tests tab, select the Electrical Governor Test (View > Safety Tests > Test Name parameter).
4. Enter a Speed sufficient to trigger the Contract Overspeed but not high enough to trip the mechanical governor.
5. Acquire Write privilege and then click the Select button.
6. Follow on-screen instructions “ELECTRICAL GOVERNOR TEST SETUP” and “To perform and Electrical Governor test-”.
7. Once the test is “Armed”, place a car call distant enough to allow the car to reach the necessary speed.
8. When the electrical governor is activated the rope brake will be deployed. Power is removed from the driving machine and brake. Place the car on Inspection and press the iBox “Fault Reset” button to reset the fault.
Ascending Car Overspeed Test - Machine Brake

This test is for installations where an independent machine brake is used as the emergency brake. This test verifies that the emergency brake (machine brake) will stop an empty car that is over-speeding in the up direction. Please refer to “Typical Brake Test Circuit: Machine Brake Emergency Brake” on page 4-49.

1. Move the empty car to the bottom of the hoistway.
2. To enable the brake test, place jumpers from terminal FB1 to FB1X and from FB2 to FB2X (see Figure 4.6).
3. To test the emergency brake, remove the brake coil wires of the main brake from their normal terminals, e.g., B1 & B2, and connect them to terminals BT1 & BT2. Note: If the machine has a set of two or more brakes designated as the main brake, move the brake coil wires for all brakes not being tested to terminals BT1 and BT2.
4. Check the mechanical governor nameplate for its tripping speed. Check the Contract Overspeed setting (Controller > View > Setup > Safety > Configuration tab).
5. On the iView Safety Tests tab, select the Electrical Governor Test (View > Safety Tests > Test Name parameter).
6. Enter a Speed sufficient to trigger the Contract Overspeed but not high enough to trip the mechanical governor.
7. Acquire Write privilege and then click the Select button.
8. Follow the on-screen instructions “ELECTRICAL GOVERNOR TEST SETUP” and “To perform and Electrical Governor test-”.
9. Once the test is “Armed”, press and hold the BRAKE TEST BUTTON to lift the brake(s) not being tested, and then place a car call distant enough to allow the car to reach the necessary speed.
10. When the electrical governor is activated the machine emergency brake will be deployed. Power is removed from the driving machine and brake. Release the BRAKE TEST BUTTON once the car has fully stopped. Place the car on Inspection and press the iBox “Fault Reset” button to reset the fault.
11. Return the brake coil wires connected to terminals BT1 and BT2 to their normal terminals.
12. Repeat the test for the main brake(s), leaving the brake coil wires for the main brake connected to their normal terminals and moving the brake coil wires for the brake(s) designated as the emergency brake to terminals BT1 and BT2. Repeat steps 5 through 11.
13. When the tests have been completed, return all brake coil wires to their normal terminals and remove the jumpers from terminal FB1 to FB1X and FB2 to FB2X.
Normal Terminal Switch Overspeed Tests

Per switch, this test verifies that either an emergency slowdown or emergency stop will be initiated if an elevator encounters an NTS switch and is moving at a speed greater than the programmed overspeed value for that switch. The car is arranged to run toward the target NTS switch without initiating any form of slowdown. When the car activates the NTS switch, it will execute either an emergency slowdown or an emergency stop, depending upon the overspeed margin detected. The car will then finish the run to a landing at leveling or correction speed.

1. It is imperative that deceleration and jerk rates for the Emergency slowdown profile be set to greater values than Standard profile deceleration and jerk rates so that initiation of an emergency slowdown will stop the elevator quickly and safely. Check the Standard and Emergency slowdown profiles to see that this is the case. For a typical, 500 fpm car, Standard jerk and deceleration settings might be 4.0 and 3.0 respectively; for the Emergency slowdown profile, jerk and deceleration might be 15.0 and 6.0 respectively. Adjust the Emergency slowdown profile parameters as necessary to ensure a rapid, aggressive stop sufficient to avoid running the car into the buffer.

2. Go to the Configuration > Pattern > Modes tab/Emergency slowdown profile and verify that Deceleration is set correctly. It is generally set to 5.0, and must be greater than the Standard profile - Deceleration parameter.

3. Go to the Configuration > Drive > General tab and verify that Emergency rate limited stop is set correctly. It is generally set to 7.0, and must be greater than the Emergency slowdown profile - Deceleration parameter.

4. Position the empty car far enough away from the target NTS switch to allow a speed to be reached that exceeds the learned overspeed value for that switch for the Overspeed Level 1 or Level 2 (whichever is being tested).

5. Go to the Diagnostics > Terminal Switches Status tab. Note the Overspeed 1 and 2 speeds learned for the terminal switch to be tested.

6. On the Safety Test window, select Normal Terminal Switch ‘n’ Overspeed Test - Level ‘n’ for the switch and level to be tested.

7. Set the test Speed to the Overspeed 1 (Level 1) or Overspeed 2 (Level 2) speed, plus 10 fpm, for the switch/test. Caution! If the speed is set below the overspeed threshold, no slowdown will be initiated and the elevator/counterweight will strike the buffer.

8. Follow on-screen instructions and perform the test. The car should perform either an emergency slowdown or emergency stop. For additional information see “Terminal Switch Overspeed and Position Faults” on page 4-54.

9. On the Operational Status tab, verify that the appropriate fault is shown in the Faults window.

10. Continue testing remaining normal terminal switches by repeating steps 4 through 9.
Emergency Terminal Switch Overspeed Tests

Per switch, this test verifies that an emergency stop will be initiated if an elevator that is moving at a speed greater than 95% of the programmed contract speed encounters the ETS switch in the cars direction of travel (DETS if the car is moving in the down direction, UETS if the car is moving in the up direction). The empty car is set far enough away from the desired terminal landing to achieve contract speed by the time it reaches the ETS switch in the selected direction. The car is arranged to run toward the desired terminal landing without initiating any form of slowdown. When the car activates the ETS switch, it will execute an emergency stop. The car will then finish the run to a landing at leveling or correction speed.

1. Go to the Configuration > Drive > General tab and verify that Emergency rate limited stop is set correctly. It is generally set to 7.0, and must be greater than the Emergency slowdown profile - Deceleration parameter.
2. Position the empty car far enough away from the target ETS switch to allow a speed to be reached that exceeds the Over Speed 2 value for that switch.
3. Go to the Diagnostics > Terminal Switches Status tab. Note the overspeed 2 value learned for the emergency terminal switch to be tested.
5. Set the test Speed to the overspeed speed for the switch/test, plus 10 fpm. Caution! If the speed is set below the overspeed threshold, no slowdown will be initiated and the elevator/counterweight will strike the buffer.
6. Follow on-screen instructions and perform the test. For additional information see “Terminal Switch Overspeed and Position Faults” on page 4-54.
7. On the Operational Status tab, verify that the appropriate fault is shown in the Faults window.
8. Continue testing remaining emergency terminal switch by repeating steps 2 through 7.

Normal and Emergency Terminal Switch Position Tests

1. On the Configuration > Terminal Switches tab, for the switch you wish to test, set the position margin to a negative value (place a minus sign in front of the value).
2. If you are testing an up terminal switch, run the car past the switch in the up direction at contract speed (if possible). If you are testing a down terminal switch, run the car past the switch in the down direction at contract speed (if possible). The car should stop using the Emergency slowdown profile parameters.
3. On the Operational Status tab, verify that the appropriate fault is shown in the Faults window.
4. On the Configuration > Terminal Switches tab, set the position margin for the tested switch back to the original positive value.
5. Continue testing the remaining switches using steps 1 through 4.
Terminal Switch Overspeed and Position Faults

The Overspeed Level 1, Level 2 and Position margins are calculated based on the speed and position values learned during the terminal learn procedure (see “Learning Normal & Emergency Terminal Limit Switches” on page 4-9)

Overspeed level 1 - During passenger (NORM) operation, if car speed exceeds the Overspeed Level 1 threshold at the time a Normal Terminal switch is activated, an Up (or Down) Normal Terminal Switch (1-5) Level 1 Speed Fault is detected and an immediate slowdown is initiated using Emergency slowdown profile parameters. For each Normal Terminal switch, the Overspeed Level 1 threshold is calculated by increasing the learned speed by a percentage of the learned speed, e.g. learned speed plus 10% of learned speed. The percentage used in the calculation is determined by the Overspeed 1 margin parameter. You may adjust the Overspeed Level 1 threshold by changing the Overspeed 1 margin parameter (Configuration > Terminal Switches tab). The default setting is 8%. Normally, you should not have to adjust this setting.

Note

Sometimes short runs to a terminal, especially one-floor runs, will exceed tightly set overspeed margins. After you learn terminal switches, it is a good practice to try a few short runs to each terminal and check the Last pass speeds against the Learned speeds for each switch (Diagnostics > Terminal Switches Status tab). If necessary, you can then adjust the Overspeed 1 margin to accommodate (possibly) higher short run switch speeds. (Overspeed level 1 faults cause an emergency slowdown into the terminal landing but the fault is automatically cleared so it is possible to miss the fact that this is occurring.)

Overspeed level 2 - During passenger (NORM) operation, if car speed exceeds the Overspeed Level 2 threshold at the time a Normal Terminal switch is activated, an Up (or Down) Normal Terminal Switch (1-5) Level 2 Speed Fault is detected and an emergency stop is initiated (motor and brake contactors immediately dropped). The Overspeed Level 2 threshold is calculated as 105% of the Overspeed Level 1 threshold

Position - During passenger (NORM) operation, if car position varies from the learned position by more than the Position Margin at the time a Normal Terminal or Emergency Terminal switch is activated, an Up (or Down) Normal Terminal Switch (1-5) Position Fault or an Up (or Down) Emergency Terminal Switch Position Fault is detected and an immediate slowdown is initiated using the Emergency slowdown profile parameters. The Position Margin for each Normal Terminal or Emergency Terminal switch is displayed and may be adjusted on the Configuration > Terminal Switches tab. The default value is 2.0 feet.

Caution

Emergency Terminal (switches) Overspeed is hard-coded at 95% of Contract Speed. Be certain that the car is traveling well below this speed when an Emergency Terminal switch is opened to avoid an emergency stop. In some instances, it may be necessary to re-position an Emergency Terminal switch to achieve this. This value is NOT affected by the Overspeed 1 margin setting.
The following illustration shows the car reaction to overspeed conditions at Normal and Emergency Terminal switches in the down direction.

**Figure 4.7  Emergency and Normal Terminal Overspeed Reaction**

- **Speed Definitions**
  - 95% of Contract Speed: Hard-coded value for Emergency Terminal Switch
  - Level 1 Overspeed threshold: Learned speed value at switch plus the Limit One Margin (set on the iView Safety Screen)
  - Level 2 Overspeed threshold: 105% of Level 1 Overspeed.
Before Release to Passenger Operation

**Danger**
Before the elevator can be turned over to normal passenger use, it is important that no safety function or circuit remains bypassed. Items to check include, but are not limited to:

- All safety switches set to the OFF position
- No jumper between SB and 3 (iBox)
- No jumper between SAFH and 3 (iBox)
- Learn and Fault/Function switches set to OFF (iBox)
- TORQMAX Drive: Parameters LF.20 Contract Speed and LF.42 High Speed set to their original values. Also, set LF.57 Speed Following Error = 1 (ON)
- No jumper between Gov and 3 (iBox)
- Pattern Scaling set to 100% (Pattern screen/Common tab)

**Note**
If this is a local car (part of a group), the “Car identifier” parameter, on the Configuration > General > General tab, must be set so that the Group controller can identify the car to which it is communicating, see “Configuration - General” on page 9-97. Initially the Car identifier is defaulted to 1. The Car Identifier range is from 1 to 20. The Car identifier for each car in a Group must be unique (no duplicates).
About System Options

This section contains information for optional iControl system components, including:

- **iCentral - Central Dispatcher**: Description, installation and setup instructions for the Central Dispatcher (see page 5-2).
- **Comm-Connect Cabinet - Local/Dispatcher**: Description of the cabinet used for the Local Dispatcher system interconnections (see page 5-28).
- **Serial Hall Call**: Description, installation and troubleshooting instructions for the Serial Hall Call system (see page 5-30).
- **Flexible I/O**: Description of the SC-ION Serial Input/Output board (see page 5-45).
- **Serial COP (Car Operating Panel)**: Description and installation instructions for the Serial COP system and boards (see page 5-48).
- **EMCO Load Weigher**: Description, installation and calibration instructions for the EMCO Load Weigher (see page 5-51).
- **MCE Load Weigher**: Description, installation and calibration instructions for the MCE Load Weigher (see page 5-61).
iCentral - Central Dispatcher

iCentral is the central dispatching option for iControl, providing a central point to coordinate dispatching, parking, special operating modes, emergency power response, security, and interaction with existing (legacy) controls. This option is used for the most demanding systems.

With iCentral, the iCue dispatching software runs on a dedicated Windows PC or an embedded micro controller. You configure and interact with iCue using a Windows XP personal computer running the iView graphical user interface. iView is also used to connect to individual elevator controllers in the iControl group. iView automatically provides the correct user interface depending on the type of control (dispatcher or elevator) you are accessing.

The standard iCentral enclosure is a single-door cabinet measuring approximately 28-inches wide by 23-inches deep by 72-inches tall (71cm wide x 58cm deep x183cm tall). The cabinet provides two fixed shelves (for a monitor and a KVM switch and iCue and iView computers respectively), a sliding keyboard/mouse tray, and a peripherals/equipment interconnect area configured to meet the requirements of the individual job. A typical equipment complement includes LAN and System Ethernet hubs, SC-ION addressable input/output boards, serial communication bus drivers, a second computer, and modular terminals to accommodate machine room and hoistway field connections.

Each iCentral will administer an elevator group servicing up to a design maximum, one hundred-fifty floors. Functionally, iCue provides the kinds of interconnection and control shown in the following illustration.

Switching Between iCue & iView PCs

The iCue PC runs the real time dispatching software that controls the elevator group. The iView PC connects to iCue or to individual car controls and allows you to configure them using the iView application. The two PCs share the single keyboard/mouse and monitor. Press the <Scroll Lock> key twice to switch from one PC to the other.

Note

Before using iView to change iCue settings, you must request and be granted write permission. When you request write permission, you must immediately switch to the iCue PC and grant permission in the pop-up dialog that appears. (This prevents remote iView connections from changing settings without the permission of machine room personnel.)
**iCue Dispatching Capabilities**

- Design maximum 96 landings
- Design maximum 20 cars per group
- Anticipates and adapts to changing traffic demands using Artificial Intelligence
- Define up to eight independent configurations each for Hall Call Eligibility, Parking Assignment, Parking Eligibility, Operating Mode, and Security — activated manually or by user-defined timers
- Continuously evaluates multiple dispatching scenarios, maximizing efficiency
- Dedicated 100 Megabaud network handles data efficiently
- Intelligent, user-defined parking system
- Supports SmartLINK hall call system, MCE-ready fixtures
- Independent, backup dispatching on one of the iControls in the elevator group takes over dispatching if iCentral is taken off line or fails
System Interconnect

It can be helpful to have a general understanding of the way the entire iControl system is interconnected. This section contains high-level interconnection drawings for:

- **System Interconnection**: Basic car control and dispatcher interconnections.
- **Dispatcher Interconnection**: More detail for dispatcher interconnections.
- **iControl Interconnection**: More detail for car controller interconnections.
- **Cartop Interconnection**: More detail for cartop interconnections.

**Figure 5.2 iControl System Interconnection**

**Figure 5.3 Central Dispatcher (iCentral) Interconnection**
Figure 5.4 Car Control Interconnection

Figure 5.5 Cartop Interconnection
Cabinet Installation

Installation of the iCentral cabinet is similar to the installation of an iController cabinet. Please refer to “Machine Room Preparation” on page 2-4.

MCE Job Prints  MCE job print drawing numbers use the format “Job Number — Car Number — Drawing Identifier.” Thus they are specifically “keyed” to particular installations. It makes using and understanding job prints much easier if you take some time to review the job prints package before beginning controller installation. Drawing identifiers and the information you can expect to find on that job print drawing are listed below:

- N: Nomenclature drawing — schematic symbols, wire gauge information, circuit board names and symbols.
- INT: iLink cartop wiring interconnect box to controller connections.
- CVR: iBox controls and indicators.
- 1: AC power connections, power bus information.
- 2 through nn: iBox/controller wiring.
- CC: Contact Count drawing — System contact/relay information.
- SH: Serial Hall Call wiring.

Note

Depending on your particular installation, you may have extra sheets of particular drawings. Extra sheets are indicated by an “x” following the drawing identifier. You may also have different or additional equipment in your installation accompanied by different or additional drawings in your job prints. In any case, take the time to become familiar with the job prints before beginning work. Also, it is very important that you review the wiring guidelines in this section before bringing wires into the cabinet. When drilling or cutting access holes or during other machining, do not allow any metal chips to fall into the electronics.

1. Mount cabinets securely.
2. Route wiring as shown in the iCentral Quick Reference (document # 46-02-0208) shipped with the cabinet.
   - Wires must be routed through the wiring trough provided in the cabinet.
   - All conductors entering or leaving the cabinet must be through conduit. High voltage, high current conductors, such as power conductors, must be separated from control wires.

PC boards can be easily damaged by electrostatic discharge (ESD). Use a properly grounded wrist strap or other static protection when handling, touching, or making connections to PC boards.

Grounding  Please refer to “Equipment Grounding” on page 2-12.
Check for Shorts to Ground
Check for shorts to ground before powering up the system. **Power must be OFF at the main disconnect(s).** A short to ground is defined as having a resistance of less than 20 ohms between the #1 (Common) bus and the terminal being tested. If any shorts to ground are discovered, they must be corrected before proceeding.

**Danger**
Be certain that power is OFF at the main disconnect(s) before proceeding.

1. Using a standard screwdriver, temporarily disengage all twist-socketed fuses by turning them counterclockwise until they pop up.
2. Measure the resistance between the #2 (120VAC) bus terminals and the #1 bus.
3. If no shorts to ground are discovered, re-engage the fuses.

AC Voltage Verification and Wiring
The AC wiring instructions in this section describe connecting power wiring between the iControl elevator cabinets and the iCue cabinet. The majority of technical information is contained in the MCE job prints package and referenced here as necessary. AC voltage verification and wiring instructions include:

- Verifying main line power
- Wiring iCue
- Initial power up and test for bus voltage presence

**Note**
All conductors entering or leaving the cabinet must be through conduit.

1. Consult the job prints. Verify that AC supply is as specified.
2. Refer to the Group Supervisor Field Wiring Print in the job prints and to the following illustration. iCentral power is provided by the car controllers as shown in drawing -2. The main AC power supply wiring size must be determined by the electrical contractor.
   2a. Check the phase-offset of the individual car ST2-bus lines before connecting them to the Group cabinet. Use a voltmeter set to AC volts to measure between adjacent car 2-bus terminals in the Group cabinet. The meter must read less than 10VAC. If the reading is higher, reverse the power leads going to the car T1 transformer at L1 and L2 and measure again.

**Caution**
All 2 bus power from cars to the iCue cabinet must be in phase. **Connecting out-of-phase power WILL cause damage.**

2b. A separate conduit or trough must be provided for the System (group-to-car) Ethernet network. Wiring details in the job prints must be followed exactly.
2c. If applicable, also wire according to the Group Interconnects to Individual Car Cabinets print. Be sure to ground all cabinets according to instructions.

2d. Refer to the Group Supervisor Field Wiring Print for iCentral field wiring instructions.

**Figure 5.6 Elevator Controller to iCue Cabinet Wiring**
Initial Power Up and Bus Verification

After AC power is connected, you are ready to temporarily power up and check that power buses inside the cabinet are providing their proper outputs.

Caution
This procedure assumes that no field wiring has yet been connected. If field wiring has been connected, it must be disconnected before beginning this procedure. Before applying power, physically check all components in the cabinet. Components loosened during shipment may cause damage.

1. Power up the elevator controllers.
2. Power up the group controller.
3. If a controller fails to power up, refer to the job prints and check supply connections and fuses.
4. Measure from each iCue ST2 bus terminal to a Common (#1) terminal. Verify 120VAC.
5. If any bus voltage is missing, check the associated fuse. The fuses are labeled with the bus numbers and are located at the top of the cabinet.
6. Power the controllers down (in preparation to continue wiring equipment).

Note
iCentral is powered from the individual car controllers so that, when any one or more of the car controllers are powered, iCentral is also powered.
iControl Ethernet Overview

iControl uses two distinct Ethernet networks:

- The System hub connects iCentral to other MCE equipment like the elevator controllers, Serial Hall Call systems, and input/output expansion boards (SC-ION boards).
- The LAN hub connects iCentral and elevator controllers to a PC running the MCE iView application (used to configure both iCentral and iControls). Through the LAN hub, the elevator group may also be connected to an external network or building LAN (Local Area Network).

Figure 5.7 iCentral Ethernet Connections
System TCP/IP

iCue uses the System TCP/IP bus to communicate with other MCE components, including:

- SC-ION I/O: SC-ION boards provide field inputs and outputs for iCue. Customers may use these inputs and outputs for a variety of purposes. Typically, an input might be used to detect a switch closure while an associated output might drive an indicator lamp for the switch. Normally, one or two SC-ION boards, each providing 16 inputs and 16 outputs are used. If I/O demands are greater, more may be used. SC-ION boards are connected to the iCue system bus.

- Serial Hall Call: MCE Serial Hall Call greatly reduces the amount of hall call wiring typical of most elevator installations. The MCE Serial Hall Call bus is a simple, twisted-pair of 16AWG wires along which as many as 980 device addresses may be supported. Power and communication are both delivered by the serial bus. If current requirements are high, as many as four serial hall call drivers may be used to support the bus.

- Serial Driver: The current demands of the serial bus may be significant if many devices are simultaneously active. To meet these demands, each bus leg has its own Serial Driver.

- Serial to TCP/IP: The Serial Driver communicates with hall call nodes and ION boards over the two-wire serial bus. The serial output of the Driver is converted to TCP/IP (Ethernet) and routed through the System hub to the iCue PC. TCP/IP from the iCue PC is likewise routed through the System hub and then converted to serial data for the Driver.

- System Hub: The System hub is a standard Ethernet hub. The hub routes data so that TCP/IP communications between connected devices are correctly connected.

- iControls: Each car in the group is under the primary direction of its own iBox/iControl. iCue communicates with all the iControls in its group through the System TCP/IP bus.

LAN TCP/IP

The LAN hub allows local and remote personal computers running iView software to connect to iCue and all group iControls. The iView application is a user-friendly, graphical user interface that allows you to easily configure iCue and all the individual iControls in the group.
System Hub

The System hub connects iCue to the iControls in its group, to Serial Hall Call drivers through SC-HCE-ME modules, and to SC-ION input/output expansion boards. The Serial Hall Call and input/output expansion board connections are completed at the factory before the system is shipped and need only be checked to make certain they are in place. Orange Ethernet cables are used for connections to the System hub. (The LAN hub cables are blue.) The cables have a shielded RJ-45 connector at each end.

7. Connect the group and car controllers to the System hub as shown in the illustration below and in the MCE job prints. The job prints are the controlling document.

*The iCue computer in your cabinet may be different than the one shown. The connection for the System Hub is labeled SYSTEM.
LAN Hub

1. Connect the group and car controllers and the iView PC to the LAN hub as shown in the illustration below and in the MCE job prints. The job prints are the controlling document. Use the blue Ethernet cables provided.

Figure 5.9 Typical LAN (iView) Ethernet Connections
External Connections
As indicated in the LAN hub connection illustration, the elevator group may be connected to larger area networks in the building or, through T1, DSL, or dial-up modems, to remote sites via phone lines or the Internet. These kinds of connections are necessary if remote iView or iMonitor access is required.

Unless you are familiar with the technology, you will probably want to contact a networking specialist or consultant to help. When connecting outside the local elevator group, the installation is exposed to attempted access by unauthorized personnel. There are several different security measures that can be implemented to protect the elevator network. Additionally, if you connect the iCue LAN hub network to another Local Area Network or to the internet, you may need to change the factory-default IP addresses for the LAN connections.

Ethernet Addresses
Ethernet (TCP/IP) addresses are assigned to each device communicating on a network. Very generally, each address is a set of four, number groups separated by decimal points/periods (.). For example, 192.168.192.20. In order to see one another on a common network, the first three digits need to match for each device (192 in our example). In order to be able to tell one device from another, the last three digits need to be different. In our example, 20, so a second device would have to be any value between 1 and 254 EXCEPT 20 (already in use).

If Ethernet addresses are not properly set, the iControls and iCue will not be able to communicate. The addresses are set and tested at the factory before the system is shipped and should not need to be changed unless you are making external connections or adding new equipment.

Please refer to “TCP/IP Reference” on page 5-15 for additional information.
TCP/IP Reference

An Ethernet network is basically several computers (or smart equipment with a computer inside — like the iBox or iCue) all connected together at a single point (the hub) so they can communicate with each other. In order for a message from one computer to reach the computer (or iCue/iBox) it wants to talk to, all the computers connected to the network have to have their own unique address. The address is called a TCP/IP number.

- IP Address: #3 iBox 192.168.193.001, factory default.
- IP Address: #2 iBox, System — see table and following illustration.
- IP Address: #1 iBox, LAN — see table and following illustration.
- IP Address: iCue System port — see table and following illustration.
- IP Address: iCue LAN port — see table and following illustration.

The iCue Group ID (System Configuration screen, page 6-5) must always be set to 1. (See Note following table.) The table lists the typical addresses used for iCue elevator groups. As many as five groups can be on a single LAN provided their Group and Car LAN addresses are all unique. If desired, this is usually accomplished by connecting each of the Group LAN hubs to a sixth, user-provided hub. You can choose Group and Car LAN addresses. Car System addresses are controlled by the Car ID setting. The table provides the factory recommended addresses for each of up to five groups. Your job prints provide specific instructions as to how all of your IP addresses are set.

Table 5.1 System, LAN, & #3=PC TCP/IP Addresses

<table>
<thead>
<tr>
<th>Hub</th>
<th>Group</th>
<th>Group IP Primary &amp; Backup</th>
<th>Car ID</th>
<th>Car IP</th>
<th>System/Hall Call Bus 1 - 4</th>
<th>iView PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN B</td>
<td></td>
<td>192.168.191.203-204</td>
<td>1-20</td>
<td>192.168.191.021-040</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAN D</td>
<td></td>
<td>192.168.191.207-208</td>
<td>1-20</td>
<td>192.168.191.061-080</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAN E</td>
<td></td>
<td>192.168.191.209-210</td>
<td>1-20</td>
<td>192.168.191.081-100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Port #3 = PC (iBox ONLY), NO HUB</td>
<td></td>
<td>192.168.193.001</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* 192.168.191.101 is typically used for the iView PC.

Note

The Group ID setting in iView determines the iCue System IP address at which iCue will accept messages. **DO NOT set the Group ID to a setting other than 1** unless instructed to do so by MCE. The Group ID is reserved for future use. Setting it to a value other than 1 will cause group-to-car communication to fail. If you need advanced System addressing information, please contact MCE.
Figure 5.10 Example of Ethernet Addresses and Connection

GROUP 1 ETHERNET ADDRESS EXAMPLES

CAR A
- 192.168.193.001
- 192.168.192.001
- 192.168.191.001

CAR B
- 192.168.193.001
- 192.168.192.002
- 192.168.191.002

CAR C
- 192.168.193.001
- 192.168.192.003
- 192.168.191.003

CAR D
- 192.168.193.001
- 192.168.192.004
- 192.168.191.004

CAR E
- 192.168.193.001
- 192.168.192.005
- 192.168.191.005

SYSTEM HUB
- 192.168.192.211
- 192.168.192.212
- 192.168.192.213

Swing Car Hall Calls
- Serial Hall Call Driver
- Isolation Board

Additional System Hub Connections for Serial Hall Call
- Serial to Ethernet
- Hall Call Driver
iControl Ethernet Overview

**SYSTEM HUB**
- 192.168.193.2
- 255.255.255.0 Subnet Mask
- 0.0.0.0 ( . . . ) Gateway

**LAN HUB**
- ORANGE CABLES
- BLUE CABLES

**iView, Direct**
- PC used for Direct Connection
- 192.168.191.101
- 255.255.255.0 Subnet Mask
- 192.168.191.254 Gateway

**iView, LAN**
- PC used for LAN Connection
- 192.168.191.101
- 255.255.255.0 Subnet Mask

**iCue Group Controller**
- 192.168.193.2
- 255.255.255.0 Subnet Mask
- 0.0.0.0 ( . . . ) Gateway

**iCue SYSTEM**
- 192.168.192.201
- 255.255.255.0 Subnet Mask
- 192.168.191.254 Gateway

**Serial to Ethernet**
- Hall Call Driver
- 192.168.192.214
System Options

System Ethernet
Only MCE equipment (iCue, iControl, MCE serial drivers) should be connected to the System hub. The TCP/IP addresses for the iBox #2 (System) and iCue System ports are set at the factory so that the systems will communicate with one another as soon as they are plugged in.

LAN Ethernet
The iCue PC or iBox and the elevator controller iBoxes are also connected to the LAN hub. The LAN hub is provided so that you can connect a PC running iView, which will then be able to access all the iCue and iControl hardware connected to the hub. The TCP/IP addresses for the LAN network (iView connection) are set at the factory. If your iView PC was provided by MCE, you can simply connect the iBoxes, the iCue, and the iView PC to the hub and they are ready to communicate. However, if you provided the PC, you will need to set its IP address properly to communicate through the hub.

Setting iView PC LAN IP Addresses
To set the IP address for an iView PC you provided and want to connect to the iCue LAN hub, use the instructions below. These instructions assume you have not changed the factory-default settings for the iCue or iBox LAN ports. When setting IP Addresses on a PC, do not enter leading zeros (i.e., .020 is entered as .20).

The following example is for the Windows XP operating system.

1. Start the PC.
2. Select Control Panel from the Windows XP Start menu.
3. Double-click Network and Internet Connections to open the Network and Internet Connections dialog.
4. Double-click Network Connections to open the Network Connections dialog.
5. Double-click the Local Area Connection icon to open the Local Area Connection Status dialog.
6. Click **Properties** to open the Local Area Connection Properties dialog.

7. In the Local Area Connection Properties dialog, select **Internet Protocol (TCP/IP)**.

8. Click **Properties** to open the Internet Protocol (TCP/IP) Properties dialog.
9. Set the IP Address to match the iCue LAN EXCEPT FOR the last set of numbers. Typically, you can set your PC’s IP address to 192.168.191.101.

10. Set the Subnet Mask to 255.255.255.0.
12. Click OK and follow any instructions to save the changes you made.
Setting iCue PC LAN IP Addresses

You should not need to set the iCue LAN IP address unless you are changing addresses to add the LAN hub to an existing Local Area Network. When entering IP Addresses on a PC, do not enter leading zeros (i.e., .020 is entered as .20).

**Note**

When you open your iCue PC Network Connections, you will see two local area connections. The LAN Ethernet controls the iCue LAN connection (iView); the System Ethernet controls the iCue System connection to iBoxes, Serial Hall Calls, and I/O boards and **SHOULD NOT BE CHANGED WITHOUT CONSULTING MCE**.

The following example is for the Windows XP operating system.

1. Start the PC.
2. Select Control Panel from the Windows XP Start menu.
3. Double-click Network and Internet Connections to open the Network and Internet Connections dialog.
4. Double-click Network Connections to open the Network Connections dialog.
5. Double-click the System Ethernet icon to open a System Ethernet Status dialog.
6. Click Properties to open the System Ethernet Properties dialog.


8. Click Properties to open the Internet Protocol (TCP/IP) Properties dialog.
9. Set IP address, Subnet Mask, and Default Gateway accord as required to reside on the new LAN. The values shown below are the factory values.

10. Click OK and follow any instructions to save the changes you made.
Pinging

If you suspect that one or more of the devices is still not communicating, you can “ping” them from the iView PC. Pinging just lets you send a message manually that just asks for a reply if the other device can “hear” you.

To ping:

1. Select Start/Programs/Accessories/Command Prompt from the Windows Start menu.
2. Type in ping and the IP address of the device you want to check. For example:

   ```plaintext
   C:\>ping 192.168.191.201
   Pinging 192.168.191.201 with 32 bytes of data:
   Reply from 192.168.191.201: bytes=32 time<10ms TTL=128
   Reply from 192.168.191.201: bytes=32 time<10ms TTL=128
   Reply from 192.168.191.201: bytes=32 time<10ms TTL=128
   Reply from 192.168.191.201: bytes=32 time<10ms TTL=128
   Ping statistics for 192.168.191.201:
     Packets: Sent = 4, Received = 4, Lost = 0 <0% loss>
     Approximate round trip times in milli-seconds:
       Minimum = 0ms, Maximum = 0ms, Average = 0ms
   C:\>
   ```

3. If the device is visible and responding, you will see four messages saying “Reply from...”
4. If not, the IP address for the PC or for the device may not be correctly set.
iCue User Interface

Whenever iCue is running and the monitor is switched to the iCue PC (rather than the iView PC), the iCue GUI is visible on the screen. The iCue GUI provides an overview of group operation and status.

- **Group Info**
  - **Group ID**: The Group ID (1) cannot be changed. All other IDs are reserved for future use. If you need advanced System addressing information please contact MCE.
System Options

- **Mode of Operation**: The current group operating mode is displayed here:
  - **Automatic**: The group assigns operating modes automatically depending upon building traffic conditions.
  - **Balanced**: The group is operating in balanced mode, favoring neither up, down, nor lobby traffic.
  - **Lobby Peak**: The group is operating in lobby peak mode, favoring traffic from the building lobby or lobbies.
  - **Demand Up Peak**: The group is optimizing car assignment to favor up direction traffic.
  - **Demand Down Peak**: The group is optimizing car assignment to favor down direction traffic.

- **Network Info (LAN and System)**: The LAN is the ethernet network used by iView, iMonitor, and iReport to communicate with groups and cars. The System is the ethernet network used by the group and individual car controls to communicate with one another.
  - **IP Address**: The TCP/IP address of the group on this network
  - **Subnet Mask**: The subnet mask limits the number of valid addresses in the group. For iControl, this should always be 255.255.255.0
  - **Gateway LAN**: 192.168.191.254
  - **Gateway System**: 000.000.000.000 (0.o.o.o)

- **Connection Status**: Displays the active car connections.

- **Bus Status**: For each serial I/O bus (1, 2, 3, 4), displays operational status:
  - **Connected**: Lights green if the bus is connected.
  - **Bus Voltage**: Lights green if the bus voltage levels are adequate.
  - **Driver VDC**: Lights green if the DC voltage provided by the driver is adequate.
  - **Node Control**: The driver polls the nodes (addresses) of connected devices (hall calls, other I/Os). This LED lights green when all nodes are responding correctly.
  - **Bus Enabled**: Lights green when there is activity on the bus.
  - **High Current**: Lights red if current demand is excessive. Occasional flashing is normal. Near continuous flashing or steady on state means that the serial driver is unable to provide enough current to meet demand. Continued high demand can damage the bus driver. Contact MCE Technical Support.

- **Emergency Power**:
  - **Generator 1**: Commercial power has been interrupted. Generator 1 is functioning.
  - **Generator 2**: Commercial power has been interrupted. Generator 2 is functioning.

- **Write privilege timeout**: Allows you to set the amount of time for which write privilege is granted. The default is 15 minutes. A value of zero = no time out.

**Write Permission**

When someone working in iView wants to change an iCue setting, they have to request permission by selecting Acquire from the Write Privileges menu. When they do, a pop-up dialog will appear on the iCue screen in which you can approve or deny the request. This prevents remote iView connections from making changes without the permission of machine room personnel.

If you request permission from the iCentral iView PC, immediately switch to the iCue PC by pressing <scroll lock> twice and approve the request in the pop-up dialog. Then switch back to the iView PC to make the changes.
iCue Watchdog

When iCue is running, there is a utility called iCue Watchdog running in the background. The watchdog monitors iCue and makes certain that it continues to run as it should.

The watchdog is a Windows Service, which means that it will not show up on the task bar or icon tray. It runs under the name iCueWatchdogService.exe. Some attributes of the watchdog include:

- The watchdog's purpose is to make sure iCue is running. If iCue is closed through the task manager, crashes, or locks up, the watchdog will restart it.
- The watchdog will also monitor the iCue GUI. It will restart the GUI if it crashes for some reason. This should have no effect on iCue or system dispatching.
- The watchdog should always be running whether iCue is running or not. It gets started in a batch file that is put into the startup directory.
- If you close the iCue GUI (by right-clicking it in the icon bar and selecting exit) the watchdog assumes that is done intentionally and will not restart icue.
- Starting the iCue GUI after it has been closed will trigger the watchdog to start monitoring the applications again.
- The watchdog has a config file for setting the directory paths of iCue and iCue GUI and timers (in msec) that it uses to monitor the applications.

Caution

Watchdog information is provided to help you understand how iCue works. Never attempt to modify Watchdog configuration. Incorrect settings can corrupt the functionality of the iCue group control software.
Comm-connect Cabinet - Local/Dispatcher

The Comm-connect cabinet is used to house the system communication components when the Local/Dispatcher option is used. This cabinet houses the Serial Hall Call Driver(s), Ethernet Switches, SC-ION Serial Control I/O Node board and AC power connections.

Figure 5.11  Typical Comm-connect Cabinet
For systems that use the Local/Dispatcher option, the Comm-Connect Cabinet is where the serial and Ethernet communication equipment is housed and where the connections are made.

- **Ethernet Switches**: The Ethernet switches are the main connection / distribution point for the Local Area Network (LAN) and System Ethernet networks.
- **SC-HC-ME Serial to Ethernet Adapter**: This component converts the serial signals from the SC-HCDA Serial Hall Call Driver Assembly to the Ethernet protocol for transmission on the System Ethernet network.
- **SC-HCDA Serial Hall Call Driver Assembly**: This assembly provides power and communication to the Serial Hall Call Node boards located in each hall fixture box. Power and communication is transmitted on the two wire Serial Bus. Two SC-HCDA assemblies may be housed in the Comm-connect cabinet. For more information about the Serial Hall Call option see “Serial Hall Call” on page 5-30.
- **SC-ION Serial Control I/O Board**: This board is used for serial communication of signals other than hall call signal (see “Checking Serial to IP Connections” on page 5-35).
Serial Hall Call

Direct serial I/O allows hall call buttons/indicators, to be connected to iControl using a simple, 2-wire bus for both communication and power. This serial bus reduces the amount of wiring required per riser and makes the wiring job much easier and less expensive.

The serial bus uses a +/- 15-volt square wave, sampled for both amplitude and duty cycle, for communication between devices. The positive-going signal actually reaches +40-volts and is regulated to +24-volts to drive hall call lamps or other loads.

A “bus driver” is required to provide the output capability necessary to carry the load of multiple, simultaneously lighted lamps. A single controller can have up to four drivers/serial buses with each bus addressing as many as 980 devices. The photograph below shows a serial hall call bus driver installed in an iCentral Controller cabinet.

Figure 5.13  Serial Hall Call Bus Driver
Figure 5.14   Typical iCentral Serial Hall Call Connections

Figure 5.15   Typical Serial Hall Call Connections for a Simplex or Swing Car
Hall Call Installation
Installing a serial hall call system includes:
• Pulling the serial bus wiring
• Setting the node board addresses
• Installing the hall call enclosures (refer to the job prints)

Pulling Serial Bus Wiring
The serial bus is the physical, twisted pair of 14 AWG or 16AWG wires along which all the hall calls are connected. Install the serial bus wiring in accordance with applicable codes. The best practice is to initiate each separate vertical bus wire run from the controller location. If necessary, multiple serial bus runs can be “paralleled” at a driver to make them a single serial bus. Refer to the drawing “Serial Hall Call Suggested Wiring Methods” in the job prints for specific instructions for each job. The illustration below shows a single serial bus connected to serve two vertical runs of hall call boxes.

Figure 5.16  Single Bus, Two Vertical Runs of Hall Call Boxes
Setting Node Board Addresses
Each hall call enclosure contains a “node” board. The node board provides two outputs to power hall call lamps or LEDs, two inputs for the hall call buttons, and jumpers to set floor ID and hall call “type.”

In a typical installation, a node (SC-HCNT) board is mounted in each hall call receptacle. The blue and orange wires of the serial bus connect to one end of the board, the hall call buttons and lamps or LEDs connect to the other end (as shown in the job prints depending upon lamp or LED connection). During installation, it is easiest to set jumpers on each node board so that it is uniquely identified for floor ID and call type before you mount the board in the enclosure.

Node board jumper examples are illustrated below.

- Floor Number/Address Jumpers
  Jumpers 2 and 3 set the Floor number (or the first two digits of the serial address) for the node board.

  Jumpers 2 and 3 set the Floor number (or the first two digits of the serial address) for the node board.

  **Floor number or first digits of serial address**

  * This example sets the Down (DN) input/output to address 124 and the UP address to 126. The first two digits represent the floor number, in this example, 12.

- Call Type Jumper
  The example shown above would set the Floor number to 12.
  Because building floors are not consistently numbered and because a riser may not serve all floors in a building, MCE creates a table of values for these jumpers according to the building survey for the job. Refer to your job prints for precise information about setting these jumpers for your installation.

  Jumper 3 sets the first digit for the floor (or serial address).
  Jumper 2 sets the second digit for the floor (or serial address).

  **Floor number or first digits of serial address**

  * This example sets the Down (DN) input/output to address 124 and the UP address to 126. The first two digits represent the floor number, in this example, 12.

  **Floor number or first digits of serial address**

  * This example sets the Down (DN) input/output to address 124 and the UP address to 126. The first two digits represent the floor number, in this example, 12.

- Call Type Jumper
  The example shown above would set the Floor number to 12.
  Because building floors are not consistently numbered and because a riser may not serve all floors in a building, MCE creates a table of values for these jumpers according to the building survey for the job. Refer to your job prints for precise information about setting these jumpers for your installation.
Jumper JP1 sets the call type for the two switch/lamp combinations serviced by the node board (or the individual jumpers can be thought of as setting the last digits of the boards two unique serial addresses). You set one jumper for each of the boards two I/Os. The most common setting for JP1 jumpers, Down Front and Up Front hall calls, is shown in the following illustration. The table after the illustration lists all call types.

Table 5.2  Floor Sub-Addresses (Call Type) Jumper Settings

<table>
<thead>
<tr>
<th>Sub-Address</th>
<th>Default Definition</th>
<th>Sub-Address</th>
<th>Default Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Front Auxiliary Down Call</td>
<td>5</td>
<td>Standard Rear Down Call</td>
</tr>
<tr>
<td>1</td>
<td>Rear Auxiliary Down Call</td>
<td>6</td>
<td>Standard Front Up Call (shown)</td>
</tr>
<tr>
<td>2</td>
<td>Front Auxiliary Up Call</td>
<td>7</td>
<td>Standard Rear Up Call</td>
</tr>
<tr>
<td>3</td>
<td>Rear Auxiliary Up Call</td>
<td>8</td>
<td>Commandeer Front Call</td>
</tr>
<tr>
<td>4</td>
<td>Standard Front Down Call (shown)</td>
<td>9</td>
<td>Commandeer Rear Call</td>
</tr>
</tbody>
</table>

**Note**

Only the Sub-address jumper, JP1, can have more than one jumper inserted. (It can have a maximum of two — one to complete the DN address, the other to complete the UP address.) All other node board jumpers can have ONLY ONE jumper inserted. If more than one jumper is inserted in JP2 or JP3, the system will not work.

**Wiring the Nodes**  Each serial bus consists of a twisted pair of wires, one orange and one blue. Each “node” on the bus (i.e., a hall call button/lantern pair), has a connection to the orange wire and a connection to the blue wire in addition to button and indicator lamp connections. See the job prints and instructions accompanying the hall call kits for details.
Checking Serial to IP Connections

Each Serial Hall Call bus originates from a Serial Hall Call Driver in the iCue cabinet. Each Serial Hall Call Driver in turn communicates with iCue through the System Ethernet hub.

Figure 5.17 Serial to TCP/IP Connection

1. Verify an orange Ethernet cable from the Serial-to-Ethernet converter to the System hub.

The Serial-to-Ethernet converters each have their own IP address. The IP address is preset at the factory and should not need to be changed.

Caution
Always power down the serial hall call driver and wait at least one minute before installing, replacing, disconnecting, or connecting an SC-HCME-EM or -ME serial to Ethernet board to avoid potential damage to the board PLD from a high voltage spike.
Troubleshooting
This section describes some basic troubleshooting techniques for the serial/Ethernet translation units (Digi boards) and the Serial Hall Call Driver Assembly (SC-HCDA).

Serial/Ethernet Translation
The serial I/O protocol used for MCE serial hall call and serial I/O board connections is translated to and from Ethernet bus protocol for system level communication over the iControl System network. (System hub in iCentral dispatcher. Orange TCP/IP cables.) One of two assemblies is used:
- SC-HCE-ME
- SC-HCE-EM

The base circuit board is the same for both units. The Ethernet port module used is different. These assemblies are mechanically configured, then programmed using a special utility program running on a Windows 2000 or XP personal computer.

SC-HCE Assemblies
The SC-HCE-ME assembly is shown in the illustration below.

Figure 5.18 SC-HCE-ME Serial/Ethernet Translation Assembly
**Mechanical Configuration**  
Refer to the preceding illustration for part identification.

- Ethernet Port: Standard Ethernet port. Used to connect this assembly to the System Ethernet hub using an orange Ethernet cable.

**Figure 5.19  -EM and -ME Ethernet Ports**

**Table 5.3  EM LED Descriptions**

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
</table>
| Serial port activity | green | Indicates activity on the serial port | Off: serial channel idle.  
Blinking: Active connection. |
| Network link         | green | Network link status.    | Off: No link detected.  
On: Link detected. |
Blinking (1-5-1): Configuration reset to factory defaults.  
Blinking (steady): Device is seeking an IP address from a DHCP server. |
| Reserved             | yellow| NA                      | NA                                                                         |

**Table 5.4  ME LED Descriptions**

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link Status/Integrity</td>
<td>yellow</td>
<td>Network link is operational: On continuously indicates that an Ethernet connection is made or an access point is engaged.</td>
</tr>
</tbody>
</table>
| Network Activity/Diagnostic| green  | Network Activity: On when network traffic detected; off when no traffic detected.  
Diagnostic: Flashes three times in even duration during power up or reset, indicating successful startup. |
• **Jumpers JP1, JP2, JP3**: These jumpers are used to set board options, e.g. the communications rate of the serial bus. Refer to the label on U2, the FPGA IC (see “SC-HCE-ME Serial/Ethernet Translation Assembly” on page 5-36), to determine the software version and thereby the jumper schedule to use.

### Table 5.5  SC-HCE-ME Board Jumper Schedule for FPGA software V6.4.0 45BC0A

<table>
<thead>
<tr>
<th>JP3</th>
<th>JP2</th>
<th>JP1</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Off</td>
<td>Off</td>
<td>115.2 kHz baud rate (default setting)</td>
</tr>
<tr>
<td>Off</td>
<td>Off</td>
<td>On</td>
<td>460.8 kHz baud rate</td>
</tr>
<tr>
<td>Off</td>
<td>On</td>
<td>Off</td>
<td>230.4 kHz baud rate</td>
</tr>
<tr>
<td>Off</td>
<td>On</td>
<td>On</td>
<td>921.6 kHz baud rate</td>
</tr>
</tbody>
</table>

**For board programming**

<table>
<thead>
<tr>
<th>JP3</th>
<th>JP2</th>
<th>JP1</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Off</td>
<td>Off</td>
<td>Board may be programmed</td>
</tr>
</tbody>
</table>

Off = No jumper in this position. On = Jumper in this position.

### Table 5.6  SC-HCE-ME Board Jumper Schedule for FPGA software V6.5.0 1DB38F

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Position</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JP1</td>
<td>Off</td>
<td>115.2 kHz baud rate (default setting)</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>230.4 kHz baud rate</td>
</tr>
<tr>
<td>JP2</td>
<td>Off</td>
<td>Over clocking enabled (default setting)</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Over clocking disabled</td>
</tr>
<tr>
<td>JP3</td>
<td>Off</td>
<td>Self resetting of (Digi) data converter enabled (default setting)</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Self resetting of (Digi) data converter disabled</td>
</tr>
</tbody>
</table>

Off = No jumper in this position. On = Jumper in this position.

### Ribbon Cable Connection

Point of connection for ribbon cable to serial driver assembly.

### Status LEDs

These LEDs are a quick way to check status:

- **FHCE OK**: Board fuse/power OK.
- **Bus Error**: If lighted, indicates a communication problem.

### Fuse

The FHCE OK LED indicates power presence “after” fuse. The fuse is 1/2A, 250V, AGC type.

---

**Caution**

Always power down the serial hall call driver and wait at least one minute before installing, replacing, disconnecting, or connecting an SC-HCME-EM or -ME serial to Ethernet board to avoid potential damage to the board PLD from a high voltage spike.
Trouble Indications

- Hall Call buttons do not work
  - Do building Hall Call buttons light when pressed?
  - Do building Hall Call buttons stay on until elevator arrives?
- Elevator reported to be in “Wild Operation” (stopping at every floor)
  - Does the iBox LCD display indicate Emergency Dispatch?
- LEDs not lighted on the base board of the serial/Ethernet assembly.
- EM: Serial Port and Reserved LEDs lighted solidly. Network Link Status and Diagnostics OFF.
- ME: Both Network Link and Network Activity LEDs OFF.
- Hall Call LEDs or lamps flashing or not operating normally.

Quick Check

- During power up:
  - Two red SC-HCE board LEDs (FHCE and Bus Error) should remain on for 30-40 seconds after the Hall Call Driver is powered-up.
  - After solid-on, LEDs will cycle through a period of start up activity then indicate normal operation as described below.
- Normal operation indication:
  - Network Link Status LED on solidly (EM top left, green; ME left, yellow).
  - Network/Serial Port Activity LED flashes once every five seconds (EM top right, green; ME right, green) when communicating with iCue.
  - Network/Serial Port Activity LED should flash once when a Hall Call button is pressed.
  - FHCE (red) LED on SC-HCE board solidly on.
  - Bus Error (red) LED on SC-HCE board off.
- Auto Reset
  - With no jumper across JP3 on the SC-HCE board, the assembly PLD will initiate a reset every 60 seconds if it does not see communication from iCue.
  - Check that the iCue software is running properly on the PC. If not, restart iCue by clicking the Windows Start button and selecting Start/Programs/Startup/iCue.
  - Recheck.

General Check

1. Check all power and data cable connections.
   - Port status LED on System hub should light when the Ethernet cable is plugged in between the hub and the serial/Ethernet board.
   - Ribbon cable seated properly on the hall call driver and the serial/Ethernet board.
   - Use a voltmeter to measure between each of the three DC voltages (3.3V, 5V, 9V) on the serial/Ethernet (SC-HCE) board to ground. Voltages should read the provided level, +/- 10%.
2. Check the SC-HCE board to see that there are no jumpers across JP1, JP2, or JP3.
**iView Check**  Use the iView System I/O Configuration screen, Bus tab to see if trouble is indicated and to check that hall calls are addressed as specified in your job prints.

1. Launch iView and connect to the group.
2. Open the System I/O Configuration screen and select the Bus tab.
3. Verify the state of the indicator LEDs and that the addresses are as defined in the group job prints (inputs as expected per serial address and Labels mapped to correct floor).
**TCP Address Check**  The Digi Device Discovery utility may be used to check and, if necessary, reset the TCP/IP address of the serial/Ethernet assembly (SC-HCE-EM or ME). This utility is available from MCE.

1. Start the Digi Device Discovery utility. The utility will launch, and check the System network for any connected SC-HCE-EM or -ME.

2. Select the device. Click on Configure Network Settings.
3. In the Configure Network Settings dialog that appears, select Manually configure network settings.

4. Check the drawing package for the dispatcher or the Ethernet Address examples drawing in the manual. Please refer to “Example of Ethernet Addresses and Connection” on page 5-16.

5. If the IP address of the device is incorrect, set it appropriately.

Note

When entering the IP address, do not enter leading zeros. For example, in the address 192.168.192.056, 056 is entered as 56, with no leading zero.

6. Click Save. A Reboot Device dialog will appear:

7. Wait for ten to fifteen seconds (until the Diagnostic LED on the serial/Ethernet assembly blinks for eight to ten seconds and then goes off), then click OK.

8. Restart the iCue PC.
**Hall Call Driver**

**Quick Test**  You can do a basic functionality test on the hall call driver.

With power applied:

1. Verify 120VAC power to the driver.
2. Unplug the Serial Bus connection (orange/blue wires).
3. Use a voltmeter to check the voltage between SHCS and SHCC. You should see approximately 30V, + or - 10%. (This voltage will only be present if the SC-HCE-ME or EM is working properly as verified in preceding troubleshooting steps.)

If this voltage is present, the driver is probably operating properly.
Driver Voltages Test  The hall call driver can be more thoroughly tested if necessary. The test is relatively simple on iCentral units shipped after July, 2005 because a female, “test” connector has been installed in the middle of the ribbon cable connecting the driver to the SC-HCE (Digi board) assembly. Earlier units do not have the test connector.

Note

Note: Digi-board connector ground pins are 2,3,4,6,9,11,12,13,14,15, and 17.

1. Cut three pieces of 22 AWG solid wire 2” in length. Strip ½” insulation off each end. These will be used as “jumpers” and test probes during the test.
2. At the SC-HCE board end, disconnect the ribbon cable connected to the hall call driver. Note the test connector in the middle of the cable. Its pinout is as shown.

Note

Alternatively, if the cable does not have a test connector, insert a 20 conductor ribbon cable, with a female connector at each end, into the SCHCD J2 socket.

3. Remove orange and blue bus wires from the hall call driver bus terminal connector.
4. Connect 120 VAC power to Serial Hall Call Driver power input terminals.
5. Insert the negative DC voltmeter lead to the Hall Call Bus SHCC Terminal connector.

• Driver DC power supply test
  1. Insert a wire test probe into pin 19. Connect the positive voltmeter lead.
  2. You should see 42-volts (+/- 10%). Remove the wire probe.

• Digi-board DC power supply test
  1. Connect the positive voltmeter probe/lead to pin 8.
  2. You should see 10-volts (+/- 10%).
Flexible I/O

- Node Response test
  1. Insert a probe wire into pin 20, connect the positive voltmeter lead.
  2. You should see 5-volts, +/- 10%. Leave the probe wire in place.
  3. Bend the wire/jumper and short pin 20 to pin 17.
  4. Insert a probe at pin 5 and connect the positive voltmeter lead.
  5. You should see something under 1-volt.
  6. Leave the pin 20 to pin 17 jumper in place and the positive voltmeter lead connected to pin 5.
  7. Use a second jumper to short pin 10 to pin 12.
  8. You should see something over 20 volts.
  9. Leave the pin 20 to pin 17 jumper in place. Remove the lead from pin 5.

- Driver output voltage test
  1. Place the positive DC voltmeter lead on the Hall Call Bus SHCS Terminal.
  2. You should see something over 35-volts.
  3. Insert a probe wire at pin 16 and connect the positive voltmeter lead
  4. You should see something over 25-volts.
  5. Leave the pin 20 to pin 17 jumper in place. Remove the lead from pin 16.

- Node control flag test
  1. Insert a probe wire at pin 18 and connect the positive voltmeter lead.
  2. Bend the wire probe and temporarily short pin 18 to pin 17 or pin 15.
  3. Watch the voltmeter as you unplug the wire from pin 17 (or 15), it should read less than 1-volt when the short is released.

- Node control flag test preferred alternate method
  1. Install a ¼ Watt 10K Ohm (brown, black, red) resistor between pin 15 and pin 18 and connect voltmeter to pin 18.
  2. Release pin 20 from the ground (pin 17). The voltmeter should read something over 20-volts.

If the preferred alternate method is used you will see a short positive pulse on your voltmeter.

  1. Place the positive DC voltmeter lead on the Hall Call Bus SHCS Terminal. The voltmeter should indicate less than 1-volt.
  2. Remove all test connections. If the driver passed all of the above tests it will likely operate OK.

Flexible I/O

iCue makes extensive use of a serial bus to handle a range of communication and control needs. The serial bus is used to service the MCE Serial Hall Call System and to control I/O through one or more SC-ION boards (input/output expansion boards). Each SC-ION board provides 16 user-configurable inputs and 16 user-configurable outputs. Input and output configuration, using the MCE iView graphical user interface, is described in Section 6 of this guide. This section describes physical I/O connections.
SC-ION Boards

The number of SC-ION boards in an iCue system will vary depending upon system configuration and the number of additional inputs and outputs required for the job. A typical job might have one SC-ION board, providing 16 additional inputs and 16 additional outputs.

Figure 5.20 SC-ION Board in iCue Cabinet

In this configuration, inputs and outputs have been routed to clearly labeled terminal strips for easy user identification and connection. Terminal strips are located behind the hinged panel inside the iCentral cabinet, mounted for convenient user access.
Flexible I/O

I/O Connections
Connect inputs and outputs as shown in your job prints. SC-ION board inputs are always 120VAC. Outputs may be configured (in specific groups) to provide either a path to ground or current to drive indicator lamps/LEDs.

Output State Selection
The outputs are divided into three groups. Each group shares a common. The common may be wired to provide a current source or a path to ground. The groups are:
- Relays 1 — 4
- Relays 5 — 8
- Relays 9 — 16

The commons for the groups are determined by the connections made to board connector J4. The appropriate connections are determined during the job survey. Each system is configured before shipment. You need only connect the inputs and outputs as shown on the job prints.

Board Addresses
Each of the 16 inputs and 16 outputs on the board has an address on the system bus. The addresses are assigned as indicated by the job survey before the system is shipped. A software tool, running on a Windows platform, is used to set individual addresses and also to set the address range (10-488 or 10-988) used for the job. To configure the board, a Windows PC running the software tool must be connected to the board serial port.

Board Programming
Addresses are programmed for each SC-ION board input and output at the factory using a tool called SCION Configuration.exe. You should never have to use this tool without factory technical support. A typical programming screen from SCION Configuration is shown for informational purposes:
Serial COP

With the Serial Car Operating Panel system, car call buttons connect directly to a serializing board located in the car station enclosure. Multiple Serial COP boards daisy-chain together to accommodate high-rise installations with a lot of call buttons.

Caution
This system is designed for 24 VDC circuits maximum. Connecting 120VAC or DC will open the input fuses.

Connection Example: Universal 4-pin inputs
Wiring from the Serial COP board(s) to the iLink cartop box is a short length of shielded cable with a telephone-style RJ-11 connector at each end. The iLink cartop box supports up to four serial control panel connections. Communication between iLink and the controller is also serial, thereby reducing the traveler and hoistway cabling.

**Figure 5.22  iLink Cartop Box**
Serial COP Board Specifications

Each Serial COP board handles up to 24 call buttons or switches. If more inputs are required, Serial COP boards are daisy-chained together.

- Each of the Serial COP board’s 24 I/O connections can be used as an input, an output or a combined call input and output.
- Plugable connections are provided for COP buttons and switches.
- Inputs can be 12 - 24 VDC (24V preferred).
- Outputs: 24V, 6W (maximum) lamps or 250mA maximum current LEDs recommended.
- Socketed, easily replaceable drivers protect the board from damage due to out-of-range inputs.
- The initial Serial COP board (ICE-COP) communicates with the iLink ICE-CTP board using an RJ-11 cable.
- Additional Serial COP boards (ICE-COP-X) are daisy-chained using RJ-11/RJ-45 cables.
- All Serial COP board I/O assignments are field configurable using the iView Configuration > I/O Boards > Configuration tab. Please refer to “Configuration - I/O Boards” on page 9-102. The signal types include:
  - Car calls
  - Car call enables (security)
  - Enable overrides (security)
  - Door controls
  - Car status
  - Position indicators
  - Alarm I/O
  - Load indicators
  - Operating mode I/O including: Fire service, Attendant service, Independent service, Flood operation, Inspection operation, Swing operation, Earthquake operation, Sabbath operation, Recall operation and CFSS (Commandeer for Special Service) operation.

Serial COP Installation

1. Mount the Serial COP boards in the car operating panel (recommended orientation: see “Serial COP board - typical installation” on page 5-48.
2. Connect the COP switches and lamps to the Serial COP board(s) using the pluggable connectors or the universal 4-pin connections. Refer to job print drawings - Cartop Details (-CTx).
3. Verify the COP board I/O assignments using the iView Configuration > I/O Boards > Configuration tab.

ICE-COP-2 Board Diagnostics

The DIP switches and LEDs in the upper right corner of the ICE-COP board provide diagnostic information. Please refer to “ICE-COP Serial Car Operating Panel Board” on page 6-76.
EMCO Load Weigher Installation and Calibration

This instruction pertains to the installation and calibration of the Elevator Motors Corporation, EMCO, Load Weigher. The following topics are covered.

- Installing the EMCO Load Cells (Sensors) (see page 5-52)
- Installing the EMCO Control Unit and connecting the wires (see page 5-53)
- Control Unit description of operation (see page 5-54)
- Load Weigher calibration procedure (page 5-55)
- Final calibration with iControl (see page 5-57)
- Installation with 2 to 1 roping (see page 5-59)
- Verifying the zero calibration (empty car weight) (see page 5-60)
- Troubleshooting (see page 5-60)

EMCO Load Weigher

Components include:
- Control Unit, model VK-3V
- Load Cells, model SWK
- Sensor installation tool
- Terminal tool/key (not shown)
- Terminal cover plate (not shown)
- DIN rail mounting bracket (not shown)
Installing the Sensors

The model SWK sensors are installed using the tool supplied. In some instances it may be necessary to extend the length of the handle to gain more leverage.

1. Typically the sensors are mounted on the wire ropes directly above the cartop hitch. However, with 2 to 1 roping the sensors must be mounted below the dead-end hitch beneath the overhead. Please refer to “Installation with 2 to 1 Roping” on page 5-59.

2. Notice that one of the sensor’s pins moves in and out. Move the pin to the in position as shown.

3. Place the sensor on the wire rope and using the installation tool, apply leverage to rotate the sensor until the pin can be moved to the out position as shown.
Installing the Control Unit and Connecting the Wires

The control unit may be mounted using the DIN mounting bracket supplied or using the holes in the sensor itself. Choose a convenient location on the cartop. (For iControl, if there is space, the control unit could be mounted inside the iLink enclosure.)

Three sets of wires must be connected to the EMCO VK-3v control unit:

1. a. For iControl, EMCO control unit output to ICE-CTP board in the iLink Cartop box:
   - connect CTP board terminal LW- to EMCO control terminal Com.
   - connect CTP board terminal LW+ to EMCO control terminal 0-10v.
   - connect CTP board terminal SHLD to the cable shield (do not connect the shield to the EMCO control unit.

1. b. For IMC or Performa, EMCO control unit output, through the traveler, to the controller.
   - connect SCR-RI (or SCR-RIX) board terminal LW- to EMCO control terminal Com.
   - connect SCR-RI (or SCR-RIX) board terminal LW+ to EMCO control terminal 0-10v.

2. 115Vac power, connected to the terminals labeled 115Vac.

3. Sensor wires, connect the control unit as indicated on the sensor wire:
   - red wired to terminal EXC+
   - black wire to terminal EXC-
   - green wire to terminal IN+
   - white wire to terminal IN-
   - shield wire to terminal MALLA

Use the Terminal tool/key (wire insertion tool), or a narrow flat blade screwdriver to open the detent in the terminal connector to allow insertion of the tinned wires.
PROGRAMMING the EMCO VK-3v Control Unit

Description of Operation
The purpose of the EMCO Load Weigher system is to measure the load in the elevator and provide usable information about the load to the elevator controller. This information is used for pre-torquing and for dispatching decisions, e.g. light load anti nuisance, heavy load and overload.

The system usually consists of a sensor or group of sensors mounted on the elevator’s wire ropes and a control unit. The sensor(s) provide a signal to the control directly related to the amount of load in the cab. The load weigher control accepts this signal and provides usable data to the elevator controller in the form of an analog signal.

How to Program the EMCO Load Weigher Control Unit

• Press the  menu button until the display shows the desired parameter to be changed.
• Press the  button to select the digit to be modified (digit blinks when selected).
• Press the  button to change the digit.
• Press the  menu button twice to save the new value. Once a value is saved the control will display the next parameter.
• If you do not press the  menu button twice the changes will not be stored and the control display will continue to show the parameter you were modifying.

Menu/Programming Order

Installation Menu
Pressing the  menu button will scroll through the Installation Menu in the following order:

- Measured weight in car (value displayed varies with load in car)
- Overload weight
- (not used)
- (not used)
- Learn empty car weight (Zero weight)
- Learn full load weight (Calibrate with Weights)
- (not used)
- Auto-zero calibration (used as required)
- (not used)
EMCO Load Weigher Installation and Calibration

Calibration

Man ual Calibr ation with Weigh ts

The Calibration with Weigh ts procedure is the most accurate and recommended method of calibrating the EMCO Load Weigher. This procedure allows the EMCO control unit to do the following:

• Learn the empty weight of the car and set this weight as the zero reference (the analog voltage output from the control unit will be about zero volts at this weight).
• Learn a known weight. You place a known weight in the car and enter the actual value of the weight, in kilograms, into the control unit. The load weigher will then learn this weight.
• You will also enter the value of the car’s overload weight into the control unit.
• The EMCO control unit will use this information to scale the analog output so that when the sensors detect the overload weight, the output voltage is about 10 volts. The analog output for the weights between empty car weight and overload weight will then be linear from about 0.0 volts to 10 volts.

Calibration procedure:

1. Before programming or calibrating the sensors and control unit:
   • Bring car to the lowest floor of its total travel.
   • Bounce in car to verify that it is free on guide rails.
2. Verify that the sensors are properly connected to the control unit.
3. Power up the control unit and verify that the input voltage is within the voltage range of the control unit.
4. Verify that the sensors are installed on the wire ropes per the previous instructions.
5. Learn the empty car weight (Zero the control unit):
   • Press the menu button until is displayed.
   • Press the button once. The display will flash.
   • While the display is flashing, press the menu button once. If the display stops flashing before you press the menu button, you must start over.
   • The control unit’s display begins to count down. Exit the cartop before the countdown finishes.
   • When the zero calibration is complete, will be displayed. If is not shown, the value has not been saved and this step must be repeated.
6. Learn the full load weight:
   • Press the menu button until is displayed, if it is not shown already.
   • Add the full load weight to the car.
   • Enter the value of the full load weight, in kilograms (1lb = .45359Kg). For example, if the full load weight is 2000lb, enter 0907 (2000 x .45359 = 907.18). Press the button to select a digit (blinks when selected) and press the button to set the value.
7. **Enter the overload weight** into the control unit:

- Press the **menu** button until **RL C** is displayed.
- Enter the value of the overload weight, in kilograms (1lb = .45359Kg). Press the ▲ button to select a digit (blinks when selected) and press the ▼ button to set the value.
- Press the **menu** button three times. (Note that when the menu button is pressed once, it displays “On” to allow you to set the AL C relay to normally open or normally closed. MCE does not use this relay, so just continue pressing the menu button two more times to save the value).

8. With the full load of weights in the car, using a digital multi meter, measure the voltage at terminals **o-10v** and **Com** on the control unit. It should be approximately 8 volts. Note the exact value.

9. Proceed to **Final Calibration with iControl** on page 5-57 and **Additional iControl Settings and Procedures** on page 5-58.

---

**Auto-zero Calibration**

The EMCO load weigher has an auto-zero calibration option which can be used if needed. Typically this option is recommended for 2 to 1 roping or where guide shoes, rather than guide rollers, are used.

**How auto-zero calibration works:**

- The control unit must see no power on the Hold terminals. Some installations use these terminals to indicate when the doors are closed, but with MCE controllers these terminals are not used.
- The CAde parameter must be set to 50.
- When the control unit senses no change in weight for two minutes, it automatically performs the CEro zero load calibration (learns the empty car weight).

**To enable auto-zero calibration:**

1. Press the **menu** button until **CAde** is displayed.
2. Enter the value 50. Press the ▲ button to select a digit (blinks when selected) and press the ▼ button to set the value.
3. Press the **menu** button twice to save the value.
Final Calibration with iControl

1. Connect the multi meter to test points TP_LW and GND on the ICE-CTP board inside the iLink Cartop Box. Adjust trimpot LW ADJ until the multi meter reads the same as the value noted in step 8.

Figure 6. ICE-CTP Cartop Processor Board

2. To view the voltage values from the load weigher using the iView Virtual Oscilloscope:
   - Using iView, connect to the controller
   - Display the Virtual Oscilloscope (View > Virtual Oscilloscope)
   - Select Load Weigher (Raw) for Test point 1
   - Observe the Load Weigher voltage values on the digital display.

3. To verify the linearity of the load weigher, place weights in the car that represent the following and observe the voltage values:
   - Empty car - about 0.0 volts
   - 25% of overload weight - about 2.5 volts
   - 50% of overload weight - about 5.0 volts
   - 75% of overload - about 7.5 volts
   - Full load weight - about 8 volts
   - Overload weight - about 10 volts
Additional iControl Settings and Procedures

Verify the following iControl settings and procedures:

1. On the iView Controller > Configuration > Load Weigher tab:
   - Set Load weighing device type to Analog signal.
   - Set Sensing type to Cross head deflection or rope tension sensing.

2. If the load weigher will be used to implement dispatching options, the parameters associated with these options must be set (see Load Weigher Adjustment for Dispatching in Section 4 of the iControl User Guide).

3. iControl needs to learn the empty and full load weights at every landing available to this car. This is a semi-automated process (see Learning Load Values in Section 4 of the iControl User Guide).
**Installation with 2 to 1 Roping**

When the EMCO load weigher is used with 2 to 1 roping, the components must be installed in locations that are different from a 1 to 1 roping application.

The load cells (sensors) must be installed just below the dead-end hitch, as shown.

It is recommended that the EMCO control unit be mounted in the controller cabinet.

The signal wires from the load cells must be routed through the overhead to the machine room. The sensor wires, which are only 6 feet in length, must be extended. It is recommended to use a terminal block to join the wires and to route the extended wires through a flexible or rigid conduit.

For an IMC or Performa installation, the output from the EMCO control unit can be connected directly the LW+ and LW- terminals on the SCR-RI (or SCR-RIX) board inside the controller cabinet.

For an iControl installation, the output signal from the EMCO control unit must be routed through the traveler to the to the LW+, LW- and SHLD terminals on the ICE-CTP board located inside the iLink Cartop box.

It is recommended to enable the Auto-zero Calibration option for a 2 to 1 roping installation. Please refer to “Auto-zero Calibration” on page 5-56.
Verifying the zero calibration (empty car weight)

It is recommended to verify the zero calibration if:

1. When working with new ropes, the calibration may change slightly as the ropes settle. After the first 30 days of operation it is recommended to check the empty car weight, with the car in the middle of the hoistway, using the display on the EMCO Load Weigher. If the empty car weight has changed (no longer zero), at a minimum the empty car weight should be re-learned (steps 1 through 5 of the calibration procedure).

2. If the car experiences violent motion, e.g. emergency stop or car / counterweight contacts the buffers, it is recommended to check the empty car weight, with the car in the middle of the hoistway, using the display on the EMCO Load Weigher. If the empty car weight has changed (no longer zero), at a minimum the empty car weight should be re-learned (steps 1 through 5 of the calibration procedure).

Troubleshooting

1. Check for Err codes on the display.
   - [Err 1] = Bad load cell connection or damaged load cell. Verify that the load cells are connected to the control unit per the wiring diagram. Inspect the cables for cuts or broken wires.
   - [Err 2] = Negative load cell flow. Verify that the load cell connections to the control unit are per the wiring diagram.
   - [Err 3] = Positive load cell flow. Load cells are too small for the application and must be replaced with proper units.
   - [Err 4] = Polarity error. Verify that the load cell connections to the control unit are per the wiring diagram. Reprogram the control.
   - [Err 5] = MB-D display short. Locate the short. Disconnect MB-D display, turn off the control and reconnect the MB-D display.

2. Verify that proper voltage is being supplied to the control unit.
3. Check all of the connections to the control unit.
4. Check the fuse. To check fuse: Disconnect power to the control unit. Open the control unit by removing the five (5) screws that hold the cover. Remove fuse from vertical free mounting (black) fuse holder next to controller transformer and replace with new fuse if necessary.

FOR FURTHER ASSISTANCE CONTACT:
MCE Technical Support
MCE Load Weigher

The MCE Load Weigher is designed for use with isolated platform elevator cars. The accuracy of the load weigher depends on the condition of the rubber isolation pads. If they are old, cracked or hard, the performance of the load weigher will suffer. Similarly, if the wrong pad material is used, the deflection (with load) can be incorrect. Please refer to “Verify Performance” on page 5-66 to verify the performance of the pads. There are three potential sensor installation methods:

- Method #1: New or replacement installation with target bracket near the middle bottom of the floor. Please refer to “Center of Gravity vs. Center of Floor” on page 5-62 (preferred method).
- Method #2: Replacement installations re-using the original load weigher location for target bracket. Please refer to “Installation Method # 2” on page 5-67.
- Method #3: Sensor on top of the car (predisposes sensor to damage and adjustment problems). Please refer to “Installation Method # 3 ” on page 5-67

Caution
Increasing the weight in the car must always increase clearance between the proximity sensor and the target for proper operation.

Figure 5.1  MCE Load Weigher


**Installation Method #1 — Preferred**
When installing, remember that the car is supported near the center of gravity. The center of gravity may be offset towards the front of the car to compensate for door operator weight unless the car has *both* front and rear doors. Install the target bracket as close to the center of the floor as possible.

**Figure 5.2 Center of Gravity vs. Center of Floor**

Center of the floor
Center of gravity, when empty

To measure the compression of the rubber pads and not the sagging of the floor – attach a structural piece such as a 1 ½" by 1 ½" angle to the outside edges of the floor.

**Figure 5.3 Sensing the Edges of the Floor (compensation for floor sag)**

Support assembly attaches at edge of floor to eliminate “sag interference”
Isolated elevator floor
3/8” air gap allows floor to sag without affecting target bracket

Support Assembly for target bracket
Rubber pads support isolated floor
Target bracket

Floor Plan (Top View)
Figure 5.4 Target Bracket and Sensor mounted on Support Assembly and Car frame

These screws hold the 2 small angles to the bottom of the floor - minimum 2 screws per angle. Screws must be short enough to avoid punching through the floor.

Support Assy
2 short pieces of angle and 1 long piece of angle

Target Bracket (2 pieces)

Adjustment bolts for setting 1/16” clearance between sensor and target bracket

Maintain a 1/4” space between target bracket and channels

Proximity sensor

Sensor bracket

Conduit to iLink

Front of car

Center of Floor

Center of Gravity

FLOOR

Note

The position sensed is where the support assembly for the target bracket is attached to the floor, NOT where the sensor is located.
If the distance between where the target bracket attaches to the floor and the center of the floor is greater than 20% of distance “A” (see Figure 8.2), an alternate mounting method may produce better results.

- **Example:** If distance “A” is 10’
  Then 20% of 10’ is 2’
  Therefore, if the target bracket attaches to floor more than 2’ from the center of the channel, an alternate method of mounting is suggested (see Figure 8.5).

**Figure 5.5  Alternate Mounting Location for Sensor and Target**

When mounting inside the channel is too great a percentage (+20%) of Distance ‘A’ try mounting sensor outside the channel.

**Figure 5.6  Typical Support Assembly for Target Bracket**

The dimension shown must be a minimum of 3/8” to provide clearance for floor to sag
Method #1 Installation Instructions
Installation consists of:

- Making a support assembly
- Mounting the target bracket on the support assembly
- Mounting the support assembly
- Mounting the proximity sensor
- Connecting the wiring
- Adjusting the amplifier (iLink car top box)
- Verifying performance
- Adjusting iControl parameters
- Maintenance recommendations

The Support Assembly
1. Cut a piece of 1 ¼" x 1 ¼" or 1 ½" x 1 ½" steel angle to span the width of the floor as shown in Figures 8.3 and 8.6.
2. Cut two more 2" lengths of angle to attach the long piece as close as possible to the outer edge of the floor. When attaching the angles together, provide 3/8" clearance to allow for floor sagging (see Figure 8.6).

Mount the Target Bracket
1. Bolt the two-piece target bracket in the middle of the support assembly so that the slots allow the target to be adjusted (see Figure 8.6).

Mount the Support Assembly
1. The support assembly attaches to the bottom of the floor of the isolated platform as close to the outside edge as possible, preferably attaching between the two channels comprising part of the safety plank (see Figure 8.4). Hold the support assembly for the proper 1/4" spacing between the target bracket and the channel shown in Figure 8.4 where the sensor will be mounted and mark the holes to drill to attach the support assembly to the floor. Be sure to leave room for the sensor and mounting bracket.
2. Drill the holes and mount the support assembly.
3. Verify the target bracket to channel space is still 1/4" (1/8" to 3/4" after mounting).

Mount the Proximity Sensor
1. Mount the proximity sensor and bracket on the channel closest to the front of the car. Center the sensor over the target with about 1/16" (or less) space between the target and sensor (see Figure 8.4).

Connect the Wiring
1. Connect proximity sensor wires to iLink CTP board terminals.
   • For Square D/Telemechanique Sensor Part # XSP-Ho8362 the color coding is:
     Brown sensor wire to +26V terminal
     Black sensor wire to LW+ terminal
     Blue sensor wire to LW- terminal
Adjust the Amplifier

1. Before adjusting the sensor amplifier the following conditions must first be met:
   • Power to the controller
   • The car is on Inspection operation
   • The brake is already adjusted to hold 125% of full load
   • The elevator is positioned level with the floor and with doors open so test weights may be added and removed

2. With the car empty, adjust the clearance between sensor and target so that 0.3 to 1.0VDC is present between test points LW+ to LW- on the iLink CTP board. This is a sensitive apparatus, so hold the target while loosening the adjustment bolts of the target, make the adjustment, and tighten the bolts. (Increasing the distance between the target and the sensor increases the voltage; decreasing distance decreases the voltage.)

3. Remove all personnel from the pit (in case the car moves when fully loaded) and put 100% of load in the car.

4. Set the LW ADJ trimpot on the CTP (cartop) board fully clockwise and check that there is LESS THAN 14VDC between test points TP LW and GND.

5. Adjust the LW ADJ trimpot so that there is no more than 8VDC and no less than 4VDC between TP LW and GND (8VDC recommended).

Verify Performance

1. Check the voltages measured between test points LW+ and LW- with the following loads. This information is used to verify rubber pad resilience for the isolation platform. Document the data below.

Table 5.7 Verify MCE Load Weigher Performance

<table>
<thead>
<tr>
<th>Load in pounds</th>
<th>Volts across LW+ to LW-</th>
<th>Voltage increase</th>
</tr>
</thead>
<tbody>
<tr>
<td>No load</td>
<td>(1)</td>
<td></td>
</tr>
<tr>
<td>1/4 of full load</td>
<td>(2)</td>
<td>(2)-(1)</td>
</tr>
<tr>
<td>½ of full load</td>
<td>(3)</td>
<td>(3)-(2)</td>
</tr>
<tr>
<td>¾ of full load</td>
<td>(4)</td>
<td>(4)-(3)</td>
</tr>
<tr>
<td>Full load</td>
<td>(5)</td>
<td>(5)-(4)</td>
</tr>
</tbody>
</table>

The variation between voltage increase entries should be linear. If voltage increase is more than 25% different from the entry just above it, check the following:
   • Condition of rubber pads
   • Voltage variance when weight is in center of car vs. on edge of car (sagging problem)

Adjust iControl Parameters

The load weigher is now installed and properly adjusted. However, the parameter adjustments for the load weigher must be completed. Please refer to “Load Weigher Configuration” on page 4-31.

Recommended Maintenance

Once a month, check the voltage between LW+ and LW-. It should be within 0.3V and 1.0VDC when the car is empty. If the voltage is outside the 0.3 to 1.0VDC range, adjust the target bracket.
Additionally, periodic checks of the voltage increase with varying load conditions will help diagnose when the rubber pads begin to lose elasticity.

**Installation Method # 2**

1. Re-use pre-existing holes or brackets to mount sensor and target.
2. When using supports created for other load weighers, be sure to arrange sensor and target so that increasing the weight in the car increases the clearance between the proximity sensor and the target.
3. Always use the target bracket for the target as it will flex slightly and not damage the sensor during any rebound while doing a buffer test, etc.
4. If the voltage between LW+ and LW- varies depending on where the weight is in the car, use Installation Method #1 instead.

**Installation Method # 3**

- Mount the sensor on the top of the car. This has the advantage of being the most convenient location, both for installation and for later adjustment. However, there are disadvantages to this approach as well.
  - The first is that the sensor and target bracket are usually more exposed to accidental physical damage (critical because the system depends on precise clearances between the sensor and target).
  - Second, since the inclination of most installers would be to mount the target directly to the top of the cab, the extra weight of an elevator adjuster on the cartop often creates problems during adjustment or if they happen to be riding there temporarily during normal operation, especially since the top of the cab is not as structurally rigid as the floor.

**Note**

If locating the load weigher on the car top is necessary, better results can be obtained by making up a target bracket assembly similar to Figure 8.6 and attaching it to the edges of the elevator cab, making it less sensitive to cab top flexing. Then, mount the sensor so it is supported by the crosshead. This can give a very good result, but requires additional expertise on the part of the installer.

**Caution**

When mounting the sensor on top of the car, be sure to arrange the sensor and target bracket so that increasing the weight in the car increases the clearance between the proximity sensor and the target.
About Troubleshooting

This section contains general troubleshooting related information and tabled information to help you diagnose and correct iControl problems. If you are viewing this on a computer, click the page number to jump to the appropriate section.

<table>
<thead>
<tr>
<th>Troubleshooting Topics</th>
<th>Description</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Troubleshooting Tools</td>
<td>Lists the troubleshooting tools available.</td>
<td>page 6-2</td>
</tr>
<tr>
<td>Safety String Bypass Jumper</td>
<td>Temporarily bypasses an open safety string.</td>
<td>page 6-3</td>
</tr>
<tr>
<td>iControl Messages</td>
<td>Fault and status messages table - includes a description, car reaction and troubleshooting tips for each message.</td>
<td>page 6-13</td>
</tr>
<tr>
<td>Replacing Circuit Boards and Assemblies</td>
<td>Instructions for removing and replacing circuit boards or the iBox.</td>
<td>page 6-72</td>
</tr>
<tr>
<td>Circuit Board Quick References</td>
<td>Descriptions of circuit board connections, indicators, jumpers and test points.</td>
<td>page 6-75</td>
</tr>
<tr>
<td>COP Board Diagnostics</td>
<td>Use to diagnose problems with Serial COP boards.</td>
<td>page 6-77</td>
</tr>
<tr>
<td>iLink Cartop Diagnostics</td>
<td>Use to diagnose problems with iLink.</td>
<td>page 6-80</td>
</tr>
</tbody>
</table>
Troubleshooting Tools

The iBox provides status and trouble shooting information:

- The status line of the iBox display scrolls messages about system operation. Please refer to “LCD Display and Keypad” on page 7-3.

- The iBox Event Log captures a FIFO file of the last 50 system events by event number and name, and provides additional data for each event captured. Press softkey (1) beneath the Car label, scroll down to View Event Log and press Enter. To view event details, scroll to the desired event and press Enter. Scroll down to see all of the data, including the event name. A description and troubleshooting suggestions for each event can be found in iView online Help (Help > iView Help > Messages Reference) and in the iControl Messages table in this user guide. Please refer to “iControl Messages” on page 6-13.

iView provides an extensive toolset to help you diagnose problems, including:

- Hoistway: The Hoistway window (Controller > View > Hoistway) shows the current position of the car in the hoistway, the calls registered, the car speed and the current operating mode. Please refer to “Hoistway window” on page 9-4.

- Operational Status tab: The Operational Status tab shows the current speed, position, pattern, and motion of the car. Also, the status of the Safety and Cartop processors, safety circuits, leveling sensors and door locks is shown. The Faults and Car status text boxes show general and car operation faults and car status so that you can monitor them easily while viewing hoistway information and running the car. A description and troubleshooting suggestions for each fault or status message can be found in iView online Help (Help > iView Help > Messages Reference) and in the iControl Messages table in this user guide. Please refer to “iControl Messages” on page 6-13.

- Event Log: The Event Log tab (View > Diagnostics > Event Log) monitors and records system events. You can easily save event log information to a file on your iView PC for archival and future reference. A description and troubleshooting suggestions for each event can be found in iView online Help (Help > iView Help > Messages Reference) and in the iControl Messages table in this user guide. Please refer to “iControl Messages” on page 6-13.

- Fault Bypass: The Fault Bypass tab (View > Diagnostics > Fault Bypass) allows you to bypass over 50 system faults. The Fault Bypass switch on the iBox must be ON and each fault bypass times out after fifteen minutes to prevent the possibility of unintended, long term bypassing of a critical faults. To bypass faults, the car must be on Machine Room Inspection or Test Operation. Please refer to “Diagnostics - Fault Bypass” on page 9-18.

- Diagnostic Flags: The Diagnostic Flags tab (View > Diagnostics > Diagnostic Flags) allows you to view system diagnostic flags and car statuses in four classifications (Operation, Motion, Safety, Drive). Please refer to “Diagnostics - Diagnostic Flags” on page 9-12.

- Terminal Switches Status: The Terminal Switches Status tab (View > Diagnostics > Terminal Switches Status) shows information about the speed and position of the car when each Normal and Emergency Terminal Switch opened. Please refer to “Diagnostics - Terminal Switches Status” on page 9-20.

- Diagnostic Outputs: Diagnostic Outputs (View > Diagnostics > Diagnostic Outputs window) allows you to choose and simultaneously monitor up to 16 system outputs on screen. Please refer to “Diagnostics - Diagnostic Outputs” on page 9-14.

- Virtual Oscilloscope: The oscilloscope (View > Diagnostics > Virtual Oscilloscope) allows you to select and view two system outputs simultaneously on a “virtual oscilloscope.” Please refer to “Diagnostics - Virtual Oscilloscope” on page 9-22.
Safety String Bypass Jumper

If any switch or relay in the safety string opens, the car immediately loses power and stops. In some situations, you may need to temporarily bypass an open safety string to move the car so that the safety string can once again be “made up.” For example, if the car has tripped a final limit, you will need to bypass the safety string and move the car up (or down) the hoistway past the limit switch so that the safety string can again be completed. Once the safety string is complete again, you must immediately remove the bypass jumper.

The safety string bypass location for iControl is accessed through ports on the front cover of the iBox. The ports are sized so that a jumper wire (16AWG minimum) with insulated clips on each end can be used to short the SB and 3 terminals to bypass the safety string.

Danger

You are jumpering 110VDC. Place the jumper with caution, being certain that you are insulated from the possibility of electrical shock.

The safety bypass circuitry is intelligent. The jumper will have no effect if it is put in place with the safety string intact (other than to generate a time out after 15 minutes pass). The jumper will bypass the string and allow the car to be moved only if it is placed after the safety string has opened. **If the jumper is in place when the string opens, you must remove the jumper, then replace it before it will bypass the string.**

The jumper is monitored by a timer. If the jumper is in place for longer than 15 minutes, the timer will expire, drop the brake and motor contactors and generate a Safety Bypass Jumper Time Out. To clear the fault and restart the car, you must remove the bypass jumper. If more time is needed, re-install the jumper and the fifteen-minute timer will restart.

The table below specifies what is and is not bypassed by the jumper.

**Table 6.1  Safety String Bypass Jumper**

<table>
<thead>
<tr>
<th>Bypasses</th>
<th>Does not bypass</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cartop exit input</td>
<td>Rope Gripper OK from Rope Gripper board</td>
</tr>
<tr>
<td>Emergency Stop switch on car</td>
<td>Unintended motion fault already tripped</td>
</tr>
<tr>
<td>Governor switch input</td>
<td>Rope brake fault already tripped</td>
</tr>
<tr>
<td>Hoistway safety string</td>
<td>Machine Room Emergency Stop switch</td>
</tr>
<tr>
<td>Car safety string</td>
<td>Any Safety Processor A or B fault</td>
</tr>
</tbody>
</table>
Message Tables

Almost all troubleshooting begins with examining system messages. System outputs are displayed alternating with other messages on the iBox LCD. Status, Fault, and Event messages are displayed by iView. (iBox maintains an Event Log as well.) This section contains two tables. Table 6.2 provides a cross-reference from iBox ID numbers to the associated iControl message name. Table 6.3 lists system messages in alphabetical order and describes the cause and recommended troubleshooting procedures if appropriate.

Table 6.2 Cross Reference: iBox Event Log ID Numbers to iControl Messages

<table>
<thead>
<tr>
<th>ID #</th>
<th>iControl Message (iBox Event Log and iView Controller Event Log)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Drive On Fault (was Drive Ready On Fault)</td>
</tr>
<tr>
<td>2</td>
<td>Brake Enable Fault</td>
</tr>
<tr>
<td>4</td>
<td>Insufficient Brake Feedback Fault</td>
</tr>
<tr>
<td>5</td>
<td>Brake Voltage Not On Fault</td>
</tr>
<tr>
<td>6</td>
<td>Excessive Brake Feedback Fault</td>
</tr>
<tr>
<td>7</td>
<td>Brake Pick Fault</td>
</tr>
<tr>
<td>8</td>
<td>Brake Module Over Temperature Fault</td>
</tr>
<tr>
<td>9</td>
<td>Heat Sensor Fault 2</td>
</tr>
<tr>
<td>10</td>
<td>Heat Sensor Fault 3</td>
</tr>
<tr>
<td>11</td>
<td>Heat Sensor Fault 4</td>
</tr>
<tr>
<td>12</td>
<td>Power Supply Fault 1</td>
</tr>
<tr>
<td>13</td>
<td>Power Supply Fault 2</td>
</tr>
<tr>
<td>14</td>
<td>Power Supply Fault 3</td>
</tr>
<tr>
<td>15</td>
<td>Power Supply Fault 4</td>
</tr>
<tr>
<td>16</td>
<td>Drive At-Speed Fault</td>
</tr>
<tr>
<td>17</td>
<td>Drive Fault</td>
</tr>
<tr>
<td>18</td>
<td>Drive Ready Fault</td>
</tr>
<tr>
<td>19</td>
<td>Front Door Close Time-out</td>
</tr>
<tr>
<td>20</td>
<td>Front Door Close Fault</td>
</tr>
<tr>
<td>21</td>
<td>Front Door Open Time-out</td>
</tr>
<tr>
<td>22</td>
<td>Front Door Open Fault</td>
</tr>
<tr>
<td>23</td>
<td>Rear Door Close Time-out</td>
</tr>
<tr>
<td>24</td>
<td>Rear Door Close Fault</td>
</tr>
<tr>
<td>25</td>
<td>Rear Door Open Time-out</td>
</tr>
<tr>
<td>26</td>
<td>Rear Door Open Fault</td>
</tr>
<tr>
<td>27</td>
<td>Earthquake Operation (Seismic Switch)</td>
</tr>
<tr>
<td>28</td>
<td>Earthquake Operation (Counterweight)</td>
</tr>
<tr>
<td>29</td>
<td>Earthquake Run</td>
</tr>
<tr>
<td>30</td>
<td>Earthquake Operation Activated</td>
</tr>
<tr>
<td>31</td>
<td>Earthquake Operation Deactivated</td>
</tr>
<tr>
<td>32</td>
<td>Earthquake Emergency Stop</td>
</tr>
<tr>
<td>33</td>
<td>Fire Service Recall Main</td>
</tr>
<tr>
<td>34</td>
<td>Fire Service Recall Alternate</td>
</tr>
<tr>
<td>35</td>
<td>Fire Service In-car Activated</td>
</tr>
<tr>
<td>36</td>
<td>Elevator Recall Operation (Switch 1)</td>
</tr>
<tr>
<td>37</td>
<td>Elevator Recall Operation (Switch 2)</td>
</tr>
<tr>
<td>38</td>
<td>Elevator Recall Operation (Switch 3)</td>
</tr>
<tr>
<td>39</td>
<td>Elevator Recall Operation (Switch 4)</td>
</tr>
<tr>
<td>40</td>
<td>Elevator Recall Operation (Switch 5)</td>
</tr>
<tr>
<td>41</td>
<td>Elevator Recall Operation (Switch 6)</td>
</tr>
<tr>
<td>42</td>
<td>Emergency Power Recall</td>
</tr>
<tr>
<td>43</td>
<td>Emergency Power Shutdown</td>
</tr>
<tr>
<td>ID #</td>
<td>iControl Message (iBox Event Log and iView Controller Event Log)</td>
</tr>
<tr>
<td>------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>44</td>
<td>Emergency Power Run</td>
</tr>
<tr>
<td>45</td>
<td>Front Door Contact Fault</td>
</tr>
<tr>
<td>46</td>
<td>Rear Door Contact Fault</td>
</tr>
<tr>
<td>47</td>
<td>Front Photo Eye Failure</td>
</tr>
<tr>
<td>48</td>
<td>Front Safe Edge Failure</td>
</tr>
<tr>
<td>49</td>
<td>Rear Photo Eye Failure</td>
</tr>
<tr>
<td>50</td>
<td>Rear Safe Edge Failure</td>
</tr>
<tr>
<td>51</td>
<td>Cartop Inspection Operation</td>
</tr>
<tr>
<td>53</td>
<td>Hoistway Access Operation</td>
</tr>
<tr>
<td>54</td>
<td>Machine Room Inspection Operation</td>
</tr>
<tr>
<td>55</td>
<td>Test Mode</td>
</tr>
<tr>
<td>56</td>
<td>Capture Mode</td>
</tr>
<tr>
<td>57</td>
<td>Independent Service</td>
</tr>
<tr>
<td>60</td>
<td>Attendant Service</td>
</tr>
<tr>
<td>61</td>
<td>Passenger Operation</td>
</tr>
<tr>
<td>62</td>
<td>Up Normal Terminal Switch 1 Position Fault</td>
</tr>
<tr>
<td>63</td>
<td>Up Normal Terminal Switch 2 Position Fault</td>
</tr>
<tr>
<td>64</td>
<td>Up Normal Terminal Switch 3 Position Fault</td>
</tr>
<tr>
<td>65</td>
<td>Up Normal Terminal Switch 4 Position Fault</td>
</tr>
<tr>
<td>66</td>
<td>Up Normal Terminal Switch 5 Position Fault</td>
</tr>
<tr>
<td>67</td>
<td>Up Emergency Terminal Switch Position Fault</td>
</tr>
<tr>
<td>68</td>
<td>Down Normal Terminal Switch 1 Position Fault</td>
</tr>
<tr>
<td>69</td>
<td>Down Normal Terminal Switch 2 Position Fault</td>
</tr>
<tr>
<td>70</td>
<td>Down Normal Terminal Switch 3 Position Fault</td>
</tr>
<tr>
<td>71</td>
<td>Down Normal Terminal Switch 4 Position Fault</td>
</tr>
<tr>
<td>72</td>
<td>Down Normal Terminal Switch 5 Position Fault</td>
</tr>
<tr>
<td>73</td>
<td>Down Emergency Terminal Switch Position Fault</td>
</tr>
<tr>
<td>74</td>
<td>Position Quadrature Fault</td>
</tr>
<tr>
<td>75</td>
<td>Position Speed Threshold Fault</td>
</tr>
<tr>
<td>76</td>
<td>Position Speed Deviation Fault</td>
</tr>
<tr>
<td>77</td>
<td>Motion Start Fault</td>
</tr>
<tr>
<td>78</td>
<td>User code accessing an invalid logical indicator (internal event)</td>
</tr>
<tr>
<td>79</td>
<td>Car shut down due to emergency power operation with no supervisor (Activated)</td>
</tr>
<tr>
<td>80</td>
<td>Car shut down due to emergency power operation with no supervisor (Deactivated)</td>
</tr>
<tr>
<td>81</td>
<td>Car delayed with doors open</td>
</tr>
<tr>
<td>82</td>
<td>Car delayed with doors closed</td>
</tr>
<tr>
<td>83</td>
<td>Car out of service with doors open</td>
</tr>
<tr>
<td>84</td>
<td>Car out of service with doors closed</td>
</tr>
<tr>
<td>85</td>
<td>Earthquake board power supply ON</td>
</tr>
<tr>
<td>86</td>
<td>Earthquake board power supply OFF</td>
</tr>
<tr>
<td>87</td>
<td>Earthquake reset button stuck ON</td>
</tr>
<tr>
<td>88</td>
<td>Earthquake reset button OK</td>
</tr>
<tr>
<td>89</td>
<td>Fire Service In-car Hold Operation</td>
</tr>
<tr>
<td>90</td>
<td>Fire Service In-car Recall Operation</td>
</tr>
<tr>
<td>91</td>
<td>Load learn process activated</td>
</tr>
<tr>
<td>92</td>
<td>Load learn process deactivated</td>
</tr>
<tr>
<td>93</td>
<td>Car Heavy Load Activated - Hall Calls Bypassed</td>
</tr>
<tr>
<td>94</td>
<td>Car Over Load Activated</td>
</tr>
<tr>
<td>95</td>
<td>Fire Service Recall Deactivated</td>
</tr>
<tr>
<td>96</td>
<td>Fire Service In-car Deactivated</td>
</tr>
<tr>
<td>97</td>
<td>Emergency Power Activated</td>
</tr>
<tr>
<td>ID #</td>
<td>iControl Message (iBox Event Log and iView Controller Event Log)</td>
</tr>
<tr>
<td>------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>98</td>
<td>Emergency Power Deactivated</td>
</tr>
<tr>
<td>100</td>
<td>Car Dispatch Load</td>
</tr>
<tr>
<td>102</td>
<td>Car Heavy Load - Deactivated</td>
</tr>
<tr>
<td>104</td>
<td>Car Over Load Deactivated</td>
</tr>
<tr>
<td>105</td>
<td>Photo Eye Antinuisance</td>
</tr>
<tr>
<td>106</td>
<td>Light Load Antinuisance</td>
</tr>
<tr>
<td>107</td>
<td>Nudging Operation</td>
</tr>
<tr>
<td>108</td>
<td>Front Photo Eye Bypassed</td>
</tr>
<tr>
<td>109</td>
<td>Rear Photo Eye Bypassed</td>
</tr>
<tr>
<td>110</td>
<td>Front Safe Edge Bypassed</td>
</tr>
<tr>
<td>111</td>
<td>Rear Safe Edge Bypassed</td>
</tr>
<tr>
<td>118</td>
<td>Inspection Overspeed Fault</td>
</tr>
<tr>
<td>119</td>
<td>Tach Error Fault</td>
</tr>
<tr>
<td>120</td>
<td>Drive Enable Feedback Fault</td>
</tr>
<tr>
<td>121</td>
<td>Safety A Inspection Overspeed Fault</td>
</tr>
<tr>
<td>122</td>
<td>IO Map Compare Fault</td>
</tr>
<tr>
<td>123</td>
<td>IO Map Toggle Compare Fault</td>
</tr>
<tr>
<td>124</td>
<td>Fault Bypass Switch Timed Out</td>
</tr>
<tr>
<td>125</td>
<td>Safety Bypass Jumper Timed Out</td>
</tr>
<tr>
<td>126</td>
<td>Learn Switch Timed Out Fault</td>
</tr>
<tr>
<td>127</td>
<td>Safety A SIB Device Fault</td>
</tr>
<tr>
<td>128</td>
<td>Safety B SIB Device Fault</td>
</tr>
<tr>
<td>129</td>
<td>QPRAM Device Error</td>
</tr>
<tr>
<td>130</td>
<td>EEPROM Device Error</td>
</tr>
<tr>
<td>131</td>
<td>Front Door Open Button Bypassed</td>
</tr>
<tr>
<td>132</td>
<td>Rear Door Open Button Bypassed</td>
</tr>
<tr>
<td>135</td>
<td>Door Lock Clipped Greater than 200fpm</td>
</tr>
<tr>
<td>136</td>
<td>Safety String Open</td>
</tr>
<tr>
<td>137</td>
<td>Motion stopped due to IO toggle test</td>
</tr>
<tr>
<td>138</td>
<td>Safety Configuration Mismatch</td>
</tr>
<tr>
<td>139</td>
<td>Safety Configuration Learn Fault</td>
</tr>
<tr>
<td>140</td>
<td>IO Map Compare Alert</td>
</tr>
<tr>
<td>141</td>
<td>Safety A Contract Overspeed Fault</td>
</tr>
<tr>
<td>142</td>
<td>Safety A Inspection Leveling Overspeed Fault</td>
</tr>
<tr>
<td>143</td>
<td>Safety Inventory Checksum Fault</td>
</tr>
<tr>
<td>144</td>
<td>Safety Configuration Checksum Fault</td>
</tr>
<tr>
<td>145</td>
<td>Limit Switches Checksum Fault</td>
</tr>
<tr>
<td>146</td>
<td>Safety Configuration Inventory Cross Check Fault</td>
</tr>
<tr>
<td>147</td>
<td>Safety Inventory Learn Fault</td>
</tr>
<tr>
<td>148</td>
<td>Limit Switches Learn Fault</td>
</tr>
<tr>
<td>149</td>
<td>Dual Channel QUAD Fault</td>
</tr>
<tr>
<td>150</td>
<td>Single Channel QUAD Fault</td>
</tr>
<tr>
<td>151</td>
<td>Loss of Position or Speed Indicators</td>
</tr>
<tr>
<td>152</td>
<td>Safety Inventory Comparison Fault</td>
</tr>
<tr>
<td>153</td>
<td>Safety Inventory Creation Fault</td>
</tr>
<tr>
<td>154</td>
<td>Position Quadrature Reversed Fault</td>
</tr>
<tr>
<td>155</td>
<td>Down Normal Terminal Switch 1 Level 1 Speed Fault</td>
</tr>
<tr>
<td>156</td>
<td>Down Normal Terminal Switch 2 Level 1 Speed Fault</td>
</tr>
<tr>
<td>157</td>
<td>Down Normal Terminal Switch 3 Level 1 Speed Fault</td>
</tr>
<tr>
<td>158</td>
<td>Down Normal Terminal Switch 4 Level 1 Speed Fault</td>
</tr>
<tr>
<td>159</td>
<td>Down Normal Terminal Switch 5 Level 1 Speed Fault</td>
</tr>
<tr>
<td>160</td>
<td>Down Normal Terminal Switch 1 Level 2 Speed Fault</td>
</tr>
<tr>
<td>ID #</td>
<td>iControl Message (iBox Event Log and iView Controller Event Log)</td>
</tr>
<tr>
<td>-----</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>161</td>
<td>Down Normal Terminal Switch 2 Level 2 Speed Fault</td>
</tr>
<tr>
<td>162</td>
<td>Down Normal Terminal Switch 3 Level 2 Speed Fault</td>
</tr>
<tr>
<td>163</td>
<td>Down Normal Terminal Switch 4 Level 2 Speed Fault</td>
</tr>
<tr>
<td>164</td>
<td>Down Normal Terminal Switch 5 Level 2 Speed Fault</td>
</tr>
<tr>
<td>165</td>
<td>Up Normal Terminal Switch 1 Level 1 Speed Fault</td>
</tr>
<tr>
<td>166</td>
<td>Up Normal Terminal Switch 2 Level 1 Speed Fault</td>
</tr>
<tr>
<td>167</td>
<td>Up Normal Terminal Switch 3 Level 1 Speed Fault</td>
</tr>
<tr>
<td>168</td>
<td>Up Normal Terminal Switch 4 Level 1 Speed Fault</td>
</tr>
<tr>
<td>169</td>
<td>Up Normal Terminal Switch 5 Level 1 Speed Fault</td>
</tr>
<tr>
<td>170</td>
<td>Up Normal Terminal Switch 2 Level 2 Speed Fault</td>
</tr>
<tr>
<td>171</td>
<td>Up Normal Terminal Switch 3 Level 2 Speed Fault</td>
</tr>
<tr>
<td>172</td>
<td>Up Normal Terminal Switch 4 Level 2 Speed Fault</td>
</tr>
<tr>
<td>173</td>
<td>Up Normal Terminal Switch 5 Level 2 Speed Fault</td>
</tr>
<tr>
<td>174</td>
<td>Safety A DETS Level 2 Speed Fault</td>
</tr>
<tr>
<td>175</td>
<td>Safety A UETS Level 2 Speed Fault</td>
</tr>
<tr>
<td>176</td>
<td>Excessive Faults Shutdown</td>
</tr>
<tr>
<td>177</td>
<td>Safety A Unintended Motion Fault</td>
</tr>
<tr>
<td>178</td>
<td>Ascending Car Overspeed Fault</td>
</tr>
<tr>
<td>179</td>
<td>Position Synchronization Required at Terminal</td>
</tr>
<tr>
<td>180</td>
<td>Position Synchronized at Terminal</td>
</tr>
<tr>
<td>181</td>
<td>Position Synchronization Required at Floor</td>
</tr>
<tr>
<td>182</td>
<td>Position Synchronized at Floor</td>
</tr>
<tr>
<td>183</td>
<td>Cartop Communication Fault</td>
</tr>
<tr>
<td>184</td>
<td>Cartop Inspection Unintended Motion Fault</td>
</tr>
<tr>
<td>185</td>
<td>Cartop Automatic Unintended Motion Fault</td>
</tr>
<tr>
<td>186</td>
<td>Motor Limit Timed Out</td>
</tr>
<tr>
<td>187</td>
<td>Safety B Fault Bypass Switch Timed Out</td>
</tr>
<tr>
<td>188</td>
<td>Safety B Safety Bypass Jumper Timed Out</td>
</tr>
<tr>
<td>189</td>
<td>IO Map Compare Long Term Alert</td>
</tr>
<tr>
<td>190</td>
<td>IO Map Compare Long Term Fault</td>
</tr>
<tr>
<td>191</td>
<td>Position Location Error Fault</td>
</tr>
<tr>
<td>192</td>
<td>Position Cartop Offset Fault</td>
</tr>
<tr>
<td>193</td>
<td>Motor Contactor Driver Proofing Fault</td>
</tr>
<tr>
<td>194</td>
<td>Motor Contactor Proofing Fault</td>
</tr>
<tr>
<td>195</td>
<td>Brake Contactor Driver Proofing Fault</td>
</tr>
<tr>
<td>196</td>
<td>Brake Contactor Proofing Fault</td>
</tr>
<tr>
<td>197</td>
<td>Safety B UETS Level 2 Speed Fault</td>
</tr>
<tr>
<td>198</td>
<td>Safety B DETS Level 2 Speed Fault</td>
</tr>
<tr>
<td>199</td>
<td>Safety B Inspection Overspeed Fault</td>
</tr>
<tr>
<td>200</td>
<td>Safety B Inspection Leveling Overspeed Fault</td>
</tr>
<tr>
<td>201</td>
<td>Safety B Contract Overspeed Fault</td>
</tr>
<tr>
<td>202</td>
<td>Excessive Relevels Fault</td>
</tr>
<tr>
<td>203</td>
<td>Excessive Restarts Fault</td>
</tr>
<tr>
<td>204</td>
<td>Cartop Emergency Stop</td>
</tr>
<tr>
<td>205</td>
<td>Cartop Power Loss</td>
</tr>
<tr>
<td>206</td>
<td>Up Direction Limit Open</td>
</tr>
<tr>
<td>207</td>
<td>Down Direction Limit Open</td>
</tr>
<tr>
<td>208</td>
<td>Floor Location Fault</td>
</tr>
<tr>
<td>209</td>
<td>Floor Sensor Fault</td>
</tr>
<tr>
<td>210</td>
<td>Power Transfer Input Activated</td>
</tr>
<tr>
<td>211</td>
<td>Power Transfer Input Deactivated</td>
</tr>
<tr>
<td>212</td>
<td></td>
</tr>
<tr>
<td>ID #</td>
<td>iControl Message (iBox Event Log and iView Controller Event Log)</td>
</tr>
<tr>
<td>------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>213</td>
<td>Invalid Front Door Position</td>
</tr>
<tr>
<td>214</td>
<td>Invalid Rear Door Position</td>
</tr>
<tr>
<td>215</td>
<td>Earthquake Reduce Speed</td>
</tr>
<tr>
<td>216</td>
<td>Cartop Inspection Operation</td>
</tr>
<tr>
<td>217</td>
<td>Car Panel Inspection Operation</td>
</tr>
<tr>
<td>218</td>
<td>Hoistway Access Inspection Operation</td>
</tr>
<tr>
<td>219</td>
<td>Machine Room Inspection Operation</td>
</tr>
<tr>
<td>220</td>
<td>Inspection Operation</td>
</tr>
<tr>
<td>221</td>
<td>Construction Cartop Inspection Operation</td>
</tr>
<tr>
<td>222</td>
<td>Construction Car Panel Inspection Operation</td>
</tr>
<tr>
<td>223</td>
<td>Construction Hoistway Access Inspection Operation</td>
</tr>
<tr>
<td>224</td>
<td>Construction Machine Room Inspection Operation</td>
</tr>
<tr>
<td>225</td>
<td>Construction Inspection Operation</td>
</tr>
<tr>
<td>226</td>
<td>Door Lock Clipped Less than 200fpm</td>
</tr>
<tr>
<td>227</td>
<td>Invalid Input</td>
</tr>
<tr>
<td>228</td>
<td>Emergency Medical Service Recall Activated (Switch 1)</td>
</tr>
<tr>
<td>229</td>
<td>Emergency Medical Service In-Car Activated (Switch 1)</td>
</tr>
<tr>
<td>230</td>
<td>Emergency Medical Service Deactivated</td>
</tr>
<tr>
<td>231</td>
<td>Emergency Medical Service Bypassed</td>
</tr>
<tr>
<td>232</td>
<td>SCR Power Supply Fault</td>
</tr>
<tr>
<td>233</td>
<td>SCR AC Phase Fault</td>
</tr>
<tr>
<td>234</td>
<td>SCR Contactor Fuse Fault</td>
</tr>
<tr>
<td>235</td>
<td>SCR Phase Lock Loop Fault</td>
</tr>
<tr>
<td>236</td>
<td>SCR Phase Lock Loop Warning</td>
</tr>
<tr>
<td>237</td>
<td>SCR Dynamic Brake Fault</td>
</tr>
<tr>
<td>238</td>
<td>SCR Instantaneous Over Current</td>
</tr>
<tr>
<td>239</td>
<td>SCR Armature Voltage On</td>
</tr>
<tr>
<td>240</td>
<td>SCR High Temperature Fault</td>
</tr>
<tr>
<td>241</td>
<td>SCR Loop Over Current</td>
</tr>
<tr>
<td>243</td>
<td>SCR Insufficient Armature Current</td>
</tr>
<tr>
<td>244</td>
<td>SCR Excessive Armature Current</td>
</tr>
<tr>
<td>245</td>
<td>SCR Excessive Current Command, Drive Enabled</td>
</tr>
<tr>
<td>246</td>
<td>SCR Excessive Current Command, Drive Disabled</td>
</tr>
<tr>
<td>247</td>
<td>Insufficient Motor Field Forcing Feedback Fault</td>
</tr>
<tr>
<td>248</td>
<td>Insufficient Motor Field Feedback Fault</td>
</tr>
<tr>
<td>249</td>
<td>Swing Operation Activated</td>
</tr>
<tr>
<td>250</td>
<td>Swing Operation Deactivated</td>
</tr>
<tr>
<td>251</td>
<td>Field Module Over Temperature Fault</td>
</tr>
<tr>
<td>252</td>
<td>Speed Limit, MF Forcing</td>
</tr>
<tr>
<td>253</td>
<td>Tach Failure</td>
</tr>
<tr>
<td>254</td>
<td>Sabbath Operation Activated</td>
</tr>
<tr>
<td>255</td>
<td>Sabbath Operation Deactivated</td>
</tr>
<tr>
<td>256</td>
<td>Emergency Brake Tripped</td>
</tr>
<tr>
<td>257</td>
<td>Landing System Sensor Fault</td>
</tr>
<tr>
<td>258</td>
<td>Emergency Brake Leg 1 Short Fault</td>
</tr>
<tr>
<td>259</td>
<td>Emergency Brake Leg 2 Short Fault</td>
</tr>
<tr>
<td>260</td>
<td>Alternate Speed Profile 1 Activated</td>
</tr>
<tr>
<td>261</td>
<td>Alternate Speed Profile 1 Deactivated</td>
</tr>
<tr>
<td>262</td>
<td>Alternate Speed Profile 2 Activated</td>
</tr>
<tr>
<td>263</td>
<td>Alternate Speed Profile 2 Deactivated</td>
</tr>
<tr>
<td>264</td>
<td>Motor Field Forcing Timed Out</td>
</tr>
<tr>
<td>265</td>
<td>iView Logged On</td>
</tr>
<tr>
<td>ID #</td>
<td>iControl Message (iBox Event Log and iView Controller Event Log)</td>
</tr>
<tr>
<td>------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>266</td>
<td>iView Logged Off</td>
</tr>
<tr>
<td>267</td>
<td>iView Timed Out</td>
</tr>
<tr>
<td>268</td>
<td>iView Lost Connection</td>
</tr>
<tr>
<td>269</td>
<td>Balanced Mode</td>
</tr>
<tr>
<td>270</td>
<td>Lobby Peak Mode</td>
</tr>
<tr>
<td>271</td>
<td>Demand Up Peak Mode</td>
</tr>
<tr>
<td>272</td>
<td>Demand Down Peak Mode</td>
</tr>
<tr>
<td>273</td>
<td>CFSS Mode 1 Recall Activated</td>
</tr>
<tr>
<td>274</td>
<td>CFSS Mode 1 at Floor Activated</td>
</tr>
<tr>
<td>275</td>
<td>CFSS Mode 1 In-car Activated</td>
</tr>
<tr>
<td>276</td>
<td>CFSS Mode 2 Recall Activated</td>
</tr>
<tr>
<td>277</td>
<td>CFSS Mode 2 at Floor Activated</td>
</tr>
<tr>
<td>278</td>
<td>CFSS Mode 2 In-car Activated</td>
</tr>
<tr>
<td>279</td>
<td>Emergency Alarm Acknowledged</td>
</tr>
<tr>
<td>280</td>
<td>Emergency Alarm Activated (Safety opened)</td>
</tr>
<tr>
<td>281</td>
<td>Emergency Alarm Activated (Car delayed with doors closed)</td>
</tr>
<tr>
<td>282</td>
<td>Emergency Alarm Activated (Alarm button)</td>
</tr>
<tr>
<td>283</td>
<td>Emergency Alarm Activated (In-car stop switch)</td>
</tr>
<tr>
<td>284</td>
<td>Emergency Brake OK open</td>
</tr>
<tr>
<td>285</td>
<td>Cartop Exit Open</td>
</tr>
<tr>
<td>286</td>
<td>Governor open</td>
</tr>
<tr>
<td>287</td>
<td>Safety H String Open</td>
</tr>
<tr>
<td>288</td>
<td>Safety C String Open</td>
</tr>
<tr>
<td>289</td>
<td>Machine Room Stop Switch Open</td>
</tr>
<tr>
<td>290</td>
<td>Car Stop Switch Open</td>
</tr>
<tr>
<td>291</td>
<td>Controller Main Computer Startup</td>
</tr>
<tr>
<td>292</td>
<td>Floor Synchronization Fault</td>
</tr>
<tr>
<td>293</td>
<td>Terminal Synchronization Fault</td>
</tr>
<tr>
<td>294</td>
<td>Position Synchronization Fault</td>
</tr>
<tr>
<td>296</td>
<td>Up Emergency Terminal Switch Shutdown</td>
</tr>
<tr>
<td>297</td>
<td>Down Emergency Terminal Switch Shutdown</td>
</tr>
<tr>
<td>298</td>
<td>Power Up Position Synchronization Required at Terminal</td>
</tr>
<tr>
<td>299</td>
<td>Learn U/DNT1-5 and U/DETS Speeds</td>
</tr>
<tr>
<td>300</td>
<td>Learn U/DNT1-5 and U/DETS Positions</td>
</tr>
<tr>
<td>301</td>
<td>Excessive Motor Field Feedback Fault</td>
</tr>
<tr>
<td>302</td>
<td>Brake Output Circuit Failure</td>
</tr>
<tr>
<td>303</td>
<td>Group Communication Lost</td>
</tr>
<tr>
<td>304</td>
<td>Group Communication Established</td>
</tr>
<tr>
<td>305</td>
<td>Flood Operation Activated</td>
</tr>
<tr>
<td>306</td>
<td>Flood Operation Deactivated</td>
</tr>
<tr>
<td>307</td>
<td>Emergency Brake UIM Reset Button Stuck</td>
</tr>
<tr>
<td>308</td>
<td>Exercise Operation Activated</td>
</tr>
<tr>
<td>309</td>
<td>Exercise Operation Deactivated</td>
</tr>
<tr>
<td>310</td>
<td>SCR Low Line Fault</td>
</tr>
<tr>
<td>311</td>
<td>SCR Low Line Caution Activated</td>
</tr>
<tr>
<td>312</td>
<td>SCR Low Line Caution Deactivated</td>
</tr>
<tr>
<td>313</td>
<td>SCR Low Line Test Fault</td>
</tr>
<tr>
<td>314</td>
<td>Excessive Restarts Warning</td>
</tr>
<tr>
<td>315</td>
<td>Governor Speed Reduction Switch Fault</td>
</tr>
<tr>
<td>316</td>
<td>Software Recall Switch Activated</td>
</tr>
<tr>
<td>317</td>
<td>SCR Drive Ready Fault</td>
</tr>
<tr>
<td>318</td>
<td>Retiring Cam Door Lock Fault Activated</td>
</tr>
<tr>
<td>ID #</td>
<td>iControl Message (iBox Event Log and iView Controller Event Log)</td>
</tr>
<tr>
<td>------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>319</td>
<td>Retiring Cam Door Lock Fault Deactivated</td>
</tr>
<tr>
<td>320</td>
<td>Retiring Cam Protection Fault Activated</td>
</tr>
<tr>
<td>321</td>
<td>Retiring Cam Protection Fault Deactivated</td>
</tr>
<tr>
<td>322</td>
<td>Watchdog Ordered Control Stop Before Reset</td>
</tr>
<tr>
<td>323</td>
<td>Front Hall Door Open Button Bypassed</td>
</tr>
<tr>
<td>324</td>
<td>Rear Hall Door Open Button Bypassed</td>
</tr>
<tr>
<td>327</td>
<td>Bus 2 Fuse Open</td>
</tr>
<tr>
<td>328</td>
<td>Bus 2D Fuse Open</td>
</tr>
<tr>
<td>329</td>
<td>Bus 2MC Fuse Open</td>
</tr>
<tr>
<td>330</td>
<td>Bus 2PI Fuse Open</td>
</tr>
<tr>
<td>331</td>
<td>Bus 3 Fuse Open</td>
</tr>
<tr>
<td>332</td>
<td>Bus 3HA Fuse Open</td>
</tr>
<tr>
<td>333</td>
<td>Watchdog Ordered Emergency Stop Before Reset</td>
</tr>
<tr>
<td>334</td>
<td>Local Dispatcher Activated</td>
</tr>
<tr>
<td>335</td>
<td>Local Dispatcher Deactivated</td>
</tr>
<tr>
<td>336</td>
<td>Drive Start Failure</td>
</tr>
<tr>
<td>337</td>
<td>Emergency Medical Service Recall Activated (Switch 2)</td>
</tr>
<tr>
<td>338</td>
<td>Emergency Medical Service In-Car Activated (Switch 2)</td>
</tr>
<tr>
<td>339</td>
<td>Pre-start Door Lock Fault</td>
</tr>
<tr>
<td>340</td>
<td>Emergency Alarm Deactivated without Acknowledgement</td>
</tr>
<tr>
<td>341</td>
<td>Cartop Exit no Counterweight Configuration Error</td>
</tr>
<tr>
<td>342</td>
<td>Front Door Close Fault Recovery Failure</td>
</tr>
<tr>
<td>343</td>
<td>Rear Door Close Fault Recovery Failure</td>
</tr>
<tr>
<td>344</td>
<td>Sheave Brake Pick Fault</td>
</tr>
<tr>
<td>345</td>
<td>Sheave Brake Drop Fault</td>
</tr>
<tr>
<td>346</td>
<td>Serial COP Buss 1 Comm Fault</td>
</tr>
<tr>
<td>347</td>
<td>Serial COP Buss 2 Comm Fault</td>
</tr>
<tr>
<td>348</td>
<td>Serial COP Buss 3 Comm Fault</td>
</tr>
<tr>
<td>349</td>
<td>Serial COP Buss 4 Comm Fault</td>
</tr>
<tr>
<td>350</td>
<td>Serial COP Bus 1 Inventory Fault</td>
</tr>
<tr>
<td>351</td>
<td>Serial COP Bus 2 Inventory Fault</td>
</tr>
<tr>
<td>352</td>
<td>Serial COP Bus 3 Inventory Fault</td>
</tr>
<tr>
<td>353</td>
<td>Serial COP Bus 4 Inventory Fault</td>
</tr>
<tr>
<td>354</td>
<td>User Defined Event 1 On</td>
</tr>
<tr>
<td>355</td>
<td>User Defined Event 1 Off</td>
</tr>
<tr>
<td>356</td>
<td>User Defined Event 2 On</td>
</tr>
<tr>
<td>357</td>
<td>User Defined Event 2 Off</td>
</tr>
<tr>
<td>358</td>
<td>User Defined Event 3 On</td>
</tr>
<tr>
<td>359</td>
<td>User Defined Event 3 Off</td>
</tr>
<tr>
<td>360</td>
<td>User Defined Event 4 On</td>
</tr>
<tr>
<td>361</td>
<td>User Defined Event 4 Off</td>
</tr>
<tr>
<td>362</td>
<td>User Defined Event 5 On</td>
</tr>
<tr>
<td>363</td>
<td>User Defined Event 5 Off</td>
</tr>
<tr>
<td>364</td>
<td>User Defined Event 6 On</td>
</tr>
<tr>
<td>365</td>
<td>User Defined Event 6 Off</td>
</tr>
<tr>
<td>366</td>
<td>User Defined Event 7 On</td>
</tr>
<tr>
<td>367</td>
<td>User Defined Event 7 Off</td>
</tr>
<tr>
<td>368</td>
<td>User Defined Event 8 On</td>
</tr>
<tr>
<td>369</td>
<td>User Defined Event 8 Off</td>
</tr>
<tr>
<td>370</td>
<td>User Defined Event 9 On</td>
</tr>
<tr>
<td>371</td>
<td>User Defined Event 9 Off</td>
</tr>
<tr>
<td>372</td>
<td>User Defined Event 10 On</td>
</tr>
<tr>
<td>ID #</td>
<td>iControl Message (iBox Event Log and iView Controller Event Log)</td>
</tr>
<tr>
<td>-------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>373</td>
<td>User Defined Event 10 Off</td>
</tr>
<tr>
<td>374</td>
<td>Drive Communication Fault</td>
</tr>
<tr>
<td>375</td>
<td>Drive Communication Warning</td>
</tr>
<tr>
<td>376</td>
<td>Motor Limit Protection Timer Elapsed</td>
</tr>
<tr>
<td>377</td>
<td>Shuttle Service Activated</td>
</tr>
<tr>
<td>378</td>
<td>Shuttle Service Deactivated</td>
</tr>
<tr>
<td>379</td>
<td>Event Log Cleared</td>
</tr>
<tr>
<td>380</td>
<td>Front Auxiliary Door Open Button Bypassed</td>
</tr>
<tr>
<td>381</td>
<td>Rear Auxiliary Door Open Button Bypassed</td>
</tr>
<tr>
<td>382</td>
<td>Backup Power Unit Failure Activated</td>
</tr>
<tr>
<td>383</td>
<td>Backup Power Unit Failure Deactivated</td>
</tr>
<tr>
<td>384</td>
<td>Backup Power Direction Reversal</td>
</tr>
<tr>
<td>385</td>
<td>Backup Power Recall ON</td>
</tr>
<tr>
<td>386</td>
<td>Backup Power Recall OFF</td>
</tr>
<tr>
<td>387</td>
<td>Machine Room Heat Detectors Activated</td>
</tr>
<tr>
<td>388</td>
<td>Machine Room Heat Detectors Deactivated</td>
</tr>
<tr>
<td>389</td>
<td>Hoistway Heat Detectors Activated</td>
</tr>
<tr>
<td>390</td>
<td>Hoistway Heat Detectors Deactivated</td>
</tr>
<tr>
<td>391</td>
<td>Floor Heat Detectors Activated</td>
</tr>
<tr>
<td>392</td>
<td>Floor Heat Detectors Deactivated</td>
</tr>
<tr>
<td>393</td>
<td>Heat Detectors Recall Activated</td>
</tr>
<tr>
<td>394</td>
<td>Heat Detectors Recall Deactivated</td>
</tr>
<tr>
<td>395</td>
<td>Heat Detectors Recall Complete</td>
</tr>
<tr>
<td>396</td>
<td>Brake Drop Fault</td>
</tr>
<tr>
<td>397</td>
<td>Cartop Communication Established</td>
</tr>
<tr>
<td>398</td>
<td>Hall Call Service Disabled</td>
</tr>
<tr>
<td>399</td>
<td>Hall Call Service Enabled</td>
</tr>
<tr>
<td>400</td>
<td>Nudging Front</td>
</tr>
<tr>
<td>401</td>
<td>Nudging Rear</td>
</tr>
<tr>
<td>402</td>
<td>Emergency Dispatch On</td>
</tr>
<tr>
<td>403</td>
<td>Emergency Dispatch Off</td>
</tr>
<tr>
<td>404</td>
<td>Safety B Unintended Motion Fault</td>
</tr>
<tr>
<td>405</td>
<td>SPA Spare Event 1</td>
</tr>
<tr>
<td>406</td>
<td>SPA Spare Event 2</td>
</tr>
<tr>
<td>407</td>
<td>SPA Spare Event 3</td>
</tr>
<tr>
<td>408</td>
<td>SPA Spare Event 4</td>
</tr>
<tr>
<td>409</td>
<td>SPA Spare Event 5</td>
</tr>
<tr>
<td>410</td>
<td>SPA Spare Event 6</td>
</tr>
<tr>
<td>411</td>
<td>SPA Spare Event 7</td>
</tr>
<tr>
<td>412</td>
<td>SPA Spare Event 8</td>
</tr>
<tr>
<td>413</td>
<td>LCD Fault</td>
</tr>
<tr>
<td>414</td>
<td>Battery Voltage Low-IMP</td>
</tr>
<tr>
<td>415</td>
<td>Emergency Brake OK open Off</td>
</tr>
<tr>
<td>416</td>
<td>Safety H String Open Off</td>
</tr>
<tr>
<td>417</td>
<td>Safety C String Open Off</td>
</tr>
<tr>
<td>418</td>
<td>Cartop Exit Open Off</td>
</tr>
<tr>
<td>419</td>
<td>Brake Pick Switch Fault Off</td>
</tr>
<tr>
<td>420</td>
<td>IO Map Compare Fault Off</td>
</tr>
<tr>
<td>421</td>
<td>IO map Toggle Compare Fault Off</td>
</tr>
<tr>
<td>422</td>
<td>Safety A SIB Device Fault Off</td>
</tr>
<tr>
<td>423</td>
<td>Safety B SIB Device Fault Off</td>
</tr>
<tr>
<td>424</td>
<td>Invalid Configuration Input Off</td>
</tr>
<tr>
<td>ID #</td>
<td>iControl Message (iBox Event Log and iView Controller Event Log)</td>
</tr>
<tr>
<td>------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>425</td>
<td>Invalid Configuration Input DLMS</td>
</tr>
<tr>
<td>426</td>
<td>Invalid Configuration Input DLAT</td>
</tr>
<tr>
<td>427</td>
<td>Invalid Configuration Input DLAB</td>
</tr>
<tr>
<td>428</td>
<td>Invalid Configuration Input DCMS</td>
</tr>
<tr>
<td>429</td>
<td>Invalid Configuration Input DCAT</td>
</tr>
<tr>
<td>430</td>
<td>Invalid Configuration Input DCAB</td>
</tr>
<tr>
<td>431</td>
<td>Invalid Configuration Input DPM</td>
</tr>
<tr>
<td>432</td>
<td>Invalid Configuration Input CTEX</td>
</tr>
<tr>
<td>433</td>
<td>Invalid Configuration Input DLMSR</td>
</tr>
<tr>
<td>434</td>
<td>Invalid Configuration Input DCMSR</td>
</tr>
<tr>
<td>435</td>
<td>Invalid Configuration Input DPMR</td>
</tr>
<tr>
<td>436</td>
<td>Safety String Closed</td>
</tr>
<tr>
<td>437</td>
<td>IMP Switch Fault - Emergency Stop</td>
</tr>
<tr>
<td>438</td>
<td>IMP Switch Fault - Fault Bypass</td>
</tr>
<tr>
<td>439</td>
<td>IMP Switch Fault - Inspection DOWN</td>
</tr>
<tr>
<td>440</td>
<td>IMP Switch Fault - Inspection UP</td>
</tr>
<tr>
<td>441</td>
<td>IMP Switch Fault - Inspection Enable</td>
</tr>
<tr>
<td>442</td>
<td>IMP Switch Fault - Inspection</td>
</tr>
<tr>
<td>443</td>
<td>IMP Switch Fault - Learn</td>
</tr>
<tr>
<td>444</td>
<td>IMP Switch Fault - Test</td>
</tr>
<tr>
<td>445</td>
<td>IMP Switch Fault - Write Enable</td>
</tr>
<tr>
<td>446</td>
<td>IMP Switch Fault - Hoistway Door Bypass</td>
</tr>
<tr>
<td>447</td>
<td>IMP Switch Fault - Car Door Bypass</td>
</tr>
<tr>
<td>448</td>
<td>IMP Switch Fault - None</td>
</tr>
<tr>
<td>451</td>
<td>Excessive Faults Warning</td>
</tr>
<tr>
<td>452</td>
<td>Stuck Cartop Inspection Input</td>
</tr>
<tr>
<td>453</td>
<td>Cartop Inspection Inputs OK</td>
</tr>
<tr>
<td>454</td>
<td>Stuck Car Panel Inspection Input</td>
</tr>
<tr>
<td>455</td>
<td>Car Panel Inspection Inputs OK</td>
</tr>
<tr>
<td>456</td>
<td>Cartop Inspection Disabled</td>
</tr>
<tr>
<td>457</td>
<td>Cartop Inspection Enabled</td>
</tr>
<tr>
<td>458</td>
<td>Hoistway Access Disabled</td>
</tr>
<tr>
<td>459</td>
<td>Hoistway Access Enabled</td>
</tr>
<tr>
<td>460</td>
<td>Car Panel Inspection Disabled</td>
</tr>
<tr>
<td>461</td>
<td>Car Panel Inspection Enabled</td>
</tr>
<tr>
<td>462</td>
<td>Machine Room Inspection Disabled</td>
</tr>
<tr>
<td>463</td>
<td>Machine Room Inspection Enabled</td>
</tr>
<tr>
<td>464</td>
<td>Stuck Inspection Input Fault</td>
</tr>
<tr>
<td>465</td>
<td>DBD Mode Activated (not used)</td>
</tr>
<tr>
<td>466</td>
<td>ETA Mode Activated (not used)</td>
</tr>
<tr>
<td>467</td>
<td>Hall Call Bypass Input ON</td>
</tr>
<tr>
<td>468</td>
<td>Hall Call Bypass Input OFF</td>
</tr>
<tr>
<td>469</td>
<td>Capture Input ON</td>
</tr>
<tr>
<td>470</td>
<td>Capture Input OFF</td>
</tr>
<tr>
<td>475</td>
<td>Emergency Stop Input Activated</td>
</tr>
<tr>
<td>476</td>
<td>Emergency Stop Input Deactivated</td>
</tr>
<tr>
<td>479</td>
<td>Safety B Fault Activated</td>
</tr>
<tr>
<td>480</td>
<td>Safety B Fault Deactivated</td>
</tr>
</tbody>
</table>
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alternate Floor Smoke Sensor Recall, ALTERNATE FLOOR SMOKE</td>
<td>Recall to the main fire floor due to active or latched smoke detector input(s) from floors other than the main recall floor.</td>
<td>Car proceeds to the user-defined main fire recall floor. Once at the recall floor, door operation is according to the user-defined door operation under fire recall operation.</td>
<td>1. If in error, inspect the sensor input and connections. 2. Related Inputs: Smoke and fire sensors as indicated in job prints.</td>
</tr>
<tr>
<td>Alternate Speed Profile 1 Activated, Alternate Speed Profile 1, ALT SPEED PROFILE 1</td>
<td>Indicates that the Alternate Speed Profile has been enabled via a keyed or switched input. When so configured, Alternate Speed Profiles 1 and 2 use Alternate 1 and Alternate 2 performance patterns respectively. (Pattern Configuration/Alternate 'n'.)</td>
<td>Car uses assigned pattern (Alternate 1 or 2).</td>
<td></td>
</tr>
<tr>
<td>Alternate Speed Profile 1 Deactivated</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alternate Speed Profile 2 Activated</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alternate Speed Profile 2 Deactivated</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ascending Car Overspeed Fault, ASCND CAR OVR SPD FLT</td>
<td>Ascending Car Overspeed Fault. Tripped if the elevator is traveling in the up direction, the Governor contact opens, and the Rope Gripper option is selected on the Safety Configuration screen. You will also see a Governor Open fault.</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped. The rope brake drops if installed. If you do not have a RG (Rope Gripper) or EB (Emergency Brake) board in your controller, this fault will not appear.</td>
<td>1. Check the iView event log for related events. 2. Identify and correct any operational problems. Check for proper governor operation. 3. Resetting the Governor switch will automatically clear this fault.</td>
</tr>
<tr>
<td>Attendant Service, Attendant Svc</td>
<td>Indicates that the elevator is operating under Attendant Service mode of operation. Generally initiated via an input (switch or button) at the car operating panel.</td>
<td>Car operates under attendant mode.</td>
<td>1. Related input: Attendant service as indicated on the job prints.</td>
</tr>
<tr>
<td>Automatic Stop</td>
<td>The Automatic Stop feature has been enabled.</td>
<td></td>
<td>1. Check the parameters on the Configuration &gt; Car Operation &gt; Auto Stop tab for proper configuration.</td>
</tr>
<tr>
<td>Backup Power Direction Reversal</td>
<td>Backup power recall reverse direction input activated (signal from TAPS Aux Power Supply).</td>
<td>Car direction of travel is reversed unless the car is on Earthquake operation and the CW1/CW2 inputs (Counterweight movement sensor) are active and reversal would move the car in the direction towards the counter weight.</td>
<td>1. Check the parameters on the Configuration &gt; Car Operation &gt; Auto Stop tab for proper configuration.</td>
</tr>
</tbody>
</table>
Table 6.3  iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Backup Power Recall OFF</strong></td>
<td>The Backup power recall input has been deactivated.</td>
</tr>
<tr>
<td><strong>Backup Power Recall ON, BACKUP POWER RECALL</strong></td>
<td>Backup power recall input activated (signal from TAPS Traction Auxiliary Power Supply).</td>
</tr>
<tr>
<td>Car Reaction: If the car is not currently at a floor, it will move to a floor and cycle the doors. If no load weigher is used, the car will move to the closest floor. If a load weigher is used, direction is dependent on the car load and the Counterweight percentage parameter. If load weight is greater than Counterweight percentage, car moves down and vice versa.</td>
<td></td>
</tr>
<tr>
<td><strong>Backup Power Unit Failure Activated, Backup power unit failure, BACKUP POWER FAILURE</strong></td>
<td>The Backup power unit failure input is low.</td>
</tr>
<tr>
<td>Car Reaction: None. The event is displayed and logged.</td>
<td></td>
</tr>
<tr>
<td>Troubleshooting:</td>
<td>1. Check the UPS unit for faults.</td>
</tr>
<tr>
<td></td>
<td>2. Check the connection to the Backup power unit failure input.</td>
</tr>
<tr>
<td></td>
<td>3. It may be necessary to replace the battery</td>
</tr>
<tr>
<td><strong>Backup Power Unit Failure Deactivated</strong></td>
<td>The Backup power unit failure input has changed back to its normally high state.</td>
</tr>
<tr>
<td><strong>Balanced Mode</strong></td>
<td>Passenger operation. Up and Down traffic treated equally. Assigned by group controller.</td>
</tr>
<tr>
<td><strong>Battery Voltage Low-IMP, BATTERY VLTG LOW-IMP</strong></td>
<td>The voltage on Battery B1 on the IMP board has dropped below 2.22 VDC and the battery must be replaced. Otherwise the BBRAM will be unable to retain the data stored during a power loss or shut down.</td>
</tr>
<tr>
<td><strong>Blocking New Remote Connections, BLOCKING REMOTE UIS</strong></td>
<td>When a car switches from Local to Local Dispatcher, parameters and connections to other cars must stabilize. While stabilizing Local Dispatcher will not accept any new remote connections for 30 seconds.</td>
</tr>
<tr>
<td>Car Reaction: iView will remain connected if it was already connected. Any new iMonitor, iReport, Liftnet, BMS, etc. connections will be denied for 30 seconds while the car is syncing up and stabilizing data.</td>
<td></td>
</tr>
<tr>
<td>Troubleshooting:</td>
<td>1. If this message is persistent for more than 30 seconds or if it seems to come and go for extended periods of time, the car may be confused as to if it should be the Local Dispatcher. Check the Alternate Dispatcher settings (System Configuration &gt; Building tab), and Car ID (Controller &gt; General &gt; General tab) parameters. This has been an issue when upgrading a car designated as Alternate Dispatcher with a Car ID not = 1. A reboot was necessary to fix it, but is also necessary after an upgrade anyway.</td>
</tr>
<tr>
<td><strong>Brake Contactor Driver Proofing Fault, BRAKE CNT DRV PRF FLT</strong></td>
<td>Fault signal for brake contactor driver proofing.</td>
</tr>
<tr>
<td>Car Reaction: None</td>
<td>troubleshooting:</td>
</tr>
<tr>
<td></td>
<td>1. Verify brake contactor driver proofing circuits.</td>
</tr>
<tr>
<td><strong>Brake Contactor Proofing Fault, BRAKE CONT PRF FAULT</strong></td>
<td>Fault signal for brake contactor proofing.</td>
</tr>
<tr>
<td>Car Reaction: None</td>
<td>troubleshooting:</td>
</tr>
<tr>
<td></td>
<td>1. Verify brake contactor proofing circuits.</td>
</tr>
</tbody>
</table>
### Brake Drop Fault, BRAKE DROP FAULT
Description: Brake contact input (SP2D or Brake Switch) not in the state required by the "Brake is picked when SP2D or Brake Switch terminal is high (low)" parameter, indicating the brake was not fully dropped for more than one second after car had stopped. Fault may be bypassed on the Controller > Diagnostics > Fault Bypass tab by setting Brake Switch.

**Car Reaction:** Car is removed from service.

**Troubleshooting:**
1. On the Controller > Configuration > Brake > Control tab, check “Brake is picked when SP2D or Brake Switch terminal is high (low)” to determine the proper state of terminal SP2D or Brake Switch when the brake is dropped (Please refer to "Configuration - Brake Tab” on page 9-25).
2. Verify proper operation of the brake and brake switch (open or closed, see step 1) when the brake is fully dropped.
3. With the brake dropped, verify the state of input SP2D or Brake Switch (low or high, see step 1). Please refer to “Installing Brake Monitoring” on page 3-20.
4. Use the iBox Fault Reset button to reset the fault.

### Brake Enable Fault
Description: When the brake module is enabled, a feedback signal is generated for the iBox. If the feedback signal is not detected, this fault is generated.

**Car Reaction:** Emergency stop: Motor and brake contactors immediately dropped.

**Troubleshooting:**
1. Check the Brake Voltage Feedback test point on the iView Oscilloscope screen.
2. Check the iField Brake Module connections.
3. Check the brake and brake connections.
4. If brake feedback voltage is actually present, the iBox Safety board may be defective.

### Brake Module Over Temperature Fault, BRAKE OVER TEMP FAULT
Description: Temperature sensor in the brake module detected an overheat condition.

**Car Reaction:** If the car is running, it will continue to answer current call. After the car is stopped at a floor, the car will not be allowed to run until the overheat condition clears.

**Troubleshooting:**
1. Check for excessive machine room temperature. (Should not exceed 104 degrees F or 40C.)
2. Verify air enters at bottom of the power box and is only expelled via the fan at the top of the power box.
3. Check the running temperature inside the power box (should not exceed 105 degrees F).
4. Check for insufficient air circulation through the power box.
5. Check for improperly picking brake.
6. Check for faulty brake module.
7. Check for faulty connection between brake module and iBox.

### Brake Output Circuit Failure, BRAKE OUTPUT FAILURE
Description: The flywheel brake IGBT has failed or the fuse has opened.

**Car Reaction:** Normal stop.

**Troubleshooting:**
1. Verify proper operation of the brake module while running on machine room inspection:
   - Does the brake pick voltage match the setting on the Configuration > Brake tab?
   - Does the brake hold voltage match the setting on the Configuration > Brake tab?
2. Verify proper operation of the brake module while performing the Brake Calibration:
   - Does the voltage max out and then slowly ramp down to about 10% of maximum supply voltage?
   - Does the current max out and then slowly ramp down to about 10% of maximum supply current?

If the brake module is constantly outputting maximum voltage and current based on the testing in steps 1 and 2, the main IGBT on the module is most likely damaged. The module must be replaced.

**CAUTION:** An open or damaged RB resistor can cause the IGBT to fail. Check the resistor by removing the center tap and measuring the value of the entire resistor. It is strongly recommended to do this before installing another brake module.
Brake Pick Fault, BRAKE PICK FAULT
Description: Brake contact input (SP2D or Brake Switch) was not in the state required by the "Brake is picked when SP2D or Brake Switch terminal is high (low)" parameter, indicating that the brake was not fully picked during one entire run or was late going low (or high) indicating a slow picking brake during three consecutive runs. This fault may be bypassed on the Controller > Diagnostics > Fault Bypass tab by setting Brake Switch.
Car Reaction: Car completes it’s nearest run and is removed from service.
Troubleshooting:
1. On the Controller > Configuration > Brake > Control tab, check "Brake is picked when SP2D or Brake Switch terminal is high (low)" to determine the proper state of terminal SP2D or Brake Switch when the brake is picked (see "Configuration - Brake Tab" on page 9-25).
2. Verify proper operation of the brake and brake pick switch (open or closed, see step 1) when the brake is fully picked.
3. With the brake picked, verify the state of input SP2D or Brake Switch (low or high, see step 1). Please refer to "Installing Brake Monitoring” on page 3-20.
4. Use the iBox Fault Reset button to reset the fault.

Brake Pick Fault Off (See: Brake Pick Fault)

Brake Voltage Not On Fault, BRAKE V NOT ON FAULT
Description: After brake contactors are picked and controller did not receive more than 30% of the picking voltage after 1 second, this fault is generated. May be bypassed on the Diagnostics > Fault Bypass tab.
Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped. Fault will self clear and car will attempt to run again.
Troubleshooting:
1. Verify Brake AC input voltage at FB1 and FB2.
2. Verify FB1 and FB2 fuses are good.
3. Verify J2 connector on right side of iBox is seated properly.
5. Recalibrate brake module if applicable.

Bus 2 Fuse Open, BUS 2 FUSE OPEN
Description: The bus 2 fuse is open.
Car Reaction: Emergency stop. Cancel demand and open doors. No further movement is allowed.
Troubleshooting: Check bus 2 fuse located at bottom of iBox.

Bus 2D Fuse Open, BUS 2D FUSE OPEN
Description: The bus 2D fuse is open.
Car Reaction: Emergency stop. Cancel demand and open doors. No further movement is allowed.
Troubleshooting: Check bus 2D fuse located at bottom of iBox.

Bus 2MC Fuse Open, BUS 2MC FUSE OPEN
Description: The bus 2MC fuse is open.
Car Reaction: Emergency stop. Cancel demand and open doors. No further movement is allowed.
Troubleshooting: Check bus 2MC fuse located at bottom of iBox.

Bus 2PI Fuse Open, BUS 2PI FUSE OPEN
Description: The bus 2PI fuse is open.
Car Reaction: None. The PI signals will not be active.
Troubleshooting: Check bus 2PI fuse located at bottom of iBox.

Bus 3 Fuse Open, BUS 3 FUSE OPEN
Description: The bus 3 fuse is open.
Car Reaction: Emergency stop. Cancel demand and open doors. No further movement is allowed.
Troubleshooting: Check bus 3 fuse located at bottom of iBox.
Table 6.3  iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bus 3HA Fuse Open, BUS 3HA FUSE OPEN</strong></td>
</tr>
<tr>
<td>Description: The bus 3HA fuse is open.</td>
</tr>
<tr>
<td>Car Reaction: None. No further movement is allowed when on Access operation.</td>
</tr>
<tr>
<td>Troubleshooting: Check bus 3HA fuse located at bottom of iBox.</td>
</tr>
<tr>
<td><strong>Capture Input OFF</strong> (see Capture Input ON)</td>
</tr>
<tr>
<td><strong>Capture Input ON</strong></td>
</tr>
<tr>
<td>Description: Discrete input used to capture the car. This input will activate</td>
</tr>
<tr>
<td>Capture mode, similar to the iBox Capture switch (see also: Capture Mode).</td>
</tr>
<tr>
<td>Car Reaction: The car takes itself out of hall call service. Hall calls are</td>
</tr>
<tr>
<td>canceled if no other car is available for hall call service. The car is also</td>
</tr>
<tr>
<td>not eligible for parking.</td>
</tr>
<tr>
<td>Troubleshooting: Check the related discrete inputs.</td>
</tr>
<tr>
<td><strong>Capture Mode, Capture</strong></td>
</tr>
<tr>
<td>Description: Indicates the Capture mode switch on the iBox has been placed in the</td>
</tr>
<tr>
<td>ON position.</td>
</tr>
<tr>
<td>Car Reaction: Car enters capture mode, removing itself from group operation</td>
</tr>
<tr>
<td>(hall calls assigned to it will be reassigned to another elevator if possible).</td>
</tr>
<tr>
<td>The car answers registered car calls but does not respond to hall call demand.</td>
</tr>
<tr>
<td>Intended to allow maintenance personnel access to the car.</td>
</tr>
<tr>
<td><strong>Car delayed with doors closed, CAR DEL DOORS CLOSED</strong></td>
</tr>
<tr>
<td>Description: Indicates that a car, with doors fully closed, has been delayed in</td>
</tr>
<tr>
<td>reaching an assigned destination.</td>
</tr>
<tr>
<td>Car Reaction: Assigned hall calls will be reassigned to other available cars.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Determine what is inhibiting the car from reaching its destination.</td>
</tr>
<tr>
<td>2. Check the event log for any faults that may have prevented the car from</td>
</tr>
<tr>
<td>moving.</td>
</tr>
<tr>
<td><strong>Car delayed with doors closing, CAR DEL DOORS CLOSING</strong></td>
</tr>
<tr>
<td>Description: Indicates that a car, with doors closing, has been delayed in</td>
</tr>
<tr>
<td>reaching an assigned destination.</td>
</tr>
<tr>
<td>Car Reaction: Assigned hall calls will be reassigned to other available cars.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Determine what is inhibiting the car from reaching its destination.</td>
</tr>
<tr>
<td>2. Check the event log for any faults that may have prevented the car from</td>
</tr>
<tr>
<td>moving.</td>
</tr>
<tr>
<td><strong>Car delayed with doors open, CAR DEL DOORS OPEN</strong></td>
</tr>
<tr>
<td>Description: Indicates that a car, with doors fully open, has been delayed in</td>
</tr>
<tr>
<td>reaching an assigned destination.</td>
</tr>
<tr>
<td>Car Reaction: Assigned hall calls will be reassigned to other available cars.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Determine what is keeping the doors open or inhibiting them from closing.</td>
</tr>
<tr>
<td>2. Check the event log for any faults that may have prevented the doors from</td>
</tr>
<tr>
<td>closing.</td>
</tr>
<tr>
<td><strong>Car delayed with doors opening, CAR DEL DOORS OPENING</strong></td>
</tr>
<tr>
<td>Description: Indicates that a car, with doors opening, has been delayed in</td>
</tr>
<tr>
<td>reaching an assigned destination.</td>
</tr>
<tr>
<td>Car Reaction: Assigned hall calls will be reassigned to other available cars.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Determine what is inhibiting the doors from opening.</td>
</tr>
<tr>
<td>2. Check the event log for any faults that may have prevented the doors from</td>
</tr>
<tr>
<td>opening.</td>
</tr>
</tbody>
</table>
Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description:</th>
<th>Car Reaction:</th>
<th>Troubleshooting:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Car delayed with doors stalled, CAR DEL DOORS STALLED</strong></td>
<td>Indicates that a car, with doors stalled, has been delayed in reaching an assigned destination.</td>
<td>Assigned hall calls will be reassigned to other available cars.</td>
<td>1. Determine what is inhibiting the doors from closing. 2. Check the event log for any faults that may have prevented the doors from closing.</td>
</tr>
<tr>
<td><strong>Car delayed with unknown door position, CAR DEL DOORS UNKNOWN</strong></td>
<td>Indicates that a car, with unknown door position, has been delayed in reaching an assigned destination.</td>
<td>Assigned hall calls will be reassigned to other available cars.</td>
<td>1. Determine what is causing the doors to be reported in an invalid condition.</td>
</tr>
<tr>
<td><strong>Car Dispatch Load</strong></td>
<td>Not currently used.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Car Door Bypass, CAR DOOR BYPASS</strong></td>
<td>The Car Door Bypass switch on the iBox is in the Bypass position. (View-only on iView Safety screen, enabled/disabled by MCE according to safety jurisdiction.)</td>
<td>The car is placed in Inspection mode. To move the car, you must place it in either cartop or car panel inspection mode. No other modes of operation are allowed.</td>
<td></td>
</tr>
<tr>
<td><strong>Car Heavy Load Activated - Hall Calls Bypassed, CAR HEAVY LOAD</strong></td>
<td>The load in the car has exceeded the Heavy Load Threshold setting.</td>
<td>Hall calls are bypassed until the heavy load condition is cleared. Hall calls assigned to this car are reassigned to other cars if possible.</td>
<td>1. Verify the programmed “Heavy Load Threshold” value and adjust if needed (Load Weigher Configuration screen). 2. Evaluate whether or not the load in the car exceeds the Heavy Load Threshold. Calibrate the load weigher if needed. 3. For discrete input load weighers, check the Heavy Load Input shown on the job prints.</td>
</tr>
<tr>
<td><strong>Car Heavy Load - Deactivated</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Car out of service with doors closed, CAR OS DOORS CLOSED</strong></td>
<td>A delayed car with closed doors has remained so for an excessive period of time (as determined by a user-programmed timer parameter, Car Operation Screen/Passenger tab).</td>
<td>The car removes itself from car and hall call service (car calls are canceled and hall calls are canceled or reassigned).</td>
<td>1. Determine what is inhibiting the car from reaching its destination. 2. Check the event log for any faults that may have prevented the car from moving.</td>
</tr>
<tr>
<td><strong>Car out of service with doors closing, CAR OS DOORS CLOSING</strong></td>
<td>A delayed car with closing doors has remained so for an excessive period of time (as determined by a user-programmed timer parameter, Car Operation Screen/Passenger tab).</td>
<td>The car removes itself from car and hall call service (car calls are canceled and hall calls are canceled or reassigned).</td>
<td>1. Determine what is inhibiting the car from reaching its destination. 2. Check the event log for any faults that may have prevented the car from moving.</td>
</tr>
</tbody>
</table>
## iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Car out of service with unknown door position, CAR OS DOORS UNKNOWN** | A delayed car with invalid doors has remained so for an excessive period of time (as determined by a user-programmed timer parameter, Car Operation Screen/Passenger tab.) | The car removes itself from car and hall call service (car calls are canceled and hall calls are canceled or reassigned). | 1. Determine what is inhibiting the car from reaching its destination.  
2. Check the event log for any faults that may have prevented the car from moving. |
| **Car out of service with doors open, CAR OS DOORS OPEN** | A delayed car with open doors has remained so for an excessive period of time (as determined by a user-programmed timer parameter, Car Operation Screen/Passenger tab.) | The car removes itself from car and hall call service (car calls are canceled and hall calls are canceled or reassigned). | 1. Determine what is inhibiting the car from reaching its destination.  
2. Check the event log for any faults that may have prevented the car from moving. |
| **Car out of service with doors opening, CAR OS DOORS OPENING** | A delayed car with opening doors has remained so for an excessive period of time (as determined by a user-programmed timer parameter, Car Operation Screen/Passenger tab.) | The car removes itself from car and hall call service (car calls are canceled and hall calls are canceled or reassigned). | 1. Determine what is inhibiting the car from reaching its destination.  
2. Check the event log for any faults that may have prevented the car from moving. |
| **Car out of service with doors stalled, CAR OS DOORS STALLED** | A delayed car with stalled doors has remained so for an excessive period of time (as determined by a user-programmed timer parameter, Car Operation Screen/Passenger tab.) | The car removes itself from car and hall call service (car calls are canceled and hall calls are canceled or reassigned). | 1. Determine what is inhibiting the car from reaching its destination.  
2. Check the event log for any faults that may have prevented the car from moving. |
| **Car Over Load Activated, CAR OVERLOAD** | The load in the car has exceeded the Overload Threshold setting. | The car is held at the floor with doors open. Over load indicators, if present, will be activated. | 1. If this message appears to be displayed in error, verify the programmed Over Load Threshold value and adjust if needed. Please refer to “Configuration - Loadweigher” on page 9-129.  
2. Evaluate whether or not the load in the car exceeds the Over Load Threshold value. Calibrate the load weigher if necessary.  
3. For discrete input load weighers, check the Over Load input shown on the job prints. |
| **Car Over Load Deactivated** | **Car Panel Inspection Disabled, CP INSPI. DISABLED** | Car Panel inspection operation has been disabled. | The car cannot be run on car panel inspection operation. | 1. Check for any car status that might prevent car panel inspection operation, e.g. earthquake.  
2. Check for the Stuck Inspection Input Fault.  
3. Check all inspection buttons (Enable, Up, Down) and verify that none are stuck in the ON position. |

### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Car out of service with unknown door position, CAR OS DOORS UNKNOWN** | A delayed car with invalid doors has remained so for an excessive period of time (as determined by a user-programmed timer parameter, Car Operation Screen/Passenger tab.) | The car removes itself from car and hall call service (car calls are canceled and hall calls are canceled or reassigned). | 1. Determine what is inhibiting the car from reaching its destination.  
2. Check the event log for any faults that may have prevented the car from moving. |
| **Car out of service with doors open, CAR OS DOORS OPEN** | A delayed car with open doors has remained so for an excessive period of time (as determined by a user-programmed timer parameter, Car Operation Screen/Passenger tab.) | The car removes itself from car and hall call service (car calls are canceled and hall calls are canceled or reassigned). | 1. Determine what is inhibiting the car from reaching its destination.  
2. Check the event log for any faults that may have prevented the car from moving. |
| **Car out of service with doors opening, CAR OS DOORS OPENING** | A delayed car with opening doors has remained so for an excessive period of time (as determined by a user-programmed timer parameter, Car Operation Screen/Passenger tab.) | The car removes itself from car and hall call service (car calls are canceled and hall calls are canceled or reassigned). | 1. Determine what is inhibiting the car from reaching its destination.  
2. Check the event log for any faults that may have prevented the car from moving. |
| **Car out of service with doors stalled, CAR OS DOORS STALLED** | A delayed car with stalled doors has remained so for an excessive period of time (as determined by a user-programmed timer parameter, Car Operation Screen/Passenger tab.) | The car removes itself from car and hall call service (car calls are canceled and hall calls are canceled or reassigned). | 1. Determine what is inhibiting the car from reaching its destination.  
2. Check the event log for any faults that may have prevented the car from moving. |
| **Car Over Load Activated, CAR OVERLOAD** | The load in the car has exceeded the Overload Threshold setting. | The car is held at the floor with doors open. Over load indicators, if present, will be activated. | 1. If this message appears to be displayed in error, verify the programmed Over Load Threshold value and adjust if needed. Please refer to “Configuration - Loadweigher” on page 9-129.  
2. Evaluate whether or not the load in the car exceeds the Over Load Threshold value. Calibrate the load weigher if necessary.  
3. For discrete input load weighers, check the Over Load input shown on the job prints. |
| **Car Over Load Deactivated** | **Car Panel Inspection Disabled, CP INSPI. DISABLED** | Car Panel inspection operation has been disabled. | The car cannot be run on car panel inspection operation. | 1. Check for any car status that might prevent car panel inspection operation, e.g. earthquake.  
2. Check for the Stuck Inspection Input Fault.  
3. Check all inspection buttons (Enable, Up, Down) and verify that none are stuck in the ON position. |
### Table 6.3  iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Car Panel Inspection Enabled</strong></td>
</tr>
<tr>
<td>Description: Car Panel inspection operation which was previously disabled is now enabled.</td>
</tr>
<tr>
<td><strong>Car Panel Inspection Inputs OK</strong></td>
</tr>
<tr>
<td>Description: One or more previously stuck cartop inspection inputs (Enable, Up, Down) have been deactivated (see Stuck Car Panel Inspection Input message).</td>
</tr>
<tr>
<td><strong>Car Panel Inspection Operation, Car Panel Inspection, Car Panel Insp.</strong></td>
</tr>
<tr>
<td>Description: The car has been placed in inspection mode using a (typically) keyed switch on the car operation panel.</td>
</tr>
<tr>
<td><strong>Car Reaction:</strong> If running, the car makes an emergency stop and is taken out of passenger service. The car uses the inspection pattern settings and can only be moved using the car panel inspection key switches.</td>
</tr>
<tr>
<td><strong>Troubleshooting:</strong></td>
</tr>
<tr>
<td>1. Check the car panel inspection switch and related inputs.</td>
</tr>
<tr>
<td>2. The Car Panel Inspection input is Normally High.</td>
</tr>
<tr>
<td><strong>Car shut down due to emergency power operation with no supervisor (Activated)</strong></td>
</tr>
<tr>
<td>Description: iControl has detected that an emergency power condition exists and it has not established communication with the emergency power supervisor (typically a group controller).</td>
</tr>
<tr>
<td><strong>Car Reaction:</strong> The car is not allowed to move to prevent overloading the emergency power generator. If the car is moving when the event occurs, the car will make an emergency stop. motor contactor and brake contactor are immediately dropped. The car is also shut down (calls and all other demands are canceled).</td>
</tr>
<tr>
<td><strong>Troubleshooting:</strong></td>
</tr>
<tr>
<td>1. If this condition exists and the system is NOT operating under emergency power, refer to the job prints and verify wiring to the controller Emergency Power status input.</td>
</tr>
<tr>
<td>2. Verify correct input state (high/low) on iView/Car Operation/Emergency Power/EPI Input setting.</td>
</tr>
<tr>
<td>3. Check group to car communication.</td>
</tr>
<tr>
<td><strong>Car shut down due to emergency power operation with no supervisor (Deactivated)</strong></td>
</tr>
<tr>
<td>Description: Emergency power condition, without established communication with group supervisor, has been resolved. Either communication with the supervisor has been established or the emergency power condition has been removed.</td>
</tr>
<tr>
<td><strong>Car Reaction:</strong> While emergency power is in effect, the car is allowed to move as determined by the group controller (iCue). Car selection for recall and emergency power operation is user determined (iView/Car Operation/Emergency Power and iCue iView/Emergency Power Configuration screens).</td>
</tr>
<tr>
<td><strong>Car Stop Switch Open, CAR STOP SWITCH OPEN</strong></td>
</tr>
<tr>
<td>Description: The car panel stop switch input has dropped (in-car stop switch has been activated). This switch may be bypassed during special modes of operation such as fire, CFSS, or EMS.</td>
</tr>
<tr>
<td><strong>Car Reaction:</strong> Emergency stop if running. The car is not allowed to run again until the car panel stop switch is moved to the RUN position.</td>
</tr>
<tr>
<td><strong>Troubleshooting:</strong></td>
</tr>
<tr>
<td>1. Check the in-car stop switch and switch connections.</td>
</tr>
<tr>
<td>2. Check current mode of operation and verify that the stop switch operation is as expected.</td>
</tr>
<tr>
<td><strong>Cartop Automatic Unintended Motion Fault, CARTOP AUTO UIM FLT</strong></td>
</tr>
<tr>
<td>Description: An unintended motion fault has been detected while the car was running under Passenger operation.</td>
</tr>
<tr>
<td><strong>Car Reaction:</strong> Emergency Stop. Cancel all calls. This fault will self reset.</td>
</tr>
<tr>
<td><strong>Troubleshooting:</strong></td>
</tr>
<tr>
<td>1. Check the iView Event Log for preceding activity.</td>
</tr>
<tr>
<td>2. Correct initiating problem, if any.</td>
</tr>
<tr>
<td><strong>Cartop Communication Established</strong></td>
</tr>
<tr>
<td>Description: Communication between iControl (iBox) and the iLink ICE-CTP board has been established. This communication is through twisted-pair, shielded cabling in the traveler cable.</td>
</tr>
</tbody>
</table>
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cartop Communication Fault, CARTOP COMM FAULT</strong></td>
<td>Communication between iControl and iLink have failed. This communication is through twisted-pair, shielded cabling in the traveler cable.</td>
<td>Emergency Stop. Cancel all calls.</td>
<td>1. Check the connections at the iBox and iLink ends of the connection. Refer to -CW job print drawing. 2. If the connections are clean and tight, use an oscilloscope to check the TX and RX signals themselves. Or, if practical, connect the iBox end of the connection to another iControl in the machine room and see if that controller can communicate with the iLink box. 3. If required, replace the iLink Cartop board or the iBox as appropriate.</td>
</tr>
<tr>
<td><strong>Cartop Emergency Stop</strong></td>
<td>The cartop processor has detected a fault and initiated an emergency stop. The Cartop Safety relay has opened in response to an unsafe condition.</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped. Cancel all calls.</td>
<td>1. Check the iView Event Log for related preceding events. 2. Troubleshoot and correct any initiating problem. 3. Restore safety string and test.</td>
</tr>
<tr>
<td><strong>Cartop Exit Open, CARTOP EXIT OPEN</strong></td>
<td>The Cartop Exit Switch input has dropped. The input is normally on when the configuration states that the switch is installed. The input may be bypassed by: 1) the car being on car top or car panel inspection while on earthquake, and 2) the safety bypass jumper being installed.</td>
<td>Emergency stop if running. The car is not allowed to run until the problem is corrected.</td>
<td>1. Check the switch status and configuration (Safety screen). 2. Check elements related to bypassing.</td>
</tr>
<tr>
<td><strong>Cartop Exit Open Off</strong> (see: Cartop Exit Open)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Cartop Exit no Counterweight Configuration Error, CTEX NO CWI CFG ERROR</strong></td>
<td>Car Top Exit, on the Safety tab, has been checked but Counter weight displacement detection, on the Car Operation - Earthquake tab, has not been checked. A car equipped with both Earthquake Operation and Cartop Exit must have a counterweight derailment device.</td>
<td>The car is not allowed to run until the problem is corrected.</td>
<td>1. Verify the status of the Car Top Exit parameter (Safety tab). 2. Verify the status of the Counter weight displacement detection parameter (Car Operation - Earthquake tab).</td>
</tr>
<tr>
<td><strong>Cartop Firmware Update Mode, CARTOP FW UPDATE MODE</strong></td>
<td>The cartop processor is not running the cartop application firmware but is instead either waiting for or processing the firmware update (iView &gt; File &gt; Firmware update).</td>
<td>The car is not allowed to run until the procedure is completed.</td>
<td></td>
</tr>
<tr>
<td><strong>Cartop Inspection Disabled, CT INSPI. DISABLED</strong></td>
<td>Cartop inspection operation has been disabled.</td>
<td>The car cannot be run on cartop inspection operation.</td>
<td>1. Check for any car status that might prevent cartop inspection operation, e.g. earthquake. 2. Check for the Stuck Inspection Input Fault. 3. Check all inspection buttons (Enable, Up, Down) and verify that none are stuck in the ON position.</td>
</tr>
</tbody>
</table>
Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cartop Inspection Enabled</strong></td>
</tr>
<tr>
<td>Description: Cartop inspection operation which was previously disabled is now enabled.</td>
</tr>
<tr>
<td><strong>Cartop Inspection Inputs OK</strong></td>
</tr>
<tr>
<td>Description: One or more previously stuck cartop inspection inputs (Enable, Up, Down) have been deactivated (see Stuck Cartop Inspection Input message).</td>
</tr>
<tr>
<td><strong>Cartop Inspection Operation, Cartop Inspection, Cartop Insp</strong></td>
</tr>
<tr>
<td>Description: The car has been placed in Inspection mode using the cartop inspection switch.</td>
</tr>
<tr>
<td>Car Reaction: The car enters inspection mode and uses the Inspection pattern settings.</td>
</tr>
<tr>
<td><strong>Cartop Inspection Unintended Motion Fault, CARTOP INSP UIM FLT</strong></td>
</tr>
<tr>
<td>Description: An unintended motion fault was detected while the car was being operated on Cartop Inspection Operation.</td>
</tr>
<tr>
<td>Car Reaction: Car motion stopped after 24 inches of travel. The safety circuit is opened.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Check the iView Event Log for related events.</td>
</tr>
<tr>
<td>2. Troubleshoot and correct any initiating problems.</td>
</tr>
<tr>
<td>3. Press iBox Fault Reset.</td>
</tr>
<tr>
<td>4. Test.</td>
</tr>
<tr>
<td><strong>Cartop Power Loss</strong></td>
</tr>
<tr>
<td>Description: A loss of power was detected by the iLink processor.</td>
</tr>
<tr>
<td>Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Check 1, 2, and 3 bus terminal voltages from iControl, through traveler, to car terminal strip.</td>
</tr>
<tr>
<td>2. Refer to job print drawing CT, check strip to iLink connections.</td>
</tr>
<tr>
<td>3. Check iLink fuses F1 and FCT1.</td>
</tr>
<tr>
<td><strong>CFSS Mode 1 at Floor Activated, CFSS 1 at Floor</strong></td>
</tr>
<tr>
<td>See CFSS Mode 1 In-car Activated.</td>
</tr>
<tr>
<td><strong>CFSS Mode 1 In-car Activated, CFSS 1 In-car</strong></td>
</tr>
<tr>
<td>Description: Commandeer For Special Services is a special operating mode. When activated by a (typically) keyed hall switch the car recalls to that floor. Two CFSS operating modes may be configured on the Car Operations screen/CFSS tab (Mode 1, Mode 2). Typically, one of the two is used for Hospital Operation, the second as the user determines. Once recall is activated, the car disposes of existing calls as configured on the CFSS tab, then moves to the recall floor. At the recall floor, In-Car CFSS is activated by an in-car switch or as configured on the CFSS tab (In-Car).</td>
</tr>
<tr>
<td>Car Reaction: As configured on the Car Operations screen/CFSS tab.</td>
</tr>
<tr>
<td><strong>CFSS Mode 1 Recall Activated, CFSS 1 Recall</strong></td>
</tr>
<tr>
<td>See CFSS Mode 1 In-car Activated.</td>
</tr>
<tr>
<td><strong>CFSS Mode 2 at Floor Activated, CFSS 2 at Floor</strong></td>
</tr>
<tr>
<td>See CFSS Mode 1 In-car Activated.</td>
</tr>
<tr>
<td><strong>CFSS Mode 2 In-car Activated, CFSS 2 In-car</strong></td>
</tr>
<tr>
<td>See CFSS Mode 1 In-car Activated.</td>
</tr>
<tr>
<td><strong>CFSS Mode 2 Recall Activated, CFSS 2 Recall</strong></td>
</tr>
<tr>
<td>See CFSS Mode 1 In-car Activated.</td>
</tr>
<tr>
<td><strong>Construction Car Panel Inspection Operation, Cnstr Car Panel Insp, Cnstr CP Insp</strong></td>
</tr>
<tr>
<td>Description: The car is on Construction mode and car panel inspection.</td>
</tr>
<tr>
<td>Car Reaction: Car is out of service and cannot be moved using the car panel inspection key switches.</td>
</tr>
<tr>
<td>Troubleshooting: When Construction mode is active, car panel operation switches are ignored. The car can only be moved using Machine Room or Cartop Inspection switches. Place the car on Machine Room or Cartop Inspection and use the appropriate switches to move the car.</td>
</tr>
</tbody>
</table>
Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Construction Cartop Inspection Operation, Cnstr Cartop Insp, Cnstr CT Insp</strong></td>
<td>Car is on Construction mode and Cartop Inspection. When the iBox is in construction mode, it is always &quot;on inspection.&quot; It will only operate in Cartop or Machine Room inspection. Car top has precedence over Machine Room, just as in Passenger operation. If neither of these two modes of operation are selected, the controller goes into a non-specific inspection mode. It will not run for any inspection direction input.</td>
<td>The car can be moved using the cartop inspection key switches.</td>
<td>1. If it appears that the car is on Cartop Inspection operation in error, verify wiring to the iBox INCT input. If no voltage exists on this input, the car will operate under Cartop Inspection operation.</td>
</tr>
<tr>
<td><strong>Construction Hoistway Access Inspection Operation, Cnstr HA Inspection, Cnstr HA Insp</strong></td>
<td>Car is on construction mode and hoistway access.</td>
<td>Car is out of service and cannot be moved using the hoistway access Up or Down switches.</td>
<td>When Construction mode is active, hoistway access switches are ignored. The car can only be moved using Machine Room or Cartop Inspection switches. Place the car on Machine Room or Cartop Inspection and use the appropriate switches to move the car.</td>
</tr>
<tr>
<td><strong>Construction Inspection Operation, Cnstr Inspection</strong></td>
<td>The car is operating in Inspection mode and the Construction setting on the Safety Configuration screen is selected.</td>
<td>The car will operate using the Inspection performance pattern using Cartop or machine room inspection modes only.</td>
<td></td>
</tr>
</tbody>
</table>
| **Construction Machine Room Inspection Operation, Cnstr Mach Room Insp, Cnstr MR Insp** | Car is on inspection mode using the iBox inspection switch while on construction mode.        | Car begins operating in Inspection mode. If running, the car will make an emergency stop and is taken out of normal service. Under this mode of operation, the car can be moved using the iBox Inspection Up and Down switches. | Troubleshooting:  
1. Related inputs:  
   MachineRoomInspection: Normally high                                                                                                                |
| **Controller Main Computer Startup**                                             | iBox main processor booting up.                                                                 |                                                                                               |                                                                                                                                            |
| **Demand Down Peak Mode, DEMAND DOWN PEAK MODE**                                | The car is running in Demand Down Peak mode, favoring traffic in the down direction as configured on the group control screens. |                                                                                               |                                                                                                                                            |
| ** Demand Up Peak Mode, DEMAND UP PEAK MODE**                                   | The car is running in Demand Up Peak mode, favoring traffic in the up direction as configured on the group control screens. |                                                                                               |                                                                                                                                            |
| **Dispatcher = Car ‘n’, DISPATCHER = CAR’n’ (n = 1 to 20)**                     | Communication with the main iCue dispatcher has been lost or not established. This car is communicating with Car ’n’ (n = 1 to 20) which is acting as the backup dispatcher. |                                                                                               | Troubleshooting: Check the group to car communication related connections and parameters.                                                                                                                      |
## Troubleshooting

### Door Lock Clipped Greater than 200fpm, DOOR LK CLIPPED G200

**Description:** The door lock signal (DLAT, DLMS, DLAB, or GS) went low for over 300mS while the car was moving at over 200 fpm.

**Car Reaction:** Emergency stop: Motor contactor and brake contactor immediately dropped.

**Troubleshooting:**
1. Use the Event Log to determine where the fault occurred. Examine the locks in that area of the hoistway first.
2. Usually caused by a misadjusted door, where the pickup rollers do not have adequate running clearance from the door clutch.
3. Because this fault must persist for over 300mS, a slight “bumping” of the door lock will not set it off. If the door clutch/pickup roller clearance is adequate, make sure the door contacts are clean and the door lock mechanism drops cleanly without friction or binding.

### Door Lock Clipped Less than 200fpm, DOOR LK CLIPPED L200

**Description:** The door lock signal (DLAT, DLMS, DLAB, or GS) went low while the car was moving at under 200 fpm.

**Car Reaction:** ASAP stop.

**Troubleshooting:**
1. Usually caused by a misadjusted or damaged door. Because it only occurs at speeds under 200 fpm, it is usually seen when the car leaves the floor where the problem door is located.

### DOOR LOCK OPENED

**Description:** This is a status message indicating that the safety processor has detected that the door lock is open. A fault is generated if the car is moving or attempts to move while the door lock is open.

### Down Direction Limit Open, DOWN DIR LIMIT OPEN

**Description:** Down normal terminal direction limit switch is open.

**Car Reaction:** Initiate an immediate stop if moving. Further down direction movement is prevented.

**Troubleshooting:**
1. Verify that the switch is operating properly.
2. Verify correct state of the iBox DNTD input.
3. Verify that DNTD switch is activating/deactivating at the appropriate location (normally 2” below the bottom terminal landing - see prints).

### Down Emergency Terminal Switch Position Fault, DN ETS POSITION FAULT

**Description:** The reported position encountered by the Terminal Switch differed from the learned switch position by more than the set position margin. This fault may be bypassed on the Diagnostics > Fault Bypass tab.

**Car Reaction:** Emergency Stop: Motor contactor and brake contactor immediately dropped. All hall and car calls are cancelled. After the car is stopped, it will run at Correction speed to the next available floor and cycle the door. Door Open button will remain operational. If fault generated when car is moving, fault will stay latched and the Fault Reset button must be pushed to clear it. If generated when the car is not moving, fault will self clear when condition no longer exists.

**Troubleshooting:**
1. Physically check the integrity of the switch and wiring.
2. Check the iBox input for the switch.
3. On the Diagnostics > Terminal Switches Status tab, compare the last pass position against the learned position for this switch. Verify that Position Margin is within a reasonable range. Relearn the NTS and ETS switches. **Please refer to ”Learning Normal & Emergency Terminal Limit Switches” on page 4-9.**

---

**Table 6.3 iControl Messages**

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Door Lock Clipped Greater than 200fpm, DOOR LK CLIPPED G200** | The door lock signal (DLAT, DLMS, DLAB, or GS) went low for over 300mS while the car was moving at over 200 fpm. | Emergency stop: Motor contactor and brake contactor immediately dropped.   | 1. Use the Event Log to determine where the fault occurred. Examine the locks in that area of the hoistway first.  
2. Usually caused by a misadjusted door, where the pickup rollers do not have adequate running clearance from the door clutch.  
3. Because this fault must persist for over 300mS, a slight “bumping” of the door lock will not set it off. If the door clutch/pickup roller clearance is adequate, make sure the door contacts are clean and the door lock mechanism drops cleanly without friction or binding. |

---

**DOOR LOCK OPENED**

**Description:** This is a status message indicating that the safety processor has detected that the door lock is open. A fault is generated if the car is moving or attempts to move while the door lock is open.

**Down Direction Limit Open, DOWN DIR LIMIT OPEN**

**Description:** Down normal terminal direction limit switch is open.

**Car Reaction:** Initiate an immediate stop if moving. Further down direction movement is prevented.

**Troubleshooting:**
1. Verify that the switch is operating properly.
2. Verify correct state of the iBox DNTD input.
3. Verify that DNTD switch is activating/deactivating at the appropriate location (normally 2” below the bottom terminal landing - see prints).

**Down Emergency Terminal Switch Position Fault, DN ETS POSITION FAULT**

**Description:** The reported position encountered by the Terminal Switch differed from the learned switch position by more than the set position margin. This fault may be bypassed on the Diagnostics > Fault Bypass tab.

**Car Reaction:** Emergency Stop: Motor contactor and brake contactor immediately dropped. All hall and car calls are cancelled. After the car is stopped, it will run at Correction speed to the next available floor and cycle the door. Door Open button will remain operational. If fault generated when car is moving, fault will stay latched and the Fault Reset button must be pushed to clear it. If generated when the car is not moving, fault will self clear when condition no longer exists.

**Troubleshooting:**
1. Physically check the integrity of the switch and wiring.
2. Check the iBox input for the switch.
3. On the Diagnostics > Terminal Switches Status tab, compare the last pass position against the learned position for this switch. Verify that Position Margin is within a reasonable range. Relearn the NTS and ETS switches. **Please refer to ”Learning Normal & Emergency Terminal Limit Switches” on page 4-9.**
Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Down Emergency Terminal Switch Shutdown, DOWN ETS SHUTDOWN</strong></td>
</tr>
<tr>
<td>Description: The Down Emergency Terminal switch opened at a speed or position exceeding its specified threshold. The fault stays latched and the Fault Reset button must be pushed to clear it. If generated when the car is stopped, the fault will self clear when the condition no longer exists.</td>
</tr>
<tr>
<td>Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
</tr>
<tr>
<td>Troubleshooting: 1. This fault is logged in conjunction with either a speed or position fault at DETS. Check the Event Log and follow the troubleshooting recommended for the Down Emergency Terminal Switch Position Fault or Safety A (or B) DETS Level 2 Speed Fault. 2. Press iBox Fault Reset to reset the fault.</td>
</tr>
</tbody>
</table>

| **Down Normal Terminal ’n’ Level 1 Speed Fault, DN NTS’n’ L1 SPEED FLT (n = 1 to 5)** |
| Description: A Level 1 Overspeed fault has been detected at Down Normal Terminal switch ’n’ (1 to 5). When the switch opened, the car was traveling faster than defined by level 1 overspeed settings (sum of learned speed plus Overspeed 1 Margin percentage on Configuration > Terminal Switches tab) but not fast enough to trigger the Level 2 overspeed fault. This fault may be bypassed on the Diagnostics > Fault Bypass tab. |
| Car Reaction: Controlled stop using Emergency Slowdown pattern parameters. |
| Troubleshooting: 1. On the Diagnostics > Terminal Switches Status tab, compare the last pass and the Learned speeds for this switch. If appropriate, increase the Overspeed 1 Margin on the Configuration > Terminal Switches tab. 2. May be caused by a change in the Pattern parameters. Always re-learn the terminal switches after any changes to Pattern parameters. 3. One or two floor runs can sometimes come in “hotter” than multi-floor runs. (Remember that the switches are learned making full hatch runs.) If short runs are causing this, you may have to increase the Overspeed 1 Margin or lower the Standard profile - High Roll Jerk parameter. 4. Can also be caused by a car that is following the pattern poorly, possibly due to heavy load or poor speed loop performance. In this case, adjust the speed loop to follow pattern as well as possible and/or alter the pattern parameters to produce a gentler deceleration and approach to the floor (then re-learn the switches). Please refer to “Learning Normal & Emergency Terminal Limit Switches” on page 4-9. |

| **Down Normal Terminal ’n’ Level 2 Speed Fault, DN NTS’n’ L2 SPEED FLT (n = 1 to 5)** |
| Description: A Level 2 Overspeed fault has been detected at Down Normal Terminal switch ’n’ (1 to 5). When the switch opened, the car was traveling faster than defined by Level 2 overspeed settings (105% of the sum of the learned speed plus the Overspeed 1 Margin percentage setting on the Configuration > Terminal Switches tab). This fault may be bypassed on the Diagnostics > Fault Bypass tab. |
| Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped. |
| Troubleshooting: 1. On the Diagnostics > Terminal Switches Status tab, compare the Last pass and Learn speeds for this switch. If appropriate, increase the Overspeed 1 Margin on the Configuration > Terminal Switches tab. 2. May be caused by a change in the Pattern parameters. Always re-learn the terminal switches after any changes to Pattern parameters. 3. One or two floor runs can sometimes come in “hotter” than multi-floor runs. (Remember that the switches are learned making full hatch runs.) If short runs are causing this, you may have to increase the Overspeed 1 Margin or lower the Standard profile - High Roll Jerk parameter. 4. Can also be caused by a car that is following the pattern poorly, possibly due to heavy load or poor speed loop performance. In this case, adjust the speed loop to follow pattern as well as possible and/or alter the pattern parameters to produce a gentler deceleration and approach to the floor (then re-learn the switches). Please refer to “Terminal Switch Overspeed and Position Faults” on page 4-54. |
# Troubleshooting

## Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Down Normal Terminal ’n’ Position Fault, DN NTS’n’ POSITION FLT (n = 1 to 5)</strong></td>
<td>When the switch opened or closed, the car’s reported position was different from the learned position by an amount exceeding the margin set on the Configuration &gt; Terminal Switches tab. This may mean that the switch opened early, late or not at all on approach to the terminal. It may also mean that the switch closed early, late, or not at all on departure from the terminal. Finally, the switch can go open while standing at a floor where its learned position is closed, or go closed at a floor where its learned position is open. This fault may be bypassed on the Diagnostics &gt; Fault Bypass tab.</td>
<td>If traveling down, the car executes an emergency slowdown, then continues at low speed until it encounters a floor. The car stops at the floor, opens its doors, and performs a floor sync operation. If the fault persists, the car goes out of service. If traveling up, the car continues normally to the first stop, opens its doors and performs a floor sync operation. If the fault persists, the car goes out of service. If stopped at a floor, the car opens its doors, does a floor sync, and, if the fault persists, takes itself out of service.</td>
<td>1. On the Diagnostics &gt; Terminal Switches Status tab, compare the Last pass position to the Learned position for this switch. 2. If the fault is mechanical (switch movement, magnet movement, or bad traveler cable), the fault will tend to repeat at the same position every time. 3. A stuck switch is easy to spot by running the car on inspection and observing the input LEDs on the iBox. 4. Perform a Terminal Sync operation (Terminal button on the Configuration &gt; Pattern &gt; Common tab).</td>
</tr>
<tr>
<td><strong>Drive At-Speed Fault, DRIVE AT-SPEED FAULT</strong></td>
<td>Detected by the drive, this fault indicates that the motor speed is outside threshold limits defined by the drive parameter. (This fault is not monitored for the TORQMAX F5 drive).</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
<td>1. If the job has a TORQMAX F5 drive and this fault occurs, verify that wires AT and GND (from iBox J46) are connected to drive terminal X2A-26 (Common).</td>
</tr>
<tr>
<td><strong>Drive Communication Fault, DRIVE COMM FAULT</strong></td>
<td>A fault is generated if a serial drive interface is selected (Controller &gt; Configuration &gt; Drive tab) and either the serial port cannot be opened or there is a communication problem with the drive.</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
<td></td>
</tr>
<tr>
<td><strong>Drive Communication Warning, DRIVE COMM WARNING</strong></td>
<td>Not currently used.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Drive Enable Feedback Fault, DRIVE ENABLE FDBK FLT</strong></td>
<td>iControl failed to send the Drive Enable signal to the drive or the drive failed to respond to the Drive Enable signal. (applies to both AC and DC drives).</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped. Followed by normal run. Fault will self clear and car is able to run again.</td>
<td>1. This fault may indicate a problem with the Gate Switch, or one of the door locks, opening up during the initial start of car motion. Verify that the inputs (GS, DLAT, DLAB, DLMS) remain high. 2. Verify that Safety Processors A and B are looping (iBox status LEDs). 3. Verify that there are no faults active on Safety Processors A and B that would prevent motion. 4. Check the iBox power supply. 5. Verify that all drive connections match wiring prints.</td>
</tr>
</tbody>
</table>

---

Table 6.3 iControl Messages
### Table 6.3  iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Drive Fault, DRIVE FAULT**                           | Detected by the drive, indicates motor speed is outside threshold limits defined by drive parameter. (TORQMAX drive only.) | Emergency stop: Motor contactor and brake contactor immediately dropped.       | 1. Verify encoder wiring and polarities.  
2. Check F5 drive terminals X2A-29 (Drive Fault) to X2A-26 (Common). The value should be high during normal operation and low during a fault condition.  
3. Verify that the brake is working correctly.  
4. Verify drive gains, Proportional Gain (LF.31) and Integral Gain (LF.32).  
5. Check drive parameters, Speed Following Error (LF.57), Speed Difference (LF.58), and Following Error Timer (LF.59). Refer to the TORQMAX manual. |
| **Drive Inspection Overspeed Fault, DRIVE IOS FAULT**  | Inspection Overspeed fault.                                                 | Emergency stop.                                                               | 1. Check Inspection speed.  
2. Check safety configuration.  
3. Calibrate car speed with a hand-held tachometer.                                                                 |
| **Drive On Fault, DRIVE ON FAULT (was Drive Ready On Fault)** | Drive failed to activate DRO signal when it was sent command to run (TORQMAX drives only). | Emergency stop: Motor contactor and brake contactor immediately dropped.       | 1. Check for fault messages on the F5 drive display and refer to Error Messages and Their Causes in the TORQMAX manual for suggested solutions.  
2. Check the state of the F5 drive inputs by displaying diagnostic parameter LF.82. Refer to the LF.82 input state table in the TORQMAX F5 drive manual.  
3. Check for proper operation of the PM contactor main contacts.  
4. Verify that the cable from the F5 drive to the PowerBox (46 pin D-sub) is properly seated.  
5. Then verify that the cable that extends to the iBox (AC/DC Drive jack) is properly seated. If the cable inside the PowerBox is suspect, temporarily connect directly from the F5 drive into the iBox.  
6. Verify that Brake Pick Delay is set correctly (0.3 or higher) to allow the motor to build up torque.  
7. Verify that F5 drive parameter LF.70 = 0.3.  
8. If the DRO fault is accompanied by a Tach Error Fault, this usually indicates improper adjustment of the TACH ADJ trimpot (Please refer to ”Verify Pattern Command and Drive Speed Feedback” on page 2-55).  
9. On iView, display the Controller > Diagnostics > Diagnostic Outputs > Drive screen and verify that the commands are being sent from the iBox to the TORQMAX drive. |
| **Drive Ready Fault, DRIVE READY FAULT**               | AC drive ready signal is low. (TORQMAX drive only.)                         | Emergency stop: Motor contactor and brake contactor immediately dropped.       | 1. Check F5 drive terminal X2A-24 to X2A-26 (Common). X2A-24 should be low during normal operation and high during fault.  
2. Check connection from AC drive to iPower Box and J46 connector on ICE-SAF board.                                                                 |
| **Drive Start Failure**                                | The drive control logic has not responded to a movement request from the motion control logic for more than ten seconds. | The motion control logic will continue to request movement from the drive logic for up to ten seconds before declaring a Motion Start Failure fault. | Verify that no drive or motor faults exist. |
Troubleshooting

Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| Dual Channel QUAD Fault, DUAL CHANNEL QUAD FLT | The Safety system did not detect movement of the car even though the iBox processor reported car movement, or the Safety system reported car movement while the processor did not. | Emergency stop: Motor contactor and brake contactor immediately dropped. | 1. Press the Fault Reset button.  
2. Check the wiring for the DP1 and DP2 encoder signals from the landing system to the iBox.  
3. Check the motor encoder or tachometer (whichever is present).  
4. Compare Pattern Command and Speed Feedback on the iView oscilloscope screen to make certain they track one another.  
5. Check reported speed accuracy using a hand-held tachometer. |
| Earthquake board power supply OFF | The controller has detected a failure of the earthquake board power supply. | The car behaves as if the counterweight derailment detector has been triggered (car generally makes an emergency stop, and is removed from service at the next available landing). | 1. Check board connections.  
2. Replace the EQ board. |
| Earthquake board power supply ON | The earthquake board (ICE-EQ) power supply is operational. | Car is no longer prevented from operating due to a loss of the earthquake board power supply. |  
| Earthquake Emergency Stop | Earthquake operation has been activated by the seismic or counterweight displacement switches and the car has performed an emergency stop as specified by the earthquake user settings. | The car will perform an emergency stop. After a pause, the car will react as directed by user settings on the Car Operation screen Earthquake tab. | 1. Check the wiring for the seismic and counterweight displacement inputs.  
2. Check the earthquake user settings on the Car Operation screen Earthquake tab. |
| Earthquake Operation Activated | The car is on earthquake operation. | Car behavior is according to the user settings on the Car Operation screen Earthquake tab. This operation is latched until the EQ reset button is pressed on the ICE-EQ board. | NA. See also “Earthquake Operation (Seismic Switch)” and “Earthquake Operation (Counterweight)”. |
| Earthquake Operation Deactivated | The Counterweight Derailment Detector has been activated, indicating an earthquake condition. | The car will typically make an emergency stop, then move slowly to the next available floor in a direction away from the counterweight. The fault is latched until the EQ reset button (ICE-EQ board) is pressed. | 1. If it is suspected that this event happened in error, check the counterweight derailment detector operation and associated wiring to the ICE-EQ board. |
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th><strong>Earthquake Operation (Seismic Switch)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Description: The Seismic Switch has been activated (input has gone low), indicating an earthquake condition.</td>
</tr>
<tr>
<td>Car Reaction: The car will react as determined by user configuration. (iView/Car Operation/Earthquake) The car will either make an emergency stop and then move slowly to the next available floor or it will stop normally at the next available floor in the direction of travel. The fault is latched until the EQ reset button (ICE-EQ board) is pressed.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. If it is suspected that this event happened in error check the seismic switch input and the associated wiring to the ICE-EQ board. The seismic input is normally on.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Earthquake Reduce Speed</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Description: An earthquake event (seismic switch) has initiated a car speed reduction (150 fpm or less) as required by some code jurisdictions.</td>
</tr>
<tr>
<td>Car Reaction: Control stop.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Earthquake reset button OK</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Description: A previously declared failure of the earthquake reset button has been resolved.</td>
</tr>
<tr>
<td>Car Reaction: Previous failure is no longer a reason to keep the car out of service.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Earthquake reset button stuck ON</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Description: The controller has detected that the earthquake reset button (located on the ICE-EQ board) has failed in the “on” state.</td>
</tr>
<tr>
<td>Car Reaction: If moving, the car will complete its run. Once stopped, the car is removed from service.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. It is likely that the reset button (or related circuitry) on the ICE-EQ board is faulty.</td>
</tr>
<tr>
<td>2. Replace the ICE-EQ board.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Earthquake Run, EARTHQUAKE RUN</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Description: Some code jurisdictions allow the car to run normally (at a speed no greater than 150 fpm) under earthquake conditions. This event indicates that the car is being allowed to run in this manner.</td>
</tr>
<tr>
<td>Car Reaction: Car operates “normally” at reduced speed.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Check the wiring for the seismic and counterweight displacement inputs.</td>
</tr>
<tr>
<td>2. Check the earthquake user settings on the Car Operation screen Earthquake tab.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Earthquake Shutdown, EARTHQUAKE SHUTDOWN</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Description: Safety Processor A EEPROM fault.</td>
</tr>
<tr>
<td>Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Verify Safety Processor A EEPROM - board test. Contact MCE.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Elevator Recall Operation (Switch ‘n’), ELEVATOR RECALL SW’n’ (n = 1 to 6)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Description: Elevator Recall Operation has been initiated by the switch identified.</td>
</tr>
<tr>
<td>Car Reaction: In most usages, the car immediately removes itself from hall call service, answers remaining car calls, then proceeds to the recall floor and cycles its doors. (The disposition of car calls, recall floor, and door operation are user-programmable. iView/Car Operation/Elevator Recall.)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Emergency Alarm Acknowledged</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Description: This message indicates that the emergency alarm has been acknowledged and reset by the Emergency Alarm Reset input.</td>
</tr>
<tr>
<td>Car Reaction: The Distress Light and the Distress Buzzer outputs will be extinguished.</td>
</tr>
<tr>
<td>Troubleshooting: NA</td>
</tr>
</tbody>
</table>
## Troubleshooting

### iControl Messages

<table>
<thead>
<tr>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Emergency Alarm Activated (Alarm button), Emergency Alarm Activated, EMERG ALARM ACTIVATED** | Distress Light illuminated until acknowledged by Emergency Alarm Reset input. Distress buzzer output will either pulse or be continuously activated as long as the car remains in this condition. | 1. Attend to the car and verify the distress signal.  
2. To reset the alarm, verify that the alarm button is restored to normal condition and activate the Emergency Alarm Reset input. |
| **Emergency Alarm Activated (Car delayed with doors closed)** | The Distress Light will be illuminated until it is acknowledged by the Emergency Alarm Reset input. The Distress Buzzer output will be active as long as the car remains in this condition. | 1. Attend to the car and verify the distress signal.  
2. To reset alarm, verify car condition restored to normal and activate Emergency Alarm Reset input. |
| **Emergency Alarm Activated (In-car stop switch)** | The Distress Light will be illuminated until it is acknowledged by the Emergency Alarm Reset input. The Distress Buzzer output will be active as long as the switch remains active. | 1. Attend to the car and verify the distress signal.  
2. To reset the alarm, verify that the car emergency stop switch is restored to normal position and activate the Emergency Alarm Reset input. |
| **Emergency Alarm Activated (Safety opened)** | The Distress Light and Distress Buzzer outputs are deactivated. | 1. Attend to the car and verify the distress signal.  
2. To reset the alarm, verify that the car condition is restored to normal and activate the Emergency Alarm Reset input. |
| **Emergency Alarm Deactivated without Acknowledgment** | The Distress Light and Distress Buzzer outputs are deactivated. | 1. Attend to the car and verify the distress signal.  
2. To reset the alarm, verify that the car condition is restored to normal and activate the Emergency Alarm Reset input. |
| **Emergency Brake Leg 1 Short Fault, EMERG BRK LEG 1 SHORT** | Emergency stop. | 1. Verify system configured for emergency brake board (ICE-RG or ICE EB).  
2. Make sure the emergency brake board is physically present and correctly connected. |

### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Emergency Alarm Activated (Alarm button), Emergency Alarm Activated, EMERG ALARM ACTIVATED** | Emergency Alarm input activated. Typically used to sound alarm and/or illuminate an indicator light to alert security personnel. | Distress Light illuminated until acknowledged by Emergency Alarm Reset input. Distress buzzer output will either pulse or be continuously activated as long as the car remains in this condition. | 1. Attend to the car and verify the distress signal.  
2. To reset the alarm, verify that the alarm button is restored to normal condition and activate the Emergency Alarm Reset input. |
| **Emergency Alarm Activated (Car delayed with doors closed)** | Emergency alarm activated due to car delayed with doors closed. This is an optional emergency alarm monitor specified by the user. | The Distress Light will be illuminated until it is acknowledged by the Emergency Alarm Reset input. The Distress Buzzer output will be active as long as the car remains in this condition. | 1. Attend to the car and verify the distress signal.  
2. To reset alarm, verify car condition restored to normal and activate Emergency Alarm Reset input. |
| **Emergency Alarm Activated (In-car stop switch)** | This message indicates that the emergency alarm has been activated due to the in-car emergency stop switch being pulled. | The Distress Light will be illuminated until it is acknowledged by the Emergency Alarm Reset input. The Distress Buzzer output will be active as long as the switch remains active. | 1. Attend to the car and verify the distress signal.  
2. To reset the alarm, verify that the car emergency stop switch is restored to normal position and activate the Emergency Alarm Reset input. |
| **Emergency Alarm Activated (Safety opened)** | This message indicates that the emergency alarm has been activated due to the safety circuit being opened (excluding the in-car emergency stop switch). This is an optional emergency alarm monitor specified by the user. | The Distress Light will be illuminated until it is acknowledged by the Emergency Alarm Reset input. The Distress Buzzer output will be active as long as the car remains in this condition. | 1. Attend to the car and verify the distress signal.  
2. To reset the alarm, verify that the car condition is restored to normal and activate the Emergency Alarm Reset input. |
| **Emergency Alarm Deactivated without Acknowledgment** | This message indicates that the emergency alarm has been deactivated because all signals that would activate it are now off and the Require Acknowledgment parameter is not checked. | The Distress Light and Distress Buzzer outputs are deactivated. | 1. Attend to the car and verify the distress signal.  
2. To reset the alarm, verify that the car condition is restored to normal and activate the Emergency Alarm Reset input. |
| **Emergency Brake Leg 1 Short Fault, EMERG BRK LEG 1 SHORT** | Emergency brake board (ICE RB or ICE EB) verification failed after a stop or as a result of a fault reset. During these scenarios, the emergency brake circuitry is verified by transitioning between leg 1 and leg 2. One of the legs must be active to prevent the emergency brake from deploying. | Emergency stop. | 1. Verify system configured for emergency brake board (ICE-RG or ICE EB).  
2. Make sure the emergency brake board is physically present and correctly connected. |
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Emergency Brake Leg 2 Short Fault, EMERG BRK LEG 2 SHORT</strong></td>
<td>See Emergency Brake Leg 1 Short Fault.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| **Emergency Brake OK open, EMERG BRAKE OK OPEN**                                  | Description: The Emergency Brake OK input has dropped (off) when the configuration states that the brake is installed and therefore the input should be picked (on). | Emergency stop if running. The car is not allowed to run until the problem is corrected. | 1. Verify that the Rope Gripper board is properly installed, connected, and powered.  
2. If this job has a sheave brake, verify that the associated circuitry is per the job prints. |
| **Emergency Brake OK open Off** (See: Emergency Brake OK open)                    |                                                                                                         |                                     |                                                                                                       |
| **Emergency Brake Tripped, EMERG BRAKE TRIPPED**                                  | Description: The emergency brake output (ICE RG or ICE-EB board) has gone low, causing the emergency brake to set. | Emergency stop.                     | 1. Check that the output did not go low in error and is properly connected.  
2. Check the elevator for underlying causes.                                        |
| **Emergency Brake UIM Reset Button Stuck, EM BK UIM RESET STUCK**                 | Description: The reset button on the Rope Gripper board (ICE-RG) or Emergency Brake board (ICE-EB) has been activated for more than 15 seconds. | The car is not allowed to move. If in motion, the car is allowed to finish the run. | Check the reset button on the ICE-RG or ICE-EB board.                                                 |
| **Emergency Dispatch On, Emergency Dispatch, EMERGENCY DISPATCH**                 | Description: The car is automatically servicing the building in a pre-defined pattern. This operation is invoked when a failure of the hall calls bus or group communication is detected. This operation may also be activated using a key switch input. | The car automatically moves to every floor in the building in a predefined pattern and cycles its doors. | 1. Check group/car communications.  
2. Check the hall call bus drivers.  
3. Check the Emergency Dispatch input.                                                |
| **Emergency Dispatch Off** (see Emergency Dispatch On)                            |                                                                                                         |                                     |                                                                                                       |
| **Emergency Medical Service Bypassed**                                            | Description: EMS is active but has been bypassed by another mode of operation.                         | Car is returned to prevailing mode of operation. | Check the current mode of operation and the EMS user settings.                                       |
| **Emergency Medical Service Deactivated**                                         | Description: EMS has been deactivated.                                                                 |                                     | NA                                                                                                   |
## Troubleshooting

### Emergency Medical Service In-Car Activated (Switch 'n'), EMS In-car (Switch 'n') (n = 1 or 2)

**Description:** EMS In-Car service is activated via the in-car EMS key-switch. This is also referred to as the EMS Phase II operation.

**Car Reaction:** The car remains out of hall call service. Car calls are enabled again and the car can be dispatched from inside the car with car calls only. After answering a car call, doors will open automatically and close with constant pressure on the Door Close Button only.

**Troubleshooting:**
1. The EMS In-Car can be terminated by taking the car to the EMS recall floor by registering a car call then deactivating the in-car EMS switch.
2. The In-Car operation can also be terminated by simply removing the in-car EMS switch from the pre-programmed IO configuration.
3. Related inputs:
   - EMSCarSwitch0: Normally low
   - EMSCarSwitch1: Normally low

### Emergency Medical Service Recall Activated (Switch 'n'), EMS Recall (Switch 'n') (n = 1 or 2)

**Description:** EMS recall is activated via one of the EMS recall key-switches located next to the designated EMS elevator. This is also referred to as the EMS Phase I operation.

**Car Reaction:** Momentary activation of the EMS recall switch will initiate a recall to the user-defined EMS Recall floor. The car removes itself from car and hall call service. Once at the EMS recall floor, the door operation is in accordance to the user-defined door operation under EMS recall operation. The car will remain on EMS Phase I as long as the hall switch is activated. Once the hall switch is deactivated, the car will return to normal operation upon expiration of a user-defined timer if the in-car switch is not activated within that time.

**Troubleshooting:**
1. Verify that none of the hall EMS recall switches is activated.
2. The EMS Recall operation can also be terminated by simply removing the in-car EMS switch from the pre-programmed IO configuration.
3. Related inputs:
   - EMSHallSwitch0: Normally low
   - EMSHallSwitch1: Normally low

### Emergency Power Activated

**Description:** Commercial power has been lost and power is now supplied by an emergency power generator.

**Car Reaction:** The car will make an emergency stop due to the momentary loss of power and will remain shut down until commanded to either lower to a pre-determined floor or proceed to the next available floor. Once all cars have reached a floor, one or more cars will be selected to run under the emergency power generator.

**Troubleshooting:**
1. Related inputs:
   - EPI: Active level field adjustable.

### Emergency Power and no communication with group, EMERG PWR NO COMM

**Description:** iControl has detected that an emergency power condition exists and it has not established communication with the emergency power supervisor (typically a group controller).

**Car Reaction:** The car is not allowed to move to prevent overloading the emergency power generator. If the car is moving when the event occurs, the car will make an emergency stop. Motor contactor and brake contactor are immediately dropped. The car is also shut down (calls and all other demands are canceled).

**Troubleshooting:**
1. If this condition exists and the system is NOT operating under emergency power, refer to the job prints and verify wiring to the controller Emergency Power status input.
2. Verify correct input state (high/low) on iView/Car Operation/Emergency Power/EPI Input setting.
3. Check group to car communication.

---

### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Emergency Medical Service In-Car Activated (Switch 'n'), EMS In-car (Switch 'n') (n = 1 or 2)</strong></td>
<td>EMS In-Car service is activated via the in-car EMS key-switch. This is also referred to as the EMS Phase II operation.</td>
<td>The car remains out of hall call service. Car calls are enabled again and the car can be dispatched from inside the car with car calls only. After answering a car call, doors will open automatically and close with constant pressure on the Door Close Button only.</td>
<td>1. The EMS In-Car can be terminated by taking the car to the EMS recall floor by registering a car call then deactivating the in-car EMS switch. 2. The In-Car operation can also be terminated by simply removing the in-car EMS switch from the pre-programmed IO configuration. 3. Related inputs: EMSCarSwitch0: Normally low EMSCarSwitch1: Normally low</td>
</tr>
<tr>
<td><strong>Emergency Medical Service Recall Activated (Switch 'n'), EMS Recall (Switch 'n') (n = 1 or 2)</strong></td>
<td>EMS recall is activated via one of the EMS recall key-switches located next to the designated EMS elevator. This is also referred to as the EMS Phase I operation.</td>
<td>Momentary activation of the EMS recall switch will initiate a recall to the user-defined EMS Recall floor. The car removes itself from car and hall call service. Once at the EMS recall floor, the door operation is in accordance to the user-defined door operation under EMS recall operation. The car will remain on EMS Phase I as long as the hall switch is activated. Once the hall switch is deactivated, the car will return to normal operation upon expiration of a user-defined timer if the in-car switch is not activated within that time.</td>
<td>1. Verify that none of the hall EMS recall switches is activated. 2. The EMS Recall operation can also be terminated by simply removing the in-car EMS switch from the pre-programmed IO configuration. 3. Related inputs: EMSHallSwitch0: Normally low EMSHallSwitch1: Normally low</td>
</tr>
<tr>
<td><strong>Emergency Power Activated</strong></td>
<td>Commercial power has been lost and power is now supplied by an emergency power generator.</td>
<td>The car will make an emergency stop due to the momentary loss of power and will remain shut down until commanded to either lower to a pre-determined floor or proceed to the next available floor. Once all cars have reached a floor, one or more cars will be selected to run under the emergency power generator.</td>
<td>1. Related inputs: EPI: Active level field adjustable.</td>
</tr>
<tr>
<td><strong>Emergency Power and no communication with group, EMERG PWR NO COMM</strong></td>
<td>iControl has detected that an emergency power condition exists and it has not established communication with the emergency power supervisor (typically a group controller).</td>
<td>The car is not allowed to move to prevent overloading the emergency power generator. If the car is moving when the event occurs, the car will make an emergency stop. Motor contactor and brake contactor are immediately dropped. The car is also shut down (calls and all other demands are canceled).</td>
<td>1. If this condition exists and the system is NOT operating under emergency power, refer to the job prints and verify wiring to the controller Emergency Power status input. 2. Verify correct input state (high/low) on iView/Car Operation/Emergency Power/EPI Input setting. 3. Check group to car communication.</td>
</tr>
</tbody>
</table>
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Emergency Power Deactivated.** See Emergency Power Activated.  
Description: This event is logged when commercial power is restored. | | 1. Related inputs:  
   - EPI: Active level field adjustable. |
| **Emergency Power Recall, EMERG POWER RECALL.** See Emergency Power Activated.  
Description: This event is logged when the elevator has been commanded to lower to the emergency power recall floor.  
Car Reaction: The elevator proceeds to the user-defined emergency power recall floor. Door operation at the recall floor is in accordance with the user defined door operation under emergency power recall conditions. | | 1. Related inputs:  
   - EPR: Normally low (high to lower the car)  
   - PTR: Normally low (low to lower the car) |
| **Emergency Power Run, EMERG POWER RUN.** See Emergency Power Activated.  
Description: This elevator is allowed to respond to calls during emergency power operation. | | 1. Related inputs (only on elevators with emergency power overlay operation):  
   - EPR: Normally low (low to run the car)  
   - PTR: Normally low (low to run the car) |
| **Emergency Power Shutdown, EMERG POWER SHUTDOWN.** See Emergency Power Activated.  
Description: This event is logged when emergency power is initially activated or if communication with the emergency power supervisor has been lost while on emergency power.  
Car Reaction: Emergency stop. Car removed from service. | | 1. Related inputs:  
   - EPI: Active level field adjustable. |
| **Emergency Stop Input Activated, EMERGENCY STOP INPUT**  
Description: The events are logged and related car status messages displayed on the OBD and iView to reflect the status of the Emergency Stop Input.  
Car Reaction: When the Emergency Stop Input is activated, the car makes an emergency stop and cancels all calls. This input has priority over all modes of operation including Fire Service.  
Troubleshooting: Check the status of the Emergency Stop Input. | |  |
| **Emergency Stop Input Deactivated** see Emergency Stop Input Activated. | |  |
| **Excessive Brake Feedback Fault, EXCESS BRAKE FDBK FLT**  
Description: After each brake activity, the controller checks to see that brake current is bleeding off properly. (After 1 second, brake voltage should be at or below 85% of the voltage applied by the last command.) This fault is issued if brake voltage remains too high when checked by the controller.  
Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped. | | 1. From the factory, RB (brake resistor circuit value) is set 3 to 5 times the brake coil resistance. Reduce RB to allow current to bleed off more quickly. (Do not reduce RB below 3 times brake coil resistance.) Please refer to “Verifying Brake Current Resistance” on page 2-20.  
2. On the iView Brake screen, Timers tab, reduce Voltage Decay Time (minimum, 0.0 seconds).  
3. Check Brake Voltage Feedback test point on iView Oscilloscope screen.  
4. Check iField Brake Module connections.  
5. Check brake and brake connections.  
6. If you continue to see this fault after taking the above steps, you may have a defective brake module or iBox Safety board. |
## Troubleshooting

### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Excessive Faults Shutdown, EXCESSIVE FAULTS</strong></td>
<td>Description: When there are five faults that resulted in an Emergency, Control, or ASAP stop within ten normal runs, this fault is generated.</td>
</tr>
<tr>
<td></td>
<td>Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped. This is a latching fault. The Fault Reset button on the iBox must be pressed to clear it.</td>
</tr>
<tr>
<td></td>
<td>Troubleshooting: 1. Check Event Log to see what drive faults were generated before this fault was triggered. Refer to those drive faults for troubleshooting information.</td>
</tr>
<tr>
<td><strong>Excessive Motor Field Feedback Fault, EXCESS MF FDBK FAULT</strong></td>
<td>Description: Excessive current was detected flowing through the motor field. Threshold is set to 85% of forcing current for more than 4 seconds. If the fault is recurring, excessive faults will be generated and the motor field module will be disabled.</td>
</tr>
<tr>
<td></td>
<td>Car Reaction: Emergency Stop.</td>
</tr>
<tr>
<td></td>
<td>Troubleshooting: Problem may be related to faulty motor field module, faulty iBox, or invalid motor field calibration. 1. If excessive faults (fault) has been generated, the module is disabled and should not be outputting any voltage. If this is not the case, there may be a problem with the motor field module. 2. Calibrate the motor field. During calibration, the current and voltage should start at their maximum value and decrease as calibration proceeds. If this is not the case, there may be a problem with the iBox.</td>
</tr>
<tr>
<td><strong>Excessive Relevels Fault, EXCESS RELEVELS FAULT</strong></td>
<td>Description: The car has failed to relevel after ten attempts.</td>
</tr>
<tr>
<td></td>
<td>Car Reaction: Cancel all calls and shutdown. The doors are cycled and the car remains shutdown until the fault is reset by pressing the iBox Fault Reset button, toggling Inspection or cycling power to the controller.</td>
</tr>
<tr>
<td></td>
<td>Troubleshooting: 1. Check for mechanical or other failure preventing proper releveling. 2. Adjust brake and motor control during releveling with a full load in the car.</td>
</tr>
<tr>
<td><strong>Excessive Restarts Fault, EXCESS RESTARTS FAULT</strong></td>
<td>Description: The elevator has attempted to start movement from the same floor successively for an excessive number of times. This fault is issued after twenty-five attempts. The counter is reset if the car makes one successful run.</td>
</tr>
<tr>
<td></td>
<td>Car Reaction: Cancel all calls and shutdown. The doors are cycled and the car remains shutdown for five minutes after the first fault or until the fault is reset by pressing the iBox Fault Reset button, toggling Inspection or cycling power to the controller.</td>
</tr>
<tr>
<td></td>
<td>Troubleshooting: 1. Check for mechanical or other failure preventing car from moving away from floor the floor.</td>
</tr>
<tr>
<td><strong>Excessive Restarts Warning</strong></td>
<td>Description: The elevator has attempted to start movement from the same floor successively for an excessive number of times. This fault is issued after ten attempts. The counter is reset if the car makes one successful run.</td>
</tr>
<tr>
<td></td>
<td>Car Reaction: None.</td>
</tr>
<tr>
<td></td>
<td>Troubleshooting: 1. Check for mechanical or other failure preventing car from moving away from floor the floor.</td>
</tr>
<tr>
<td><strong>Exercise Operation Activated, EXERCISE OPERATION</strong></td>
<td>Description: The car has been idle for a predetermined user-defined time and is now performing a user-defined number of Exercise operation runs.</td>
</tr>
<tr>
<td></td>
<td>Car Reaction: The car lowers to the bottom landing, then proceeds to the top landing and back down to the bottom landing without cycling the doors. Moving the car to the top landing and then back down to the bottom landing is considered one exercise run. The user defines the number of exercise runs.</td>
</tr>
</tbody>
</table>
## Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>Message Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Exercise Operation Deactivated</strong></td>
<td>Description: The car has completed all of the exercise runs or Exercise operation has been terminated due to change in mode of operation or calls being entered into the system.</td>
<td></td>
</tr>
<tr>
<td><strong>Fault Bypass Switch On, FAULT BYPASS SW ON</strong></td>
<td>Description: The iBox Fault Bypass switch is in the ON position.</td>
<td></td>
</tr>
<tr>
<td><strong>Fault Bypass Switch Timed Out, FLT BYP SW TIMED OUT</strong></td>
<td>Description: Indicates that a fault bypass has timed out. (Bypasses are allowed for 15 minutes with the iBox Fault/Function Bypass switch in the ON position.)</td>
<td>Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
</tr>
<tr>
<td><strong>Field Module Over Temperature Fault, FIELD MODULE OVR TEMP</strong></td>
<td>Description: The temperature of the Motor Field module heat sink is excessive (DC only).</td>
<td>1. To clear this fault, place the Fault/Function Bypass switch to the OFF position.</td>
</tr>
<tr>
<td><strong>Fire Service In-car Activated, Fire Service In-car, Fire Svc In-car</strong></td>
<td>Description: In-car firefighters service has been activated via the in-car fire service key-switch.</td>
<td>2. Verify air enters at bottom of power box and is only expelled via fan at the top of the power box.</td>
</tr>
<tr>
<td><strong>Fire Service In-car Deactivated</strong></td>
<td>Description: In-car firefighter’s service has been deactivated.</td>
<td>3. Check for insufficient air circulation through the power box.</td>
</tr>
<tr>
<td><strong>Fire Service In-car Hold Operation</strong></td>
<td>Description: Car is on in-car firefighter hold operation.</td>
<td>4. Check the running temperature inside the power box (should not exceed 105 degrees F).</td>
</tr>
<tr>
<td><strong>Fire Service In-car Recall Operation</strong></td>
<td>Description: A car on in-car firefighter operation is being recalled to the designated fire recall floor.</td>
<td>5. Check for faulty field module.</td>
</tr>
<tr>
<td><strong>Fire Service In-car Deactivated</strong></td>
<td>Description: Car is returned to prevailing mode of operation.</td>
<td>6. Check for faulty iBox.</td>
</tr>
<tr>
<td><strong>F DPM OPEN-GS CLOSED</strong></td>
<td>See Front DPM Open - GS Closed.</td>
<td>7. Check for faulty connection between motor field module and iBox.</td>
</tr>
<tr>
<td><strong>F DR CLS FLT REC FAIL</strong></td>
<td>See Front Door Close Fault Recovery Failure</td>
<td></td>
</tr>
<tr>
<td><strong>Troubleshooting:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Related inputs:</strong></td>
<td>FireIIOn: Normally low</td>
<td></td>
</tr>
<tr>
<td><strong>Fire Service In-car Hold Operation</strong></td>
<td>FireIIOff: Normally high</td>
<td></td>
</tr>
<tr>
<td><strong>Fire Service In-car Recall Operation</strong></td>
<td>FireIIHold: Normally low</td>
<td></td>
</tr>
<tr>
<td><strong>Fire Service In-car Deactivated</strong></td>
<td><strong>Troubleshooting:</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Fire Service In-car Hold Operation</strong></td>
<td>1. Check the in-car firefighter switch status and Fire II hold operation user settings.</td>
<td></td>
</tr>
<tr>
<td><strong>Fire Service In-car Recall Operation</strong></td>
<td><strong>Troubleshooting:</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Fire Service In-car Deactivated</strong></td>
<td>1. Check the in-car firefighter switch status and Fire II operation user settings.</td>
<td></td>
</tr>
</tbody>
</table>

---

### Exercises

**Exercise Operation Deactivated**
- **Description:** The car has completed all of the exercise runs or Exercise operation has been terminated due to change in mode of operation or calls being entered into the system.
- **Car Reaction:** None.

**Fault Bypass Switch On, FAULT BYPASS SW ON**
- **Description:** The iBox Fault Bypass switch is in the ON position.
- **Car Reaction:** None.

**Fault Bypass Switch Timed Out, FLT BYP SW TIMED OUT**
- **Description:** Indicates that a fault bypass has timed out. (Bypasses are allowed for 15 minutes with the iBox Fault/Function Bypass switch in the ON position.)
- **Car Reaction:** Emergency stop: Motor contactor and brake contactor immediately dropped.
- **Troubleshooting:**
  1. To clear this fault, place the Fault/Function Bypass switch to the OFF position.

**Field Module Over Temperature Fault, FIELD MODULE OVR TEMP**
- **Description:** The temperature of the Motor Field module heat sink is excessive (DC only).
- **Car Reaction:** Stop at the next floor. Restart not permitted.
- **Troubleshooting:**
  1. Check machine room temperature (should not exceed 104 degrees F or 40 degrees C).
  2. Verify air enters at bottom of power box and is only expelled via fan at the top of the power box.
  3. Check for insufficient air circulation through the power box.
  4. Check the running temperature inside the power box (should not exceed 105 degrees F).
  5. Check for faulty field module.
  6. Check for faulty iBox.
  7. Check for faulty connection between motor field module and iBox.

**Fire Service In-car Activated, Fire Service In-car, Fire Svc In-car**
- **Description:** In-car firefighters service has been activated via the in-car fire service key-switch.
- **Car Reaction:** Car/Door operation according to user-defined fire code. (iView/Car Operation/Fire Service.)
- **Troubleshooting:**
  1. Related inputs:
     - FireIIOn: Normally low
     - FireIIOff: Normally high
     - FireIIHold: Normally low
Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Fire Service Recall Alternate, Fire Recall Alternate, Fire Recall Alt.</strong></td>
<td>Description: Fire recall to the alternate fire floor has been initiated.</td>
<td>Car proceeds to the user-defined alternate fire recall floor. Once at the recall floor, door operation is according to the user-defined door operation under fire recall operation.</td>
<td>Troubleshooting: 1. If in error, inspect the fire sensor and switch inputs and connections. 2. Related Inputs: Smoke sensors and fire recall switches as indicated on the job prints.</td>
</tr>
<tr>
<td><strong>Fire Service Recall Main, Fire Recall Main, Fire Recall Main</strong></td>
<td>Description: Fire recall to the main fire floor has been initiated.</td>
<td>Car proceeds to the user-defined main fire recall floor. Once at the recall floor, door operation is according to the user-defined door operation under fire recall operation.</td>
<td>Troubleshooting: 1. If in error, inspect the fire sensor and switch inputs and connections. 2. Related Inputs: Smoke sensors and fire recall switches as indicated on the job prints.</td>
</tr>
<tr>
<td><strong>Fire Service Recall Deactivated</strong></td>
<td>Description: Fire service recall operation has been deactivated.</td>
<td>Car returns to its prevailing mode of operation.</td>
<td>NA</td>
</tr>
<tr>
<td><strong>Flood Operation Activated, FLOOD OPERATION</strong></td>
<td>Description: Flood operation has been activated via system command or hardware switch.</td>
<td>Car in the flood zone area moves immediately to a floor outside the flood zone. The car will no longer service the floors in the flood zone until Flood Operation is deactivated.</td>
<td>Troubleshooting: Check the flood zone switch and the user interface command.</td>
</tr>
<tr>
<td><strong>Flood Operation Deactivated</strong></td>
<td>Description: Flood operation has been deactivated.</td>
<td>Car will service all eligible floors.</td>
<td>NA</td>
</tr>
<tr>
<td><strong>Floor Heat Detectors Activated, FLOOR HEAT DETECTORS</strong></td>
<td>Description: One or more floor heat detector inputs are activated. The fire warning light will flash until all heat detectors have been reset. The fire-warning buzzer will sound until the car is shutdown at a floor.</td>
<td>Car that is parked at a floor will open its doors and shut down. A car in motion will proceed in the current direction to the next available floor where the heat detector is not tripped. If all heat detectors in the current direction are tripped, the car will reverse direction and proceed to the first floor where the heat detector is not tripped. If again all heat detectors are tripped, the car shall proceed to the main fire recall floor unless the car is also on Fire Service, in which case the car will proceed to the appropriate fire recall floor. Once the car is stopped at a floor it shall automatically open its doors and shut down. Then, if the machine room or hoistway heat detectors are active, a signal is provided to disconnect the main power line and activate the sprinklers where available. Please refer to “Car Operation - Heat Detectors” on page 9-88.</td>
<td></td>
</tr>
<tr>
<td><strong>Floor Heat Detectors Deactivated</strong></td>
<td>Description: All floor heat detector inputs are deactivated.</td>
<td>Car is allowed to run.</td>
<td>NA</td>
</tr>
</tbody>
</table>
Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Floor Location Fault, FLOOR LOCATION FAULT</strong></td>
</tr>
<tr>
<td>Description: Floor magnet location is recorded during the floor height learn procedure. The on and off positions for both the ULM and DLM sensors are recorded, for a total of four pieces of data for every floor magnet, front and rear. The controller watches for the floor magnets constantly and checks to see that each is in its learned location.</td>
</tr>
<tr>
<td>Car Reaction: Run to next stop, then shut down.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Usually, a magnet has shifted position or fallen off.</td>
</tr>
<tr>
<td>2. Check the clearance between the floor sensor board and the magnets. Set if necessary. (Sometimes this clearance will be off just enough to make some magnets fail to register properly.)</td>
</tr>
<tr>
<td>3. Re-learn floor heights.</td>
</tr>
<tr>
<td>4. Perform a Terminal synchronization.</td>
</tr>
<tr>
<td><strong>Floor Sensor Fault, FLOOR SENSOR FAULT</strong></td>
</tr>
<tr>
<td>Description: The system did not detect a floor sensor while performing floor synchronization. Terminal synchronization will be performed as a result.</td>
</tr>
<tr>
<td>Car Reaction: Normal stop.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Fault will be generated if the car was moved while the controller was not powered. The system will detect movement of the elevator for only ten seconds after power is removed. This will be sufficient to accommodate the time required for an elevator to stop after power is removed when running at contract speed.</td>
</tr>
<tr>
<td>2. On Inspection, verify that the system is detecting the LU, DZ, and LD signals when the elevator passes a floor. The signals can be observed on the iView Floor Heights Configuration screen.</td>
</tr>
<tr>
<td><strong>Floor Synchronization Fault</strong></td>
</tr>
<tr>
<td>Description: While performing floor synchronization, the system either did not receive edge position data from the cartop or did not detect a floor position magnet where expected.</td>
</tr>
<tr>
<td>Car Reaction: The car will stop and initiate terminal synchronization.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Verify that the car was not moved after power was shut off.</td>
</tr>
<tr>
<td>2. Move the car past floors around the vicinity of the fault and verify the proper activation of the LU and LD sensors.</td>
</tr>
<tr>
<td>3. Verify that the system is communicating with the cartop (no Cartop Communication Fault).</td>
</tr>
<tr>
<td>4. Verify that the absolute and cartop positions change by the same amount and in the same direction while moving the car.</td>
</tr>
<tr>
<td>5. Verify that a magnet has not fallen off.</td>
</tr>
<tr>
<td>6. Check the clearance between the floor sensor board and the magnets. Sometimes this clearance will be off just enough to make some magnets fail to register properly. Adjust clearance if necessary.</td>
</tr>
<tr>
<td>7. Re-learn the floor heights.</td>
</tr>
<tr>
<td>8. The iLink, iLand or iBox may be faulty.</td>
</tr>
<tr>
<td><strong>Front Door Close Fault, FRONT DOOR CLOSE FLT</strong></td>
</tr>
<tr>
<td>Description: One or more front door failures to close have been detected. The controller will attempt to close the doors as defined by user parameters (door close protection timer and number of attempts) before declaring this fault. iView Car Operation/Doors tab.</td>
</tr>
<tr>
<td>Car Reaction: The doors will reopen fully. All car calls are canceled and car removes itself from hall call service (hall calls assigned to this car are canceled or reassigned to other cars if available). Doors may be closed using constant pressure on the front door close button.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Door closed status is determined by the front door close limit and by the front door position monitor contact if applicable. Check the wiring of these signals.</td>
</tr>
<tr>
<td>2. Check the door close protection timer and number of closing attempts on the Car Operation - Doors tab.</td>
</tr>
</tbody>
</table>
### Troubleshooting

#### Front Door Close Fault Recovery Failure, F DR CLS FLT REC FAIL

**Description:** The Door Close Fault Recovery timer starts when a Door Close Fault is generated. When the timer expires, the Door Close Fault is cleared to allow the doors to again attempt to close (see Front Door Close Fault). This is repeated the number of times specified by the Door Close Fault Recovery Attempts parameter. If the doors have failed to close when the number of attempts equals the recovery attempts parameter setting, the Front Door Close Fault Recovery Failure is generated.

**Car Reaction:** The car is not allowed to run until a mode change is detected or the doors are successfully closed via constant pressure on the Door Close Button.

**Troubleshooting:**
1. Door closed status is determined by the front door close limit and by the front door position monitor contact if applicable. Check the wiring of these signals.
2. Check the door close protection timer and number of closing attempts on the Car Operation - Doors tab.

#### Front Door Close Time-out

**Description:** Failure of front door to close detected. Controller will attempt to close doors for period of time defined by Closing protection timer parameter (Door Motor Protection Timers). If timer elapses prior to the doors closing fully, this event is generated.

**Car Reaction:** Doors reopen fully and again attempt to close.

**Troubleshooting:**
1. Door closed status determined by front door close limit the front door position monitor contact.
2. Check the wiring of these signals.
3. Check the Closing protection timer (iView Car Operation Configuration/Doors Tab/General Tab/Door Motor Protection Timers).

#### Front Door Contact Fault, FRONT DOOR CNTCT FLT

**Description:** Faulty front door contact (gate switch, door lock) detected. This is detected when the doors are in their fully open position and either the gate switch contact is closed or the doors appear to be locked.

**Car Reaction:** All car calls are canceled and the car removes itself from hall call service. The front doors are not allowed to close and the car is not allowed to run.

**Troubleshooting:**
1. Check the front door gate switch and door lock contact at the floor at which the car is located.
2. Check associated wiring for these signals.

#### Front Door Open Button Bypassed, FRONT DOB BYPASSED

**Description:** The front door open button has been continuously activated for a user-defined time and is now bypassed according to the user-defined setting. (iView/Car Operation/Doors/Advanced.)

**Car Reaction:** The front door open button is rendered inoperative.

**Troubleshooting:**
1. Check the corresponding input: Front Door - Open Button (Normally low).
2. The operation of the door open button can also be restored by setting the Door open button bypass option to off (unchecked) (Car Operation Configuration/Doors tab/Advanced dialog).

#### Front Door Open Fault, FRONT DOOR OPEN FAULT

**Description:** One or more front door failures to open fully detected. After repeated attempts to open door (as specified by user parameters), door open failure declared. Amount of time allowed for the door to open and the number of attempts made are user parameters. iView Car Operation/Doors tab, plus Advanced dialog.

**Car Reaction:** The door stalls at its last position. Car calls are canceled and the car removes itself from hall call service (hall calls assigned to this car are canceled or reassigned to other cars if available). Doors may be moved via constant pressure on the door open and door close buttons.

**Troubleshooting:**
1. The door open status is determined by the front door open limit status.
2. Check the wiring of this signal.
3. Check the door open protection timer and number of open attempts on the Operation screen Doors tab and associated Advanced dialog.

---

**Table 6.3 iControl Messages**

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Front Door Close Fault Recovery Failure, F DR CLS FLT REC FAIL** | The Door Close Fault Recovery timer starts when a Door Close Fault is generated. When the timer expires, the Door Close Fault is cleared to allow the doors to again attempt to close (see Front Door Close Fault). This is repeated the number of times specified by the Door Close Fault Recovery Attempts parameter. If the doors have failed to close when the number of attempts equals the recovery attempts parameter setting, the Front Door Close Fault Recovery Failure is generated. | The car is not allowed to run until a mode change is detected or the doors are successfully closed via constant pressure on the Door Close Button. | 1. Door closed status is determined by the front door close limit and by the front door position monitor contact if applicable. Check the wiring of these signals.  
2. Check the door close protection timer and number of closing attempts on the Car Operation - Doors tab. |
| **Front Door Close Time-out**                          | Failure of front door to close detected. Controller will attempt to close doors for period of time defined by Closing protection timer parameter (Door Motor Protection Timers). If timer elapses prior to the doors closing fully, this event is generated. | Doors reopen fully and again attempt to close.                                                   | 1. Door closed status determined by front door close limit the front door position monitor contact.  
2. Check the wiring of these signals.  
3. Check the Closing protection timer (iView Car Operation Configuration/Doors Tab/General Tab/Door Motor Protection Timers). |
| **Front Door Contact Fault, FRONT DOOR CNTCT FLT**     | Faulty front door contact (gate switch, door lock) detected. This is detected when the doors are in their fully open position and either the gate switch contact is closed or the doors appear to be locked. | All car calls are canceled and the car removes itself from hall call service. The front doors are not allowed to close and the car is not allowed to run. | 1. Check the front door gate switch and door lock contact at the floor at which the car is located.  
2. Check associated wiring for these signals. |
| **Front Door Open Button Bypassed, FRONT DOB BYPASSED** | The front door open button has been continuously activated for a user-defined time and is now bypassed according to the user-defined setting. (iView/Car Operation/Doors/Advanced.) | The front door open button is rendered inoperative.                                               | 1. Check the corresponding input: Front Door - Open Button (Normally low).  
2. The operation of the door open button can also be restored by setting the Door open button bypass option to off (unchecked) (Car Operation Configuration/Doors tab/Advanced dialog). |
| **Front Door Open Fault, FRONT DOOR OPEN FAULT**       | One or more front door failures to open fully detected. After repeated attempts to open door (as specified by user parameters), door open failure declared. Amount of time allowed for the door to open and the number of attempts made are user parameters. iView Car Operation/Doors tab, plus Advanced dialog. | The door stalls at its last position. Car calls are canceled and the car removes itself from hall call service (hall calls assigned to this car are canceled or reassigned to other cars if available). Doors may be moved via constant pressure on the door open and door close buttons. | 1. The door open status is determined by the front door open limit status.  
2. Check the wiring of this signal.  
3. Check the door open protection timer and number of open attempts on the Operation screen Doors tab and associated Advanced dialog. |
Table 6.3  iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Front Door Open Time-out</strong></td>
</tr>
<tr>
<td>Description: A failure of the front door to open has been detected. The controller will attempt to open the doors for a period of time defined by the Opening protection timer parameter (Door Motor Protection Timers). If the timer elapses prior to the doors opening fully, this event is generated.</td>
</tr>
<tr>
<td>Car Reaction: The door open cycle is halted and the door is allowed to reclose. If so configured, repeated attempts will be made to open the door. Otherwise, the car is allowed to leave the landing once the doors are closed.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Door open status is determined by the front door open limit and by the front door position monitor contact if applicable.</td>
</tr>
<tr>
<td>2. Check the wiring of these signals.</td>
</tr>
<tr>
<td>3. Check the Opening protection timer (iView Car Operation Configuration/Doors Tab/General Tab/Door Motor Protection Timers).</td>
</tr>
<tr>
<td><strong>Front Doors Stopped, FRONT DOORS STOPPED</strong></td>
</tr>
<tr>
<td>Description: The Door Stop button or Emergency Stop switch was activated causing the doors to be prevented from moving.</td>
</tr>
<tr>
<td>Car Reaction: The car is not allowed to move unless the doors are fully closed.</td>
</tr>
<tr>
<td>Troubleshooting: This condition can be cleared by activation of the Door Open button, Door Close button or if the car goes into Inspection or Fire Service mode, provided that the Door Stop input is off.</td>
</tr>
<tr>
<td><strong>Front DPM Open - GS Closed, F DPM OPEN-GS CLOSED</strong></td>
</tr>
<tr>
<td>Description: The front door position monitoring contact is open while the gate switch is closed.</td>
</tr>
<tr>
<td>Car Reaction: None.</td>
</tr>
<tr>
<td>Troubleshooting: Check the front door position monitoring contact, gate switch and all related circuitry.</td>
</tr>
<tr>
<td><strong>Front Hall Door Open Button Bypassed, FRONT HALL DOB BYP</strong></td>
</tr>
<tr>
<td>Description: The front hall door open button has been continuously activated for a user-defined time (Door open bypass timer) and is now bypassed in accordance with the user-defined setting (Car Operation Configuration/Doors tab/Advanced dialog).</td>
</tr>
<tr>
<td>Car Reaction: The front hall door open button is rendered inoperative.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Check the corresponding input, Front Door - Hall Door Open Button: Normally low.</td>
</tr>
<tr>
<td>2. The operation of the hall door open button can also be restored by setting the Door open button bypass option to off (unchecked) (Car Operation Configuration/Doors tab/Advanced dialog).</td>
</tr>
<tr>
<td><strong>Front Photo Eye Bypassed, FRONT PHOTO EYE BYP</strong></td>
</tr>
<tr>
<td>Description: The front photo eye device has been continuously activated for a user-defined time and is now bypassed in accordance to the user-defined setting. (iView/Car Operation/Passenger/Anti Nuisance.)</td>
</tr>
<tr>
<td>Car Reaction: The front photo eye device is rendered inoperative.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. To restore the operation of the photo eye device, check the corresponding input.</td>
</tr>
<tr>
<td>2. Related inputs:</td>
</tr>
<tr>
<td>PhotoEyeFront: Normally low</td>
</tr>
<tr>
<td><strong>Front Photo Eye Failure, FRONT PHOTO EYE FAIL</strong></td>
</tr>
<tr>
<td>Description: This event is logged when the photo eye is continuously activated for a predetermined time (4 seconds) while the front doors are fully closed.</td>
</tr>
<tr>
<td>Car Reaction: The front photo eye is rendered inoperative.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Check for abnormal blockage or failure of the front optical device.</td>
</tr>
<tr>
<td>2. Related inputs:</td>
</tr>
<tr>
<td>FrontPhotoEye: Normally low</td>
</tr>
</tbody>
</table>
Troubleshooting

Table 6.3  iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Front Safe Edge Bypassed, FRONT SAFE EDGE BYP** | The front door safe edge has been continuously activated for a user-defined time and is now bypassed according to the user-defined setting. (iView/Car Operation/Common/Door Device Bypass Timers.) | The front safe edge is rendered inoperative. | 1. Check the state of the front safe edge input.  
2. Related inputs: SafeEdgeFront: Normally low |
| **Front Safe Edge Failure, FRONT SAFE EDGE FAIL** | This event is logged when the front door safe edge is continuously activated for a predetermined time (4 seconds) while the front doors are fully closed. | The front door safe edge is rendered inoperative. | 1. Check for abnormal blockage or failure of the front door mechanical reopening device.  
2. Related inputs: FrontSafeEdge: Normally low |
| **Global Parameter Update, Reset Controller, PARAM CHNG-RESET CAR** | This message indicates that all of the controller parameters have been updated and it is necessary to reset the controller once the update is completed (press the iBox COMPUTER RESET button). | The car is not allowed to run until the parameter update has been completed and the computer has been reset. |  |
| **Governor open, GOVERNOR OPEN** | The Gov input has dropped. Will also cause an Ascending Car Overspeed Fault and set the rope gripper if running up. | Emergency stop if running. The car is not allowed to run again until the problem is corrected. | 1. Check the GOV (Governor) input, connection, and function. |
| **Governor Speed Reduction Switch Fault, GOV SPEED SWITCH FLT** | This fault is generated if the elevator is moving and the Governor Speed Reduction Switch input goes low (expansion input assigned via iView under Motor and Drive). | Emergency Stop | Troubleshooting: Verify the state of the Governor Speed Reduction Switch and input. |
| **Group Communication Established** | The car has established communication with the main iCue dispatcher. |  |
| **Group Communication Lost** | Communication with the main iCue dispatcher has been lost. | The car establishes communication with the backup dispatcher car if one has been selected. Otherwise the car goes into emergency dispatch mode if that operation is not bypassed via the hardware override switch. | Troubleshooting: Check the group to car communication related connections and parameters. |
| **Hall Call Bus 'n' Failure, HALL CALL BUS 'n' FAIL (n = 1 to 4)** | There is no power to the named hall call bus. | No response to calls from the affected floor. | 1. Check bus fuses and connections.  
2. Test associated hall call bus driver. |
| **Hall Call Bypass Input OFF** (see Hall Call Bypass Input ON) |  |  |  |
Table 6.3  iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hall Call Bypass Input ON, HALL CALL BYPASS INP.</strong></td>
<td>Discrete input used to bypass hall calls.</td>
<td>The car takes itself out of hall call service. Hall calls remain registered until answered. The car is also not eligible for parking.</td>
<td>Check the related discrete inputs.</td>
</tr>
</tbody>
</table>
| **Hall Call Service Disabled** | The car is rejecting hall calls (iBox IN GROUP indicator is Off and the Hall call reject status LED on the iView Diagnostics > Diagnostic Outputs > Car Operation tab is On) either because of the current mode of operation (Inspection, Test, Independent service, Capture) or because of a fault condition. | Hall calls are rejected. | 1. Verify that the car is not on a mode of operation in which hall calls are not accepted.  
2. Check the iView Faults text box and Event Log for faults that would cause the car to reject hall calls.  
3. If the car is not responding to hall calls, but neither 1 or 2 apply, the problem could be due to loss of communication with the dispatcher, security settings, heavy load status or hall call system malfunction. |
| **Hall Call Service Enabled** (see Hall Call Service Disabled) | The car is accepting hall calls (iBox IN GROUP indicator is On). See also, Hall Call Service Disabled. | | |
| **Heat Detectors Recall Activated, HEAT DETECTORS RECALL** | A heat detector input has been activated. | A car that is parked at a floor will open its doors and shut down. A car in motion will proceed in the current direction to the next available floor where the heat detector is not tripped. If all heat detectors in the current direction are tripped, the car will reverse direction and proceed to the first floor where the heat detector is not tripped. If again all heat detectors are tripped, the car shall proceed to the main fire recall floor unless the car is also on Fire Service, in which case the car will proceed to the appropriate fire recall floor. Once the car is stopped at a floor it shall automatically open its doors and shut down. Then, if the machine room or hoistway heat detectors are active, a signal is provided to disconnect the main power line and activate the sprinklers where available. Please refer to “Car Operation - Heat Detectors” on page 9-88. | |
| **Heat Detectors Recall Complete** | Indicates that the car has completed the Heat Detectors Recall operation (reached a floor and doors are fully open). | The car remains shut down until all heat detector inputs have been deactivated (see Heat Detectors Recall Deactivated). | |
| **Heat Detectors Recall Deactivated** | All heat detector inputs are deactivated | The car is allowed to run. | |
| **Heat Sensor Fault 'n'** (n = 2 to 4) | Not currently used. | | |
| **Hoistway Access Disabled, HA INSPECTION DISABLED** | Hoistway access inspection operation has been disabled. | The car cannot be run on hoistway access inspection operation. | 1. Check for any car status that might prevent hoistway access inspection operation, e.g. earthquake.  
2. Check for the Stuck Inspection Input Fault.  
3. Check all inspection buttons (Enable, Up, Down) and verify that none are stuck in the ON position. |
| **Hoistway Access Enabled** | Hoistway access inspection operation which was previously disabled is now enabled. | | |
### Troubleshooting

#### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Hoistway Access Inspection Operation, Hoistway Access Operation, Hoistway Access** | Description: Car is on Hoistway access (enabled by the Hoistway access switch). | Car Reaction: If running, the car will make an emergency stop and is taken out of normal service. Under this mode of operation, car can only be moved manually using the access key switches. | Troubleshooting:  
1. Related inputs:  
   - HoistwayAccess: Normally high  

| **Hoistway Door Bypass, HOISTWAY DOOR BYPASS**                                    | The Hoistway Door Bypass switch on the iBox is in the Bypass position. (View-only on iView Safety screen, enabled/disabled by MCE according to safety jurisdiction.) The ability to set this bypass must be enabled at the factory and is only available if allowed by safety regulations in your area. Check the iView Safety Configuration screen to see if the feature is enabled in your installation. | Car Reaction: The car is placed in Inspection mode. To move the car, you must place it in either cartop or car panel inspection mode. No other modes of operation are allowed. |  
1. Related inputs:  
   - HoistwayAccess: Normally high  

| **Hoistway Heat Detectors Activated, HOIST HEAT DETECTORS**                       | Description: The hoistway heat detector input is activated. The fire warning light will flash until all heat detectors have been reset. The fire-warning buzzer will sound until the car is shutdown at a floor. | Car Reaction: A car that is parked at a floor will open its doors and shut down. A car in motion will proceed in the current direction to the next available floor where the heat detector is not tripped. If all heat detectors in the current direction are tripped, the car will reverse direction and proceed to the first floor where the heat detector is not tripped. If again all heat detectors are tripped, the car shall proceed to the main fire recall floor unless the car is also on Fire Service, in which case the car will proceed to the appropriate fire recall floor. Once the car is stopped at a floor it shall automatically open its doors and shut down. Then, if the machine room or hoistway heat detectors are active, a signal is provided to disconnect the main power line and activate the sprinklers where available. **Please refer to “Car Operation - Heat Detectors” on page 9-88**. |  

| **Hoistway Heat Detectors Deactivated**                                            | Description: The hoistway heat detector input is deactivated.               | Car Reaction: The car is allowed to run.                                      |  

| **HOISTWAY LEARN ON**                                                             | Description: This status message, on the iBox display, indicates that the system is ready to perform the hoistway learn operation. |  
|----------------------------------------------------------------------------------|-----------------------------------------------------------------------------|------------------------------------------------------------------------------|-----------------------------------------------------------------------------------------------------|
| **IMP Switch Fault - Car Door Bypass, IMP SW FLT:C DOOR BP**                      | Description: There is a problem with the iBox CAR DOOR BYPASS switch. Both poles must activate. | Car Reaction: None                                                            | Troubleshooting:  
1. Sometimes the switch fault can be temporarily cleared by toggling the switch multiple times.  
2. The iBox slide switches can be repaired using MCE part: IMP-SW-JUMPER-KIT.  

| **IMP Switch Fault - Emergency Stop, IMP SW FAULT: EM STOP**                     | Description: There is a problem with the iBox CONTROLLER STOP switch. Both poles must activate. | Car Reaction: If stopped, the car is immediately shut down and taken out of service for all types of demands, including fire and medical emergencies. If the switch fault is detected while running, the car is allowed to reach its next destination before shutting down. | Troubleshooting:  
1. Sometimes the switch fault can be temporarily cleared by toggling the switch multiple times.  
2. The iBox slide switches can be repaired using MCE part: IMP-SW-JUMPER-KIT.  

---

**Table 6.3 iControl Messages**
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **IMP Switch Fault - Fault Bypass, IMP SW FAULT: FLT BYP** | There is a problem with the iBox FAULT/FUNCTION BYPASS switch. Both poles must activate. | None | 1. Sometimes the switch fault can be temporarily cleared by toggling the switch multiple times.  
2. The iBox slide switches can be repaired using MCE part: IMP-SW-JUMPER-KIT. |
| **IMP Switch Fault - Hoistway Door Bypass, IMP SW FLT: H DOOR BP** | There is a problem with the iBox HOISTWAY DOOR BYPASS switch. Both poles must activate. | None | 1. Sometimes the switch fault can be temporarily cleared by toggling the switch multiple times.  
2. The iBox slide switches can be repaired using MCE part: IMP-SW-JUMPER-KIT. |
| **IMP Switch Fault - Inspection, IMP SW FAULT: INSP** | There is a problem with the iBox INSPECTION switch. Both poles must activate. | If stopped, the car is immediately shut down and taken out of service for all types of demands, including fire and medical emergencies. If the switch fault is detected while running, the car is allowed to reach its next destination before shutting down. | 1. Sometimes the switch fault can be temporarily cleared by toggling the switch multiple times.  
2. The iBox slide switches can be repaired using MCE part: IMP-SW-JUMPER-KIT. |
| **IMP Switch Fault - Inspection DOWN, IMP SW FAULT: INSP DN** | There is a problem with the iBox Inspection DOWN switch. Both poles must activate. | None | |
| **IMP Switch Fault - Inspection Enable, IMP SW FAULT: INSP EN** | There is a problem with the iBox Inspection ENABLE switch. Both poles must activate. | None | |
| **IMP Switch Fault - Inspection UP, IMP SW FAULT: INSP UP** | There is a problem with the iBox Inspection UP switch. Both poles must activate. | None | |
| **IMP Switch Fault - Learn, IMP SW FAULT: LEARN** | There is a problem with the iBox LEARN switch. Both poles must activate. | None | 1. Sometimes the switch fault can be temporarily cleared by toggling the switch multiple times.  
2. The iBox slide switches can be repaired using MCE part: IMP-SW-JUMPER-KIT. |
| **IMP Switch Fault - None** | This message is generated when an IMP switch fault has occurred and is then cleared. If multiple switch faults occur at the same time, the message is generated when all faults have been cleared. | If the car had been shut down due to the IMP switch faults, it is cleared to run again. | |
| **IMP Switch Fault - Test, IMP SW FAULT: TEST** | There is a problem with the iBox TEST switch. Both poles of this switch must activate. | None | 1. Sometimes the switch fault can be temporarily cleared by toggling the switch multiple times.  
2. The iBox slide switches can be repaired using MCE part: IMP-SW-JUMPER-KIT. |
**Troubleshooting**

### IMP Switch Fault - Write Enable, IMP SW FLT: WRITE EN

**Description:** There is a problem with the iBox WRITE ENABLE switch. Both poles must activate.

**Car Reaction:** None

**Troubleshooting:**
1. Sometimes the switch fault can be temporarily cleared by toggling the switch multiple times.
2. The iBox slide switches can be repaired using MCE part: IMP-SW-JUMPER-KIT.

### Independent Service, Independent Svc

**Description:** Indicates that the Independent Service switch has been activated.

**Car Reaction:** Car and door operation in accordance to user-defined settings for independent service. (iView/Car Operation/Independent Service.) Car does not respond to hall calls.

**Troubleshooting:**
1. If reported in error, check the Independent Service switch and wiring.

### Inspection Operation, Inspection

**Description:** The car is operating in Inspection mode.

**Car Reaction:** One of the inspection modes (in-car, machine room, or cartop) is active. The car will operate using the Inspection performance pattern.

### Inspection Overspeed Fault

**Description:** While operating in Inspection mode, the car exceeded the Inspection Overspeed setting on the iView Safety Configuration screen.

**Car Reaction:** Emergency stop: Motor contactor and brake contactor immediately dropped.

**Troubleshooting:**
1. The fault will automatically clear 5 seconds after the car stops. The car is then allowed to run again.
2. If reported in error, check the Inspection Overspeed setting on the Safety Configuration screen.
3. Check the iView event log for any events immediately preceding the overspeed fault.
4. Determine and correct the cause of the overspeed.

### Insufficient Brake Feedback Fault, INSFCNT BRK FDBK FLT

**Description:** Brake current feedback is abnormally low.

**Car Reaction:** Emergency stop: Motor contactor and brake contactor immediately dropped.

**Troubleshooting:**
1. Check DB-25 connector from iField module to iBox is seated properly.
2. Check power supply on brake iField module.
3. Verify all wiring connections on the brake (BK) contactors are properly terminated and conducting.
4. Verify brake voltage parameters.
5. Verify iField Module setting for terminals FMCI and FMHC. Please refer to "IFIELD-MODULE Terminals on the ICE-FMP Board (Brake Module)" on page 6-87.
6. Verify that the brake is properly calibrated. Please refer to "Drive Offsets Calibration" on page 2-46. Please refer to "Brake Parameter Adjustments" on page 4-19.
7. Check Brake voltage on the Operational Status tab. If the value goes below 0.00 volts, and/or the drive offset (Input ADC) was recently calibrated or adjusted, verify / set the Input ADC = 0.0 on the Configuration > Drive > Calibration tab.

### Insufficient Motor Field Feedback Fault, INSFCNT MF FDBK FLT

**Description:** Indicates that Motor Current Feedback signal is less than 50% of the commanded field current.

**Car Reaction:** If detected four times over seven runs the car will shut down.

**Troubleshooting:**
1. Check motor field AC supply off isolation transformer.
2. Check connections from controller to motor.
3. Check connections to iField motor module.
4. Check for open fuses.
5. Recalibrate motor field.

---

**Table 6.3  iControl Messages**

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **IMP Switch Fault - Write Enable, IMP SW FLT: WRITE EN**                        | Description: There is a problem with the iBox WRITE ENABLE switch. Both poles must activate. | Car Reaction: None                                                             | Troubleshooting:
1. Sometimes the switch fault can be temporarily cleared by toggling the switch multiple times.  
2. The iBox slide switches can be repaired using MCE part: IMP-SW-JUMPER-KIT. |
| **Independent Service, Independent Svc**                                         | Description: Indicates that the Independent Service switch has been activated. | Car Reaction: Car and door operation in accordance to user-defined settings for independent service. (iView/Car Operation/Independent Service.) Car does not respond to hall calls. | Troubleshooting:
1. If reported in error, check the Independent Service switch and wiring. |
| **Inspection Operation, Inspection**                                             | Description: The car is operating in Inspection mode.                       | Car Reaction: One of the inspection modes (in-car, machine room, or cartop) is active. The car will operate using the Inspection performance pattern. | |
| **Inspection Overspeed Fault**                                                   | Description: While operating in Inspection mode, the car exceeded the Inspection Overspeed setting on the iView Safety Configuration screen. | Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped. | Troubleshooting:
1. The fault will automatically clear 5 seconds after the car stops. The car is then allowed to run again.  
2. If reported in error, check the Inspection Overspeed setting on the Safety Configuration screen.  
3. Check the iView event log for any events immediately preceding the overspeed fault.  
4. Determine and correct the cause of the overspeed. |
| **Insufficient Brake Feedback Fault, INSFCNT BRK FDBK FLT**                      | Description: Brake current feedback is abnormally low.                      | Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped. | Troubleshooting:
1. Check DB-25 connector from iField module to iBox is seated properly.  
2. Check power supply on brake iField module.  
3. Verify all wiring connections on the brake (BK) contactors are properly terminated and conducting.  
4. Verify brake voltage parameters.  
5. Verify iField Module setting for terminals FMCI and FMHC. Please refer to "IFIELD-MODULE Terminals on the ICE-FMP Board (Brake Module)" on page 6-87.  
6. Verify that the brake is properly calibrated. Please refer to "Drive Offsets Calibration" on page 2-46. Please refer to "Brake Parameter Adjustments" on page 4-19.  
7. Check Brake voltage on the Operational Status tab. If the value goes below 0.00 volts, and/or the drive offset (Input ADC) was recently calibrated or adjusted, verify / set the Input ADC = 0.0 on the Configuration > Drive > Calibration tab. |
| **Insufficient Motor Field Feedback Fault, INSFCNT MF FDBK FLT**                 | Description: Indicates that Motor Current Feedback signal is less than 50% of the commanded field current. | Car Reaction: If detected four times over seven runs the car will shut down. | Troubleshooting:
1. Check motor field AC supply off isolation transformer.  
2. Check connections from controller to motor.  
3. Check connections to iField motor module.  
4. Check for open fuses.  
5. Recalibrate motor field. |
Table 6.3  iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Insufficient Motor Field Forcing Feedback Fault, INSFCNT MF FORCNG FLT</strong></td>
<td>Description: Motor field voltage is inadequate. DC motors only.</td>
</tr>
<tr>
<td>Car Reaction:</td>
<td></td>
</tr>
<tr>
<td>Troubleshooting:</td>
<td>1. Verify motor field voltage parameters.</td>
</tr>
<tr>
<td></td>
<td>2. The motor field may be improperly calibrated. Check settings (iView Motor Configuration screen).</td>
</tr>
<tr>
<td></td>
<td>3. Recalibrate motor field if necessary.</td>
</tr>
<tr>
<td><strong>Invalid Configuration BALRQ, INVALID CNFG BALRQ</strong></td>
<td>Description: Bottom Access Landing Rear Qualifier. The safety system has detected the improper use of BALRQ option on the iView safety configuration screen.</td>
</tr>
<tr>
<td>Car Reaction:</td>
<td>Safety OK status remains off.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
<td>1. Check that the Safety Configuration, Bottom Access Landing Rear option is properly set.</td>
</tr>
<tr>
<td><strong>Invalid Configuration Input, INVALID CNFG INPUT</strong></td>
<td>Description: An invalid input was discovered when cross checking safety inputs against safety configuration.</td>
</tr>
<tr>
<td>Car Reaction:</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
<td>1. Check car setup/wiring against Safety Screen configuration.</td>
</tr>
<tr>
<td></td>
<td>2. Press Fault Reset to clear.</td>
</tr>
<tr>
<td><strong>Invalid Configuration Input Off (See: Invalid Configuration Input)</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Invalid Configuration Input CTEX, INVLD CNFG INPUT CTEX</strong></td>
<td>Description: Cartop Emergency Exit. The safety system detected an input/safety setting difference when cross checking inputs against configuration.</td>
</tr>
<tr>
<td>Car Reaction:</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
<td>1. Verify car setup/wiring matches the Safety screen setting for the option.</td>
</tr>
<tr>
<td></td>
<td>2. Press Fault Reset to clear.</td>
</tr>
<tr>
<td></td>
<td>3. Re-learn the Safety Configuration.</td>
</tr>
<tr>
<td><strong>Invalid Configuration Input DCAB, INVLD CNFG INPUT DCAB</strong></td>
<td>Description: Door Close Access Bottom. The safety system detected an input/safety setting difference when cross checking inputs against configuration.</td>
</tr>
<tr>
<td>Car Reaction:</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
<td>1. Verify car setup/wiring matches the Safety screen setting for the option.</td>
</tr>
<tr>
<td></td>
<td>2. Press Fault Reset to clear.</td>
</tr>
<tr>
<td></td>
<td>3. Re-learn the Safety Configuration.</td>
</tr>
<tr>
<td><strong>Invalid Configuration Input DCAT, INVLD CNFG INPUT DCAT</strong></td>
<td>Description: Door Close Access Top. The safety system detected an input/safety setting difference when cross checking inputs against configuration.</td>
</tr>
<tr>
<td>Car Reaction:</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
<td>1. Verify car setup/wiring matches the Safety screen setting for the option.</td>
</tr>
<tr>
<td></td>
<td>2. Press Fault Reset to clear.</td>
</tr>
<tr>
<td></td>
<td>3. Re-learn the Safety Configuration.</td>
</tr>
</tbody>
</table>
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| Invalid Configuration Input DCMS, INVLD CNFG INPUT DCMS | Door Close Main String. The safety system detected an input/safety setting difference when cross checking inputs against configuration. | Motor contactor and brake contactor immediately dropped. | 1. Verify car setup/wiring matches the Safety screen setting for the option.  
2. Press Fault Reset to clear.  
3. Re-learn the Safety Configuration. |
| Invalid Configuration Input DCMS R, INV CNFG INPUT DCMS R | Door Close Main String Rear. The safety system detected an input/safety setting difference when cross checking inputs against configuration. | Motor contactor and brake contactor immediately dropped. | 1. Verify car setup/wiring matches the Safety screen setting for the option.  
2. Press Fault Reset to clear.  
3. Re-learn the Safety Configuration. |
| Invalid Configuration Input DLAB, INVLD CNFG INPUT DLAB | Door Lock Access Bottom. The safety system detected an input/safety setting difference when cross checking inputs against configuration. | Motor contactor and brake contactor immediately dropped. | 1. Verify car setup/wiring matches the Safety screen setting for the option.  
2. Press Fault Reset to clear.  
3. Re-learn the Safety Configuration. |
| Invalid Configuration Input DLAT, INVLD CNFG INPUT DLAT | Door Lock Access Top. The safety system detected an input/safety setting difference when cross checking inputs against configuration. | Motor contactor and brake contactor immediately dropped. | 1. Verify car setup/wiring matches the Safety screen setting for the option.  
2. Press Fault Reset to clear.  
3. Re-learn the Safety Configuration. |
| Invalid Configuration Input DLMS, INVLD CNFG INPUT DLMS | Door Lock Main String. The safety system detected an input/safety setting difference when cross checking inputs against configuration. | Motor contactor and brake contactor immediately dropped. | 1. Verify car setup/wiring matches the Safety screen setting for the option.  
2. Press Fault Reset to clear.  
3. Re-learn the Safety Configuration. |
| Invalid Configuration Input DLMS R, INV CNFG INPUT DLMS R | Door Lock Main String Rear. The safety system detected an input/safety setting difference when cross checking inputs against configuration. | Motor contactor and brake contactor immediately dropped. | 1. Verify car setup/wiring matches the Safety screen setting for the option.  
2. Press Fault Reset to clear.  
3. Re-learn the Safety Configuration. |
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Invalid Configuration Input DPM, INVLD CNFG INPUT DPM** | Door Position Monitoring. The safety system detected an input/safety setting difference when cross checking inputs against configuration. | Emergency stop: Motor contactor and brake contactor immediately dropped. | 1. Verify car setup/wiring matches the Safety screen setting for the option.  
2. Press Fault Reset to clear.  
3. Re-learn the Safety Configuration. |
| **Invalid Configuration Input DPM_R, INV CNFG INPUT DPM_R** | Door Position Monitoring Rear. The safety system detected an input/safety setting difference when cross checking inputs against configuration. | Emergency stop: Motor contactor and brake contactor immediately dropped. | 1. Verify car setup/wiring matches the Safety screen setting for the option.  
2. Press Fault Reset to clear.  
3. Re-learn the Safety Configuration. |
| **Invalid Configuration TALRQ, INVALID CNFG TALRQ** | Top Access Landing Rear Qualifier. The safety system detected an input/safety setting difference when cross checking inputs against configuration. | Safety OK remains off. | 1. Verify car setup/wiring matches the Safety screen setting for the option.  
2. Press Fault Reset to clear.  
3. Re-learn the Safety Configuration. |
| **Invalid Configuration Inventory Cross Check BALRQ, INV INVTRY XCHK BALRQ** | Bottom Access Landing Rear Qualifier. The safety system detected a configuration/inventory (board complement) difference when cross checking board complement against system configuration. | Safety OK remains off. | 1. Verify that the Configuration settings on the Setup > Safety > Configuration tab match the car options/wiring. Any rear door options require a rear door board be attached to the safety expansion bus. Likewise, a rear door board attached to the safety expansion bus requires at least one rear door option be selected on the Safety Configuration (Setup > Safety > Configuration tab).  
2. If the safety configuration is incorrect, make appropriate changes and re-learn the new configuration using the Learn operation on the Setup > Safety > Configuration tab.  
3. Re-learn board inventory using the Inventory Learn procedure on the Setup > Safety > Inventory tab.  
4. Reset the fault (press the iBox FAULT RESET button). |
| **Invalid Configuration Inventory Cross Check DCCOR, INV INVTRY XCHK DCCOR** | Door Close Contact Rear. The safety system detected a configuration/inventory (board complement) difference when cross checking board complement against system configuration. | Safety OK remains off. | 1. Verify that the Configuration settings on the Setup > Safety > Configuration tab match the car options/wiring. Any rear door options require a rear door board be attached to the safety expansion bus. Likewise, a rear door board attached to the safety expansion bus requires at least one rear door option be selected on the Safety Configuration (Setup > Safety > Configuration tab).  
2. If safety configuration is incorrect, make appropriate changes and re-learn the new configuration using the Learn operation on the Setup > Safety > Configuration tab.  
3. Re-learn board inventory using the Inventory Learn procedure on the Setup > Safety > Inventory tab.  
4. Reset the fault (press the iBox FAULT RESET button). |
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Invalid Configuration Inventory Cross Check NMS R, INV INVTRY XCHK NMS R</strong></td>
</tr>
<tr>
<td>Description: No Main String Rear. The safety system detected a configuration/inventory (board complement) difference when cross checking board complement against system configuration.</td>
</tr>
<tr>
<td>Car Reaction: Safety OK remains off.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Verify that the Configuration settings on the Setup &gt; Safety &gt; Configuration tab match the car options/wiring. Any rear door options require a rear door board be attached to the safety expansion bus. Likewise, a rear door board attached to the safety expansion bus requires at least one rear door option be selected on the Safety Configuration (Setup &gt; Safety &gt; Configuration tab).</td>
</tr>
<tr>
<td>2. If the safety configuration is incorrect, make appropriate changes and re-learn the new configuration using the Learn operation on the Setup &gt; Safety &gt; Configuration tab.</td>
</tr>
<tr>
<td>3. Re-learn board inventory using the Inventory Learn procedure on the Setup &gt; Safety &gt; Inventory tab.</td>
</tr>
<tr>
<td>4. Reset the fault (press the iBox FAULT RESET button).</td>
</tr>
<tr>
<td><strong>Invalid Configuration Inventory Cross Check RD Board, INV INVTRY XCHK RD BD</strong></td>
</tr>
<tr>
<td>Description: Rear Door board. The safety system detected a configuration/inventory (board complement) difference when cross checking board complement against system configuration.</td>
</tr>
<tr>
<td>Car Reaction: Safety OK remains off.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Verify that the Configuration settings on the Setup &gt; Safety &gt; Configuration tab match the car options/wiring. Any rear door options require a rear door board be attached to the safety expansion bus. Likewise, a rear door board attached to the safety expansion bus requires at least one rear door option be selected on the Safety Configuration (Setup &gt; Safety &gt; Configuration tab).</td>
</tr>
<tr>
<td>2. If the safety configuration is incorrect, make appropriate changes and re-learn the new configuration using the Learn operation on the Setup &gt; Safety &gt; Configuration tab.</td>
</tr>
<tr>
<td>3. Re-learn board inventory using the Inventory Learn procedure on the Setup &gt; Safety &gt; Inventory tab.</td>
</tr>
<tr>
<td>4. Reset the fault (press the iBox FAULT RESET button).</td>
</tr>
<tr>
<td><strong>Invalid Configuration Inventory Cross Check RDOPT, INV INVTRY XCHK RDOPT</strong></td>
</tr>
<tr>
<td>Description: Rear Door Option. The safety system detected a configuration/inventory (board complement) difference when cross checking board complement against system configuration.</td>
</tr>
<tr>
<td>Car Reaction: Safety OK remains off.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Verify that the Configuration settings on the Setup &gt; Safety &gt; Configuration tab match the car options/wiring. Any rear door options require a rear door board be attached to the safety expansion bus. Likewise, a rear door board attached to the safety expansion bus requires at least one rear door option be selected on the Safety Configuration (Setup &gt; Safety &gt; Configuration tab).</td>
</tr>
<tr>
<td>2. If the safety configuration is incorrect, make appropriate changes and re-learn the new configuration using the Learn operation on the Setup &gt; Safety &gt; Configuration tab.</td>
</tr>
<tr>
<td>3. Re-learn board inventory using the Inventory Learn procedure on the Setup &gt; Safety &gt; Inventory tab.</td>
</tr>
<tr>
<td>4. Reset the fault (press the iBox FAULT RESET button).</td>
</tr>
<tr>
<td><strong>Invalid Configuration Inventory Cross Check RG Board, INV INVTRY XCHK RG BD</strong></td>
</tr>
<tr>
<td>Description: Rope Gripper board. The safety system detected a configuration/inventory (board complement) difference when cross checking board complement against system configuration.</td>
</tr>
<tr>
<td>Car Reaction: Safety OK remains off.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Verify Configuration settings on Setup &gt; Safety &gt; Configuration tab match car options/wiring. Any emergency brake options require an emergency brake board. Likewise, emergency brake board requires at least one emergency brake option selected on Safety Configuration (Setup &gt; Safety &gt; Configuration).</td>
</tr>
<tr>
<td>2. If the safety configuration is incorrect, make appropriate changes and re-learn the new configuration using the Learn operation on the Setup &gt; Safety &gt; Configuration tab.</td>
</tr>
<tr>
<td>3. Re-learn board inventory using the Inventory Learn procedure on the Setup &gt; Safety &gt; Inventory tab.</td>
</tr>
<tr>
<td>4. Reset the fault (press the iBox FAULT RESET button).</td>
</tr>
</tbody>
</table>
Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Invalid Configuration Inventory Cross Check RGOPT, INV INVTRY XCHK RGOPT</strong></td>
<td>Rope Gripper Option. The safety system detected a configuration/inventory (board complement) difference when cross checking board complement against system configuration.</td>
<td>Safety OK remains off.</td>
<td>1. Verify that the Configuration settings on the Setup &gt; Safety &gt; Configuration tab match the car options/wiring. Any emergency brake options require an emergency brake board be attached to the safety expansion bus. Likewise, a emergency brake board attached to the safety expansion bus requires at least one emergency brake option be selected on the Safety Configuration (Setup &gt; Safety &gt; Configuration tab). 2. If the safety configuration is incorrect, make appropriate changes and re-learn the new configuration using the Learn operation on the Setup &gt; Safety &gt; Configuration tab. 3. Re-learn the inventory of boards using the Inventory Learn procedure on the Setup &gt; Safety &gt; Inventory tab. 4. Reset the fault (press the iBox FAULT RESET button).</td>
</tr>
<tr>
<td><strong>Invalid Configuration Inventory Cross Check TALRQ, INV INVTRY XCHK TALRQ</strong></td>
<td>Top Access Landing Rear Qualifier. The safety system detected a configuration/inventory (board complement) difference when cross checking board complement against system configuration.</td>
<td>Safety OK remains off.</td>
<td>1. Verify that the Configuration settings on the Setup &gt; Safety &gt; Configuration tab match the car options/wiring. Any rear door options require a rear door board be attached to the safety expansion bus. Likewise, a rear door board attached to the safety expansion bus requires at least one rear door option be selected on the Safety Configuration (Setup &gt; Safety &gt; Configuration tab). 2. If the safety configuration is incorrect, make appropriate changes and re-learn the new configuration using the Learn operation on the Setup &gt; Safety &gt; Configuration tab. 3. Re-learn the inventory of boards using the Inventory Learn procedure on the Setup &gt; Safety &gt; Inventory tab. 4. Reset the fault (press the iBox FAULT RESET button).</td>
</tr>
<tr>
<td><strong>Invalid Destination, INVALID DESTINATION</strong></td>
<td>The car has been assigned to a destination floor that does not have an opening.</td>
<td>Car ignores the demand.</td>
<td>Troubleshooting: Check the current mode of operation and check the corresponding recall floor and verify that the floor is set to a floor with an opening.</td>
</tr>
<tr>
<td><strong>Invalid Front Door Position, INVLD FRONT DOOR PSTN</strong></td>
<td>The front door inputs are in an invalid state (i.e.: doors open and closed at the same time).</td>
<td>Car is taken out of service and doors will stall.</td>
<td>Troubleshooting: 1. Check all the front door inputs and wiring. 2. Related inputs: FrontDoorCloseLimit: Low when the doors are fully closed FrontDoorPositionMonitoring: High when the doors are fully closed FrontDoorOpenLimit: Low when doors are fully open FrontCarGate: High when doors are fully closed</td>
</tr>
<tr>
<td><strong>Invalid Input</strong></td>
<td>(See: Invalid Configuration Input)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 6.3 iControl Messages
## Troubleshooting

### Table 6.3  iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Invalid Rear Door Position, INVLD REAR DOOR PSTN</strong></td>
</tr>
<tr>
<td>Description: The rear door inputs are in an invalid state (i.e., doors open and closed at the same time).</td>
</tr>
<tr>
<td>Car Reaction: Car is taken out of service and doors will stall.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Check all the rear door inputs and wiring.</td>
</tr>
<tr>
<td>2. Related inputs:</td>
</tr>
<tr>
<td>RearDoorCloseLimit: Low when the doors are fully closed</td>
</tr>
<tr>
<td>RearDoorPositionMonitoring: High when the doors are fully closed</td>
</tr>
<tr>
<td>RearDoorOpenLimit: Low when doors are fully open</td>
</tr>
<tr>
<td>RearCarGate: High when doors are fully closed</td>
</tr>
</tbody>
</table>

| **IO Map Compare Fault, IO MAP COMPARE FAULT** |
| Description: Safety A IO Map did not match Safety B IO Map. |
| Car Reaction: If running, car makes an emergency stop. Car is not allowed to run. |
| Troubleshooting: |
| 1. Press the Fault Reset button to clear the fault. |
| 2. If problem persists it is an indication that the iBox may need to be replaced. Consult MCE Technical Support for instructions. |

**IO Map Compare Fault Off** (See: IO Map Compare Fault)

| **IO Map Compare Long Term Fault, IO MAP COMPARE LT FLT** |
| Description: Safety A long term products did not match Safety B long term products for 1.2 seconds. |
| Car Reaction: If running, car makes an emergency stop. Car is not allowed to run. |
| Troubleshooting: |
| 1. Press the Fault Reset button to clear the fault. |
| 2. If problem persists it is an indication that the iBox may need to be replaced. Consult MCE Technical Support for instructions. |

**IO Map Toggle Compare Fault, IO MAP TOGLE COMP FLT** |

| Description: The failure of a safety input was detected during the “input toggle test” (performed at the end of each run). This test verifies the proper operation of safety system inputs that normally remain unchanged during the course of elevator operation. |
| Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped. |
| Troubleshooting: |
| 1. Press the Fault Reset button to clear the fault. |
| 2. If problem persists, indicates iBox may need replacing. Consult MCE Technical Support for instructions. |

**IO Map Toggle Compare Fault Off** (See: IO Map Toggle Compare Fault)

| **iView Logged Off.** |
| Passenger operation. An iView connection to the controller has logged off. |

| **iView Logged On.** |
| Passenger operation. An iView user has logged on to the controller. |

| **iView Lost Connection.** |
| An iView connection has been dropped. |

| **iView Timed Out.** |
| An iView connection was inactive for a period of time beyond the idle timeout and has been disconnected. |

| **Landing System Sensor Fault, LAND SYS SENSOR FAULT** |
| Description: Generated when a ULM or DLM sensor is activated while car is running and away from a floor. It can also be generated if the M contactor is ON (car commanded to run) and safety system sees a door zone magnet for more than 16 inches of single direction travel. |
| Car Reaction: Emergency Stop. Motor and brake contactors immediately dropped. |
| Troubleshooting: |
| 1. Press Fault Reset to clear. |
| 2. If allowed, set Contactor Drop Delay Time to 0.9 seconds. |
| 3. Check for stuck door zone sensor input (front or rear). |
**Table 6.3 iControl Messages**

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LCD Fault</strong></td>
<td>This fault is generated if the controller gets a &quot;not ready&quot; state from the LCD. This can happen if the iBox LCD is not connected properly or, with some LCD models, if the contrast is set to far to an extreme.</td>
<td>None. The fault is simply an indication to adjust or replace the iBox LCD.</td>
<td>1. Check the iBox Onboard Display LCD. If the LCD is blank or frozen, adjust the contrast dial to midpoint. 2. If the display looks corrupted, press the iBox Computer Reset button.</td>
</tr>
<tr>
<td><strong>Learn Switch Timed Out Fault, LEARN SW TIMED OUT</strong></td>
<td>When the Learn Switch is ON for more than 15 minutes, the car will shut down.</td>
<td>The car is not allowed to restart after the current run is completed.</td>
<td>1. Turn OFF the iBox Learn switch. 2. If more time is needed in the Learn mode, then turn the Learn switch back ON to reset the fifteen minute timer.</td>
</tr>
<tr>
<td><strong>Learn U/DNT1-5 and U/DETS Positions, LEARN U/DTS POSITIONS</strong></td>
<td>The positions for the normal and emergency terminal limit switches have not been learned.</td>
<td>The elevator can only be run on Inspection or Test modes.</td>
<td>Perform the normal and emergency terminal limit switches learn operation (Learn tab on the iView Terminal Switches Configuration screen).</td>
</tr>
<tr>
<td><strong>Learn U/DNT1-5 and U/DETS Speeds, LEARN U/DTS SPEEDS</strong></td>
<td>The speeds for the normal and emergency terminal limit switches have not been learned.</td>
<td>The elevator can only be run on Inspection or Test modes.</td>
<td>Perform the normal and emergency terminal limit switches learn operation (Learn tab on the iView Terminal Switches Configuration screen).</td>
</tr>
<tr>
<td><strong>Learning empty load values, LEARNING EMPTY LOAD</strong></td>
<td>Empty car load learn calibration has been initiated.</td>
<td>The elevator can only be run on Inspection or Test modes.</td>
<td>Perform the normal and emergency terminal limit switches learn operation (Learn tab on the iView Terminal Switches Configuration screen).</td>
</tr>
<tr>
<td><strong>Learning full load values, LEARNING FULL LOAD</strong></td>
<td>Full car load learn calibration has been initiated.</td>
<td>The elevator can only be run on Inspection or Test modes.</td>
<td>Perform the normal and emergency terminal limit switches learn operation (Learn tab on the iView Terminal Switches Configuration screen).</td>
</tr>
<tr>
<td><strong>Light Load Antinuisance</strong></td>
<td>Light load anti-nuisance operation. The load in the car is less than the programmed Light Load Threshold value.</td>
<td>Under these conditions, an anti-nuisance feature (if enabled) will limit the number of car calls registered. Should the number of registered car calls exceed the programmed limit, all car calls will be canceled.</td>
<td>1. If this message appears to be displayed in error, verify the programmed “Light Load Threshold” value. (Adjust if needed on the Load Weigher Configuration screen.) 2. Verify the user-defined number of car calls allowed if the car load is less than the Light Load Threshold. Please refer to “Car Operation - Passenger Tab” on page 9-39. 3. Evaluate whether or not the load in the car is less than the Light Load Threshold value. Calibrate the load weigher if necessary. 4. For discrete input load weighers, check the Light Load input shown on the job prints.</td>
</tr>
</tbody>
</table>
## Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Limit Switches Checksum Fault, LIMIT SW CHKSUM FAULT</strong></td>
<td>Description: Learned ETS and NTS limit switch speed values have Invalid Checksum in nonvolatile memory. An invalid checksum means that the data stored may not be reliable.</td>
<td>Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
<td>Troubleshooting: 1. Relearn the Hoistway limit switches. 2. Use the Default option on the Terminal Switch learning screen.</td>
</tr>
<tr>
<td><strong>Load calibration on, LOAD CALIBRATION ON</strong></td>
<td>Description: Load learn calibration has been initiated.</td>
<td>Car Reaction: Car will start load learn process.</td>
<td></td>
</tr>
<tr>
<td><strong>Load learn process activated</strong></td>
<td>See Load Calibration On.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Load learn process deactivated</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Lobby Peak Mode, LOBBY PEAK MODE</strong></td>
<td>Description: The elevator is operating in lobby peak mode, favoring traffic coming from the lobby.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Loss of Position or Speed Indicators, LOSS OF POS/SPD IND</strong></td>
<td>Description: Speed feedback signal used to compare with the position feedback signal is not being seen properly or is not properly calibrated. This can be caused by a loss of traction.</td>
<td>Car Reaction: Emergency Stop. Latched fault.</td>
<td>Troubleshooting: 1. On the iView oscilloscope (or a DVM connected between STP1 and STP2), compare Pattern Command and Speed Feedback readouts. They must match within 0.050 VDC while the car is running at steady state speed. If not, adjust the TACH ADJ trimpot. Please refer to “Verify Pattern Command and Drive Speed Feedback” on page 2-55. 2. Use a hand-held tachometer to verify car speed. If the actual speed does not match commanded speed, adjust motor parameter LF.22. Please refer to “Following Error Margin” on page 2-56. 3. Run the car on inspection and check the speed displayed on the iBox display.</td>
</tr>
<tr>
<td><strong>Mac Address Error, MAC ADDRESS ERROR</strong></td>
<td>Description: The iBox has detected that one of its three MAC addresses has been defaulted or set to zero. This could lead to multiple cars having the same MAC address, which will cause network problems.</td>
<td>Car Reaction: None.</td>
<td>Troubleshooting: Remove iBox cover. On OBD select Car &gt; View Factory Data &gt; MAC Addresses. Verify MAC addresses displayed on LCD match addresses on barcode stickers on ICE-IMP board. Correct if necessary.</td>
</tr>
<tr>
<td><strong>Machine Room Heat Detectors Activated, MR HEAT DETECTORS</strong></td>
<td>Description: Machine room heat detector input activated. Fire warning light will flash until all heat detectors have been reset. Fire-warning buzzer will sound until car is shutdown at a floor. Car in motion will proceed in current direction to next available floor where the heat detector is not tripped. If all heat detectors in current direction are tripped, car will reverse direction and proceed to first floor where heat detector is not tripped. If again all heat detectors are tripped, car shall proceed to main fire recall floor unless car is on Fire Service, in which case car will proceed to appropriate fire recall floor. Once car is stopped at a floor it shall automatically open doors and shut down. Then, if machine room or hoistway heat detectors active, a signal is provided to disconnect main power line and activate sprinklers where available. Please refer to “Car Operation - Heat Detectors” on page 9-88.</td>
<td>Car Reaction: Car parked at a floor will open doors and shut down. Car in motion will proceed in current direction to next available floor where the heat detector is not tripped. If all heat detectors in current direction are tripped, car will reverse direction and proceed to first floor where heat detector is not tripped. If again all heat detectors are tripped, car shall proceed to main fire recall floor unless car is on Fire Service, in which case car will proceed to appropriate fire recall floor. Once car is stopped at a floor it shall automatically open doors and shut down. Then, if machine room or hoistway heat detectors active, a signal is provided to disconnect main power line and activate sprinklers where available. Please refer to “Car Operation - Heat Detectors” on page 9-88.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Machine Room Heat Detectors Deactivated</strong></td>
<td>Description: The machine room heat detector input is deactivated.</td>
<td>Car Reaction: The car is allowed to run.</td>
<td></td>
</tr>
<tr>
<td><strong>Machine Room Stop Switch Open, MR STOP SWITCH OPEN</strong></td>
<td>Description: The machine room stop switch input has dropped.</td>
<td>Car Reaction: Emergency stop if running. The car is not allowed to run until the problem is corrected.</td>
<td>1. Check the Machine Room stop switch on the front panel of the iBox.</td>
</tr>
<tr>
<td><strong>Machine Room Inspection Disabled, MR INSP. DISABLED</strong></td>
<td>Description: Machine room inspection operation has been disabled.</td>
<td>Car Reaction: The car cannot be run on machine room inspection operation.</td>
<td>1. Check for any car status that might prevent machine room inspection operation, e.g. earthquake. 2. Check for the Stuck Inspection Input Fault. 3. Check all inspection buttons (Enable, Up, Down) and verify that none are stuck in the ON position.</td>
</tr>
<tr>
<td><strong>Machine Room Inspection Enabled</strong></td>
<td>Description: Machine room inspection operation which was previously disabled is now enabled.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Machine Room Inspection Operation, Machine Rm Inspection, Mach Rm Insp</strong></td>
<td>Description: Car placed in Machine Room Inspection operation using the iBox Inspection switch.</td>
<td>Car Reaction: Car begins operating in Inspection mode. If running, the car will make an emergency stop and is taken out of normal service. Under this mode of operation, car can only be moved manually using the iBox Inspection Up and Down switches.</td>
<td>1. Related inputs: MachineRoomInspection: Normally high</td>
</tr>
<tr>
<td><strong>Main Floor Smoke Sensor Recall, MAIN FLOOR SMOKE</strong></td>
<td>Description: Recall to the alternate fire floor due to active or latched smoke detector inputs from the main floor.</td>
<td>Car Reaction: Car proceeds to the user-defined alternate fire recall floor. Once at the recall floor, door operation is according to the user-defined door operation under fire recall operation.</td>
<td>1. If in error, inspect the sensor input and connections. 2. Related Inputs: Main floor smoke and fire sensors as indicated on job print drawing(s) -1.</td>
</tr>
<tr>
<td><strong>Motion Start Fault, MOTION START FAULT</strong></td>
<td>Description: Car initiated movement but was unable to start for more than ten seconds.</td>
<td>Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
<td>1. Determine mechanical or other reason car is unable to start.</td>
</tr>
<tr>
<td><strong>Motion stopped due to IO toggle test, MOTION STOPPED-IO TST</strong></td>
<td>Description: iBox requested start of motion while a toggle test was being performed.</td>
<td>Car Reaction: None. iBox will resend request.</td>
<td>Troubleshooting: NA</td>
</tr>
</tbody>
</table>
### Table 6.3  iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Motor Contactor Driver Proofing Fault, MOTR CNTR DRV PRF FLT** | **Description:** Fault signal for motor contactor driver proofing circuits. | **Car Reaction:** None                | **Troubleshooting:**  
  1. Verify motor contactor driver proofing circuits.  
  2. Check the coil of the motor contactor. |
| **Motor Contactor Proofing Fault, MOTOR CNTR PROOF FLT**  | **Description:** Fault signal for motor contactor proofing circuits.         | **Car Reaction:** None                | **Troubleshooting:**  
  1. Verify motor contactor proofing circuits. |
| **Motor Field Forcing Timed Out, MF FORCING TIMED OUT**  | **Description:** DC motors only. The motor field was being forced for over 1 minute. | **Car Reaction:** Stop the run. Restart. | **Troubleshooting:**  
  1. The motor field starts forcing if there is a demand and the doors are closing. Check that the doors are not obstructed and/or that passengers are not holding the doors open past the 1 minute limit. |
| **Motor Limit Protection Timer Elapsed, MOTOR LMT TIMED OUT** | **Description:** A fault is generated is the system requests movement for more than ten minutes but no movement is detected. | **Car Reaction:** Currently for informational purposes only. | **Troubleshooting:**  
  1. Check that Pattern Scaling is not set to 0.0.  
  2. Check Contract Speed is correctly set.  
  3. Check pattern voltage to drive (0 - 10V) with meter. |
| **Motor Limit Timed Out, MOTOR LIMIT TIMED OUT**         | **Description:** Generated if no other fault has been generated and the system has attempted to move the car for three minutes with no movement detected or has detected only minimum movement for ten minutes. | **Car Reaction:** Emergency stop: Motor contactor and brake contactor immediately dropped. Cancel all calls. | **Troubleshooting:**  
  1. Check that Pattern Scaling is not set to 0.0.  
  2. Check Contract Speed is correctly set.  
  3. Check pattern voltage to drive (0 - 10V) with meter. |
| **Nudging Front, NUDGING FRONT**                        | **Description:** This event is logged when front door nudging operation is invoked. | **Car Reaction:** Front doors start closing at reduced speed and torque. | **Nudging Operation**  
  Description: The doors are operating in Nudging mode. (Passenger operation). |
| **Nudging Operation**                                   | **Description:** The doors are operating in Nudging mode. (Passenger operation). | **Nudging Rear, NUDGING REAR**        | **Description:** This event is logged when rear door nudging operation is invoked. |
| **Nudging Rear, NUDGING REAR**                          | **Description:** This event is logged when rear door nudging operation is invoked. | **Car Reaction:** Rear doors start closing at reduced speed and torque. | **Other Cars Alternate Fire Sensor Recall, OTHER CARS ALT FIRE**  
  Description: Alternate fire recall due to active or latched smoke detector input(s) from the hoistway or machine room of other cars in the system. |
| **Other Cars Alternate Fire Sensor Recall, OTHER CARS ALT FIRE** | **Description:** Alternate fire recall due to active or latched smoke detector input(s) from the hoistway or machine room of other cars in the system. | **Car Reaction:** Car proceeds to the user-defined alternate fire recall floor. Once at the recall floor, door operation is according to the user-defined door operation under fire recall operation. | **Troubleshooting:**  
  1. If in error, inspect the sensors, inputs, and connections.  
  2. Related Inputs: Other Cars Alt Recall sensor inputs as indicated on job prints. |
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Other Cars Main Fire Sensor Recall, OTHER CARS MAIN FIRE</strong></td>
</tr>
<tr>
<td>Description: Main fire recall due to active or latched smoke detector input(s) from the hoistway or machine room of other cars in the system.</td>
</tr>
<tr>
<td>Car Reaction: Car proceeds to the user-defined main fire recall floor. Once at the recall floor, door operation is according to the user-defined door operation under fire recall operation.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. If in error, inspect the sensors, inputs, and connections.</td>
</tr>
<tr>
<td>2. Related Inputs: Other Cars Main Recall sensor inputs as indicated on job prints.</td>
</tr>
<tr>
<td><strong>PARAM CHNG-RESET CAR, see Global Parameter Update, Reset Controller</strong></td>
</tr>
<tr>
<td><strong>Passenger Operation, Passenger</strong> Normal operation status message.</td>
</tr>
<tr>
<td><strong>Photo Eye Antinuisance</strong></td>
</tr>
<tr>
<td>Description: Logged when car calls are canceled due to a user-defined number of car calls being registered without interruption of the photo eye device.</td>
</tr>
<tr>
<td>Car Reaction: All car calls are cancelled.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Check the user defined options related to the operation. (iView/Car Operation/Passenger/Anti Nuisance.)</td>
</tr>
<tr>
<td>2. Check the photo eye device and related inputs.</td>
</tr>
<tr>
<td><strong>Position Cartop Offset Fault, POSTN CARTP OFFST FLT</strong></td>
</tr>
<tr>
<td>Description: Each time car stops, it obtains position information from cartop position encoder. If the reported position varies from the position last reported at this location by more than two feet, this fault is generated.</td>
</tr>
<tr>
<td>Car Reaction: Emergency stop. Motor and brake contactors immediately dropped.</td>
</tr>
<tr>
<td>Troubleshooting: Performance a Terminal Synchronization (Pattern Configuration screen&gt;Common tab&gt;Position Synchronization.</td>
</tr>
<tr>
<td><strong>Position Location Error Fault, POSTN LCTN ERROR FLT</strong></td>
</tr>
<tr>
<td>Description: If the difference between the learned position of a floor (magnet) and the currently indicated position of that floor (magnet) is greater than 2 feet, this fault is generated.</td>
</tr>
<tr>
<td>Car Reaction: Car will perform a terminal synchronization.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Check that the iLand landing system is properly installed and adjusted. (Refer to Section 3 of this guide.)</td>
</tr>
<tr>
<td><strong>Position Quadrature Fault, POSITION QUAD FAULT</strong></td>
</tr>
<tr>
<td>Description: The quadrature signal from iLand is not being detected (one or both streams). When moving above 30 fpm, the system expects to see proper transitions on both quadrature signals. This fault may be bypassed on the Diagnostics &gt; Fault Bypass tab.</td>
</tr>
<tr>
<td>Car Reaction: Emergency stop.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Verify that both quadrature channels are arriving at the iBox.</td>
</tr>
<tr>
<td>2. On Hoistway screen, verify absolute position increments when moving up and decrements when moving down (on inspection). If absolute position does not change, there may be a problem with the iBox.</td>
</tr>
<tr>
<td><strong>Position Quadrature Reversed Fault, POSITN QUAD RVRSD FLT</strong></td>
</tr>
<tr>
<td>Description: The arrival sequence of the quadrature pulse streams indicates travel in the opposite direction of that requested by the system.</td>
</tr>
<tr>
<td>Car Reaction: None.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Verify that the elevator moves in the requested direction.</td>
</tr>
<tr>
<td>2. On the Hoistway screen, verify that the cartop position increments when moving up and decrements when moving down (on inspection).</td>
</tr>
<tr>
<td>3. On the Hoistway screen, verify that the absolute position increments when moving up and decrements when moving down (on inspection).</td>
</tr>
</tbody>
</table>
Troubleshooting

Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Position Speed Deviation Fault, POSITN SPEED DVTN FLT</strong></td>
<td>The safety processor compares the distance travelled reported by the position quadrature with the distance travelled according to motor rotation. If the quadrature reports 48” travelled but the motor reports less than 32” travelled, this fault is generated. This fault may be bypassed on the Diagnostics &gt; Fault Bypass tab.</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
<td>1. Check velocity feedback from drive.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Check that Pattern Configuration/General tab Position Encoder Resolution is set to 256.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Check calibration of speed feedback signal.</td>
<td></td>
</tr>
</tbody>
</table>

**Position Speed Threshold Fault, POSTN SPD THRSHLDFLT**

Description: The quadrature synthesized speed exceeds 115% of contract speed. This fault may be bypassed on the Diagnostics > Fault Bypass tab.

Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped.

Troubleshooting:
1. On the iView oscilloscope, compare Pattern Command and Speed Feedback to see that they match.
2. Use a hand-held tachometer to verify car speed.
3. Run the car on inspection and check the speed displayed on the iBox display.
4. For SCR drives, verify that the programmed running motor field is close to the actual motor field value when running at contract speed. If the value is higher, the system will have to weaken the motor field as the elevator reaches contract speed. If the motor field is very inductive, this may cause an overshoot. If the value is too low, excessive current may flow through the armature. Note that load will affect this value. Running in the up direction with a full load in the car will yield the worst-case scenario. For an empty elevator, running in the down direction produces the worst-case scenario (the value will be higher than for the fully loaded car.)
5. For highly inductive motor fields, begin motor field weakening earlier and end motor field weakening earlier. If the begin weakening percentage is too low, poor control will result when the elevator is approaching the destination floor (spotting). If this is the case, reduce the end weaken percentage without modifying (by much) the begin weakening percentage. Generally, begin is recommended around 50% while end is recommended around 90% for normal motor fields.
6. Reduce high roll jerk.

**Position Synchronization Fault**

Description: The system was not able to read the position correction value stored in battery backed RAM when the controller powered up. This fault usually results in a floor sensor fault or a position location fault.

Car Reaction: None.

Troubleshooting:
1. Verify iBox battery connection and charge (lower left side of ICE-IMP board - iBox cover removed).
   Battery type: 1/2 AA, 3.6V Lithium. Manufacturer: SAFT, part # LS14250. MCE part # 30-05-0001.

**Position Synchronization Required at Floor, POSITION SYNC-FLOOR**

Description: The elevator needs to verify position by crossing a door zone sensor.

Car Reaction: Cancel all existing calls, synchronize to floor.

**Position Synchronization Required at Terminal, POSITION SYNC-TERMINAL**

Description: The elevator does not know where it is. It needs to locate a terminal door zone sensor to establish position.

Car Reaction: Cancel all existing calls, synchronize to terminal.

**Position Synchronized at Floor**

Description: The elevator has completed synchronizing its position using a door zone sensor. See Position Synchronization Required at Floor.

Car Reaction: Return to normal service.
Table 6.3  iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Position Synchronized at Terminal</strong></td>
<td>The elevator has completed synchronizing its position using a terminal door zone sensor. See</td>
<td>Return to normal operation.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Position Synchronization Required at Terminal</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Power Transfer Input Activated, Power Transfer, POWER TRANSFER</strong></td>
<td>Power transfer input activated. Power is being transferred from the emergency generator to</td>
<td>Cancel existing calls. Stop at next floor and open doors.</td>
<td>Check the Power Transfer input.</td>
</tr>
<tr>
<td></td>
<td>commercial service.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Power Transfer Input Deactivated</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Power Up Position Synchronization Required at Terminal</strong></td>
<td>Position synchronization at a terminal landing required after power-up/ reset. Terminal synchro-</td>
<td>The elevator will synchronize at a terminal landing.</td>
<td>Battery may need to be changed.</td>
</tr>
<tr>
<td></td>
<td>nization after power-up will occur if the elevator was required to synchronize before power was lost or the</td>
<td></td>
<td>Check for faulty SRAM.</td>
</tr>
<tr>
<td></td>
<td>controller was reset, or if synchronization information in battery backed SRAM is invalid.</td>
<td></td>
<td>Check for SRAM not correctly inserted in socket.</td>
</tr>
<tr>
<td><strong>Pre-start Door Lock Fault</strong></td>
<td>Once the decision to move the elevator has been made, three acknowledgments (motion start,</td>
<td>The pre-start sequence will stop and the sequence will repeat. If the fault persists, an excessive restarts fault will occur.</td>
<td>Check the primary fire recall switch inputs.</td>
</tr>
<tr>
<td></td>
<td>door lock and drive start) must be received before physical movement is allowed. However, if the system is so configured, pre-start sequencing will begin while the doors are closing. If the door lock acknowledgement is not received within 15 seconds (after the pre-start sequence is begun), this fault is generated.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Primary Fire Switch Bypass, PRI FIRE SWITCH BYP</strong></td>
<td>The primary fire switch is in the Bypass position.</td>
<td>According to selected Fire Code.</td>
<td>Check the primary fire recall switch inputs.</td>
</tr>
<tr>
<td><strong>Primary Fire Switch On, PRI FIRE SWITCH ON</strong></td>
<td>The car will recall to the Main fire recall floor, position its doors as directed on the Car Operation/Fire/Modify/Fire Recall screen, and wait for activation of the in-car firefighter switch.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>QPRAM Device Error, QPRAM DEVICE ERROR</strong></td>
<td>Safety Processor A problem writing to QPRAM device.</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
<td>Replace QPRAM on Safety Processor A. Contact MCE.</td>
</tr>
</tbody>
</table>
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rear Door Close Fault, REAR DOOR CLOSE FAULT</strong></td>
</tr>
<tr>
<td>Description: One or more rear door failures to close have been detected. The controller will attempt to close the doors as defined by user parameters (door close protection timer and number of attempts) before declaring this fault. iView Car Operation/Doors tab.</td>
</tr>
<tr>
<td>Car Reaction: The doors will reopen fully. All car calls are canceled and car removes itself from hall call service (hall calls assigned to this car are canceled or reassigned to other cars if available). Doors may be closed using constant pressure on the rear door close button.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Door closed status is determined by the rear door close limit and by the rear door position monitor contact if applicable.</td>
</tr>
<tr>
<td>2. Check the wiring of these signals.</td>
</tr>
<tr>
<td>3. Check the door close protection timer and number of closing attempts on the Operation/Doors tab.</td>
</tr>
<tr>
<td><strong>Rear Door Close Fault Recovery Failure, R DR CLS FLT REC FAIL</strong></td>
</tr>
<tr>
<td>Description: The Door Close Fault Recovery timer starts when a Door Close Fault is generated. When the timer expires, the Door Close Fault is cleared to allow the doors to again attempt to close (see Rear Door Close Fault). This is repeated the number of times specified by the Door Close Fault Recovery Attempts parameter. If the doors have failed to close when the number of attempts equals the recovery attempts parameter setting, the Rear Door Close Fault Recovery Failure is generated.</td>
</tr>
<tr>
<td>Car Reaction: The car is not allowed to run until a mode change is detected or the doors are successfully closed via constant pressure on the Door Close Button.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Door closed status is determined by the rear door close limit and by the rear door position monitor contact if applicable. Check the wiring of these signals.</td>
</tr>
<tr>
<td>2. Check the door close protection timer and number of closing attempts on the Car Operation - Doors tab.</td>
</tr>
<tr>
<td><strong>Rear Door Close Time-out</strong></td>
</tr>
<tr>
<td>Description: A failure of the rear door to close has been detected. The controller will attempt to close the doors for a period of time defined by the Closing protection timer parameter (Door Motor Protection Timers). If the timer elapses prior to the doors closing fully, this event is generated.</td>
</tr>
<tr>
<td>Car Reaction: Doors reopen fully and again attempt to close.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Door closed status is determined by the rear door close limit and by the rear door position monitor contact if applicable.</td>
</tr>
<tr>
<td>2. Check the wiring of these signals.</td>
</tr>
<tr>
<td>3. Check the Closing protection timer (iView Car Operation Configuration/Doors Tab/General Tab/Door Motor Protection Timers).</td>
</tr>
<tr>
<td><strong>Rear Doors Stopped, REAR DOORS STOPPED</strong></td>
</tr>
<tr>
<td>Description: The Door Stop button or Emergency Stop switch was activated causing the doors to be prevented from moving.</td>
</tr>
<tr>
<td>Car Reaction: The car is not allowed to move unless the doors are fully closed.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>This condition can be cleared by activation of the Door Open button, Door Close button or if the car goes into Inspection or Fire Service mode, provided that the Door Stop input is off.</td>
</tr>
<tr>
<td><strong>Rear Door Contact Fault, REAR DOOR CONTCT FLT</strong></td>
</tr>
<tr>
<td>Description: A faulty rear door contact (gate switch, door lock) has been detected. This is detected when the doors are in their fully open position and either the gate switch contact is closed or the doors appear to be locked.</td>
</tr>
<tr>
<td>Car Reaction: All car calls are canceled and the car removes itself from hall call service. The rear doors are not allowed to close and the car is not allowed to run.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Check the rear door gate switch and door lock contact at the floor at which the car is located.</td>
</tr>
<tr>
<td>2. Check associated wiring for these signals.</td>
</tr>
</tbody>
</table>
### iControl Messages

#### Rear Door Open Button Bypassed, REAR DOB BYPASSED

**Description:** The rear door open button has been continuously activated for a user-defined time and is now bypassed according to the user defined setting. ([iView/Car Operation/Doors/Advanced.](#))

**Car Reaction:** The rear door open button is rendered inoperative.

**Troubleshooting:**
1. Check the corresponding input: Rear Door - Open Button (Normally low).
2. Door open button operation can also be restored by setting Door open button bypass option to off (unchecked) ([Car Operation Configuration/Doors Tab/Advanced dialog.](#)).

#### Rear Door Open Fault, REAR DOOR OPEN FAULT

**Description:** One or more rear door failures to open fully detected. After repeated attempts to open door (as specified by user parameters), door open failure is declared. Amount of time allowed for door to open and number of attempts made are user parameters. View [Car Operation/Doors tab, plus Advanced dialog.](#)

**Car Reaction:** The door stalls at its last position. Car calls are canceled and the car removes itself from hall call service (hall calls assigned to this car are canceled or reassigned to other cars if available). Doors may be moved via constant pressure on the door open and door close buttons.

**Troubleshooting:**
1. The door open status is determined by the rear door open limit status.
2. Check the wiring of this signal.
3. Check door open protection timer and number of open attempts on Operation screen Doors tab and associated Advanced dialog.

#### Rear Door Open Time-out

**Description:** Failure of rear door to open detected. Controller will attempt to open doors for a period of time defined by Opening protection timer parameter ([Door Motor Protection Timers.](#)). If timer elapses prior to doors opening fully, this event is generated.

**Car Reaction:** Door open cycle is halted and door is allowed to reclose. If so configured, repeated attempts will be made to open the door. Otherwise, the car is allowed to leave the landing once the doors are closed.

**Troubleshooting:**
1. Door open status determined by rear door open limit and rear door position monitor contact if applicable.
2. Check the wiring of these signals.
3. Check the Opening protection timer ([iView Car Operation Configuration/Doors Tab/General Tab/Door Motor Protection Timers.](#)).

#### Rear Doors Stopped, REAR DOORS STOPPED

**Description:** While the rear doors were opening or closing, the Door Stop button or Emergency Stop switch was activated causing the doors to stop.

**Car Reaction:** The car is not allowed to move unless the doors are fully closed.

**Troubleshooting:** This condition can be cleared by activation of the Door Open button, Door Close button or by changing to a different mode of operation, e.g. Inspection.

#### Rear DPM Open - GS Closed, R DPM OPEN-GS CLOSED

**Description:** The rear door position monitoring contact is open while the gate switch is closed.

**Car Reaction:** None.

**Troubleshooting:** Check the rear door position monitoring contact, gate switch and all related circuitry.

#### Rear Hall Door Open Button Bypassed, REAR HALL DOB BYP

**Description:** Rear hall door open button continuously activated for user-defined time (Door open bypass timer) and is now bypassed according to setting ([Car Operation Configuration/Doors tab/Advanced dialog.](#)).

**Car Reaction:** The rear hall door open button is rendered inoperative.

**Troubleshooting:**
1. Check the corresponding input, Rear Door - Hall Door Open Button: Normally low.
2. Operation of hall door open button can also be restored by setting Door open button bypass option to off (unchecked) ([Car Operation Configuration/Doors tab/Advanced dialog.](#)).

---

**Table 6.3 iControl Messages**

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| Rear Door Open Button Bypassed, REAR DOB BYPASSED | The rear door open button has been continuously activated for a user-defined time and is now bypassed according to the user defined setting. ([iView/Car Operation/Doors/Advanced.](#)) | The rear door open button is rendered inoperative. | 1. Check the corresponding input: Rear Door - Open Button (Normally low).  
2. Door open button operation can also be restored by setting Door open button bypass option to off (unchecked) ([Car Operation Configuration/Doors Tab/Advanced dialog.](#)). |
| Rear Door Open Fault, REAR DOOR OPEN FAULT | One or more rear door failures to open fully detected. After repeated attempts to open door (as specified by user parameters), door open failure is declared. Amount of time allowed for door to open and number of attempts made are user parameters. View [Car Operation/Doors tab, plus Advanced dialog.](#) | The door stalls at its last position. Car calls are canceled and the car removes itself from hall call service (hall calls assigned to this car are canceled or reassigned to other cars if available). Doors may be moved via constant pressure on the door open and door close buttons. | 1. The door open status is determined by the rear door open limit status.  
2. Check the wiring of this signal.  
3. Check door open protection timer and number of open attempts on Operation screen Doors tab and associated Advanced dialog. |
| Rear Door Open Time-out | Failure of rear door to open detected. Controller will attempt to open doors for a period of time defined by Opening protection timer parameter ([Door Motor Protection Timers.](#)). If timer elapses prior to doors opening fully, this event is generated. | Door open cycle is halted and door is allowed to reclose. If so configured, repeated attempts will be made to open the door. Otherwise, the car is allowed to leave the landing once the doors are closed. | 1. Door open status determined by rear door open limit and rear door position monitor contact if applicable.  
2. Check the wiring of these signals.  
3. Check the Opening protection timer ([iView Car Operation Configuration/Doors Tab/General Tab/Door Motor Protection Timers.](#)). |
| Rear Doors Stopped, REAR DOORS STOPPED | While the rear doors were opening or closing, the Door Stop button or Emergency Stop switch was activated causing the doors to stop. | The car is not allowed to move unless the doors are fully closed. | This condition can be cleared by activation of the Door Open button, Door Close button or by changing to a different mode of operation, e.g. Inspection. |
| Rear DPM Open - GS Closed, R DPM OPEN-GS CLOSED | The rear door position monitoring contact is open while the gate switch is closed. | None. | Check the rear door position monitoring contact, gate switch and all related circuitry. |
| Rear Hall Door Open Button Bypassed, REAR HALL DOB BYP | Rear hall door open button continuously activated for user-defined time (Door open bypass timer) and is now bypassed according to setting ([Car Operation Configuration/Doors tab/Advanced dialog.](#)). | The rear hall door open button is rendered inoperative. | 1. Check the corresponding input, Rear Door - Hall Door Open Button: Normally low.  
2. Operation of hall door open button can also be restored by setting Door open button bypass option to off (unchecked) ([Car Operation Configuration/Doors tab/Advanced dialog.](#)). |
## Troubleshooting

### Rear Photo Eye Bypassed, REAR PHOTO EYE BYP
**Description:** The rear photo eye device has been continuously activated for a user-defined time and is now bypassed in accordance to the user-defined setting. (iView/Car Operation/Passenger/Anti Nuisance.)
**Car Reaction:** The rear photo eye device is rendered inoperative.
**Troubleshooting:**
1. To restore the operation of the photo eye device, check the corresponding input.
2. Related inputs:
   - PhotoEyeRear: Normally low

### Rear Photo Eye Failure, REAR PHOTO EYE FAIL
**Description:** This event is logged when the photo eye is continuously activated for a predetermined time (4 seconds) while the rear doors are fully closed.
**Car Reaction:** The rear photo eye is rendered inoperative.
**Troubleshooting:**
1. Check for abnormal blockage or failure of the rear optical device.
2. Related inputs:
   - RearPhotoEye: Normally low

### Rear Safe Edge Bypassed, REAR SAFE EDGE BYP
**Description:** The rear door safe edge has been continuously activated for a user-defined time and is now bypassed according to the user-defined setting. (iView/Car Operation/Common/Door Device Bypass Timers.)
**Car Reaction:** The rear safe edge is rendered inoperative.
**Troubleshooting:**
1. Check the state of the rear safe edge input.
2. Related inputs:
   - SafeEdgeRear: Normally low

### Rear Safe Edge Failure, REAR SAFE EDGE FAIL
**Description:** This event is logged when the rear door safe edge is continuously activated for a predetermined time (4 seconds) while the rear doors are fully closed.
**Car Reaction:** The rear door safe edge is rendered inoperative.
**Troubleshooting:**
1. Check for abnormal blockage or failure of the rear door mechanical reopening device.
2. Related inputs:
   - RearSafeEdge: Normally low

### Receive Sys Params
**Description:** Indicates that this controller is receiving system parameters from the Central or Local / Dispatcher. (DO NOT RESET THE CONTROLLER).

### Restricted, RESTRICTED
**Description:** Indicates that this controller has been shipped with Restricted Mode enabled. The controller will run in all modes of operation, but will not accept hall call assignments. Restricted mode can be terminated at any time by entering the Restricted Mode Key as described in document 42-IS-0144, *Restricted Mode Instruction for iControl Users.* Obtain the Restricted Mode Key by calling MCE’s Credit Department at (916) 463-9582. When calling, please provide the controller’s job number and car identifier.

### R DR CLS FLT REC FAIL
See Rear Door Close Fault Recovery Failure
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Retiring Cam Door Lock Fault Activated, Retiring Cam Door Lock Fault, RETIRING CAM DLK FLT** | Door locks have failed to make up within user-adjustable time after user adjustable number of attempts to lock doors. This fault is detected on cars equipped with a retiring cam door lock mechanism. | Car is taken out of service and doors re-open fully. The doors can be closed with constant pressure on the door close button. | 1. Check the door locks and the retiring cam circuitry.  
2. Verify that the related user-defined parameters are correct.  
3. Cleared by any mode of operation change or if doors are closed (constant pressure, door closed button.) |
| **Retiring Cam Door Lock Fault Deactivated.** | See Retiring Cam Door Lock Fault Activated | | |
| **Retiring Cam Protection Fault Activated, Retiring Cam Protection Fault, RET CAM PROTECTIN FLT** | Retiring cam output has been activated for a pre-determined user-adjustable time after the doors have successfully been locked. This fault is monitored in the event the car fails to reach its destination. | Emergency stop if the car is traveling when the fault is detected. The car is taken out of service. If the car is at a landing, the doors shall re-open fully. | 1. Check the door locks and the retiring cam circuitry.  
2. Verify that the related parameters are correct.  
3. This fault is cleared by any mode of operation change or by the iBox Fault Reset button. |
| **Retiring Cam Protection Fault Deactivated.** | See Retiring Cam Protection Fault Activated | | |
| **Sabbath Operation Activated, Sabbath Operation, SABBATH OPERATION.** | The elevator is operating in Sabbath mode initiated by a software command, switched input or timer. Sabbath mode allows the elevator to operate, serving the building without requiring buttons to be pressed for hall calls or car calls. Car behavior is determined by parameters located on the Car Operation Configuration > Sabbath tab. | | |
| **Sabbath Operation Deactivated.** | See Sabbath Operation Activated. | | |
| **Safety A Contract Overspeed Fault, SPA COS FAULT** | The car has exceeded the Contract Overspeed setting (iView, Safety Configuration screen). This fault may be bypassed on the Diagnostics > Fault Bypass tab. | Emergency Stop: Motor contactor and brake contactor immediately dropped. | 1. The fault will automatically clear 5 seconds after the car stops. The car is then allowed to run again.  
2. Check the contract overspeed parameter for proper setting (iView/Safety Configuration/General). |
| **Safety A DETS Level 2 Speed Fault, SPA DETS L2 SPEED FLT** | The car contacted the Down Emergency Terminal Switch while traveling at over 95% of contract speed. This fault may be bypassed on the Diagnostics > Fault Bypass tab. | Emergency stop: Motor contactor and brake contactor immediately dropped. | 1. The fault will automatically clear 5 seconds after the car stops. The car is then allowed to run again.  
2. Check for the proper positioning of the DETS switch in the hoistway. |
| **Safety A IMP Configuration Mismatch** | The parameters saved in the Safety system do not match the values saved in the main processor. When Safety screen parameters are changed, this message appears after the Send button is pressed. Complete a Safety learn operation as directed on the iView Safety Configuration screen to learn the new safety configuration. | Car will not run. | 1. Using iView, check the values programmed under the Safety Configuration screen. Verify that they are correct.  
2. Download correct values to the Safety system by executing the learn process from the Safety screen. |
## Troubleshooting

### Safety A Inspection Leveling Overspeed Fault, SPA LOS FAULT

**Description:** The car exceeded the leveling overspeed limit (detected by safety processor A). This fault may be bypassed on the Diagnostics > Fault Bypass tab.

**Car Reaction:** Emergency stop: Motor contactor and brake contactor immediately dropped.

**Troubleshooting:**
1. The fault will automatically clear 5 seconds after the car stops. The car is then allowed to move again.
2. Check the leveling overspeed parameter for proper setting (iView/Safety Config/General).

### Safety A Inspection Overspeed Fault, SPA IOS FAULT

**Description:** The car has exceeded the inspection overspeed limit of 150 fpm (detected by safety processor A). This fault may be bypassed on the Diagnostics > Fault Bypass tab.

**Car Reaction:** Emergency stop: Motor contactor and brake contactor immediately dropped.

**Troubleshooting:**
1. The fault will automatically clear 5 seconds after the car stops. The car is then allowed to move again.

### Safety A SIB Device Fault, SPA SIB DEVICE FAULT

**Description:** Safety Processor A has a problem writing Safety Ice Bus.

**Car Reaction:** Emergency stop: Motor contactor and brake contactor immediately dropped.

**Troubleshooting:**
1. Replace iBox. SAF Board damaged. Contact MCE.

### Safety A SIB Device Fault Off (See: Safety A SIB Device Fault)

### Safety A UETS Level 2 Speed Fault, SPA UETS L2 SPD FLT

**Description:** The car contacted the Up Emergency Terminal Switch while traveling at over 95% of contract speed. This fault may be bypassed on the Diagnostics > Fault Bypass tab.

**Car Reaction:** Emergency stop: Motor contactor and brake contactor immediately dropped.

**Troubleshooting:**
1. The fault will automatically clear 5 seconds after the car stops. The car is then allowed to run again.
2. Check for the proper positioning of the UETS switch in the hoistway.

### Safety A Unintended Motion Fault, SPA UNTD MOTION FLT

**Description:** Safety processor A has detected that both hoistway doors and car gate doors were open as the car moved away from the floor without a command from the iControl main processor (IMP board) to move.

**Car Reaction:** Emergency stop: Motor contactor and brake contactor immediately dropped. If applicable, the rope brake drops.

**Troubleshooting:**
1. Check for proper door operation and control.
2. Close the hoistway doors and close the car gate.
3. Press the Fault Reset button. Test.

### Safety B Contract Overspeed Fault, SPB COS FAULT

**Description:** The car has exceeded the Contract Overspeed setting. This fault may be bypassed on the Diagnostics > Fault Bypass tab.

**Car Reaction:** Emergency stop: Motor contactor and brake contactor immediately dropped.

**Troubleshooting:**
1. The fault will automatically clear 5 seconds after the car stops. The car is then allowed to run again.
2. Check the contract overspeed parameter for proper setting. (iView/Safety Config/General)

---

### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Safety A Inspection Leveling Overspeed Fault, SPA LOS FAULT</strong></td>
<td>The car exceeded the leveling overspeed limit (detected by safety processor A). This fault may be bypassed on the Diagnostics &gt; Fault Bypass tab.</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
<td>1. The fault will automatically clear 5 seconds after the car stops. The car is then allowed to move again. 2. Check the leveling overspeed parameter for proper setting (iView/Safety Config/General).</td>
</tr>
<tr>
<td><strong>Safety A Inspection Overspeed Fault, SPA IOS FAULT</strong></td>
<td>The car has exceeded the inspection overspeed limit of 150 fpm (detected by safety processor A). This fault may be bypassed on the Diagnostics &gt; Fault Bypass tab.</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
<td>1. The fault will automatically clear 5 seconds after the car stops. The car is then allowed to move again.</td>
</tr>
<tr>
<td><strong>Safety A SIB Device Fault, SPA SIB DEVICE FAULT</strong></td>
<td>Safety Processor A has a problem writing Safety Ice Bus.</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
<td>1. Replace iBox. SAF Board damaged. Contact MCE.</td>
</tr>
<tr>
<td><strong>Safety A UETS Level 2 Speed Fault, SPA UETS L2 SPD FLT</strong></td>
<td>The car contacted the Up Emergency Terminal Switch while traveling at over 95% of contract speed. This fault may be bypassed on the Diagnostics &gt; Fault Bypass tab.</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
<td>1. The fault will automatically clear 5 seconds after the car stops. The car is then allowed to run again. 2. Check for the proper positioning of the UETS switch in the hoistway.</td>
</tr>
<tr>
<td><strong>Safety A Unintended Motion Fault, SPA UNTD MOTION FLT</strong></td>
<td>Safety processor A has detected that both hoistway doors and car gate doors were open as the car moved away from the floor without a command from the iControl main processor (IMP board) to move.</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped. If applicable, the rope brake drops.</td>
<td>1. Check for proper door operation and control. 2. Close the hoistway doors and close the car gate. 3. Press the Fault Reset button. Test.</td>
</tr>
<tr>
<td><strong>Safety B Contract Overspeed Fault, SPB COS FAULT</strong></td>
<td>The car has exceeded the Contract Overspeed setting. This fault may be bypassed on the Diagnostics &gt; Fault Bypass tab.</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
<td>1. The fault will automatically clear 5 seconds after the car stops. The car is then allowed to run again. 2. Check the contract overspeed parameter for proper setting. (iView/Safety Config/General)</td>
</tr>
</tbody>
</table>
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Safety B DETS Level 2 Speed Fault, SPB DETS L2 SPEED FLT**  | The car contacted the Down Emergency Terminal Switch while traveling at over 95% of contract speed. This fault may be bypassed on the Diagnostics > Fault Bypass tab. | Emergency stop: Motor contactor and brake contactor immediately dropped. | 1. The fault will automatically clear 5 seconds after the car stops. The car is then allowed to run again.  
2. Check for the proper positioning of the DETS switch in the hoistway. |
| **Safety B Fault Activated, SAFETY B FAULT**                   | This event is logged and related car status messages displayed on the OBD and iView if a fault is detected by safety processor B but not by safety processor A. | Emergency stop: Motor contactor and brake contactor immediately dropped. All calls are immediately cancelled. | 1. Check the Event Log for other faults and information related to this fault. |
| **Safety B Fault deactivated (See: Safety B Fault Activated)** |                                                                                   |                                       |                                                                                 |
| **Safety B Fault Bypass Switch Timed Out**                     | Indicates that a fault bypass has timed out. (Bypasses are allowed for 15 minutes with the iBox Fault/Function Bypass switch in the ON position.) On Inspection mode, this fault is bypassed indefinitely. | Emergency stop: Motor contactor and brake contactor immediately dropped. | 1. To clear this fault, place the Fault/Function Bypass switch to the OFF position. |
| **Safety B Inspection Leveling Overspeed Fault, SPB LOS FAULT**| The car exceeded the leveling overspeed limit (detected by safety processor B). This fault may be bypassed on the Diagnostics > Fault Bypass tab. | Emergency stop: Motor contactor and brake contactor immediately dropped. | 1. The fault will automatically clear 5 seconds after the car stops. The car is then allowed to move again.  
2. Check the leveling overspeed parameter for proper setting (iView/Safety Config/General). |
| **Safety B Inspection Overspeed Fault, SPB IOS FAULT**         | The car has exceeded the inspection overspeed limit of 150 fpm (detected by safety processor B). | Emergency stop: Motor contactor and brake contactor immediately dropped. | 1. The fault will automatically clear 5 seconds after the car stops. The car is then allowed to move again. |
| **Safety B SIB Device Fault, SPB SIB DEVICE FAULT**           | Safety Processor B has a problem writing Safety Ice Bus.                         | Emergency stop: Motor contactor and brake contactor immediately dropped. | 1. Replace iBox. SAF Board damaged. Contact MCE. |
| **Safety B SIB Device Fault Off (See: Safety B SIB Device Fault)** |                                                                                   |                                       |                                                                                 |
| **Safety B Safety Bypass Jumper Timed Out**                    | Safety Processor B detected Safety Bypass Jumper has been on for more than 15 minutes. | The car will not be allowed to restart after the end of the current run. | 1. Remove the iBox Safety Bypass Jumper.  
2. If more time is needed in the Safety Bypass mode, then reinstall Safety Bypass Jumper and the 15 minute timer will restart. |
## Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Safety B UETS Level 2 Speed Fault, SPB UETS L2 SPD FLT**                        | Description: The car contacted the Up Emergency Terminal Switch while traveling at over 95% of contract speed. This fault may be bypassed on the Diagnostics > Fault Bypass tab. | Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped. | Troubleshooting:  
1. The fault will automatically clear 5 seconds after the car stops. The car is then allowed to run again.  
2. Check for the proper positioning of the UETS switch in the hoistway. |
| **Safety B Unintended Motion Fault, SPB UNTD MOTION FLT**                         | Description: Safety processor B has detected that both hoistway doors and car gate doors were open as the car moved away from the floor without a command from the iControl main processor (IMP board) to move. | Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped. If applicable, the rope brake drops. | Troubleshooting:  
1. Check for proper door operation and control.  
2. Close the hoistway doors and close the car gate.  
3. Press the Fault Reset button. Test. |
| **Safety Bypass Jumper On**                                                      | Description: Indicates that the Safety Bypass Jumper is in place.           |                                                                              |                                                                                  |
| **Safety Bypass Jumper Timed Out, SFTY BYP JMPR TMD OUT**                         | Description: Safety Processor A has detected that the Safety Bypass Jumper has been on for more than 15 minutes. | Car Reaction: The car will not be allowed to restart after the end of the current run. | Troubleshooting:  
1. Remove the iBox Safety Bypass Jumper.  
2. If more time is needed in the Safety Bypass mode, then reinstall Safety Bypass Jumper and the 15 minute timer will restart. |
| **Safety C String Open, SAFETY C STRING OPEN**                                   | Description: The input has dropped. Input does not come on when bypassed, but the bypass will allow it to run on Test and Machine Room Inspection. | Car Reaction: Emergency stop if running. The car is not allowed to run until the problem is corrected. | Troubleshooting:  
1. Check the car safety string elements and finally the actual input to the iBox. |
| **Safety C String Open Off** (See: Safety C String Open)                         |                                                                              |                                                                              |                                                                                  |
| **Safety Configuration Checksum Fault, SFTY CONFIG CHKSM FLT**                   | Description: Safety configuration parameters stored in nonvolatile memory are corrupt or missing. | Car Reaction: The car is not allowed to move.                               | Troubleshooting:  
| **Safety Configuration Learn Fault, SFTY CONFIG LEARN FLT**                     | Description: Safety Processor A had a failure when storing configuration values to nonvolatile memory. | Car Reaction: Car will not run until fault is cleared.                       | Troubleshooting:  
1. Make sure the car is on Machine Room Inspection before learning the safety configuration.  
2. Check that the installed safety configuration matches the selections on the Safety Configuration screen and that no bypasses are in place.  
3. Repeat the learn process. Please refer to “Setup - Safety - Configuration Tab” on page 9-151.  
4. If unsuccessful, contact MCE Technical Support. (Possible iBox failure.) |
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Safety Configuration Mismatch, SFTY CONFIG MISMATCH**                           | Description: The parameters saved in the Safety system do not match the values saved in the main processor. | Car will not run.                                                             | 1. Using iView, check the values programmed under the Safety Configuration screen. Verify that they are correct.  
2. Download correct values to the Safety system by executing the learn process from the Safety tab. Please refer to “Setup - Safety - Configuration Tab” on page 9-151. |
| **Safety Configuration Inventory Cross Check Fault, SFTY VCTR XCHK FLT**         | Description: The safety-related boards in the controller do not match the learned configuration. | The car is not allowed to move.                                                | 1. Verify safety bus inventory against safety configuration. If changes are made, relearn the safety configuration. Please refer to "Setup - Safety - Configuration Tab" on page 9-151.  
2. Re-learn the board complement (inventory). Please refer to “Setup - Safety - Inventory Tab” on page 9-154. |
| **Safety H String Open, SAFETY H STRING OPEN**                                   | Description: The input has dropped. Input does not come on when bypassed, but the bypass will allow it to run on Test and Machine Room Inspection. | Emergency stop if running. The car is not allowed to run until the problem is corrected. | 1. Check the car safety string elements and finally the actual input to the iBox. |
| **Safety H String Open Off**                                                      | (See: Safety H String Open)                                                 |                                                                              |                                                                                                  |
| **Safety Inventory Checksum Fault, SFTY INVTRY CHKSUM FLT**                      | Description: The Safety Ice bus board inventory stored in nonvolatile memory is corrupt or missing. | The car will not run.                                                         | 1. Relearn the inventory of boards using the Learn operation on the Setup > Safety > Inventory tab.  
2. Reset the fault (press the iBox FAULT RESET button). |
| **Safety Inventory Comparison Fault, SFTY INVTRY COMPARE FLT**                   | Description: The Safety boards attached to the iBox do not match the safety board inventory kept in the safety system. | The car will not run.                                                         | 1. Relearn the inventory of boards using the Learn operation on the Setup > Safety > Inventory tab.  
2. Reset the fault (press the iBox FAULT RESET button). |
| **Safety Inventory Creation Fault, SFTY INVTRY CREATION FLT**                   | Description: During a relearn of the Safety board inventory, the safety system had a problem creating a list of boards in non-volatile storage. | Car will not run.                                                             | 1. Relearn the inventory of boards using the Learn operation on the Setup > Safety > Inventory tab.  
2. Reset the fault (press the iBox FAULT RESET button).  
3. If the fault does not clear, cycle power to the controller. Repeat the first two steps if the fault reoccurs.  
4. If the previous steps are unsuccessful, iBox replacement may be indicated. |
Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **Safety Inventory Learn Fault, SFTY INVTRY LEARN FLT** | Safety Processor A failed to store inventory values to nonvolatile memory. | None | 1. Relearn the inventory of boards using the Learn operation on the Setup > Safety > Inventory tab.  
2. Reset the fault (press the iBox FAULT RESET button).  
3. If the fault does not clear, cycle power to the controller. Repeat the first two steps if the fault reoccurs.  
4. If the previous steps are unsuccessful, iBox replacement may be indicated. |
| **Safety String Open** | Contact in safety circuit is open. | Emergency stop: Motor contactor and brake contactor immediately dropped. | 1. Refer to the job prints. Verify all safety string switches and wiring.  
2. Verify the following have power: SAFC, SAFH, GOV, ESM, and ESC (if the car stop switch bypass is off).  
   Note that SAFC and SAFH can be bypassed by installing the Safety Bypass Jumper on the IRB board if the car needs to be moved off the final limits for example).  
3. If a rope gripper is installed and the rope gripper option is selected, check RGOK is equal to 1.  
4. If a cartop exit is present and the cartop exit option is selected, check that CTEX input is equal to 1.  
5. If Unintended Motion was tripped, clear the Unintended Motion fault.  
6. Clear any faults left on the iBox display.  
7. When the problem is fixed, the fault will automatically clear after 5 seconds. |
| **Secondary Fire Switch On, SEC FIRE SWITCH ON** | The Secondary Fire Recall Switch is in the ON position. | The car will recall to the Main fire recall floor, position its doors as indicated on the Car Operation/Fire/Modify/Fire Recall screen, and await activation of the in-car firefighter switch. | Troubleshooting: If in error, check the Secondary Fire Recall switch input. |
| **Serial COP Bus ‘n’ Comm Fault, SCOP BUS ‘n’ COMM FAULT (n = 1 - 4)** | Indicates lost communication between the ICE-CTP (cartop processor) board and the ICE-COP (serial COP) board for at least 1.5 seconds. | None | 1. Check for a bad cable between the ICE-CTP and ICE-COP boards.  
2. Check for a bad ICE-COP board.  
3. Check for high electrical noise interference.  
4. Check for proper shielding of the cables (board to board and board to controller). |
| **Serial COP Bus ‘n’ Inventory Fault, SCOP BUS ‘n’ INVENTORY FLT (n = 1 - 4)** | Can indicate lost communication between the ICE-COP (serial COP) board and one or more ICE-COP-x boards. Could also indicate that an ICE-COP-x board was connected or disconnected after the system was powered up (I/O inventory changed). | None | 1. Check for bad cable(s) between the ICE-COP and ICE-COP-x boards.  
2. Check for a bad ICE-COP-x board.  
3. Press the RESET button on the ICE-COP board (takes a new inventory). |
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sheave Brake Drop Fault, SHEAVE BRAKE DROP FLT</strong></td>
<td>The sheave brake was disabled via Sheave Brake Enable output, but the Sheave Brake Monitor input was high. There is a five second delay before fault is generated.</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped. All calls are cancelled. The doors will cycle.</td>
<td>1. Verify that the Sheave Brake Monitor input and Sheave Brake Enable output have been programmed (Configuration &gt; I/O Boards &gt; Configuration tab).&lt;br&gt;2. Check the voltage at the Sheave Brake Monitor input and the internal representation via the View button on the Configuration &gt; I/O Boards &gt; Configuration tab.&lt;br&gt;3. Check the voltage at the Sheave Brake Enable output and the internal representation via the View button on the Configuration &gt; I/O Boards &gt; Configuration tab.&lt;br&gt;4. Check the sheave brake mechanism and circuitry.</td>
</tr>
<tr>
<td><strong>Sheave Brake Pick Fault, SHEAVE BRAKE PICK FLT</strong></td>
<td>The sheave brake was enabled via Sheave Brake Enable output, but the Sheave Brake Monitor input was low. There is a five second delay before a fault is generated.</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped. All calls are cancelled. The doors will cycle.</td>
<td>1. Verify that the Sheave Brake Monitor input and Sheave Brake Enable output have been programmed (Configuration &gt; I/O Boards &gt; Configuration tab).&lt;br&gt;2. Check the voltage at the Sheave Brake Monitor input and the internal representation via the View button on the Configuration &gt; I/O Boards &gt; Configuration tab.&lt;br&gt;3. Check the voltage at the Sheave Brake Enable output and the internal representation via the View button on the Configuration &gt; I/O Boards &gt; Configuration tab.&lt;br&gt;4. Check the sheave brake mechanism and circuitry.</td>
</tr>
<tr>
<td><strong>Shuttle Service Activated, SHUTTLE SERVICE ON</strong></td>
<td>Indicates that Shuttle service has been activated via key-switch/input, software command or timer.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Shuttle Service Deactivated, SHUTTLE SERVICE OFF</strong></td>
<td>(see Shuttle Service Activated)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Single Channel QUAD Fault, SNG CHANNEL QUAD FLT</strong></td>
<td>This fault indicates the failure of one of the two landing system quadrature signals (DP1 or DP2).</td>
<td>Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
<td>1. Check DP1 and DP2 wiring from the landing system to the iBox.</td>
</tr>
<tr>
<td><strong>Software Recall Switch Activated, SOFTWARE RECALL ON</strong></td>
<td>The software recall command has been activated via iMonitor.</td>
<td>The car recalls to the specified floor. Car calls and doors operate as specified by the software recall command parameters.</td>
<td>Troubleshooting: Check the status of the recall command and related parameters.</td>
</tr>
<tr>
<td><strong>SPA Spare Event 'n' (n = 1 to 8)</strong></td>
<td>SPA Spare Events 1 through 8 are used for testing.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Speed Limit, MF Forcing, SPD LMT MF FORCING</strong></td>
<td>The system detected armature current without the armature current command. (The motor field is forced to help dynamic braking slow the car.) DC controls only.</td>
<td></td>
<td>1. Check that the brake is setting properly.</td>
</tr>
</tbody>
</table>
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Stuck Cartop Inspection Input, STUCK CT INSPI. INPUT</strong></td>
</tr>
<tr>
<td>Description: Stuck inspection monitoring is enabled by the Monitor cartop and car panel inspection inputs option (Setup &gt; Safety &gt; Configuration tab). During passenger (automatic) operation, this message is generated if any of the cartop inspection inputs (CTEN, ICTU, ICTD) remain high for more than 250msec. During inspection operation, this message is generated if any combination of cartop inspection inputs remain high for more than five seconds, except for the following two, Enable plus Up (CTEN + ICTU) and Enable plus Down (CTEN + ICTD).</td>
</tr>
<tr>
<td>Car Reaction: None</td>
</tr>
<tr>
<td>Troubleshooting: Check and fix the car panel inspection buttons and related circuitry (Enable, Up, Down).</td>
</tr>
<tr>
<td><strong>Stuck Car Panel Inspection Input, STUCK CP INSPI. INPUT</strong></td>
</tr>
<tr>
<td>Description: Stuck inspection monitoring is enabled by the Monitor cartop and car panel inspection inputs option (Setup &gt; Safety &gt; Configuration tab). During passenger (automatic) operation, this message is generated if any of the car panel inspection inputs (ICEN, ICPU, ICPD) remain high for more than 250msec. During inspection operation, this message is generated if any combination of car panel inspection inputs remain high for more than five seconds, except for the following two, Enable plus Up (ICEN + ICPU) and Enable plus Down (ICEN + ICPD).</td>
</tr>
<tr>
<td>Car Reaction: None</td>
</tr>
<tr>
<td>Troubleshooting: Check and fix the cartop inspection buttons and related circuitry (Enable, Up, Down).</td>
</tr>
<tr>
<td><strong>Stuck Inspection Input Fault, STUCK IN. INPUT FLT</strong></td>
</tr>
<tr>
<td>Description: This fault is generated when a stuck inspection input is detected during passenger (automatic) operation (see Stuck Cartop / Car Panel Inspection Input message). The fault is not generated if the car was on inspection operation. To avoid entrapment, the fault is not generated until the car has reached a floor.</td>
</tr>
<tr>
<td>Car Reaction: All hall calls are reassigned or canceled. The car will complete its run. When the car is at a floor, doors are cycled to let the passengers out and all car calls are canceled. The car is shut down and remains out-of-service until the fault is cleared.</td>
</tr>
<tr>
<td>Troubleshooting: Check and fix all inspection inputs/buttons. Then press the iBox Fault reset button.</td>
</tr>
<tr>
<td><strong>Swing Operation Activated, Swing Operation, SWING OPERATION</strong></td>
</tr>
<tr>
<td>Description: Indicates that the car is in swing car operation, independent of the Group Controller. The car should be servicing a riser of hall calls dedicated to the car. The car will use settings from the Simplex Hall Call and Parking related settings from the car Simplex supervisor screens.</td>
</tr>
<tr>
<td><strong>Swing Operation Deactivated. See Swing Operation Activated.</strong></td>
</tr>
<tr>
<td><strong>SYSTEM SYNC</strong></td>
</tr>
<tr>
<td>Description: The iBox is establishing communication with the cartop and acquiring position data.</td>
</tr>
<tr>
<td><strong>Tach Error Fault, TACH ERROR FAULT</strong></td>
</tr>
<tr>
<td>Description: Indicates that the difference between the intended speed and the speed feedback signal has exceeded the Following Error parameter.</td>
</tr>
<tr>
<td>Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped. Followed by normal run.</td>
</tr>
<tr>
<td>Troubleshooting: 1. Please refer to “Tach Error Tripping Threshold Adjustment” on page 4-40.</td>
</tr>
<tr>
<td><strong>Tach Failure, TACH FAILURE</strong></td>
</tr>
<tr>
<td>Description: Indicates that the difference between the synthetic tach signal and the external speed feedback signal has exceeded the tolerance value. DC controls only.</td>
</tr>
<tr>
<td>Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped. Cancel all calls.</td>
</tr>
</tbody>
</table>
# Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th>Description</th>
<th>Car Reaction</th>
<th>Troubleshooting</th>
</tr>
</thead>
</table>
| **TERMINAL LEARN ON**                                   | Description: This message on iBox display, indicates system is prepared to learn speed and position values for normal (UNT1-5/DNT1-5) and emergency (UETS/DETS) terminal switches. |                                                                               | 1. Verify car was not moved after power was shut off.  
2. Verify up/down normal terminal switch #5 opens at appropriate location. When up/down switch opens, no LU or LD sensor should be active. Also, only one floor magnet should be encountered in direction of travel after up/down switch opens.  
3. Move car past floors around vicinity of fault and verify the proper activation of the LU and LD sensors.  
4. Verify system is communicating with cartop (no Cartop Communication Fault).  
5. Verify absolute and cartop positions change by same amount and same direction while moving the car.  
6. Verify that the terminal magnet has not fallen off.  
7. Check clearance between floor sensor board and magnets. May be off just enough to make some magnets fail to register properly. Adjust the clearance if necessary.  
8. Re-learn the floor heights. |  |
| **Terminal Synchronization Fault, TERMINAL SYNC FAULT**  | Description: The system either did not receive edge position data from the cartop or the system did not detect a floor position magnet where expected. | Car stops after crossing floor magnet at top or bottom terminal and is not allowed to move. |  |
| **Car Reaction**                                         |                                                                                                 |                                                                               |  |
| **Test Mode, Test**                                     | Description: Indicates that the elevator is in the Test mode of operation. iBox Test switch in Test position. | Door operation is disabled. This setting is used to adjust or test the elevator. |  |
| **Test**                                                 |                                                                                                 |                                                                               |  |
| **This Car Alternate Fire Sensor Recall, THIS CAR ALT FIRE** | Description: Recall to the alternate fire floor due to active or latched smoke detector input(s) from the cars hoistway or machine room. | Car proceeds to the user-defined alternate fire recall floor. Once at the recall floor, door operation is according to the user-defined door operation under fire recall operation. The fire warning indicator light will flash. | 1. If in error, inspect the sensors, inputs, and connections.  
2. Related Inputs: This Car Alt Recall sensor inputs as shown on the job prints. |  |
| **This Car Main Fire Sensor Recall, THIS CAR MAIN FIRE**  | Description: Recall to the main fire floor due to active or latched smoke detector input(s) from the cars hoistway or machine room. | Car proceeds to the user-defined main fire recall floor. Once at the recall floor, door operation is according to the user-defined door operation under fire recall operation. The fire warning indicator light will flash. | 1. If in error, inspect the sensors, inputs, and connections.  
2. Related Inputs: This Car Main Recall sensor inputs as shown on the job prints. |  |
| **Unintended Motion Fault**                             | (see Safety A Unintended Motion Fault)                                                           |                                                                               |  |
| **Up Direction Limit Open, UP DIR LIMIT OPEN**           | Description: The up normal terminal direction switch is open                                     | Immediate stop if moving. Further up direction movement is prevented.         | 1. Verify that the switch is operating properly.  
2. Verify correct state of the iBox UNTD input.  
3. Verify UNTD switch activating/deactivating at the appropriate location (normally 2” below the bottom terminal landing - see prints). |
### Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Up Emergency Terminal Switch Position Fault, UP ETS POSITION FAULT</strong></td>
<td></td>
</tr>
<tr>
<td>Description: Reported position upon encountering Terminal Switch differed from learned position by more than set position margin. This fault may be bypassed on the Diagnostics &gt; Fault Bypass tab.</td>
<td></td>
</tr>
<tr>
<td>Car Reaction: Emergency Stop: Motor contactor/brake contactor dropped. All hall and car calls are cancelled. After car is stopped, it will run at Correction speed to the next available floor and cycle door. Door Open button will remain operational. If generated when car is moving, fault will stay latched and Fault Reset button must be pushed to clear. If generated when car is not moving, fault will self clear when condition clears.</td>
<td></td>
</tr>
<tr>
<td>Troubleshooting:</td>
<td></td>
</tr>
<tr>
<td>1. Physically check the integrity of the switch and wiring.</td>
<td></td>
</tr>
<tr>
<td>2. Check the iBox input for the switch.</td>
<td></td>
</tr>
<tr>
<td>3. On the Diagnostics &gt; Terminal Switches Status tab, compare the Last pass position to the Learned position for this switch. Verify that Position Margin is within a reasonable range (Configuration &gt; Terminal Switches tab). If appropriate, move the switch closer to the terminal landing.</td>
<td></td>
</tr>
<tr>
<td><strong>Up Emergency Terminal Switch Shutdown, UP ETS SHUTDOWN</strong></td>
<td></td>
</tr>
<tr>
<td>Description: The Up Emergency Terminal Switch opened at a speed or position exceeding its specified threshold. The fault stays latched and the Fault Reset button must be pushed to clear it. If generated when the car is stopped, the fault will self clear when the condition no longer exists.</td>
<td></td>
</tr>
<tr>
<td>Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
<td></td>
</tr>
<tr>
<td>Troubleshooting:</td>
<td></td>
</tr>
<tr>
<td>1. This fault is logged in conjunction with either a speed or position fault at UETS. Check the Event Log and follow the troubleshooting recommended for the Up Emergency Terminal Switch Position Fault or Safety A (or B) UETS Level 2 Speed Fault.</td>
<td></td>
</tr>
<tr>
<td>2. Press iBox Fault Reset to clear the fault.</td>
<td></td>
</tr>
<tr>
<td><strong>Up Normal Terminal Switch ’n’ Level 1 Speed Fault, UP NTS’n’ L1 SPEED FLT (n = 1 to 5)</strong></td>
<td></td>
</tr>
<tr>
<td>Description: Level 1 Overspeed fault detected at Up Normal Terminal switch ‘n’ (1 to 5). When switch opened, car was traveling faster than defined by Level 1 overspeed settings (sum of learned speed plus Overspeed 1 Margin percentage setting on Configuration &gt; Terminal Switches tab) but not fast enough to trigger the Level 2 overspeed fault. This fault may be bypassed on the Diagnostics &gt; Fault Bypass tab.</td>
<td></td>
</tr>
<tr>
<td>Car Reaction: Controlled stop using Emergency Slowdown pattern parameters.</td>
<td></td>
</tr>
<tr>
<td>Troubleshooting:</td>
<td></td>
</tr>
<tr>
<td>1. On the Diagnostics &gt; Terminal Switches Status tab, compare the Last pass and Learned speeds for this switch. If appropriate, increase the Overspeed 1 Margin on the Configuration &gt; Terminal Switches tab.</td>
<td></td>
</tr>
<tr>
<td>2. May be caused by a change in the Pattern parameters. Always re-learn the terminal switches after any changes to Pattern parameters.</td>
<td></td>
</tr>
<tr>
<td>3. One or two floor runs can sometimes come in “hotter” than multi-floor runs.(the switches are learned making full hatch runs). If short runs are causing the problem, increase the Overspeed 1 Margin (Configuration &gt; Terminal Switches tab) or lower the Standard profile - High Roll Jerk parameter (Configuration &gt; Pattern &gt; Modes tab.</td>
<td></td>
</tr>
<tr>
<td>4. Can also be caused by a car that is following the pattern poorly, possibly due to heavy load or poor speed loop performance. In this case, adjust the speed loop to follow pattern as well as possible and/or alter the pattern parameters to produce a gentler deceleration and approach to the floor (then re-learn the switches). Please refer to “Terminal Switch Overspeed and Position Faults” on page 4-54.</td>
<td></td>
</tr>
</tbody>
</table>
Table 6.3 iControl Messages

<table>
<thead>
<tr>
<th>iControl Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Up Normal Terminal Switch ‘n’ Level 2 Speed Fault, UP NTS’n’ L2 SPEED FLT (n = 1 to 5)</strong></td>
</tr>
<tr>
<td>Description: Level 2 Overspeed fault detected at Up Normal Terminal switch ‘n’ (1 to 5). Car traveling faster than Level 2 overspeed settings (105% of sum of learned speed plus Overspeed 1 Margin percentage on Configuration &gt; Terminal Switches tab). This fault may be bypassed on the Diagnostics &gt; Fault Bypass tab.</td>
</tr>
<tr>
<td>Car Reaction: Emergency stop: Motor contactor and brake contactor immediately dropped.</td>
</tr>
<tr>
<td>Troubleshooting:</td>
</tr>
<tr>
<td>1. Check Diagnostics &gt; Terminal Switches Status tab to see how fast car was traveling on Last pass by switch. Check value against Learned speed for switch. If appropriate, increase Overspeed 1 Margin on Configuration &gt; Terminal Switches tab.</td>
</tr>
<tr>
<td>2. May be caused by a change in Pattern parameters. Always re-learn terminal switches after any changes to Pattern parameters.</td>
</tr>
<tr>
<td>3. One or two floor runs may come in “hotter” than multi-floor runs. (switches are learned making full hatch runs.) If short runs are causing this, you may have to increase Overspeed 1 Margin or lower Standard profile - High Roll Jerk parameter.</td>
</tr>
<tr>
<td>4. May be caused by a car that is following pattern poorly, possibly due to heavy load or poor speed loop performance. In this case, adjust speed loop to follow pattern as well as possible and/or alter pattern parameters to produce gentler deceleration and approach to floor (then re-learn the switches). Please refer to “Terminal Switch Overspeed and Position Faults” on page 4-54.</td>
</tr>
</tbody>
</table>

| **Up Normal Terminal Switch ‘n’ Position Fault, UP NTS’n’ POSITION FLT (n = 1 to 6)** |
| Description: When switch opened or closed, car reported position was different from learned position by a value exceeding margin set on Configuration > Terminal Switches tab. May mean switch opened early, late or not at all on terminal approach. May also mean switch closed early, late, or not at all on terminal departure. Finally, the switch can go open while standing at a floor where its learned position is closed, or go closed at a floor where its learned position is open. This fault may be bypassed on the Diagnostics > Fault Bypass tab. |
| Car Reaction: If traveling up, car executes emergency slowdown then continues at low speed until it encounters a floor. Car stops at the floor, opens doors, and performs floor sync operation. If fault persists, car goes out of service. If traveling down, car continues normally to first stop, opens doors and performs a floor sync operation. If fault persists, car goes out of service. If stopped at a floor, car opens doors, does a floor sync, and, if fault persists, goes out of service. |
| Troubleshooting: |
| 1. Diagnostics > Terminal Switches Status tab, compare Last pass position to Learned position for switch. |
| 2. If fault is mechanical (switch movement, magnet movement, or bad traveler cable), it will tend to repeat at the same position every time. |
| 3. A stuck switch is easy to spot by running the car on inspection and observing the input LEDs on the iBox. |
| 4. Perform a Terminal Sync operation (Terminal button on the Configuration > Pattern > Common tab). |

| **User code accessing an invalid logical indicator (internal event)** |
| **User Event ‘n’ Off (n = 1 - 10) (see User Defined Event ‘n’ On)** |
| **User Event ‘n’ On (n = 1 - 10), User Defined Event Fault, USER DEF EVENT FAULT** |
| Description: Indicates that User Event ‘x’ (1 - 10) has been activated via User Input ‘n’ (1 - 10) |
| Car Reaction: Determined by user programming (Configuration > User Inputs tab) |
| Troubleshooting: Determined by user programming (Configuration > User Inputs tab) |

| **Vector Checksum Fault (see Safety Inventory Checksum Fault)** |
| **Vector Comparison Fault (see Safety Inventory Comparison Fault)** |
| **Vector Creation Fault (see Safety Inventory Creation Fault)** |
| **Vector Learn Fault (see Safety Inventory Learn Fault)** |

| **Watchdog Ordered Control Stop Before Reset** |
| Description: Critical component has locked up; car performs emergency stop, system reboots automatically. |
| **Watchdog Ordered Emergency Stop Before Reset** |
| Description: Critical component has locked up; car performs emergency stop, system reboots automatically. |
Circuit Boards and Assemblies

This section contains information to help you troubleshoot and replace iControl circuit boards and assemblies, including:

- Circuit board removal and replacement
- iBox removal and replacement (see “iBox Removal and Replacement” on page 6-73).
- Circuit board QRs (see “iControl Circuit Board Quick References” on page 6-75).

Circuit Board Removal and Replacement

Peripheral circuit boards in iControl and in the iLink cartop box are connected along a central, pluggable bus. The boards are mounted on slide-tracks so that, if you need to replace a board you can loosen the mounting bolts of the boards above or below it, slide them away, then loosen, slide, and remove the board you need to replace. In iControl, the central bus extends both above and below the iBox.

Figure 6.1  Circuit Board Removal and Replacement

Before using iView to assign or reassign inputs or outputs to I/O boards, consult MCE so that your job prints can be corrected. Remember that reassigning an input or output will also require appropriate re-routing of the wiring.
iBox Removal and Replacement

The iBox is designed for relatively simple removal and replacement. The configuration file for the original iBox can be uploaded from a computer to the replacement iBox so that many operational settings will be in place. Some information, like floor heights and brake calibration, etc., may need to be “re-learned” when an iBox is replaced. This section contains:

- iBox Archive File
- iBox Removal
- iBox Installation
- iBox File Upload

iBox Configuration File

As described in Section 8 of this guide, you can easily save the configuration information for the iBox to a computer hard drive (Please refer to “Saving Parameters to a Configuration File” on page 8-20). Some or all of the information in this file can then be “uploaded” to the same or another iBox, simplifying configuration.

1. Locate the archive file for the iBox you need to replace. If no archive file exists, depending on the nature of the malfunction, you may be able to create an archive file now:
   2. Connect to the iBox through its #3 PC Ethernet connector.
   3. Select Save to File from the File menu.
   A typical Windows save dialog will appear. The default name suggested for the file will be the controller connection name with param.xml appended, i.e. if the connection name was CarA, the suggested file name would be CarAparam.xml. The default file suggested in the dialog will be the file folder that contains the connection icon for the controller. You may change either or both of the default suggestions and store the file wherever you wish under any name you wish. As with any Windows file, if you change or delete the file extension (.xml) it will lose its association with the application that created it. It is best to leave the file extension as-is.

4. Save the file to the desired location.

iBox Removal

1. Shut off power at the main disconnect.
2. Open the iControl cabinet.
3. Loosen the iBox cover retaining screws and remove the cover.
4. Unplug all connections to the body of the iBox. You can leave the connections to the rail-mounted circuit boards above and below the iBox connected.
5. Slightly loosen the retaining screws for the rail-mounted circuit boards and slide them away from the iBox (disconnecting the pluggable central bus).
6. Loosen the four captive, retaining screws that secure the iBox to the circuit board rails.
7. Remove the iBox.
**iBox Installation**
1. Verify that power is off at the main disconnect.
2. Open the iControl cabinet.
3. Remove the cover (bezel) from the new iBox.
4. Secure the new iBox in position between the rail-mounted circuit boards.
5. Slide the rail-mounted circuit boards above and below the iBox back into position so that the central bus is plugged back in.
6. Tighten the board retaining screws.
7. Reconnect all cabling to the body of the iBox.

**iBox File Upload**
While online (connected to a controller), you may select a Configuration (.cfg) file and send all or selected data from that file to the controller. Please refer to “Loading Parameters from a Configuration File” on page 8-22.
iControl Circuit Board Quick References

This section contains information about iControl circuit boards and assemblies, including photographs with informational call outs, input/outputs, indicators, jumpers, test points and other information pertinent to troubleshooting.

The circuit boards are listed in the table below. If you are viewing this file on a computer, click the page number to jump to the appropriate section.

Table 6.4  iControl Circuit Boards

<table>
<thead>
<tr>
<th>Board</th>
<th>Name</th>
<th>Where Used</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICE-COP-2</td>
<td>Serial Car Operating Panel Board</td>
<td>Car Operating Panels</td>
<td>page 6-76</td>
</tr>
<tr>
<td>ICE-CTP</td>
<td>Car Top Processor Board</td>
<td>iLink Car Top Interconnect</td>
<td>page 6-78</td>
</tr>
<tr>
<td>ICE-EB</td>
<td>Emergency Brake Board</td>
<td>iControl AC and DC</td>
<td>page 6-84</td>
</tr>
<tr>
<td>ICE-FML</td>
<td>Field Module Logic Board</td>
<td>iControl AD, DC</td>
<td>page 6-85</td>
</tr>
<tr>
<td>ICE-I EQ</td>
<td>Earthquake Board</td>
<td>iControl AC, DC</td>
<td>page 6-88</td>
</tr>
<tr>
<td>ICE-IMP</td>
<td>Main Processor Board</td>
<td>iControl AC, DC</td>
<td>page 6-90</td>
</tr>
<tr>
<td>ICE-IRB</td>
<td>Relay Board</td>
<td>iControl AC, DC</td>
<td>page 6-92</td>
</tr>
<tr>
<td>ICE-IRD</td>
<td>Rear Door Board</td>
<td>iControl AC, DC</td>
<td>page 6-95</td>
</tr>
<tr>
<td>ICE-L CB</td>
<td>Low Current Brake Board</td>
<td>iControl AC, DC</td>
<td>page 6-96</td>
</tr>
<tr>
<td>ICE-MIAC</td>
<td>Multiple Input (120V) AC Board</td>
<td>iControl AC, DC</td>
<td>page 6-97</td>
</tr>
<tr>
<td>ICE-MIAC-24V</td>
<td>Multiple Input (24V) AC or DC Board</td>
<td>iControl AC, DC, iCentral Group, iLink</td>
<td>page 6-97</td>
</tr>
<tr>
<td>ICE-M OR</td>
<td>Multiple Output Relay Board</td>
<td>iControl AC, DC, iCentral Group, iLink</td>
<td>page 6-100</td>
</tr>
<tr>
<td>ICE-RG</td>
<td>Rope Gripper Board</td>
<td>iControl AC, DC</td>
<td>page 6-102</td>
</tr>
<tr>
<td>ICE-S AF</td>
<td>Safety Board</td>
<td>iControl AC, DC</td>
<td>page 6-103</td>
</tr>
<tr>
<td>ICE-SF</td>
<td>Serial Fixture Board</td>
<td>iControl AC, DC</td>
<td>page 6-108</td>
</tr>
<tr>
<td>SC-HCDA-ISO</td>
<td>Serial Hall Call Driver Isolation Board</td>
<td>iControl AC, DC Simplex / Swing Car</td>
<td>page 6-109</td>
</tr>
<tr>
<td>SC-H C E-ME</td>
<td>Serial Hall Call Ethernet - Digi Board</td>
<td>iCentral Group</td>
<td>page 6-110</td>
</tr>
<tr>
<td>SC-H C N T</td>
<td>Serial Hall Call Node Board</td>
<td>Hall Call Fixture Enclosures</td>
<td>page 6-109</td>
</tr>
<tr>
<td>SC-I ON</td>
<td>Serial Control I/O Node Board</td>
<td>iCentral Group</td>
<td>page 6-108</td>
</tr>
</tbody>
</table>
ICE-COP Serial Car Operating Panel Board

The ICE-COP-2 board interfaces between analog devices in the elevator car and serial devices in the elevator controller. Multiple ICE-COP-2 boards may be “daisy-chained” together to accommodate high-rise installations.

Board connection is described in detail on the prints for the specific job.

Normal Operation

During normal operation, I/O LEDs will be lighted when the associated I/O is active (dimmer when the output is active; brighter when the input is active). The SPA processor LED will be continuously lighted. If I/O LEDs remain in a static condition or the SPA processor LED is not continuously on:

- Press the RST button on the board. The I/O LEDs will all cycle and the board will resume operation.

Board Diagnostics

Two DIP switches and the I/O status LEDs provide diagnostic information.

- Set the two bottom DIP switches (1 and 2) to the ON position.
  - I/O 1 and 2 LEDs will flash if RS485 with the cartop is good. LED 1 monitors received data; LED 2 monitors transmitted data. If an LED is not flashing, that phase of communication has failed.
  - I/O 4 and 5 LEDs will flash if SPI communication with the preceding board in the chain is good. LED 4 monitors received data; LED 5 monitors transmitted data. If an LED is not flashing, that phase of communication has failed.
  - I/O 7 and 8 LEDs will flash if SPI communication with the next board in the chain is good. LED 7 monitors received data; LED 8 monitors transmitted data. If an LED is not flashing, that phase of communication has failed.

Software Version Query

Used by themselves (not in conjunction with another DIP switch as in Diagnostics), switches 1, 2, and 3 will separately display the board software version level:

- Switch 1 ON will display the low version number on the first 8 LEDs (IO1 - IO8).
- Switch 2 ON will display the middle version number on the first 8 LEDs (IO1 - IO8).
- Switch 3 ON will display the high version number on the first 8 LEDs (IO1 - IO8).

The number is expressed in binary format with IO1 the least significant and IO8 the most significant value.

Table 6.5 Version Number Example

<table>
<thead>
<tr>
<th>S1</th>
<th>S2</th>
<th>S3</th>
<th>IO8=128</th>
<th>IO7=64</th>
<th>IO6=32</th>
<th>IO5=16</th>
<th>IO4=8</th>
<th>IO3=4</th>
<th>IO2=2</th>
<th>IO1=1</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>ON</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>16</td>
</tr>
<tr>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>ON</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>8</td>
</tr>
<tr>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>OFF</td>
<td>ON</td>
<td>OFF</td>
<td>OFF</td>
<td>ON</td>
<td>ON</td>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>

Example software version: 3.8.16
ICE-COP Serial Car Operating Panel Board

- 4-pin “universal” inputs may be used instead of screw terminals if desired.
- OUT to additional ICE-COP boards (RJ45)
- I/O connections 24 VDC max. 6W max.
- To CTP board in iLink Cartop box
- IN from additional ICE-COP boards (RJ45)
- Board power input. See prints.

Test points:
- +5v
- COM
- GND
- +24V
- Reset button
- 8-position DIP switch package
- SPA processor OK
- Test point, +3.3v

Caution
This system is designed for 24 VDC circuits maximum. Connecting 120VAC or DC will open the input fuses.

4-pin “universal” input connection example
**ICE-CTP Cartop Processor Board**

The Cartop Processor board handles local control and communications for the iLink cartop interconnect. Like the iBox, the Cartop Processor usually has track-mounted expansion boards for extra inputs and outputs.

**Figure 6.2  ICE-CTP Cartop Processor Board**

- Board programming port, factory use only
- LED, Computer On
- Ground Testpoint
- RST OUT testpoint
- Load Weigher testpoint
- LW
- Clock Out testpoint
- Ground testpoint
- TP_LW testpoint
- CTS Cartop Safety Relay, part of the safety string
- +2.5V testpoint
- Load Weigher adjust, LW- testpoint
- Lamp Testpoint
- Refer to iControl User Manual, Section 5 for adjustment instructions
- Fuse F1, 1A, 125VAC, MDQ
- Front door level sensor from iLand
- Rear door level sensor from iLand
- Connectors for serial Car Operating Panel COP boards
### Table 6.6  ICE-CTP Board Connections

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Common</td>
</tr>
<tr>
<td>DLSP</td>
<td>Door Logic Supply (See job prints for source level)</td>
</tr>
<tr>
<td>2</td>
<td>120VAC</td>
</tr>
<tr>
<td>DOF</td>
<td>Door Open Function output (active level =DLSP)</td>
</tr>
<tr>
<td>DBF</td>
<td>Door Boost Function output (active level =DLSP)</td>
</tr>
<tr>
<td>DCF</td>
<td>Door Close Function output (active level =DLSP)</td>
</tr>
<tr>
<td>NUDG</td>
<td>Door Nudge output (active level =DLSP)</td>
</tr>
<tr>
<td>SP1</td>
<td>Spare Input (120VAC signal level)</td>
</tr>
<tr>
<td>SP2</td>
<td>Spare Input (120VAC signal level)</td>
</tr>
<tr>
<td>SP3</td>
<td>Spare Input (120VAC signal level)</td>
</tr>
<tr>
<td>SP4</td>
<td>Spare Input (120VAC signal level)</td>
</tr>
<tr>
<td>SE</td>
<td>(Door) Safe Edge Input (120VAC signal level)</td>
</tr>
<tr>
<td>PHE</td>
<td>Photo Eye input (120VAC signal level)</td>
</tr>
<tr>
<td>DOL</td>
<td>Door Open Limit input (120VAC signal level)</td>
</tr>
<tr>
<td>DCL</td>
<td>Door Close Limit input (120VAC signal level)</td>
</tr>
<tr>
<td>DPM</td>
<td>Door Position Monitor input (120VAC signal level)</td>
</tr>
<tr>
<td>ICTD</td>
<td>Cartop inspection down button (110VDC= switch closed)</td>
</tr>
<tr>
<td>ICTU</td>
<td>Cartop inspection up button (110VDC= switch closed)</td>
</tr>
<tr>
<td>INCT</td>
<td>Cartop inspection switch active (110VDC= switch closed)</td>
</tr>
<tr>
<td>GS</td>
<td>Gate Switch input (110VDC= switch closed)</td>
</tr>
<tr>
<td>GSR</td>
<td>Gate Switch Rear (110VDC= switch closed)</td>
</tr>
<tr>
<td>ULMR</td>
<td>Up Level Marker Rear output (110VDC= output active)</td>
</tr>
<tr>
<td>DZR</td>
<td>Door Zone Rear (110VDC= output active)</td>
</tr>
<tr>
<td>DLMR</td>
<td>Down Level Marker Rear (110VDC= output active)</td>
</tr>
<tr>
<td>ULM</td>
<td>Up Level Marker (110VDC= output active)</td>
</tr>
<tr>
<td>DZ</td>
<td>Door Zone (110VDC= output active)</td>
</tr>
<tr>
<td>DLM</td>
<td>Down Level Marker (110VDC= output active)</td>
</tr>
<tr>
<td>1</td>
<td>Common</td>
</tr>
<tr>
<td>2</td>
<td>120VAC</td>
</tr>
<tr>
<td>3</td>
<td>110VDC</td>
</tr>
<tr>
<td>SCT1</td>
<td>Cartop Safety Contact 1 (110VDC= contact closed)</td>
</tr>
<tr>
<td>SCT2</td>
<td>Cartop Safety Contact 2 (110VDC= contact closed)</td>
</tr>
</tbody>
</table>

### Table 6.7  ICE-CTP Board Connections

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHLD</td>
<td>Shield: Common</td>
</tr>
<tr>
<td>26V</td>
<td>26V output to load weigher</td>
</tr>
<tr>
<td>LW-</td>
<td>Input from Load Weigher (analog voltage)</td>
</tr>
<tr>
<td>LW+</td>
<td>Input from Load Weigher (analog voltage)</td>
</tr>
<tr>
<td>DP2-</td>
<td>Position input from iLand (balanced pair with DP2+)</td>
</tr>
<tr>
<td>DP2+</td>
<td>Position input from iLand (balanced pair with DP2-)</td>
</tr>
<tr>
<td>SHLD</td>
<td>Shield: Common</td>
</tr>
</tbody>
</table>
Figure 6.3   ICE-CTP Board Switches

- Computer Reset: Press to initialize the Cartop Processor board computer.
- Diagnostic Switches: Factory board test use only.
- Program Switch: Used at the factory during board programming.
- Learn Switch: Used at the factory during board programming.
- Test points: +5V, -15V, +15V, -26V, +26V, +3.3V, +E3.3V (emergency logic power provided by on board battery).

ICE-CTP Cartop Diagnostics
On power up or reset, the eight LEDs on the CTP board light sequentially, first in one direction, then the other, after which they will briefly clear.

Diagnostic LED 1 Regardless of switch settings, LED 8 is ON when an interrupt is being serviced. In normal operation it turns on and off quickly enough that it is almost as bright as a fully illuminated LED. If LED 8 stays OFF, the board is not functioning normally and should be reset (press the RESET button).
Note

If there is a problem with communication between the iBox and the CTP board after initial installation, verify that the iBox TX+ and TX- terminals are connected to the CTP board RX+ and RX- terminals, and the iBox RX+ and RX- terminals are connected to the CTP board TX+ and TX- terminals (see “ICE-CTP Board Connections” on page 6-79).

**Manual Reset**  Regardless of switch settings, the LEDs mean the same during reset and startup.

- When the reset button is released, the LEDs will light up one at a time in the following sequence - (1, 2, 3, 4, 5, 6, 7, 8, 7, 6, 5, 4, 3, 2, 1). Normal operation should commence immediately following the reset sequence.

If the reset sequence consists of three iterations of all LEDs on at the same time followed by all LEDs off, the board has been programmed with a non-production version of firmware. The board should be reprogrammed.

**Diagnostic Switches**  The Diagnostic Switches, see “ICE-CTP Board Switches” on page 6-80, must be in the fully ON or fully OFF position to function reliably. Be sure to push the switches firmly in the appropriate direction when setting the switches. The use of a small screwdriver or ballpoint pen is recommended.
Normal Operation  The normal operating condition is with all DIP switches OFF. This gives the normal operation display as follows:

Table 6.9  Diagnostic Indicators (Normal Operation - All DIP Switches OFF)

<table>
<thead>
<tr>
<th>LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Represents message input from iBox to iLink. With proper communication, toggles approximately every 80mS. Goes OFF and stays OFF if input is lost.</td>
</tr>
<tr>
<td>2</td>
<td>Indicates cartop detected an unintended motion safety fault. With the car on Passenger operation, after the car had reached a landing, the car moved at a speed greater than 150 feet-per-minute.</td>
</tr>
<tr>
<td>3</td>
<td>Indicates that the cartop detected an unintended motion safety fault. With the car on Inspection, after the car had reached a landing, the car moved with doors open.</td>
</tr>
<tr>
<td>4</td>
<td>Message output from iLink to iBox. With proper communication, toggles approximately every 80mS. Goes OFF and stays OFF if output is lost.</td>
</tr>
<tr>
<td>5</td>
<td>This is the “alive” indicator. It toggles every 80mS during normal operation.</td>
</tr>
<tr>
<td>6</td>
<td>Lights when the car is on Inspection mode.</td>
</tr>
<tr>
<td>7</td>
<td>Unused.</td>
</tr>
<tr>
<td>8</td>
<td>Indicates an interrupt is being serviced. If it goes off and stays off, the board is not functioning normally and should be reset (press the RESET button).</td>
</tr>
</tbody>
</table>

When the iBox is not active, only LED 5 will toggle. When the iBox is active and normal operations are in progress, LEDs 1, 4 and 5 will toggle regularly.

Firmware Download  Firmware updates can be downloaded via iView. Please refer to “Updating Controller Firmware” on page 8-41. Normally, no manual intervention is needed at the cartop. However, if a problem does develop, the following may be of use in recovering:

1. Set the S1 DIP switches 1, 6 and 8 = ON.
2. Press the Reset button on the ICE-CTP board. This tells the cartop firmware to wait for a firmware download without attempting to run the normal cartop application first.
3. Perform the firmware update using iView (File > Firmware Update).

Board Version  The version and revision of the ICE-CTP board can be determined using the DIP switches and LEDs 1 through 6 (ignore LEDs 7 and 8) The values are in hexadecimal, with LED1 bring the 2⁰ bit. For example, if the number were “01”, LED 1 would be ON and LEDs 2 through 6 would be OFF (LEDs 7 and 8 are not part of the value and must be ignored).

- DIP switch 3 = ON, all others = OFF: Major version number displayed on LEDs.
- DIP switch 2 = ON, all others = OFF: Minor version number displayed on LEDs.
- DIP switch 1 = ON, all others = OFF: Revision number displayed on LEDs.
Receive Serial Data  
There are five serial connections on the cartop - one to the iBox and up to four to Serial COP boards. Each connection can be monitored by setting the S1 DIP switches as described below:

- To monitor data received from iBox, set DIP switches 1 and 4 = ON.
- To monitor data received from COP1, set DIP switches 1, 2 and 4 = ON.
- To monitor data received from COP2, set DIP switches 1, 3 and 4 = ON.
- To monitor data received from COP3, set DIP switches 1, 2, 3 and 4 = ON.
- To monitor data received from COP4, set DIP switches 1, and 5 = ON.

When the LEDs are ON they indicate the following:

- LED1: A non-STX character has been detected when an STX character was expected.
- LED2: An STX character has been received from the cartop.
- LED3: Data characters are being received from the cartop.
- LED4: A CRC character has been received.
- LED5: The CRC check indicates that good data was received.
- LED6: The CRC check indicates that bad data was received.

In normal operation, LEDs 2, 3, and 5 will glow faintly and LED 4 will blink roughly once every 40ms. If LED 1 or 6 is bright, bad data is being received from the cartop. This suggests that there is a serial line quality problem.

Transmit Serial Data  
Set the S1 DIP switches as described below:

- To monitor data transmitted to iBox, set DIP switches 2 and 4 = ON.
- To monitor data transmitted to COP1, set DIP switches 3 and 4 = ON.
- To monitor data transmitted to COP2, set DIP switches 2, 3 and 4 = ON.
- To monitor data transmitted to COP3, set DIP switch 5 = ON.
- To monitor data transmitted to COP4, set DIP switches 2 and 5 = ON.

When the LEDs are ON they indicate the following:

- LED1: The transmitter is in the RESET condition.
- LED2: The board is sending STX characters.
- LED3: The board is sending data characters.
- LED4: The board is sending CRC characters.
- LED5: The transmitter was busy when the board attempted to send data.

In normal operation, LEDs 2, 3, and 4 will glow faintly. If either LED 1 or 5 comes on and stays on, the board has malfunctioned. If a manual reset does not clear the problem, there is a hardware problem on the ICE-CTP board.

If LEDs turn on and stay on, the board is not functioning normally and should be reset (press the RESET button). If the condition persists, there is likely a hardware problem on the board.
**ICE-EB Emergency Brake Board**

The Emergency Brake board is used in iControl AC and DC elevator controllers to control a hoist motor-mounted emergency brake. The emergency brake is typically a separate friction brake mounted on an extended or secondary sheave.

**Figure 6.4  ICE-EB Emergency Brake Board**

![ICE-EB Emergency Brake Board Diagram](image)

---

**Table 6.10  ICE-EB Board Inputs and Outputs**

<table>
<thead>
<tr>
<th>Connector</th>
<th>Signal</th>
<th>Connector</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="EBP1 Connector" /></td>
<td>EBP1: 0VAC= Brk picked, 120VAC= Brk engaged</td>
<td><img src="image" alt="Connector 1" /></td>
<td>1: Common</td>
</tr>
<tr>
<td><img src="image" alt="EBP2 Connector" /></td>
<td>EBP2: 0VAC= Brk picked, 120VAC= Brk engaged</td>
<td><img src="image" alt="24X2 Connector" /></td>
<td>24X2: 24VDC input</td>
</tr>
<tr>
<td><img src="image" alt="EBP3 Connector" /></td>
<td>EBP3: 0VAC= Brk picked, 120VAC= Brk engaged</td>
<td><img src="image" alt="24 Connector" /></td>
<td>24: 24VDC input</td>
</tr>
<tr>
<td><img src="image" alt="EBP4 Connector" /></td>
<td>EBP4: 0VAC= Brk picked, 120VAC= Brk engaged</td>
<td><img src="image" alt="120VAC Connector" /></td>
<td>2: 120VAC input</td>
</tr>
<tr>
<td><img src="image" alt="EBS1 Connector" /></td>
<td>EBS1: 120VAC= Brk OK (picked)</td>
<td><img src="image" alt="GND Connector" /></td>
<td>GND</td>
</tr>
<tr>
<td><img src="image" alt="EBS2 Connector" /></td>
<td>EBS2: 120VAC= Brk OK (picked)</td>
<td><img src="image" alt="+3.3V Connector" /></td>
<td>+3.3V</td>
</tr>
<tr>
<td><img src="image" alt="EBR1 Connector" /></td>
<td>EBR1: 120VAC= Brk picked, 0VAC= Brk engaged</td>
<td><img src="image" alt="+5V Connector" /></td>
<td>+5V</td>
</tr>
<tr>
<td><img src="image" alt="EBR2 Connector" /></td>
<td>EBR2: 120VAC= Brk picked, 0VAC= Brk engaged</td>
<td><img src="image" alt="+24V Connector" /></td>
<td>+24V</td>
</tr>
</tbody>
</table>

The user makes no direct connections to this board. Refer to job prints for circuit information.
ICE-FML Field Module Logic Board

iField Modules are used to supply power to the brake on iControl AC and DC systems and to the motor field on iControl with DC drive. The iField Modules used for both purposes are the same, with the exception of the wiring to terminal J7 on the ICE-FMP, Field Module Power Board.

<table>
<thead>
<tr>
<th>IFIELD-MODULE Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inputs: 70 VAC min, 300 VAC max, 1 Phase, 50/60Hz, 42 AMPS Maximum</td>
</tr>
<tr>
<td>Outputs: 0 VDC minimum, 265 VDC maximum, 45 AMPS Maximum</td>
</tr>
<tr>
<td>OVER-CURRENT PROTECTION REQUIRED ON INPUT</td>
</tr>
<tr>
<td>- For loads up to 30A - use Bussman type FNQ or LittleFuse type FLQ</td>
</tr>
<tr>
<td>- For loads over 30A - use Ferraz Shawmut type A50QS80-4 or LittleFuse type L50S80</td>
</tr>
</tbody>
</table>
**Table 6.11** IFIELD-MODULE Indicators on the ICE-FML Board

<table>
<thead>
<tr>
<th>Indicators</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+15 ISO OK</td>
<td>LED indicator for isolated +15V power supply, measured with respect to isolated Ground, GND-ISO. Normally ON. Turns OFF when module loses +15 ISO voltage.</td>
</tr>
<tr>
<td>F. BAD</td>
<td>LED indicator for AC input on FMX1 and FMX2 terminals (on FMP board). Normally OFF. Turns ON when any input side AC fuse opens.</td>
</tr>
<tr>
<td>+15 OK</td>
<td>LED indicator for +15V power supply, measured with respect to Ground. Normally ON. Turns OFF when module loses +15V.</td>
</tr>
<tr>
<td>HI TEMP</td>
<td>LED turns ON to indicate high temperature on the heatsink. Normally OFF. Turns ON when the temperature of the main IGBT raises above 85°C (185°F).</td>
</tr>
<tr>
<td>IGBT FLT</td>
<td>LED turns ON to indicate that the AUX IGBT has failed open.</td>
</tr>
</tbody>
</table>
### Table 6.12 IFIELD MODULE Terminals on the ICE-FML Board

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>BUS: AC input supply to the ICE-FML Board.</td>
</tr>
<tr>
<td>2</td>
<td>2B BUS: AC input supply to the ICE-FML Board.</td>
</tr>
<tr>
<td>FAN 1</td>
<td>(not used) Terminals for connecting an external fan.</td>
</tr>
<tr>
<td>FAN 2</td>
<td>(not used) Terminals for connecting an external fan.</td>
</tr>
<tr>
<td>TEMP 1</td>
<td>(not used) Terminals for connecting an external temperature sensor.</td>
</tr>
<tr>
<td>TEMP 2</td>
<td>(not used) Terminals for connecting an external temperature sensor.</td>
</tr>
</tbody>
</table>

### Table 6.13 IFIELD-MODULE Terminals on the ICE-FMP Board (Brake Module)

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FMO+</td>
<td>Field Module Output, positive, to brake coil.</td>
</tr>
<tr>
<td>FMO-</td>
<td>Field Module Output, negative, to brake coil.</td>
</tr>
<tr>
<td>FMSI</td>
<td>Field Module Safety Input: Jumpered to FMSO. FMSI and FMSO are always jumpered together unless there is a requirement for a mechanical safety contact to break between the load and the field module.</td>
</tr>
<tr>
<td>FMCI</td>
<td>Field Module Current Input: When load current is higher than 10A, jumper FMCI to FMHC. For load current less than 10A, leave both FMCI and FMHC open.</td>
</tr>
<tr>
<td>FMHC</td>
<td>Field Module High Current: See FMCI.</td>
</tr>
<tr>
<td>FMS1</td>
<td>Field Module Snubber 1: When used as a Brake Module, a shunt RC parallel network (RB &amp; CB) is connected between FMS1 and FMLD.</td>
</tr>
<tr>
<td>FMS2</td>
<td>Field Module Snubber 2: N/C</td>
</tr>
<tr>
<td>FMLD</td>
<td>Field Module Load Diode: FMLD is connected to the cathode of a diode on the ICE-FMP board. FMLD is also connected to RC network RB &amp; CB (see FMS1).</td>
</tr>
<tr>
<td>FMSO</td>
<td>Field Module Safety Output: Jumpered to FMSI. (see FMS1)</td>
</tr>
<tr>
<td>FMX1</td>
<td>AC power input to Field Module from brake contacts (70 VAC min, 300 VAC max)</td>
</tr>
<tr>
<td>FMX2</td>
<td>AC power input to Field Module from brake contacts (70 VAC min, 300 VAC max)</td>
</tr>
</tbody>
</table>

### Table 6.14 IFIELD-MODULE Terminals on the ICE-FMP Board (Motor Field Module)

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FMO+</td>
<td>Field Module Output, positive, to motor field.</td>
</tr>
<tr>
<td>FMO-</td>
<td>Field Module Output, negative, to motor field.</td>
</tr>
<tr>
<td>FMSI</td>
<td>Field Module Safety Input: Jumpered to FMSO. FMSI and FMSO are always jumpered together unless there is a requirement for a mechanical safety contact to break between the load and the field module.</td>
</tr>
<tr>
<td>FMCI</td>
<td>Field Module Current Input: When load current is higher than 10A, jumper FMCI to FMHC. For load current less than 10A, leave both FMCI and FMHC open.</td>
</tr>
<tr>
<td>FMHC</td>
<td>Field Module High Current: See FMCI.</td>
</tr>
<tr>
<td>FMS1</td>
<td>Field Module Snubber 1: When used as a Motor Field Module, an RC filter network (RM &amp; CM) is connected between FMS1 and FMS2. FMS1 is also jumpered to FMLD.</td>
</tr>
<tr>
<td>FMS2</td>
<td>Field Module Snubber 2: Connect to RC filter (CM) see FMS1.</td>
</tr>
<tr>
<td>FMLD</td>
<td>Field Module Load Diode: FMLD is connected to the cathode of a diode on the ICE-FMP board. FMLD is also jumpered to FMS1.</td>
</tr>
<tr>
<td>FMSO</td>
<td>Field Module Safety Output: Jumpered to FMSI. (see FMS1)</td>
</tr>
<tr>
<td>FMX1</td>
<td>AC power input to Field Module (70 VAC min, 300 VAC max)</td>
</tr>
<tr>
<td>FMX2</td>
<td>AC power input to Field Module (70 VAC min, 300 VAC max)</td>
</tr>
</tbody>
</table>
ICE-IEQ Earthquake Board

The Earthquake board provides an interface between motion sensing devices and the iControl elevator controller.

Figure 6.6   ICE-IEQ Earthquake Board

Table 6.15   Earthquake Board Connections

<table>
<thead>
<tr>
<th>Connector</th>
<th>Signal</th>
</tr>
</thead>
</table>
| ![Diagram](image) | EQSP 1:Spare. 0V=Normal. 120VAC=Tripped  
ESS: 120VAC= Normal, 0V= Tripped  
(120VAC from #2 bus, through sensor to ESS)  
CW2: 24VDC= Normal, 0V= String shorted  
CW1: 24VDC= Normal, 0V= String shorted |

<table>
<thead>
<tr>
<th>Connector</th>
<th>Signal</th>
</tr>
</thead>
</table>
| ![Diagram](image) | 1: Common  
CWX2: 18VAC  
CWX1: 18VAC |

EQSP LED  
On = EQ fault  
Off = No EQ fault

ESS LED  
On = Normal  
Off = Seismic device tripped

+24VDC Testpoint  
CW2 LED, On = CW String OK  
CW1 LED, On = CW String OK
The ICE-IMP Main Processor Board provides central processing, data storage, control switches and communication. The Onboard display and ICE-SAF boards plug into the ICE-IMP board.

### Table 6.16 ICE-IMP Jumper Table

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JP1</td>
<td>B</td>
<td>(I^2C) EEPROM Write Protect, (A = \text{ON}, B = \text{OFF})</td>
</tr>
<tr>
<td>JP2</td>
<td>B</td>
<td>MODCK1, processor speed setting</td>
</tr>
<tr>
<td>JP3</td>
<td>A</td>
<td>MODCK2, processor speed setting</td>
</tr>
<tr>
<td>JP4</td>
<td>B</td>
<td>MODCK3, processor speed setting</td>
</tr>
<tr>
<td>JP5</td>
<td>B</td>
<td>Processor HRESET configuration</td>
</tr>
<tr>
<td>JP6</td>
<td>Battery</td>
<td>SRAM power select (Battery/Regular)</td>
</tr>
<tr>
<td>JP7</td>
<td>B</td>
<td>Socket 1 setting, (A = \text{Flash}, B = \text{SRAM})</td>
</tr>
<tr>
<td>JP8</td>
<td>A</td>
<td>CANH configuration to expansion boards (future)</td>
</tr>
<tr>
<td>JP9</td>
<td>ON</td>
<td>CAN1 Termination</td>
</tr>
<tr>
<td>JP10</td>
<td>B</td>
<td>RSTCONF, (A = \text{used for debugging}, B = \text{normal setting})</td>
</tr>
<tr>
<td>JP11</td>
<td>ON</td>
<td>CAN2 Termination</td>
</tr>
<tr>
<td>JP12</td>
<td>ON*</td>
<td>IMP (iControl Main Processor): (ON = ) enables iBox COMPUTER RESET button to reset this processor. *iBox Rev. 7 thru 10 have a wire from this jumper to the ICE-SAF board which allows resetting if any power supply voltages are out of tolerance. iBox Rev. 11 and above use an internal circuit for this purpose.</td>
</tr>
<tr>
<td>JP13</td>
<td>ON</td>
<td>SPA (Safety Processor A): (ON = ) enables iBox COMPUTER RESET button to reset this processor.</td>
</tr>
<tr>
<td>JP14</td>
<td>ON</td>
<td>SPB (Safety Processor B): (ON = ) enables iBox COMPUTER RESET button to reset this processor.</td>
</tr>
<tr>
<td>JP15</td>
<td>ON</td>
<td>Serial interface transmit configuration</td>
</tr>
<tr>
<td>JP16</td>
<td>A</td>
<td>CANL configuration to expansion boards (future)</td>
</tr>
</tbody>
</table>
**ICE-IRB-2 Relay Board**

The Relay Board is an integral part of the iBox. Three system relays are mounted on the board. The SAFT relay is socketed (replaceable). There are also six fuses protecting the 110VDC and 120VAC iBox output buses that may be replaced. Electrically, the Relay Board is between the iBox processor and the motor and brake field modules inside the iPower Box. The SB and 3 terminals are accessible through the front of the iBox and bypass the safety string when “jump-ered” together. If a jumper is placed, it “times out” automatically after 15 minutes. In TSSA jurisdictions, SB and 3 terminals are capped with insulators and are not front panel accessible.

**Figure 6.8 ICE-IRB Relay Board**
**Table 6.17  ICE-IRB Relay Board**

<table>
<thead>
<tr>
<th>Signal (Left Edge)</th>
<th>Signal (Right Edge)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BD:</strong> Brake Driver relay indicator. When the BD relay on the Relay board is closed to pick the brake, this LED will light. Monitored by Safety Processor A.</td>
<td><strong>M1:</strong> Drive contactor coil connection.</td>
</tr>
<tr>
<td><strong>TB:</strong> Brake Triac active indicator. When the brake triac on the Relay board is active (completes circuit for BD relay), this LED will light. Monitored by Safety Processor B.</td>
<td><strong>M2:</strong> Drive contactor coil connection.</td>
</tr>
<tr>
<td><strong>BRD:</strong> Brake Redundancy. This LED lights when the main brake contactor drops out.</td>
<td><strong>MR:</strong> Connects to drive contactor auxiliary contact for redundancy input.</td>
</tr>
<tr>
<td><strong>BDRD:</strong> Brake Drive Redundancy. This LED lights when the BD relay drops out.</td>
<td><strong>MX:</strong> Connects to drive contactor auxiliary contact for brake qualification.</td>
</tr>
<tr>
<td><strong>MD:</strong> Motor Drive relay indicator. When the MD relay on the Relay board is closed to enable the motor, this LED will light. Monitored by Safety Processor A.</td>
<td><strong>M:</strong> Part of MX circuit.</td>
</tr>
<tr>
<td><strong>TM:</strong> Motor Triac active indicator. When the motor triac on the Relay board is active (completes circuit for MD relay), this LED will light. Monitored by Safety Processor B.</td>
<td><strong>UP:</strong> Up direction output to MCE System 12 SCR Drive.</td>
</tr>
<tr>
<td><strong>MRD:</strong> Motor Redundancy. This LED lights when the main motor contactor drops out.</td>
<td><strong>DN:</strong> Down direction output to MCE System 12 SCR Drive.</td>
</tr>
<tr>
<td><strong>MDRD:</strong> Motor Drive Redundancy. This LED lights when the MD relay drops out.</td>
<td><strong>—:</strong> Not connected.</td>
</tr>
<tr>
<td><strong>SAFC:</strong> Safety Cartop input. Cartop safety relays and switches are wired in series between SAFH (Safety Hoistway) and SAFC. If any contact in the safety string opens, there will be 0VDC on this input and the car will not run. If all safety contacts in the string are closed, there will be 110VDC on this input.</td>
<td><strong>2D:</strong> 120VAC power to the drive. Fused on IRB board (fuse F2D).</td>
</tr>
<tr>
<td><strong>SAFH:</strong> Safety Hoistway input. Hoistway safety relays and switches are wired in series between the #3 bus and SAFH. The patch also includes the Governor switch, with the GOV connection providing access to the #3 bus via the governor switch. (#3 to GOV through governor switch, GOV to SAFH through hoistway safety relays and switches). The job prints for the job provide specific wiring instructions. If any contact in the safety string opens, there will be 0VDC on this input and the car will not run. If all safety contacts in the string are closed, there will be 110VDC on this input.</td>
<td><strong>1D:</strong> System common to the drive - source is the 1 bus.</td>
</tr>
<tr>
<td><strong>SP1 D:</strong> Optional input. See job prints.</td>
<td><strong>BK2:</strong> Connects to the brake contactor for redundancy checking. The source of power for this circuit comes from fuse F2 on the IRB board.</td>
</tr>
<tr>
<td><strong>SP2 D:</strong> Optional input. See job prints. (When used as a brake pick switch input: Set brake = 110VDC. Picked brake = 0VDC.</td>
<td><strong>BK1:</strong> Connects to the brake contactor for redundancy checking. The source of power for this circuit comes from fuse F2 on the IRB board.</td>
</tr>
<tr>
<td><strong>SP2:</strong> Optional input. See job prints.</td>
<td><strong>BC1:</strong> Connects to the brake contactor coil (see job prints for connection).</td>
</tr>
<tr>
<td><strong>SP3:</strong> Optional input. See job prints.</td>
<td><strong>BC2:</strong> Connects to the brake contactor coil (see job prints for connection).</td>
</tr>
</tbody>
</table>
Troubleshooting

Checking TM Triac on ICE-IRB Board
If the PM or M contactors are not picking, you might see the following fault messages:

- Motor Contactor Driver Proofing Fault
- Drive Ready On Fault
- Drive Enable Feedback Fault
- SCR Insufficient Armature Current

Note

These faults do not necessarily mean that the problem is with the TM Triac. It is recommended to first consult the iControl Messages table in the Troubleshooting section and follow the troubleshooting tips for the message(s) displayed.

To check the TM triac:
1. With controller power off remove the cover on the iBox.
2. The TM triac is in the upper right hand corner of the ICE-IRB board, which is the lowest board under the iBox cover and has three relays on it.
3. Measure the resistance across the outside legs of the TM triac. The legs can be hard to get to depending on the probe leads used. You can get to the upper leg from the left and the lower leg from below.
4. If the resistance is 60-70 ohms then the triac is good and continue troubleshooting the fault. If the resistance is 15 ohms or less the ICE-IRB board needs to be replaced.
ICE-IRD Rear Door Board
The Rear Door board provides additional door zone inputs.

Figure 6.9  ICE-IRD Rear Door Board

Table 6.18  Rear Door Board Connections

<table>
<thead>
<tr>
<th>Connector</th>
<th>Signal</th>
<th>Connector</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>DZ-R: Rear Door Zone signal from iLink. 110VDC active signal level. Off = 0.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ULM-R: Rear Up Level Marker signal from iLink. 110VDC active signal level Off = 0.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DLM-R: Rear Down Level Marker signal from iLink. 110VDC active signal level. Off = 0.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DPM-R: Rear Door Position Monitor input. Door closed, input inactive. 120VAC. Door not closed, 0VAC.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>GS-R: Rear Gate Switch input. The gate switch makes up when the elevator doors close. When the switch is made, there will be 110VDC on this input. When the switch is open, there will be 0VDC on this input. The gate switch may be wired in series with other switches or locks on the elevator doors (as shown in the job prints) so that, if any of the switches do not make, the GS input will remain low and the car will not run.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DLMS-R: Rear Door Lock Main String input. If top and bottom hoistway access is not provided, all hoistway rear door locks are wired in series between the #3 bus and this input. When the switch is made, there will be 110VDC on this input. When any switch is open, there will be 0VDC on this input and the car will not run.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DCMS-R: Rear Door Contact Main String input. If top and bottom hoistway access is not provided, all hoistway rear door contacts are wired in series between the #3 bus and this input. When the switch is made, there will be 110VDC on this input. When any switch is open, there will be 0VDC on this input and the car will not run.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
ICE-LCB Low Current Brake Board
Most iControls use the iField brake module for precise control of brake picking, holding, and application. If the requirements of the job permit, the Low Current Brake board may be used instead to provide simple brake pick and hold control. If used, the Low Current Brake board is usually mounted on the right wall inside the iPower Box. Brake adjusting components (resistors, capacitors, diodes) may be “wired in” to the board circuitry using AWG 18 wire and on-board screw terminals to modify the performance of the circuit. The job prints will show the Low Current Brake board connections clearly if it is used.

Table 6.19  Low Current Brake Board Signals

<table>
<thead>
<tr>
<th>Signal</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>B2 -, B1+</td>
<td>Brake voltage feedback signals to iControl Safety Board.</td>
</tr>
<tr>
<td>BXX1, BXX2</td>
<td>110VAC (typical) inputs to Low Current Brake Board rectifier.</td>
</tr>
<tr>
<td>BKD1</td>
<td>Brake Diode D1 cathode (used to include D1 in the circuit)</td>
</tr>
<tr>
<td>B2MCE</td>
<td>Used to include external components in the circuit</td>
</tr>
<tr>
<td>FBS1</td>
<td>Brake Diode D1 anode (used to include D1 in the circuit)</td>
</tr>
<tr>
<td>FBS2</td>
<td>Used to include external components in the circuit</td>
</tr>
<tr>
<td>BK2</td>
<td>Used to include external components in the circuit</td>
</tr>
<tr>
<td>BK1</td>
<td>Used to include capacitor C1 in the circuit</td>
</tr>
<tr>
<td>B1</td>
<td>Positive voltage output to brake coil via controller B1 terminal</td>
</tr>
<tr>
<td>B2</td>
<td>Return from brake coil via controller B2 terminal</td>
</tr>
</tbody>
</table>
ICE-MIAC (-24V) Multiple Input Board
The ICE-MIAC board is used in AC and DC iControls and in the iLink cartop interconnect as a general purpose input board suitable for industry-common 120VAC input signal levels. The ICE-MIAC-24V board can be used for 24V AC or DC inputs.

Figure 6.10  ICE-MIAC Multiple Input AC Board

Figure 6.11  ICE-MIAC-24V Multiple Input AC/DC Board

Caution!
Blue terminals indicate low voltage (24V AC or DC) input. Connecting 120VAC to these inputs will damage the board.
## Table 6.20  ICE-MIAC Board Connections

<table>
<thead>
<tr>
<th>Connector</th>
<th>Signal</th>
<th>Connector</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orange Terminals Inputs 1 - 32</td>
<td>120VAC = input active</td>
<td>Orange</td>
<td>1: Common</td>
</tr>
</tbody>
</table>

### Typical Input Circuit

![Typical Input Circuit Diagram](image-url)
### Table 6.21  ICE-MIAC-24V Board Connections

<table>
<thead>
<tr>
<th>Connector</th>
<th>Signal</th>
<th>Connector</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>Blue</td>
<td>Blue</td>
<td></td>
</tr>
<tr>
<td>Blue</td>
<td>Blue</td>
<td>Blue</td>
<td></td>
</tr>
<tr>
<td>Blue</td>
<td>Blue</td>
<td>Blue</td>
<td></td>
</tr>
<tr>
<td>Blue</td>
<td>Blue</td>
<td>Blue</td>
<td></td>
</tr>
<tr>
<td>Blue</td>
<td>Blue</td>
<td>Blue</td>
<td></td>
</tr>
<tr>
<td>Blue</td>
<td>Blue</td>
<td>Blue</td>
<td></td>
</tr>
<tr>
<td>Blue</td>
<td>Blue</td>
<td>Blue</td>
<td></td>
</tr>
<tr>
<td>Blue</td>
<td>Blue</td>
<td>Blue</td>
<td></td>
</tr>
<tr>
<td>Blue</td>
<td>Blue</td>
<td>Blue</td>
<td></td>
</tr>
</tbody>
</table>

Blue Terminals
Inputs 1 - 32
24V AC or DC = input active
**Caution! Connecting 120V to these terminals will damage the board.**

**Typical Input Circuit**

![Typical Input Circuit Diagram](image-url)
ICE-MOR Multiple Output Relay Board

The ICE-MOR board is a multi-purpose, relay-closure output board. ICE-MOR boards are used in iControl elevator controllers and in iLink cartop enclosures.

Output Connections

Connect outputs as shown in your job prints. Outputs may be configured (in specific groups) to provide either a path to ground or current to drive indicator lamps/LEDs.

Output State Selection

The outputs are divided into five groups. Each group shares a common. The common may be wired to provide a current source or a path to ground. The groups are:

- Relays 1 — 4
- Relays 5 — 8
- Relays 9 — 16
- Relays 17 - 24
- Relays 25 - 32

The commons for the groups are determined by the connections made to board connector J5. The appropriate connections are determined during the job survey. Each system is configured before shipment. You need only connect outputs as shown on the job prints.

Table 6.22  ICE-MOR Board Connections

<table>
<thead>
<tr>
<th>Connector</th>
<th>Signal</th>
<th>Connector</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="Diagram" /></td>
<td>Output determined by Common connection to board connector J5.</td>
<td><img src="#" alt="Diagram" /></td>
<td>1: Common</td>
</tr>
<tr>
<td><img src="#" alt="Diagram" /></td>
<td></td>
<td><img src="#" alt="Diagram" /></td>
<td>1: Common</td>
</tr>
<tr>
<td></td>
<td>AC2: MOR2, typical 18VAC</td>
<td></td>
<td>AC1: MOR1, typical 18VAC</td>
</tr>
<tr>
<td></td>
<td>Common 25 - 32</td>
<td></td>
<td>Common 25 - 32</td>
</tr>
<tr>
<td></td>
<td>Common 9 - 16</td>
<td></td>
<td>Common 17 - 24</td>
</tr>
<tr>
<td></td>
<td>Common 5 - 8</td>
<td></td>
<td>Common 17 - 24</td>
</tr>
<tr>
<td></td>
<td>Common 17 - 24</td>
<td></td>
<td>1: Common</td>
</tr>
</tbody>
</table>
Figure 6.12  ICE-MOR Board

+24V Testpoint
24V OK LED
On when iBox queries board

+5V Testpoint
Board Query LED
On when iBox queries board

FMOR Fuse
6/10A, 250V, MDQ

18VAC
1 bus

LED lights when corresponding output relay is active.

Active = Open
Active = Closed
Determined by iView settings according to user requirements.

Typical output circuit

Common per J5 connection per output group
ICE-RG Rope Gripper Board

The Rope Gripper board monitors and resets a rope gripper (emergency brake). The board is used in both AC and DC iControls.

Figure 6.13  ICE-RG Rope Gripper Board

Table 6.23  Rope Gripper Board Connections

<table>
<thead>
<tr>
<th>Connector</th>
<th>Signal</th>
<th>Connector</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>RG1: 120VAC to RG power supply</td>
<td>1: Common</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RG2: RG power supply return</td>
<td>24x2: 18VAC in</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RG5: 120VAC = rope gripper OK 0V = rope gripper tripped</td>
<td>24: 18 VAC in</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RG7: 120VAC signal to rope gripper</td>
<td>2: 120VAC in</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 6.14  Simplified Rope Gripper Operation

Closed = Rope Gripper Retracted
Closed = normal operation, rope gripper enabled
Open = manual operation, rope gripper disabled
Open = Rope Gripper Actuated
ICE-SAF Safety Board

- Status LEDs
- JP5, JP6
- To I/O Boards
- Encoder/Tach Switch
- TACH ADJ. trimpot
- Power Input
  - 1\,-15VDC
  - +15VDC
  - GND
  - +5VDC
- Motor Field connections
- Brake connections
- AC/DC Drive connections
- RS485 Fault LED
- JP1
- To ICE-IRB Board
- DCC Filter
- OFF
- ON
- J3 AC Drive
- Encoder Output
- Drive Serial Port
- Test Points
  - STP1
  - STP2
  - GND
Table 6.24  ICE-SAF Board Jumper Table

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JP1</td>
<td>A</td>
<td>Encoder Voltage. A = +5V, B = +15V</td>
</tr>
<tr>
<td>JP3</td>
<td>AC</td>
<td>Pre-Torque Filter (AC / DC): AC setting is hard wired, adds filtering to the pre-torque output.</td>
</tr>
<tr>
<td>JP5</td>
<td>B</td>
<td>Tach input range. A = 20-80V, B = 81-190V</td>
</tr>
<tr>
<td>JP6</td>
<td>B</td>
<td>Tach input range. A = 20-80V, B = 81-190V</td>
</tr>
</tbody>
</table>

Table 6.25  ICE-SAF Board Switches

<table>
<thead>
<tr>
<th>Switch</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW1</td>
<td>Serial Port switch: Setting for the Drive Serial Port (AC Drive / DC Drive). DC Drive setting hard wired.</td>
</tr>
<tr>
<td>SW2</td>
<td>Encoder / Tach: Encoder = AC drive with velocity encoder connected to AC drive. Tach = DC drive or AC drive with velocity encoder connected to iBox VELOCITY inputs.</td>
</tr>
<tr>
<td>SW4</td>
<td>DCC Filter (ON / OFF) Default = ON, adds filtering to Drive Current Command output.</td>
</tr>
</tbody>
</table>

Table 6.26  iBox Field Connections on ICE-SAF Board

<table>
<thead>
<tr>
<th>Source</th>
<th>Connection</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TACH</td>
<td>TS</td>
<td>Tach positive signal. Analog. 0 - 30 VDC (15 VDC @ 1000 RPM).</td>
</tr>
<tr>
<td></td>
<td>TC</td>
<td>Tach common (negative in respect to TS when car moving down)</td>
</tr>
<tr>
<td></td>
<td>SHLD</td>
<td>Tach shield connection (connect at iBox-end only)</td>
</tr>
<tr>
<td></td>
<td>DP1+</td>
<td>Positive going, +15V, digital pulse stream from iLand to iLink to iBox (DP1 leads DP2 when car moves up). Please refer to &quot;iLand Landing System&quot; on page 3-2.</td>
</tr>
<tr>
<td></td>
<td>DP1-</td>
<td>Negative going, -15V, digital pulse stream from iLand to iLink to iBox.</td>
</tr>
<tr>
<td></td>
<td>SHLD</td>
<td>Shield connection for twisted-pair DP1+/DP1-</td>
</tr>
<tr>
<td></td>
<td>DP2+</td>
<td>Positive going, +15V, digital pulse stream from iLand to iLink to iBox (DP2 leads DP1 when car moves down)</td>
</tr>
<tr>
<td></td>
<td>DP2-</td>
<td>Negative going, -15V, digital pulse stream from iLand to iLink to iBox</td>
</tr>
<tr>
<td></td>
<td>SHLD</td>
<td>Shield connection for twisted-pair DP2+/DP2-</td>
</tr>
<tr>
<td>VELOCITY ENCODER</td>
<td>A+</td>
<td>Positive going, +12V, digital pulse from motor velocity encoder. Please refer to &quot;Velocity Encoder Installation and Wiring &quot; on page 2-22.</td>
</tr>
<tr>
<td></td>
<td>A-</td>
<td>Negative going, -12V, digital pulse from motor velocity encoder.</td>
</tr>
<tr>
<td></td>
<td>B+</td>
<td>Positive going, +12V, digital pulse from motor velocity encoder.</td>
</tr>
<tr>
<td></td>
<td>B-</td>
<td>Negative going, -12V, digital pulse from motor velocity encoder.</td>
</tr>
<tr>
<td></td>
<td>Z+</td>
<td>Positive going, +12V, digital pulse from motor velocity encoder.</td>
</tr>
<tr>
<td></td>
<td>Z-</td>
<td>Negative going, -12V, digital pulse from motor velocity encoder.</td>
</tr>
<tr>
<td></td>
<td>VE-</td>
<td>Encoder power return</td>
</tr>
<tr>
<td></td>
<td>VE+</td>
<td>+12 VDC power to encoder (relative to VE-)</td>
</tr>
</tbody>
</table>
Table 6.26  iBox Field Connections on ICE-SAF Board

<table>
<thead>
<tr>
<th>Source</th>
<th>Connection</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CARTOP LINK</td>
<td>TX+</td>
<td>iBox transmit, positive going serial communication stream from iBox to iLink. Connects to iLink ICE-CTP Board terminal RX+. TX+ and TX- comprise a differential communications pair. Please refer to &quot;Installing iLink&quot; on page 3-13.</td>
</tr>
<tr>
<td></td>
<td>TX-</td>
<td>iBox transmit, negative going serial communication stream from iBox to iLink. Connects to iLink ICE-CTP Board terminal RX-.</td>
</tr>
<tr>
<td></td>
<td>SHLD</td>
<td>Shield connection for twisted-pair TX+/TX-</td>
</tr>
<tr>
<td></td>
<td>RX+</td>
<td>iBox receive, positive going serial communication stream from iLink to iBox. Connects to iLink ICE-CTP board terminal TX+. RX+ and RX- comprise a differential communications pair.</td>
</tr>
<tr>
<td></td>
<td>RX-</td>
<td>iBox receive, negative going serial communication stream from iLink to iBox. Connects to iLink ICE-CTP board terminal TX-.</td>
</tr>
<tr>
<td></td>
<td>SHLD</td>
<td>Shield connection for twisted-pair RX+/RX-</td>
</tr>
<tr>
<td>CAR</td>
<td>DZ</td>
<td>Door Zone Sensor input. Activated = 110 VDC.</td>
</tr>
<tr>
<td></td>
<td>ULM</td>
<td>Up Leveling Marker Sensor input. Activated = 110 VDC.</td>
</tr>
<tr>
<td></td>
<td>DLM</td>
<td>Down Leveling Marker Sensor input. Activated = 110 VDC.</td>
</tr>
<tr>
<td></td>
<td>INCT</td>
<td>Cartop Inspection Station INSP/AUTO Switch input. Activated = 110 VDC.</td>
</tr>
<tr>
<td></td>
<td>ICTU</td>
<td>Cartop Inspection Station UP Button input (includes SAF button). Activated = 110 VDC.</td>
</tr>
<tr>
<td></td>
<td>ICTD</td>
<td>Cartop Inspection Station DN Button input (includes SAF button). Activated = 110 VDC.</td>
</tr>
<tr>
<td></td>
<td>INCP</td>
<td>COP Inspection Station INSP/AUTO Switch input. Activated = 110 VDC.</td>
</tr>
<tr>
<td></td>
<td>ICPU</td>
<td>COP Inspection Station UP Button input. Activated = 110 VDC.</td>
</tr>
<tr>
<td></td>
<td>ICPD</td>
<td>COP Inspection Station DN Button input. Activated = 110 VDC.</td>
</tr>
<tr>
<td></td>
<td>INA</td>
<td>Car Panel (Hoistway) Access Enable switch input. 0 VDC active signal level. Off = 110 VDC.</td>
</tr>
<tr>
<td></td>
<td>ESC</td>
<td>Car Panel Emergency Stop switch input. 0 VDC active signal level stops car. Off = 110 VDC.</td>
</tr>
<tr>
<td></td>
<td>DCL</td>
<td>Door Close Limit input. Door fully closed, input inactive, 0 VAC. Door not closed signal level, 120 VAC.</td>
</tr>
<tr>
<td></td>
<td>DOL</td>
<td>Door Open Limit input. Door fully open, input inactive, 0 VAC. Door not open signal level, 120 VAC.</td>
</tr>
<tr>
<td></td>
<td>DPM</td>
<td>Door Position Monitor input. Door closed, input inactive, 120 VAC. Door not closed, 0 VAC.</td>
</tr>
</tbody>
</table>
## Table 6.26  iBox Field Connections on ICE-SAF Board

<table>
<thead>
<tr>
<th>Source</th>
<th>Connection</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNTD</td>
<td>Up Normal Limit Direction switch input. 110 VDC = input on/switch closed. 0 VDC = input off/switch open.</td>
<td></td>
</tr>
<tr>
<td>UNT5</td>
<td>Up Slowdown Limit switch #5 input. (see UNTD)</td>
<td></td>
</tr>
<tr>
<td>UNT4</td>
<td>Up Slowdown Limit switch #4 input. (see UNTD)</td>
<td></td>
</tr>
<tr>
<td>UNT3</td>
<td>Up Slowdown Limit switch #3 input. (see UNTD)</td>
<td></td>
</tr>
<tr>
<td>UNT2</td>
<td>Up Slowdown Limit switch #2 input. (see UNTD)</td>
<td></td>
</tr>
<tr>
<td>UETS</td>
<td>Up Emergency Terminal Limit switch input. (see UNTD)</td>
<td></td>
</tr>
<tr>
<td>UNT1</td>
<td>Up Slowdown Limit switch #1 input. (see UNTD)</td>
<td></td>
</tr>
<tr>
<td>DNT1</td>
<td>Down Slowdown Limit switch #1 input. (see UNTD)</td>
<td></td>
</tr>
<tr>
<td>DETS</td>
<td>Down Emergency Terminal Limit switch input. (see UNTD)</td>
<td></td>
</tr>
<tr>
<td>DNT2</td>
<td>Down Slowdown Limit switch #2 input. (see UNTD)</td>
<td></td>
</tr>
<tr>
<td>DNT3</td>
<td>Down Slowdown Limit switch #3 input. (see UNTD)</td>
<td></td>
</tr>
<tr>
<td>DNT4</td>
<td>Down Slowdown Limit switch #4 input. (see UNTD)</td>
<td></td>
</tr>
<tr>
<td>DNT5</td>
<td>Down Slowdown Limit switch #5 input. (see UNTD)</td>
<td></td>
</tr>
<tr>
<td>DNTD</td>
<td>Down Normal Limit Direction switch input. (see UNTD)</td>
<td></td>
</tr>
</tbody>
</table>

### Limits

- **ATU**: Hoistway Access Top Up switch input. When the Car Panel Access Enable switch (INA input) is on, an active input (key switch closure) here (110 VDC) will cause the car to move up the hoistway. A hoistway limit switch electrically between the ATU input and the activating switch will open and stop the car after it has moved the required distance up the hoistway (if installed). Normal/Off state = 0 VDC. Refer also to the -MRW drawing in the job prints.

- **ATD**: Hoistway Access Top Down switch input. When the Car Panel Access Enable switch (INA input) is on, an active input (key switch closure) here (110 VDC) will cause the car to move down the hoistway. A hoistway limit switch electrically between the ATD input and the activating switch will open and stop the car after it has moved the required distance down the hoistway (if installed). Normal/Off state = 0 VDC. Refer also to the -MRW drawing in the job prints.

### H/Way

- **ABU**: Hoistway Access Bottom Up switch input. When the Car Panel Access Enable switch (INA input) is on, an active input (key switch closure) here (110 VDC) will cause the car to move up the hoistway. A hoistway limit switch electrically between the ABU input and the activating switch will open and stop the car after it has moved the required distance up the hoistway (if installed). Normal/Off state = 0 VDC. Refer also to the -MRW drawing in the job prints.

- **ABD**: Hoistway Access Bottom Down switch input. When the Car Panel Access Enable switch (INA input) is on, an active input (key switch closure) here (110 VDC) will cause the car to move down the hoistway. A hoistway limit switch electrically between the ABD input and the activating switch will open and stop the car after it has moved the required distance down the hoistway (if installed). Normal/Off state = 0 VDC. Refer also to the -MRW drawing in the job prints.
**LOCKS/CONTACTS**

<table>
<thead>
<tr>
<th>Source</th>
<th>Connection</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GS</td>
<td>Gate Switch input. The gate switch makes up when the elevator doors close. When the switch is made, there will be 110 VDC on this input. When the switch is open, there will be 0 VDC on this input. The gate switch may be wired in series with other switches or locks on the elevator doors (as shown in the job prints) so that if any of the switches do not make, the GS input will remain low and the car will not run.</td>
<td></td>
</tr>
<tr>
<td>DLAT</td>
<td>Door Lock Access Top input. When a top hoistway access is provided (see INA, ATU, and ATD), the hoistway door lock associated with that landing is connected between the #3 bus and this input. When the switch is made, there will be 110 VDC on this input. When the switch is open, there will be 0 VDC on this input and the car will not run unless INA is active and then only in response to the ATU or ATD input.</td>
<td></td>
</tr>
<tr>
<td>DLMS</td>
<td>Door Lock Main String input. If top and bottom hoistway access (see INA, ATU, ATD, ABU, and ABD) is not provided, all hoistway door locks are wired in series between the #3 bus and DLMS. When the switches are made, there will be 110 VDC on this input. When any switch is open, there will be 0 VDC on this input and the car will not run.</td>
<td></td>
</tr>
<tr>
<td>DLAB</td>
<td>Door Lock Access Bottom input. When a bottom hoistway access is provided (see INA, ABU, and ABD), the hoistway door lock associated with that landing is connected between the #3 bus and this input. When the switch is made, there will be 110 VDC on this input. When the switch is open, there will be 0 VDC on this input and the car will not run unless INA is active and then only in response to the ABU or ABD input.</td>
<td></td>
</tr>
<tr>
<td>DCAT</td>
<td>Door Contact Access Top input. When a top hoistway access is provided (see INA, ATU, ATD, and DLAT), the hoistway door contact associated with that landing is connected between the #3 bus and this input. When the switch is made, there will be 110 VDC on this input. When the switch is open, there will be 0 VDC on this input and the car will not run unless INA is active and then only in response to the ATU or ATD input.</td>
<td></td>
</tr>
<tr>
<td>DCMS</td>
<td>Door Contact Main String input. If top and bottom hoistway access (see INA, ATU, ATD, ABU, and ABD) is not provided, all hoistway door contacts are wired in series between the #3 bus and DCMS. When the switches are made, there will be 110 VDC on this input. When any switch is open, there will be 0 VDC on this input and the car will not run.</td>
<td></td>
</tr>
<tr>
<td>DCAB</td>
<td>Door Contact Access Bottom input. When a bottom hoistway access is provided (see INA, ABU, ABD, and DLAB), the hoistway door contact associated with that landing is connected between the #3 bus and this input. When the switch is made, there will be 110 VDC on this input. When the switch is open, there will be 0 VDC on this input and the car will not run unless INA is active and then only in response to the ABU or ABD input.</td>
<td></td>
</tr>
<tr>
<td>GOV</td>
<td>Governor input. The governor is connected between the #3 bus and this input. When the governor switch is made, there is 110 VDC on this input. When the governor switch trips/opens, there is 0 VDC on this input and the car will not run.</td>
<td></td>
</tr>
<tr>
<td>SP 1</td>
<td>Spare input 1. If used, connect as shown in the job prints.</td>
<td></td>
</tr>
</tbody>
</table>

---

**Table 6.26 iBox Field Connections on ICE-SAF Board**

<table>
<thead>
<tr>
<th>Source</th>
<th>Connection</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GS</td>
<td>Gate Switch input. The gate switch makes up when the elevator doors close. When the switch is made, there will be 110 VDC on this input. When the switch is open, there will be 0 VDC on this input. The gate switch may be wired in series with other switches or locks on the elevator doors (as shown in the job prints) so that if any of the switches do not make, the GS input will remain low and the car will not run.</td>
<td></td>
</tr>
<tr>
<td>DLAT</td>
<td>Door Lock Access Top input. When a top hoistway access is provided (see INA, ATU, and ATD), the hoistway door lock associated with that landing is connected between the #3 bus and this input. When the switch is made, there will be 110 VDC on this input. When the switch is open, there will be 0 VDC on this input and the car will not run unless INA is active and then only in response to the ATU or ATD input.</td>
<td></td>
</tr>
<tr>
<td>DLMS</td>
<td>Door Lock Main String input. If top and bottom hoistway access (see INA, ATU, ATD, ABU, and ABD) is not provided, all hoistway door locks are wired in series between the #3 bus and DLMS. When the switches are made, there will be 110 VDC on this input. When any switch is open, there will be 0 VDC on this input and the car will not run.</td>
<td></td>
</tr>
<tr>
<td>DLAB</td>
<td>Door Lock Access Bottom input. When a bottom hoistway access is provided (see INA, ABU, and ABD), the hoistway door lock associated with that landing is connected between the #3 bus and this input. When the switch is made, there will be 110 VDC on this input. When the switch is open, there will be 0 VDC on this input and the car will not run unless INA is active and then only in response to the ABU or ABD input.</td>
<td></td>
</tr>
<tr>
<td>DCAT</td>
<td>Door Contact Access Top input. When a top hoistway access is provided (see INA, ATU, ATD, and DLAT), the hoistway door contact associated with that landing is connected between the #3 bus and this input. When the switch is made, there will be 110 VDC on this input. When the switch is open, there will be 0 VDC on this input and the car will not run unless INA is active and then only in response to the ATU or ATD input.</td>
<td></td>
</tr>
<tr>
<td>DCMS</td>
<td>Door Contact Main String input. If top and bottom hoistway access (see INA, ATU, ATD, ABU, and ABD) is not provided, all hoistway door contacts are wired in series between the #3 bus and DCMS. When the switches are made, there will be 110 VDC on this input. When any switch is open, there will be 0 VDC on this input and the car will not run.</td>
<td></td>
</tr>
<tr>
<td>DCAB</td>
<td>Door Contact Access Bottom input. When a bottom hoistway access is provided (see INA, ABU, ABD, and DLAB), the hoistway door contact associated with that landing is connected between the #3 bus and this input. When the switch is made, there will be 110 VDC on this input. When the switch is open, there will be 0 VDC on this input and the car will not run unless INA is active and then only in response to the ABU or ABD input.</td>
<td></td>
</tr>
<tr>
<td>GOV</td>
<td>Governor input. The governor is connected between the #3 bus and this input. When the governor switch is made, there is 110 VDC on this input. It the governor switch trips/opens, there is 0 VDC on this input and the car will not run.</td>
<td></td>
</tr>
<tr>
<td>SP 1</td>
<td>Spare input 1. If used, connect as shown in the job prints.</td>
<td></td>
</tr>
</tbody>
</table>
ICE-SF-x Serial Fixtures Board

The Serial Fixtures board is used in iControl elevator controllers to communicate with serial-control audible and visual indicators, e.g., voice annunciators or character displays. The board provides two identical outputs — one for hall displays and one for car displays. The “x” in the part number refers to the fixture type:

- CE = CE Electronics
- EM = E-Motive
- HJ = Hong Jiang

**Table 6.27 Serial Fixture Board Connections**

<table>
<thead>
<tr>
<th>Connector</th>
<th>Signal</th>
<th>Connector</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1: Common</td>
<td></td>
<td>18VAC</td>
</tr>
<tr>
<td></td>
<td>+24: 24VDC</td>
<td>18VAC</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CData: Data to car</td>
<td>1: Common</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HData: Data to hall</td>
<td>+24: 24VDC</td>
<td></td>
</tr>
</tbody>
</table>

**DIP Switches and Display**

The DIP switches and 4-character display are used for factory testing and diagnostics. For normal operation, all of the DIP switches are set to OFF (down). The 4-character display shows direction and ascii floor number.
SC-HCDA-ISO Serial Hall Call Driver Isolation Board
The SC-HCDA-ISO Serial Hall Call Driver Isolation Board is used on iControl AC and DC Simplex and Swing car controllers. The isolation board is placed between the SC-HCDA Serial Hall Call Driver (usually mounted inside the iPower Box) and the Serial Hall Call Input on the right side of the iBox. Revision 6.0 and later of the ICE-IMP board incorporates the isolation circuitry thereby eliminating the need for the SC-HCDA-ISO. Please refer to “Serial Hall Call” on page 5-30 for additional information.

Figure 6.16 SC-HCDA-ISO Serial Hall Call Driver Isolation Board

SC-HCNT Serial Hall Call Node Board
In a typical installation, an SC-HCNT Serial Hall Call Node board is mounted in each hall call fixture enclosure. Please refer to “Hall Call Installation” on page 5-32. The board provides two outputs to power the hall call lamps or LEDs, two inputs for the hall call buttons, and jumpers to set the floor ID and hall call “type”.

Figure 6.17 SC-HCNT Serial Hall Call Node Board

For more information on setting the node board addresses, Please refer to “Setting Node Board Addresses” on page 5-33.
SC-HCE-ME Serial Hall Call Ethernet - Digi ME Board

The SC-HCE-ME Serial Hall Call Ethernet board is used to convert signals from the SC-HCDA Serial Hall Driver Assembly to Ethernet for transmit and receive via the 2 = SYSTEM bus. The -ME indicates that the Digi Connect ME device is being used on this board.

Figure 6.18  SC-HCE-ME Serial Hall Call Ethernet - Digi ME Board

Table 6.28  SC-HCN-ME Indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus Error</td>
<td>ON = Communication problem</td>
</tr>
<tr>
<td>FHCE OK</td>
<td>ON = Power to the board and fuse OK</td>
</tr>
<tr>
<td>Link Status</td>
<td>Yellow indicator, ON = Network link is operational.</td>
</tr>
<tr>
<td>Network Activity</td>
<td>Green indicator, ON = Network traffic detected.</td>
</tr>
</tbody>
</table>

Table 6.29  SC-HCN-ME Jumpers

<table>
<thead>
<tr>
<th>JP1</th>
<th>JP2</th>
<th>JP3</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>OFF</td>
<td>ON</td>
<td>115kHz baud rate (default setting)</td>
</tr>
<tr>
<td>OFF</td>
<td>ON</td>
<td>OFF</td>
<td>230.4 kHz baud rate</td>
</tr>
<tr>
<td>ON</td>
<td>OFF</td>
<td>ON</td>
<td>460.8 kHz baud rate</td>
</tr>
<tr>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
<td>921.4 kHz baud rate</td>
</tr>
<tr>
<td>OFF</td>
<td>OFF</td>
<td>ON</td>
<td>Board address cannot be changed (default setting)</td>
</tr>
<tr>
<td>ON</td>
<td>ON</td>
<td>OFF</td>
<td>Board address can be programmed</td>
</tr>
</tbody>
</table>
SC-ION: Serial Control I/O Board

One or more SC-ION boards may be used in an iCentral group controller. The SC-ION board provides a communications interface between discrete signal level or relay-oriented field equipment and serial communications used by iCentral for serial hall call and other serial messaging. Inputs and outputs on the SC-ION board are assigned unique serial addresses at the factory according to customer requirements. Using iView, customers can view the function assigned to each address and may even assign a different (MCE-supported) function if their needs change. Each SC-ION board provides 16 user-configurable inputs and 16 user-configurable outputs.

I/O Connections

Connect inputs and outputs as shown in your job prints. SC-ION board inputs are always 117VAC. Outputs may be configured (in specific groups) to provide either a path to ground or current to drive indicator lamps/LEDs.

Output State Selection

The outputs are divided into three groups. Each group shares a common. The common may be wired to provide a current source or a path to ground. The groups are:

- Relays 1 — 4
- Relays 5 — 8
- Relays 9 — 16

The commons for the groups are determined by the connections made to board connector J4. The appropriate connections are determined during the job survey. Each system is configured before shipment. You need only connect the inputs and outputs as shown on the job prints.

Board Addresses

Each of the 16 inputs and 16 outputs on the board has an address on the system bus. The addresses are assigned as indicated by the job survey before the system is shipped. A software tool, running on a Windows platform, is used to set individual addresses and also to set the address range (10-489 or 10-989) used for the job. To configure the board, a Windows PC running the software tool must be connected to the board serial port.

Table 6.30 SC-ION Board Inputs and Outputs

<table>
<thead>
<tr>
<th>Connector</th>
<th>Signal</th>
<th>Connector</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Input Connections" /></td>
<td>In 1-16: 120VAC when active</td>
<td><img src="image" alt="Input Connections" /></td>
<td>1: Common</td>
</tr>
<tr>
<td><img src="image" alt="Input Connections" /></td>
<td>Out 1-16: Determined by common connection</td>
<td><img src="image" alt="Input Connections" /></td>
<td>SHCS: Serial signal, +/-15V bit stream</td>
</tr>
<tr>
<td><img src="image" alt="Input Connections" /></td>
<td></td>
<td><img src="image" alt="Input Connections" /></td>
<td>SHCC: Serial signal, common</td>
</tr>
<tr>
<td><img src="image" alt="Input Connections" /></td>
<td></td>
<td><img src="image" alt="Input Connections" /></td>
<td>1: Common</td>
</tr>
<tr>
<td><img src="image" alt="Input Connections" /></td>
<td></td>
<td><img src="image" alt="Input Connections" /></td>
<td>SHCS: Serial signal, +/-15V bit stream</td>
</tr>
<tr>
<td><img src="image" alt="Input Connections" /></td>
<td></td>
<td><img src="image" alt="Input Connections" /></td>
<td>SHCC: Serial signal, common</td>
</tr>
<tr>
<td><img src="image" alt="Input Connections" /></td>
<td></td>
<td><img src="image" alt="Input Connections" /></td>
<td>COM 9-16: Connect to select active output for outputs 9-16.</td>
</tr>
<tr>
<td><img src="image" alt="Input Connections" /></td>
<td></td>
<td><img src="image" alt="Input Connections" /></td>
<td>COM 5-8: Connect to select active output for outputs 5-8.</td>
</tr>
<tr>
<td><img src="image" alt="Input Connections" /></td>
<td></td>
<td><img src="image" alt="Input Connections" /></td>
<td>COM 1-4: Connect to select active output for outputs 1-4.</td>
</tr>
</tbody>
</table>
Figure 6.19 SC-ION Serial Control I/O Board

- **Inputs**
- **Outputs**

**COMP ON:**
- On = Computer on
- Off = Computer resetting

**RST_OUT:** Low when computer is in reset mode

**Board programming port:**
- Factory use only.

**High/Low (Current Source/Current Sink) Output Selection (J4).** For example, connecting the COM 9 - 16 terminal to the MCE #1 (common) bus would mean that when one of outputs 9 through 16 was active the signal connected to it would be taken to ground (sink/active low).

**DIP switch and LEDs used in factory diagnostics and programming.** No field application.

**Testpoints, Ground**
- +24V
- +3.3V
- +5.0V

**LED lights when corresponding input or output is active.**

**Board Reset**
About the iBox Front Panel

System status indicator LEDs and function control switches are accessible on the iBox front panel. The front panel also provides:

- LCD display and entry keypad (see page 7-3).
- Access to iBox Ethernet Port addresses (see page 7-9).
- System-level diagnostic LED display (see page 7-11).
- System function control switches (see page 7-12).

Front panel controls allow you to:

- Directly view and adjust iBox configurable parameters (see page 7-3).
- Quickly ascertain system status (see page 7-11).
- Access Controller mode and other function switches (see page 7-12).
The following illustration shows iBox front panel controls.

**Figure 7.1  iBox**

- **LCD Display and Keypad**
- **System Status Display**
- **System Control Switches**
- **Fuses and Safety Bypass Jumper**
**LCD Display and Keypad**

The iBox LCD display and keypad allow you to:

- View and change parameter settings
- View and register calls
- View the status of inputs, outputs, and flags
- View error messages and the system event log

Typically, when you need to view or change parameters in an iControl, you connect to the iBox through the PC or LAN ethernet port and use the iView graphical user interface running on a Windows OS PC to easily access, view, or edit any desired parameter. However, during initial system setup when setting the parameters that allow PC access to your system, or when a PC is not available, some parameters can be directly accessed and edited through the keypad and LCD display located on the front panel of every iBox.

**Figure 7.2 iBox Data Entry Keypad and LCD Display**
Keypad Controls

Keypad controls include:

- Display Contrast — adjusts the LCD display
- Computer Reset — resets the iBox computers
- Fault Reset — initializes the fault list
- Softkeys — selects the associated topic across the bottom of the LCD display
- Up Arrow — moves the selection bar up or increases a parameter value
- Down Arrow — moves the selection bar down or decreases a parameter value
- Left Arrow — moves the cursor left (digit selection)
- Right Arrow — moves the cursor right (digit selection)
- ENTER — confirms a selection or enters a parameter value

LCD Display

The LCD display allows you to view iBox parameters. The top line of each display “screen” provides a status “snapshot” for the car associated with the controller. In our example:

- @ (door zone) —
  - @: in door zone
  - -: below door zone
  - +: above door zone
- 003 — current floor
- s or t (direction arrows)
- 015 — next floor
- F (front doors) —
  - Open
  - Closed
  - Opening/Closing
  - Invalid door position
- R (rear doors) —
  - Open
  - Closed
  - Opening/Closing
  - Invalid door position
- S or L (Simplex or Local)
- 03 (Car ID)

The second line of the display shows the mode of operation (Passenger in the example) displayed in rotation with any active status or error messages. If a soft key is pressed (Car or Mgmt) the remaining display lines change to display appropriate information. The labels in the bottom line change to indicate the function of their associated soft key.
Parameter Entry

To edit or view a parameter, you select a broad topic by pressing the Enter soft key, then select and view or edit a parameter. For example, to change or edit a Car-associated parameter.

1. Press the soft key (1) beneath the Car label. The LCD will change as shown to the right.
2. Use the arrow keys to scroll to a topic.
3. With the topic selected (Network Setup in our example), press ENTER.

Note that the soft key labels have changed:

- Home — Returns you to the home screen.
- Back — Takes you back one screen.
- PgUp — When there are more topics than can be listed on a single screen, PgUp moves you up the list a full “screen” at a time.
- PgDn — When there are more topics than can be listed on a single screen, PgDn moves you down the list a full “screen” at a time.

4. Use the arrow keys to scroll to a topic.
5. With the topic selected, press ENTER.

When you press ENTER, the display updates.

6. Use the arrow keys to scroll to a topic.
7. With the topic selected, press ENTER.

When you press ENTER, the display updates. The cursor/arrow indicates a parameter can be edited.

8. Use the left/right arrow keys to position the arrow below the number to be changed.
9. Use the up/down arrow keys to increment or decrement the value.
10. Repeat positioning and incrementing/decrementing as necessary. Press ENTER to enter the new value.
11. The soft key labels will indicate Save and Cancel. Press Save to save your changes after a yes or no acknowledgement.

or,

12. Press Cancel to leave the screen without saving your changes (after a yes or no acknowledgement).
Editing a Controller Parameter

To edit a parameter:

1. Navigate to the desired screen.
2. Edit the parameter.
3. Save the edited parameter.

The following illustration shows which parameter groups are accessible on the Car and Mgmt menu LCD screens. Use the illustration and Table 6.1 to help you locate a parameter to be adjusted.

Figure 7.3  Onboard Diagnostics Car Menu Tree
Table 7.1  Car Menu Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description and Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Network Setup</strong></td>
<td>There are three Ethernet ports on the iBox. #1 is the Local Area Network connection used to connect Group and Elevator controllers to your Local Area Network. #2 is the MCE equipment connection used to interconnect Group and Elevator controllers for equipment control purposes. #3 is the PC Direct connection used to connect a PC directly to a Controller for immediate access. Network setup parameters allow the IP information to be set for each of the three ports. Additionally, an FTP User Name and Password must be set here without which the File Transfer Protocol server may not be accessed. There are many websites that are helpful in learning about TCP/IP.</td>
</tr>
<tr>
<td>To set the FTP User Name</td>
<td>Enter a User Name that must be employed to access the FTP server.</td>
</tr>
<tr>
<td>To set the FTP User Password</td>
<td>Enter a password that must be employed to access the FTP server.</td>
</tr>
<tr>
<td>To set the IP Name 1</td>
<td>Enter a name for the #1 port. This is the peripherals port used for local area network connection, typically for networked PCs running iView.</td>
</tr>
<tr>
<td>To set the IP Address 1</td>
<td>Enter an address for the #1 port. Please refer to “System, LAN, &amp; 3=PC TCP/IP Addresses” on page 7-9.</td>
</tr>
<tr>
<td>To set the IP Gateway 1</td>
<td>Enter a gateway address for the #1 port. Please refer to “System, LAN, &amp; 3=PC TCP/IP Addresses” on page 7-9.</td>
</tr>
<tr>
<td>To set the IP Subnet Mask 1</td>
<td>Enter a subnet mask address for the #1 port. Please refer to “System, LAN, &amp; 3=PC TCP/IP Addresses” on page 7-9.</td>
</tr>
<tr>
<td>To set the IP Name 2</td>
<td>Enter a name for the #2 port. This is the system port used to connect to the hub that supports MCE controllers, serial hall call, etc.</td>
</tr>
<tr>
<td>To set the IP Address 2</td>
<td>Enter an address for the #2 port. Please refer to “System, LAN, &amp; 3=PC TCP/IP Addresses” on page 7-9.</td>
</tr>
<tr>
<td>To set the IP Gateway 2</td>
<td>Enter a gateway address for the #2 port. Please refer to “System, LAN, &amp; 3=PC TCP/IP Addresses” on page 7-9.</td>
</tr>
<tr>
<td>To set the IP Subnet Mask 2</td>
<td>Enter a subnet mask address for the #2 port. Please refer to “System, LAN, &amp; 3=PC TCP/IP Addresses” on page 7-9.</td>
</tr>
<tr>
<td>To set the IP Name 3</td>
<td>Enter a name for the #3 port. This is the PC port, meant for direct connection to a PC running iView using a standard Ethernet cable and NO HUB.</td>
</tr>
<tr>
<td>To set the IP Address 3</td>
<td>Address for the #3 port. Default at 192.168.193.1.</td>
</tr>
</tbody>
</table>
Table 7.1  Car Menu Parameters

<table>
<thead>
<tr>
<th>Car Menu Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>To set the IP Gateway 3:</strong></td>
</tr>
<tr>
<td>Enter a gateway address for the #3 port. Please refer to &quot;System, LAN, &amp; 3=PC TCP/IP</td>
</tr>
<tr>
<td>Addresses” on page 7-9.</td>
</tr>
<tr>
<td><strong>To set the IP Subnet Mask 3:</strong></td>
</tr>
<tr>
<td>Enter a subnet mask address for the #3 port. Please refer to “System, LAN, &amp; 3=PC TCP/IP</td>
</tr>
<tr>
<td>Addresses” on page 7-9.</td>
</tr>
<tr>
<td><strong>View Event Log</strong></td>
</tr>
<tr>
<td>View Event log accesses the event database maintained by the controller. This</td>
</tr>
<tr>
<td>database lists messages by ID Number, ordered by time-of-occurrence. Additional</td>
</tr>
<tr>
<td>data is also stored, e.g. Type, Date, Time, Acknowledgement Status, and Event (name)</td>
</tr>
<tr>
<td>for each event. A listing of iBox Event Log ID Numbers and a cross-reference to</td>
</tr>
<tr>
<td>iControl Messages and descriptions can be found in Section 6 of this User Guide.</td>
</tr>
<tr>
<td>Please refer to “Cross Reference: iBox Event Log ID Numbers to iControl Messages ”</td>
</tr>
<tr>
<td>on page 6-4 and see “iControl Messages” on page 6-13</td>
</tr>
<tr>
<td><strong>To view the Event Log:</strong></td>
</tr>
<tr>
<td>Press softkey (1) beneath the Car label, scroll down to View Event Log and press</td>
</tr>
<tr>
<td>Enter. To view event details, scroll to the desired event and press Enter.</td>
</tr>
<tr>
<td>Scroll down to see all of the data, including the event name.</td>
</tr>
<tr>
<td><strong>View/Register Calls</strong></td>
</tr>
<tr>
<td>The View/Register Calls dialog allows you to send transport commands to the</td>
</tr>
<tr>
<td>controller.</td>
</tr>
<tr>
<td><strong>To View/Register Calls:</strong></td>
</tr>
<tr>
<td>Allows you to enter car and hall calls for Front or Rear Car Operating Panels.</td>
</tr>
<tr>
<td><strong>Set Time/Date</strong></td>
</tr>
<tr>
<td>This parameter sets the real time clock for the controller.</td>
</tr>
<tr>
<td><strong>To set the Set Time/Date:</strong></td>
</tr>
<tr>
<td>Enter the current time and date for use by the controller real time clock.</td>
</tr>
<tr>
<td><strong>View Factory Data</strong></td>
</tr>
<tr>
<td>View Factory Data accesses serial number, date, and MAC address information for the</td>
</tr>
<tr>
<td>controller. This information is very useful should you ever have to contact MCE</td>
</tr>
<tr>
<td>about your equipment.</td>
</tr>
<tr>
<td><strong>MAC Addresses:</strong></td>
</tr>
<tr>
<td>A six-byte, unique, identifying code used by LANs to positively identify</td>
</tr>
<tr>
<td>communicating equipment. This parameter allows you to view the MAC address for each</td>
</tr>
<tr>
<td>of the three Ethernet ports.</td>
</tr>
<tr>
<td><strong>Manufacturing Info:</strong></td>
</tr>
<tr>
<td>View the controller serial number, revision, and ICE-IMP information.</td>
</tr>
<tr>
<td><strong>Version Info</strong></td>
</tr>
<tr>
<td>Version Info provides version information for the software currently installed on</td>
</tr>
<tr>
<td>your controller.</td>
</tr>
<tr>
<td><strong>Version Info:</strong></td>
</tr>
<tr>
<td>View the software version information for the controller and car top processors.</td>
</tr>
<tr>
<td><strong>View / Clear Statistics</strong></td>
</tr>
<tr>
<td>View and/or clear statistical data collected by the controller. The statistical</td>
</tr>
<tr>
<td>data includes the odometer, power-up cycles, front and rear door cycles, motion</td>
</tr>
<tr>
<td>cycles, floor time, floor runs, inspection runs, auto runs, and auto relevels.</td>
</tr>
</tbody>
</table>
Setting iBox Ethernet Port Addresses

The table below lists the factory default addresses TCP/IP addresses. The iBox 3 = PC port (PC direct) is set to 192.168.193.001 and should not be changed.

Table 7.3 System, LAN, & 3=PC TCP/IP Addresses

<table>
<thead>
<tr>
<th>Hub</th>
<th>Group</th>
<th>Group IP, Primary &amp; Backup</th>
<th>Car ID</th>
<th>Car IP</th>
<th>System/Serial Hall Call Bus 1 - 4</th>
<th>iView PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN</td>
<td>B</td>
<td>192.168.191.203-204</td>
<td>1-20</td>
<td>192.168.191.021-040</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAN</td>
<td>D</td>
<td>192.168.191.207-208</td>
<td>1-20</td>
<td>192.168.191.061-080</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAN</td>
<td>E</td>
<td>192.168.191.209-210</td>
<td>1-20</td>
<td>192.168.191.081-100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Port #3 = PC (iBox ONLY), NO HUB</td>
<td></td>
<td></td>
<td></td>
<td>192.168.193.001</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*192.168.191.101 is typically used for the iView PC.

The default Subnet Mask for all ports is 255.255.255.000.

The default Gateway for the #1 (LAN or Peripheral Port) is 192.168.191.254.

The default Gateway for the #2 and #3 ports is 000.000.000.000.

You should not need to change the factory-set IP information. If you are having problems connecting to an iBox Ethernet port, refer to the following topic to verify and, if necessary, set IP addresses.

Note

The Group ID setting in iView determines the iCue System IP address at which iCue will accept messages. **NOT set the Group ID to a setting other than 1** unless instructed to do so by MCE. Group IDs other than 1 are reserved for future use and will cause group-to-car communication to fail. If you need advanced System addressing information, please contact MCE.
**IP Address Verification/Setting**

You should not need to change the factory-set IP information. If you are having problems connecting to an iBox Ethernet port, verify that IP information is correct as described here. If you find an incorrectly set port, these instructions will help you correct it. These instructions are for Port 1 but the procedure is the same for all iBox ports.

1. Press the soft key (1) beneath the Car label. The LCD will change as shown to the right.
2. With Network Setup selected, press ENTER.
3. Scroll down to IP Address 1, press ENTER.
4. Verify that the Address displayed is correct (see preceding table). For example, Car A of Group 1 should be 192.168.191.001.
5. If you are using the default addresses, and the address displayed is incorrect, set it according to the table using Left and Right arrow keys to select a number and Up and Down arrow keys to change the value. Continue until the address is correct, then press ENTER. Press SAVE to save your changes (if any).
6. Scroll down to IP Gateway 1. The default for the #1 Port is 192.168.191.254. (The default for the #2 and #3 Ports is 000.000.000.000) If necessary, change it as described above.
7. Scroll down to IP Subnet Mask 1. The default is 255.255.255.000. If necessary, change as described above.
8. Continue as above to verify the IP information for the #2 and #3 Ports respectively. Check the preceding table for factory default addresses.
System Status Display

iBox front panel LEDs and the LCD display both provide status information.

LED Status Display

The LEDs of the front panel display provide immediate controller status information:

- **Computer**: Lights green when the controller microprocessor is running properly.
- **Safety A**: Lights green when Safety System A is functioning properly.
- **Safety B**: Lights green when Safety System B is functioning properly.
- **Car Top**: Lights green when the Cartop microprocessor is running properly.
- **Sys Comm**: Lights green when controller is communicating with Group.
- **Up**: Lights amber when car is moving up.
- **Drive On**: Lights amber when drive has control of car. Drive On may be ON while UP and DOWN are OFF indicating no movement but drive is holding zero speed.
- **Down**: Lights amber when car is moving down.
- **Run**: Lights green when car is making a run between floors. Remains off during re-leveling operations.
- **Relevel**: Lights red when car is releveling.
- **Safety OK**: Lights green when safety path is made up.
- **Doors Locked**: Lights green when doors are locked.
- **Inspection**: Lights amber when car is on Cartop, In-Car, Machine Room, or Hoistway Access Inspection.
- **In Group**: Lights green if car is able to respond to group hall call demand.
- **Fault**: Lights red if one or more system faults are active.

Note

These displays are frequently used when the elevator controller is being configured. Please refer to Sections 3 and 4 of this guide for use descriptions.
LCD Status Display
The LCD screen displays text messages advising of system status. The second line of the display shows the mode of operation (Passenger in the example) displayed in rotation with any active status messages. Please refer to “iControl Messages” on page 6-13 for description.

System Control Switches
The front panel system control switches allow you direct access to system functions including:

- Inspection: Switch used to place the car on Machine Room Inspection (Insp) or Normal operation (Norm).
- Up: Push switch used to run the car up when the system is on Machine Room Inspection and the Enable button is simultaneously pressed and held.
- Enable: Push switch used to run the car up or down when the system is on Machine Room Inspection and the Up or Down button is simultaneously pressed and held.
- Down: Push switch used to run the car down when the system is on Machine Room Inspection and the Enable button is simultaneously pressed and held.
- Controller Stop: Switch used to immediately remove hoist motor and brake power (Stop) or apply power to those systems (Run).
- Capture: Switch used to place Car on Capture operation (On). While this switch is On, the car will not respond to hall call demand or Parking.
- Test: Switch used to place the car on Test Mode operation (On).
- Fault/Function Bypass: Switch to allow specific faults and safety functions (as determined by Keypad/LCD settings) to be bypassed. Car must be in Test mode.
- Write Enable: (Factory only) Switch used to allow special data to be saved (On).
- Learn: Switch used to confirm intended Learn operation. The learn procedure must be selected. For Hoistway Learn, the car must be on Inspection mode. For Terminal Switch Learn, the car must be on Test mode.
- Car Door Bypass: Switch used to bypass the car door electric contacts (Bypass position). When set to Bypass, the car will run only on Inspection mode. The ability to set this bypass must be enabled at the factory and is only available if allowed by safety regulations in your area. Check the iView Safety Configuration screen to see if the feature is enabled in your installation.
• Hoistway Door Bypass: Switch used to bypass the hoistway door electric contacts (Bypass position). When set to Bypass, the car will run only on Inspection mode. The ability to set this bypass must be enabled at the factory and is only available if allowed by safety regulations in your area. Check the iView Safety Configuration screen to see if the feature is enabled in your installation.

Note

These control switches are used when the elevator controller is being configured. Please refer to Sections 3 and 4 of this guide for use descriptions.

Safety Bypass Jumper and Fuses

The iBox provides four fused outputs:

• 120v/60Hz AC: Fuses F2 and F2PI.
• 110v DC: Fuses F3 and F3HA.
• 120v/60Hz AC: Motor Drive. Fuse F2D.
• 120v/60Hz AC: Motor Contactor. Fuse F2MC.

When installed, the Safety Bypass jumper electrically connects the SB and 3 terminals on the IRB Relay Board. Information about the Safety Bypass jumper is in Section 6 of this guide (see “Safety String Bypass Jumper” on page 6-3).

Danger

The fuses and the bypass jumper expose dangerous high voltages that can cause bodily harm or death. ONLY TRAINED, AUTHORIZED PERSONNEL should have access to these areas.
About iVIEW

iVIEW is a graphical user interface running on a Windows PC or laptop computer. The computer may be connected directly to the iBox PC Ethernet port or, through a Local Area Network, to the iBox LAN ethernet port. Using iView, you can quickly and easily:

- View and adjust all user-configurable controller parameters (see page 8-17).
- Diagnose performance issues — on location, from a remote site, or both.
- Work in an offline file, then upload data to a controller (see page 8-23).

This section provides a detailed description of iView. iView on-line Help provides even greater detail and is updated whenever a software revision is released. This section contains:

- How iView Works (see page 8-2)
- Getting Started (see page 8-4)
- LAN Connections (see page 8-13)
- Working Online (see page 8-17)
- Saving Parameters to a Configuration File (see page 8-20)
- Saving Default Parameters to a Configuration File (see page 8-21)
- Loading Parameters from a Configuration File (see page 8-22)
- Working Offline (see page 8-23)
- Accessing Online Help (see page 8-24)
- iView Windows and Tabs (see page 8-25)
- Resizing Windows & Docking/Undocking Windows (see page 8-34 & page 8-35).
- Updating Controller Firmware (see page 8-41).
How iView Works

iView software runs on any PC using the Windows 2000 or later operating system. iView communicates with a controller through an Ethernet connection and loads operating parameters stored on the controller into iView screens. The iView user can view virtually any controller parameter and can edit/adjust any user-configurable parameter, then send changed parameters to the controller.

Because iView communicates with elevator controllers through an Ethernet connection, a single PC can be used to administer multiple elevators or even multiple groups of elevators (with each group operating under the direction of a group dispatcher). Elevator adjusters who service multiple sites will find it convenient to connect directly to a controller, then easily upload proven settings from a file on their hard drive to the controller. The diagram below illustrates just a few of the ways Ethernet connectivity allows iView to communicate with elevator controllers.

![Diagram of Ethernet connectivity](image)
Installing iView

If you purchased your iView PC from MCE, iView was installed at the factory. If not, you will need to install iView from a CD-ROM or other source. Minimum requirements for the iView PC are:

- At least 1GB free hard drive space for installation
- Minimum 256MB RAM
- Windows 2000 or XP operating system
- CD-ROM drive
- 10/100 Ethernet capable
- Simple text or comparable text editing software

These instructions assume familiarity with personal computers. To install iView:

1. Insert the iView CD-ROM in the computer CD-ROM drive.
2. Launch the CD.
3. Double-click the ReadMeFirst (or other accompanying text file) to review the latest iView instructions.
5. Follow on-screen instructions to install iView.

After installation, the iView icon will appear on your desktop.
Getting Started

There are two ways to connect the iBox to a PC:

- Direct Connection: Connect the PC directly to the iBox through the iBox 3 = PC port.
- Peripheral LAN Connection: Connect the PC to the LAN hub supporting one or more iBox controllers (iBox 1 = LAN port). (This hub is part of the iCue/iCentral installation.)

Connections are stored in the iControl Connections folder. To make a LAN connection, you launch iView, click File > Connection > Open and double-click the connection you wish to open. If the connection has not yet been created, you will need to create it as described in this section before you can connect to the controller. Please refer to “Creating a New LAN Connection” on page 8-13 if you need to create a connection. When entering addresses on a PC, do not use leading zeros, i.e., .020 is entered as .20. (When entering IP addresses through the iBox keypad, leading zeros are required.)

About LANs:   LAN stands for Local Area Network. A LAN is basically several computers (or smart equipment with a computer inside — like the iBox or iCue) all connected at a common point (the hub) so they can communicate with each other. In order for a message from one computer to reach the computer (or iCue/iBox) it wants to talk to, all the computers connected to the LAN have to have their own unique address. The address is called a TCP/IP number. The table below lists iControl default IP addresses. Your job prints provide specific instructions as to how all of your IP addresses are set.

Table 8.1   System, LAN, & 3=PC TCP/IP Addresses

<table>
<thead>
<tr>
<th>Hub</th>
<th>Group</th>
<th>Group IP, Primary &amp; Backup</th>
<th>Car ID</th>
<th>Car IP</th>
<th>System/Serial Hall Call Bus 1 - 4</th>
<th>iView PC</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN B</td>
<td></td>
<td>192.168.191.203-204</td>
<td>1-20</td>
<td>192.168.191.021-040</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAN D</td>
<td></td>
<td>192.168.191.207-208</td>
<td>1-20</td>
<td>192.168.191.061-080</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAN E</td>
<td></td>
<td>192.168.191.209-210</td>
<td>1-20</td>
<td>192.168.191.081-100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Port #3 = PC (iBox ONLY), NO HUB</td>
<td></td>
<td>192.168.193.001</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*192.168.191.101 is typically used for the iView PC.

The default Subnet Mask for all ports is 255.255.255.000.
The default Gateway for the #1 (LAN or Peripheral Port) is 192.168.191.254.
The default Gateway for the #2 and #3 ports is 000.000.000.000.

Note

The Group ID setting in iView determines the iCue System IP address at which iCue will accept messages. NO NOT set the Group ID to a setting other than 1 unless instructed to do so by MCE. Group IDs other than 1 are reserved for future use and will cause group-to-car communication to fail. If you need advanced System addressing information, please contact MCE.
Direct Connections

Unless a Local Area Network (Ethernet) hub has already been installed, you will find it easiest to connect a PC to the iBox using the 3 = PC port on the iBox (direct connection). To make a direct connection:

1. Connect the iView PC to the controller 3 = PC port using only a standard Ethernet cable. (Do not connect the #3 port through a hub or router.)

Figure 8.1 Ethernet Cable and iBox Ethernet Ports

![Diagram of Ethernet Cable and iBox Ethernet Ports]

Typical ethernet CAT-5 shielded cable. RJ45 connectors at each end.

Note

The iBox 3 = PC Ethernet port address, gateway, and mask are set to default values by MCE. If you have used your PC to connect to other iBoxes, you probably only need to connect the cable, launch iView, and select the connection with the appropriate IP information and use that to connect. When creating direct connections in the iView connections folder, it is a good practice to name them clearly so they are easy to distinguish (i.e., “CarA Direct”). The instructions here are intended to help a first-time user make a direct Ethernet connection between a PC and the iBox. Please refer to “System and LAN Ethernet” on page 11-15 for more detail.
2. Start the PC.
3. From the Windows XP Start menu, click Control Panel.
4. Double click Network and Internet Connections to open the Network and Internet Connections dialog.
5. Double click Network Connections to open the Network Connections dialog.
6. Double-click the Local Area Connection icon to open the Local Area Connection Status dialog.

7. Click Properties to open the Local Area Connection Properties dialog.

Note: Sample screens are Windows XP operating system.
8. In the Local Area Connection Properties dialog, select *Internet Protocol (TCP/IP)*.
9. Click *Properties* to open the Internet Protocol (TCP/IP) Properties dialog.
10. Set the IP Address to match the iBox EXCEPT FOR the last set of numbers. The #3 iBox port is defaulted to 192.168.193.1. Typically, you can set your PC’s IP address to 192.168.193.2.

![Internet Protocol (TCP/IP) Properties](image)

11. Set the Subnet Mask to 255.255.255.0.
12. Click OK and follow any instructions to save the changes you made.

**Note**

Sample screens are Windows XP™ operating system.

**Note**

It is important that the PC have only one IP address assigned. Click the *Advanced* button and verify that the PC is configured for only a single IP Address (192.168.193.2). If there is more than one IP Address, highlight the additional IP Address and then click *Remove*. 
Creating a Direct Connection in iView  

Once you have set your computer TCP/IP as described previously, you need to create a connection in iView.

1. Double-click on the iView icon on your computer screen to launch iView.
2. Click File on the menu bar.
3. Select Connection and click New to open the Connection dialog.

4. Type in a name for the connection.
5. Enter the direct connection IP Address for the iBox (192.168.193.1).
7. Click OK. The Save As dialog opens.
8. Enter a *File name* for this connection in the Save As dialog.

9. The suggested (default) location for connections is the *Connections* folder (My Documents > Motion Control Engineering > iView > Connections). You may choose another location using standard windows methods. You may also create sub-folders inside the iController Connections folder in which groups of connections can be stored.

10. Click *Save* to save the connection.
Connecting to the iBox  Once the connection is created and saved, you are ready to connect.

1. Click the Open Connection button
2. or click File on the menu bar, select Connection and click Open. The Open dialog appears.

3. To connect to a controller, double click the desired connection or select the connection and click Open.
4. When iView is communicating with a controller, this symbol is displayed in the bottom left corner of the iView screen.

5. When iView is not communicating with a controller, this symbol is displayed in the bottom left corner of the iView screen.

6. When the connection is established, the Operational Status tab and Hoistway window are displayed.
LAN Connections
In most installations, there will be at least one iView PC continuously connected to the Local Area Network on which the iBox controllers reside. LAN TCP/IP addresses and associated settings for any hubs, routers, or other equipment involved are resolved when network equipment is installed. In these instances, the iView PC is already connected through the network to the controllers.

Creating a New LAN Connection
A controller connection must be created before it appears in the iView Connections folder. This is typically completed at the factory, before the system is shipped (if your PC was purchased through MCE). Creating a new LAN connection is similar to creating a new Direct connection. To create a LAN connection:

1. Double-click on the iView icon on your computer screen to launch iView.
2. Click File on the menu bar.
3. Select Connection and click New to open the Connection dialog.
4. Type in a name for the connection.
5. Enter the Ip Address, the controllers #1 (LAN) Ethernet port address. The site network administrator should have this information for you. Please refer to “System, LAN, & 3=PC TCP/IP Addresses” on page 8-4 for the factory default settings.
7. Click OK. The Save As dialog opens.
8. Enter a *File name* for this connection in the Save As dialog (the Connection automatically suggested).

9. The suggested (default) location for connections is the *Connections* folder (My Documents > Motion Control Engineering > iView > Connections). You may choose another location using standard windows methods. You may also create sub-folders inside the iController Connections folder in which groups of connections can be stored.

10. Click *Save* to save the connection.
Connecting to the iBox  

Once the connection is created and saved, you are ready to connect.

1. Click the **Open Connection** button

2. or click **File** on the menu bar, select **Connection** and click **Open**. The Open dialog appears.

3. To connect to a controller, double click the desired connection. The connection will take a moment or two to establish, then a main screen will appear.

**Note**

The default location for connection (.conn) files is the **Connections** folder (My Documents > Motion Control Engineering > iView > Connections). The default location for configuration (.cfg) files is the **Configuration** folder (My Documents > Motion Control Engineering > iView > Configuration). If you want to work online, connected to a controller, select **Connection > Open** from the File menu. Connection (.conn) files will be displayed in the Open dialog. If you want to work in an offline configuration file, select **Configuration File > Edit** from the File menu. Configuration (.cfg) files will be displayed in the Open Configuration File dialog. Refer to the **Working Online** and **Working Offline** topics later in this section for more information.
**Editing an Existing LAN Connection**

1. Click Edit on the File > Connection menu.
2. The Open dialog is displayed. Double click the connection you wish to edit. The connection dialog is displayed. Click in any field and correct the information you wish to edit.
3. Click **OK**.

**Delete an Existing LAN Connection**

1. Select Edit on the File > Connection menu.
2. The Open dialog is displayed. Right-click on the connection you wish to delete.
3. Select **Delete** from the popup menu.
4. A warning dialog will appear. Click **Yes** to delete the connection or **No** to cancel without deleting.
Working Online

Working Online means that you are connected to an iController and are viewing or adjusting its parameters. To work online, select Open from File > Connection menu and double click the desired connection in the Open dialog.

When the connection is established, the Operational Status tab and Hoistway window are displayed with the Controller’s connection name on the top left side of the title bar.

When iView is communicating with a controller, this symbol is displayed in the bottom left corner of the iView screen.

When iView is not communicating with a controller, this symbol is displayed in the bottom left corner of the iView screen.

When working online, you may:

- View and adjust any configurable settings.
- Send adjusted settings to the controller.
- Save parameters to a Configuration file.
- Get parameters from a Configuration file and send them to the controller.
- Access Online Help
Viewing and Adjusting Settings

To view and/or adjust settings, you first select the Configuration tab associated with those settings. There are two ways to select Configuration tabs:

1. Click the desired tab on the View > Configuration menu.
2. To display all of the configuration tabs (this takes a few seconds), click View > Layouts > Configuration. You can then click the desired tab (Configuration layout shown with Pattern/Modes tab selected).

Some tabs have one or more “sub-tabs,” each supporting a related set of controls or displays. For example, if you want to adjust a timer associated with the brake, click the Brake tab and then click the Control tab. The Timer settings will appear.

To adjust a particular setting, Pick delay for example, you may either drag the cursor over the existing value and type in a new value or you may use the associated control (up/down arrows) to increase or decrease the setting.
Sending Adjustments to the Controller

After making adjustments you will want to send the new parameter values to the controller. To send the new values:

1. Select Acquire from the Write privilege menu.
2. Press the “Yes” softkey on the iBox to grant the privilege request.
3. Then click Send to send changes to the controller. (The Send button becomes active when parameter changes have been made.)
Saving Parameters to a Configuration File

All of the iView settings associated with a controller can be saved in a configuration (.cfg) file. The .cfg extension identifies a file used to store information in a predetermined, fixed structure (XML).

Using configuration files to store settings on a hard drive, USB Flash Drive or other storage media provides some great capabilities:

- Working Offline: Using iView, you can open a file and work with its settings without necessarily having access to the controller itself.
- File Uploading: When connected to a controller, you can choose to get some or all of the settings in a configuration file and send them to the controller.
- Adjuster Portability/Flexibility: Elevator adjusters can store configuration files associated with all the controllers they service on their laptop PC. They can edit values offline, then coordinate with on site, machine room personnel to connect and upload those changes to the controller through the elevator Local Area Network or, through modems, DSL, T1 or other internet connections, from virtually anyplace in the world.
- Archiving controller data for future use.

You create configuration files by saving controller parameters to a file while you are working online.

Save to File

While connected to a controller, you can easily save all controller parameters to a configuration (.cfg) file.

1. Click the *Save Configuration File* button
2. or select *Save* from the *File > Configuration* menu. A typical Windows save dialog appears.
   - The default name suggested for the file will be the controller connection name with .cfg appended. **Caution:** If the parameters for this controller have previously been saved using the default name, those previously saved parameters will be overwritten unless you change the file name. You may want to add a number or date to the file name.
   - The default folder suggested in the dialog is the Configurations folder (My Documents > Motion Control Engineering > iView > Configurations).
3. Click *Save* to save the file.
4. Once you have saved the file, it will appear in the Open Configuration File dialog the next time you select either Load or Edit from the File > Configuration menu.
Saving Default Parameters to a Configuration File

The Controller and/or System default parameter settings can be saved to a configuration (.cfg) file. The default parameter values can then be loaded onto the controller should you determine that you want to start making adjustments beginning with the default values.

To Save the Default Parameters:

1. Select Controller or System from the File > Configuration > Generate default menu. The Controller or System default configuration dialog appears.

2. In the Controller or System default configuration dialog, enter the desired file name.

3. The default folder suggested is the Configurations folder (My Documents > Motion Control Engineering > iView > Configurations). You may change this if you so desire.

4. Click Save to save the file.

5. Once you have saved the file, it will appear in the Open Configuration File dialog the next time you select either Load or Edit from the File > Configuration menu. You can load the default parameters onto the controller by selecting Load from the File > Configuration menu as described on the next page.
Loading Parameters from a Configuration File
When working online (connected to a controller), you may load (send) selected data from a previously saved configuration (.cfg) file to the controller (after ensuring that it is safe to do so and setting the iBox Controller Stop switch appropriately).

1. Acquire Write Privilege (select Acquire from the Write Privilege menu).
2. Select Load from the File > Configuration menu.
3. The Open Configuration File dialog is displayed, allowing you to choose the desired configuration file. Select the file and click Open or double-click the file.
4. The Select Categories dialog opens allowing you to choose the data to send: “All screens” or data from “Selected screens”.
5. After selecting the desired data, click Ok to send or Cancel. If you selected “All categories” or any “Security” parameters, you must enter the Security Password and click Ok. The default security password is “manager”.

![Select Categories dialog](image)
Working Offline

Working offline means that you are not connected to a controller but are working with a configuration (.cfg) file. You must have previously created the configuration file by saving it while working on line with a controller. Please refer to “Saving Parameters to a Configuration File” on page 8-20. To work offline:

1. Launch iView.
2. Select Edit from the File > Configuration menu.
3. The Open Configuration File dialog opens. Double-click or select the desired configuration file and click Open. The .cfg extension indicates that this is a configuration file used when working off-line.
4. A top level screen resembling the controller screen will appear. The title bar of the screen displays the path and file name. You access the parameter screens and edit parameters just as you do online. However, you cannot send parameters to a controller while offline. Please refer to “Loading Parameters from a Configuration File” on page 8-22.
5. To save changes, click the Save button .

Note

While working offline you will not be able to view some real-time data screens such as Hoistway and Floor Heights.

To copy a configuration file: You may not want to modify the original configuration file. Instead, you can make a copy of the original and then edit the copy.

1. Click the Start button.
2. Click My Documents.
3. Double click the Motion Control Engineering folder.
4. Double click the iView folder.
5. Double click the Configurations folder.
6. Select the configuration file and click “Copy this file” in the File and Folder Tasks list.
7. Select a location from the Copy Items dialog and click Copy.
8. Right click the copied file and select Rename.
9. Type the new name and press Enter.
10. From the File menu in iView, select Configuration > Edit.
11. Select the file from the Open Configuration File dialog and click Open.
12. Edit and Save the file.
Accessing Online Help

iView offers extensive online help. Help is available whether you are working online or offline. On-line help is incorporated into iView to provide information about iControl screens and parameters. You can access iView On-line Help in the following ways:

**Context Sensitive Help** You can view On-line Help information about any screen or tab by pressing function-key one (F1) while a screen or tab has focus. Do the following:

- Click the title bar of a window, e.g., the Hoistway window, to bring focus to the window. The background color of the window’s title bar darkens indicating that the window has focus. Then press the F1 key. iView Help will display the topic that describes the window.
- Click a tab (title). An outline will appear around the tab title indicating that the tab has focus. Then press the F1 key. iView Help will display the topic that describes the tab.

**Context Sensitive Event Help** The Controller logs status and error information in the Event Log (see “Diagnostics - Diagnostic Outputs” on page 9-14). To view the Event Log, Event Properties and Context Sensitive Event Help:

1. In the Controller view, click View > Diagnostics > Event Log to display the Event Log.
2. Double click an event in the Event Log to display the Event Properties dialog.
3. Click the Help button in the Event Properties dialog to display the Troubleshooting Tips dialog which provides a description of the event, an indication of what action is taken, and troubleshooting tips if appropriate.

**Help Viewer** iView On-line Help provides three additional ways of locating information. The Contents and Index tabs let you find general information. The Search tab lets you look up specific words or phrases.

To start iView On-line Help:

1. On the iView menu bar, click Help.
2. On the Help menu, click iView Help. The help viewer is displayed. Use the Contents, Index or Search tabs to locate the desired information.

iView On-line Help provides the following kinds of information:

- Using iView Help - A description of the many options, capabilities and ways of using iView On-line Help.
- Using iView - Provides information and instructions on how to use the iView graphical user interface.
- iView Windows and Tabs - Lists all of the iView windows and tabs and provides links to descriptions of the parameters on each tab.
- Message Reference - An alphabetical listing of iControl status and error messages. Each listing includes a description, an indication of what action is taken, and troubleshooting tips.
- Parameter Reference - a tab by tab listing of all of the Controller and System parameters including a description of each parameter.
iView Windows and Tabs

The View menu is used to navigate to the various windows and tabs in the Controller view and System view. Many tabs have subordinate tabs that are not shown here, but are documented in the Content Overview tables that follow.

Controller - Configuration Tabs

Controller parameter settings are displayed and may be changed on the Controller - Configuration tabs. The Configuration tabs may be accessed in one of two ways.

1. While in Controller view (see “Selecting Controller View” on page 9-1), select the desired tab from the View > Configuration menu.
2. Display all of the Configuration tabs by selecting Configuration from the View > Layouts menu. Then click the desired configuration tab.

Controller - Diagnostic Tabs

The Controller - Diagnostic tabs contain information about the status and condition of the controller. The Diagnostic tabs can be accessed in one of two ways.

1. Select the desired tab from the View > Diagnostics menu.
2. Display all of the Diagnostic tabs by selecting Diagnostics from the View > Layouts menu. Then click the desired diagnostics tab.

Controller - Setup Tabs

The Controller - Setup tabs are used to perform the iControl automatic and semi-automatic setup procedures. The Setup tabs can be accessed by selecting Setup from the View menu. Then click the desired calibration tab.

Additional Windows

Additional windows can be accessed from the View menu. They include:

- Data Trap
- Hoistway
- Outputs
- Safety Tests
- Virtual Oscilloscope
Specific contents will vary depending on the hardware installed at your site and on the revision level of your iView and iBox software. Always refer first to the online help available within iView. Online help contains the most detailed and current information about your iView software. For detailed parameter or display descriptions, refer also to Section 9 of this manual.

Table 5.2 lists the items on the View menu and tables 5.3 through 5.5 list the tabs found on the Configuration, Diagnostics and Setup menus. Click the “see page” links to jump to that page.

**Table 8.2 Controller - View Menu**

<table>
<thead>
<tr>
<th>Window</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>Parameter settings are displayed and may be changed on the Configuration tabs. The tabs include Brake, Car Operation, Drive, General, I/O Board, Load Weigher, Motor Field, Pattern, Safety, Serial I/O Simplex Configuration, Simplex Security, Terminal Switches and Timer Tables (see page 9-25).</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>The Diagnostic tabs contain information about the status and condition of the controller. The tabs include Diagnostic Outputs, Event Log, Fault Bypass, Operational Status and Terminal Switches Status. Three additional diagnostic screens, Data Trap, Diagnostic Outputs and Virtual Oscilloscope, are displayed each in their own window. This allows them to be used with other windows (see page 9-11).</td>
</tr>
<tr>
<td>Setup</td>
<td>The Setup tabs are used to perform the automatic and semi-automatic setup procedures. The tabs include Brake, Counterweight, Drive, Floor Heights, Floor Off- sets, Load Weigher, Safety and Terminal Switches (see page 9-143).</td>
</tr>
<tr>
<td>Hoistway</td>
<td>A graphical representation of the car in the hoistway, including assigned car and hall calls. Shows the current mode of operation, direction preference, speed and actual floor height information (see page 9-4).</td>
</tr>
<tr>
<td>Safety Tests</td>
<td>Automated control of acceptance test procedures (see page 9-156).</td>
</tr>
<tr>
<td>Layouts</td>
<td>Pre-programmed screen layouts can be displayed. Custom screen layouts can be created and saved and displayed (see page 9-157).</td>
</tr>
</tbody>
</table>

**Table 8.3 Controller - Configuration Tabs**

<table>
<thead>
<tr>
<th>Tab</th>
<th>Sub-Tab</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced</td>
<td>Custom Outputs</td>
<td>Allows existing inputs, outputs and internal flags to be combined in a logic equation which can then generate a custom output (see page 9-142).</td>
</tr>
<tr>
<td></td>
<td>User Events</td>
<td>Configure User Events (see page 9-141)</td>
</tr>
<tr>
<td>Brake</td>
<td>Control</td>
<td>Brake voltage, timer and filter settings (see page 9-26).</td>
</tr>
<tr>
<td></td>
<td>Configuration</td>
<td>Brake voltage, Output timer, and Current reference settings for braking progression at 10% increments (brake fine tuning) (see page 9-28).</td>
</tr>
<tr>
<td>Car Call Enable</td>
<td></td>
<td>Configure the enable inputs to be active high or low (see page 9-29).</td>
</tr>
<tr>
<td>Car Operation</td>
<td>Doors</td>
<td>Door motor protection timer settings, safe edge and photo eye bypass selections, plus front and rear door closing delay, etc. (see page 9-31).</td>
</tr>
<tr>
<td>(see page 9-30)</td>
<td>Devices</td>
<td>Hall and car gong settings, emergency alarm monitoring and serial fixture parameters (see page 9-35).</td>
</tr>
<tr>
<td></td>
<td>Passenger</td>
<td>Anti-nuisance, nudging, exercise operation, automatic swing operation, and door operation settings for car in normal passenger service (see page 9-39).</td>
</tr>
</tbody>
</table>
### Table 8.3  Controller - Configuration Tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Sub-Tab</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Car Operation</strong></td>
<td>Fire Service</td>
<td>Main and alternate recall, fire code selection, and door functionality for car in fire service operation (see page 9-46).</td>
</tr>
<tr>
<td></td>
<td>Independent</td>
<td>Door and call functionality for car on Independent service (see page 9-61).</td>
</tr>
<tr>
<td></td>
<td>Service</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Elevator Recall</td>
<td>Recall floor, call disposition, door operation, and override settings for car on recall operation (see page 9-63).</td>
</tr>
<tr>
<td></td>
<td>Earthquake</td>
<td>Counterweight displacement sensor enable/disable, and earthquake code selection for car on earthquake operation (see page 9-66).</td>
</tr>
<tr>
<td></td>
<td>EMS</td>
<td>Emergency Medical Service settings (recall floor, switch, and doors etc.) (see page 9-68).</td>
</tr>
<tr>
<td></td>
<td>Emergency</td>
<td>Includes recall, generator and door settings for car on Emergency Power operation (see page 9-72).</td>
</tr>
<tr>
<td></td>
<td>Power</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CFSS</td>
<td>Commandeer for Special Services. Parameters determine car behavior when operating in CFSS Recall and In-car modes (see page 9-75).</td>
</tr>
<tr>
<td></td>
<td>Flood</td>
<td>Determines Flood operation floors, substitute Emergency Power and Fire recall floors, and Flood operation bypass settings (see page 9-78).</td>
</tr>
<tr>
<td></td>
<td>operation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Attendant</td>
<td>Set front and rear door operation parameters used during Attendant Service operation (see page 9-80).</td>
</tr>
<tr>
<td></td>
<td>service</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Auto stop</td>
<td>Parameters determine car behavior during Automatic Stop operation (see page 9-81).</td>
</tr>
<tr>
<td></td>
<td>Sabbath</td>
<td>Enable/disable, select floors and other parameters that determine car behavior while on Sabbath operation (see page 9-83).</td>
</tr>
<tr>
<td></td>
<td>operation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shuttle</td>
<td>Allows a car to provide express service for a subset of the building’s floors (see page 9-86).</td>
</tr>
<tr>
<td></td>
<td>Service</td>
<td></td>
</tr>
<tr>
<td><strong>Drive</strong></td>
<td>General</td>
<td>Drive type selection, speed reference selection, speed reference configuration, and system drive-related selections for drive (see page 9-90).</td>
</tr>
<tr>
<td></td>
<td>Safety</td>
<td>Speed reference and over-current settings (see page 9-92).</td>
</tr>
<tr>
<td></td>
<td>Filters</td>
<td>Drive notch and system filter settings (see page 9-93).</td>
</tr>
<tr>
<td></td>
<td>Pre-Torque</td>
<td>Pretorque enable/disable and option settings (see page 9-94).</td>
</tr>
<tr>
<td></td>
<td>Calibration</td>
<td>Drive offset settings (see page 9-95).</td>
</tr>
<tr>
<td><strong>Floor Heights</strong></td>
<td>Configurations</td>
<td>Use to view the learned values for the floor heights (see page 9-96).</td>
</tr>
<tr>
<td></td>
<td>Floor Offsets</td>
<td>Use to view the learned values of the floor offsets (see page 9-96).</td>
</tr>
<tr>
<td><strong>General</strong></td>
<td>General</td>
<td>Job information, car label, ID, simplex car and backup dispatcher options (see page 9-97).</td>
</tr>
<tr>
<td></td>
<td>Floors Data</td>
<td>Front and rear opening settings for all floors (see page 9-98).</td>
</tr>
<tr>
<td></td>
<td>Car Call</td>
<td>Car Call eligibility settings for all floors. Default eligibility configurations to be used during special modes of operation, e.g. Independent service (see page 9-99).</td>
</tr>
<tr>
<td></td>
<td>Eligibility</td>
<td></td>
</tr>
<tr>
<td><strong>I/O Board</strong></td>
<td>Configuration</td>
<td>Graphical display and organization of controller and cartop I/O boards including specific input and output assignment on connectors (see page 9-102).</td>
</tr>
<tr>
<td></td>
<td>Configurable</td>
<td>Determines during which modes of operation the Door Enable Output, Automatic Closing Output and/or Hall Door Button Output are disabled.</td>
</tr>
<tr>
<td></td>
<td>outputs</td>
<td></td>
</tr>
<tr>
<td><strong>IBox Configuration</strong></td>
<td></td>
<td>IP information for iControl (see page 9-128).</td>
</tr>
<tr>
<td><strong>Load Weigher</strong></td>
<td></td>
<td>Load Weigher configuration and threshold settings (see page 9-129).</td>
</tr>
</tbody>
</table>
Table 8.3 Controller - Configuration Tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Sub-Tab</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pattern</td>
<td>Common</td>
<td>Display and edit parameters common to all pattern profiles. Position encoder resolution, leveling and releveling speeds, pattern scaling, dead zone distance, door pre-opening distance, and position synchronization by floor or terminal switches (see page 9-131).</td>
</tr>
<tr>
<td>Terminal Switches</td>
<td></td>
<td>Position margin settings for up and down normal terminal and emergency terminal switches, and Overspeed 1 margin setting (see page 9-137).</td>
</tr>
<tr>
<td>Timer Tables</td>
<td></td>
<td>Programming of timed operations (Sabbath, Swing and Auto stop operation).(see page 9-138).</td>
</tr>
</tbody>
</table>

Table 8.4 Controller - Diagnostics Tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Sub-Tab</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operational Status</td>
<td></td>
<td>Displays the car status including: motion, speed, position, pattern, motor and brake, processor, in-service, leveling, door locks, faults and car status (see page 9-8).</td>
</tr>
<tr>
<td>Data Trap</td>
<td></td>
<td>Use this tool to record and analyze controller data including input and output states, internal flags and parameter values (see page 9-12).</td>
</tr>
<tr>
<td>Diagnostic Flags</td>
<td>Car Operation</td>
<td>Displays status of car operation input and output flags, including front and rear doors, e.g. car call above, car call below. Click arrow buttons to display dependent outputs (see page 9-12).</td>
</tr>
<tr>
<td></td>
<td>Motion</td>
<td>Displays the status of Passenger (automatic) and Inspection mode motion related inputs and outputs, e.g. Ready, Synchronization and Qualifier status.</td>
</tr>
<tr>
<td></td>
<td>Drive</td>
<td>Displays the status of Drive related inputs and outputs, e.g. Up direction request, Pattern enable, and Motor run mode.</td>
</tr>
<tr>
<td></td>
<td>Safety</td>
<td>Displays the status of Safety related inputs and outputs, e.g. Car top exit open, Governor open, and Safety (Car) open.</td>
</tr>
<tr>
<td>Diagnostic Outputs</td>
<td></td>
<td>Selection and display of up to sixteen system outputs for monitoring or diagnosis. Hundreds of outputs are available (see page 9-14).</td>
</tr>
<tr>
<td>Event Log</td>
<td></td>
<td>Display of recorded controller events (see page 9-15).</td>
</tr>
<tr>
<td>Fault Bypass</td>
<td></td>
<td>Enable/disable selected system faults to facilitate adjustment and testing. Display of faults currently bypassed (see page 9-18).</td>
</tr>
<tr>
<td>Terminal Switches Status</td>
<td></td>
<td>Displays the learned terminal switch speeds and positions, overspeed and position fault thresholds and last pass positions and speeds (see page 9-20).</td>
</tr>
<tr>
<td>Virtual Oscilloscope</td>
<td></td>
<td>An on-board oscilloscope with software selection of test point signals to be monitored and customizable display (see page 9-22).</td>
</tr>
</tbody>
</table>
Table 8.5  Controller - Setup Tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brake</td>
<td>Calibrate the brake voltage settings (see page 2-46 and page 9-143).</td>
</tr>
<tr>
<td>Counterweight</td>
<td>Learn the position where counterweight is adjacent to the car (see page 3-28 and page 9-144).</td>
</tr>
<tr>
<td>Drive</td>
<td>Learn the values for the Drive Offsets (see page 2-46 and page 9-145).</td>
</tr>
<tr>
<td>Floor Heights</td>
<td>Learn the absolute floor positions (distance to each floor from the lowest landing). Also used to assist in measuring and entering the floor offsets (deviation of floor magnet position from actual floor stopping position) (see page 4-2, page 4-25, page 9-146 and page 9-149).</td>
</tr>
<tr>
<td>Load Weigher</td>
<td>Learn the car empty and full load weights (see page 4-31 and page 9-150).</td>
</tr>
<tr>
<td>Safety</td>
<td>Verify that the configurations of the main and safety processors match. Perform the Inventory learn procedure (see page 9-151 and page 9-154).</td>
</tr>
<tr>
<td>Terminal Switches</td>
<td>Learn the speeds and positions of the normal and emergency terminal switches (see page 4-9 and page 9-155).</td>
</tr>
</tbody>
</table>

Table 8.6  Controller - Miscellaneous Dialogs/Controls

<table>
<thead>
<tr>
<th>Tab</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Registration</td>
<td>Allows you to register car and hall calls. This control is accessed by clicking the Call Registration button on the button bar (see page 9-158).</td>
</tr>
<tr>
<td>Firmware Update</td>
<td>Guides you through the process of updating iControl firmware. This control is accessed by selecting Firmware Update from the File menu (see page 8-41).</td>
</tr>
<tr>
<td>Refresh</td>
<td>Updates the information displayed on iView windows and tabs. This control is accessed by clicking the Refresh button on the button bar.</td>
</tr>
</tbody>
</table>
Controller - Layouts

With iView, you can move and size tabs to suit the task to be performed. When you find a particular arrangement to be useful, you can save it as a custom layout (View > Layouts > Save as). You can then display that layout at any time by selecting your custom layout from the View > Layouts > Custom menu.

Some useful layouts have been pre-programmed and are supplied with iView. They include:

- **Configuration**: This layout displays all of the configuration tabs for easy selection.

- **Diagnostics**: Displays all of the diagnostic tabs for easy selection.

- **Default**: Displays the default (initial connection) layout.

- **Brake**: Used to perform the brake calibration procedure. Displays the Brake setup and configuration tabs plus the Hoistway pane.

- **Drive**: Used to perform the drive offsets calibration. Displays the Drive setup and configuration tabs plus the Hoistway pane (see page 2-46).

- **Floor Heights**: Used to perform the hoistway (floor heights) learn operation. Displays the Floor Heights setup and configuration tabs plus the Hoistway pane.

- **Load Weigher**: Used to perform the Load Weigher learn procedure. Displays the Load Weigher setup and configuration tabs plus the Hoistway pane.

- **Motor Field**: Used to perform the Motor Field calibration procedure. Displays the Motor Field setup and configuration tabs plus the Hoistway pane.

- **Terminal Switches**: Used to perform the Terminal learn procedure. Displays the Terminal Switches setup, configuration and diagnostics tabs plus the Hoistway pane.

- **Custom**: Used to select a custom layout to be displayed. This is the listing of custom layouts created using View > Layouts > Save as.

- **Save As**: Used to create and save a custom layout.
  - Enter the name for the custom layout.
  - Click OK.
System View Windows and Tabs

System - Configuration Tabs
System parameter settings are displayed and may be changed on the System - Configuration tabs. The Configuration tabs may be accessed in one of two ways.

1. While in System view (see “Selecting System View” on page 10-1), select the desired tab from the View > Configuration menu.
2. Display all of the Configuration tabs by selecting Configuration from the View > Layouts menu. Then click the desired configuration tab.

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>System I/O</th>
<th>Security</th>
<th>Emergency Power</th>
<th>Legacy Group Interface</th>
<th>Timer Tables</th>
<th>Remote Outputs</th>
<th>User Events</th>
</tr>
</thead>
</table>

System - Diagnostic Tabs
The System - Diagnostic tabs contain information about the status and condition of the system. The Diagnostic tabs can be accessed in one of two ways.

1. Select the desired tab from the View > Diagnostics menu.
2. Display all of the Diagnostic tabs by selecting Diagnostics from the View > Layouts menu. Then click the desired diagnostics tab.

<table>
<thead>
<tr>
<th>Diagnostics</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Log</td>
<td></td>
</tr>
</tbody>
</table>

Additional Windows
Additional windows can be accessed from the View menu. They include:

- Hoistway
- System Performance
- Layouts

Table 8.7 System - View Menu

<table>
<thead>
<tr>
<th>Window</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration</td>
<td>System parameter settings are displayed and may be changed on the Configuration tabs. The tabs include Emergency Power, System Configuration, Legacy Group Interface, Security, System I/O, Timer Tables, User Inputs and User Outputs (see page 10-2).</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>The System Diagnostic tabs contain information about the status and condition of the system. The tabs include Event Log (see page 10-68).</td>
</tr>
<tr>
<td>Hoistway</td>
<td>A graphical representation of the cars in the system hoistways, including assigned car and hall calls. Shows the current mode of operation, direction preference and current floor for each elevator (page 10-70).</td>
</tr>
<tr>
<td>System Performance</td>
<td>Graphical representation of system performance statistics (see page 10-74).</td>
</tr>
<tr>
<td>Layouts</td>
<td>Use to load Configuration, Diagnostic or Custom layouts (see page 10-75).</td>
</tr>
</tbody>
</table>
### Table 8.8 System - Configuration Tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Sub-Tab</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Emergency Power</strong></td>
<td>Building</td>
<td>Use to indicate cars connected to each generator and define how switching to and from emergency power is handled (see page 10-33).</td>
</tr>
<tr>
<td>System Configuration</td>
<td>CFSS</td>
<td>Definition of Commandeer For Special Services modes 1 and 2 (see page 10-9).</td>
</tr>
<tr>
<td></td>
<td>Dispatching</td>
<td>Define system dispatching options and manually select dispatching configurations (see page 10-11)</td>
</tr>
<tr>
<td></td>
<td>Hall Call Eligibility</td>
<td>Define up to eight Hall call eligibility configurations (see page 10-13).</td>
</tr>
<tr>
<td></td>
<td>Mode of Operation</td>
<td>Define up to eight dispatching Mode of Operation configurations (see page 10-14).</td>
</tr>
<tr>
<td></td>
<td>Parking</td>
<td>Define up to eight Parking configurations (see page 10-21).</td>
</tr>
<tr>
<td></td>
<td>Parking Eligibility</td>
<td>Define up to eight Parking Eligibility configurations (see page 10-27).</td>
</tr>
<tr>
<td></td>
<td>Split Bank</td>
<td>This capability is only available through the Central Dispatcher (see page 10-29).</td>
</tr>
<tr>
<td><strong>Legacy Group Interface</strong></td>
<td>General</td>
<td>Select either Cross-cancellation or Cross-registration (see page 10-36).</td>
</tr>
<tr>
<td></td>
<td>Hall Calls</td>
<td>Shows the status of System Security. Use these controls to configure car and hall call restrictions for a simplex or swing car or car assigned to be the backup or local dispatcher for a group (see page 10-38).</td>
</tr>
<tr>
<td></td>
<td>Car Calls</td>
<td></td>
</tr>
<tr>
<td><strong>System I/O</strong></td>
<td>System</td>
<td>Configuration of system input/output settings (see page 10-51).</td>
</tr>
<tr>
<td></td>
<td>Bus</td>
<td>Serial bus troubleshooting.</td>
</tr>
<tr>
<td><strong>Timer Tables</strong></td>
<td></td>
<td>Use to configure timer tables to control system functions, e.g., Hall call eligibility, Parking, Parking eligibility, Mode of operation, Security, and User outputs 1 through 3 (see page 10-62).</td>
</tr>
<tr>
<td><strong>User Events</strong></td>
<td></td>
<td>Define User Events which, when assigned a hardware input, are logged on the System Event Log when activated and deactivated (see page 10-65).</td>
</tr>
<tr>
<td><strong>Remote Outputs</strong></td>
<td>Configuration</td>
<td>Define and configure up to 32 Remote Outputs which can be wired to any input or other device as needed (see page 10-66).</td>
</tr>
<tr>
<td></td>
<td>Trigger</td>
<td></td>
</tr>
</tbody>
</table>

### Table 8.9 System - Diagnostic Tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Log</td>
<td>Display of recorded system events (page 10-68).</td>
</tr>
</tbody>
</table>

### Table 8.10 System - Miscellaneous Dialogs/Controls

<table>
<thead>
<tr>
<th>Tab</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Registration</td>
<td>Allows you to register car and hall calls. This control is accessed by clicking the Call Registration button on the button bar (see page 10-73).</td>
</tr>
<tr>
<td>Refresh</td>
<td>Updates the information displayed on iView windows and tabs. This control is accessed by clicking the Refresh button on the button bar.</td>
</tr>
</tbody>
</table>
Pinning and Unpinning Windows

Notice that iView windows have a little push-pin icon in the upper right corner, e.g. the Hoistway window shown on the right.

- When the pin is pointing down, the window is “pinned” in its designated position.

- If you click the pin icon, it points to the left and a button, labeled Hoistway, appears to the right of the window.
- The window remains in view if the window has focus (click the window title bar) or as long as the mouse cursor remains on the window or button.

- But if another window has focus and you move the mouse cursor off of the window or button, the window collapses out of view.

- To temporarily bring the window into view again, place the mouse cursor over the button. The window slides into view and will remain in view if you click the window's title bar or as long as the cursor remains on the button or window.

To permanently display the window again:

1. Bring the window into view by placing the cursor over the button.
2. Click the pin so that it is pointing down again.
Resizing Windows

iView windows can be resize so that you see just the data you need to perform a test or task.

To resize a window:

1. Place the mouse cursor in the space between the windows.

2. When the cursor changes to a double line with arrows, you can click and drag (hold the left mouse button down while moving the mouse) the window boundary and resize the window.
Docking and Undocking Windows

iView windows can be undocked from their assigned position and moved to another position on the screen.

To undock and move a window:

1. Notice that the Diagnostics window is positioned at the bottom of the screen (connection arrows at bottom left corner). Double click the window title bar.

2. The title bar and frame around the Diagnostics window change to a solid blue line indicating that the window is now undocked and can be moved.

3. Click the title bar and drag (hold down the left mouse button while moving the mouse) the window to a new location.

4. Release the mouse button. The undocked window will appear in the new location, on top of whatever is in that location. You can tell that it is undocked because the solid blue frame remains.

5. You can quickly return the window to its original docked location by double-clicking in the window’s title bar.
To dock a window in a new location:

1. Notice that while moving an undocked window, docking controls appear near the center and at the top, bottom and sides of the screen. As you slide the cursor over the controls, a light blue highlight indicates the position to which the window will be moved. Release the mouse button and the window docks in the new location.
2. An alternate method of moving a window is to right click the title bar of the window. In the drop down list that appears, select Dock to and click the desired location. In the example below, the Diagnostics window has been moved to the top of the screen.

3. If you like this arrangement and would like to be able to easily display this arrangement in the future, you can save it as a Custom Layout. Please refer to “Controller - Layouts” on page 8-30.
Printing Screens

1. With the screen displayed, press the Print Screen key to send the entire screen to the clipboard (PC memory).
2. To send only the selected item (window or dialog) to the clipboard, press and hold the Alt key, then press the Print Screen key.

Items sent to the clipboard can be pasted into any of several applications. One that you should definitely have on your PC is Wordpad.

3. Open the Wordpad application (Start > All Programs > Accessories > Wordpad).
4. Select Paste from the Edit menu or press and hold the Ctrl key while pressing and releasing the “v” key to paste the captured screen into Wordpad.
5. Select Print from the File menu to print the screen.
6. Save the file if you want to keep a record of the screen on the PC hard drive.

Setting the System’s Date and Time

The iControl system’s time and date can be set using the iView application connected to the Central Dispatcher (iCue PC), Local/Dispatcher or Simplex car controller. The dispatcher’s time and date are transferred to all local cars that are running (communicating) and all other cars as they power up.

To set the time and date:

1. Establish an iView connection to the system dispatcher or simplex car.
2. Double-click the time/date display at the bottom-right of the status bar (shown below). The Date / Time Configuration dialog will appear:

   ![Date / Time Configuration dialog](image)

3. Use the controls to set the date and/or time and click Apply or OK. The date and time will be updated on all controllers communicating with the dispatcher.

Note

The iView PC’s time, which is displayed at the very bottom-right corner of the screen, is not the same as the iControl system’s date and time. The iControl system’s date and time are displayed on the iView status bar and are set using the Date / Time Configuration dialog shown above.
Editing Dynamic Displays

The virtual oscilloscope display is editable. You may easily modify labels, displays, animation, and more to suit your immediate display needs. When a display is closed, then re-opened, it reverts to its default values.

To edit a display:

- Right-click on the graph or on one of the scales to reveal a popup menu. Select Edit from the menu.
4. Experiment with modifying the display to find the combinations that suit the signal types you are currently examining. The Edit menu is extensive:

![Plot Axis Editor](image1)

5. Several different editors are available depending on where you click in the graphic display.

![Data-View Editor](image2)
Updating Controller Firmware

Warning! Do not attempt this procedure without first contacting MCE Technical Support. Failure to do so can result in catastrophic failure of the iBox.

Firmware Update allows you to install updated iControl operating software. It is likely that two firmware program files will be updated. They are:

- Bootrom.mce, the iControl boot up program.
- vxworks.mce, the iControl IMP computer program.

To update iControl firmware:

1. Copy the new **Bootrom.mce** (Bootrom folder) and **vxworks.mce** (IMP folder) files to the desktop of the computer being used to perform the firmware update.
2. Use iView to connect to the iBox on which the firmware is being updated.
3. If you want to save the configuration settings for later re-loading, select **Save** from the File > Configuration File menu. In the **Save Configuration File** dialog, type a name in the **File name:** box and click **Save**. Please refer to “Saving Parameters to a Configuration File” on page 8-20.
4. Select **Firmware Update** from the **File** menu.
5. Click **Yes** in the dialog “This action will automatically deactivate all screens. Proceed?”

To proceed, you must do the following:

1. Acquire write privilege - select Acquire from the Write privilege menu. Confirm by pressing iBox softkey #1.
2. Place the iBox INSPECTION switch in the INSPTH position.
3. Place the iBox CONTROLLER STOP switch in the STOP position.
4. Place the iBox WRITE ENABLE switch in the ON position.
6. Follow instructions 1 through 4 in the Firmware Update dialog and then click **Continue**. The Firmware Update dialog will change to:

![Firmware Update Dialog](image)

**WARNING: DO NOT RESTART THE CONTROLLER WHILE THE UPDATE IS IN PROGRESS OTHERWISE THE CONTROLLER WILL BE IN AN UNUSABLE STATE**

7. Update the Bootrom first. Double click the (...) in the **Bootrom row**.

8. Use the **Open** dialog to navigate to the computer’s Desktop and double click the **Bootrom.mce** file. The bootrom file will load and the version will be indicated in the **Upgrade version** column.

9. Click **Start upgrade**. The upgrade progress will be indicated in the text window. When the upgrade is completed you will be instructed to close iView and press the iBox **Computer Reset** button.

**Note:** If an *FrmFtp Login* dialog appears asking for a User and Password, click **OK**. The user name and password are not used for this operation at this time.

10. Use iView to connect to the iBox when it finishes the re-boot.

11. Repeat steps 4, 5 and 6.

12. Click the check box to “**Delete the paramf and constf files on the controller after IMP upgrade**”

13. Double click the (...) in the **Imp row**.
14. Use the Open dialog to navigate to the computer’s Desktop and double click the vxworks.mce file. The IMP application file will load and the version will be indicated in the Upgrade version column.

15. Click Start upgrade. The upgrade progress will be indicated in the text window. When the upgrade is completed you will be instructed to close iView and press the iBox Computer Reset button.

16. Use iView to connect to the iBox when it finishes the re-boot.

17. Select About iView from the Help menu and verify the version numbers for the IMP Application and IMP Bootrom.

18. If you want to restore the original parameter settings which were saved in step #3, first acquire write privilege and then select Load from the File > Configuration file menu. Please refer to “Loading Parameters from a Configuration File” on page 8-22.

19. Select and Open or double click the desired file from the Open Configuration File dialog.

20. Select All screens or the Selected screens for which you wish to restore the original parameter settings, and click OK.

**Upgrade Options**

When upgrading firmware from a pre-December 2005 release to a later release, in the event that the Upgrade Wizard fails to properly load the parameters file, iView may not be able to connect to the upgraded controller. The Upgrade Options Dialog (File > Upgrade Options) can be used to enable iView to connect to the controller or iCue and complete the upgrade.
Bootrom Recovery via OBD

In rare instances the iBox may refuse to bootup, usually after updating or backdating firmware. This utility on the OBD, may allow the iBox to be recovered. It is available on bootrom version 4.0.2 or greater. These options are meant for expert users or tech support only.

Begin by pressing and holding the ENTER button on the iBox. Momentarily press the COMPUTER RESET button.

Continue holding in the ENTER button until the Boot Menu is displayed.

Change IP Address - Use this option to change the IP address of the LAN Network port before bootup (see Default Boot Params). This is helpful if the boot parameters have been corrupted or the IP is not correct and you need to FTP into the iBox.

With the Boot Menu displayed, press soft switch #1: Use the left/right arrow keys to select the digit and the up/down arrows to make the correction. Press Enter to save the changed IP address.

Default Boot Params - This option allows the computer to reset all parameters to standard settings. With the Boot Menu displayed, press soft switch #2:

The Parameters Defaulted message is displayed to indicate that the parameters have been defaulted. Press Enter to return to the Boot Menu.

Warning: You will need to check the IP addresses and MAC addresses to make sure they match the job site.

Also, all of the configuration parameters will be set to their default values. If you have a saved configuration file you can load it once the iBox has booted.

Start FTP Server - available on iView 3.5.0 and above. With the Boot Menu displayed, press soft switch #3.

This option starts an FTP server on the iBox to allow access to the Flash and BBRAM file system. This is useful if the vxworks.mce image is corrupted or missing. Using the FTP Viewer in iView, the vxworks file can be replaced, the paramf file can be deleted, etc. Instructions for using the FTP File Viewer are in the April 2010 Release or later iControl User Guide.

Boot - This option causes the boot process to continue. Press soft switch #4.
About this Section
This section contains detailed information about:

- Selecting Controller view:
- Controller View Windows and tabs: A complete list of iView windows and tabs, and information about the parameters on each.

Selecting Controller View
iView is used to view and adjust the Controller and System parameters. iView is divided into two main sections:

- Controller View - used to view and adjust the controller parameters, e.g., Brake, Drive, Pattern, Car Operation, etc. When iView first connects to an iController, the Controller view is displayed.
- System View - used to view and adjust the System parameters, e.g., Dispatching, Parking, Emergency Power, Security, etc. When iView is connected to a central dispatcher (iCentral), the Controller and System buttons are missing and System view is always displayed. Please refer to “Selecting System View” on page 10-1.

To select Controller view, click the Controller view button at the top of the iView screen.
Controller View Windows and Tabs

The parameters displayed in the Controller view are related to the operation and control of the connected car. Table 9.1 lists the locations where the parameters and settings are explained. If you are viewing this as a PDF file, click the page number link to jump to the description of the parameters on that tab.

Table 9.1 Controller View Windows and Tabs

<table>
<thead>
<tr>
<th>Windows</th>
<th>Tabs</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Operational Status</td>
<td></td>
</tr>
<tr>
<td>Configuration</td>
<td>Advanced &gt; Custom Outputs</td>
<td>page 9-142</td>
</tr>
<tr>
<td></td>
<td>Advanced &gt; User Events</td>
<td>page 9-141</td>
</tr>
<tr>
<td></td>
<td>Brake</td>
<td>page 9-25</td>
</tr>
<tr>
<td></td>
<td>Car Call Enable</td>
<td>page 9-29</td>
</tr>
<tr>
<td></td>
<td>Car Operation</td>
<td>page 9-30</td>
</tr>
<tr>
<td></td>
<td>Drive</td>
<td>page 9-89</td>
</tr>
<tr>
<td></td>
<td>Floor Heights</td>
<td>page 9-96</td>
</tr>
<tr>
<td></td>
<td>General</td>
<td>page 9-97</td>
</tr>
<tr>
<td></td>
<td>I/O Boards</td>
<td>page 9-102</td>
</tr>
<tr>
<td></td>
<td>iBox Configuration</td>
<td>page 9-128</td>
</tr>
<tr>
<td></td>
<td>Load Weigher</td>
<td>page 9-129</td>
</tr>
<tr>
<td></td>
<td>Pattern</td>
<td>page 9-131</td>
</tr>
<tr>
<td></td>
<td>Terminal Switches</td>
<td>page 9-137</td>
</tr>
<tr>
<td></td>
<td>Timer Tables</td>
<td>page 9-138</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>Car Statistics</td>
<td>page 9-11</td>
</tr>
<tr>
<td></td>
<td>Data Trap</td>
<td>page 9-12</td>
</tr>
<tr>
<td></td>
<td>Diagnostic Flags</td>
<td>page 9-12</td>
</tr>
<tr>
<td></td>
<td>Diagnostic Outputs</td>
<td>page 9-14</td>
</tr>
<tr>
<td></td>
<td>Event Log</td>
<td>page 9-15</td>
</tr>
<tr>
<td></td>
<td>Fault Bypass</td>
<td>page 9-18</td>
</tr>
<tr>
<td></td>
<td>Terminal Switches</td>
<td>page 9-20</td>
</tr>
<tr>
<td></td>
<td>Virtual Oscilloscope</td>
<td>page 9-22</td>
</tr>
<tr>
<td>Setup</td>
<td>Brake</td>
<td>page 9-143</td>
</tr>
<tr>
<td></td>
<td>Counterweight</td>
<td>page 9-143</td>
</tr>
<tr>
<td></td>
<td>Drive</td>
<td>page 9-145</td>
</tr>
<tr>
<td></td>
<td>Floor Heights</td>
<td>page 9-146</td>
</tr>
<tr>
<td></td>
<td>Load Weigher</td>
<td>page 9-150</td>
</tr>
<tr>
<td></td>
<td>Safety</td>
<td>page 9-151</td>
</tr>
<tr>
<td></td>
<td>Terminal Switches</td>
<td>page 9-155</td>
</tr>
<tr>
<td>Hoistway</td>
<td></td>
<td>page 9-4</td>
</tr>
<tr>
<td></td>
<td>Safety Tests</td>
<td>page 9-156</td>
</tr>
<tr>
<td>Layouts</td>
<td>Configuration</td>
<td>page 9-157</td>
</tr>
<tr>
<td></td>
<td>Diagnostics</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Brake</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Drive</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Floor Heights</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Load Weigher</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Motor Field</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Terminal Switches</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Custom</td>
<td></td>
</tr>
</tbody>
</table>
iView Button Bar

Table 9.2 lists the locations where the functions of the buttons are explained.

Table 9.2 Buttons and Dialogs

<table>
<thead>
<tr>
<th>Buttons / Dialogs</th>
<th>Description</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Connection</td>
<td>Displays the Open dialog</td>
<td>page 8-11</td>
</tr>
<tr>
<td>Open Configuration File</td>
<td>Displays the Open Configuration File dialog</td>
<td>page 8-22</td>
</tr>
<tr>
<td>Save Configuration File</td>
<td>Displays the Save Configuration File dialog</td>
<td>page 8-20</td>
</tr>
<tr>
<td>Call Registration</td>
<td>Place car calls and hall calls</td>
<td>page 9-158</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refreshes the parameters being displayed</td>
<td></td>
</tr>
<tr>
<td>Firmware Update</td>
<td>Update the iBox imbedded firmware</td>
<td>page 8-41</td>
</tr>
<tr>
<td>Controller</td>
<td>Causes the Controller view to be displayed</td>
<td>page 9-1</td>
</tr>
<tr>
<td>System</td>
<td>Causes the System view to be displayed</td>
<td>page 10-1</td>
</tr>
</tbody>
</table>

iView Status Bar

The status bar at the bottom of the iView screen provides the following information:

**Connection Status**

Connected arrows, shown above, indicate that iView is communicating with the controller. Broken arrows indicate that the connection has been broken.

**Write Privilege Status/Time Remaining**

An unlocked lock, shown above, indicates that this connection does not have write privilege. A locked lock indicates that write privilege has been granted, and the time remaining before timeout is displayed.

**Controller Type**

Indicates the type of controller to which iView is connected. For a description of each type see “An Overview of System Options” on page 10-4 The controller types include:

- Simplex - a single car that is not part of a group.
- Local - a car that is part of a group.
- Local (Swing) - a local car that can swing away (detach from the group).
- Swing - a local car that is currently detached from the group and is acting like a simplex.
- Local (Alternate Dispatcher) - a local car that can assume dispatching responsibilities.
- Local / Dispatcher - a local car that is also currently the dispatcher. iCue dispatching software is running on the local car’s iBox.
- iCentral - a central dispatcher with iCue dispatching software running on a dedicated PC or embedded micro controller.
Hoistway window

The Hoistway pane shows the following:

- Position of the car in the hoistway
- Real time position of the doors
- Floor labels
- Registered calls assigned to this car
- Floor heights (distance from lowest landing)
- Load in car - % of full load: Yellow = Empty load, Light Green = Light load, Light Red = Heavy load, Red = Overload
- Mode of operation
- Direction of travel
- Destination floor
- Car speed

The diagram illustrates the layout of the display with labels for each section, indicating the various pieces of information that are displayed.
Mode of Operation

The top line of the Hoistway pane shows the current car operation mode:

- **Attendant Service:** The car is operating in Attendant service mode. Usually initiated by a key-operated switch inside the car to allow the elevator to be operated by an in-car Attendant. While on Attendant service, hall and car call buttons remain active. The elevator will respond to car calls that have been enabled via different settings as specified by the car call eligibility and card reader options. During Attendant service, the Attendant inside the car controls direction of travel using the Attendant service Up and Down switches. The Attendant can also bypass hall calls using the Attendant service Non-Stop switch. Door operation is typically automatic open with constant pressure on the door close button required to close the doors. However, user settings are available to modify door operation if desired. The parameters and descriptions are the same as for the Independent Service > Front / Rear tabs. Please refer to “Car Operation - Independent Service Tab” on page 9-61.

- **Capture:** The car has been placed in Capture mode using the Capture switch on the iBox or by activating the Capture Input. When placed in Capture mode the car is taken “out” of public service. It will not respond to hall call demand or parking instructions. It will continue to service car call demand so that current passengers are not inconvenienced. The intent is to allow the car to service current passengers and then remain empty at the last serviced floor so that it may be captured for test, adjustment, or other non-passenger use.

- **Car Panel Inspection:** The car has been placed on Inspection mode using the car operating panel switch. Use the car panel inspection switches to move the car.

- **Cartop Inspection:** The car has been placed on Inspection mode using the cartop switch. Use the cartop inspection switches to move the car.

- **CFSS Mode 1 (2) at Floor:** Commandeer for Special Services - The car has recalled to the CFSS floor and is waiting for a person to commandeer it according to the settings selected on the Configuration > Car Operation > CFSS > Mode 1 (2) tab. Please refer to “Car Operation - CFSS Tab” on page 9-75.

- **CFSS Mode 1 (2) In-car:** Commandeer for Special Services - The in-car switch has been activated (or the car is at the recall floor if no switch). Car behavior is determined by the In-car settings on the Configuration > Car Operation > CFSS > Mode 1 (2) tab. Please refer to “Car Operation - CFSS Tab” on page 9-75.

- **CFSS Mode 1 (2) Recall:** Commandeer for Special Services - A CFSS call has been initiated via a hall switch. Any other hall calls will be un-assigned from the car. Any existing car calls will be disposed of according to the Recall settings selected on the Configuration > Car Operation > CFSS > Mode 1 (2) tab and the car will then recall to the floor at which the CFSS call was latched. Please refer to “Car Operation - CFSS Tab” on page 9-75.

- **Construction Car Panel Inspection:** Construction mode is enabled (Configuration > Safety tab), and the car operation panel inspection switch has been activated. However, while in Construction mode, the car panel inspection switches are ignored. The car can only be operated via the machine room or cartop inspection switches while in Construction mode.

- **Construction Cartop Inspection:** Construction mode is enabled (Configuration > Safety tab), allowing the car to be run on Inspection with a bare minimum of field wiring installed, and the cartop Inspection switch has been activated. Use the cartop Up, Down and Safe switches to move the car. Place the car on machine room or cartop inspection and operate the car with the appropriate switches.
• Construction Hoistway Access Inspection: Construction mode is enabled (Configuration > Safety tab), and the hall mounted Access switch has been activated. However, while in Construction mode, the hoistway access inspection switches are ignored. The car can only be operated via the machine room or cartop inspection switches while in Construction mode. Place the car on machine room or cartop inspection and operate the car with the appropriate switches.

• Construction Inspection: Construction mode is enabled (Configuration > Safety tab), allowing the car to be run on Inspection with a bare minimum of field wiring installed, and the car is therefore operating on Inspection operation. The car can be moved using either the cartop or machine room inspection operation switches.

• Construction Machine Room Inspection: Construction mode is enabled (Configuration > Safety tab), allowing the car to be run on Inspection with a bare minimum of field wiring installed, and the iBox INSPECTION switch has been placed in the INSP position. Use the iBox Up, Down and Enable switches to move the car.

• EMS In-car (Switch 1 / 2): Emergency Medical Service - The EMS in-car switch has been activated. The car remains on EMS operation until it is returned to the recall floor and the in-car switch is deactivated.

• EMS Recall (Switch 1 / 2): Emergency Medical Service has been activated via a hall switch (1 or 2). Car behavior, including the designated recall floor, are determined by the General settings on the Configuration > Car Operation > EMS > Switch 1 (2) tab. Please refer to “Car Operation - EMS Tab” on page 9-68.

• Fire Service In-car: In-car Firefighter’s Service has been activated via the in-car fire service key-switch. Car and door behavior is determined by the fire code settings on the Configuration > Car Operation > Fire service > Fire code > In-car tab. Please refer to “Fire Code - In-Car - General Tab” on page 9-54.

• Fire Service Recall Alternate: Fire Recall Operation (Phase I), to the alternate fire recall floor has been initiated. Generally this is initiated by the activation of a smoke detector at the main fire recall floor. The car proceeds to the alternate fire recall floor designated on the Configuration > Car Operation > Fire service tab. Car and door behavior is determined by the fire code settings on the Configuration > Car Operation > Fire service > Fire code > Recall tab. Please refer to “Fire Code - Recall - General Tab” on page 9-49.

• Fire Service Recall Main: Fire Recall Operation (Phase I), at the main fire recall floor, has been initiated. Generally this is initiated by the activation of a smoke detector on a floor other than the main fire recall floor. Can also be initiated by the activation of the fire recall switch input. The car proceeds to the main fire recall floor designated on the Configuration > Car Operation > Fire service tab. Car and door behavior is determined by the fire code settings on the Configuration > Car Operation > Fire service > Fire code > Recall tab. Please refer to “Fire Code - Recall - General Tab” on page 9-49.

• Hoistway Access: The car has been placed on Hoistway Access Inspection mode using one of the hall panel mounted switches. The car can be positioned to allow access to the cartop or bottom.
Controller View Windows and Tabs

- Independent Service: Independent service is usually initiated by a key-operated switch inside the car to allow the elevator to be operated by an in-car Attendant. While on Independent service, hall call buttons and lamps for the elevator are disabled. The elevator will respond only to car calls that have been enabled via different settings as specified by the car call eligibility and card reader options. Door operation is typically automatic open with constant pressure on the door close button required to close the doors. However, user settings are available to modify door operation if desired. Please refer to “Car Operation - Independent Service Tab” on page 9-61.

- Inspection: One of the inspection modes (in-car, machine room or cartop) is active and the car is operating in Inspection mode. The Inspection profile parameters are used.

- Machine Room Inspection: The car has been placed on Machine Room Inspection mode using the iBox Inspection switch. (All other Inspection modes must be inactive before Machine Room Inspection may be enabled.)

- Passenger: The car is operating in normal passenger mode, responding to dispatching and parking instructions and to hall and car call demands. Car and door operation are determined by settings on the Configuration > Car Operation > Passenger tab. Please refer to “Car Operation - Passenger Tab” on page 9-39.

- Sabbath Operation: The elevator is operating in Sabbath mode initiated by a software command, switched input or timer. Sabbath mode allows the elevator to operate, serving the building without requiring buttons to be pressed for hall calls or car calls. Car behavior is determined by parameters located on the Configuration > Car Operation > Sabbath operation tab. Please refer to “Car Operation - Sabbath Tab” on page 9-83.

- Shuttle service: The elevator is operating in Shuttle service mode initiated by a key-switch/input, software command or timer. This option allows the car to be used to provide express service for a subset of the building’s floors. Car behavior is determined by parameters located on the Configuration > Car Operation > Shuttle service tab. Please refer to “Car Operation - Shuttle Service” on page 9-86.

- Test: Indicates that the iBox Test switch is in the Test position and the elevator is in Test mode, generally used to adjust or test the elevator. The elevator operates the same as in normal passenger mode except that the doors are disabled and no hall calls are registered.
The Operational Status tab is displayed, along with the Hoistway pane, when iView first connects to an iController.

### Speed
- **Commanded**: The speed commanded by the control system
- **Actual**: The actual car speed determined by the landing system encoder.
- **Motor**: Speed determined by the motor encoder/tachometer.

### Processor health
- **Safety A**: Indicates that Safety processor A is ok.
- **Safety B**: Indicates that Safety processor B is ok.
- **Cartop**: Indicates that the Cartop processor is ok.

### In-service
- **Safety OK**: Indicates that the safety string is made up.
- **System communication**: Indicates that system communication is ok.
- **In group**: Indicates that the car is operating under group dispatcher control.

### Time Remaining for
- **Learn switch**: Time remaining until the Learn switch timer elapses. Reset the timer by toggling the iBox LEARN switch OFF and then back to ON.
- **Safety bypass**: Time remaining until the Safety bypass timer elapses. Reset the timer by removing and then reinstalling the jumper (SB to 3 on the iBox).
- **Fault Bypass**: Time remaining until the Fault bypass timer elapses. Reset the timer by toggling the iBox FAULT/FUNCTION BYPASS switch to OFF and then back to ON.
Motion
- **Cmd direction (Commanded direction):** Indicates the car’s commanded direction of travel.
- **Actual direction:** Indicates the car’s actual direction of travel.
- **Category:** (Note: Insp = Inspection mode, all others = Automatic (Passenger) mode.)
  - AutoHalt: An emergency stop has been initiated.
  - AutoIdle: Waiting for a request to move to a different floor or relevel at current floor.
  - AutoWait: Waiting for the actual speed to indicate that the car has stopped moving.
  - InspHalt: An emergency stop has been initiated.
  - InspIdle: Waiting for a request to move.
  - InspMove: Received permission to move and movement initiated.
  - InspStart: Received a request to move and determined it is safe to do so.
  - InspStop: A normal stop has been initiated.
  - InspWait: Waiting for the actual speed to indicate that the car has stopped moving.
  - LevMove: Received permission to relevel and movement initiated.
  - LevStart: Received a request to relevel and determined it is safe to do so.
  - LevStop: While releveling, a normal stop has been initiated.
  - RunMove: Received permission to move and movement initiated.
  - Run Slow: Slowdown has been initiated.
  - RunStart: Received a request to move and determined it is safe to do so.
  - RunStop: A normal stop has been initiated.

Position
- **Logical:** The idealized position of the car. Indicates where the car would stop if so commanded, taking into account current speed and deceleration rate.
- **Actual:** The true position of the car reported by the position encoder.
- **Cartop:** Raw position from cartop, no offset included.

Machine
- **Mode:**
  - Brake Contact Enable: The contactor for the brake subsystem has been energized. Voltage is available at the input of the brake subsystem.
  - Brake Electric Enable: The brake subsystem has been enabled. Along with an energized brake contactor, the brake subsystem is able to produce brake output voltage.
  - Drive Electric Enable: The drive subsystem has been enabled. Along with an energized motor contactor, the drive system is able to produce output voltage (armature voltage).
  - Motor Contact Enabled: The contactor for the drive subsystem has been energized. Voltage is available at the input of the drive subsystem.
  - Run: The system has received permission to energize the motor and has done so.
  - Start: The system has received a request to energize the motor and determined that it is safe to do so.
  - Stop: The system has begun the process to de-energize the motor.
- **Arm voltage (Armature voltage):** Voltage applied to the armature.
- **Arm current (Armature current):** Armature current expressed as a function of voltage.
• Field voltage: Actual voltage applied to the motor field. (DC only)
• Field current: Value proportional to the current flowing through the motor field (DC only).
• Brake voltage: Actual voltage applied to the brake.
• Brake current: A value proportional to the actual current flowing through the brake.

**Door lock**
- Front and Rear: Indicates when the front and rear door locks are made up.

**Leveling sensor**
- Up leveling marker (Front and Rear): Indicates when front and rear Up leveling markers sensors are On.
- Door zone (Front and Rear): Indicates when front and rear door zone sensors are On.
- Down leveling marker (Front and Rear): Indicates when front and rear down leveling marker sensors are On.

**Pattern**
- Profile:
  - Alternate 1
  - Alternate 2
  - Correction
- Phase: (see graphic below)
  - Idle
  - Begin Accel
  - Acceleration
  - End Accel
  - High Speed
  - Emergency Power
  - Earthquake
  - Emergency slowdown
  - Inspection
  - Standard

**Faults**
- All active fault messages are displayed in the Faults list box. A complete listing of fault messages is provided in Section 6. Please refer to “iControl Messages” on page 6-13.

**Car status**
- All active car status messages are displayed in the Car status list box. A complete listing of status messages is provided in Section 6. Please refer to “iControl Messages” on page 6-13.
Diagnostics Tabs

Diagnostics tabs can be displayed one at a time by selecting each one from the Controller > Diagnostics menu or they can all be displayed by selecting Diagnostics from the Controller > Layouts menu.

Four other diagnostic screens, Call Generator, Data Trap, Diagnostic Outputs and Virtual Oscilloscope, are displayed each in their own window. This allows them to be used simultaneously with other windows.

Diagnostics - Car Statistics Tab

The Controller > Diagnostics > Car Statistics tab displays statistical data collected by the controller. The counters can be cleared using the Clear Statistics button.

The statistical data includes:

- Odometer: Distance the car has traveled in miles.
- Power-up cycles: Number of times the controller has been powered up.
- Motion cycles: Sum of inspection runs, automatic runs and automatic relevels.
- Front door cycles: Number of times the front doors have cycled.
- Rear door cycles: Number of times the rear doors have cycled.
- Floor: Number of runs in which elevator movement originated and terminated at a floor.
- Inspection runs: Number of runs on inspection operation.
- Automatic runs: Number of runs on automatic operation.
- Automatic relevels: Number of times the car automatically releveled.
- Floor Time: On the last floor to floor run, time from start to end of elevator movement.
Diagnostics - Data Trap

The data trap diagnostic tool allows you to record and analyze controller data including input and output states, internal flags and parameter values. When the trap is ON (Running), the controller samples data at specified intervals (Data sample time). The most recent 500 samples are retained in a buffer. The user selects a specific event to “trigger” the data trap. When the selected event occurs, sampling stops and the data in the buffer can be saved to disk and then viewed. The data leading up to the event can be examined to help diagnose controller problems.

- **ON/OFF buttons**: Click the ON button to turn the data trap ON. The Data trap status changes to Running. Click the OFF button to turn the data trap OFF. The Data trap status changes to Disabled.
- **Data trap status**: Indicates the status of the data trap, Disabled or Running.
- **Data sample time**: Sets the duration of the data sample.
- **Select Data Trap Triggering Event**: Select from the list of signals and events and then Send to the controller.
- **Save button**: Once the data trap has been triggered, the Data trap status changes to Disabled (OFF) and no further samples are taken. Click the Save icon to display the Save dialog box. Choose a name and a location for the file and click Save. The saved files (.csv) can be viewed using a spreadsheet program such as Microsoft Excel.

Diagnostics - Diagnostic Flags

During an elevator run, a number of “events” occur in a particular sequence. Examining this sequence is useful in determining the status of the elevator. The Diagnostics flags provide a near
real-time, graphical display of system diagnostic flags. LEDs indicating currently active flags are lighted.

The tree in the left pane allows you to view the status of input and output flags arranged into four groups:

- Car Operation: Active car and hall calls, direction of travel, recall status, parking status flags, OK to start status, etc.
- Motion: Operational flags that determine whether or not the elevator is “allowed” to move.
- Drive: Run state flags for drive and motor.
- Safety: Safety flags.
Diagnostics - Diagnostic Outputs

The Diagnostic Outputs pane allows you to select from hundreds of system outputs and display those outputs (up to sixteen at a time) on the screen for easy monitoring.

To select outputs to monitor:

- Click an output in the table on the left and drag it into the title bar of one of the sixteen output monitors. The value of that output will appear in the window below the title bar.

To remove an output being monitored:

- Click the “X” next to the output’s name in the title bar of the monitor.
Diagnostics - Event Log

The Event Log (Controller > Diagnostics > Event Log) provides a way to view controller events logged by iControl. This is an invaluable troubleshooting tool. A complete listing of iControl messages, a description and trouble shooting tips can be found in Section 6 and in the iView online help. Please refer to “iControl Messages” on page 6-13.

The Controller Event Log lists the following for the events recorded:

- Type of event
- Time
- Date
- Event

Events may be sorted by any of the above by clicking the column heading.

Save event log / Open event log

The Event Log can be saved to a file for future reference. To save a Controller Event Log to a file:

- Click the Save button on the Controller > Diagnostics > Event Log tab.
- Navigate to the folder you want to save the file in.
- Name the file and click Save.

The Event Log file can be viewed using iView. To view a previously saved Event Log file:

- Click the Open file button on the Controller > Diagnostics > Event Log tab.
- Navigate to the file you want to view and double-click it.

Print / Print Preview

To print the event log or to view a print preview and/or print the event log from the print preview dialog:

- Click the Print button, choose a printer from the Print dialog and click Print.

- Click the Print Preview button and use the controls to display and/or print the desired pages.

Clear All

Click the Clear All button to delete all of the events in the Event Log.
Event Properties

To view greater detail about an event:

- Double-click the event in the Event Log. The Event Properties dialog is displayed.
- Click Help in the Event Properties dialog. The Troubleshooting Tips dialog is displayed.
**Event Filter**  
The Event Filter controls which events will be displayed in iView.

- Click the button on the Event Log tab. The check events will be displayed.
- Click to remove the check mark from events that you don’t want displayed.
- Click again to add a check mark to events that you want to be displayed.

**Events Received**  
Shown at the bottom of the Event Log window, this indicates the number of events that have been received from the controller.

**Events Displaying**  
This indicates the number of events that are being displayed. By comparing the Events Received versus the Events Displaying, you can determine how many events are being filtered out by the Event Filter.
Diagnostics - Fault Bypass

The Fault Bypasses allow you to temporarily bypass the normal system reaction to certain faults. This can be helpful when diagnosing system problems or operating the elevator under abnormal conditions. Bypasses can only be activated when not on normal (passenger) operation.

To bypass faults:

1. In iView, display the Diagnostics > Fault Bypass tab. The message window provides instructions.
2. Set the iBox INSPECTION switch to the INSP position (or set the TEST switch to ON).
3. Set the iBox FAULT/ FUNCTION BYPASS switch to ON. (see “Time remaining” below)
4. When the message window indicates “ABLE TO BYPASS FAULTS” click the button(s) for the fault(s) you wish to bypass. The LEDs on the buttons turn on when the bypass is active, off when a bypass is inactive and the buttons are grayed out when a bypass is unavailable.
Diagnostics Tabs

System status

- Inspection - lights when the iBox INSPECTION switch is in the INSP position.
- Test - lights when the iBox TEST switch is ON.
- Fault bypass - lights when the iBox FAULT/FUNCTION BYPASS switch is ON.
- Bypass active - lights when any fault bypass is active.

Bypass status

- Active bypasses - indicates the number of active bypasses.
- Time remaining - the bypass remains active for fifteen minutes from the time the iBox Fault/Function Bypass switch is turned ON. This display indicates the remaining time. When the time elapses, the message window indicates “FAULT BYPASS SWITCH TIMED OUT”. If you need additional time, turning the Fault/Function Bypass switch to OFF and then back to ON within one second will reset the selected bypasses.
- Message window - shows instructional information.

Fault Bypasses

The following bypasses are provided. When enabled, the fault will be ignored and the system will not respond to the fault as programmed.

Table 9.3 Fault Bypasses

<table>
<thead>
<tr>
<th>Drive inspection overspeed</th>
<th>Tech error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive enable feedback</td>
<td>Brake voltage not on</td>
</tr>
<tr>
<td>Brake switch</td>
<td>Position reversed</td>
</tr>
<tr>
<td>Position quadrature</td>
<td>Quadrature speed threshold</td>
</tr>
<tr>
<td>Quadrature speed deviation</td>
<td>Motion start</td>
</tr>
<tr>
<td>Buffer test</td>
<td>Direction limit</td>
</tr>
<tr>
<td>Limit switch checksum</td>
<td>Outer level Correction</td>
</tr>
<tr>
<td>UNT1 through 5 Level 1 Overspeed</td>
<td>DNT1 through 5 Level 1 Overspeed</td>
</tr>
<tr>
<td>UNT1 through 5 Level 2 Overspeed</td>
<td>DNT1 through 5 Level 2 Overspeed</td>
</tr>
<tr>
<td>UETS Level 2 Overspeed</td>
<td>DE TS Level 2 Overspeed</td>
</tr>
<tr>
<td>UNT1 through UNT5 Position</td>
<td>DNT1 through DNT5 Position</td>
</tr>
<tr>
<td>UETS Position</td>
<td>DETS Position</td>
</tr>
<tr>
<td>Safety Contract Overspeed</td>
<td>Safety Inspection Overspeed</td>
</tr>
<tr>
<td>Safety Leveling Overspeed</td>
<td>Tach Failure</td>
</tr>
</tbody>
</table>
Diagnostics - Terminal Switches Status

The Terminal Switches Status shows information about the speed and position of the car when each Normal Terminal Switch (U/DNT1 - U/DNT5) and Emergency Terminal Switch (U/DETS) opened. The parameters are divided into the following groups:

- **Switch data**: U/DNT1 through U/DNT5: Speed and position parameters for Up and Down Normal Terminal Switches 1 through 5. Also, U/DETS: Speed and position for the Emergency Terminal Switches.
- **Position at speed transition points - Last run**: Car position at various speed transition points during the last run.
Switch Data

- **Position (ft.)**
  - Learned: Learned position of the car when this switch opened during the Learn operation.
  - Lower limit: Variance below the learned switch position required to generate an Up or Down Normal Terminal Switch (n) Position Fault or an Up or Down Emergency Terminal Switch Position Fault, causing the car to stop using the Emergency Slowdown Profile parameters.
  - Upper limit: Variance above the learned switch position required to generate an Up or Down Normal Terminal Switch (n) Position Fault, causing the car to stop using the Emergency Slowdown Profile parameters.
  - Last pass: Position of the car when this switch opened during the last run.

- **Speed (ft./min.)**
  - Learned: Learned speed of the car when this switch opened during the Learn operation.
  - Overspeed 1: Variance from the learned speed required to generate an Up or Down Normal Terminal Switch (n) Level 1 Speed Fault, causing the car to stop using the Emergency Slowdown Profile parameters.
  - Overspeed 2 (DNT or UNT switch): Variance from the learned speed required to generate an Up or Down Normal Terminal Switch (n) Level 2 Speed Fault, causing the car to perform an Emergency Stop by dropping the brake.
  - Overspeed 2 (DETS or UETS switch): Variance from the learned speed required to generate a Safety A UETS (or DETS) Level 2 Speed Fault, causing the car to perform an Emergency Stop by dropping the brake.
  - Last pass: Speed of the car when this switch opened during the last run.

**Note**

Emergency Terminal Overspeed is hard-coded at 95% of Contract Speed. Be certain that the car is traveling well below this speed when an Emergency Terminal switch is opened to avoid an emergency stop. In some instances, it may be necessary to re-position an Emergency Terminal switch to achieve this. Contact MCE Technical Support if needed.

**Position at speed transition points - Last run:**

- Position of the car in the hoistway at various speed transition points measured during the last run. These position values can be useful, especially if the last run was to a terminal landing.
Diagnostics - Virtual Oscilloscope

The Virtual Oscilloscope allows you to display and track two signals over time simultaneously. The selected signal values are shown on the Test point 1 and 2 displays and output on the STP 1 and STP 2 physical test points on the iBox.

- Acquire write privileges (select Acquire from the Write privilege menu).
- Using the drop down list, select the Test point 1 signal. This signal will be tracked in green on the oscilloscope, displayed numerically in the Test point 1 window and output to iBox test point STP1.
- Using the drop down list, select the Test point 2 signal. This signal will be tracked in blue on the oscilloscope, displayed numerically in the Test point 2 window and output to iBox test point STP2.
- You can freeze and reposition the display by clicking and dragging.

Note

Some signals are scaled, e.g. motor field and brake voltage are scaled by a factor of 100. Other signals are scaled based on parameter values, e.g. pattern High speed (contract speed).
Display Editing
The virtual oscilloscope display is editable. You may easily modify labels, displays, animation, and more to suit your immediate display needs. When a display is closed, then re-opened, it reverts to its default values. To edit a display:

- Right-click on the graph or on one of the scales to reveal a popup menu.
- Select Edit from the menu. An editor dialog is displayed. The editor dialog will be different depending on where you click in the oscilloscope display.
- Experiment with modifying the display to find the combinations that suit the signal types you are currently examining. The Edit menu is extensive:

![Plot Axis Editor](image)

**Tracking** Enable Tracking from the popup (right-click) menu to track a signal over time. Disable tracking if you want to drag the horizontal scale to look at a particular moment in time.

- Click on a scale, then press the keyboard <Home> to decrement the scale one full “screen.”
- Click on a scale, then press the keyboard <End> key to increment the scale one full screen.
- Click on a scale, then press the keyboard right or left arrow keys to increment or decrement by units.
- While tracking, clicking on any keyboard key will stop tracking.
Scale  One typical modification you might want to make is to the scale of a display. For example, if you wanted to change the scale of the Test point 2 vertical display (Y axis):

1. Right-click on the Test point 2 display scale and select edit.

   ![Plot Axis Editor](image)

2. Set the Minimum value for the scale (Min = zero in our example).
3. Set the Span, number of units to display (Span = one in our example).
4. Close the Plot Axis Editor dialog.

Zoom to Fit  Zoom to Fit is another very useful tool. If you are monitoring two signals, and they diverge so that both are not visible, use Zoom to Fit to instantly bring each back into view (vertical scale). Conversely, if two signals are very close together in the display, use Zoom to Fit to expand the display and see fine changes in the signal.

- Right-click on the scale display then select Zoom to Fit.

For the horizontal scale, Zoom to Fit resets the left margin to zero time and scales the display to include total elapsed time at that point. In other words, if you are tracking a signal over time, then want to see all its transitions since you began tracking, use Zoom to Fit on the (lower) horizontal scale.
The Controller Configuration tabs are used to view and enter (change) iController parameter values. The Configuration tabs are accessed from the Controller View menu (Controller > Configuration) or you can display all of the configuration tabs by selecting Configuration from the Controller > Layouts menu.

Configuration - Brake Tab

The Configuration > Brake tab is used to set the brake voltage and brake timer parameters. Also, on the Brake > Configuration tab, you can view the values determined by the brake setup procedure.
Brake - Control Tab - Voltage

The Brake Control tab allows you to set brake operating voltage outputs. Please refer to “Brake Parameter Adjustments” on page 4-19.

- Pick voltage: Enter the necessary brake Pick voltage (from the job prints) for the brake used on this job.
- Partial pick voltage: Applied only if a “While doors are closing with motor and partially picked brake” pre-start sequence is selected. Under this restricted condition, it is only applied if the motor and brake contactor are picked before the door locks make up. If partial pick voltage is applied, full pick voltage will be applied after the door locks make up and Speed pick delay 1 expires. Under this scenario, Speed pick delay 2 needs to expire after full pick voltage is applied before the elevator is allowed to move. When partial pick voltage is applied, the brake should still apply some pressure on the brake drum.
- Hold voltage: After the brake picks, the brake voltage will change from Pick voltage to Hold voltage. This is the brake “cooling” voltage. Set Hold voltage = Pick voltage, if not used.
- Relevel voltage: The desired brake releveling voltage. This voltage must be sufficient to reduce brake pressure so the car can relevel under the brake. On gearless machines it is important to partially reduce brake pressure, therefore, Relevel voltage should be less than Pick voltage, usually about 50%. Please refer to “Releveling Operation” on page 4-28.
- Weakening voltage: Used to smoothly pick the brake when there is rollback. Set Weakening voltage = Pick voltage, if not used.

Brake - Control Tab - Filter

The Brake > Control tab - Filter section allows you to adjust the filters associated with brake operation.

- Current low pass frequency: This parameter adjusts the amount of filtering (smoothing) that is applied to the analog brake current feedback. Generally the default value does not need to be modified. If a change is required, a reduction of the default value will most likely be needed.
- Voltage low pass frequency: This parameter adjusts the amount of filtering (smoothing) that is applied to the analog brake voltage feedback. Generally the default value does not need to be modified. If a change is required, a reduction of the default value will most likely be needed.

Brake - Control Tab - Switch

Brake monitoring via an independent contact is required by code only for disc brakes.

- Brake is picked when SP2D or Brake Switch terminal is high: Sets polarity of the brake contact input.
- Brake is picked when SP2D or Brake Switch terminal is low: Sets polarity of the brake contact input.
- Monitor for brake pick fault: Specifies brake pick fault monitoring via an independent contact. Please refer to the Brake Pick Fault message description(see page 6-16).
- Monitor for brake drop fault: Specifies brake drop switch fault monitoring. Please refer to the Brake Drop Fault message description(see page 6-15).
Brake - Control Tab - Timers

The Brake > Control tab - Timer section allows you to set the various delays associated with brake operation.

- **Pick delay**: The delay between when the drive is enabled for a run and when the brake voltage is set to Pick voltage. [Please refer to “Speed Pick Delay” on page 4-7. Please refer to “Empty Car Tests” on page 3-31.]
- **Hold delay**: Determines how long the brake voltage remains at Pick voltage before Hold voltage is applied. The timer starts after Repick time expires.
- **Weakening delay**: Determines how long the brake voltage remains at Pick voltage before Weakening voltage is applied. This timer starts after Pick delay expires. If there is no rollback, set Weakening delay = 0.00 sec.
- **Repick time**: Determines how long the brake voltage remains at Weakening voltage before Pick voltage is reapplied. This timer starts after Weakening delay expires. If there is no rollback, set Repick delay = 0.00. [Please refer to “Brake Parameter Adjustments” on page 4-19.]
- **Speed pick delay 1**: Determines the time between when the drive is enabled for a run and pattern application. Used to coordinate brake picking with the beginning of acceleration. Adjust this parameter for minimum rollback without moving through the brake. [Please refer to “Speed Pick Delay” on page 4-7]
- **Speed pick delay 2**: This delay is applied after the door locks are made up and Speed pick delay 1 expires. It has the potential of being applied only if a “While doors are closing with motor and partially picked brake” pre-start sequence is selected. Under this restricted condition, it would only be applied if the motor and brake contactor are picked before the door locks make up. If the door locks are made up or any other pre-start sequence is selected, only a Speed pick delay 1 would be applied.
- **Contactor drop delay**: Determines how long the motor and brake contactors remain picked after the Drive Enable signal is dropped.
- **Brake drop delay**: Used to allow the car to stop completely after a normal run before dropping the brake. The timer starts when the Direction signal is dropped (Stop Command). [Please refer to “Final Stop” on page 4-25.]
- **Voltage decay time**: Determines the amount of time over which the brake voltage will “decay” and gradually drop the brake. A longer Voltage Decay Time will lead to a more gradual brake drop. [Please refer to “Final Stop” on page 4-25.]

**Figure 9.1 Brake Timing**

![Brake Timing Diagram](image-url)
Danger
Warning! Possibility of losing control of the car at the end of the run if Drop Delay and Voltage Decay time exceed Contactor Drop Delay!

Brake - Configuration Tab

Caution
The parameters on this tab are set automatically during brake calibration. Do not modify these parameters unless advised to do so by an MCE representative.

- Voltage: The voltage output to the brake coil at various percentages of maximum voltage, measured during calibration (see Caution above).
- Output Timer: The amount of OFF time during each cycle (delay before turning on the brake output) required to output the appropriate voltage to the brake coil at various percentages of maximum voltage (see Caution above).
- Current Reference: The voltage feedback that represents the brake current at various percentages of maximum voltage, measured during calibration (see Caution above).

Table 9.4 Typical Configuration Values for 300V AC Brake Supply

<table>
<thead>
<tr>
<th>Percent of V max</th>
<th>Voltage VDC</th>
<th>Output Timer</th>
<th>Current Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>At 100%</td>
<td>249.639V</td>
<td>0.100ms</td>
<td>0.243V</td>
</tr>
<tr>
<td>At 90%</td>
<td>225.484V</td>
<td>2.084ms</td>
<td>0.214V</td>
</tr>
<tr>
<td>At 80%</td>
<td>200.253V</td>
<td>2.852ms</td>
<td>0.194V</td>
</tr>
<tr>
<td>At 70%</td>
<td>174.083V</td>
<td>3.492ms</td>
<td>0.171V</td>
</tr>
<tr>
<td>At 60%</td>
<td>149.155V</td>
<td>4.608ms</td>
<td>0.149V</td>
</tr>
<tr>
<td>At 50%</td>
<td>125.508V</td>
<td>4.580ms</td>
<td>0.128V</td>
</tr>
<tr>
<td>At 40%</td>
<td>100.000V</td>
<td>5.156ms</td>
<td>0.105V</td>
</tr>
<tr>
<td>At 30%</td>
<td>73.632V</td>
<td>5.735ms</td>
<td>0.082V</td>
</tr>
<tr>
<td>At 20%</td>
<td>49.092V</td>
<td>6.308ms</td>
<td>0.069V</td>
</tr>
<tr>
<td>At 10%</td>
<td>25.041V</td>
<td>7.012ms</td>
<td>0.040V</td>
</tr>
</tbody>
</table>
Configuration - Car Call Enable

Car Call Enable inputs are used with card reader or key switch security devices. The inputs are programmed using the Controller > Configuration > I/O Boards tab. When Elevator Security is on, the appropriate car call enable input must be activated in order for a call to be registered to the corresponding secured floor. This screen allows you to specify the polarity (active high or active low) of the Car call enable 1 and 2 inputs. Other parameters relating to these inputs are programmed using iCue.

<table>
<thead>
<tr>
<th>Operational Status</th>
<th>Car Call Enable</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Car call enable 1 inputs active high</td>
</tr>
<tr>
<td></td>
<td>Car call enable 2 inputs active high</td>
</tr>
</tbody>
</table>

Send


**Configuration - Car Operation**

The Configuration > Car Operation tab is used to view and adjust car door and device behavior under different operating modes. If you are viewing this as a PDF file, click the page number link to jump to the description of the parameters on that tab. The car operation sub-tabs include:

<table>
<thead>
<tr>
<th>Sub-tab</th>
<th>Description</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Doors</td>
<td>Door device bypass timers, door motor protection timers, and door closing delay parameters.</td>
<td>page 9-31</td>
</tr>
<tr>
<td>Devices</td>
<td>Arrival fixture, CE Electronics fixture and voice communicator parameters.</td>
<td>page 9-35</td>
</tr>
<tr>
<td>Passenger</td>
<td>Door opening and closing, photo eye, dwell timers, load weigher, car delayed timer, and call cancel parameters.</td>
<td>page 9-39</td>
</tr>
<tr>
<td>Fire Service</td>
<td>Applicable code Fire Service Recall and In-Car Firefighter's Service parameters.</td>
<td>page 9-46</td>
</tr>
<tr>
<td>Independent Service</td>
<td>Independent Service parameters.</td>
<td>page 9-61</td>
</tr>
<tr>
<td>Elevator Recall</td>
<td>Elevator recall switches configuration.</td>
<td>page 9-63</td>
</tr>
<tr>
<td>Earthquake</td>
<td>Applicable code and advanced EQ parameters. Counterweight device.</td>
<td>page 9-66</td>
</tr>
<tr>
<td>EMS</td>
<td>Emergency Medical Service operation parameters.</td>
<td>page 9-68</td>
</tr>
<tr>
<td>Emergency power</td>
<td>Emergency Power operating parameters.</td>
<td>page 9-72</td>
</tr>
<tr>
<td>CFSS</td>
<td>Commandeer for Special Service parameters.</td>
<td>page 9-75</td>
</tr>
<tr>
<td>Flood Operation</td>
<td>Determines car behavior during flood operation.</td>
<td>page 9-78</td>
</tr>
<tr>
<td>Attendant service</td>
<td>Attendant Service operation parameters.</td>
<td>page 9-80</td>
</tr>
<tr>
<td>Auto stop</td>
<td>Auto Stop operation parameters.</td>
<td>page 9-81</td>
</tr>
<tr>
<td>Sabbath operation</td>
<td>Sabbath operation parameters.</td>
<td>page 9-83</td>
</tr>
<tr>
<td>Shuttle Service</td>
<td>Shuttle service parameters.</td>
<td>page 9-86</td>
</tr>
<tr>
<td>Heat Detectors</td>
<td>Heat Detector operation parameters.</td>
<td>page 9-88</td>
</tr>
</tbody>
</table>
Car Operation - Doors tab

The Doors tab allows you to set bypass timers for elevator safe edge and photo eye devices, set door protection timers, enable simplex operation, latch open or close door power, and disable door contact monitoring.

General

- Non-interference timer: Determines the number of seconds a car with non-automatic door operation waits at a floor in response to a call before proceeding to answer other demands.
- Door Open delay timer to reverse closing doors: This timer is used to delay the door open command on closing doors.
- Door close delay timer: This timer is used to delay the door close command.
- Relevel door open inhibit timer: 0 (OFF) = disabled. When enabled, closed doors shall not be opened while the car is releveling, but must wait until releveling is complete or the timer elapses. However, this feature does not prevent preopening.

Door Device

- Mechanical Safe Edge: Check Front and/or Rear to indicate that the doors have a mechanical safe edge. If, after a period of time, an active safe edge input should be bypassed and the doors closed, enable bypass (check Bypass after timeout) and set the timer (Device timeout) to the desired time. This option works in conjunction with Nudging (see “Nudging” on page 9-39).
• Photo Eye: Check *Front* and/or *Rear* to indicate that the doors have a photo eye. If, after a period of time, an active photo eye input should be bypassed and the doors closed, enable bypass (check *Bypass after timeout*) and set the timer (*Device timeout*) to the desired time. This option works in conjunction with Nudging (see “Nudging” on page 9-39).

• Door Open Button: If, after a period of time, an active door open button input should be bypassed and the doors closed, enable bypass (check *Bypass after timeout*) and set the timer (*Device timeout*) to the desired time. This option works in conjunction with Nudging (see “Nudging” on page 9-39).

• Door Open Button At Security Floor:
  • Remains operative at a secured opening: When checked, the Door Open Button will remain operative for the side that has opened at a secured/locked floor (meaning that someone has access to that side via a car call or hall call). Otherwise the DOB will only be enabled as long as the doors are not fully closed.

**Door Motor Protection Timers**

• Opening:
  • Door open attempts: Determines the number of opening cycles the door should attempt before a door open fault is declared.
  • Opening timer: This setting determines the amount of time, in seconds, that the elevator car should continue to attempt to open its doors if the initial open attempt is not successful. When this timer expires, the doors will close fully. The subsequent action of the elevator depends upon the setting of *Multiple open attempts per stop*.
  • Multiple open attempts per stop: If enabled, the elevator will stay at the floor and the doors will attempt to reopen the number of times determined by the Door Open Attempts setting. After the selected number of open attempts has been reached, a door open fault will be declared. If the Door Open button is pressed and held, the doors will attempt to open without any close attempts between cycles. The fault is cleared when the doors successfully open.
    • If Multiple Open Attempts Per Stop has not been enabled, the elevator will proceed to answer the next call or demand (once the doors have fully closed), unless there are additional attempts to open the door (hall call, car call, or open button activation). In either case (whether it has left the floor or remained because of additional open attempts), a door open fault will be declared if the door fails to successfully open for the set number of consecutive times.

• Closing:
  • Door close attempts: Determines the number of closing cycles the door should attempt before a door close fault is declared.
  • Closing timer: This setting determines the amount of time, in seconds, that the elevator car should continue to attempt to close its doors. When this timer expires, the doors will reopen fully, stand open for a short time, and then initiate another close attempt. This cycle will repeat until the doors reach the closed position or a pre-determined number of closing attempts has been made (Door close attempts). When this occurs, a door close fault will be declared. If the Door Close button is pressed and held, the doors will attempt to close without any open attempts between cycles. The fault is cleared when the doors successfully close.
• Door Close Fault Recovery:
  • Fault recovery attempts: (see Fault recovery timer).
  • Fault recovery timer: Timer starts when a Door Close Fault is detected. When the timer expires, the Door Close Fault is cleared to allow the doors to again attempt to close. If the doors still do not successfully close, another Door Close Fault is declared and the Fault recovery timer runs again. When the number of recovery attempts reaches the value of the Fault recovery attempts parameter, a Fault Recovery Failure is declared and the message is displayed. The car is shut down until a mode change is detected or the doors are successfully closed via constant pressure on the Door Close Button.

• Retiring cam:
  • Enable: Enables the retiring cam feature and motor protection functions.
  • Door lock attempts: The number of attempts made to lock the doors with the retiring cam before declaring a Retiring Cam Door Lock fault and re-opening the doors.
  • Door lock protection timer: The amount of time to attempt to lock the doors with the retiring cam before declaring a Retiring Cam Door Lock fault and re-opening the doors.
  • Motor timer: The amount of time to energize the retiring cam motor in an attempt to lock the doors before declaring a Retiring Cam Protection fault and re-opening the doors.
Doors - Front / Rear

- Door Closing Delay: Determines under what conditions (No delay, Always delay, Delay only if closed with hall door close button, Sabbath delay, DBD special access delay) and how much door closing delay shall be applied. These parameters may be set independently for front and rear doors.

- Closing warning light timer: Upon door close intent, if the Door Closing Delay parameter calls for a delay, the Front (Rear) Closing Warning Light output is turned ON. This timer determines the amount of delay after the Front (Rear) Closing Warning Light output is turned ON before the Front (Rear) Closing Warning Buzzer output is turned ON.

- Closing warning buzzer timer: This timer determines the amount of delay after the Front (Rear) Closing Warning Buzzer output is turned ON before automatic closing of the front or rear doors begins.

- Door closing delay time: Total door closing delay is the sum of the closing warning light and buzzer timers.

- Door close button bypasses closing delay: If checked, pressing the door close button will bypass the door closing delay timer and clear all related warning signals.

- Door closing delay on passenger mode only: If checked, the door closing delay and related warning signals will only be enabled during Passenger mode.

- Door open power latch: If checked, the controller will sustain the door open command to the door operator, preventing the possibility of doors drifting closed when the command is dropped.

- Door close power latch: If checked, the controller will sustain the door close command to the door operator, preventing the possibility of doors drifting open when the command is dropped.

- Disable door contact monitoring: If checked, door contact monitoring is disabled.
Car Operation - Devices Tab

The Devices tab allows you to configure the car arrival “announcement” devices, emergency alarm monitoring and serial fixture parameters.

Arrival Fixtures

- Hall Mounted: Enable if hall-mounted arrival notification devices are used for this car.
- Double Strike on Down Direction: Sound hall-mounted arrival fixtures twice when announcing down direction. If the fixtures themselves support double-striking, this feature should not be enabled.
- Set the On Timer for the amount of time the gong output should be active. Set the Off Timer to establish the pause between first and second gongs.

Car Riding: Enable if car-riding arrival notification devices are used for this car.

- Double Strike on Down Direction: Sound car-riding arrival fixtures twice when announcing down direction arrival. If the fixtures themselves support double-striking, this feature should not be enabled.
- Set the On Timer for the amount of time the gong output should be active. Set the Off Timer to establish the pause between first and second gongs.

Passing Floor Gong: Set the On Timer for the amount of time the gong output should be active. Set the Off Timer to establish the minimum pause between gongs.
• Emergency Alarm Monitoring:
  • Enable: Enables emergency alarm monitoring.
    • Monitor alarm button input: By default, the alarm button alarm input is monitored with visible and audible indicators driven by the Alarm Light and Alarm Buzzer outputs.
    • Monitor in-car stop switch: By default, the in-car stop switch is monitored with visible and audible indicators driven by the Alarm Light and Alarm Buzzer outputs.
    • Monitor car delayed with doors closed: When enabled, if the car is delayed with doors closed an amount of time in excess of the Car delayed timer setting, the Alarm Light and Alarm Buzzer outputs will be activated.
    • Monitor safety circuit open: If enabled, any condition that causes a safety string switch, contact, or relay to open will activate the Alarm Light and Alarm Buzzer outputs.
  • Require acknowledgement: Requires that the emergency alarm be acknowledged in order to turn off the Alarm light and buzzer. Typically this is done via the Alarm Reset input.
    • Allow software acknowledgement: If enabled, emergency alarms may also be acknowledged via iMonitor.
• Binary PIs:
  • Zero based: Specifies that the binary outputs to the position indicators shall be zero based.
  • One based: Specifies that the binary outputs to the position indicators shall be one based.

**Note**

Alarm Light: Typically, the Alarm Light is placed where it will be visible to security personnel. The output remains latched until acknowledged by activation or the Alarm Reset input (typically a keyed switch).

**Note**

Alarm Buzzer: Typically, the Alarm Buzzer is placed where it will be audible to security personnel. The standard (in-car stop or alarm open) output is constant and causes a constant tone. The additional (delayed with doors closed or other open safety condition) output is pulsating and causes a pulsating tone. This output does not latch but remains active only so long as the monitored condition exists (switch, contact, or relay remains open).
If the installation uses CE Electronics serial fixtures, configure them on this tab.

### Serial Fixture Tab

- **Start Floor Arrival Announcement:** Select the time at which you want the voice arrival announcement to occur — As the car slows during approach, At the end of the run, or When the door is fully open.

- **Flash direction arrow while running:** Specifies that the direction arrow will flash while the car is running.

- **Serial Messages:** This control box allows you to configure announcements to be displayed or annunciated by the CE fixtures. Serial Messages are text or audible messages pre-programmed into the serial fixture (character display or “talking”) and triggered by the elevator controller. Configuring a message requires providing a number (matched to a fixture message number to display or announce the correct message), a node qualifier (determines which fixtures will display or annunciate the message), and if appropriate, three ASCII characters (letters A-Z, numbers 0-9: used by character displays to show an abbreviated message, e.g., FSA for Fire Service Alternate).

- **Up and Down Buttons:** Some fixtures display only one message at a time. If two or more messages are valid, the message highest on the list is displayed. To move a message up or down on the list, click the message to select it, click the up or down button to move the message, and click **Send** to send the change to the controller.
To configure a serial message description:

1. Double click a serial message description to open the message definition dialog.

![Message Definition Dialog]

2. Check the fixture manufacturers documentation to determine the message number to message correlation. Enter the number in the Number entry box.

3. If character displays (i.e., floor position indicators) should display the message condition abbreviation, enter the characters into the ASCII entry boxes from top to bottom as they should appear from left to right. For example, to display FSA, enter F in the ASCII III box, S in the ASCII II box, and A in the ASCII I box. Displays that display fewer than three characters will display the right most letters of the condition. (For FSA, a two character display would show “SA”; a one character display “A”.

4. Set the node qualifier. The node qualifier determines which fixtures will accept the message. Fixtures have switches that allow them to be designated 00, 01, 10, or 11 (two switches, on=1, off=0). Fixtures with a 00 address will display all messages. Refer to the following table to see which fixtures will display the node qualified messages.

Table 9.6 Serial Fixture Message Display or Annunciation

<table>
<thead>
<tr>
<th>Fixture Switch</th>
<th>Node Qualifier</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>00</td>
<td>Accept</td>
</tr>
<tr>
<td></td>
<td>01</td>
<td>Accept</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>Accept</td>
</tr>
<tr>
<td></td>
<td>11</td>
<td>Accept</td>
</tr>
<tr>
<td>01</td>
<td>00</td>
<td>Accept</td>
</tr>
<tr>
<td></td>
<td>01</td>
<td>Accept</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>Reject</td>
</tr>
<tr>
<td></td>
<td>11</td>
<td>Reject</td>
</tr>
<tr>
<td>10</td>
<td>00</td>
<td>Accept</td>
</tr>
<tr>
<td></td>
<td>01</td>
<td>Reject</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>Accept</td>
</tr>
<tr>
<td></td>
<td>11</td>
<td>Reject</td>
</tr>
<tr>
<td>11</td>
<td>00</td>
<td>Accept</td>
</tr>
<tr>
<td></td>
<td>01</td>
<td>Reject</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>Reject</td>
</tr>
<tr>
<td></td>
<td>11</td>
<td>Accept</td>
</tr>
</tbody>
</table>

5. Click OK to set the message.

6. Message priority determines which message will be displayed first if more than one message is active at a time. Messages higher in the table have higher priority. To change a message priority, highlight the message name, then use the arrow buttons to move it up or down in the table.
Car Operation - Passenger Tab

The Passenger tab is used to configure car and door behavior on Passenger (Norm) operation.

General

- Lobby floor: This setting determines which floor will use the lobby dwell timer. If the car is part of a group, the group dispatcher settings for primary and alternate lobby floors supersede this selection.
- Egress floor: The Egress Floor Gong output will activate for 500 ms when the car arrives at this floor in response to a car or hall call. This output is used to activate an audible indicator to alert the visually impaired that the car has arrived at the main egress floor.

Nudging

Nudging is intended to discourage passengers from holding the doors open for excessive lengths of time. These options work in conjunction with the Door Device settings (see “Door Device” on page 9-31). The nudging options are:

- None: Nudging is disabled.
- Buzzer only: When the reopening device bypass timer expires, only the buzzer will sound.
- Reduced speed and torque: An open door will attempt to close at reduced speed and torque if it is held open for an extended period of time. This time is determined by the reopening device bypass timer.
- Stop doors due to reopening device activated during nudging: If enabled, activation of a safe edge during nudging will stop the doors from closing. Otherwise they will fully reopen.

To see how the Nudge and Buzzer outputs and Door operation after device timeout are affected by the various nudging and door device settings, see Table 9.7 Nudging Operation Table.
• Allow hall call button to reverse doors on a departing car: *(Not implemented on this screen)* Please refer to the iCue > Group Configuration > Dispatching tab “Allow same floor hall calls to reverse doors on a departing car” parameter.

• Allow direction arrow to reverse with doors open: If the car is at a destination floor and the next demand is in the opposite direction of the last run, determines whether the direction arrow is allowed to reverse while the elevator doors are open. Enable if the direction arrow is allowed to reverse with the elevator doors open.

• Cancel calls at slow down: By default, when a answering a call, the call is canceled when the car reaches door zone. This option specifies that calls are to be canceled when the car begins slow down when approaching the floor.

• Car delayed timer (seconds) - If a car is delayed in satisfying a demand an amount of time in excess of this timer setting, it will be taken out of hall call service. All calls remain registered. Hall calls are reassigned if the car is in a group.

• Car out of service timer (minutes) - This timer starts once the Car delayed timer (above) expires. If the Car delayed condition persists for this amount of time, the car is taken out of service and all calls are cancelled.

• Car fan and light timer (minutes): Set the number of minutes the car fan and light should remain on when the car is parked before automatically shutting off. The fan and light will become active again when the car responds to a demand.

**Anti-Nuisance**  
Anti-nuisance functions help the controller recognize and avoid nuisance operation, for example, a passenger intentionally interfering with elevator operations by unnecessarily selecting multiple stops, etc.

• Photo eye: All remaining car calls are canceled if the photo eye has not been activated and the number of car call stops exceeds the “Allowed number of car call stops without photo eye activation” parameter.

• Light load: All car calls are canceled if the number of registered calls exceeds the “Number of car calls allowed” parameter and the car weight (percentage of full load), as measured by the load weigher, is less than the “Light Load Threshold” parameter.

• Cancel car calls behind car: If enabled, car calls entered in the opposite direction to current or upcoming direction of travel are not allowed.

• Cancel remaining car calls with direction reversal: If enabled, when the car reverses direction of travel, any remaining calls in the previous direction are cancelled. For example, an up travelling car has car calls registered below it. Those calls will be cancelled when the car switches direction to down.

---

Table 9.7  Nudging Operation Table

<table>
<thead>
<tr>
<th>Nudging Option</th>
<th>Bypass Option</th>
<th>Safe Edge Option</th>
<th>Nudge Output</th>
<th>Buzzer Output</th>
<th>Door Operation After Device Timeout</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>No</td>
<td>-</td>
<td>Off</td>
<td>Off</td>
<td>Remain open</td>
</tr>
<tr>
<td>None</td>
<td>Yes</td>
<td>No</td>
<td>Off</td>
<td>Off</td>
<td>Remain open</td>
</tr>
<tr>
<td>None</td>
<td>Yes</td>
<td>Yes</td>
<td>Off</td>
<td>Off</td>
<td>Close at normal speed</td>
</tr>
<tr>
<td>Buzzer only</td>
<td>No</td>
<td>-</td>
<td>Off</td>
<td>On</td>
<td>Remain open</td>
</tr>
<tr>
<td>Buzzer only</td>
<td>Yes</td>
<td>No</td>
<td>Off</td>
<td>On</td>
<td>Remain open</td>
</tr>
<tr>
<td>Buzzer only</td>
<td>Yes</td>
<td>Yes</td>
<td>Off</td>
<td>On</td>
<td>Close at normal speed</td>
</tr>
<tr>
<td>Reduced speed and torque</td>
<td>No</td>
<td>-</td>
<td>Off</td>
<td>Off</td>
<td>Remain open</td>
</tr>
<tr>
<td>Reduced speed and torque</td>
<td>Yes</td>
<td>-</td>
<td>Off</td>
<td>On</td>
<td>Close at reduced speed</td>
</tr>
</tbody>
</table>
• Reject hall calls when the in-car stop switch is activated:
  • If checked, the car is taken out of hall call service and hall calls are re-assigned when
    the in-car stop switch is pulled. If no other car is available, calls remain registered but
    unassigned. If the stop switch is still pulled after ten seconds, the car is taken out of
    service and any unassigned hall calls are canceled if this is the only car.
  • If not checked, when the in-car stop switch is pulled the car remains in service and
    assigned hall calls remain assigned to the car. If the stop switch is still pulled after ten
    seconds, the car is taken out of service and all assigned hall calls are re-assigned or
    canceled if this is the only car.

Exercise Operation  This option is used to cause the elevator to perform a number of
full hatch runs after being idle (on normal passenger service) for a number of hours. Once exer-
cised, the car returns to normal operation.
  • Enable: Check to enable exercise operation.
  • Idle timer: The exercise operation will be performed when the car has been idle (on
    normal passenger operation) for more than the set number of hours.
  • Number of run cycles: Sets the number of run cycles to be performed. One cycle is a
    full hatch run up and down.

Automatic Swing Operation  Swing operation removes a car from some aspects of
central dispatcher or Local/Dispatcher control. During Swing operation the car responds to hall
call demand from a dedicated set of hall calls (a Swing riser).
  • Enable: If enabled, the car will automatically enter Swing operation when a hall call is
    received from the Swing riser. Automatic Swing operation assumes an “always active”
    Swing riser. This option will override the “Swing Automatic Operation” input.
  • Disabled, or enabled with input: This option allows Automatic Swing operation to be
    enabled by activation of the “Swing Automatic Operation” input. The car will automati-
    cally enter Swing operation when a hall call is received from the Swing riser.
  • Idle swing car timer: Automatic Swing operation is monitored. An idle Swing car will
    return to normal service if no Swing riser inputs are activated for the period of time set
    by this control. Idle is defined as a car with no assigned calls, parking demand, or door
dwell times.

While Swing operation is active:
  • The car does not use the dispatching and security parameter settings from the central or
    local dispatcher. It uses parameter settings stored on it’s own iBox. With Swing operation
    enabled either by enabling Automatic Swing Operation or by assigning the Swing Opera-
    tion Switch input to an I/O board terminal, these parameters must be programmed using
    iView connected to the Swing car’s iBox.
  • The Swing car does not service group hall calls. Any existing group hall calls for the car are
    canceled or reassigned. Hall call eligibility for the swing car must be programmed using
    the Swing car’s System View > System Configuration > Hall Call Eligibility tab.
  • The car parks at the floor assigned on the Swing car’s System Configuration > Parking tab.
  • Existing car calls are not affected unless an alternate car call eligibility set is assigned by
    activation of a constant closure switch, in which case car calls are disposed of according to
    settings for that eligibility set. Up to eight alternate car call eligibility sets may be defined.
    Please refer to “General - Car Call Eligibility Tab” on page 9-99.
• The Swing car uses normal passenger settings pertaining to door operation, door dwell timers, etc.
• The Swing car uses elevator security settings that are stored on its own iBox. The security parameters must be programmed using the Swing car’s System View > Configuration > Security tab.
• Emergency dispatching caused by loss of communication between the car and the central or Local/Dispatcher+ is disabled.

**Passenger - Door operation tab**
The Configure > Car Operation > Passenger > Door operation tab determines door behavior for both front and rear doors while on Passenger (Norm) operation.
General

- Sequential Door Operation
  - Open both doors simultaneously: Both doors are allowed to open at the same time.
  - Open front doors first: Front doors will be opened first.
  - Open rear doors first: Rear doors will be opened first.
  - Open egress doors first: Doors on the side of the first registered car call to that floor open first.
  - Open ingress doors first: Doors on the side of the first registered active hall call from that floor open first.
  - Open offset timer: This timer allows you to set a duration in seconds which the second opening set of doors will wait to open, based on the open or closed status of the first opening set of doors. (Active only when a sequential opening mode is selected; changes to suit the selection.)
    - Open rear/front/egress/ingress doors XX (0 to 3600) sec after the front/rear/ingress/egress doors have fully opened/closed.

Door Dwell Timers

These timers set the door dwell times.

- Reopen: The amount of time that the doors are to remain open (dwell) when a door reopening device or open button has been activated.
- Door hold: The amount of time that the doors are to remain open when reopened by the activation of the Door Hold button.
- ADA car call: The minimum amount of time that the doors are to remain open after arriving at a floor selected by a car call per ADA requirements. Door dwell is not shortened by activation of a button or door reopening device (call or door close button, etc.). Timer starts when doors are fully open.
- ADA hall call: The minimum notification time from activation of the hall gong to when the door is about to close as required by the Americans with Disabilities Act. This dwell is not shortened by activation of a car call or door close button.

- Car Call
  - Dwell time: The amount of time that the doors are to remain open when responding to a car call. Any of the following may be specified to cancel car call dwell time:
    - Door close button: Pressing the door close button will cancel car call dwell time.
    - Car call button: Pressing a car call button will cancel car call dwell time.
    - Photo eye: Activation of the photo eye detector will cancel car call dwell time.

- Hall Call
  - Dwell time: The amount of time that the doors are to remain open when responding to a hall call. Any of the following may be specified to cancel hall call dwell time:
    - Door close button: Pressing the door close button will cancel hall call dwell time.
    - Car call button: Pressing a car call button will cancel hall call dwell time.
    - Photo eye: Activation of the photo eye detector will cancel hall call dwell time.

- Lobby Call
  - Dwell time: The amount of time that the doors are to remain open when responding to a call at the lobby floor. Any of the following may be specified to cancel lobby call dwell time:
    - Door close button: Pressing the door close button will cancel lobby call dwell time.
    - Car call button: Pressing a car call button will cancel lobby call dwell time.
    - Photo eye: Activation of the photo eye detector will cancel lobby call dwell time.
Passenger - Door operation - Front / Rear tabs

The Configure > Car Operation > Passenger > Door operation > Front and Rear tabs determine door behavior for front or rear doors while on Passenger (Norm) operation.

**General**

- Open doors for idle car: The car will park with doors open. If the parking option is not set, the car will remain at the last floor answered with doors open.
- Open car gate if hoistway door is open: The car gate will open if the hoistway door is open.
- DCF on between floors: Specifies that the door close function shall be on when the car is not at a floor in non-inspection modes.

**Opening**

When “MCE Controlled” is checked, the following parameters determine what action will cause the doors to open when the car arrives at a floor.

Mechanism:

- Automatic: With the presence of door open intent, doors shall open automatically upon arrival at the floor. When the car is sitting idle, the doors will open and remain open.
- Momentary pressure on door open button: Doors shall not open automatically upon arrival at a floor. Momentary activation of the door open button initiates door opening.
Closing  
When “MCE Controlled” is checked, the following parameters determine what action will cause the doors to close.

Mechanism:

- Automatic: With the absence of door open intent, the doors shall close automatically upon dwell time expiration.
- Passenger initiated: Doors shall not close automatically. The passenger initiated action selected below shall be required to cause the door to close.
  - Door close button:
    - Does not close doors: Doors shall not respond to door close button.
    - Constant pressure: Doors shall close with constant pressure on door close button. If the door close button is released before the doors are fully closed, the doors shall reopen and stand open.
    - Momentary pressure: Doors shall close with momentary pressure on door close button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - Momentary pressure if a car call is registered: Doors shall close with momentary pressure on door close button if a car call is registered. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
  - Car Call Button:
    - Does not close doors: Doors shall not close in response to car call button.
    - Constant pressure: Doors will close with constant pressure on car call button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - Momentary pressure: Doors shall close with momentary pressure on car call button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - Car call registration closes doors: Doors will close if a car call is registered.
Car Operation - Fire Service Tab

Settings on this tab determine car behavior during Fire Service operation. Fire Service operation typically proceeds in two stages. (Some codes allow the second stage to be initiated at any time by switch actuation.) The first stage, Recall, begins when a fire alarm, smoke detector, or fire recall switch is activated. During Recall, the elevator moves to a pre-determined floor to make itself available to emergency personnel. Based on the location of the initiating device(s), smoke detector, sensors, or recall switch, the car recalls to either the Main or Alternate recall floor. During recall, car speed and performance may be controlled by Standard Pattern or by Alternate 1 Pattern parameters (Configuration > Pattern tab). Car behavior during recall is determined by the Fire Code selected and by any user modifications to the selected Fire Code made using tabs accessed through the Configuration > Car Operation > Fire Service > Fire code tab.

Once cars arrive at the recall floor, they are taken out of service and will not respond to hall calls or car calls until the In Car Firefighter switch is activated. In this second stage of Fire Service, the car behaves as determined by the Fire Code selected and by any user modifications to the selected Fire Code made using tabs accessed through the Configuration > Car Operation > Fire Service > Fire code tab. During Fire Phase 2, car speed and performance may be controlled by Standard Pattern or by Alternate 2 Pattern parameters (Configuration > Pattern tab).

Main Recall  Settings for Main fire recall.

- Floor: Specifies the Main Recall floor for Fire Recall operation.
- Front Opening: Specifies that the front doors shall open when the car completes Fire Recall Operation to the Main Recall floor.
- Rear Opening: Specifies that the rear doors shall open when the car completes Fire Recall Operation to the Main Recall floor.

Alternate Recall  Settings for alternate fire recall.

- Floor: Specifies the Alternate Recall floor for Fire Recall operation.
- Front Opening: Specifies that the front doors shall open when the car completes Fire Recall Operation to the Alternate Recall floor.
- Rear Opening: Specifies that the rear doors shall open when the car completes Fire Recall Operation to the Alternate Recall floor.
### Fire Recall
Settings for fire recall.

- **Fire recall door cycle time**: Sets the door cycle time for the Fire Recall Door Cycle option. When the car reaches the recall floor and doors are opened, the doors will then close after the Fire Recall Door Cycle time expires (used for pressurised hoistway).

### Fire Service - Fire Code
Displays the currently selected Fire Code and allows a different Fire Code to be selected.

- **All parameters are in default state**: Indicates that all of the fire service parameters are set as specified by the selected code. If this is not the case, "One or more parameters has been changed." is displayed.
- **Name**: Select the appropriate code from the drop down list.
- **Year**: Select the appropriate version (year) of the code.
- **Default button**: Sets the fire service parameters to the values specified by the selected code, e.g. A17.1 - 2000.
- **Latch the fire hat flashing**: Flashing the fire hat is required by certain jurisdictions whenever the hoistway or machine room smoke sensors are tripped. When these sensors are reset, the fire hat continues to flash if this option is set. Otherwise the fire hat will remain illuminated until fire service is deactivated.
Fire Service Override

• **Security does not override fire service**: This is the default state.

• **Override fire service/heat detectors when the following security configurations are active**: This option is intended only for an installation where security is of prime importance and where fire service/heat detectors operation would compromise that security. If this option is selected, fire service/heat detectors operation will not be allowed if Master security is active and one of the checked Security Configurations is active (System > Configuration > Security > General > Status). The active Security Configuration must have at least one floor secured or locked, regardless of the status of car call enable or car call enable override inputs. If a fire sensor/heat sensor or switch is activated while Master security is active, and then Master security is deactivated, fire service/heat detectors operation will be allowed. However, if fire service/heat detectors operation is already in progress and Master security is then activated, fire service/heat detectors operation will continue.

  • **Security configuration 1 (through 8)**: Check the Security configuration(s) which, when active, will override fire service as described above.

![Caution]

Changing Fire Code parameter settings may cause you to be out of compliance with the selected code and may require a variance. Parameter settings that are in compliance with the selected code are shown with an underline. If a setting is changed to one that does not comply with the selected code, it will appear in RED.

Firefighter’s car

• **No in-car firefighter’s switch**: Check if the car does not have an in-car firefighter’s switch (Required for British Fire Code EN 81-72).

  • **Designated firefighter’s car**: Check if the car does not have an in-car firefighter’s switch, but is a designated firefighter’s car. Upon completion of Fire Phase I it will then automatically go to Fire Phase II.

Fire Recall

• **Fire recall door cycle time**: Sets the door cycle time for the Fire Recall Door Cycle option. When the car reaches the recall floor and doors are opened, the doors will then close after the Fire Recall Door Cycle time expires (used for pressurised hoistway).
**Fire Code - Recall - General Tab**

This tab allows you to set various fire code recall parameters.

- **Latch primary fire recall switch:**
  - Never: The recall condition will clear automatically when the initiating condition clears.
  - Fire device OFF: In order to clear the recall condition, the primary fire recall switch must be off.
  - Primary bypass: In order to clear the recall condition, the primary fire recall switch must be turned to the BYPASS position.
  - Bypass and recall completed: In order to clear the recall condition, the car must be at the fire floor with doors open and the primary fire recall switch must be turned to the BYPASS position.
  - Recall completed all cars: In order to clear the recall condition, the fire recall must be completed for all elevators in the group.
  - Primary bypass then OFF: In order to clear the recall condition, the primary fire switch must be turned to the BYPASS position and then back to off.
• Latch secondary fire recall switch:
  • Never: The recall condition will clear automatically when the initiating condition clears.
  • Fire device OFF: In order to clear the recall condition, the secondary fire recall switch must be off.
  • Primary bypass: In order to clear the recall condition, the primary fire recall switch must be turned to the BYPASS position.
  • Bypass and recall completed: In order to clear the recall condition, the car must be at the fire floor with doors open and the primary fire recall switch must be turned to the BYPASS position.
  • Recall completed all cars: In order to clear the recall condition, the fire recall must be completed for all elevators in the group.
  • Primary bypass then OFF: In order to clear the recall condition, the primary fire recall switch must be turned to the BYPASS position and then back to off.
• Latch first smoke detector zone:
  • Never: The recall condition will clear automatically when the initiating condition clears. When this option is set, the main floor smoke sensor will override the upper floor smoke sensors.
  • Fire device OFF: In order to clear the recall condition, the secondary fire recall switch must be off.
  • Primary bypass: In order to clear the recall condition, the primary fire recall switch must be turned to the BYPASS position.
  • Bypass and recall completed: In order to clear the recall condition, the car must be at the fire floor with doors open and the primary fire recall switch must be turned to the BYPASS position.
  • Recall completed all cars: In order to clear the recall condition, the fire recall must be completed for all elevators in the group.
  • Primary bypass then OFF: In order to clear the recall condition, the primary fire recall switch must be turned to the BYPASS position and then back to off.
• Fire Phase 1 nudging:
  • No nudging: During Fire Phase I, nudging will be inhibited.
  • Nudge if no reopen devices: During Fire Phase I, the doors will nudge close if there are no operative reopening devices.
• Disable DOB and nudge during Fire Phase I:
  • Not at all: The Door Open button will remain active.
  • Immediately: The Door Open button will immediately become inactive when Fire Phase I is initiated and the doors will nudge close if the Door Open Button is pressed as the doors are closing.
  • After delay: The Door Open Button will become inactive after the set delay when Fire Phase I has been initiated and the doors will nudge close if the Door Open Button is pressed as the doors are closing.
• Fire bypasses independent service:
  • No bypass: Fire recall will not bypass Independent Service.
  • Bypass immediately: Fire recall will immediately bypass Independent Service.
  • Bypass if running or after delay: Fire recall will bypass Independent Service after the
delay set here expires or immediately if the car is running.

• Fire bypasses attendant service:
  • No bypass: Fire recall will not bypass Attendant Service.
  • Bypass immediately: Fire recall will immediately bypass Attendant Service.
  • Bypass if running or after delay: Fire recall will bypass Attendant Service after the
delay set here expires or immediately if the car is running.

• Fire Switch Settings:
  • Require primary and secondary switch activation to override alternate floor recall:
    Enable if both primary and secondary fire switches must be active to override alternate
    floor recall.
  • Primary fire recall switch overrides alternate fire recall: Enable if primary fire recall
    switch will override alternate fire recall.
  • Secondary fire recall switch overrides alternate fire recall: Enable if secondary fire
    recall switch will override alternate fire recall.
  • Bypass position of primary recall switch bypasses sensors: Primary recall switch
    bypass position will bypass smoke sensors.
  • Primary fire switch recall resets alternate fire recall: Once the Phase I switch is used to
    recall the car to the main recall floor, the main recall floor becomes the recall level for
    the remainder of fire service operation regardless of the subsequent position of the fire
    switch or the status of the main floor fire sensor (complies with A17.1a-2005 or later
    code).

• Main Floor Sensor Options:
  • Primary switch on to reset alternate recall: Recall to the alternate fire floor can only be
    reset by putting the primary recall switch in the ON position (with this option
    enabled).
  • Alternate recall bypasses main recall: When a main floor recall is in process and an
    alternate floor recall is initiated, the main recall will be bypassed and the alternate
    recall will proceed (with this option enabled).

• Miscellaneous:
  • Fire 1 bypasses stop switch: Fire 1 will bypass the stop switch.
  • Fire 1 disables safety edge: Fire 1 will disable the door safety edge.
  • Disable door contact monitoring during fire recall: Door contact monitoring shall be
    disabled during fire recall.
  • Attendant operated fire warning buzzer: Fire warning buzzer will only be activated
    when car is being operated by an attendant (required for British Fire Code EN 81-72).
Fire Code - Recall - Front / Rear Door Tabs

Determine how the doors shall open and close during Fire Recall operation.

<table>
<thead>
<tr>
<th>Fire Code</th>
<th>In-Car</th>
<th>Recall</th>
<th>In-Car Recall</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Front</td>
<td>Rear</td>
<td></td>
</tr>
</tbody>
</table>

### Recall Completed

**Opening**

- **MCE Controlled**
  - Mechanism: Automatic

**Closing**

- **MCE Controlled**
  - Mechanism: Passenger initiated
  - Door close button: Does not close doors
  - Car call button: Does not close doors
  - Car call registration closes doors

### Recall Not Completed

**Opening**

- **MCE Controlled**
  - Mechanism: Automatic

**Closing**

- **MCE Controlled**
  - Mechanism: Passenger initiated
  - Door close button: Does not close doors
  - Car call button: Does not close doors
  - Car call registration closes doors

### Recall Not Completed - Recall Completed

Determine how the doors shall open and close before recall has been completed and after recall has been completed. The parameters and descriptions are the same for both Recall Not Completed and Recall Completed and for both Front and Rear tabs.

**Opening**

When “MCE Controlled” is checked, the following parameters determine what action will cause the doors to open when the car arrives at a floor.

**Mechanism:**

- **Automatic:** With the presence of door open intent, doors shall open automatically upon arrival at the floor. When the car is sitting idle, the doors will open and remain open.
- **Constant pressure on door open button:** Doors shall not open automatically upon arrival at a floor. Constant pressure activation of the door open button is required to open the doors. If the door open button is released before the doors are fully open, the doors shall re-close.
- **Momentary pressure on door open button:** Doors shall not open automatically upon arrival at a floor. Momentary activation of the door open button shall initiate opening the doors.
Closing  When “MCE Controlled” is checked, the following parameters determine what action will cause the doors to close.

Mechanism:

- **Automatic**: With the absence of door open intent, the doors shall close automatically upon fire service activation.
- **Passenger initiated**: Doors shall not close automatically. The passenger initiated action selected below shall be required to cause the door to close.
  - **Door close button**:
    - **Does not close doors**: Doors shall not respond to door close button.
    - **Constant pressure**: Doors shall close with constant pressure on door close button. If the door close button is released before the doors are fully closed, the doors shall reopen and stand open.
    - **Momentary pressure**: Doors shall close with momentary pressure on door close button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - **Momentary pressure if a car call is registered**: Doors shall close with momentary pressure on door close button if a car call is registered. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated. *(Not applicable to Fire Service Recall operation)*
  - **Car Call Button**:
    - **Does not close doors**: Doors shall not close in response to car call button.
    - **Constant pressure**: Doors will close with constant pressure on car call button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - **Momentary pressure**: Doors shall close with momentary pressure on car call button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
Fire Code - In-Car - General Tab
This tab allows you to set In-Car Firefighter parameters.

- Fire Phase II Recall Conditions: One of the following conditions is necessary to initiate Fire Phase II recall when the Fire Phase II switch is deactivated.
  - No recall: Never recall.
  - Recall: Always initiate recall.
  - Doors open or closed: Initiate recall only if the doors are fully open or closed.
  - Phase 1 and doors open: Initiate recall only if Phase I is still active and the doors are fully open.
  - Phase I and doors open or closed: Initiate recall only if Phase I is still active and the doors are fully open or closed.
  - Phase I and doors opened once: Initiate recall only if Phase I is active and the doors have been opened at least once at the floor.
  - Doors open: Initiate recall only if the doors are fully open.
• Fire Phase II hold conditions: One of the following conditions is required to put the car on Fire Phase II Hold when the switch is turned to the Hold position.
  • Never: Never put the car on Fire Phase II Hold.
  • Not on Phase I: Initiate Fire Phase II Hold if Fire Phase I is not active.
  • Not on Phase I and doors open: Initiate Fire Phase II Hold if Fire Phase I is not active and the elevator doors are fully open.
  • Unconditional hold: Put the car on Fire Phase II Hold unconditionally.
  • Doors open hold: Initiate Fire Phase II Hold only if doors are fully open.
  • Phase I and doors open: Put the car on Fire Phase II Hold if Fire Phase I is active and the doors are fully open.
• Put car on Fire Phase II when: One of the following conditions is required to activate in-car firefighter operation when the in-car fire fighter switch is activated
  • Unqualified: Put the car on Fire Phase II unconditionally.
  • Recall completes: Put the car on Fire Phase II when the recall is complete.
  • Recall completes and Primary ON: Put the car on Fire Phase II when the recall is complete and the Primary Fire recall switch is in the ON position.
• Take car off Fire Phase II when: One of the following conditions is required to take the car off in-car firefighter operation.
  • Unqualified: Take car off Fire Phase II when the in-car switch is deactivated.
  • Recall completes: Take car off Fire Phase II when the recall is complete and the in-car switch is deactivated.
  • Recall completes and Primary ON: Take the car off Fire Phase II when the recall is complete, the in-car switch is deactivated and the Primary Fire Recall switch is in the ON position.
  • Primary OFF: Take the car off Fire Phase II when the Primary Fire Recall switch is in the OFF position.
• Put car on Fire Phase II during Fire Phase II recall when: One of the following conditions is required to put the car on Phase II during Phase II recall if the Phase II Switch is reactivated.
  • None: Never re-initiate Phase II once Phase II recall has been activated.
  • Unconditional: Phase II will be re-activated unconditionally.
  • Doors are not closed: Phase II will be re-activated only if the doors are not closed.
  • Doors not closed away from recall floor: Phase II will be re-activated only if the car is away from the recall floor and the doors are not closed.
• Put car on Phase II hold when: One of the following conditions is required to activate Fire Phase II Hold when.
  • Never: Never activate Phase II Hold.
  • Not on Phase I: Initiate Phase II Hold if Phase I is not activated.
  • Not on Phase I and doors open: Initiate Phase II Hold if Phase I is not activated and the doors are fully open.
  • Unconditional hold: Phase II Hold will be activated unconditionally.
  • Doors open hold: Phase II Hold will be activated only if the doors are fully open.
  • Phase I and doors open: Phase II Hold will be activated only if Phase I is active and the doors are fully open.
• During Fire Phase II Hold:
  • Keep doors open and disable door close button): Hold the car doors open during Fire Phase II Hold, bypassing the Door Close Button.
  • Cancel car calls: During Fire Phase II Hold, cancel all car calls and prevent registration of new car calls.

• Conditions for stopping / disabling doors:
  • Emergency stop switch stops doors.
  • Emergency stop switch disables door opening.
  • Emergency stop switch disables door closing.
  • Door stop button stops doors.
  • Door stop button disables door opening.
  • Door stop button disables door closing.

• Miscellaneous:
  • Auto close doors if car away from recall floor: Unless the Door Open Button is pressed, always keep the doors closed when away from the recall floor.
  • Nudge doors: Close doors at nudging speed during in-car firefighter operation.
  • Cancel Fire Phase II car calls if car is at recall floor and DOB is pressed: Cancel car calls during in-car firefighter operation if the car is at the recall floor and the Door Open Button is pressed.
  • Fire Phase II bypasses stop switch: Bypass the Stop switch during in-car firefighter operation.
  • Enable safe edge during firefighter service: Enable the door safety edge during in-car firefighter operation.
  • Fire Phase II cancel car call upon door reopen: During in-car firefighter operation, cancel car calls if a door reopens.
  • Keep doors open during Fire Phase II: Enabling this option will cause the doors to reopen as soon as the Door Close button is deactivated, even if the doors have fully closed (as long as the car is not moving).
  • Car emergency stop switch cancels car calls: Cancel car calls when the car emergency stop switch is activated while on in-car firefighter operation.
  • Do not move car to next floor after an emergency stop: During in-car firefighter operation, the car shall not be moved to the next floor after an emergency stop.
  • Enable the in-car fire switch upon power up: In order to comply with ASME A17.1-2000 code, when this parameter is checked, after power up, changes to the In-car Fire Switch are recognized regardless of the position of the doors, until the doors have fully opened once.
  • Sync towards the fire recall floor: The car shall move towards the fire recall floor when performing a floor sync operation.
  • Enable in-car fire switch if doors have opened once: The In-car Fire Switch shall be recognized regardless of the position of the doors, if the doors have been fully opened once at the fire recall level. **Note** - This option must be checked for elevators with manual doors that must comply with the ASME A17.1-2000 or later code.
  • Disable door contact monitoring during fire phase II: Specifies that door contact monitoring shall be disabled during fire phase II (required for New York 2000 fire code).
  • New car call registration cancels previous car call: Specifies that registration of a new car call shall cancel the previous call (required for British Fire Code EN 81-72).
**Fire Code - In-Car - Front / Rear Tabs**

Determine how the doors shall open and close during Fire Service - In-Car operation.

<table>
<thead>
<tr>
<th>Fire Code</th>
<th>In-Car</th>
<th>Recall</th>
<th>In-Car Recall</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Front</td>
<td>Rear</td>
<td></td>
</tr>
</tbody>
</table>

**At Recall Floor**

- **Opening**
  - **MCE controlled**
  - **Mechanism**
    - **Constant pressure on door open button**

- **Closing**
  - **MCE controlled**
  - **Mechanism**
    - **Passenger initiated**
      - **Door close button**
        - **Constant Pressure**
      - **Car call button**
        - **Does not close doors**
    - **Car call registration closes doors**

**Away From Recall Floor**

- **Opening**
  - **MCE controlled**
  - **Mechanism**
    - **Constant pressure on door open button**

- **Closing**
  - **MCE controlled**
  - **Mechanism**
    - **Passenger initiated**
      - **Door close button**
        - **Constant Pressure**
      - **Car call button**
        - **Does not close doors**
    - **Car call registration closes doors**

**At Recall Floor - Away from Recall Floor**

Determine how the doors shall open and close when the car is at the recall floor and when the car is away from the recall floor. The parameters and descriptions are the same for both At Recall Floor and Away From Recall Floor and for both Front and Rear tabs.

**Opening**

When “MCE Controlled” is checked, the following parameters determine what action will cause the doors to open when the car arrives at a floor.

**Mechanism:**

- **Automatic**: With the presence of door open intent, doors shall open automatically upon arrival at the floor. When the car is sitting idle, the doors will open and remain open.
- **Constant pressure on door open button**: Doors shall not open automatically upon arrival at a floor. Constant pressure activation of the door open button is required to open the doors. If the door open button is released before the doors are fully open, the doors shall re-close.
- **Momentary pressure on door open button**: Doors shall not open automatically upon arrival at a floor. Momentary activation of the door open button shall initiate opening the doors.
**Closing** When “MCE Controlled” is checked, the following parameters determine what action will cause the doors to close.

**Mechanism:**

- **Automatic:** With the absence of door open intent, the doors shall close automatically upon dwell time expiration.
- **Passenger initiated:** Doors shall not close automatically. The passenger initiated action selected below shall be required to cause the door to close.
  - **Door close button:**
    - **Does not close doors:** Doors shall not respond to door close button.
    - **Constant pressure:** Doors shall close with constant pressure on door close button. If the door close button is released before the doors are fully closed, the doors shall reopen and stand open.
    - **Momentary pressure:** Doors shall close with momentary pressure on door close button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - **Momentary pressure if a car call is registered:** Doors shall close with momentary pressure on door close button if a car call is registered. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - **Constant pressure if a car call is registered:** Doors shall close with constant pressure on door close button if a car call is registered. If the door close button has been released, operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
  - **Car Call Button:**
    - **Does not close doors:** Doors shall not close in response to car call button.
    - **Constant pressure:** Doors will close with constant pressure on car call button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - **Momentary pressure:** Doors shall close with momentary pressure on car call button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - **Car call registration closes doors:** Doors will close if a car call is registered.
Fire Code - In-Car Recall - Front / Rear Tabs

Determine how the doors shall open and close during Fire Service In-Car Recall operation. The parameters and descriptions are the same for both Front and Rear tabs.

<table>
<thead>
<tr>
<th>Fire code</th>
<th>In-Car</th>
<th>Recall</th>
<th>In-Car Recall</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rear</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Opening**

When “MCE controlled” is checked, the following parameters determine what action will cause the doors to open when the car arrives at a floor.

Mechanism:

- **Automatic**: With the presence of door open intent, doors shall open automatically upon arrival at the floor. When the car is sitting idle, the doors will open and remain open.
- **Constant pressure on door open button**: Doors shall not open automatically upon arrival at a floor. Constant pressure activation of the door open button is required to open the doors. If the door open button is released before the doors are fully open, the doors shall re-close.
- **Momentary pressure on door open button**: Doors shall not open automatically upon arrival at a floor. Momentary activation of the door open button initiates door opening.
Closing  When “MCE controlled” is checked, the following parameters determine what action will cause the doors to close.

Mechanism:

- Automatic: With the absence of door open intent, the doors shall close automatically upon dwell time expiration.
- Passenger initiated: Doors shall not close automatically. The passenger initiated action selected below shall be required to cause the door to close.
  - Door close button:
    - Does not close doors: Doors shall not respond to door close button.
    - Constant pressure: Doors shall close with constant pressure on door close button. If the door close button is released before the doors are fully closed, the doors shall reopen and stand open.
    - Momentary pressure: Doors shall close with momentary pressure on door close button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - Momentary pressure if a car call is registered: Doors shall close with momentary pressure on door close button if a car call is registered. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
- Car Call Button:
  - Does not close doors: Doors shall not close in response to car call button.
  - Constant pressure: Doors will close with constant pressure on car call button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
  - Momentary pressure: Doors shall close with momentary pressure on car call button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
  - Car call registration closes doors: Doors will close if a car call is registered.

Note

For elevators that must comply with the ASME A17.1-2000 and later code, if the door is power-operated and vertically sliding, the Closing Mechanism parameter (Fire Code > In-Car Recall > Front / Rear) must be set to Passenger initiated and the Door close button parameter must be set to Constant Pressure.
**Car Operation - Independent Service Tab**

This tab sets parameters associated with Independent and Attendant Service operation.

<table>
<thead>
<tr>
<th>Operational Status</th>
<th>Car Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Independent service</strong></td>
<td></td>
</tr>
<tr>
<td>Doors</td>
<td>Devices</td>
</tr>
<tr>
<td>Front</td>
<td>Rear</td>
</tr>
</tbody>
</table>

**General**

- **Open front doors**: If the doors are closed when the car is placed on Independent Service, the front doors shall be opened.
- **Open rear doors**: If the doors are closed when the car is placed on Independent Service, the rear doors shall be opened.
- **Cancel all car calls at next car call stop**: Specifies that all car calls be canceled after the elevator completes the first car call stop

**Independent Service - Front / Rear Tabs**

Determine how the doors shall open and close during Independent Service operation. The parameters and descriptions are the same for both Front and Rear tabs.

<table>
<thead>
<tr>
<th>Operational Status</th>
<th>Car Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>**Independent service</td>
<td>Front**</td>
</tr>
<tr>
<td>Doors</td>
<td>Devices</td>
</tr>
<tr>
<td>Front</td>
<td>Rear</td>
</tr>
<tr>
<td>Elevator recall</td>
<td>Earthquake</td>
</tr>
</tbody>
</table>

**Opening**

- **MCE controlled**
  - **Mechanism**: Automatic

**Closing**

- **MCE controlled**
  - **Mechanism**: Passenger initiated
  - **Door close button**: Constant Pressure
  - **Car call button**: Constant pressure
  - **Car call registration closes doors**
Opening When “MCE controlled” is checked, the following parameters determine what action will cause the doors to open when the car arrives at a floor.

Mechanism:

- Automatic: With the presence of door open intent, doors shall open automatically upon arrival at the floor. When the car is sitting idle, the doors will open and remain open.
- Momentary pressure on door open button: Doors shall not open automatically upon arrival at a floor. Momentary activation of the door open button initiates door opening.

Closing When “MCE controlled” is checked, the following parameters determine what action will cause the doors to close.

Mechanism:

- Automatic: This option is not available on Independent service.
- Passenger initiated: Doors shall not close automatically. The passenger initiated action selected below shall be required to cause the door to close.
  - Door close button:
    - Does not close doors: Doors shall not respond to door close button.
    - Constant pressure: Doors shall close with constant pressure on door close button. If the door close button is released before the doors are fully closed, the doors shall reopen and stand open.
    - Momentary pressure: Doors shall close with momentary pressure on door close button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - Momentary pressure if a car call is registered: Doors shall close with momentary pressure on door close button if a car call is registered. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
  - Car Call Button:
    - Does not close doors: Doors shall not close in response to car call button.
    - Constant pressure: Doors will close with constant pressure on car call button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - Momentary pressure: Doors shall close with momentary pressure on car call button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - Car call registration closes doors: Doors will close if a car call is registered.
Car Operation - Elevator Recall Tab

Elevator Recall switch parameters determine how the car will respond during Elevator Recall operation (when the Elevator Recall Switch is activated).

General

- **Recall floor**: Specifies the floor to which the elevator is recalled.
- **Next available floor**: Causes the car to stop at the next available floor in the direction of travel if “Car call disposition” is set to “Cancel immediately”. If car calls are allowed to remain registered, the elevator will remain at the floor at which the last registered car call was answered.
- **“Floor label”**: Specifies the floor to which the elevator shall be recalled.
- **Switch priority**: Determines which switch has priority if more than one Elevator Recall Switch is activated simultaneously. (#1 is highest priority.)
- **Car call disposition**: Determines how existing car calls are handled when the Elevator Recall Switch is activated.
  - Service existing car calls: All previously registered car calls remain registered and the elevator is allowed to answer the car calls.
  - Cancel immediately: All previously registered car calls are immediately canceled.
  - Cancel at the next car call stop: All previously registered car calls remain registered. When the elevator answers its next car call, all remaining car calls are canceled.
• Allow new car call registration: Determines if new car calls shall be registered during the “first phase” of elevator Recall Operation. During the “first phase” of Elevator Recall Operation, the elevator must handle existing car calls. This parameter determines if new car calls shall be registered during the “first phase” of Elevator Recall Operation. Once the elevator has finished answering all registered car calls, the “second phase” commences, and the elevator is taken to the recall floor. No car calls are accepted during the “second phase.”

• Override Attendant service: Elevator Recall operation shall override Attendant service.

• Override CFSS mode 1: Elevator Recall operation shall override CFSS mode 1.

• Override CFSS mode 2: Elevator Recall operation shall override CFSS mode 2.

• Override EMS mode 1: Elevator Recall operation shall override EMS mode 1.

• Override EMS mode 2: Elevator Recall operation shall override EMS mode 2.

• Override Independent service: Elevator Recall operation shall override Independent service.

• Switch type: Indicates the type of Elevator Recall Switch.
  • Continuous closure: The controller performs the Elevator Recall Operation as long as the switch remains closed. If the switch opens midway through the process, the recall operation is terminated.
  • Momentary closure: A momentary closure of the switch causes the controller to perform the complete Elevator Recall Operation. Once completed, the controller will return to normal service.
    • Resume normal operation after ___ sec: This timer begins when door operation at the recall floor is complete. When the timer expires, the car is returned to normal operation.
    • After recall, activate independent service: If enabled, Independent service will be activated after recall is complete. The car remains on Independent Service until the continuous closure switch is opened or the “Resume normal operation after” timer expires.

**Door Operation Front**

Determines how the elevator front doors shall operate once the elevator has arrived at the recall floor (after all car calls have been answered).

• Keep closed: The front doors shall remain closed.

• Keep open: The front doors shall open and remain open.

• Open doors for “xx” sec: The front doors shall open for the time specified, then reclose.

• Respond to door open button: Specifies that the front doors shall respond to activation of the front door open button (once the car has arrived at the recall floor). If this option is selected, the front door open button remains operative at all times. If not selected, the front door open button will be rendered inoperative when the front doors are closed at the recall floor. (Note: The door open button will always remain operative when the associated doors are open).
**Door Operation Rear**  
Determines how the elevator rear doors shall operate once the elevator has arrived at the recall floor (after all car calls have been answered).

- Keep closed: The rear doors shall remain closed.
- Keep open: The rear doors shall open and remain open.
- Open doors for “xx” sec: The rear doors shall open for the amount of time specified, then reclose.
- Respond to door open button: Specifies that the rear doors shall respond to activation of the rear door open button (once the car has arrived at the recall floor). If this option is selected, the rear door open button remains operative at all times. If not selected, the rear door open button will be rendered inoperative when the rear doors are closed at the recall floor. (Note: The door open button will always remain operative when the associated doors are open).

**Hoistway Access Recall**  
This control allows the recall operation, based on the parameter settings for the selected recall switch (1 - 6), to be activated by one of the Hoistway Access direction switches. This allows the mechanic to recall the car prior to placing it on access operation.

- Assign this recall to the following hoistway access input:
  - No access recall:
  - ATU - Access Top Up: Activation of the ATU switch/input shall cause the car to recall per the selected recall switch (1 - 6) parameter settings.
  - ATD - Access Top Down: Activation of the ATD switch/input shall cause the car to recall per the selected recall switch (1 - 6) parameter settings.
  - ABU - Access Bottom Up: Activation of the ABU switch/input shall cause the car to recall per the selected recall switch (1 - 6) parameter settings.
  - ABD - Access Bottom Down: Activation of the ABD switch/input shall cause the car to recall per the selected recall switch (1 - 6) parameter settings.
Car Operation - Earthquake Tab

Allows selection of operating parameters during earthquake operation. Please refer to “Installing the Earthquake Sensor” on page 3-21 for additional information.

Earthquake Code

Select the earthquake code and version/year being used.

Caution

Changing earthquake parameter settings may cause you to be out of compliance with the selected code and may require a variance. Note that some parameter settings are underlined, indicating that the setting is in compliance with the selected code. If a setting is changed to one that does not comply with the selected code, it will appear in RED.
• Earthquake run mode: Specifies when the elevator should be allowed to run while under Earthquake mode of operation. The elevator is allowed to run at a reduced speed (not to exceed 150 fpm) as long as the counterweight has not been displaced from its guide rails.
  • None: The car is not allowed to run in earthquake mode.
  • Delay: The car is allowed to run after a delay.
  • Fire only: The car is allowed to run only during fire service. The car is also allowed to run with the counterweight derailed if the car is below the counterweight.

• Reaction to Seismic Device: Determines how the elevator should react to the activation of a seismic switch.
  • Emergency Stop: Perform an Emergency stop then, after a brief delay, proceed to next available floor in a direction away from the counterweight.
  • Stop at Next Floor: Stop at next available floor in direction of travel.

• Freeze Car During Earthquake: Stop the car immediately during earthquake activity and keep it shut down as long as the earthquake remains active. (Title 8 earthquake compliance.)

• Allow all inspection modes during earthquake operation if the counterweight derailment device is not tripped: Specifies that the elevator should be allowed to run under all inspection modes of operation if the counterweight has not been displaced from its guide rails. If the counterweight is derailed, only Cartop Inspection is allowed to run during earthquake operation.

• Drum Machine Defaults button: Sets the earthquake parameters to the code specified default values for a drum machine installation.

• Default button: Sets the earthquake parameters to the code specified default values.

**Miscellaneous:**

• Counterweight displacement detection: If the job has a device to detect displacement of the counterweight, enable this check box.
### Car Operation - EMS Tab

Allows selection of operating parameters during Emergency Medical Service operation.

<table>
<thead>
<tr>
<th>Operational Status</th>
<th>Car Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMS</td>
<td>Switch 1</td>
</tr>
<tr>
<td>• Doors</td>
<td>• Devices</td>
</tr>
<tr>
<td>• Passenger</td>
<td>• Fire service</td>
</tr>
<tr>
<td>• Fire code</td>
<td>• Independent service</td>
</tr>
<tr>
<td>• Elevator recall</td>
<td>• Earthquake</td>
</tr>
<tr>
<td>• EMS</td>
<td>• EMS Switch 1</td>
</tr>
<tr>
<td>• Emergency power</td>
<td>• Emergency power</td>
</tr>
<tr>
<td>• Fire service and heat detector operation</td>
<td>• Fire service and heat detector operation</td>
</tr>
<tr>
<td>bypass EMS</td>
<td>bypass EMS</td>
</tr>
<tr>
<td>• Recall Switch Location</td>
<td>• Recall Switch Location</td>
</tr>
<tr>
<td>• Front</td>
<td>• Rear</td>
</tr>
</tbody>
</table>

#### General

- **Recall Floor**: Determines the recall floor for EMS service.
- **Phase 1 Timeout**: Allows a time period to be set after which EMS Phase 1 service will time out without activation of Phase 2 (in-car switch).
- **Bypasses Attendant in XX Seconds**: Allows a time period to be set after which EMS service will bypass Attendant service.
- **Fire service and heat detector operation bypass EMS**: If enabled, Fire Service or Heat Detector operation will immediately bypass EMS service.
- **Recall Switch Location (Front or Rear)**: Indicates the location of the EMS recall switch (front riser or rear riser).
EMS Switch ‘n’ - Front / Rear Tabs  The EMS - Front and Rear parameters determine how the front and rear doors will operate during EMS Operation. The parameters and descriptions are the same for both Switch 1 and 2 and for both Front and Rear tabs.

Opening - After Car Arrives At Recall Floor  When “MCE controlled” is checked, the following parameters determine what action will cause the doors to open when the car arrives at a floor.

Mechanism:

- Automatic: With the presence of door open intent, doors shall open automatically upon arrival at the floor. When the car is sitting idle, the doors will open and remain open.
- Constant pressure on door open button: Doors shall not open automatically upon arrival at a floor. Constant pressure activation of the door open button is required to open the doors. If the door open button is released before the doors are fully open, the doors shall re-close.
- Momentary pressure on door open button: Doors shall not open automatically upon arrival at a floor. Momentary activation of the door open button initiates door opening.
In-car Opening

When “MCE controlled” is checked, the following parameters determine what action will cause the doors to open when the car arrives at a floor.

Mechanism:

- Automatic: With the presence of door open intent, doors shall open automatically upon arrival at the floor. When the car is sitting idle, the doors will open and remain open.
- Constant pressure on door open button: Doors shall not open automatically upon arrival at a floor. Constant pressure activation of the door open button is required to open the doors. If the door open button is released before the doors are fully open, the doors shall re-close.
- Momentary pressure on door open button: Doors shall not open automatically upon arrival at a floor. Momentary activation of the door open button initiates door opening.

Closing - When Car Responds to Recall Command

When “MCE controlled” is checked, the following parameters determine what action will cause the doors to close.

Mechanism:

- Automatic: With the presence of door open intent, doors shall open automatically upon arrival at the floor. When the car is sitting idle, the doors will open and remain open.
- Passenger initiated: Doors shall not close automatically. The passenger initiated action selected below shall be required to cause the door to close.
  - Door close button:
    - Does not close doors: Doors shall not respond to door close button.
    - Constant pressure: Doors shall close with constant pressure on door close button. If the door close button is released before the doors are fully closed, the doors shall reopen and stand open.
    - Momentary pressure: Doors shall close with momentary pressure on door close button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - Momentary pressure if a car call is registered: Doors shall close with momentary pressure on door close button if a car call is registered. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
  - Car Call Button:
    - Does not close doors: Doors shall not close in response to car call button.
    - Constant pressure: Doors will close with constant pressure on car call button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - Momentary pressure: Doors shall close with momentary pressure on car call button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - Car call registration closes doors: Doors will close if a car call is registered.
In-car Closing When “MCE controlled” is checked, the following parameters determine what action will cause the doors to close.

Mechanism:

- Automatic: With the presence of door open intent, doors shall open automatically upon arrival at the floor. When the car is sitting idle, the doors will open and remain open.
- Passenger initiated: Doors shall not close automatically. The passenger initiated action selected below shall be required to cause the door to close.
  - Door close button:
    - Does not close doors: Doors shall not respond to door close button.
    - Constant pressure: Doors shall close with constant pressure on door close button. If the door close button is released before the doors are fully closed, the doors shall reopen and stand open.
    - Momentary pressure: Doors shall close with momentary pressure on door close button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - Momentary pressure if a car call is registered: Doors shall close with momentary pressure on door close button if a car call is registered. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
  - Car Call Button:
    - Does not close doors: Doors shall not close in response to car call button.
    - Constant pressure: Doors will close with constant pressure on car call button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - Momentary pressure: Doors shall close with momentary pressure on car call button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - Car call registration closes doors: Doors will close if a car call is registered.
Car Operation - Emergency Power Tab
Determine the car reaction to loss of commercial power.

- Emergency power type:
  - Group/Simplex: Select this option for a simplex or for a car that is part of a group that controls the car during emergency power generator operation.
  - Overlay: Select this option if the car is controlled via discrete inputs from a remote emergency power overlay controller during emergency power generator operation.
  - Backup power: Select this option if the car is using a battery backup unit, e.g. the Traction Auxiliary Power Supply (TAPS) from MCE.

- Emergency power input (does not apply to Backup power option):
  - Active low: Low (ground) voltage at the EPI input will cause emergency power to become active.
  - Active high: High (110VDC) voltage at the EPI input will cause emergency power to become active.

- Recall Floor: Set the recall floor for this car (does not apply to Backup power option).

- Recall Timeout: Defines the period of time after which the controller will stop attempting to recall this car after a power failure has occurred (does not apply to Backup power option).

- Counterweight percentage: The weight of the counterweight divided by the sum of the full load weight plus the weight of the cab. (applies only to Backup power option).

- Apply emergency power door operation during in-car fire service: The emergency power door operation settings shall be used, instead of the in-car fire service door operation settings, when the car is on in-car fire service (applies only to Backup power option).

- Disable fire warning light during backup power recall: The fire warning light and buzzer shall be disabled during backup power recall operation (applies only to Backup power option).
Emergency Power - Front / Rear Tabs  The Front and Rear door parameters determine how the front and rear doors will operate during Emergency Power operation. The parameter descriptions are the same for both Front and Rear tabs.

Opening  When “MCE controlled” is checked, the following parameters determine what action will cause the doors to open when the car arrives at a floor.

- Mechanism:
  - Automatic: With the presence of door open intent, doors shall open automatically upon arrival at the floor. When the car is sitting idle, the doors will open and remain open.
  - Momentary pressure on door open button: Doors shall not open automatically upon arrival at a floor. Momentary activation of the door open button initiates door opening.
  - Front door operation after recall: After Emergency Power Recall is completed, the doors shall open as follows:
    - Open doors (and leave them open): Open the doors and leave them open.
    - Open doors for ‘xx’ sec: Open the doors for the time designated and then close them.
    - Do not open doors: The doors shall remain closed.
Note

Per the elevator code, the *Front /Rear door operation after recall* parameter (Emergency Power > Front / Rear > Opening) must be set to *Do not open doors* if:

- the car has a backup power source, e.g., MCE’s TAPS, and
- door closing is not automatic, e.g., the door *Mechanism* parameter (Emergency Power > Front / Rear > Closing) is set to *Passenger initiated*.

**Closing**

When “MCE controlled” is checked, the following parameters determine what action will cause the doors to close.

**Mechanism:**

- **Automatic:** With the presence of door open intent, doors shall open automatically upon arrival at the floor. When the car is sitting idle, the doors will open and remain open.
- **Passenger initiated:** Doors shall not close automatically. The passenger initiated action selected below shall be required to cause the door to close.
  - **Door close button:**
    - **Does not close doors:** Doors shall not respond to door close button.
    - **Constant pressure:** Doors shall close with constant pressure on door close button. If the door close button is released before the doors are fully closed, the doors shall reopen and stand open.
    - **Momentary pressure:** Doors shall close with momentary pressure on door close button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
  - **Car Call Button:**
    - **Does not close doors:** Doors shall not close in response to car call button.
    - **Constant pressure:** Doors will close with constant pressure on car call button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
    - **Momentary pressure:** Doors shall close with momentary pressure on car call button. Operational door reopening devices shall initiate door reopening, and once fully open the doors shall stand open until the door close button is again activated.
  - **Car call registration closes doors:** Doors will close if a car call is registered.
Car Operation - CFSS Tab

The CFSS (Commandeer For Special Service) tabs allow you to configure two “commandeer” modes. When active, these modes allow the elevator to be operated independently as configured for the commandeer mode selected. Please refer to “CFSS (Commandeer for Special Services)” on page 10-9 also.

### General
- Fire service and heat detector operation bypass CFSS: Specifies that CFSS will be bypassed when the car is in Fire Service operation and Heat Detector operation.

<table>
<thead>
<tr>
<th>Operational Status</th>
<th>Car Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>CFSS Mode 1</td>
<td></td>
</tr>
<tr>
<td>Doors</td>
<td></td>
</tr>
<tr>
<td>Devices</td>
<td></td>
</tr>
<tr>
<td>Passenger</td>
<td></td>
</tr>
<tr>
<td>Fire service</td>
<td></td>
</tr>
<tr>
<td>Fire code</td>
<td></td>
</tr>
<tr>
<td>Independent service</td>
<td></td>
</tr>
<tr>
<td>Elevator recall</td>
<td></td>
</tr>
<tr>
<td>Earthquake</td>
<td></td>
</tr>
<tr>
<td>EMS</td>
<td></td>
</tr>
<tr>
<td>Emergency power</td>
<td></td>
</tr>
<tr>
<td>CFSS</td>
<td></td>
</tr>
<tr>
<td>Mode 2</td>
<td></td>
</tr>
<tr>
<td>Flood operation</td>
<td></td>
</tr>
<tr>
<td>Attendant service</td>
<td></td>
</tr>
<tr>
<td>Auto stop</td>
<td></td>
</tr>
<tr>
<td>Sabbath operation</td>
<td></td>
</tr>
<tr>
<td>Shuttle Service</td>
<td></td>
</tr>
<tr>
<td>Heat Detectors</td>
<td></td>
</tr>
</tbody>
</table>

**General**
- Fire service and heat detector operation bypass CFSS

**Recall**
- Disposition of existing car calls
  - Cancel immediately
- Stop at next floor and cycle doors
- Allow new car call registration
- Recall empty car timer: 10 sec

**In-car visual indicator behavior**
- Flash

**In-car audible indicator behavior**
- Solid

- Cars on independent service are eligible for CFSS
  - Bypass independent service after: 0 sec
- Cars on attendant service are eligible for CFSS
  - Bypass attendant service after: 0 sec
- Bypass stop switch when car on CFSS recall
- CFSS recall timeout: 50 sec

**In-car**
- In-car visual indicator behavior
  - Flash

**In-car switch to activate CFSS**
- Constant pressure

Resume normal service: 240 sec after answering last car call

- Permit in-car activation without recall first
- Cancel remaining car calls after answering a call
- Cancel car calls if doors are not fully closed
- Retain status during power loss
Recall

When a CFSS mode is activated, the affected car is recalled to the activation floor according to the behavior defined by these settings.

- Disposition of existing car calls: Once a car has been assigned a CFSS call, these settings determine how existing car calls will be handled.
  - Service existing car calls: All currently registered car calls will be serviced before the car is recalled. Audio and visual indicators in the car will signal passengers.
  - Cancel immediately: Car calls are canceled and the car will proceed immediately to the recall floor. If this choice is selected, you may also choose to enable “Stop at next floor and cycle doors” in which case the car will stop at the next floor in its direction of travel and cycle its doors while using visual and audio indicators to signal passengers to exit. Once passengers have exited, the car will proceed to the recall floor.
  - Cancel calls at next car call stop: All remaining car calls will be cancelled at the cars next stop. Audio and visual indicators within the car will signal the passengers to exit.
  - Stop at next floor and cycle doors: Allows passengers to exit if car calls are canceled.
  - Allow new car call registration: Should be selected if “Recall empty car” is selected, to ensure recalling an empty car in case a passenger enters after hall call service is canceled.

- Recall empty car: Specifies that the recalled car must be empty. Select an appropriate “Disposition of existing car calls” option that will result in the car being empty. Once all car calls have been cleared, the car will close its doors and must then pass the empty car test (Empty Load Input = On, Car Not Empty Sensor Input = Off or car weight is below the Load Weigher Empty load threshold setting) before the Recall empty car timer expires.

- Recall empty car timer: This timer starts when all car calls have been cleared and the doors are fully closed. If the car has not passed the empty car test before this timer expires, it removes itself from CFSS service to allow the dispatcher to re-assign the CFSS call. If no car is available the CFSS call is canceled.

- In-car visual indicator behavior: The visual indicator may be set to remain off, light continuously, or light intermittently (Flash).

- In-car audible indicator behavior: The alarm may be set to remain off, sound constantly, or sound intermittently (Flash).

- Cars on independent service are eligible for CFSS: If enabled, a car currently operating on Independent Service mode may be assigned a CFSS call.
  - Bypass independent service after “nnn” sec: Determines the delay from when a car is assigned a CFSS call to when Independent Service is bypassed and the car begins CFSS mode.

- Cars on attendant service are eligible for CFSS: If enabled, a car currently operating on Attendant Service mode may be assigned a CFSS call.
  - Bypass attendant service after “nnn” sec: Determines the delay from when a car is assigned a CFSS call to when Attendant Service is bypassed and the car begins CFSS mode.

- Bypass stop switch when car on CFSS recall: Enable if activation of the in-car Stop switch should be ignored when the car is on commandeered operation.

- CFSS recall timeout: If the car has not answered the CFSS call before this timer times out, the car becomes ineligible for CFSS calls, thereby allowing the call to be re-assigned to another car. This timer also determines how long a recalled car will wait at the recall floor, for activation of the in-car CFSS service switch or the registration of a car call if there is no in-car CFSS service switch, before timing-out and returning to normal service.
**In-car** When a CFSS mode is selected, and after the recall is complete, these settings determine how in-car operation is invoked and how the car behaves during in-car CFSS operation.

- In-car visual indicator behavior while in-car CFSS is active. This setting defines how the in-car visual indicator (light, etc.) will behave while in-car CFSS is active.
  - Off: Indicator will remain off.
  - Solid: Indicator will light solidly.
  - Flash: Indicator will light intermittently (flash).
- In-car switch to activate CFSS:
  - No switch: Select if there is no switch in the car to activate CFSS. If selected, set the “Resume normal service xx seconds after answering last call” timer so that, after the period of inactivity it defines has passed, the car will automatically exit CFSS operation.
  - Constant Pressure (2-position switch): Select if there is a key or other constant-contact switch in the car to invoke in-car CFSS operation.
  - Momentary pressure (momentary switch): Select if there is a momentary-contact switch (spring-loaded key or other) in the car to invoke in-car CFSS operation. If selected, set the “Resume normal service xx seconds after answering last call” timer so that, after the period of inactivity it defines has passed, the car will automatically exit CFSS operation.
- Resume normal service after ‘xx’ seconds after answering last call: This determines how long a recalled car will wait after answering the last call before timing-out and returning to normal service.
- Permit in-car activation without recall first: If selected, in-car CFSS may be activated by an in-car switch without first initiating and completing a recall phase.
- Cancel remaining car calls after answering a car call: If enabled, after the first CFSS car call is answered, remaining calls are automatically canceled. Limits CFSS calls to one-at-a-time.
- Cancel car calls if doors are not fully closed: If enabled, during in-car CFSS operation, if the doors are not fully closed, new car calls may not be registered and existing car calls will be canceled.
- Retain status during power loss: If enabled, the car will retain its in-car CFSS status after recovering from a power loss.

**CFSS Mode ‘n’ - Front / Rear Tabs** The CFSS Mode 1 and 2 > Front and Rear tabs determine how the front and rear doors will operate during CFSS operation. The parameters and descriptions are the same as those for EMS Switch 1 and 2 > Front and Rear tabs. Please refer to “EMS Switch ‘n’ - Front / Rear Tabs” on page 9-69
Car Operation - Flood Operation Tab

This tab allows the elevator to be configured for emergency operation during flood conditions.

Enable  In areas where flood operation is not required, this option may be left unchecked. If enabled, the flood condition selections on the screen become active.

Flood Floors  During flood operation, floors in danger of flooding shall be avoided. The topography and construction at each job site will determine which and how many floors are affected.

- Click in the Flood floors column, the floors that should not be serviced during flood operation. A check mark will appear next to each selected floor.
**Flood Operation Shall Override**  Depending upon code requirements, flood operation interaction with other operating modes is user selectable. For the mode(s) of operation selected, where the requirements of Flood operation are not in agreement with those of the selected mode, the requirements of Flood operation will take precedence.

During Flood operation, cars shall avoid the flood zones. If inside the flood zones, cars shall proceed to the nearest floor outside the flood zone immediately unless the doors are open, in which case the timer (if any) must first elapse:

- Firefighters service: Select if flood operation requirements should override In-car firefighter operation requirements.
- In-car CFSS mode 1: Select if flood operation requirements should override In-car CFSS mode 1 requirements.
  - If doors are open, after (timer) sec. If the car is inside the flood zone and doors are open, this timer must elapse before the car proceeds to the nearest floor outside the flood zones.
- In-car CFSS mode 2: Select if flood operation requirements should override In-car CFSS mode 2 requirements.
  - If doors are open, after (timer) sec. If the car is inside the flood zone and doors are open, this timer must elapse before the car proceeds to the nearest floor outside the flood zones.
- Emergency medical service (EMS): Select if flood operation requirements should override the requirements of EMS service.
  - If doors are open, after (timer) sec. If the car is inside the flood zone and doors are open, this timer must elapse before the car proceeds to the nearest floor outside the flood zones.
- Independent Service: Select if flood operation requirements should override Independent and Service operation requirements.
- Attendant Service: Select if flood operation requirements should override Attendant Service operation requirements.
  - Independent and Attendant service if doors are open, after (timer) sec. If the car is inside the flood zone and doors are open, this timer must elapse before the car proceeds to the nearest floor outside the flood zones.

**Substitute recall floor during flood operation**  Substitute floors can be designated for Emergency Power recall and Fire recall:

- Emergency Power recall: Select the recall floor the elevator is to use during emergency power operation under flood conditions.
- Fire recall floor: Select if flood operation should modify fire recall operation. If so, set the recall floor to be used if fire recall is activated during flood conditions.
Car Operation - Attendant Service Tab

Attendant Service allows a car to be diverted from passenger operation for use by an attendant.

- **General** These parameters specify which doors to open if both doors are closed when the car is placed on Attendant operation.
  
  - Open front doors: If the doors are closed when a car call is placed on Attendant Service, the front doors shall be opened.
  - Open rear doors: If the doors are closed when a car call is placed on Attendant Service, the rear doors shall be opened.
  - Cancel all car calls at next car call stop: Specifies that all car calls be canceled after the elevator completes the first car call stop.
  - Enable arrival lanterns and gongs (on attendant service).

**Attendant Service - Front / Rear Tabs** The Front and Rear parameters determine how the front and rear doors will operate during Attendant Service Operation. The parameters and descriptions are the same as for the Independent Service > Front and Rear tabs. Please refer to “Independent Service - Front / Rear Tabs” on page 9-61.
Car Operation - Auto Stop Tab

If enabled and activated, Auto Stop will cause a car to stop at a selected floor and cycle its doors for observation before continuing on to its destination. The controls become enabled when “Enable” is checked. Set the configuration parameters and click Send to send those settings to the controller.

- Enable: Allows automatic stop controls to become active and “arms” the feature. The elevator will not actually begin obeying automatic stop settings until the Automatic Stop hardware input is activated, a timer is programmed or the Activate button and Send button are clicked.
- General
  - Stop floor: The floor at which the car should pause and cycle doors.
  - Direction: Determines if the car will pause when travelling up, down, or both.
  - Door operation: Determines whether front, rear, or both doors will cycle.
  - Stop during Independent service: Allows Automatic Stop to take effect during Independent service. Otherwise, a car on Independent service will not obey automatic stop.
  - Stop during Attendant service: Allows Automatic Stop to take effect during Attendant service. Otherwise, a car on Attendant service will not obey automatic stop.
• Door Dwell
  • Dwell time: The time, in seconds, that the door(s) will remain open before re-closing.
  • PHE cancels dwell timer: Allows photo eye detector activation to cancel remaining dwell time.
  • Car call button cancels dwell timer: Allows pressing a car call button to cancel remaining dwell time.
  • Door close button cancels dwell timer: Allows pressing the door close button to cancel remaining dwell time.

• Status
  • Auto stop ON: LED lights to indicate that Auto stop is On.
  • Activate button: Turns the Automatic stop function On or Off. The button caption changes to Deactivate when Auto stop is On:

Note

When Automatic Stop is enabled (“Enable” is checked), it may be turned On or Off using the following:

• A switch connected to the Automatic Stop hardware input.
• By clicking the Activate button and then clicking the Send button.
• By programming a Timer to turn Auto stop On or Off.
Car Operation - Sabbath Tab

These parameters determine how the car performs when on Sabbath operation. Sabbath operation must be Enabled via the “Enable Sabbath operation” parameter, and then Activated/Deactivated via a key switch-input, timer or software command from iMonitor or iView (Activate/Deactivate button on this tab). While performing Sabbath operation, the car automatically stops at predetermined floors, opens the doors for a period of time, then closes the doors and moves to the next designated Sabbath operation floor.
The programmable options for Sabbath operation include:

- **Enable Sabbath Operation**: Must be checked for Sabbath operation to be activated/deactivated. Otherwise Sabbath operation is disabled.
- **Allow hall call service**: Check to allow existing hall calls to be served and new hall calls to be registered while on Sabbath operation.
  - **Disable arrival lanterns**: During Sabbath operation the arrival lanterns shall be disabled (applies only if “Allow hall call service” is checked).
- **Allow car call service**: Check to allow existing car calls to be served and new car calls to be registered while on Sabbath operation.
- **Finish existing car calls**: When Sabbath operation is activated, the car will service all existing car calls before beginning Sabbath operation.
- **Disable car call buttons light**: The car call buttons will not illuminate in response to automatically generated Sabbath operation calls. However, they will illuminate to indicate registration of car calls in response to call button activation.
- **Disable position indicators**: During Sabbath operation the position and direction indicators shall be disabled (except for CE Electronics displays).
- **Disable load weighing functions**: During Sabbath operation the elevator's load weighing functions shall be disabled (except for pre-torquing).
- **Sabbath operation recall floor**: When Sabbath operation is activated, if a recall floor is designated, the car will first recall to this floor before beginning Sabbath operation service.
- **Sabbath operation start floor**: When Sabbath operation is activated, after traveling to the recall floor (if designated), the car will travel to the start floor (if designated) before beginning Sabbath operation service. The start floor options are:
  - **Bottom (unidirectional)** = Start at the bottom floor and travel up, stopping at designated Sabbath floors until the top designated floor is reached. What happens next is determined by the Sabbath trip interval timer and Sabbath operation return floor parameters.
  - **Top (unidirectional)** = start at the top floor and travel down, stopping at designated Sabbath floors until the bottom designated floor is reached. What happens next is determined by the Sabbath trip interval timer and Sabbath operation return floor parameters.
  - **Current up (bidirectional)** = start at the current floor and travel up (unless down preference exists, in which case travel down), stopping at designated Sabbath floors until the top/bottom designated floor is reached. Then, if all designated floors have not been served at least once, reverse direction, stopping at designated floors until the bottom/top designated floor is reached. What happens next is determined by the Sabbath trip interval timer and Sabbath operation return floor parameters.
  - **Current down (bidirectional)** = start at the current floor and travel down (unless up preference exists, in which case travel up), stopping at designated Sabbath floors until the bottom/top designated floor is reached. Then, if all designated floors have not been serviced at least once, reverse direction, stopping at designated floors until the top/bottom designated floor is reached. What happens next is determined by the Sabbath trip interval timer and Sabbath operation return floor parameters.
- **Sabbath operation return floor**: The car shall travel to the return floor (if specified) after it has finished servicing all of the Sabbath floors (at least once). Select None or any floor.
• Sabbath trip interval timer: Specifies the interval between Sabbath operation trips. During the time between trips, the car operates in Passenger mode. A value of Non-stop = continuous Sabbath operation.

• Sabbath door open timer: Specifies the amount of time the doors shall remain open at each floor during Sabbath operation.

• Sabbath operation status LED: LED lights green when Sabbath operation is activated.

• Activate/Deactivate button: Sabbath operation can be activated/deactivated using this button. When Sabbath operation has been activated, the button caption changes to “Deactivate”. Sabbath operation can also be activated/deactivated via a key switch-input, iMonitor command or a timer.

• Sabbath Operation Floors: Specifies the floors (front, rear or both openings) that are to be serviced during Sabbath operation.
  • To add or remove the check mark in an individual cell, click the cell.
  • To add or remove check marks from a group of cells, click and drag to select the cells, then click Select or Deselect.
  • To add or remove check marks from a whole column, click the column label, then click Select or Deselect.
Car Operation - Shuttle Service

The Shuttle service option allows the car to be used to provide express service for a subset of the building's floors. Shuttle service is available only during Passenger mode and is turned On/Off via a key-switch/input or software command (Activate/Deactivate button). A key-switch/input may also be used to immediately override Shuttle service.

- **Enable shuttle service**: Indicates that the job has shuttle service and enables the shuttle service controls.
- **Enable shuttle hall call service**: Determines if hall call service is enabled while on Shuttle service.

**Car Call**

- **Dwell time**: Sets the door dwell time when the car is responding to a car call.
- **Canceled by** - Car call dwell time is canceled by any of the following that are checked.
  - **Door close button**: Activation of the door close button cancels car call dwell time.
  - **Car call button**: Activation of a car call button cancels car call dwell time.
  - **Photo eye**: Activation of the photo eye cancels car call dwell time.
Shuttle Service Status

- **Shuttle service status LED**: LED is lighted when Shuttle service is On.
- **Activate / Deactivate button**: Software command used to turn Shuttle service On or Off.

Shuttle Floors and Car Call Disposition

- **Cancel existing calls that are no longer eligible**: Specifies that any calls that become ineligible as a result of switching to the Shuttle Floors eligibility map will be canceled.
- **Use current eligibility**: If enabled, Shuttle service will use the car call eligibilities specified in the active car call configuration. Otherwise the “Shuttle Floors” map determines car call eligibilities during Shuttle service operation.
- **Shuttle Floors**: Allows the user to create an alternate car call eligibility map to be used during Shuttle service operation.

Home Floor Parking Permission

- **No park**: If no demand exists after the car completes a Shuttle service call, the car will remain at the floor.
- **Park - At floor**: If no demand exists after the car completes a Shuttle service call, the car will proceed to the specified floor and park.
- **Front / Rear door time**: Use the “Edit” button to display the “Door Timers” dialog and specify the door behavior to be used when the car parks. The options are:
  - Closed
  - Open
  - Open for X seconds.

**Home floor doors close when** When the car is parked at the home floor, the doors are closed when the conditions of any of the following (that are checked) are met.

- **Door Close Timer**: The doors are closed when the door close timer expires. The timer starts when the first car call is registered.
- **Number of registered car calls**: The doors are closed when the number of registered car calls reaches this value.
- **Door close button pressed**: If calls are registered, momentary activation of the door close button causes the doors to close.
- **Heavy load status reached**: The doors are closed when the car reaches heavy load status.
Car Operation - Heat Detectors

This screen contains parameters that determine how the car will behave when one or more of the heat detectors are activated. Heat detectors can be installed in the machine room, in the hoistway, and/or on individual floors in the building. They are connected to inputs on an ICE-MIAC board. Outputs from an ICE-MOR board are used to control audible and visual alarms and well as to signal when heat detectors recall is complete.

- When heat detectors are activated, the fire warning light will flash until all heat detectors have been reset. The fire-warning buzzer will sound until the car is shutdown at a floor. A car that is parked at a floor will open its doors and shut down. A car in motion will proceed in the current direction to the next available floor where the heat detector is not tripped. If all heat detectors in the current direction are tripped, the car will reverse direction and proceed to the first floor where the heat detector is not tripped. If again all heat detectors are tripped, the car will proceed to the main fire recall floor unless the car is also on Fire Service, in which case the car will proceed to the appropriate fire recall floor. Once the car is stopped at a floor it will automatically open its doors and shut down. Then, if the machine room or hoistway heat detectors are active, a signal is provided to disconnect the main power line and/or activate the sprinklers where available.

<table>
<thead>
<tr>
<th>Operational Status</th>
<th>Car Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heat Detectors</td>
<td></td>
</tr>
<tr>
<td>• Doors</td>
<td></td>
</tr>
<tr>
<td>• Devices</td>
<td></td>
</tr>
<tr>
<td>• Passenger</td>
<td></td>
</tr>
<tr>
<td>• Fire service</td>
<td></td>
</tr>
<tr>
<td>• Fire code</td>
<td></td>
</tr>
<tr>
<td>• Independent service</td>
<td></td>
</tr>
<tr>
<td>• Elevator recall</td>
<td></td>
</tr>
<tr>
<td>• Earthquake</td>
<td></td>
</tr>
<tr>
<td>• EMS</td>
<td></td>
</tr>
<tr>
<td>• Emergency power</td>
<td></td>
</tr>
<tr>
<td>• CFSS</td>
<td></td>
</tr>
<tr>
<td>• Flood operation</td>
<td></td>
</tr>
<tr>
<td>• Attendant service</td>
<td></td>
</tr>
<tr>
<td>• Auto stop</td>
<td></td>
</tr>
<tr>
<td>• Sabbath operation</td>
<td></td>
</tr>
<tr>
<td>• Shuttle Service</td>
<td></td>
</tr>
<tr>
<td>• Heat Detectors</td>
<td></td>
</tr>
</tbody>
</table>

- Heat detectors operation overrides fire recall operation: If checked, heat detectors operation will override fire recall operation even if fire recall is already in progress when the heat detector(s) are activated. If not checked, fire recall operation will take precedence unless heat detectors operation is already in progress or has completed and the car has been shut down when fire service is activated.
The Drive Configuration tab allows you to set and view user adjustable drive parameters.

Tabs are selectable for parameters including:

- General: Drive type, speed reference, system values, pre-start sequence (see page 9-90).
- Safety: Safety related settings (see page 9-92).
- Control: Not applicable to iControl AC.
- Filters: Filter frequency settings (see page 9-93).
- Dampening: Not applicable to iControl AC.
- Pre-Torque: Pre-torque settings where appropriate (see page 9-94).
- Calibration: Drive calibration procedure initiation (see page 9-95).
Drive - General Tab

Options  General drive setup:
• Drive type: Select the drive used in this controller.
• Drive interface: Select Analog or Serial.
• Motor blower hold delay: The motor blower is relay driven and shuts down when the motor stops. This timer allows you to delay blower shutdown so that the motor may receive additional cooling or so that the blower is not constantly power-cycled when the motor is stopping for only a brief period.

Pre-Start Sequence  These parameters define the conditions under which the machine may be energized and/or the brake lifted prior to the default “After doors are locked” state. Warning! Do not use Pre-Start Sequence options until drive control parameters have been adjusted for no rollback and good control at zero speed.
• Allow machine to be energized: Defines the state of the doors required before the machine is allowed to be energized:
  • After doors are locked: Doors must be locked before the machine may be energized (the motor is energized and brake is fully picked). Any soft lift brake adjustment is applied.
  • After door position monitor is activated: The door position monitor or doors locked sensors must be activated before the machine may be energized (the motor is energized and brake is fully picked). If this option is selected, but the job doesn’t have a door position monitor, the machine is energized when the doors are locked. Any soft lift brake adjustment is applied.
  • While door are closing: Doors must be closing, then the machine may be energized as follows:
    • with motor and fully picked brake: The motor is energized and the brake is fully picked. Any soft lift brake adjustment is applied.
    • with motor and partially picked brake: The motor is energized and brake is partially picked. The Speed pick delay 1 must expire and the doors must be locked before the brake is fully picked. After the brake is fully picked, Speed pick delay 2 must expire before the elevator is allowed to move. No soft lift brake adjustment is applied.
    • with motor only: The motor is energized after the prescribed delay from doors closing. After the doors lock, the brake is fully picked, and Speed pick delay 1 must expire before the elevator is allowed to move. Any soft pick brake adjustment is applied.
  • Pre-Start Sequence Delay: After the doors have begun to close, wait the specified time before energizing the machine as defined as defined in “While doors are closing”.

Note
Regardless of the selection above, the elevator is not allowed to move away from the landing until the doors are locked and the Speed pick delay 1 timer has elapsed.
Speed Reference  

More detailed settings related to the speed reference mechanism. Please refer to “Following Error Margin” on page 2-56.

- Reference type: Tachometer, Encoder, Internal or Serial.
- Resolution: This parameter affects elevator speed only for an encoder configuration. Increasing this parameter will increase car speed.
- Rotational coupling ratio: This parameter affects elevator speed only for an encoder configuration. Increasing this parameter will increase car speed. If the encoder is shaft mounted, this is normally set to 1. If the encoder is sheave or brake drum mounted, this value must be calculated:

\[
\text{Coupling Rotational Ratio} = \frac{\text{Motor Rated RPM} \times \text{Sheave (Brake) Diameter}}{\text{Encoder Follower Wheel Diameter}} \]

\text{OR}

\[
\text{Coupling Rotational Ratio} = \frac{\text{Brake Drum Circumference}}{\text{Encoder Follower Wheel Circumference}}
\]

- Rated motor RPM: This parameter affects elevator speed for an encoder or serial configuration. Increasing this parameter will increase car speed.
- Rotational direction: Sets the encoder pulse stream order recognized by the controller as indicating up or down travel. This parameter is used by all configurations except Internal.
- Scaling: This parameter affects elevator speed only for a tachometer configuration. Increasing this parameter will reduce car speed.
- Current safety calibration: Not applicable to iControl AC.
- Voltage safety calibration: Not applicable to iControl AC.

System

- Rated line voltage: Line voltage being supplied to the drive.
- Drive header voltage: Not applicable to iControl AC.
- Drive header current: Not applicable to iControl AC.
- Normal rate limited stop: Determines the deceleration from leveling/releveling to zero speed when the elevator stops normally at a floor. Please refer to “Final Adjustment Before Running at Contract Speed” on page 4-7.
- Emergency rate limited stop: Determines the deceleration from this speed at this instant to zero speed when the elevator makes an emergency stop.
Drive - Safety Tab

Speed Reference

- Following error: Adjusts amount of error permitted between voltage from Tach/Encoder and pattern voltage. When set to 75%, a 7.5VDC error is allowed between the Tach/Encoder and pattern voltages (100% = 10VDC). If excessive error is detected, a Tach Error Fault will be displayed. Please refer to “Following Error Margin” on page 2-56.
Drive - Filters Tab

System filters are used to smooth oscillation or resonance in a signal. Oscillation can almost always be corrected by adjusting the TORQMAX drive and should always be adjusted before filtering defaults are changed. The notch filter is used to block a specific, fixed/narrow frequency oscillation, induced by the mechanical system and reflected in the speed feedback signal.

System filters are used to smooth oscillation or resonance in a signal. Oscillation can almost always be corrected by adjusting the TORQMAX drive and should always be adjusted before filtering defaults are changed. The notch filter is used to block a specific, fixed/narrow frequency oscillation, induced by the mechanical system and reflected in the speed feedback signal.

Caution
Incorrect filter settings may result in oscillation (not enough high frequency filtering) or in unresponsive, erratic control of car speed (too much high frequency filtering). Consult MCE Technical Support if you are not familiar with adjusting filters. Always work with TORQMAX drive before changing filter default settings.

System

Speed loop filtering.

- Raw pattern frequency: Applies smoothing to the raw pattern frequency. Higher settings provide better response but may result in uneven (bumpy) acceleration/deceleration.
- Flare pattern frequency: Applies smoothing to the flare pattern frequency. Higher settings provide better response but may result in uneven (bumpy) acceleration/deceleration.
- Processed pattern frequency: Applies smoothing to the post-processing pattern signal. Higher settings provide better response but may result in uneven (bumpy) acceleration/deceleration.
- Speed reference frequency: Smooths the Tach/Encoder signal. Typical recommended range is from 50 to 75 Hz. Higher values provide less smoothing.
Control

Both isolated platform and strain gauge load weighing devices are supported. Please refer to “Pre-torque Adjustments” on page 4-16.

- Pretorque option: The following Pretorque options are available:
  - No Pretorque: Pretorque is disabled.
  - Synthetic pretorque: Pretorque is enabled with a fixed load value which is equal to a Pretorque balance adjustment value of four (4). When a load weigher is not available, this option can be used to improve initial start by helping to hold the car at zero speed when the brake is first lifted. Adjust the Pretorque balance adjustment up or down from four (4) to get positive or negative pretorque, and adjust the Pretorque position compensation and Pretorque gain as desired.
  - Load weigher pretorque: Pretorque is enabled. The load value is supplied by an analog load weigher.
  - Pretorque position compensation: Controls the pretorque output voltage based on car position in the hoistway.
  - Pretorque gain: Controls the amount of output voltage from the pre-torque function. Increase to increase voltage at takeoff and compensate for any rollback at the start of a run.
  - Pretorque balance adjustment: Adjust to ensure no rollback of a balanced car at the top of the hoistway.
Offsets
For various functions the iBox converts voltages from analog to digital or from digital to analog. ADC and DAC adjustments allow you to compensate for any conversion offset that might occur.

- Output DAC: Compensates for slight differences that might exist between zero speed commanded by the pattern and 0.0 volts appearing between the iBox and the drive input.
- Input ADC: Compensates for slight differences that might exist between the analog input voltage and the resulting value after the iBox converts that value to a digital equivalent for internal processing. The Input ADC offset values are determined when the drive setup procedure is performed. Please refer to “Drive Offsets Calibration” on page 2-46.
Configuration - Floor Heights

The Configuration > Floor Heights > Configurations tab is used to view the learned values for the floor heights.

- **Level Up Top**: The learned distance from the bottom floor to the top of the floor magnet as determined by the Level Up sensor.
- **Level Up Bottom**: The learned distance from the bottom floor to the bottom of the floor magnet as determined by the Level Up sensor.
- **Level Down Top**: The learned distance from the bottom floor to the top of the floor magnet determined by the Level Down sensor.
- **Level Down Bottom**: The learned distance from the bottom floor to the bottom of the floor magnet determined by the Level Down sensor.

**Floor Offsets Tab**

- **Offsets**: The variance from the floor magnet position to the actual floor level position. The offset value is determined by performing the floor offset calibration procedure (Setup > Floor Heights > Floor Offsets). Please refer to “Calibrating the Floor Offsets” on page 4-22.
Configuration - General

The Configuration > General tab supports general building parameters. The tabs include:

- General: Car label, Car identifier and Simplex car parameters.
- Floor Data: Floor specific data including openings, false floors, door boost (see page 9-98).
- Car Call Eligibility: Car call permission/restriction for each opening (see page 9-99).

General Tab

- Car label: Assigned by building management.
- Car identifier: Used by the iCUE Central or Local Dispatcher for communication with the car in group systems. Set from 1 to 20.
  **Caution!** The car identifier must be unique for every car within a group of elevators (no to cars assigned the same car identifier).
- Group identifier: The Group ID (1) cannot be changed. All other IDs are reserved for future use. If you need advanced System addressing information please contact MCE.
- Simplex car: This car is not part of a group.
General - Floor Data Tab

Floor data settings provide information about floor openings, floor labels, and door boost.

Note

Rather than proceeding floor-by-floor, column-by-column, you may choose to select a column head or multiple cells and use the “system wide” Select/Deselect controls to set all floors the same for that topic (where appropriate). You can also move from field to field using the Tab key.

Floor Data Settings

For each floor:

- Floor: This is the floor number.
- Floor label: (Read only) The floor label is set on the System > Building tab.
- False Floor: Indicate whether or not this is a false floor (no openings).
- Front/Rear Opening: Indicate whether the car has front and/or rear opening doors. A check mark indicates the opening is available.
- Door Boost Front/Rear: Enable/Disable Door Boost to compensate for heavy doors or wind loading at a particular location.
General - Car Call Eligibility Tab

This tab allows you to create up to eight car call eligibility configurations. Each configuration, when active, determines whether car calls can be registered at any given side of an eligible floor. If no side is selected, car calls for that floor are disabled.

Any of the eight car call eligibility configurations may be manually selected as the “Active configuration” via its respective key-switch input or by selecting it using the software Configuration Settings on this screen. The Passenger service configuration setting is the software selection for all modes of operation except when the car is operating in one of the other modes listed under Configuration Settings, e.g. Independent or Attendant service. A key-switch selection overrides a software selection.
Eligibility  The table displays the current eligibility settings for the eligibility configuration selected by the Select configuration control.

- **Select configuration**: Select a configuration (1 through 8) to edit. As soon as a configuration is selected, the Eligibility table will update to show the current settings for that configuration.

- **Cancel existing car calls that are no longer eligible**: For the configuration selected, enable this setting if existing car calls that would become ineligible when this configuration is made active, should be immediately canceled. If this option is not enabled, existing car calls will be serviced.

**To configure an eligibility configuration**:

1. Select the desired configuration. Note that the table updates accordingly.
2. On a per-floor basis, enable (check) or disable (no check) front and/or rear car calls to that floor.
3. When the configuration is complete, click Send to store the changes on the iControl.

System wide operations: For high- or mid-rise buildings, use the system wide controls to speed the configuration process:

1. Click on the Front or Rear column header.
2. Click Select or Deselect.

Alternatively, you may drag through a number of floors below the column header, then use the Select or Deselect control to set all highlighted floors.

**Note**

The “existence” of front and/or rear openings is determined by your selections on the preceding, Floor Data tab. If an opening is not recognized to exist, it will not be selectable.
Configuration Settings These controls allow you to select the active or default car call eligibility configuration and to select the same configuration or any of the other configurations to be active if one of the following special operating modes is activated.

<table>
<thead>
<tr>
<th>Configuration Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active configuration</strong></td>
</tr>
<tr>
<td><strong>Passenger service</strong></td>
</tr>
<tr>
<td><strong>Independent service</strong></td>
</tr>
<tr>
<td><strong>Attendant service</strong></td>
</tr>
<tr>
<td><strong>CFSS 1 service</strong></td>
</tr>
<tr>
<td><strong>CFSS 2 service</strong></td>
</tr>
<tr>
<td><strong>Swing operation</strong></td>
</tr>
</tbody>
</table>

- **Active configuration**: Indicates which car call eligibility configuration is currently active.
- **Passenger service**: This is the car call eligibility configuration which will be used when the car is on Passenger service or any mode of operation other than the ones listed below, e.g. Independent service, Attendant service, etc. Make any car call eligibility configuration active by selecting it here and clicking Send. (The active configuration display will update unless the car is on one of the modes of operation listed below.)
- **Independent service**: If the car should enter Independent service, the car call eligibility set selected here will be in control.
- **Attendant service**: If the car should enter Attendant service, the car call eligibility set selected here will be in control.
- **CFSS1 service**: If the car should enter Commandeer For Special Service (mode 1), the car call eligibility set selected here will be in control.
- **CFSS2 service**: If the car should enter Commandeer For Special Service (mode 2), the car call eligibility set selected here will be in control.
- **Swing operation**: If the car should enter Swing operation, the car call eligibility set selected here will be in control.

**Sequential step scan car calls** This option allows compliance with the ICC/ANSI A117.1-2003 requirement to accommodate passengers who are short or are using a wheel chair in buildings where the car control buttons are more than 48 inches above the floor. Scan Up and Scan Down buttons are used. When “Scan Up” is pressed, the car call buttons above the current floor are scanned. When “Scan Down” is pressed, the car call buttons below the current floor are scanned. When the button is released for more than 2 seconds, a call is registered for the last floor selected. This option is enabled when the Sequential Step Scan inputs are programmed (see “Configuration - I/O Boards” on page 9-102).

- Front inputs scan front and rear car call buttons: This option allows a single Scan Up and Scan Down button to be used to scan both front and rear car call buttons.
The input/output structure of your system was collected during the MCE field survey. This controller and cartop box are structured as shown in your job prints to reflect survey information. By incorrectly assigning inputs and/or outputs, you may disable parts of your system. Be certain that you understand what changes need to be made before beginning. Contact MCE Technical Support for information. IN NORMAL INSTALLATIONS, YOU WILL NOT NEED TO ASSIGN INPUTS AND OUTPUTS. THEY WILL ALREADY BE ASSIGNED AS SHOWN ON YOUR JOB PRINTS.

The circuit board complement of the iController (IMP), iLink (CTP) and Serial Car Operating Panel (COP 1 - 4)) can be changed if required. When boards are added or connections are changed, this tab allows you to reassign inputs and outputs accordingly.

**IMP / CTP** In the window shown below (Configuration > I/O Boards > Configuration tab), a Multiple Input AC (ICE-MIAC) board connected to the iBox Main Processor (ICE-IMP) board is selected for editing. When the edit button is clicked, the Terminal Configuration (IMP - MIAC) dialog, shown on the following page, is displayed.
Using the I/O Board Configuration Tab  

This tab is used to program I/O Board inputs and outputs, should you desire to make changes.

To add a board:

1. Select IMP / CTP or COP 1 - 4. **Note:** COP4 is not available on Cartop software version 1.1.15 of greater.
2. Locate the board in the *Boards* box on the right of the Configuration tab.
3. Drag the board into the ICE-IMP (iControl), ICE-CTP (iLink cartop box) or COP 1 - 4 (Car Operating Panel) enclosure as appropriate. Release the mouse button.
4. To rearrange a board along the bus representation, highlight it and click on the associated up/down controls. The board will move accordingly.
5. To remove a board, select and click Delete.

To change the input or output to/from a board connection:

1. Click to select the desired board and click Edit.
2. Select a signal group from the drop down list in the Signals box.
3. Select a signal from the list and drag it to the desired pin in the Terminals box.
4. To remove a signal from a pin, drag it into the trash or right click and then click Remove signal. To remove all signal assignments, click the *Clear all* button.
5. Click OK to approve your configuration.
6. Click Send to send your changes to the controller.
7. Or, click Cancel to close the dialog without saving any changes.

Each input or output may be assigned to only a single terminal.

Terminal Configuration (IMP - MIAC)
**I/O Assert**  
The I/O Assert feature allows the user to bypass the current state of a terminal on an IO board and assert a desired state (on or off) via iView. This can be used for troubleshooting and/or testing. Currently this feature is available for ICE-MIAC Multiple Input AC boards, ICE-MOR Multiple Output Relay boards and ICE-COP Serial Car Operating Panel boards both in the iController (connected to the ICE-IMP board) and on the cartop (connected to the ICE-CTP board.

**To use IO Assertion:**

1. Acquire write privilege (select Acquire from the iView Write privilege menu).
2. Set the iBox FAULT/FUNCTION BYPASS switch to ON.
3. Click the Assert Session **Start** button (Configuration > I/O Boards > Configuration tab). The assert session begins and a 15 minute timer begins counting down the time remaining for this session.
4. Select an I/O board (Configuration > I/O Board > Configuration tab) and click View. Notice that the state for all terminals, shown in the drop down list next to the indicator LED, is *Pass*, meaning that the current (default) state of the terminals is *not bypassed*.

**Terminal Output dialog (view terminal status and set I/O assertions)**
5. For the desired terminal, select On or Off from the drop down list next to the indicator LED to bypass the current state and assert the desired state.
6. You may set the state for additional terminals on this board or select a different board on which to set terminal assertions.
7. The Assert Session will end when one of the following occurs; the timer elapses, the FAULT/FUNCTION BYPASS switch is set to OFF or the Assert Session Cancel button is clicked. When the session has ended, all I/O are returned to the default Pass state.

**Serial COPs - COP1 thru COP4** In the window shown below, a Serial Car Operating Panel (ICE-COP) board is selected for editing. **Note:** COP4 is not available on Cartop software version 1.1.15 of greater.

- **Edit button:** When the edit button is clicked, the Terminal Configuration (CTP - SERIAL COP) dialog is displayed (see page 9-106).
- **View button:** Use this button to view the current state (On or Off) of the inputs and outputs and to assert a specific state (see “I/O Assert” on page 9-104).
- **Reset COP button:** This button causes the processor on the ICE-COP board to reset.
The method of assigning inputs and outputs to terminals is the same for Serial COP boards as for Multiple Input AC (MIAC) and Multiple Output Relay (MOR) boards. Select a particular signal from the column and drag it to the desired connector pin box. Except for car call button inputs and lamp outputs (shown below), each input or output may be assigned to only a single terminal on the Serial COP boards.

**Terminal Configuration (CTP - SERIAL COP)**

![Terminal Configuration (CTP - SERIAL COP)](image-url)

**Caution**

The Terminal Configuration dialog reassigns the signal assignments to circuit board pins in controller SOFTWARE. You must also make the correct hard connections to avoid damage or incorrect operation.
I/O Board - Configurable outputs

The controls on the Configurable outputs tab are typically used for freight doors. They specify that the listed door outputs shall be disabled under certain conditions, e.g., Inspection operation, Fire service, etc.

- **Disable Door Enable Output**: A check specifies that the Door Enable Output is to be disabled under the selected condition(s).
- **Disable Hall Door Button Output**: A check specifies that the Hall Doors Button Output is to be disabled under the selected condition(s).
- **Disable Automatic Closing Output**: A check specifies that the Hall Doors Button Output is to be disabled under the selected condition(s).
- **Toggle Output**: The Toggle Output (MOR board > Custom Outputs signal) can be used to convert a steady state Custom Output to a toggled output. Use this control to Enable the Toggle Output and to set the On time and Off time of the toggle.
Input Signal Groups

The following signal groups can be programmed on the ICE-MIAC or ICE-COP boards. Depending upon options and configuration, your system may not have all available signals. Refer to your job prints for active signal level and specific connection information.

- Elevator
  - Alarm Button: Input, usually from a button, that initiates and latches the emergency alarm.
  - Alarm Reset: Input to reset the car alarm.
  - Alternate Fire Switch ON: This fire service switch input shall be seen as second priority to the main switch input but will override the sensor inputs. When ON, the car will return to the alternate fire floor landing.
  - Alternate Floor Smoke: Input from the smoke sensors located at the alternate recall floor. Activation of these sensors will initiate recall to the main recall floor.
  - Alternate Speed Profile 1: Input, usually from a keyed switch, that selects the Alternate 1 pattern profile (Configuration > Pattern > Modes tab) for elevator operation. Please refer to “Pattern - Modes Tab” on page 9-134.
  - Alternate Speed Profile 2: Input, usually from a keyed switch, that selects the Alternate 2 pattern profile (Configuration > Pattern > Modes tab) for elevator operation.
  - Attendant Service: Input, from a key switch, that places the car in Attendant Service operating mode and recalls it to the activating floor. Uses normal operation door parameters and normal performance pattern. Has car call restrictions according to the car call eligibility set selected on the Configuration > General > Car call eligibility tab.
  - Attendant Service Down: Input from a key switch usually located in the car operating panel used to move the car in the down direction while on Attendant Service.
  - Attendant Service Non-Stop: Input from a key-switch usually located in the car operating panel used to bypass hall calls while on Attendant Service.
  - Attendant Service Up: Input from a key switch usually located in the car operating panel used to move the car in the up direction while on Attendant Service.
  - Automatic Stop Input: Input that, when active, will cause the car to stop at a selected floor and cycle its doors for observation before continuing to the destination. Floor and other attributes are selected on the Configuration > Car Operation > Auto stop tab.
  - Backup power recall: Input from the backup power unit used to initiate backup power recall.
  - Backup power recall reverse direction: Input from the backup power unit indicating that direction should be reversed during backup power recall.
  - Backup power unit failure: Input from the backup power unit indicating a failure.
  - Cancel In-Car CFSS Mode 1: Input from an in-car CFSS Mode 1 cancel switch. Activation of this input cancels the “Resume normal service” timer when “In-car switch to activate CFSS” is set to “No switch”, see “In-car” on page 9-77
  - Cancel In-Car CFSS Mode 2: Input from an in-car CFSS Mode 2 cancel switch (see Cancel In-Car CFSS Mode 1 above).
  - Capture Input: Discrete input used to activate Capture Mode, similar to the iBox Capture switch, see Capture on page 9-5.
Input Signal Groups

- Car Call Cancel Button: Car operating panel button input to cancel all car calls currently registered on that panel.
- Car Call Enable 1 Override input: Input that allows Car Call Enable Operation 1 to be overridden, setting car call eligibility to the currently active configuration.
- Car Call Enable 2 Override input: Input that allows Car Call Enable Operation 2 to be overridden, setting car call eligibility to the currently active configuration.
- Car Not Empty Sensor Input: Input from a sensor that detects the presence of passengers in the car. Used with the CFSS “Recall empty car” feature to determine when the car is empty (see “Car Operation - CFSS Tab” on page 9-75).
- CC Eligibility Config (1 through 8): One of eight inputs used to manually select a particular car call eligibility configuration configured on the General > Car call eligibility tab. If more than one input is active, the lower-numbered input will have control. Please refer to “General - Car Call Eligibility Tab” on page 9-99.
- CFSS In Car Switch 1: Input from an in-car switch that initiates in-car Commandeer For Special Services mode 1 as specified on the Configuration > Car Operation > CFSS tab. Please refer to “Car Operation - CFSS Tab” on page 9-75.
- CFSS In Car Switch 2: Input from an in-car switch that initiates in-car Commandeer For Special Services mode 2 as specified on the Configuration > Car Operation > CFSS tab.
- Emerg. Pwr. Auto Car Select: Input from a key switch, if so set by the user, may be required before the car is automatically selected to run on emergency power. Conditions that affect this operation are specified on the Configuration > Car Operation > Emergency power tab. Please refer to “Car Operation - Emergency Power Tab” on page 9-72.
- Emerg. Pwr. Auto Recall: Input from a key switch, if so set by the user, may be required before the car will recall on emergency power. Conditions that affect this operation are specified on the Configuration > Car Operation > Emergency power tab.
- Emerg. Pwr. Manual Car Select: Input from a key switch used to manually select the car to run on emergency power.
- Emergency Dispatch: Input from a key switch used to force the car to automatically service the building in a pre-defined pattern, cycling the doors when stopping at floors.
- Emergency Dispatch Override: Input from a key switch used to override Emergency Dispatch operation usually manually invoked via the Emergency Dispatch key switch or automatically upon detection of a failure of the hall call bus.
- Emergency Power: Input from a contact closure that indicates whether the system is running on commercial or generator power. Emergency power operation proceeds first in a recall phase, where cars are recalled to a floor and then in a Run phase where one or more cars are selected to run under the emergency power generator using the emergency power performance pattern.
- Emergency Power Manual Override: Input from a key switch or contact closure used to bypass the emergency power recall operation.
- Emergency Power Permission to Run: Input from a contact closure that allows the car to run under the emergency power generator.
- Emergency Power Return: Input from a contact closure that initiates emergency power recall.
• Emergency Stop Input: When this input is activated, the car makes an emergency stop and all calls are canceled. This input has priority over all modes of operation including Fire Service.
• EMS Car Switch: Input from a key switch located inside the car that initiates in-car Emergency Medical Service operation (also referred to as EMS Phase II) allowing the car to be dispatched to a selected floor.
• EMS Hall Switch 1: Input from a key switch used to initiate EMS service 1 recall operation, immediately recalling the car to the specified floor and positioning the doors as selected (Configuration > Car Operation > EMS tab). Please refer to “Car Operation - EMS Tab” on page 9-68.
• EMS Hall Switch 2: Input from a key switch used to initiate EMS service 2 recall operation, immediately recalling the car to the specified floor and positioning the doors as selected (Configuration > Car Operation > EMS tab).
• Empty load input: Input from a load weigher discrete output. Used with the CFSS “Recall empty car” feature to determine when the car is empty (see “Car Operation - CFSS Tab” on page 9-75).
• Fire Phase II Call Cancel Switch: Input from a button on the car operating panel that allows car calls to be cancelled during in-car Firefighter Service.
• Fire Phase II Switch HOLD: Input from a keyed switch in the car that allows firefighters to “hold” the car at a particular floor, disabling the car call buttons while the hold switch is active. Conditions under which the car may be placed on Hold or removed from Hold and how the doors behave while on Hold are determined on the Configuration > Car Operation > Fire Service > Fire Code tabs.
• Fire Phase II Switch OFF: Input from a keyed switch in the car that terminates in-car Firefighter service if appropriate (as specified per code).
• Flood Operation Input: Input that, when active, will cause the car to enter Floor operation mode. Flood operation attributes are selected on the Configuration > Car Operation > Flood operation tab.
• Flood Override Input: When this input is activated, the Flood Operation input is ignored and, if already activated, Flood Operation is canceled.
• Hall Call Bypass Input: Discrete input used to bypass hall calls. Hall calls remain registered until answered. The car is also not eligible for parking.
• Heavy Load Input: Input from a discrete load weigher heavy load output.
• Independent Service: Input, from a key switch, that places the car in Independent Operating mode. Independent Operating mode has unique door operating parameters (Configuration > Car Operation > Independent Service), uses the normal performance pattern, and has car call restrictions according to the car call eligibility set selected on the Configuration > General > Call Eligibility tab. Please refer to “General - Car Call Eligibility Tab” on page 9-99.

• Light Load Input: Input from a discrete load weigher light load output.

• Main Floor Smoke: Input from the smoke sensors located at the main recall floor. Activation of these sensors will initiate recall to the alternate recall floor.

• Other Cars Alternate: Input from other car (in the same system) smoke sensors located in the hoistway or machine room if the machine room is located at the main recall floor. Activation of these sensors will initiate recall to the alternate recall floor.

• Other Cars Main: Input from other car (in same system) smoke sensors located in the hoistway or machine room if the machine room is located at any floor other than the main recall floor. Activation of these sensors will initiate recall to the main recall floor.

• Over Load Input: Input from a discrete load weigher over load output.

• Passing Floor Gong Enabled: Input, from a key switch, that enables the audible passing floor gong in the elevator car.

• Power Transfer: Input from a key switch or contact closure used to force the car to stop at the next available floor and open its doors. This input is usually used right before power is transferred from the emergency power generator to commercial power.

• Primary Fire Switch BYPASS: Input from a keyed switch in the building lobby, that allows a Fire Phase I initiating device (smoke detector, fire alarm, etc.) to be bypassed or unlatched as specified per code.

• Primary Fire Switch OFF: Input from a keyed switch in the building lobby, that terminates Fire Phase I if appropriate (as specified per code).

• Primary Fire Switch ON: Input from a keyed switch in the building lobby, that initiates Fire Phase I and recalls the car to the main fire recall floor. Recall particulars are fire code specific. Code is selected on the Configuration > Car Operation > Fire Service tab and particulars may be modified on the Fire code tabs.

• Recall Switch “x”: (x = 1 - 6): One of six switches that places a car in Recall mode, recalling it to an assigned floor. Switch priority, door operation, car call disposition, and more are configured on the Configuration > Car Operation > Elevator recall tab. Please refer to “Car Operation - Elevator Recall Tab” on page 9-63

• Recall Switch “x” Unlatch: (x = 1 - 6) A car that has been or is being recalled after momentary activation of the elevator recall switch shall immediately resume normal operation when this input is activated (regardless of the value of the “Resume normal operation after --- sec” timer).

• Sabbath Operation Switch: Input from a key switch used to force the car to automatically service the building based on the selected floor eligibility so that the passengers can travel from floor to floor without having to press any buttons.

• Sabbath Override Input: When this input is activated, the Sabbath Operation Switch input is ignored and, if already activated, Sabbath Operation is cancelled.

• Secondary Fire Switch ON: Input from a keyed switch in a different location than the Primary Fire Switch, that initiates Fire Phase I and recalls the car to the alternate fire recall floor. Recall particulars are fire code specific.
• Shuttle Service: Input from a key switch used to turn Shuttle service On and Off.
• Shuttle Service Override: Input from a key switch used to override Shuttle service.
• Swing Automatic Operation: When activated, the car will automatically enter Swing operation when a hall call is received from the Swing riser. Automatic Swing operation assumes an “always active” Swing riser.
• Swing Operation Switch: Input from a key switch used to take the car out of group dispatching operation allowing it to service a dedicated hall call riser and perform its own parking, hall call service and security based on the System parameters programmed and stored on the Swing car’s iBox (see “Automatic Swing Operation” on page 9-41)
• This Car Alternate: Input from the smoke sensors located in the hoistway or machine room if the machine room is located at the main recall floor and if the car has any equipment in that hoistway or machine room. Activation of sensors will initiate recall to the alternate recall floor and cause the fire warning indicator in the car to flash.
• This Car Main: Input from the smoke sensors located in the hoistway or machine room if the machine room is at any floor other than the main recall floor and if the car has any equipment in that hoistway or machine room. Activation of sensors will initiate recall to the main recall floor and cause the fire warning indicator in the car to flash.

• Front Door
  • Disable Front Hall Door Buttons: Input used to disable the front hall door buttons.
  • Front COP2 Door Close Button: Input from the front auxiliary door close button:
  • Front COP2 Door Hold Button: Input from the front auxiliary door hold button.
  • Front COP2 Door Open Button: Input from the front auxiliary door open button.
  • Front COP2 Door Stop Button: Input from the front auxiliary door stop button (active low).
  • Front Constant Pressure Close: Activation overrides front door close software settings.
  • Front Constant Pressure Open: Activation overrides front door open software settings.
  • Front Door Close Button (COP1): Input from the front main door close button.
  • Front Door Hold Button (COP1): Input from the front main door hold button.
  • Front Door Open Button (COP1): Input from the front main door open button.
  • Front Door Stop Button (COP1): Input from front main door stop button (active low).
  • Front Hall Door Close Button: Input from a front hall door close button.
  • Front Hall Door Hold Button: Input from a front hall door hold button.
  • Front Hall Door Open Button: Input from a front hall door open button.
  • Front Hall Door Stop Button: Input from a front hall door stop button (active low).
  • Front Momentary Pressure Close: Overrides front door close software setting.
  • Front Momentary Pressure Open: Overrides front door open software setting.
  • Front Photo Eye Cut Out: Input from a front key switch - disables photo eye operation.

• Rear Door
  • Disable Rear Hall Door Buttons: Input used to disable the rear hall door buttons.
  • Rear COP2 Door Close Button: Input from the rear auxiliary door close button:
  • Rear COP2 Door Hold Button: Input from the rear auxiliary door hold button.
• Rear COP2 Door Open Button: Input from the rear auxiliary door open button.
• Rear COP2 Door Stop Button: Input from the rear auxiliary door stop button (active low).
• Rear Constant Pressure Close: Activation overrides rear door close software settings.
• Rear Constant Pressure Open: Activation overrides rear door open software settings.
• Rear Door Close Button (COP1): Input from the rear main door close button.
• Rear Door Close Limit: Input from rear Door Close Limit switch.
• Rear Door Hold Button (COP1): Input from the rear main door hold button.
• Rear Door Open Button (COP1): Input from the rear main door open button.
• Rear Door Open Limit: Input from rear Door Open Limit switch.
• Rear Door Photo Eye: Input from rear door photo eye.
• Rear door safe edge: Input from rear door safe edge.
• Rear Door Stop Button (COP1): Input from rear main door stop button (active low).
• Rear Hall Door Close Button: Input from a rear hall door close button.
• Rear Hall Door Hold Button: Input from a rear hall door hold button.
• Rear Hall Door Open Button: Input from a rear hall door open button.
• Rear Hall Door Stop Button: Input from a rear hall door stop button (active low).
• Rear Momentary Pressure Close: Activation overrides rear door close software setting.
• Rear Momentary Pressure Open: Activation overrides rear door open software setting.
• Rear Photo Eye Cut Out: Input from the rear key switch that disables rear door photo eye operation.

• Car Calls - Front COP1:
  • Car Call - Front COP1 button, Floor 1 —150: Inputs from front car call buttons for non-serial, front, car operating panel 1.
  • Sequential Step Scan Up Front COP 1: Sequential step scan car calls option input.
  • Sequential Step Scan Down Front COP1: Sequential step scan car calls option input.
  • Disable Front COP 1: Input used to disable the front car call and door buttons of the main Car Operating Panel.

• Car Calls - Rear COP1
  • Car Call - Rear COP 1 button, Floor 1 —150: Inputs from rear car call buttons for non-serial, rear, car operating panel 1.
  • Sequential Step Scan Up Rear COP 1: Sequential step scan car calls option input.
  • Sequential Step Scan Down Rear COP1: Sequential step scan car calls option input.
  • Disable Rear COP 1: Input used to disable the rear car call and door buttons of the main Car Operating Panel.

• Car Calls - Front COP2
  • Car Call - Front COP 2 button, Floor 1 —150: Inputs from front car call buttons for non-serial, front, car operating panel 2.
  • Sequential Step Scan Up Front COP 2: Sequential step scan car calls option input.
  • Sequential Step Scan Down Front COP2: Sequential step scan car calls option input.
• Disable Front COP 2: Input used to disable the front car call and door buttons of the auxiliary Car Operating Panel.

• Car Calls - Rear COP2
  • Car Call - Rear COP 2 button, Floor 1 —150: Inputs from rear car call buttons for non-serial, rear, car operating panel 2.
  • Sequential Step Scan Up Rear COP 2: Sequential step scan car calls option input.
  • Sequential Step Scan Down Rear COP2: Sequential step scan car calls option input.
  • Disable Rear COP 2: Input used to disable the rear car call and door buttons of the auxiliary Car Operating Panel

• Car Call Enable 1 - Front
  • Car Call Enable 1 - Front, Floor 1 —150: Per floor, non-serial inputs from car call enable 1 - front door device (card reader or keypad, etc.).

• Car Call Enable 1 - Rear
  • Car Call Enable 1 - Rear, Floor 1 —150: Per floor, non-serial inputs from car call enable 1 - rear door device (card reader or keypad, etc.).

• Car Call Enable 2 - Front
  • Car Call Enable 2 - Front, Floor 1 —150: Per floor, non-serial inputs from car call enable 2 - front door device (card reader or keypad, etc.).

• Car Call Enable 2 - Rear
  • Car Call Enable 2 - Rear, Floor 1 —150: Per floor, non-serial inputs from car call enable 2 - rear door device (card reader or keypad, etc.).

• Motor and Drive
  • Governor Speed Reduction Switch: Input from Governor Speed Reduction Switch.
  • Sheave Brake Monitor: Input from the sheave brake monitor.
  • Brake Switch: This input can be used in place of input SP2D. The “Switch” parameters on the Controller > Configuration > Brake > Control tab determine the state of the input (high or low) that indicates the brake is picked.

• System Configurations (Simplex)
  • Hall Call Eligibility Config (1 - 8): Activation of a Hall Call Eligibility Configuration (1 - 8) input causes the respective configuration to be the active configuration.
  • Parking Config (1 - 8): Activation of a Parking Configuration (1 - 8) input causes the respective configuration to be the active configuration.
  • Parking Eligibility Config (1 - 8): Activation of a Parking Eligibility Configuration (1 - 8) input causes the respective configuration to be the active configuration.
  • Mode of Operation Config (1 - 8): Activation of a Mode of Operation Configuration (1 - 8) input causes the respective configuration to be the active configuration.
  • Security Config (1 - 8): Activation of a Security Configuration (1 - 8) input causes the respective configuration to be the active configuration.
  • Master Security Override input: Activation of this input overrides all elevator security.

• Hall Call Security 1 Override input: Activation of this input overrides Hall Call Security 1 security.
• Hall Call Security 2 Override input: Activation of this input overrides Hall Call Security 2 security.

• Hall Calls - Aux Front Down
  • Hall Call - Aux Front Down Button (1 - 150): Non-serial inputs from front aux down hall call buttons.

• Hall Calls - Aux Rear Down
  • Hall Calls - Aux Rear Down Button (1 - 150): Non-serial inputs from rear aux down hall call buttons.

• Hall Calls - Main Front Down
  • Hall Calls - Main Front Down Button (1 - 150): Non-serial inputs from front main down hall call buttons.

• Hall Calls - Main Rear Down
  • Hall Calls - Main Rear Down Button (1 - 150): Non-serial inputs from rear main down hall call buttons.

• Hall Calls - Aux Front Up
  • Hall Calls - Aux Front Up Button (1 - 150): Non-serial inputs from front aux up hall call buttons.

• Hall Calls - Aux Rear Up
  • Hall Calls - Aux Rear Up Button (1 - 150): Non-serial inputs from rear aux up hall call buttons.

• Hall Calls - Main Front Up
  • Hall Calls - Main Front Up Button (1 - 150): Non-serial inputs from front main up hall call buttons.

• Hall Calls - Main Rear Up
  • Hall Calls - Main Rear Up Button (1 - 150): Non-serial inputs from rear main up hall call buttons.

• CFSS Calls - CFSS 1 Front
  • CFSS Call - CFSS 1 Front Input (1 - 150): Non-serial inputs from CFSS 1 front call switches.

• CFSS Calls - CFSS 1 Rear
  • CFSS Call - CFSS 1 Rear Input (1 - 150): Non-serial inputs from CFSS 1 rear call switches.

• CFSS Calls - CFSS 2 Front
  • CFSS Call - CFSS 2 Front Input (1 - 150): Non-serial inputs from CFSS 2 front call switches.

• CFSS Calls - CFSS 2 Rear
  • CFSS Call - CFSS 2 Rear Input (1 - 150): Non-serial inputs from CFSS 2 rear call switches.

• Hall Call Enable 1 (2) - Floor
  • Hall Call Enable 1 (2) - Floor (1 - 150): Non-serial floor inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).

• Hall Call Enable 1 (2) - Front
• Hall Call Enable 1 (2) - Front, Floor (1 - 150): Non-serial front inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).
• Hall Call Enable 1 (2) - Rear
  • Hall Call Enable 1 (2) - Rear, Floor (1 - 150): Non-serial rear inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).
• Hall Call Enable 1 (2) - Main Front
  • Hall Call Enable 1 (2) - Main Front, Floor (1 - 150): Non-serial main front inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).
• Hall Call Enable 1 (2) - Main Rear
  • Hall Call Enable 1 (2) - Main Rear, Floor (1 - 150): Non-serial main rear inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).
• Hall Call Enable 1 (2) - Aux Front
  • Hall Call Enable 1 (2) - Aux Front, Floor (1 - 150): Non-serial aux front inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).
• Hall Call Enable 1 (2) - Aux Rear
  • Hall Call Enable 1 (2) - Aux Rear, Floor (1 - 150): Non-serial aux rear inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).
• Hall Call Enable 1 (2) - Aux Front Down
  • Hall Call Enable 1 (2) - Down Aux Front, Floor (1 - 150): Non-serial down aux front inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).
• Hall Call Enable 1 (2) - Aux Rear Down
  • Hall Call Enable 1 (2) - Down Aux Rear, Floor (1 - 150): Non-serial down aux rear inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).
• Hall Call Enable 1 (2) - Aux Rear Up
  • Hall Call Enable 1 (2) - Up Aux Rear, Floor (1 - 150): Non-serial up aux rear inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).
• Hall Call Enable 1 (2) - Main Front Down
  • Hall Call Enable 1 (2) - Down Main Front, Floor (1 - 150): Non-serial down main front inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).
• Hall Call Enable 1 (2) - Main Rear Down
  • Hall Call Enable 1 (2) - Down Main Rear, Floor (1 - 150): Non-serial down main rear inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).
• Hall Call Enable 1 (2) - Main Front Up
  • Hall Call Enable 1 (2) - Up Main Front, Floor (1 - 150): Non-serial up main front inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).
• Hall Call Enable 1 (2) - Main Rear Up
  • Hall Call Enable 1 (2) - Up Main Rear, Floor (1 - 150): Non-serial up main rear inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).
• CFSS 1 (2) Enable 1 (2) - Floor
  • CFSS 1 (2) Enable 1 (2) - Floor (1 - 150): Non-serial CFSS mode 1 (2) inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).
• CFSS 1 (2) Enable 1 (2) - Front
• CFSS 1 (2) Enable 1 (2) - Front, Floor (1 - 150): Non-serial CFSS mode 1 (2) front inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).
• CFSS 1 (2) Enable 1 (2) - Rear
• CFSS 1 (2) Enable 1 (2) - Rear, Floor (1 - 150): Non-serial CFSS mode 1 (2) rear inputs from Hall call enable 1 (2) devices (card reader or keypad etc.).
• User Defined Events
• User Event (1 - 10): Activation of a User Event (1 - 10) input causes the corresponding User Event (1 - 10) to be activated (Configuration > User-Defined Inputs tab).
• Heat Detectors
• Machine Room Heat Detectors: Signals that a machine room heat detector is activated.
• Hoistway Heat Detectors: Signals that a hoistway heat detector is activated.
• Heat Detectors Floor (1 - 150): Signals that a heat detector on floor (1 - 150) is activated.
• User Serial Fixtures Messages
• User Serial Fixture Message (1 - 4): Signals that cause user defined messages to be displayed and/or announced on the serial fixtures (see “Serial Fixture Tab” on page 9-37).

Output Signal Groups

Outputs are logic-enabled and provide current/voltage or a path to ground as determined by the common shared by the particular relay group. Refer to your job prints for active signal level and specific connection information. The following output groups can be programmed on the ICE-MOR or ICE-COP boards.

• Elevator
  • Alarm Buzzer: Activated if the Emergency Stop Switch or Alarm Bell input are activated and will pulsate if the SAFH, SAFC or GOV inputs go low or if the TDISL input is used. It is reset using the “Emergency Alarm Reset input”. Configure using the Configuration > Car Operation > Devices tab (Emergency Alarm Monitoring parameters).
  • Alarm Light: Activated due to an extended safety string fault, emergency stop switch or alarm bell activation. It is reset using the “Emergency Alarm Reset input”. Configure using the Configuration > Car Operation > Devices tab (Emergency Alarm Monitoring parameters).
  • Attendant Buzzer: This output turns on momentarily (activates an in-car buzzer) to indicate that a hall call button has been pressed while the elevator is on attendant operation.
  • Attendant Hall Call Above: While on attendant operation, this output comes on to indicate that the car has been assigned to answer a hall call above the car (normally used to activate an indicator light to alert the attendant).
  • Attendant Hall Call Below: While on attendant operation, this output comes on to indicate that the car has been assigned to answer a hall call below the car (normally used to activate an indicator light to alert the attendant).
  • Attendant Service Indicator: Active when the car is on Attendant service.
  • Available for fire service: Active when the car is available for fire service operation.
  • Backup power recall done: The car is at a floor and the required door operations have been completed.
• Car Call Audible: Active momentarily when a call is entered. Used for certain CSA applications that require ‘barrier free’ operation.

• Car Call Enable 1 (2) Override output: These respective outputs are active when the Car Call Enable 1 (or 2) Override is active.

• Car Call Registered Audible: This output comes on momentarily when a car call is registered. It is used for certain CSA applications that require “barrier free” operation.

• Car Delayed: The Car delayed timer (Configuration > Car Operation > Passenger tab) starts whenever there is demand. This output turns on if the Car delayed timer expires before the car reaches the demanded destination.

• Car In Service: This output is on when the car operating in normal Passenger mode. It is used by parking and arrival gong logic and is cleared by fire service and inspection operation, and also when the “Car out of service timer” expires or when the heavy load threshold is exceeded. The Car out of service timer is set on the Configuration > Car Operation > Passenger tab

• Car Out Of Service: This output is on when the car is not operating in normal Passenger mode.

• Cartop Inspection: Active when the car is on cartop inspection operation.

• CC Eligibility Config 1 through 8: These respective outputs indicate that a particular car call eligibility configuration has been selected on the Configuration > General > Car Call Eligibility tab or via an input (inputs override software selection).

• CFSS Car Buzzer 1 (2): These respective outputs are turned On whenever the car has been assigned a CFSS call. The output remains On until the CFSS call is answered or de-assigned (see Configuration > Car Operation > CFSS tab).

• CFSS Car Light 1 (2): These respective outputs are used to activate an in-car visual warning indicator associated with Commandeer for Special Service Mode 1 or Mode 2. The output is activated when CFFS Mode 1 (or 2) is activated and remains so until the in-car switch is activated or the “Resume normal service timer” expires (Configuration > Car Operation > CFSS tab).

• CFSS Mode 1 (2) In-Use (Simplex): These respective outputs are active when the car is on CFSS Mode 1 or CFSS Mode 2 as specified on the Configuration > Car Operation > CFSS tab.

• CFSS Mode 1 (2) System (Simplex): These respective outputs are active when the car is on CFSS Mode 1 or CFSS Mode 2 as specified on the Configuration > Car Operation > CFSS tab.

• Commercial Power: This output is active when the controller is on commercial power.

• Counterweight Derailment: Activated when the car counterweight derailment circuit on the Earth Quake (ICE-I EQ) board is latched. The output remains on until the Reset switch on the EQ board is pressed.

• Delayed Mechanically In Service: Use with Emergency Power Overlay logic. This output is “normally” active (when the car is running normally), but is turned “off” when the car appears to be “mechanically” out of service. There is a delay in the dropping of this output for emergency power timing. Only two statuses are checked for the clearing of this output: Safety String and Motor Limit Timer.

• Direction Arrow Down: Active when the car’s current or intended direction is down.
• Direction arrow down 2: (see Direction Arrow Down) This output is disabled during Fire service to accommodate the ASME A17.1 code requirement to disable hall fixtures at all floors except the lobby during Fire service.

• Direction Arrow Up: Active when the car’s current or intended direction is up.

• Direction arrow up 2: (see Direction Arrow Up) This output is disabled during Fire service to accommodate the ASME A17.1 code requirement to disable hall fixtures at all floors except the lobby during Fire service.

• Earthquake Buzzer: Active when the car is on Earthquake operation (earthquake sensor or counterweight derailment inputs active).

• Earthquake Light: Active when the car is on Earthquake operation (earthquake sensor or counterweight derailment inputs active).

• Egress Floor Gong: This output will activate for 300 msec. when the car arrives at the “egress” floor and opens the doors in response to a hall or car call. This output is used to activate an audible indicator to inform visually impaired passengers that the elevator has arrived at the main egress floor of the building. The egress floor is selected on the Configuration > Car Operation > Passenger tab.

• Emerg. Pwr. Car Selected to Recall: Active when this car is selected to lower the recall floor on emergency power.

• Emerg. Pwr. Car Selected to Run: Active when this car is selected to run on emergency power (see Configuration > Car Operation > Emergency power tab).

• Emergency Power Car Done Recall: Active when the car has completed the recall on Emergency Power operation.

• Emergency Power Phase I (Simplex): Activated when the Emergency Power input is activated and remains on until all cars have returned to the recall floor.

• Emergency Power Phase II (Simplex): Activated when all cars have reached the recall floor and remains on until normal power is reinstated.

• Emergency Power Priority Status: Activated when the car is on EMS phase 2, CFSS phase 2 and Fire Service Phase II.

• Emergency Power Recall Complete: Activated when the car is on Emergency Power and is at the recall floor with the doors fully open.

• Emergency Power Service (Simplex): Active when the car is on Emergency Power (Emergency Power input active). Configure using Configuration > Car Operation > Emergency power tab.

• EMS Car Buzzer: This output comes on when the EMS 1 or EMS2 hall switch is activated and turns off when the car reaches the EMS floor (phase 1 return). It is used to activate an in-car audible buzzer to alert passengers that the car is being commandeered for Emergency Medical Service.

• EMS Car Light: This output comes on when the EMS 1 or EMS2 hall switch is activated and stays on until the car returns to normal service. It is used to activate a visual indicator to alert passengers that the car is on Emergency Medical Service.

• EMS Hall Light 1 (2): These respective outputs come on when the EMS1 (or 2) hall switch is activated and turns off when the in-car switch is activated. It is used to activate a visual indicator to alert EMS personnel that the EMS1 or EMS2 signal has been registered. EMS settings and configured on the iView Configuration > Car Operation > EMS tab.
• Empty Car Output: This output is active when one or more of the following are true: Empty Load Input = On, Car Not Empty Sensor Input = Off or the car weight is below the Empty load threshold setting on the Configuration > Load Weigher tab.
• Empty Load: This output is active when the car weight from an analog load weigher is below the Empty load threshold on the Configuration > Load Weigher tab or the discrete Empty Load Input is On.
• EP Car Selected to Run or Recall: This output is active when the car is selected to lower or run on emergency power. Conditions that affect this operation are specified on the Configuration > Car Operation > Emergency Power tab.
• Fan and Light Indicator: This output is normally off and will turn on when the car is at rest long enough for the “Car fan and light timer” (Configuration > Car Operation > Passenger tab) to time out.
• Fire I Light: This output is on when the car is in Fire phase I recall to the main or alternate fire floor. It turns off when then-car firefighter’s switch is activated.
• Fire II Light: Active when the in-car firefighters switch is active (fire phase II).
• Fire Recall: Active when the car is in Fire phase I recall to the main or alternate recall floor.
• Fire Service Phase I Return Complete: This output is normally on and turns “off” to indicate that the car has successfully completed the Fire service phase I recall function (the car is positioned at the fire recall floor with its doors open). It turns back on when phase 2 switch is turned on. It is most often used as a signal that it is O.K. to remove power from the control equipment and start the machine room sprinklers.
• Fire Warning Buzzer: This output comes on when fire service phase I is initiated.
• Fire Warning Light: This output will be solid on during fire service phase I and II. The output will flash only if the machine room or hoistway fire sensors have tripped.
• Firefighter’s Panel Unlock: Activated when the car reaches the recall floor. Used to unlock the fire panel.
• Flood Operation Buzzer: Active when the car is on Flood Operation (set parameters on the Configuration > Car Operation > Flood Operation tab).
• Flood Operation Status: Active when the car is on Flood Operation (set parameters on the Configuration > Car Operation > Flood Operation tab).
• Gate Release Solenoid: Typically used on horizontally sliding fully manual doors to release the car gate and allow it to close. This output is ON when the hoistway doors are closed and there is a demand to move the car. It is turned OFF when both car gates are fully closed.
• Gong Enable Down Front: This output comes on whenever the car passes a floor with a front opening in the DOWN direction and the passing floor going enable button has been activated.
• Gong Enable Down Rear: This output comes on whenever the car passes a floor with a rear opening in the DOWN direction and the passing floor going enable button has been activated.
• Gong Enable Up Front: This output comes on whenever the car passes a floor with a front opening in the UP direction and the passing floor going enable button has been activated.
• Gong Enable Up Rear: This output comes on whenever the car passes a floor with a rear opening in the UP direction and the passing floor going enable button has been activated.

• Heavy Load: This output is activated when the load in the elevator exceeds the threshold set for “hall call bypass” on the Configuration > Load Weigher tab. The “load status” will only change once the car has stopped at a landing and has opened its doors.

• Hoistway Inspection: Active when the car is on Hoistway-Access Inspection operation.

• In-Car Fire Door Operation: This output is typically used by the freight door controller to adjust the door operation per the code requirements for in-car fire service and in-car fire service recall operations. This output is ON during in-car fire service and also during in-car fire service recall until the doors are fully closed.

• In-Car Fire Hold: This output is ON during In-car fire service hold operation.

• In-Car Fire Recall: Typically used to re-enable the hall door buttons station during in-car fire service recall, this output is ON during In-car fire service recall operation.

• In-Car Inspection: Active when the car is on in-car inspection operation.

• In Use Light: This output turns on when the car doors are not fully closed or there is a demand to move the car.

• Independent Service Indicator: Active when the car is on Independent service.

• Inspection Output: Active when the car is on any Inspection operation.

• Light Load: Activated when the Light Load Input is active or when the weight in the car, detected by an analog load weigher, is less than the Light load threshold.

• Machine Room Inspection: Active when the car is on machine room inspection operation.

• Mechanically In Service: This output is “normally” active (when the car is running normally), but is turned off when the car appears to be mechanically out of service. Only two statuses are checked for clearing this output: Safety String and Motor Limit Timer.

• Overload: This output is on when the overload threshold, value at which it may be considered unsafe to move the elevator, has been reached. The car will remain at the floor with doors open (overridden by fire phase II). Typically a visual and/or audible indicator is used to alert passengers that the car is overloaded.

• Pass Code Failure: Activated momentarily when the time limit expires prior to a correct pass code having been entered on the Car Operating Panel.

• Pass Code Success: Activated momentarily when a correct pass code is entered at the Car Operating Panel.

• Passing Floor Gong: This output is on whenever the car passes a floor. Timer options are located on the iView Configuration > Car Operation > Devices tab.

• Passing Floor Gong Enabled: This output comes on whenever the car passes a floor and the passing floor gong enable button has been pushed. Timer options are located on the iView Configuration > Car Operation > Devices tab.

• Recall Switch 1 through 6: One of six outputs indicating that its respective switch has been activated and has placed a car in Recall mode, recalling it to an assigned floor. Switch priority, door operation, car call disposition and more are configured on the iView Configuration > Car Operation > Elevator recall tab.
• Retiring Cam: This output is turned ON to lock the hoistway doors if all doors (front and rear) are fully closed and there is a demand to move the car. Otherwise it is OFF. This output is turned OFF if the car is stopped in between floors.

• Sabbath Operation Indicator: This output is on when the car is on Sabbath operation (Configuration > Car Operation > Sabbath operation tab).

• Seismic Switch: Activated when the seismic switch circuitry on the Earth Quake (ICE-IEQ) board is latched. Remains on until the Reset switch on the EQ board is pressed.

• Shuttle service: This output is on when the car is on Shuttle service (Configuration > Car Operation > Shuttle service tab)

• Swing Operation Indicator: This output is on when the car is on Swing operation. Hall call service is based on parameters set on the Configuration > Swing Configuration tabs. Automatic swing operation is enabled on the Configuration > Car Operation > Passenger tab. Car call eligibility is set on the Configuration > General > Car call eligibility tab.

• Test Mode: Active when the car is on Test mode operation.

• Front Door — Rear Door

• Front (Rear) Car Gong: This output is activated to announce the elevator's intention to go up or down after the car steps into a floor by sounding the front or rear car gong. Timer options located on Configuration > Car Operation > Devices tab.

• Front (Rear) Closing Warning Buzzer: This output is turned ON after the Closing warning light timer has elapsed (see Front (Rear) Closing Warning Light). The Closing warning buzzer timer, on the Configuration > Car Operation > Doors > Front or Rear tab, determines the amount of delay after the Front (Rear) Closing Warning Buzzer output is turned ON before automatic closing of the front or rear doors begins. Total door closing delay is the sum of the closing warning light and buzzer times. The door close warning buzzer is required for power operated vertically sliding doors whenever they are closed automatically or with momentary pressure. It must come on at least 5 seconds prior to the start of closing and stay on until the front/rear doors are closed. For momentary pressure closing, when the in-car front/rear door close button is pressed, the 5 second closing delay may be omitted.

• Front (Rear) Closing Warning Light: This output is turned ON prior to the Front (Rear) Closing Warning Buzzer output being turned ON. The Closing warning light timer, on the Configuration > Car Operation > Doors > Front or Rear tab, determines the amount of delay before the Front (Rear) Closing Warning Buzzer output is turned ON. This output remains ON until the doors are fully closed.

• Front (Rear) DCLC Output: This output turns ON when the front (rear) car gate and hoistway doors are closed.

• Front (Rear) Disable Automatic Close: Used to disable automatic closing, these outputs are normally OFF and can be configured, on the Configuration > I/O Board > Configurable outputs tab, to turn ON during any combination of the following modes/conditions: In-car fire service, Independent service, Attendant service, In-car CFSS mode 1 (2) operation, In-car EMS operation, Door hold button or timer activation.

• Front (Rear) Disable Hall Door Buttons: Used to disable the hall door buttons station, this output is normally OFF and can be configured, on the Configuration > I/O Board > Configurable outputs tab, to turn ON during any combination of the following modes and/or conditions: In-car fire service, Independent service, Attendant service, In-car
CFSS mode 1 (2) operation, In-car EMS operation, Door hold button or timer activation.

- Front (Rear) Door Close Limit: Inactive when the doors are fully closed.
- Front (Rear) Door Enable: Used to cut power to front/rear doors, these outputs are normally ON and can be configured, on the Configuration > I/O Board > Configurable outputs tab, to turn OFF during any combination of the following modes and/or conditions: Test mode, Inspection operation, In-car stop switch activated and doors are fully open, Door stop input activated.
- Front (Rear) Door Hold End: This output turns on five seconds prior to expiration of the “Door hold” timer (see Front (Rear) Door Hold Function).
- Front (Rear) Door Hold Function: This output is active during the time the doors are being held by the “Door hold” timer (Configuration > Car Operation > Passenger > Door Operation - Door Dwell Timers).
- Front (Rear) Door Left Open: This output is used for non-automatic front/rear doors and shall be ON if the front/rear doors are open and a hall call button is pressed. Otherwise it shall be OFF.
- Front (Rear) Door Lock Power: This output is activated when the doors are closed and locked and is used for door operators that need a separate signal to hold the doors closed.
- Front (Rear) Down Car Lantern: This output is activated (usually a double ding; on-off-on) to announce the elevator's intention to go down after the doors start to open by operating the front or rear in-car gong/lantern assembly. This will happen when a down hall call has been entered and the car has reached the floor from which that call originated, or the doors are open and a car call is entered for a floor below. Timer options are located on the Configuration > Car Operation > Devices tab.
- Front (Rear) Nudging Audible: This output is activated when door nudging has been activated. Options located on Configuration > Car Operation > Passenger tab.
- Front (Rear) Door This Car Up: This output is active when the car is at the lobby floor and has been selected as the next car to go in the UP direction.
- Front (Rear) Up Car Lantern: This output is activated (usually a single ding) to announce the elevator's intention to go up after the doors start to open by operating the front or rear in-car gong/lantern assembly. This will happen when an up hall call has been entered and the car has reached the floor from which that call originated, or the doors are open and a car call is entered for a floor above. Timer options are located on the Configuration > Car Operation > Devices tab.

- Car Calls - Front COP 1
  - Car Call - Front COP 1 light, Floor 1—150: Outputs to the front Car Operating Panel 1 lights.
- Car Calls - Rear COP 1
  - Car Call - Rear COP 1 light, Floor 1—150: Outputs to the rear Car Operating Panel 1 lights.
- Car Calls - Front COP 2
  - Car Call - Front COP 2 light, Floor 1—150: Outputs to the front Car Operating Panel 2 lights.
• Car Calls - Rear COP 2
  • Car Call - Rear COP 2 light, Floor 1—150: Outputs to the rear Car Operating Panel 2 lights.

• Position indicators Binary Outputs I
  • Binary Position Indicator I, Output 1—8: Outputs 1 through 8 to Binary Position Indicator I. Outputs I will stay active during Fire Service.

• Position indicators Binary Outputs II
  • Binary Position Indicators II, Output 1—8: Outputs 1 through 8 to Binary Position Indicator II. Outputs II will deactivate during Fire Service.

• Position indicators Single Outputs I
  • Position Indicators Single I, Floor 1—64: Outputs to one line per floor position indicators. Outputs I will stay active during Fire Service.

• Position indicators Single Outputs II
  • Position Indicators Single II, Floor 1—64: Outputs to one line per floor position indicators. Outputs II will deactivate during Fire Service.

• Position indicators Rotodial Outputs I
  • Rotodial Position Indicators I, Output 1—3: Outputs created for the “Rotodial” brand position indicators. These three outputs change in a specified pattern to cause the rotodial device to rotate in the appropriate direction. Outputs I will stay active during Fire Service.

• Position indicators Rotodial Outputs II
  • Rotodial Position Indicators II, Output 1—3: Outputs created for the “Rotodial” brand position indicators. These three outputs change in a specified pattern to cause the rotodial device to rotate in the appropriate direction. Outputs II will deactivate during Fire Service.

• Hall lanterns - Front up
  • Hall lantern - Front up, Floor 1—150: This output is generated to activate the front door hall gong/lantern assembly. Options are set on the Configuration > Car Operation > Devices tab.

• Hall lanterns - Front down
  • Hall lantern - Front down, Floor 1—150: This output is generated to activate the front door hall gong/lantern assembly. Options are set on the Configuration > Car Operation > Devices tab.

• Hall lanterns - Rear up
  • Hall lantern - Rear up, Floor 1—150: This output is generated to activate the rear door hall gong/lantern assembly. Options are set on the Configuration > Car Operation > Devices tab.

• Hall lanterns - Rear down
  • Hall lantern - Rear down, Floor 1—150: This output is generated to activate the rear door hall gong/lantern assembly. Options are set on the Configuration > Car Operation > Devices tab.

• Hall gongs - Front
  • Hall gongs - Front, Floor 1—150: This output is generated to activate a separate front door hall gong.
• Hall gongs - Rear
  • Hall gongs - Rear, Floor 1—150: This output is generated to activate a separate rear door hall gong.

• Motor and Drive
  • Brake Holding Voltage: This output turns ON for hardware driven Brake picking to Holding voltage. The Hold delay timer option is located on Configuration > Brake > Timers tab.
  • Motor Blower: This output for the Motor Blower is ON when car is in motion and for the duration of the time setting of the Motor blower hold delay timer on the Configuration > Drive > General tab.
  • Sheave Brake Enable: Used to enable the emergency brake function. The Emergency Brake - Sheave brake options must be selected on the Configuration > Safety tab.

• Melina PI display Outputs I (Left)
  • Left Character 9—22: Outputs to the Melina position indicator for the left character. Outputs I will stay active during Fire Service.

• Melina PI display Outputs I (Middle)
  • Middle Character 9—22: Outputs to the Melina position indicator for the middle character. Outputs I will stay active during Fire Service.

• Melina PI display Outputs I (Right)
  • Right Character 9—22: Outputs to the Melina position indicator for the right character. Outputs I will stay active during Fire Service.

• Melina PI display Outputs II (Left)
  • Left Character 9—22: Outputs to the Melina position indicator for the left character. Outputs II will deactivate during Fire Service.

• Melina PI display Outputs II (Middle)
  • Middle Character 9—22: Outputs to the Melina position indicator for the middle character. Outputs II will deactivate during Fire Service.

• Melina PI display Outputs II (Right)
  • Right Character 9—22: Outputs to the Melina position indicator for the right character. Outputs II will deactivate during Fire Service.

• System Configurations (Simplex)
  • Hall Call Eligibility Config (1 - 8): Output is active when the respective Hall Call Eligibility Configuration (1 - 8) is active.
  • Parking Config (1 - 8): Output is active when the respective Parking Configuration (1 - 8) is active.
  • Parking Eligibility Config (1 - 8): Output is active when the respective Parking Eligibility Configuration (1 - 8) is active.
  • Mode of Operation Config (1 - 8): Output is active when the respective Mode of Operation Configuration (1 - 8) is active.
  • Security Config (1 - 8): Output is active when the respective Security Configuration (1 - 8) is active.
  • CFSS In Use 1 (2):
  • CFSS System 1 (2):
• Active Mode - Balanced: Output is active when the current dispatching mode is Balanced.
• Active Mode - Demand Up Peak: Output is active when the current dispatching mode is Demand Up Peak.
• Active Mode - Demand Down Peak: Output is active when the current dispatching mode is Demand Down Peak.

• Hall Calls - Aux Front Down
  • Hall Call - Aux Front Down Light 1 - 150): Outputs which can be used to drive the Front Auxiliary Down Hall Call lights.

• Hall Calls - Aux Rear Down
  • Hall Call - Aux Rear Down Light (1 - 150): Outputs which can be used to drive the Rear Auxiliary Down Hall Call lights.

• Hall Calls - Main Front Down
  • Hall Call - Main Front Down Light (1 - 150): Outputs which can be used to drive the Front Main Down Hall Call lights.

• Hall Calls - Main Rear Down
  • Hall Call - Main Rear Down Light (1 - 150): Outputs which can be used to drive the Rear Main Down Hall Call lights.

• Hall Calls - Aux Front Up
  • Hall Call - Aux Front Up Light (1 - 150): Outputs which can be used to drive the Front Auxiliary Up Hall Call lights.

• Hall Calls - Aux Rear Up
  • Hall Call - Aux Rear Up Light (1 - 150): Outputs which can be used to drive the Rear Auxiliary Up Hall Call lights.

• Hall Calls - Main Front Up
  • Hall Call - Main Front Up Light (1 - 150): Outputs which can be used to drive the Front Main Up Hall Call lights.

• Hall Calls - Main Rear Up
  • Hall Call - Main Rear Up Light (1 - 150): Outputs which can be used to drive the Rear Main Up Hall Call lights.

• CFSS Calls - CFSS 1 Front
  • CFSS Call - CFSS 1 Front Output (1 - 150): Outputs which can be used to drive the CFSS 1 Front Call lights.

• CFSS Calls - CFSS 1 Rear
  • CFSS Call - CFSS 1 Rear Output (1 - 150): Outputs which can be used to drive the CFSS 1 Rear Call lights.

• CFSS Calls - CFSS 2 Front
  • CFSS Call - CFSS 2 Front Output (1 - 150): Outputs which can be used to drive the CFSS 2 Front Call lights.

• CFSS Calls - CFSS 2 Rear
  • CFSS Call - CFSS 2 Rear Output (1 - 150): Outputs which can be used to drive the CFSS 2 Rear Call lights.
• Custom Outputs
  • Toggle Output: The Toggle Output can be used to convert a steady state Custom Output to a toggled output.
  • Custom Out (1 - 20): Allows existing inputs, outputs and internal flags to be combined in a custom logic equation which can then generate a custom output. Please refer to “Configuration - Advanced - Custom Outputs” on page 9-142.

• Remote User Outputs

• Heat Detectors
  • Heat Detectors Audible Signal: This normally low output is activated when heat detectors are activated. It is used to operate audible indicator(s).
  • Heat Detectors Visual Signal: This normally low output flashes when heat detectors are activated. It is used to operate visual indicator(s).
  • Heat Detectors Recall Complete: This normally low output is activated when the car has completed the Heat Detectors recall operation (reached a floor - doors are fully open).
**Configuration - iBox Configuration**

This tab provides detailed information about the iBox and its port address settings (View > Configuration > iBox Configuration).

<table>
<thead>
<tr>
<th>Operational Status</th>
<th>iBox Configuration</th>
</tr>
</thead>
</table>

- **MAC Addresses**: Unique hardware address for each of the iBox Ethernet ports.
- **Version**: iBox and iView version information.
- **Miscellaneous**: Boot flags are used during internal test. Time zone indicates the time zone where the equipment is installed and is used primarily for a monitoring reference.
- **Network Information**: Ethernet information for each of the iBox ports.

![iBox Configuration Table](image)

- **LAN Port**
  - **IP address**: 10.10.52.10
  - **Subnet**: 255.255.0.0
  - **Gateway**: 10.10.254.254
  - **DNS name**: MCE0000F1
  - **DNS server**:

- **System Ethernet Port**
  - **IP address**: 192.168.192.1
  - **Subnet**: 255.255.255.0
  - **Gateway**: 0.0.0.0
  - **DNS name**: MCE0000F2
  - **DNS server**:

- **PC**
  - **IP address**: 10.10.193.1
  - **Subnet**: 255.255.255.0
  - **Gateway**: 0.0.0.0
  - **DNS name**: MCE0000F3
  - **DNS server**:

• Mac Addresses: Unique hardware address for each of the iBox Ethernet ports.
• Version: iBox and iView version information.
• Miscellaneous: Boot flags are used during internal test. Time zone indicates the time zone where the equipment is installed and is used primarily for a monitoring reference.
• Network Information: Ethernet information for each of the iBox ports.
Configuration - Loadweigher

The Loadweigher screen configures the controls associated with the load weigher.

Device configuration

- Load weighing device type:
  - No load weigher: Select if no load weigher is used.
  - Discrete contact closures: Select if your load weigher provides only discrete contact closure information (no analog value).
  - Analog signal: Select if your load weigher provides an analog signal corresponding to the weight in the car. This selection will enable the additional parameters below.
Analog device configuration

• Sensing type
  • Cross head deflection or rope tension sensing: Select if your load weigher provides an analog signal based on deflection of the elevator cross head or the tension of the wire ropes.
  • Isolated platform displacement sensing (MCE): Select if your load weigher provides an analog signal based on the compression of the pads under the isolated platform in the car.

• Over load threshold (% of full load): When the weight in the car exceeds this threshold the controller will consider the car to be in an over load condition. This value is typically 110% to 115% of full load. Please refer to “Load Weigher Selection and Threshold Settings” on page 4-31.

• Heavy load threshold (% of full load): When the weight in the car exceeds this threshold the controller will consider the car to be in a heavy load condition (used for hall call bypass). Typically set from 80% to 90% of full load. Please refer to “Load Weigher Selection and Threshold Settings” on page 4-31.

• Light load threshold (% of full load): When the weight in the car is less than this threshold the controller will consider the car to be in a light load condition. Typically this value is set below 20% of full load. Please refer to “Load Weigher Selection and Threshold Settings” on page 4-31.

• Empty load threshold (% of full load): When the weight in the car is less than this threshold the controller will consider the car to be empty. Typically less than 10% of full load. Please refer to “Load Weigher Selection and Threshold Settings” on page 4-31.
Configuration - Pattern

The active Pattern Profile dictates the cars change in velocity as it moves between floors. This includes starting from a stop, accelerating, running at speed, decelerating, and coming to a stop. Adjusting pattern parameters affects the performance of the car (ride comfort, floor-to-floor times, etc.). The larger profile below shows a run long enough for the car to reach contract speed (multi-floor run). The smaller profile shows a short run in which the car did not reach contract speed (i.e., a one-floor run).

From the Configuration > Pattern tab, you can adjust parameters that determine the profile of the patterns used by the system in its various operating modes. The illustration below shows a pattern with adjustment points called out.

**Figure 9.2 Pattern Profile Adjustment Points**

The patterns use by iControl include:

- **Standard**: Profile used for normal passenger operation.
- **Earthquake**: Profile used when the Earthquake (EQI) input is activated.
- **Emergency power**: Profile is used when the Emergency Power Input (EPI) is activated.
- **Emergency slowdown**: Profile used when faster than normal deceleration is required, e.g. overspeed at a Normal Terminal Switch or loss of quadrature (positioning) signal. (Does not have a High Speed parameter setting.)
- **Correction**: Profile used when the system is not confident of car hoistway position. The car proceeds to a known position using the Correction Profile in order to synchronize its position information.
- **Inspection**: Profile used when the elevator is on Inspection operation. (Has two additional parameters.)
- **Alternate 1**: Profile used when the Alternate Speed Profile One (ASP1) Input is activated.
- **Alternate 2**: Profile used when the Alternate Speed Profile Two (ASP2) Input is activated.

The Pattern > Common tab, sets parameters that apply to all profiles. The parameters that shape the various patterns are adjusted on the Pattern > Modes tab.
Pattern - Common Tab

The Pattern > Common tab parameters apply to all pattern profiles.

**Position Synchronization**  When the elevator encounters a floor magnet or terminal switch, the controller uses the learned position of that magnet or switch to update the current reported position. Position Synchronization buttons allow you to force the controller to synchronize position to floor magnets or the building bottom landing (controller 0.00 position).

- **Terminal**: Synchronizes position with a terminal landing. The controller will use iLand reported position to choose the upper or lower terminal. The car will travel at a rate halfway between Contract and Correction Speed to the terminal. Upon reaching the first terminal switch, the car will decelerate to Correction Speed. At the final terminal switch, the car will decelerate to leveling speed, synchronize its position, and return to normal operation. The on-screen Terminal “LED” lights during synchronization.

- **Floor**: Synchronizes position with the current or nearest floor magnet. The car will rise just enough to register the falling edge of the magnet-induced signal, then resettle to the floor and synchronize its position. (The controller anticipates, based on its logical position in the hoistway, that the signal should be encountered within a calculated number of inches. If this calculation proves false, the elevator will stop at the next floor.)

- **Preset**: Not implemented.
General

- Pattern scaling: Scaling factor applied to all programmed speeds. This is used during adjustment to move the car slowly to verify drive operation, etc. May be set from 0 to 150%. At 0%, no pattern command output voltage is produced so the car should not move. At 100%, the car will move at the high speed set for the selected operating mode.
- Lag delay: Used to compensate for drive and hoist motor response. This value acts as a ‘look ahead’ time, telling the speed profile generator the amount of time it takes the car to follow the speed demand. A setting of 0.0 seconds assumes the car will precisely follow the speed profile with no delay. The more sluggish the system, the larger the number required to compensate for drive tracking. Higher values make the system initiate changes in the profile sooner since the car will not follow the demanded profile closely. Setting this value too large will lengthen the amount of time the elevator spends leveling.
- Door pre-opening distance: When set, this is the distance from the final floor position at which door pre-opening is initiated. If no distance is set, door pre-opening is disabled.

Leveling

- Leveling speed: Determines the speed at which the elevator will level into the floor (initial approach prior to normal rate limited stop). Please refer to “Final Stop” on page 4-25.
- Releveling speed: Determines the speed used during releveling, prior to normal rate limited stop. Releveling occurs after the car has reached a floor and subsequently is required to relevel (direction enabled with ULM or DLM active). See also: Relevel distance and Relevel dead zone distance.
- Leveling distance: Determines the distance from the final floor position at which the elevator operates at leveling speed.
- Releveling distance: The car must perform a re-level operation if it stops further than this distance from the floor (with ULM or DLM active) or if, after stopping, moves further than this distance from the floor due to load change.

Dead zone

- Dead zone distance: The distance from the final floor position where the stop command is issued (transition from leveling speed to normal rate limited stop) on the initial run to the floor (i.e., leveling operation).
- Re-level dead zone distance: The distance from the final floor position where the stop command is issued (transition from re-level speed to normal rate limited stop) during a relevel operation. Please refer to “Releveling Operation” on page 4-28.

Position encoder resolution

- Select the landing system in use, then click the associated apply button.
- If using MRDF (Machine Room Distance Feedback):
  - Enter pulses per revolution.
  - Enter governor sheave diameter in FEET (example: 30 inches = 2.5 [feet]).
  - Click the Calculate button.
- Click the associated Apply button.
**Typical Common Tab Settings**

The settings in the table below are typical for a 500 feet per minute installation.

**Table 9.8 Typical Common Tab Settings**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position Encoder resolution</td>
<td>256 (iLand, normal installation)</td>
</tr>
<tr>
<td>Pattern scaling</td>
<td>100%</td>
</tr>
<tr>
<td>Door preopening distance</td>
<td>3.0</td>
</tr>
<tr>
<td>Leveling speed</td>
<td>4.0</td>
</tr>
<tr>
<td>Releveling speed</td>
<td>4.0</td>
</tr>
<tr>
<td>Leveling distance</td>
<td>0.2</td>
</tr>
<tr>
<td>Releveling distance</td>
<td>0.3</td>
</tr>
<tr>
<td>Dead zone distance</td>
<td>0.2</td>
</tr>
<tr>
<td>Relevel dead zone distance</td>
<td>0.1</td>
</tr>
</tbody>
</table>

**Pattern - Modes Tab**

The parameters that shape the various patterns are adjusted on the Pattern > Modes tab. Click a parameter name (top row) or parameter value to see the portion of the profile adjusted by that parameter. Click a pattern name (left column) to highlight the parameters used by that pattern.
Pattern Profile parameters

- Initial jerk: The transition from zero speed to full acceleration. As Initial jerk is increased, the profile transitions more quickly from starting acceleration to maximum acceleration.
- Acceleration: Determines the maximum acceleration for this profile.
- High roll jerk: Used when the car is not able to reach High speed. Determines how quickly the profile transitions from maximum to zero acceleration and zero to maximum deceleration.
- High speed: Determines the maximum speed for this profile. (For the Standard profile this is usually contract speed.
- Low roll jerk: Used when the car is able to reach High speed. Determines how quickly the profile transitions from maximum to zero acceleration and zero to maximum deceleration.
- Deceleration: Determines the maximum deceleration for this profile.
- Flare jerk: The transition from maximum deceleration to Approach deceleration. As Flare jerk is increased, the profile transitions more quickly.
- Approach deceleration: Determines the deceleration rate for the transition from Flare jerk to Approach Jerk.
- Approach jerk: The transition from approach Deceleration to leveling speed. As Approach Jerk is increased, the profile transitions more quickly.
- Low speed: The Low speed parameter is used only in Inspection mode. It determines the reduced speed to which the car will decelerate after encountering a DNT5 or UNT5 switch when operating in Inspection mode. (For example, if Inspection - High speed were set to 50 feet per minute and Low speed to 20 feet per minute, the car would decelerate from 50 fpm to 20 fpm if a terminal switch was encountered during Inspection operation.) Active only when the Reduced inspection speed option is enabled.
- Reduced inspection speed: Specifies that the car, when in Inspection mode, will decelerate to the Low speed setting if a DNT5 or UNT5 switch is opened.

Pattern shape preset

Pattern shape preset can be used to enter preset values for the profile parameters based on the high speed (contract speed) of the elevator and the selected shape type.

1. Speed: Enter the high speed (contract speed of the elevator).
2. Shape type: Select the desired shape type.
   - Slow: Slow floor to floor times with gentle transitions.
   - Moderate: Moderate floor to floor times with moderate transitions.
   - Fast: Fast floor to floor times with aggressive transitions.
3. Click Configure. Preset values for the pattern profile parameters are entered.
To edit parameters

1. Click in the cell where the parameter is located.
2. Use the up / down arrow buttons or highlight the value and type a new value.
3. Acquire write privilege (click Acquire on the Write privilege menu). Press the YES soft-key on the iBox.
4. Click Send to send the new value to iControl.

**Typical Pattern Values** Typical values for a 500 feet per minute installation are shown in the following table. Alternate 1 and 2 values depend completely on the behavior desired when the elevator is operating under control of those patterns (there really are no “typical” settings for Alt 1 and Alt 2).

**Typical Pattern Settings (500 FPM Installation)**

<table>
<thead>
<tr>
<th>Operational Status</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Common</td>
</tr>
<tr>
<td></td>
<td>Profiles</td>
</tr>
<tr>
<td></td>
<td>Initial jerk</td>
</tr>
<tr>
<td>Standard</td>
<td>4.000</td>
</tr>
<tr>
<td>Earthquake</td>
<td>7.000</td>
</tr>
<tr>
<td>Emergency power</td>
<td>3.000</td>
</tr>
<tr>
<td>Emergency slowdown</td>
<td>10.000</td>
</tr>
<tr>
<td>Coriander</td>
<td>7.000</td>
</tr>
<tr>
<td>Inspection</td>
<td>3.000</td>
</tr>
<tr>
<td>Alternate 1</td>
<td>7.000</td>
</tr>
<tr>
<td>Alternate 2</td>
<td>7.000</td>
</tr>
</tbody>
</table>
Configuration - Terminal Switches

The Configuration > Terminal Switches tab displays the position margins for the normal and emergency terminal switches plus the Overspeed 1 percentage.

- Margin: The position of the Normal and Emergency Terminal switches is learned using the Terminal Learn procedure (Please refer to “Learning Normal & Emergency Terminal Limit Switches” on page 4-9). The margin settings determines the variance from the learned position required to generate an Up (or Down) Normal Terminal Switch ‘n’ Position Fault or an Up (or Down) Emergency Terminal Switch Position Fault (n = 1 to 5).

- Overspeed 1: Determines the percentage of variance from the learned speed required to generate an Up (or Down) Normal Terminal Switch ‘n’ Level 1 Speed Fault (n = 1 to 5). The “learned” speed is learned using the Terminal Learn procedure (Please refer to “Learning Normal & Emergency Terminal Limit Switches” on page 4-9).
Configuration - Timer Tables (Controller)

The Controller > Configuration tab allows you to create timers that automatically determine, based on day and time of day, the status (on or off) of Auto Stop, Sabbath operation and Swing operation.

**Note**

System timer tables can be used to determine the currently active configuration for Hall Call Eligibility, Parking, Parking Eligibility, Mode of Operation, Security and the state for User Outputs 1 through 4. Please refer to “Configuration Tabs - Timer Tables (System)” on page 10-62.

**Features**

The timers associated with the type of operation selected in Features are displayed in the Timers list. For example, in the screen above, Auto Stop is selected and the timers that automatically determine the state of Auto Stop are displayed. Timers may be displayed for:

- Auto Stop
- Sabbath Operation
- Swing
Timer Details
When a timer is selected in the table, details of its settings appear in Timer Details. (You must select a timer and click Edit to change settings. This display is read only.)

Timers
Timers are displayed in the Timers list. If timers overlap (manage the same period of time), the timer appearing higher in the list will have priority (control). To move a timer within the list, click to select it, then click Move Up or Move Down.

Add a Timer
To add a new timer to the list:
1. Click Add. The Add/Edit Timer dialog is displayed.

2. From the Configurations list, select the configuration(s) and/or feature(s) that should be active when this timer is valid (timer day and time are the present day and time).
3. Select the repeat frequency (Recurrence type) of the timer:
   • Daily: This timer is active every day during the specified time period.
   • Weekly (Day of the week): This timer is active each week on the specified day or days (i.e., Mondays or Mondays and Tuesdays) or can be set to span days (i.e., Monday through Wednesday).
   • Monthly (Day of week): This timer is active each month on the specified week days (i.e., first Monday, third Sunday, etc.) or can be set to span days (i.e., second Sunday through third Saturday, etc.).
• Monthly (Day of month): This timer is active each month during the specified time period, on the specified date or dates or may be set to span dates.
• Yearly (Day of week): This timer is active each year during the specified time period, during the specified month or months, on the specified day or days or may be set to span days across multiple months.
• Yearly (Day of month): This timer is active each year during the specified time period, during the specified month or months, on the specified date or dates or may be set to span dates across multiple months.

4. Enter the timer details using the Recurrence pattern controls. (These controls change depending on the Recurrence type selected.)
   • Enter a descriptive name for the timer (up to 25 characters).
   • Select the start and end time, day(s) or date information required.

5. Click OK.
6. Click Send to send new or changed timer information to iControl.

To remove a timer
1. Select a configuration/feature type from the Features drop down list.
2. Select a timer from the Timers list.
3. Click Remove.

To edit a timer
1. Select a configuration/feature type from the Features drop down list.
2. Select a timer from the Timers list.
3. Click Edit.
4. Make changes using the Add/Edit Timers dialog.
5. Click OK.

To move a timer    A timer’s position in the list determines its priority. If two timers are attempting to control the same configuration at the same time, the timer higher in the list (lower Priority number) will have control. To move a timer:
1. Select the timer from the Timers list.
2. Click Move Up or Move Down.

Note
No valid timer: For a particular configuration/feature, i.e., Auto Stop, Sabbath Operation, etc., if Timed is selected and there is no valid timer (current date and time falls within the timer’s date(s) and times), those configurations/features will default to their #1 configuration or default state.
The User Events tab is used to assign a name to an Input / User Event. Up to 10 Input / Event Names can be programmed. This event name can then be assigned to a hardware input. An event is logged, on the Controller Event Log, when the input is activated and again when it is deactivated. Controller - Input / Event Names are assigned to terminals on an ICE-MIAC Multiple Input AC board using the Controller > Configuration > I/O Boards tab. For information about System User Events see “Configuration Tabs - User Events” on page 10-65.

To configure a Controller User Event:

1. Display the User Events tab (Controller > Configuration > Advanced > User Events tab).
2. Enter the desired Input / Event Name, up to 40 characters.
3. Send the Input / Event name to the controller. The name will then appear under User-Defined Events on the list of inputs used to configure the I/O Boards.
4. Assign the event to a terminal on an ICE-MIAC Multiple Input AC Board using the Controller > Configuration > I/O Board tab (see “Configuration - I/O Boards” on page 9-102). User Events can also be assigned to terminals on an ICE-COP Serial Car Operating Panel Board.
Configuration - Advanced - Custom Outputs

The custom outputs feature allows existing inputs, outputs and internal flags to be combined in a custom logic equation which can then generate a custom output which can be assigned to an output terminal on an ICE-MOR or ICE-COP board.

In the simple example above, the Earthquake Buzzer, Attendant Buzzer, Fire Warning Buzzer and Nudging Audible outputs are OR’ed into one Combined Buzzer Output, which is then assigned to a terminal on an ICE-MOR board.

**To program a custom output**

Custom outputs are programmed as follows:

1. Check the Enabled box to enable a line of the logic equation.
2. The Name of the output or flag can be customized, up to 16 characters can be used.
3. Click the Operand I cell and click the arrow. Use the dialog box to select the Data Type and Operand Data. Then click OK. The appropriate information is placed in the logic table.
4. Click the Operator cell, click the arrow and select an operator (NOT, AND, OR, XOR, NAND).
5. Click the Operand 2 cell and click the arrow. Use the dialog box to select the Data Type and Operand Data as in step 3.
6. Acquire Write privilege and Send the data to iControl.
7. The Status LED turns on when the logic statement is true.
8. Once the logic equation is complete, you can assign the custom output to a terminal using the I/O Boards tab. Please refer to “Configuration - I/O Boards” on page 9-102. Outputs can be programmed for an ICE-MOR board or for an ICE-COP board.
Controller - Setup Tabs

The Setup tabs allow you to perform various setup and calibration procedures. Typically these procedures require observation or manipulation of parameters contained on the associated Configuration tab. Screen layouts have been created that display both the configuration and the setup tab. Therefore, when performing a setup procedure, it is recommend to use the layout display, e.g. when performing the Brake Calibration, use the Brake layout (View > Layouts > Brake).

Setup - Brake Tab

The Setup > Brake tab allows you to perform the brake calibration procedure. When performing this procedure it is recommend to display the Brake Layout (View > Layout > Brake).

- Indicators: The Calibrating, Waiting, and progress indicators track and report progress through Brake Calibration phases.
- Message window: Provides feedback and instructions during Brake Calibration.
- Default button: Sets brake parameters to the default values.
- Calibrate button: Starts the Brake Calibration procedure using voltage and timer values entered.
- Abort button: Aborts the Brake Calibration procedure.
- Continue button: Restarts the Brake Calibration procedure if it has paused to allow completion of an instruction displayed in the message window.

The brake calibration procedure is described in Section 2 of this manual. Please refer to “Drive Offsets Calibration” on page 2-46.
Setup - Counterweight Tab

Used to first learn, then display the learned position in the hoistway where the car and counterweight are adjacent to each other. iControl uses this information to make logic decisions requiring knowledge of counterweight position in relation to the car (i.e., Earthquake operation mode decisions).

- Counterweight Position: The distance, in feet, between the car and the lowest floor served by the elevator when the counterweight learn operation was accomplished. The learn operation is performed with the car and counterweight at the same height in the hoistway (adjacent to one another). Please refer to “Counterweight Learn Procedure” on page 3-28.
Setup - Drive Tab

Used to calibrate the Input ADC and Output DAC offsets. Please refer to “Automated Drive Setup Procedure” on page 2-46.
**Setup - Floor Heights - Learn Tab**

The Setup > Floor Heights > Learn tab is used to perform the Floor Heights Learn procedure. Please refer to “Learning Floor Heights” on page 4-2. When performing this procedure it is best to use the Floor Heights layout (View > Layouts > Floor Heights) which displays both the Floor heights setup and Floor Heights configuration tabs. While performing the learn procedure, the current car position and speed can be viewed in the Hoistway window. The results of this calibration can be viewed on the Configuration > Floor Heights > Configurations tab. Please refer to “Configuration - Floor Heights” on page 9-96.
The Setup > Floor Heights > Learn tab contains:

**Configuration data**  Learned and actual (previously saved) data detected by the Floor Heights Learn procedure.

- Floors - the top floor configured on the Configuration > General > Floor data tab.
- Front markers - the number of front landing magnets detected.
- Landings - the number of floors where a front and/or rear landing magnet was detected (includes false floors).
- Rear markers - the number of rear landing magnets detected.
- Openings - the number of floors with eligible openings (front and/or rear) per the Configuration > General > Floor data tab.

**Edge data**  For diagnosing possible problems with floor magnets or magnet detection.

- Error - the error is displayed in feet and indicates the difference between the height learned by the Floor Heights Learn procedure and the height currently detected by the Top level up, Top level down, Bottom level up and Bottom level down sensors for the front and/or rear landing magnets. A typical error reading is 0.02083 (1/4 inch) to 0.01041 (1/8 inch) or less. If the error is greater than 0.04166 (1/2 inch), it is recommended to re-do the placement of the magnets and then re-learn the floor heights.
  - Top level up - The ULM sensor has detected the top edge of a landing magnet. The elevator is roughly aligned with the center of the landing magnets.
  - Top level down - The DLM sensor has detected the top edge of a landing magnet. The elevator is roughly six inches above the center of the landing magnet.
  - Bottom level up - The ULM sensor has detected the bottom edge of a landing magnet. The elevator is roughly six inches below the center of the landing magnet.
  - Bottom level down - The DLM sensor has detected the bottom edge of a landing magnet. The elevator is roughly aligned with the center of the landing magnet.
- Count - the number of times each landing system leveling sensor has detected the top or bottom of a front or rear landing magnet at the floor. These values will return to zero when power is cycled or the controller is reset.

**Learn metrics**

- Floor - during the Floor Heights Learn operation, indicates the most recently learned floor.
- Height - the learned height for the most recently learned floor.
- Last floor height - the incremental distance to the previously learned floor (difference between the heights learned for the previous and most recently learned floors).

**Leveling Sensor**  Indicates the current state (activated or deactivated) of the front and rear Up leveling marker, Door zone and Down leveling marker sensors.

**Outer level**

- Velocity - the car speed at the time the last landing magnet edge was detected.
- Error - the difference between the learned and most recent car position when the last landing magnet edge was detected.
Learn  The following controls and messages pertain to the Floor Heights Learn procedure. Follow the instructions displayed in the message window to perform the learn procedure.

- **Type** - Manual / Auto. On Manual, you use the iBox Enable and Up/Down switches to run the car through the hoistway. On Auto, iControl will run the car through the hoistway automatically.

- **Status** - The following status messages can be displayed:
  - Waiting for learn request: Waiting for the *Learn* button to be clicked.
  - Waiting for proper start location: The car must be moved onto the down directional limit before the learn operation can begin.
  - Idle: The elevator is at the proper start location and the learn procedure is activated.
  - Acquiring floor markers: The learn operation is *In progress*. The car is moving through the hoistway capturing the location of the floor magnets.
  - Invalid floor sensor transition: The system expects the ULM, DZ and DLM sensors to activate and deactivate in the proper sequence as the elevator passes a landing magnet or vane. A floor sensor transition other than the expected transition has occurred. This can occur when a floor sensor and magnet are misaligned, the floor sensor and magnet are not in the correct proximity (distance) or the sensor has malfunctioned. (For a NEMA or slide-guide iLand, this can occur when the sensor and a floor vane are not correctly aligned or adjusted. The vanes must be exactly perpendicular to the sensor).
  - Acquired floor markers fewer than configuration: The number of floor magnets sensed during the learn operation is less than the number of floors and false floors indicated on the Controller view > Configuration > General > Floor Data tab.
  - Acquired floor markers more than configuration: The number of floor magnets sensed during the learn operation is greater than the number of floors and false floors indicated on the Controller view > Configuration > General > Floor Data tab.
  - Configured floor markers more than maximum allowed: The number of floor magnets sensed during the learn operation is more than the maximum number supported.
  - Acquired floor marker heights mismatch configuration: The height and/or location of the detected floor magnets does not match the configuration (Controller > Configuration > General > Floor Data tab) in one of the following ways:
    - the sequence of the front and rear magnets does not match the configuration,
    - the floor magnets for a walk-through floor are greater than one inch apart,
    - the floor magnets for two non-walk-through floors is less than one inch apart.
  - Learned: The Floor Heights Learn operation has been completed.
  - Saved: The floor heights have been saved on the controller’s iBox.

- **Learn button**: When the *Ready* status light is on, the *Learn* button starts the Floor Heights Learn procedure and the *In progress* status light turns on.

- **Abort button**: The Floor Heights Learn procedure may be halted by clicking the *Abort* button. If the learn procedure is aborted, the last saved complete set of floor height values is retained.

When the *Done* status light turns on, the iBox Learn switch may be set to the *OFF* position.

Click the *Refresh* button ( ) to update the learned floor height information on the Controller view > Configuration > Floor Heights > Configurations tab.
Setup - Floor Heights - Floor Offsets Tab

Used to perform the floor offset calibration procedure. Please refer to “Calibrating the Floor Offsets” on page 4-22.

**Floor offset landing**

- **Landing**: The car’s current landing location.
- **Start landing**: The landing where the floor offset calibration procedure was started.

**Offsets**

- **Detected in**: The detected variance between the car’s current location (position in the hoistway) and the learned position of the landing magnet.
- **Measured in**: The measured distance in decimal inches between the hoistway landing sill and the car sill. Enter a minus (-) value if the car sill was above the landing sill or a plus (+) value if the car sill was below the landing sill.
- **Actual in**: The calculated floor offset. Once the measured values are entered and sent to the iController, this value will appear on the Configuration > Floor Heights > Floor Offset tab.
- **Acquired light**: Lights to indicate that the Detected in value has been acquired and it is OK to measure and record the distance between the landing sill and the car sill.
Setup - Load Weigher Tab

Used to perform the load weigher learn procedure. Please refer to “Load Weigher Learn Procedure” on page 4-33.
**Setup - Safety - Configuration Tab**

The Safety Setup - Configuration tab defines an installation for the safety processors, letting them know what to monitor. It is also used to perform the safety comparison learn operation. If the safety parameters are changed, the learn process must be completed.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulses per foot</td>
<td>256,000</td>
</tr>
<tr>
<td>Contract speed</td>
<td>499.9998 ft/min</td>
</tr>
<tr>
<td>Overspeed margin</td>
<td>5%</td>
</tr>
</tbody>
</table>

- Top access landing
- Top access rear
- Bottom access landing
- Bottom access rear
- No intermediate front door locks
- No intermediate rear door locks

- Emergency Brake
  - Emergency brake
  - Rope gripper
  - Sheave brake

- Normal drop delay: 60 sec
- Inspection drop delay: 0.0 sec

**Learn**

Waiting for Learn switch to turn on:

The system has detected a mismatch between the Main Processor’s safety configuration and the Safety Processors’ safety configuration. To resolve this, the system must relearn the safety configuration.

To learn the safety configuration, please do the following:
1) Obtain “Write Privilege”.

[Learn, Abort, Send]
Configuration

- Pulses per foot: Displays the pulses per foot value sent by the position encoder (iLand).
- Contract speed: Displays the contract speed for the elevator in feet per minute.
- Overspeed 1 margin: Displays the Overspeed 1 margin which is set on the Configuration > Terminal Switches tab. The default value is 8% and should not need to be adjusted. If a car exceeds the Overspeed 1 threshold when a Normal Terminal switch opens, it will be brought to a stop using the Emergency slowdown profile settings. The Overspeed 1 threshold = Learned speed at the switch + Overspeed 1 margin.
- Contract overspeed: Allows you to set the contract overspeed limit at which an overspeed fault will be generated and the car will be brought to an Emergency Stop.
- Inspection overspeed: Allows you to set the inspection overspeed limit at which a car in inspection mode is deemed to be traveling too fast and must be brought to an Emergency Stop.
- Leveling overspeed: Allows you to set the leveling overspeed limit at which a car approaching a destination floor will be deemed to be traveling too fast and must be brought to an Emergency Stop.

Selections made here let iControl know exactly what safety inputs are used on the installation. On start-up, iControl checks the state of the monitored inputs to determine the status of the safety configuration.

- Top access landing: Select if the installation has a top hoistway access floor. If selected, the door lock and door closed contacts (if applicable) for the associated hoistway door must be wired to the DLAT and DCAT iBox inputs, respectively.
- Top access rear: Select if the top access door is a rear door.
- Bottom access landing: Select if the installation has a bottom hoistway access floor. If selected, the door lock and door closed contacts (if applicable) for the associated hoistway door must be wired to the DLAB and DCAB iBox inputs, respectively.
- Bottom access rear: Select if the bottom access door is a rear door.
- No intermediate front door locks: Select if the installation has no door lock contacts wired to the DLMS iBox input. Door lock contacts that should be wired to the DLMS input are front opening hoistway door locks at floors other than the Access floors. Used if all existing front door lock contacts are wired to Access landing inputs (DLAT, DLAB).
- No intermediate rear door locks: Select if the installation has no door lock contacts wired to the DLMS-R iBox Rear Door Expansion board (ICE-IRD) input. Door lock contacts that should be wired to the DLMS-R input are rear opening hoistway door locks at floors other than the Access floors. This option used if all existing rear door lock contacts are wired to Access landing inputs (DLAT, DLAB).
- Front door closed contact: Select if the installation has a front door closed contact string wired to the DCMS iBox input, or to DCAT or DCAB.
- Rear door closed contact: Select if the installation has a rear door closed contact string wired to the DCMS-R iBox Rear Door Expansion Board (ICE-IRD) input, or to DCAT or DCAB.
- Rear doors: Select if the car has rear doors.
- Freight door option 1: Not implemented.
- Car top exit: Select if the car has a top emergency hatch wired to the SP1 iBox input. Wiring the top emergency hatch to the SP1 input is required when the elevator safety code
allows the car to operate with this hatch open during earthquake operation (e.g., ASME A17.1 allows this). Otherwise, the top emergency hatch should be wired in series with other car-mounted safety device contacts, and this option should not be selected.

- **Construction mode**: Select if the car is to operate in construction mode only. Please refer to “Overview of Construction Mode” on page 2-2 for important information about fault generation and required connections unique to construction mode operation.
- **Door position monitor**: Select if the car has a door position monitor contact wired to the iBox DPM input.
- **In car panel inspection**: Select if the car has an in-car inspection switch wired to the iBox INCP input.
- **Bypass switch option**: Factory-enabled/disabled only. Enables/disables the Car and Hoist-way Door Bypass switches on the iBox. This option is factory-set in accordance with applicable jurisdictional requirements.

**Emergency Brake**

Use these parameters if the car has an emergency brake to indicate the type of brake and other brake related parameter settings.

Emergency brake: Select if the car has an emergency brake

- **Rope gripper**: Select if the installation uses a rope gripper (emergency braking device) wired to the iBox Rope Gripper Board (ICE-RG) connections.
- **Sheave brake**: Select if the installation uses a sheave brake (emergency braking device) wired to the iBox Emergency Brake Board (ICE-EB) connections.
  - **Normal drop delay**: On normal (Passenger) operation, after the M-contactor drops, this delay will expire before the sheave brake drops.
  - **Inspection drop delay**: On Inspection operation, after the M-contactor drops, this delay will expire before the sheave brake drops.
- **Monitor cartop and car panel inspection inputs**: Provides monitoring of cartop and car panel inspection inputs required for TSSA certification.

**Learn**

Used to perform the safety comparison. The safety configuration of the job is stored in two locations in iControl. iControl constantly checks current safety information against stored data and also compares the data in the two stored locations to make certain they continue to match. If you make a change on the Safety screen, you will need to do a “learn” operation to write the new data to iControl. The controller is set to match the installation safety configuration, according to the job survey, before being shipped. By default, Construction Mode is enabled before the controller is shipped. You should not have to make changes to the Safety tab until taking the car out of Construction Mode. Please refer to “Learning the Safety Configuration” on page 2-44.
Setup - Safety - Inventory Tab

The Inventory tab is used to perform the Safety Inventory Learn procedure. This procedure must be performed when an inventory fault is generated.

**Status**

The status section provides fault indicators and a list of known safety boards attached to the iBox.

- **Inventory checksum fault indicator**: Indicates that the previously learned value of the inventory checksum does not match the value currently being reported by the safety processors. The inventory learn procedure must be performed before the car can run.
- **Inventory comparison fault indicator**: The Safety boards attached to the iBox do not match the safety board inventory in the safety system. The inventory learn procedure must be performed before the car can run.
- **Set button**: This function is primarily for factory use or for use as instructed by MCE.

**Learn**

These controls are used to perform the safety inventory learn operation. The indicators on the left show the status of the learn operation and the text window provides information and instructions.

- **Learn button**: Learning the inventory causes the safety processors to take an inventory of the boards attached below the ICE-SAF board. When performing the inventory learn procedure, the car must be placed on Inspection mode. Follow the instructions in the display window. When the indicators show Ready, click the Learn button.
- **Erase button**: Causes the values currently stored in the Safety EEPROMS to be erased. This should be used as a last resort when troubleshooting inventory faults. Afterwards, the safety inventory, limit switches and safety configuration must be relearned.
Setup - Terminal Switches Tab
Used to perform the Terminal Learn procedure. Please refer to “Learning Normal & Emergency Terminal Limit Switches” on page 4-9.

- Learn operation indicators: Show progress through the various phases of the Terminal Learn operation.
- Message window: Provides feedback and instructions during the Learn operation.
- Learn button: Starts the Learn operation.
- Abort button: Aborts the Learn operation.
- Default button: Sets the switch Learned Values to values that allow the car to run without activating limit switch faults as long as the car remains in Test operation. The car is not allowed to run on passenger operation until real switch data is learned.
Controller - Safety Tests

The Safety Tests pane provides highly automated control over final system testing performed before the car is turned over to normal operation.

Please refer to “Safety Tests” on page 4-42 for details about running tests from this screen.
Controller - Layouts

With iView, you can move and size tabs to suit the task to be performed. When you find a particularly arrangement to be useful, you can save it as a custom layout (View > Layouts > Save as). You can then display that layout at any time by selecting your custom layout from the View > Layouts > Custom menu.

Some useful layouts have been pre-programmed and are supplied with iView. They include:

- Configuration: This layout displays all of the configuration tabs for easy selection.

- Diagnostics: Displays all of the diagnostic tabs for easy selection.

- Default: Displays the default (initial connection) layout.

- Brake: Used to perform the brake calibration procedure. Displays the Brake setup and configuration tabs plus the hoistway pane.

- Drive: Used to perform the drive offsets calibration. Displays the Five setup and configuration tabs plus the Hoistway pane.

- Floor Heights: Used to perform the hoistway (floor heights) learn operation. Displays the Floor Heights setup and configuration tabs plus the Hoistway pane.

- Load Weigher: Used to perform the Load Weigher learn procedure. Displays the Load Weigher setup and configuration tabs plus the Hoistway pane.

- Motor Field: Used to perform the Motor Field Calibration procedure. Displays the Motor Field setup and configuration tabs plus the Hoistway pane.

- Terminal Switches: Used to perform the Terminal learn procedure. Displays the Terminal Switches setup, configuration and diagnostics tabs plus the Hoistway pane.

- Custom: Used to select a custom layout to be displayed. This is the listing of custom layouts created using View > Layouts > Save as.

- Save As: Used to create and save a custom layout.
  - Enter the name for the custom layout.
  - Click OK.
Call Registration

The Call Registration panel is available while working on any screen in iView.

- Call Registration : Opens the dialog used to register car calls.

To register car calls:

1. Click the Car tab.
2. Select a car from the Car drop-down list (if available).
3. Click Front or Rear.
4. Click a floor button.
5. To close the dialog, click the “X” in the upper right corner.

To register hall calls:

1. Click the Front or Rear tab (or Hall tab if the car has only front doors).
2. Click the Up Main, Down Main, Up Auxiliary, Down Auxiliary, CFSS1 or CFSS2 call button.
3. Click the desired floor button(s).
4. To close the dialog, click the “X” in the upper right corner.
About this Section

This section contains detailed information about:

- Selecting System View:
- System View Windows and tabs: A complete list of System view windows and tabs, and information about the parameters on each.

Selecting System View

iView is used to view and adjust the Controller and System parameters. iView is divided into two main sections:

- Controller View - used to view and adjust the controller parameters, e.g., Brake, Drive, Pattern, Car Operation, etc. When iView first connects to an iController, the Controller view is displayed. Please refer to “Selecting Controller View” on page 9-1.
- System View - used to view and adjust the System parameters, e.g., Dispatching, Parking, Emergency Power, Security, etc. When iView is connected to a central dispatcher (iCentral), the Controller and System buttons are missing and System view is always displayed.

To select System view, click the System view button at the top of the iView screen.
System View Windows and Tabs

System View displays parameters, controls and diagnostics pertaining to system functions, e.g., hall calls, dispatching, parking, security, emergency power, etc. The parameters displayed in System view vary depending the type of controller and how it is configured (simplex, local, swing, local / dispatcher or central dispatcher). Please refer to “An Overview of System Options” on page 10-4. Table 10.1 lists the locations where the System parameters and settings are explained. If you are viewing this as a PDF file, click the page number link to jump to the description of the parameters on that tab.

Table 10.1  System View Windows and Tabs

<table>
<thead>
<tr>
<th>Windows</th>
<th>Tabs</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Tabs</td>
<td>System Configuration</td>
<td>page 10-6</td>
</tr>
<tr>
<td></td>
<td>Emergency Power</td>
<td>page 10-33</td>
</tr>
<tr>
<td></td>
<td>Legacy Group Interface</td>
<td>page 10-36</td>
</tr>
<tr>
<td></td>
<td>Security</td>
<td>page 10-38</td>
</tr>
<tr>
<td></td>
<td>System I/O</td>
<td>page 10-51</td>
</tr>
<tr>
<td></td>
<td>Timer Tables</td>
<td>page 10-62</td>
</tr>
<tr>
<td></td>
<td>User Events</td>
<td>page 10-65</td>
</tr>
<tr>
<td></td>
<td>Remote Outputs</td>
<td>page 10-66</td>
</tr>
<tr>
<td>Diagnostic Tabs</td>
<td>Event Log</td>
<td>page 10-68</td>
</tr>
<tr>
<td>Hoistway</td>
<td></td>
<td>page 10-70</td>
</tr>
<tr>
<td>System Performance</td>
<td></td>
<td>page 10-74</td>
</tr>
<tr>
<td>Layouts</td>
<td>Configuration</td>
<td>page 10-75</td>
</tr>
<tr>
<td></td>
<td>Diagnostics</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Custom</td>
<td></td>
</tr>
</tbody>
</table>

Button Bar

Table 9.2 lists the locations where the functions of the buttons are explained.

Table 10.2  Buttons and Dialogs

<table>
<thead>
<tr>
<th>Buttons / Dialogs</th>
<th>Description</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Connection</td>
<td>Displays the Open dialog</td>
<td>page 8-11</td>
</tr>
<tr>
<td>Open Configuration File</td>
<td>Displays the Open Configuration File dialog</td>
<td>page 8-22</td>
</tr>
<tr>
<td>Save Configuration File</td>
<td>Displays the Save Configuration File dialog</td>
<td>page 8-20</td>
</tr>
<tr>
<td>Call Registration</td>
<td>Place car calls and hall calls</td>
<td>page 10-73</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refreshes the parameters being displayed</td>
<td></td>
</tr>
<tr>
<td>Firmware Update</td>
<td>Update the iBox imbedded firmware</td>
<td>page 8-41</td>
</tr>
<tr>
<td>Controller</td>
<td>Causes the Controller view to be displayed</td>
<td>page 9-1</td>
</tr>
<tr>
<td>System</td>
<td>Causes the System view to be displayed</td>
<td>page 10-1</td>
</tr>
</tbody>
</table>
iView Status Bar

The status bar at the bottom of the iView screen provides the following information:

- **Connection Status**: Connected arrows, shown above, indicate that iView is communicating with the controller. Broken arrows indicate that the connection has been broken.

- **Write Privilege Status**: An unlocked lock, shown above, indicates that this connection does not have write privilege. A locked lock indicates that write privilege has been granted.

- **Controller Type**: Indicates the type of controller to which iView is connected. For a description of each type see “An Overview of System Options” on page 10-4. The controller types include:
  - Simplex - a single car that is not part of a group.
  - Local - a car that is part of a group.
  - Local (Swing) - a local car that can swing away (detach from the group).
  - Swing - a local car that is currently detached from the group and is acting like a simplex.
  - Local (Alternate Dispatcher) - a local car that can assume dispatching responsibilities.
  - Local / Dispatcher - a local car that is also currently the dispatcher. iCue dispatching software is running on the local car’s iBox.
  - iCentral - a central dispatcher with iCue dispatching software running on a dedicated PC or embedded microcontroller.
An Overview of System Options

Depending on user needs, the iControl System can be configured in a number of ways. System functions can be performed by a central dispatcher (iCentral). In addition, each iController can perform certain system functions depending on its configuration (Simplex, Local, Swing or Local / Dispatcher).

The following are brief descriptions of the various ways in which iControl can be configured. Please refer to “iControl System Options” on page 10-5 for additional information.

**Simplex**

An elevator operating alone, not connected to a group, is called a Simplex. The parameters which control the Hall Call Eligibility, Parking, Parking Eligibility, etc. are programmed on the car controller’s System View tabs. Simplex operation is enabled via the Simplex car parameter on the Controller > Configuration > General > General tab (see “Configuration - General” on page 9-97).

**Local**

MCE uses the term Local to refer to an individual car that is part of a group of elevators. Dispatching and parking functions for a Local are performed by either a Local / Dispatcher or a Central Dispatcher. The only System parameter used by a Local car is the Car label on the System Configuration > Building tab.

**Swing - Local (Swing)**

Local (Swing) is displayed on the iView status bar when a Local car has been configured so that it can, on command, operate independent of the group using an auxiliary hall call riser. Swing is displayed when the car is actually on swing operation. The parameters which control the Hall Call Eligibility, Parking, Parking Eligibility and (if applicable) CFSS and Security while the car is on Swing operation, are programmed on the Swing car’s System View tabs and stored on the Swing car controller. Automatic Swing operation, is enabled via the Automatic Swing Operation Enable parameter on the Controller > Configuration > Passenger tab (see “Car Operation - Passenger Tab” on page 9-39). Swing operation can also be initiated using the Swing Operation Switch input which can be programmed using the Controller > Configuration > I/O Boards tab (see “Configuration - I/O Boards” on page 9-102).

**Local / Dispatcher - Local (Alternate Dispatcher)**

Beginning with the December 2006 Release, in addition to performing car control functions, iControllers can assume full dispatching responsibilities for a group of elevators. Local / Dispatcher is displayed on the status bar of a Local car that is performing the dispatching functions. One or more Local cars can be designated as an Alternate Dispatcher, meaning that they can act as a backup for a central dispatcher or as one of several potential dispatchers for a group than has no central dispatcher. The Alternate Dispatcher controls on the System Configuration > Building tab are used to designate the cars and preference order for selecting the Local / Dispatcher (see “Building” on page 10-7). The Dispatching, Hall Call Eligibility, Parking, etc. parameters are programmed on the System tabs of the car that is currently the Local / Dispatcher. These settings are automatically copied to all cars designated as Alternate Dispatcher.

**iCentral**

A central dispatcher (iCentral) can be used to perform the dispatching functions for a group of iControllers. The iCue dispatching software runs on a dedicated PC or embedded microcontroller. This solution is used for the most demanding iControl systems. When iView connects to a central dispatcher, iCentral is displayed on the status bar and iView displays only the System view windows and tabs. The Dispatching, Hall Call Eligibility, Parking, etc. parameters are programmed on the central dispatcher’s System tabs and are automatically copied to all cars designated as Alternate Dispatcher.
An Overview of System Options

<table>
<thead>
<tr>
<th>System Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>iCentral</strong></td>
<td>Performs dispatching and group management functions for an elevator group. Connect to iCue PC using a unique iView connection.</td>
</tr>
<tr>
<td><strong>iController</strong></td>
<td>Connect to iController using a unique iView connection.</td>
</tr>
<tr>
<td><strong>iCue PC</strong></td>
<td></td>
</tr>
<tr>
<td><strong>iBox computer</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Car Control</strong></td>
<td>Manages the operation (call requests, door operation, movement, etc.) of an elevator using the Controller parameters.</td>
</tr>
<tr>
<td><strong>System Control</strong></td>
<td>Can be configured as a Simplex, Local, Swing, or Local /Dispatcher.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>System Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Simplex</strong></td>
<td>(Not part of a group)</td>
</tr>
<tr>
<td></td>
<td>The following system parameters are set and stored on the Simplex car controller:</td>
</tr>
<tr>
<td></td>
<td><strong>System parameters used</strong></td>
</tr>
<tr>
<td></td>
<td>Building Configuration</td>
</tr>
<tr>
<td></td>
<td>Hall call eligibility, Parking eligibility, Parking configurations CFSS</td>
</tr>
<tr>
<td></td>
<td>Emergency Power Security System I/O</td>
</tr>
<tr>
<td><strong>Local</strong></td>
<td>(Part of a group)</td>
</tr>
<tr>
<td></td>
<td>Dispatching functions are performed by an iCentral or a Local /Dispatcher.</td>
</tr>
<tr>
<td></td>
<td>Dispatching parameters on this car are not used.</td>
</tr>
<tr>
<td><strong>Swing</strong></td>
<td>(Local car, sometimes acts as a simplex)</td>
</tr>
<tr>
<td></td>
<td>When not on Swing operation, dispatching is performed by the an iCentral or a Local / Dispatcher using the parameters set on the iCentral or Local / Dispatcher. When the car is on Swing operation the following parameters set and stored on the Swing car are used:</td>
</tr>
<tr>
<td><strong>Local / Dispatcher</strong></td>
<td>Performs the dispatching and group management functions for a group of elevators. Can be a backup for an iCentral (full dispatching capabilities).</td>
</tr>
<tr>
<td></td>
<td>All system parameters are set on the current Local / Dispatcher and passed to designated Alternate Dispatchers.</td>
</tr>
<tr>
<td><strong>System parameters used</strong></td>
<td>Building configuration</td>
</tr>
<tr>
<td></td>
<td>Hall call eligibility, Parking eligibility, Parking configurations CFSS</td>
</tr>
<tr>
<td></td>
<td>Emergency Power Security System I/O</td>
</tr>
<tr>
<td><strong>Configuration</strong></td>
<td>Brake Car Call Enable Car Operation Drive Floor Heights General I/O Boards iBox configuration Load Weigher Motor Field Pattern Terminal Switches Timer Tables Custom Outputs User Inputs</td>
</tr>
<tr>
<td><strong>Diagnostics</strong></td>
<td>Diagnostic Outputs Event Log Fault Bypass Terminal Switches</td>
</tr>
<tr>
<td><strong>Setups</strong></td>
<td>Data Trap Hoistway Outputs Safety Tests Virtual Oscilloscope Layouts</td>
</tr>
</tbody>
</table>

| **Group Management**    | Emergency Power Security System I/O                                                                                                        |
| **Dispatching**         | Building configuration Hall call eligibility Parking Parking eligibility Parking configurations CFSS                                           |
| **System Parameters**   | Building configuration Hall call eligibility Parking eligibility Parking configurations CFSS Emergency Power Security System I/O               |
|                         | System I/O                                                                                                                                     |

| **System Performance**  | Event Log                                                                                                                                    |
| **System Event Log**    |                                                                                                                                              |

| **Cross cancellation**  |                                                                                                                                              |
| **Cross registration**  |                                                                                                                                              |

Figure 10.1    An Overview of System Options

<table>
<thead>
<tr>
<th>An iController can be configured as one of the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Simplex</strong></td>
</tr>
<tr>
<td>(Not part of a group)</td>
</tr>
<tr>
<td>The following system parameters are set and stored on the Simplex car controller:</td>
</tr>
<tr>
<td><strong>System parameters used</strong></td>
</tr>
<tr>
<td>Building Configuration</td>
</tr>
<tr>
<td>Hall call eligibility, Parking eligibility, Parking configurations CFSS</td>
</tr>
<tr>
<td>Emergency Power Security System I/O</td>
</tr>
<tr>
<td><strong>Local</strong></td>
</tr>
<tr>
<td>(Part of a group)</td>
</tr>
<tr>
<td>Dispatching functions are performed by an iCentral or a Local /Dispatcher.</td>
</tr>
<tr>
<td>Dispatching parameters on this car are not used.</td>
</tr>
<tr>
<td><strong>Swing</strong></td>
</tr>
<tr>
<td>(Local car, sometimes acts as a simplex)</td>
</tr>
<tr>
<td>When not on Swing operation, dispatching is performed by the an iCentral or a Local / Dispatcher using the parameters set on the iCentral or Local / Dispatcher. When the car is on Swing operation the following parameters set and stored on the Swing car are used:</td>
</tr>
<tr>
<td><strong>Local / Dispatcher</strong></td>
</tr>
<tr>
<td>Performs the dispatching and group management functions for a group of elevators. Can be a backup for an iCentral (full dispatching capabilities).</td>
</tr>
<tr>
<td>All system parameters are set on the current Local / Dispatcher and passed to designated Alternate Dispatchers.</td>
</tr>
<tr>
<td><strong>System parameters used</strong></td>
</tr>
<tr>
<td>Building configuration</td>
</tr>
<tr>
<td>Hall call eligibility, Parking eligibility, Parking configurations CFSS</td>
</tr>
<tr>
<td>Emergency Power Security System I/O</td>
</tr>
<tr>
<td><strong>Security</strong></td>
</tr>
<tr>
<td>System I/O</td>
</tr>
<tr>
<td><strong>System Performance</strong></td>
</tr>
<tr>
<td>Event Log</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>System Parameters</strong></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configuration</strong></td>
<td>Brake Car Call Enable Car Operation Drive Floor Heights General I/O Boards iBox configuration Load Weigher Motor Field Pattern Terminal Switches Timer Tables Custom Outputs User Inputs</td>
</tr>
<tr>
<td><strong>Diagnostics</strong></td>
<td>Diagnostic Outputs Event Log Fault Bypass Terminal Switches</td>
</tr>
<tr>
<td><strong>Setups</strong></td>
<td>Data Trap Hoistway Outputs Safety Tests Virtual Oscilloscope Layouts</td>
</tr>
</tbody>
</table>

An iController can be configured as one of the following: Simplex (Not part of a group) Local (Part of a group) Swing (Local car, sometimes acts as a simplex) Local / Dispatcher (Performs the dispatching and group management functions for a group of elevators. Can be a backup for an iCentral (full dispatching capabilities).) All system parameters are set on the current Local / Dispatcher and passed to designated Alternate Dispatchers. System parameters used Building configuration Hall call eligibility, Parking eligibility, Parking configurations CFSS Emergency Power Security System I/O Security System I/O System Performance Event Log.
System Configuration tab

The System Configuration tab is used to program the dispatching parameters for a Simplex car, Swing car, or AGC (Local Dispatcher). This tab provides access to controls affecting dispatching, parking, operational modes, etc.

Through the tree on the left side of this tab, you can access:

- **Building**: Set the highest floor served, number of cars, floor and car labels, etc. *(see page 10-7).*
- **CFSS**: Set recall-to-floor eligibility when operating in a Commander for Special Service mode *(see page 10-9).*
- **Dispatching**: General dispatching controls *(see page 10-11).*
- **Hall Call Eligibility**: On a per-floor, per-configuration basis (1 — 8), select the hall calls to which the car(s) may respond *(see page 10-13).*
- **Mode of Operation**: Setup the dispatching mode of operation parameters and configurations *(see page 10-14).*
- **Parking**: Set parking options and floors for Parking configurations *(see page 10-20).*
- **Parking Eligibility**: On per-configuration basis (1 — 8), set the parking eligibility parameters for the car *(see page 10-27).*
- **Split Bank**: Split Bank operation is available only on the Central Dispatcher *(see page 10-29).*
- **Management**: Provides access to the following:
  - **Remote Monitoring Authorization**: Use to authorize a third party remote monitoring tool to connect to iControl *(see page 10-31).*
  - **Local Dispatcher**: Use to force the system to resend the system parameters to all connected cars *(see page 10-32).*
Building

The Building page is used to set the highest floor served, number of cars, floor and car labels, job name and number, and to program Local / Dispatcher selection parameters.

Floors

- **Floors**: Indicates the highest floor served by this car.
- **Floor label**: If desired, provide a label, up to three characters, for any or all floors. Highlight the default floor label (number) and type a new label. Click Send when you have finished setting parameters on this page.

Cars

- **Cars**: Indicates the number of cars in the group. If this is a Simplex the default is 1 and the parameter is read only.
- **Car label**: If desired provide a label for the car(s), up to three characters.

Job Information

- **Job name**: Indicates the name of the job.
- **MCE job number**: Indicates the job number assigned by MCE.
Dispatcher Displays a car identifier of the car that is currently the Local/Dispatcher or iCentral to indicate that the central dispatcher is doing the dispatching.

Alternate Dispatcher Use these controls to designate which car(s) can be the Local/Dispatcher and to manually select or auto-select a different car to be the Local/Dispatcher.

- **Manual Select button:** When iView is connected to the Local/Dispatcher, this button can be used to manually select any car on the Alternate Dispatcher list to be the Local/Dispatcher. Choose the desired car from the Cars drop down list. When iView is connected to any other car in the Alternate Dispatcher list (not the Local/Dispatcher), only the car to which iView is connected can be manually selected to be the Local/Dispatcher.

- **Auto Select button:** When iView is connected to the Local/Dispatcher, this button can be used to request that another car on the Alternate Dispatcher list be auto-selected to be the Local/Dispatcher.

- **Auto-select Preference Order:** This control is used to designate which cars can become the Local/Dispatcher and the order in which they are to be selected. Initially all cars are shown in the Local Cars list.
  1. Click to select cars in the Local Cars list and use the right arrow to move them into the Alternate Dispatcher list.
  2. Click to select cars in the Alternate Dispatcher list and use the Up and Down buttons to place them in the desired order. The highest on the list is selected first. If the first on the list is not available, the next on the list is selected, and so forth. Once a car has assumed the Local Dispatcher roll it continues in that roll even if a car that is higher on the list becomes available.
  3. To remove a car from the Alternate Dispatcher list, click to select the car and use the left arrow to move it to the Local Cars list.

**Caution**
The “Auto-select Preference Order” settings must be identical for every car within a group of elevators. Please refer to “Before connecting the “System” ethernet cable to the iBox:” on page 2-29.

**Group ID:** The Group ID (1) cannot be changed. All other IDs are reserved for future use. If you need advanced System addressing information please contact MCE.
CFSS (Commandeer for Special Services)

This tab allows you to set car recall floor eligibility for Commandeer For Special Service operation. Car behavior during CFSS recall and operation is determined on the Controller > Configuration - Car operation > CFSS tab. Please refer to “Car Operation - CFSS Tab” on page 9-75.

**To program a CFSS Configuration**

- Select a CFSS configuration (1 through 2): Select the CFSS configuration you wish to edit.
- Maximum number of cars to operate on CFSS Mode “n” at the same time: Set the number of cars allowed to be in CFSS mode “n” at the same time. (Not pertinent to Simplex operation.)
- Allow multiple CFSS Mode “n” hall calls per car: If multiple CFSS recall hall switches are simultaneously latched for this mode, they will be serviced (recall/CFSS in-car/release) in the sequence in which they were registered.
Making Settings Per-Car    Verify the “Select a car to configure (1) drop-down box. (There must also be a CFSS recall switch physically at the eligible Front or Rear door locations on a floor selected to be eligible to initiate CFSS recall.)

Enable individual floor/recall location eligibility. You can make a selection in a few different ways:

- Click in the door/hall call column in the desired floor row to enable or disable.
- Click and drag in a column to select multiple floors, then click the Select control to allow calls or the Deselect control to restrict calls.
- Click in the column head (i.e., Front) to highlight the entire column (all floors), then use the system-wide Select calls or Deselect calls controls.

Auto-select Preference Order    This list defines the order in which CFSS calls are assigned. The dispatcher selects the first available car in the priority list to assign a new call. If there are no cars from the Priority Cars list available for a new CFSS call, the best available car from the Non-priority Cars list shall be assigned the call. Initially, all cars are shown in the Non-priority Cars list.

1. To move cars to the Priority Cars list, click to select cars in the Non-priority Cars list and use the right arrow to move them to the Priority Cars list, as desired.
2. Click to select cars in the Priority Cars list and use the Up and Down buttons to place them in the desired order. The highest on the list is selected first. If the first on the list is not available, the next on the list is selected, and so fourth.
3. To remove a car from the Priority Cars list, click to select the car and use the left arrow to move it to the Non-priority Cars list.
Dispatching - Options

Dispatching options allow you to set up conditions that favor the assignment of one car or another.

When assigning hall calls to cars, iControl determines which car can respond in the least time considering where each car is, its direction of travel, parking assignment and status (moving or idle). By adding bonus or penalty seconds to the response time under certain conditions, you can influence dispatching assignments.

- **Car at same floor bonus**: If a car is at the same floor as a newly-registered hall call, credit its response time (favor its assignment) by the set number of seconds.
- **Coincidence call bonus**: If a car is on its way to a floor when a hall call is registered from that same floor, credit its response time (favor its assignment) by the set time in seconds.
- **Retask penalty**: When considering reassigning a call from one car to another to improve response time, debit the response time of all cars except the one to which the call is currently assigned (penalize reassignment) by the set number of seconds.
- **Move lobby parked car penalty**: When making a hall call assignment or reassignment, debit the response time of any car parked at a lobby (penalize its assignment) by the set number of seconds. (This allows you to skew the decision in favor of keeping the lobby parked cars available at the lobby.)
- **Move non-lobby parked car penalty**: When making a hall call assignment or reassignment, debit the response time of any car parked at non-lobby floors (penalize its assignment) by the set number of seconds. (This allows you to skew the decision in favor of keeping parked cars available at their parking floor.)
- **Move idle car penalty**: When making a hall call assignment or reassignment, debit the response time of any idle car (penalize its assignment) by the set number of seconds.
- **Allow same floor hall calls to reverse doors on a departing car**: If enabled, a hall call placed at the floor/riser where a car is preparing to depart (closing its doors) will cause the doors to reopen.
Dispatching - Configurations

These controls determine how four types of pre-programmed dispatching configurations are selected to be the active configuration. Up to eight configurations of each type can be programmed.

- Dispatching configuration: The currently active configuration can be selected manually (Manual) or by a timer schedule (Timed).

- Configurations:
  - **Manual**: When Dispatching configuration is set to manual, you can select which configuration is active in the Manual column. When a setting is changed, it becomes active after you Send it to the controller.
  - **Timed**: Select Timed to have the currently active configurations determined via timer table. Please refer to “Configuration Tabs - Timer Tables (System)” on page 10-62.
  - **Active**: The dispatching configurations that are currently active are shown in the “Active” column. The four types of dispatching configurations are:
    - Hall Call Eligibility
    - Parking
    - Parking Eligibility
    - Mode of Operation

The configurations you are selecting here are configured on the screen tabs of the same name.
Hall Call Eligibility

Use these controls to create up to eight different Hall Call Eligibility configurations. Each configuration includes eligibility permissions/restrictions for the car. The active configuration can be selected and run manually or by timer table.

The following controls are found on the Hall Call Eligibility tab.

- Select the Hall Call Eligibility configuration (1 - 8) you want to create or edit.
- Convert Front (Rear) Auxiliary Hall Call Riser to Front (Rear) Main Hall Call Riser: If, when this configuration is active, you want one or both of the auxiliary hall risers to function as additional sets of main risers, enable the appropriate choice.
- Select car to configure: For a Simplex this will default to 1.

Eligibility Table For each floor (listed in the left-most column), a check mark in any of the remaining columns indicates that the associated hall call is eligible to be registered at that floor. You can make a selection in a few different ways:

1. Click in individual cells to enable or disable, or
2. Click and drag in a column to select multiple floors, then click to Select allow calls or Deselect to restrict calls, or
3. Click in the column head (i.e., Front Main Up) to highlight the entire column (all floors), then use the Select or Deselect buttons.
4. When you are satisfied with your settings, click Send to send the data to the iBox.
5. Continue to create configurations (up to eight) as needed.
Mode of Operation

Use these controls to create or edit up to eight Mode of operation configurations. Each configuration, when active, determines and defines the dispatching mode. The currently active configuration can be selected manually (Dispatching > Configuration tab) or by timer table.

Select a Configuration

- Select a mode of operation configuration to edit/create (1 — 8). Screen information will automatically update when a configuration is selected.

Mode of Operation

Specifies the dispatching mode to be used when the selected configuration is active. The options are:

- Automatic: The dispatching mode (Balanced, Demand Up Peak, or Demand down peak) is automatically selected depending on building demands.
- Balanced: Selects balanced dispatching, favoring neither up nor down traffic.
- Lobby Peak: Favors lobby traffic (not applicable to simplex operation).
- Demand up peak: Typically used during morning arrival when demand is predominantly in the up direction. The controller keeps track of bypassed call demands, which occur when the car becomes heavily loaded, and manages call assignments to ensure that no calls are ignored due to heavy loads.
- Demand down peak: Typically used during afternoon departure when demand is predominantly in the down direction. The controller keeps track of bypassed call demands, which occur when the car becomes heavily loaded, and manages call assignments to ensure that no calls are ignored due to heavy loads.
To edit or change the mode currently assigned to the selected configuration:

1. Select the mode of operation configuration number.
2. Select the mode of operation you want enabled when the configuration is active:
   - Automatic
   - Balanced
   - Lobby peak
   - Demand Up Peak
   - Demand Down Peak

**Automatic**
iControl will automatically determine which operating mode to use at any one time. The Automatic “sub controls” allow you to fine tune the selection criteria. The “hysteresis” timer set here affects every mode change made automatically for the selected configuration. The timer says that, “after changing modes, it cannot change again for X minutes.” This prevents rapid changes in traffic data from forcing operating modes to change constantly (which would disrupt service efficiency).

<table>
<thead>
<tr>
<th>Mode hysteresis timer</th>
<th>2 min</th>
</tr>
</thead>
</table>

**Lobby Peak Detection Criteria**  
Lets you fine tune the criteria that will cause iControl to detect a need to select Lobby Peak operation.

- **Allow lobby peak detection**: If you want iControl to detect the need to switch to lobby peak operation, enable this check box.
- **Lobby peak loaded car detection method**:
  - **Load weigher**: iControl will automatically engage Lobby Peak mode as determined by factoring the number of successive heavy load cars leaving the lobby with the interval between when a car leaves the lobby and when the next lobby hall call is registered. Uses the “Number of loaded cars to initiate lobby peak” setting.
  - **Car calls**: iControl will automatically engage Lobby Peak based on successive cars departing the lobby with a car call quantity equal to or greater than that set here. Uses the “Number of car calls to consider car loaded” setting.
**Lobby Peak Options**  
Allows you to fine tune system behavior when Lobby Peak is automatically selected by the group control.

- **Always keep at least Car(s) in balanced mode**: If you want to hold one or more cars in balanced service mode (non lobby peak) when lobby peak is active, set that number of cars here.

1. **Set lobby door dwell time.** (The time the doors stand open before attempting to close.)
2. **During busy conditions, you can choose to employ load weigher monitoring or car call monitoring to decrease door dwell time and prepare the car to leave the lobby:**
   - **Use load weigher monitoring**: If you want the load weigher used to determine when door dwell should be shortened. When the car weight reaches the “heavy load” setting (car controller Load Weigher screen setting), the doors will begin closing in preparation to leave the lobby.
   - **Use car call monitoring**: If you want to monitor the number of calls placed in the car to determine when door dwell should be shortened. When the number of car calls placed reaches the quantity set here, the doors will begin closing in preparation to leave the lobby.
3. **If desired, you can set a (dynamic) percentage of the “in-use” cars to use for lobby peak service at this lobby floor.** (For example, this is useful if the group is split between two lobbies and you want 50% of the available cars servicing one and 50% of the available cars servicing the other.)
4. **Choose to use only specific cars for lobby peak service and even set the priority in which you want them used.** (Higher position in list = use first.)
Demand Peak Detection Criteria  Sets the conditions under which iControl will automatically enable demand peak operation.

- Allow demand up peak detection: Enable to allow iControl to detect demand up peak conditions.
- Allow demand down peak detection: Enable to allow iControl to detect demand down peak conditions.
- Peak detection hall call percentage volume: When the percentage of hall calls in one direction (up or down), equals or exceeds this percentage of total hall calls, iControl will select demand peak operation in that direction. A typical setting is 75 to 80%.
- Number of floors with peak direction hall calls: When the number of floors with hall calls in one direction (up or down) exceeds this number, iControl will select demand peak operation in that direction.

Demand Peak Options  Fine tunes system behavior when demand peak is active.

- Non-peak hall call assignment penalty: When demand peak operation is active, hall calls in the non-peak direction (i.e., up calls during Demand Down operation), receive lower priority service. If both peak and non-peak direction hall calls are active, the dispatcher compares how long each has been registered when deciding which will be assigned the next available car. The time entered here is subtracted from the non-peak direction call registered time, causing the peak direction call to be favored.

Balanced
Balanced mode provides equal treatment for up and down calls, favoring neither up nor down traffic.
**Lobby Peak**

When active by manual or timer selection, operates group cars in Lobby Peak mode.

To configure Lobby Peak:

- **Select a lobby to configure.**
- **Settings Per Lobby:**
  1. For the selected lobby (1 or 2), enable or disable Lobby peak mode operation.
  2. Set the lobby floor.
  3. Set lobby door dwell time. (The time the doors stand open before attempting to close.)
  4. During busy conditions, you can choose to employ load weigher monitoring or car call monitoring to decrease door dwell time and prepare the car to leave the lobby:
     - **Use load weigher monitoring...:** If you want the load weigher used to determine when door dwell should be shortened. When the car weight reaches the “heavy load” setting (car controller Load Weigher screen setting), the doors will begin closing in preparation to leave the lobby.
     - **Use car call monitoring...:** If you want to monitor the number of calls placed in the car to determine when door dwell should be shortened. When the number of car calls placed reaches the quantity set here, the doors will begin closing in preparation to leave the lobby.
5. If desired, you can set a (dynamic) percentage of the “in-use” cars to use for lobby peak service at this lobby floor. (For example, this is useful if the group is split between two lobbies and you want 50% of the available cars servicing one and 50% of the available cars servicing the other.)

6. Select the direction of peak traffic from this lobby (Up or Down).

7. Select the call types available in the lobby.

8. Finally, you can choose to use only specific cars for lobby peak service and even set the priority in which you want them used. (Higher position in list = use first.)

Demand Up Peak

Demand Up Peak is generally used during hours when traffic demand in the building is largely in the up direction.

- Main exit floor: If much of the traffic is exiting at a particular floor (i.e., the main employer in an office building), setting that floor number here will allow the system to assign calls so that floor receives the best possible service.

- Non-peak hall call assignment penalty: Favors demand up peak calls by adding the number of seconds entered here to their time of registration, making them appear to have been registered sooner and thus have more priority.

- Peak hall call types: If appropriate, allows you to select those risers on which up hall calls will be identified as demand up peak calls.

Demand Down Peak

Demand Down Peak is generally used during hours when traffic demand in the building is largely in the down direction.

- Main exit floor: If much of the traffic is exiting at a particular floor (i.e., the lobby), setting that floor number here will allow the system to assign calls so that floor receives the best possible service.
- Non-peak hall call assignment penalty: Favors demand down peak calls by adding the number of seconds entered here to their time of registration, making them appear to have been registered sooner and thus have more priority.
- Peak hall call types: If appropriate, allows you to select those risers on which down hall calls will be identified as demand down peak calls.

Parking
Create up to eight different Parking configurations. Each configuration tells iControl how and where to park the car when it is idle and how long to wait before parking an idle car at a lobby or non-lobby floor. Parking configurations are selected manually (Dispatching tab) or by timer table. The car will park only when idle and eligible to park, will re-park only if eligibility or parking configuration changes, and will un-park only if there is a change of status (i.e., hall call demand, car call demand, out-of-service, inspection, etc.).

```
System Configuration

Parking

| Select a parking configuration (1 thru 8) | 1
| Parking method | Per floor parking |

General

- Enable sector dispatching

Parking options

- Lobby parking delay: 2 sec
- Lobby shuffle delay: 10 sec
- Non-Lobby parking delay: 20 sec
- Non-Lobby shuffle delay: 10 sec

Parking floors

- Hall call demand dynamic parking

<table>
<thead>
<tr>
<th>Front Door Time</th>
<th>Rear Door Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lobby</td>
<td>Closed</td>
</tr>
<tr>
<td>Non-Lobby</td>
<td>Closed</td>
</tr>
</tbody>
</table>

Edit

User setting

<table>
<thead>
<tr>
<th>Priority</th>
<th>Floor</th>
<th>Front Doors</th>
<th>Rear Doors</th>
</tr>
</thead>
</table>

Add
```

Parking Configuration
For each Parking configuration, users may choose to allow iControl to determine the optimal parking configuration at any given time or to manually define a parking floor (lobby or non-lobby for each configuration):

- **User setting**: On a per-configuration basis, the user defines priority (lobby or non-lobby) and car door behavior at the selected parking floor.
- **Dynamic**: iControl predicts building hall call demand and parks the car accordingly, determining optimal parking configuration on an ongoing basis.
- **Combination**: The user programs essential floors only, leaving other floor entries blank. When acting as the Backup Dispatcher, once user-defined parking floors are served, iControl will park the remaining idle cars automatically.

**Parking Configurations**
1. Select a Parking configuration to edit/create (1 — 8). Screen information will automatically update when a configuration is selected.
2. Select a Parking method:
   - **Per floor parking**: Parking is assigned on a per floor basis.
   - **Sector parking**: The building is divided into a number of user-defined sectors (contiguous group of floors) and parking assignments are based on those sectors rather than upon individual floors. The Parking floors pane will change to indicate floors or sectors depending on the method selected. The user may also choose to enable Sector dispatching, causing the dispatcher to consider parking assignments and through-sector travel when making call assignments.

**Set Parking Delay Timers**
These delay timers are used by both user-defined and dynamic parking behaviors.

- **Lobby parking delay**: When a car becomes idle (no call demand), this parameter determines the minimum time before it may be moved to a lobby parking floor.
- **Lobby Shuffle delay**: When a lobby parking floor becomes available, this parameter determines the delay before requesting that a car parked at a non-lobby parking floor be shuffled to a lobby parking floor.
- **Non-lobby parking delay**: When a car becomes idle, this parameter determines the minimum time before it may be moved to a non-lobby parking floor. If no lobby or non-lobby parking floors are available, the car will remain idle at the last floor served.
- **Non-lobby shuffle delay**: When a car is parked at a non-lobby parking floor, this parameter determines the minimum time it must remain at that floor before it may be shuffled to a lobby parking floor.

Parking delay timers ensure that the car is not constantly parked and re-parked in response to momentary system conditions.
Choose Dynamic or User-Defined Parking

If you enable only dynamic parking, iControl will automatically control parking behavior for the car. If you enable only user-defined parking, the floor selection assigned the highest priority will be the parking floor.

Note

Floors assigned a priority from 1 to 4 are recognized as lobby floors for purposes or door behavior.

If there is only one car in this “group,” you should assign only one floor per parking configuration. If you assign more than one floor, only the highest priority floor will be selected for parking. The priority setting is useful in assigning lobby (1-4) or non-lobby (5+) door behavior.

Dynamic Door Times

Edit door behavior for cars parking at lobby and non-lobby floors:

1. With dynamic parking enabled, select either the Lobby or the Non Lobby row.
2. Click Edit.
3. Choose whether the car should park with front and/or rear doors closed, open, or open for a number of seconds, then closed.
4. Click OK after making settings.
**Per Floor Parking - User Defined Priority, Floor, and Door Times**  
To select priority, parking floor, and door times manually when the Parking method is set to “Per floor parking”:

1. Select an entry row in the list and click Edit, or click Add if you are adding a new entry to an unfilled table. (You may assign as many parking/floor sets as you have cars in the group. If you want multiple cars to park at the same floor, set up multiple, identical entries for that floor.)

![User setting table](image)

2. Assign a priority of 1 through 4 to the floor if you want it recognized as the lobby floor for this configuration.

**Note**

Priorities 1 through 4 are treated as lobby parking floors (use lobby delay timers). Remaining priorities are treated as non-lobby floors. Start and End floor selections are active only when Sector parking has been chosen.

3. Select the parking floor.
4. Choose whether cars should park with front and/or rear doors closed, open, or open for a number of seconds, then closed.
5. Click OK after making settings.
6. Continue selecting and setting additional priority/floor sets as needed.
Sector Parking - User Defined Priority, Floor, and Door Times  
To define sectors, select priority, parking floor within the sector, and door times manually when Parking method is set to “Sector parking”:

1. Select an entry row in the list and click Edit, or click Add if you are adding a new entry to an unfilled table. (You may assign as many parking/floor sets as you have cars in the group. If you want multiple cars to park at the same floor, set up multiple, identical entries for that floor.)

2. Select a Priority. The higher the priority, the more iControl will attempt to maintain a parked car in the sector. One (1) is the highest priority.

**Note**
Priorities 1 through 4 are treated as lobby parking sectors (use lobby delay timers). Remaining priorities are treated as non-lobby sectors.

3. Select the preferred parking floor within the sector.
4. Choose a starting floor (lowest) return floor and end floor (highest). This defines the sector.
5. Choose whether cars should park with front and/or rear doors closed, open, or open for a number of seconds, then closed.
6. Click OK after making settings.
7. Continue selecting and setting additional priority/floor sets as needed.
Sector parking conditions:

- Overlapping start and/or end floors are allowed.
- Cars without car or hall call demands will be immediately parked. If the idle car is in a sector that already has a parked car, it will move to the nearest unoccupied sector.
- Only one car may be parked in a sector at any one time.
- If a car-call demand stops a car in an unoccupied sector, and it is assigned to park, it will park at the floor of the demand (rather than moving to the preferred floor within the sector).
- If the dispatcher assigns a car to park in an unoccupied sector, but then detects a car-call registered to that sector for another car, the first car will not be moved (or will be stopped if already moving).
- If sector parking is selected for a parking configuration but the user does not define sectors, or defines fewer sectors than might be accommodated by the number of cars in the group or available landings, the dispatcher will make sector parking assignments dynamically using artificial intelligence. Under these conditions:
  - The number of landings assigned to a sector will vary according to traffic demands. For example, during up peak operation, the upper sector will be extended so that any down demand may be more effectively met by the car assigned to park in the sector, while up demand is met by other cars in the group.
  - The dispatcher will adjust behavior depending upon traffic data collected from previous experience during the same timer periods. For example, if hall call demand at a particular floor has been historically heavy during certain times, a car or cars will be moved to or near those floors in anticipation of the demand.
  - If previous experience during a particular time so indicates, the dispatcher will anticipate the destination of hall call demand from a particular floor or floors and will reassign parking for idle cars at anticipated destination floors accordingly.

Sector Dispatching

When the parking method is set to Sector, and Sector dispatching is enabled, the dispatcher will consider user-defined and/or dynamically assigned parking sectors when making dispatching decisions (refer to sector parking conditions above).

Enable sector dispatching is only suitable for Group dispatching and is not applied on Simplex operation. For a Simplex car, when Sector dispatching is enabled and used in conjunction with Sector parking, this option will cause the simplex car to park in the nearest available sector rather than in the highest priority sector.
**Combine Dynamic and User-Defined**

To use both dynamic and user-defined behaviors:

1. Enable both dynamic and user-defined capabilities.
2. Set lobby and non-lobby floor dynamic door behavior as described previously (Dynamic Door Times).
3. Define essential floors or sectors, priority, and door behavior manually as described previously (User Defined Priority). (Remember that 1 through 4 priorities are treated as lobby floors/sectors.)

4. If necessary, remove any unneeded user-defined entries from the table because all user-defined parking floors must be satisfied before the dynamic parking will begin to park cars.

**Sending Changes to iControl**

As you define Parking configurations, you can send them to iControl at any time using the Send button. To send changes, you must have acquired write privileges first (*Write privilege* menu/ Acquire).

**Note**

Parking configurations interact with and respond to choices made in Parking Eligibility configurations. Please refer to “Parking Eligibility” on page 10-27.
Parking Eligibility

For a Simplex car, Swing car or Local/Dispatcher, create up to eight Parking Eligibility configurations. Each configuration determines how the car is allowed to park: Not park at all/local park/or park according to the Parking configurations.

Note

Parking configurations determine how the car is parked according to demand and priority. Parking Eligibility configurations determine parking restrictions and behavior as they apply to the car.

If a car is ineligible to park at a particular floor, it will not be moved to that floor to satisfy a parking demand. However, if a car is at a normally ineligible floor in response to a car or hall call, it may remain at that floor. If a car is parked at an eligible floor when the Parking Eligibility configuration is changed manually or via automated timer such that the car is no longer eligible to park at that floor, the cars “parked” status is removed but the car itself will not be moved except by car call, hall call, or other parking demand (active under the new configuration).
To program a Parking Eligibility configuration:

1. Select a Parking Eligibility configuration to edit/create (1 — 8).
2. Verify the car for which you want to set parking specifics.
3. If the car is not allowed to park when this configuration is active, select Not at all.
4. If the car is allowed to park only at a specific floor, set that floor, then click Edit to set door behavior. In this instance, the elevator controller will be responsible for parking the car — Parking tab configuration timers will not apply. Please refer to “Parking Configurations” on page 10-21.
5. If the car is eligible to be parked according to the Parking configurations, select Per parking configuration. The table below the selection will become active when Per parking configuration is active. If you select this choice, also set the floors at which the car is eligible to be parked and front, rear, or both doors access at that floor.

Note

If a car is set to be eligible to be parked according to the Parking configurations, it must be made eligible to park at some floor in the building (by selection in the table). It cannot be ineligible to park at every floor and yet be included in Parking configurations. Please refer to “Parking” on page 10-20.

6. Click Send to send changes to iControl.
7. Repeat for additional configurations or if this car is the designated Backup Dispatcher, for additional cars.
Split Bank Operation

Split Bank operation allows one or more cars of a group system to provide special operations in some aspects of car operation, dispatching or parking. Split Bank is typically used for freight cars, express service, dining service, shuttle service, dual-parking schemes or to dispatch a car with one bank or the other based on average wait times (to reduce wait times). Split Bank operation requires the use of a Central Dispatcher.

When Split Bank operation is enabled and active, the elevator group is effectively split into two separate groups, each called a “bank.” Hall call eligibility, per car and per hall call eligibility configuration for each bank, is separately configurable. When split bank operation is enabled and active, split bank cars use the Bank B hall call eligibility. (Please refer to “Hall Call Eligibility” on page 10-13.) During split bank operation, Bank B car risers may also be reassigned. Emergency power and Security settings are not affected by Split Bank selection. When Split Bank operation is deactivated, all group cars return to using the Bank A hall call eligibility assignments.

- Split Bank operation may be activated through iView manually by selecting manual assignment and the appropriate hall call eligibility configuration on the Dispatching screen Configuration tab. Split bank must be enabled.
- Split Bank operation may be activated by timer selection of a hall call eligibility configuration when split bank is enabled.
- Split Bank operation may be activated manually by switch input. (Highest activation priority rests with this switch.) Split bank must be enabled.
- Split Bank operation may be deactivated manually by switch input. (Highest deactivation priority rests with this switch. When this switch is active, regardless of how Split Bank activation was invoked, it will be shut off.)

- Enable split bank operation: When this box is checked, Split Bank operation is enabled. Though enabled, it may or may not be active. It can be made active as described above.
• Select Hall Call Configuration (1 thru 8): Select a Hall call configuration here, then click on the Hall Call Riser tab to modify hall call riser assignments when split bank operation is active and this hall call configuration is in use.

• Convert “xxx” riser to: In the selection boxes, pick the risers to be emulated as appropriate to your installation when the displayed hall call configuration is active.
Management

Provides access to Remote Monitoring Authorization and Local Dispatcher.

Remote Monitoring Authorization

Use to authorize a third party remote monitoring tool to connect to iControl.

To activate Third Party Monitoring:

1. Call MCE to obtain the Activation code. You will need to indicate the type of monitoring system and hardware key for each iCue/iController to be connected.
2. Enter the Activation code supplied by an MCE representative.
3. Click the Activate button.
4. If the connection has been authorized, the name of the monitoring system is added to the Activated Clients list.

To deactivate Third Party Authorization:

1. Enter the activation code for the monitoring system you wish to deactivate.
2. Click the Deactivate button.
3. The name of the monitoring system is removed from the Activated Clients list.

Note

The Activation code is unique for each iControl installation.
Local Dispatcher

Normally the system parameters are passed automatically to all cars designated as Alternate Dispatcher. This tool is used to command the system to resend the parameters.

System parameters

Click the **Resend** button to command the system to resend the system parameters to all cars designated as Alternate Dispatcher. Any cars which are not in operation will receive the updated system parameters when they are powered up and communication with the dispatcher is reestablished.
Configuration Tabs - Emergency Power

The Local Dispatcher can manage emergency power from one or two emergency generators. Use these controls to indicate which cars are connected to each generator and to define how switching to and from emergency power is handled. The sequence of Emergency Power Operation is as follows:

1. Upon loss of commercial power, as indicated by the Emergency power input, no cars are permitted to run until power from the emergency generator is established and the After emergency power comes on, time to wait before running the cars time has elapsed.

2. Emergency Power Recall - During recall, cars are powered and returned to their recall floor (set on Controller > Configuration > Car Operation > Emergency power tab) as defined by the Emergency Power Recall parameters. (Cars on Fire Service, Test or Earthquake operation may be recalled to other floors per code requirements).

3. Emergency Power Run - When recall is completed, cars are allowed to run on emergency power as defined by the Emergency Power Run parameters.

4. Power Transfer - Activation of the Power transfer input indicates that commercial power is about to be restored. All cars are commanded to stop and/or not move until transfer to commercial power is completed.
Assign Cars To Using the controls at the top of the screen, select cars and use the arrow buttons to place them in the Generator 1 or Generator 2 column. The cars must be physically wired to receive their emergency power from the selected generator.

Defining Emergency Power Behavior
The Generator 1 and Generator 2 controls allow you to define emergency power parameters for each generator individually.

**Emergency Power Input**
Set the *Emergency power input* to be active high (120VAC) or active low (0VAC) as required by the job.

- **After Emergency Power comes on, time to wait before running the cars:** Set the amount of time to wait, after switching to emergency power, before initiating the Recall phase. This allows emergency power to stabilize. Set this time long enough to allow the controllers to establish communication with the dispatcher.

**Emergency Power Recall**
Based on the *Number of cars that can be recalled at the same time* parameter, cars are selected to recall as follows:

1. Cars with a *Priority Recall Request* status, e.g. heavily loaded cars, are recalled in the order they appear on the *Recall sequence* list.
2. All remaining cars are recalled in the order they appear on the *Recall sequence* list.
3. A second attempt is made to recall any cars unsuccessfully recalled.

These parameters define Emergency Power Recall behavior.

- **Activate recall by the Auto recall selection switch input:** If this option is selected, Emergency Power Recall will be activated if the *Auto recall selection switch input* is active when the *After emergency power comes on, time to wait before running the cars* time elapses. Otherwise, Emergency Power Recall will be skipped.
- **Always recall:** Emergency Power Recall will always be activated when the *After Emergency power comes on, time to wait before running the cars* time elapses.
- **Never recall:** The Recall phase is always skipped.

**Note**
Some Fire codes require a car that is on Fire Service to be recalled on Emergency Power regardless of the options selected.

- **Recall Sequence**: Cars are recalled in the order in which they appear in this list. Select a car and use the Up/Down buttons to order the list.
- **Number of cars that can be recalled at the same time**: Set the number of cars that may be recalled at the same time, considering generator capabilities and elevator car and other building power demands.
- **Recall Timeout**: If a car fails to respond to a recall signal within this time, the car will be placed Out of Service.
- **At a minimum, recall to next floor**: This option permits cars to be recalled to the nearest floor to prevent entrapments if the Recall phase would instead be bypassed. The Recall phase is bypassed if one of the cars is manually selected to run, *Activate recall by the Auto recall selection switch input* is selected but the *Auto recall selection switch input* is not active, or *Never recall* is selected.
**Emergency Power Run**  
Based on the *Number of cars that can be run at the same time* parameter, cars are selected to run as follows:

- **Manual selection** - cars are selected to run in the order they appear on the *Run sequence* list as follows:
  1. Cars with a *Priority Run Request* status (e.g. EMS phase 2, CFSS phase 2 and Fire Service Phase II), that also have their *Emergency power run input* active.
  2. Cars that have their *Emergency power run input* active.

- **Automatic selection** - If *Always run* is selected, or if *Activate run by the Emergency power auto run input* is selected and the *Emergency power auto run input* is active, cars are selected to run in the order they appear on the *Run sequence* list as follows:
  3. Cars with a *Priority Run Request* status, e.g. EMS phase 2, CFSS phase 2 or Fire Service Phase II.
  4. If *Last car to be recalled shall be the first car to run* parameter is selected, that car is chosen to run at this time, if it hasn’t already been selected.
  5. All other cars.

Choose one of the following three parameters to determine the method used to activate automatic selection of cars to run on emergency power.

- **Activate run by the Emergency power auto run input**: Cars are selected to run as indicated in Automatic selection above.
- **Always run**: Cars are selected to run as indicated in Automatic selection above.
- **Never run**: Cars are not automatically selected to run on emergency power.
- **Run Sequence**: Cars are selected to run in the order in which they appear in this list. Select a car and use the Up/Down buttons to order the list.
- **Number of cars that can be run at the same time**: Set the number of cars that may be run at any one time, considering generator capabilities and elevator and other building demands. Typically set to run one car.
- **Run all manually selected cars**: Caution! Checking this box will allow all manually selected cars to run during the emergency power running phase. Please verify your building’s generator capacity before activating this option.
- **Last car to be recalled shall be the first car to run**: The last recalled car is selected to run as indicated in 4 above.

**Power Transfer**  
This phase, initiated by the activation of the “Power transfer input”, indicates that commercial power is about to be restored. Cars that are moving on emergency power are commanded to stop at the next available floor to avoid an emergency stop. No cars are permitted to move until transfer to commercial power is completed.

If the Power transfer input is deactivated, and commercial power has not been restored, the system will return to the Emergency Power phase it was operating in prior to the Power transfer input being activated.
Configuration Tabs - Legacy Group Interface

During building modernization, it may be desirable to retain the legacy dispatcher and some of the legacy controllers a period of time. To accomplish this, iControl provides two options, cross-registration and cross-cancellation. These options are available only on the central dispatcher (iCentral) running the iCue dispatching software.

- **Select legacy group interface**: Use this control to select the legacy group interface option being used, Cross-cancellation, Cross-registration or None.

**Cross-registration**

With Cross-registration, the iControl central dispatcher (iCentral) receives the hall calls and manages the dispatching based on the following:

1. If an iControl car is available and can answer the call within the user adjustable “ETA threshold” time, the hall call is assigned to an iControl car.
2. All other hall calls are passed to the legacy dispatcher provided that a legacy car that can answer the call, per the eligibility map, is in service.

- **Select cars to be cross-registered**: Indicates which cars are MCE iControl and which are legacy cars. Select those legacy cars that are to be cross-registered and use the right arrow to place them in the “Legacy” list.
• **ETA threshold**: If an iControl car is available and can answer a call within the ETS threshold time, the call is assigned to the iControl car. Otherwise, the call is passed to the legacy dispatcher.

**Note**

When using cross-registration, care must be taken to ensure that the hall call eligibility (System > Configuration > Hall Call Eligibility) for the legacy cars is correct so that the iControl central dispatcher knows whether the car has proper access privileges.

---

**Cross-cancellation**

With cross-cancellation, the legacy dispatcher receives the hall calls and assigns them to legacy cars. The legacy dispatcher also passes the calls, via a relay closure corresponding to the riser and direction of the call, to the iControl central dispatcher (iCentral) which assigns the calls to iControl cars. If the iControl car is first to answer the call, the central dispatcher signals the legacy dispatcher to cancel the call, and vice versa.

- **Cross-cancellation output timer**: (de-bounce for the “call answered” output) When the legacy dispatcher sees the relay closure indicating that an iControl car has answered a call, it takes some finite time to recognize and process the signal, at which point it cancels the hall call demand. iControl then waits for the duration set in this timer before dropping its “call answered” closure. This delay prevents the legacy system from misinterpreting the relay state change as “call not yet satisfied.”
Configuration Tabs - Security

These parameters control elevator security by restricting hall and car call registration. For local cars, operating under the direction of a central dispatcher (iCentral) or a Local/Dispatcher, elevator security is controlled by settings made while iView is connected to iCentral or the Local/Dispatcher. The parameters are stored on iCentral or the Local Dispatcher and are copied to all Alternate Dispatchers. However, when the controller is configured as a simplex or swing car, the security parameters are stored on the simplex or swing car controller. To change the parameters iView must be connected to the simplex or swing car controller.

When you select System > Security, the General > Status tab is displayed. Access to security settings beyond viewing the general status is restricted to authorized users. There are two user classes, manager and technician. The manager is allowed to set up and edit passwords, the technician is not. To log on:

1. Click the Logon button at the bottom of the screen. The Logon dialog is displayed.
2. Enter the manager or technician password. (Factory default passwords are “manager” for manager logon and “technician” for technician logon.)
3. Click Ok. The menus that were previously grayed-out will become available.

General - Status
The Status screen provides an overview of currently active security settings.

- **Master security:**
  - Active: Lights if any security mode is active.
  - Hardware override: Lights if security has been overridden by a switch input.
  - Software override: Lights if security has been overridden by a software selection.
  - Activate Override button: Activates software security override. Button caption changes to Deactivate Override when override is activated.

- **Active configuration:**
  - Display: Indicates the currently active security configuration.
  - Hardware configuration: Lights if configuration was activated by a hardware switch.
  - Software configuration: Lights if configuration activated by software setting.
  - Timed configuration: Lights if configuration activated by system timer created using the Configuration > Timer Tables tab.

- **Hall call security overrides:**
  - Enable 1: Lights if hall call enable 1 input is activated by a card reader or keypad, etc. (System View > Configuration > System I/O - System tab - Hall call enable 1 inputs).
  - Enable 2: Lights if hall call enable 2 input is activated by a card reader or keypad, etc. (System View > Configuration > System I/O > System tab - Hall call enable 2 inputs).

- **Car call security override:**
  - Enable 1: Lights if a Car call enable 1 input is activated by a card reader or keypad, etc. (Controller > Configuration > I/O Boards > MIAC or COP - Car call enable 1 inputs).
  - Enable 2: Lights if a Car call enable 2 input is activated by a card reader or keypad, etc. (Controller > Configuration > I/O Boards > MIAC or COP - Car call enable 2 inputs).

**General - Configuration**

This tab allows you to set the active security configuration manually or by timed assignment and to Enable Hardware Override.

**To set the security configuration manually**

2. Set the desired configuration in the drop-down list.
3. Click Send.
To have the active security configuration set by timer table

1. Select *Timed* in Configuration Assignment.
2. Click Send.
3. Program one or more timer tables (System > Configuration > Timer tables tab).

**Enable Hardware Override:** The Security override - Master security override input is ignored unless this control is activated.

**General - Manage Passwords**

Only the “manager” can set passwords. To change the password settings:

1. Logon using the manager’s password. If you are changing the passwords from their initial settings, logon using the default password “manager”.
2. Display the Manage Passwords tab (General > Manage Passwords).
3. Click the *Set Pwd* button. The Change password dialog is displayed.

4. Select the User (Manager or Technician) who's password is to be changed.
5. Enter the new password in the “New password:” text box.
6. Re-enter the new password in the “Re-enter pswd:” text box.
7. Click OK.

**Note**

If you forget the password, locate the job number and/or serial number of the controller and contact MCE Technical Support at 916-463-9200.

**Note**

In order to activate security, physical device (card reader, key switch, etc.) inputs must be properly configured and wired. Please refer to “Configuration - I/O Boards” on page 9-102.
Security - General

The Security Level is set on the System > Configuration > Security > General screen.

The following Security Level options are available:

- **No Security**: Security is not being used.
- **Basic Security with per floor codes**:
- **Basic Security with per floor and passenger codes**:
Hall Calls

iControl security provides two types of hall call restrictions:

- **Per-Floor Security**: Places restrictions on hall call riser access on a per-floor basis.
- **Per-Car Lock Out**: Specifies which cars may stop at particular floors.

**Per-Floor Security**

Hall calls may be Unlocked, Locked or Secured:

- **Unlocked**: Unrestricted access. Calls may be registered.
- **Locked**: No access. Calls may not be registered.
- **Secured**: Access is restricted to authorized passengers. Calls may be registered after proper authorization (i.e., card reader, key switch, or code entry).

To set hall call security restrictions:

1. Select **Per-Floor Security** (System > Security > Hall Calls > Per-Floor Security).

2. **Configuration**: Select the security Configuration (1 - 8) to which the hall call security restrictions apply.

3. For the hall call type (i.e., Main, Auxiliary, etc.) and location (Front/Rear), click in the table at the floor and direction (up/down) to be set.
4. In the selection list that appears, select the desired security condition (Unlock/ Lock/ Secure), and click OK.

5. If Secure is selected, choose the desired enable method(s) that will allow calls to be registered, and click OK.
   - Enable 1: Hall call enable 1 input activation.
   - Enable 2: Hall call enable 2 input activation.
   - Enable 1 AND Enable 2: Activation of both Hall call enable 1 and Hall call enable 2 inputs.
   - Enable 1 OR Enable 2: Activation of either Hall call enable 1 or Hall call enable 2 input.

Alternate selection methods

- Click in a floor label in the Floor column to select all call types for that floor.
- Click a column heading, e.g. Main, Main Front or Main Front Up to select that type of call for all floors.
- Click and drag to select multiple floors and/or multiple columns (call types).
- Once the floor(s) and call type(s) are selected, click the Set Selection button. The Input Setup dialog is displayed.
- Select the desired security condition as described in steps 4 and 5 and click OK.

6. When you have the hall call security settings as desired, click Send to send the settings to iControl.

Other controls - General

- **Security input latch time**: Hall call enable inputs can be activated by a card reader or key switch, etc. Card readers typically hold the enable input activated for a period of time so that the user has time to enter the desired call. However, if a momentary switch or key switch is used to activate the hall call enable input, this control allows you to set the length of time that the user has to enter the call, after the hall call enable input has been deactivated.

- **Hall call enable 1 (or 2) inputs active high**: These controls allow you to program the hall call enable inputs to activate on either a low or high going signal.

- **Allow parking at secured hall call**: Cars are not allowed to park at a floor that is secured for hall calls unless this control is checked.

- **Allow parking at a partially locked floor**: Cars may park at a floor where some hall calls are locked, e.g. down hall calls locked but up hall calls are allowed.
Per-Car Lockout

On a per-car, per-floor, per-direction basis, this control determines which cars may respond to the various hall call types.

1. Select **Per-Car Lock Out** (System > Security > Hall Calls > Per-Car Lock Out).

2. **Call type**: Select a call type, Main, AUX or CFSS.

3. **Floor, Car, Front/Rear, Up/Down**: The car numbers are at the top of the columns. Click in the row and column that selects the floor, car, front/rear, up/down hall call desired.

4. Click **Lock** or **Unlock** and OK in the dialog that appears.

**Alternate selection methods**

- Click in the Car box to select all floors and directions. Or, click in the Riser box to select all calls for that riser.
- Choose the desired setting
- Click OK to set all selected calls the same.

Or,

- Click and drag in a column or row to make multiple selections.
- Click Set Selection.
- Choose the desired setting and click OK to set all selected calls the same.
- Click send to save your settings to iControl.
Car Calls - Configuration

Car calls may be Unlocked, Locked or Secured:

- **Unlocked**: Unrestricted access. Calls may be registered.
- **Locked**: No access. Calls may not be registered.
- **Secured**: Access is restricted to authorized passengers. Calls may be registered after proper authorization (i.e., card reader, key switch, or code entry).

To set car call security restrictions:

1. Display the System > Security > Car Calls > Configuration.

2. Select the security Configuration (1 - 8) to which the car call security restrictions apply.

3. For the car call type (front/rear), click in the table at the floor and car panel location (front/rear) to be set.

4. In the selection list that appears, select the desired security condition (Unlock/Lock or Secure).

5. If Secure is selected, choose the desired enable method or methods that will allow car calls to be registered.
   - **Enable 1**: Car call enable 1 input activation.
   - **Enable 2**: Car call enable 2 input activation.
   - **COP Passcode**: Passcode entered via the Car Operating Panel buttons.
   - A combination of the above (see Security Symbols on the next page).
Alternate selection methods

- Click in a floor label in the Floor column to select all call types for that floor.
- Click a column heading, e.g. Front, Rear or both to select that type of call for all floors.
- Click and drag to select multiple floors and/or multiple columns (call types).
- Once the floor(s) and call type(s) are selected, click the Set Selection button. The Input Setup dialog (similar to the list shown above) is displayed.
- Select the desired security condition as described in steps 4 and 5 and click OK.

6. When you have the car call security settings as desired, click Send to send the settings to iControl.

Other controls

- **Security input latch timer**: Car call enable inputs can be activated by a card reader, key switch, etc. Card readers typically hold the enable input activated for a period of time so that the user has time to enter the desired call. However, if a momentary switch or key switch is used to activate the hall call enable input, this control allows you to set the length of time, after the hall call enable input has been deactivated, that the user has to enter the call.
Car Calls - Mode Overrides

On a per configuration, per authorizing signal basis, you can allow a car call security restriction to be overridden when the car is operating in a selected mode or when the call is placed from a selected source. To program the override:

1. Configuration: Select the configuration affected by these choices.
2. Signal: Select the signal which would have been required to enable the restricted car call to be registered (Enable 1, Enable 2 or Passcode).

3. Selection: Select floors, and calls singly or in blocks as described previously (Please refer to “Car Calls - Configuration” on page 10-45).

4. Choose the sources /operating mode(s) that will override (ignore) the car call security restriction at the selected floor/riser.
   - All: Car calls from all of the following sources and modes.
   - OBD calls: Calls placed using the iBox On-board Display.
   - Remote calls: Calls placed using iView or iMonitor.
   - Automatic calls: Calls placed automatically by iControl, e.g.
     - Automatic door open: Under certain conditions, including certain fault conditions and emergency power transfer periods, the elevator doors may need to automatically open or cycle open/closed at floors. Activating this override, allows the doors to open or cycle even at a secured opening.
     - Emergency dispatch: Calls generated as a result of emergency dispatching.
• Sabbath: Calls generated as a result of the car being on Sabbath operation.
• COP buttons: Calls placed using COP buttons while the car is operating in one of the following modes: Attendant Service, CFSS 1, CFSS2, Independent service, Test mode, Shuttle service.

5. Click OK.

Active overrides are displayed as single letters, each corresponding to a mode:

- I = Independent
- A = Attendant
- 1 = CFSS1
- 2 = CFSS2
- D = Auto Door
- T = Test Mode
- E = Emerg Dispatch
- S = Sabbath
- R = Remote
- O = OBD

**Car Calls - Passcodes**

This screen allows you to set parameters that pertain to per-floor and passenger passcodes.

- **Timeout between buttons:** Passcodes are entered using car operating panel (COP) buttons. When the passenger is entering a passcode, if more than the number of seconds set here elapses between button presses, the passcode entry will time out.
- **Passenger passcode length:** Sets the length of the passenger passcodes. (It is recommended that the passenger passcode length and floor passcode length be the same).

**Car Calls - Passcodes - Floor**

This tab allows you to assign per-floor car call enable passcodes (passcodes are entered using COP buttons). To program a floor passcode

1. Select the Configuration (1 - 8).
2. Select the floor(s) and call types as previously described (Please refer to “Car Calls - Configuration” on page 10-45).

3. In the dialog that appears, select the COP (front or rear) and the passcode (COP buttons that must be pressed).

4. Click OK.

5. If you make an entry error, click Clear and then re-enter the numbers.

**Car Calls - Passcodes - Passenger**

This tab allows you to assign per-passenger car call enable passcodes (passcodes are entered using COP buttons). To program a Passenger Passcode:

- Click the Add button. The Passenger Properties dialog is displayed.

- Enter the Name.
- Enter the Destinations Allowed by clicking the desired floors, front and/or rear, or click and drag to select multiple floors and then click Select or Deselect.
• Enter the **Pass Code** by clicking the desired call buttons and front or rear

• **Modes Allowed:** Authorizes the passenger to use the COP passcode while the car is operating on the selected mode(s) in addition to Passenger mode.

**Security - COP Passcode operation** For the elevator passenger, using the COP passcode to register call a call to a secured floor works as follows:

1. Press a floor selection on the COP as usual. The panel buttons will flash to indicate that a passcode must be entered.
2. Press floor buttons to enter the passcode.
3. Correct entry of the passcode will register the call. The panel buttons will return to normal.
   • An incorrect or timed-out entry will not register the call. The user may repeat the process if the entry was incorrect or timed out.

**Note**

If both a passcode entry and an enable input (card reader or switch) are required to register a particular call, the enable input must be completed before the COP passcode is entered.
Configuration Tabs - System I/O

System I/O allows iControl to use a simple, two-wire serial bus for external communication. For local cars (part of a group) the hall call assignments are made on the central dispatcher (iCentral) or Local/Dispatcher. For a simplex or swing car the hall call assignments are made using this tab on each car. Normally these assignments are made at the factory. You should only need to verify that the inputs and outputs are assigned correctly according to the job prints.

System Tab

This tab allows you to set the polling range for I/O addresses and to assign individual inputs and outputs to the desired functions.

Address Range

Each serial bus will accommodate addresses from 10 to 488 or from 10 to 988. If your bus is not populated beyond 488 inputs and outputs, the smaller range should be used to speed up control response efficiency. The address range is preset at the factory according to the job survey. You should not need to change these settings if they are connected as shown in your job prints.
Default Calls Button
This selection defaults the address assignments to building condition settings (numbers of floors and cars, and call types). This is an excellent way to begin setting up I/O addressing if required. If selected, a warning is displayed:

Configure Button
This selection allows the system to automatically configure inputs and outputs of a type you select.

For example:

1. Click in the Starting Node Address column to select the address at which you want automatic assignment to begin.
2. Click in the Input/Output column to select an input or output group you would like to assign.
3. Set whether you want addresses assigned sequentially from the starting address you selected or whether you want the addresses assigned to every tenth location.
4. Set whether or not existing programming, if any, for the address range affected should be overwritten.
5. Click OK to automatically assign the selected input type to the addresses.

As noted in the Auto Configure dialog, we recommend you begin by clicking the Default calls button on Serial I/O screen before performing this operation.
Configuring System I/O

This table allows you to define each input or output on the bus. **These settings are pre-defined at the factory according to the job survey and should not need to be changed if connected as shown on your job prints.**

- Node address: The addresses available on this bus.
- Input/Output: The type of input or output assigned to this address.

To assign an input or output to a node address:

1. Click in the **Input / Output** cell next to the desired node address.
2. Click the down arrow (right side of cell).
3. Double click an input or output from the list provided.
4. Click in the adjacent **Association** cell.
5. Click the desired selection.
6. Click Send to send the assignment to iControl.

The pre-defined inputs and outputs include:

- **Hall Calls**
  - Hall call - Down aux front: Select floor in Association column.
  - Hall call - Down aux rear: Select floor in Association column.
  - Hall call - Up aux front: Select floor in Association column.
  - Hall call - Up aux rear: Select floor in Association column.
  - Hall call - Down main front: Select floor in Association column.
  - Hall call - Down main rear: Select floor in Association column.
  - Hall call - Up main front: Select floor in Association column.
  - Hall call - Up main rear: Select floor in Association column.

- **CFSS calls (Commandeer for Special Service)**
  - CFSS call - Mode 1 front: Select floor in Association column.
  - CFSS call - Mode 1 rear: Select floor in Association column.
  - CFSS call - Mode 2 front: Select floor in Association column.
  - CFSS call - Mode 2 rear: Select floor in Association column.

- **CFSS outputs (Commandeer For Special Service)**
  - CFSS - Mode 1 in-use output: When all cars that are available to accept CFSS Mode 1 calls (determined by “Maximum number of cars to operate on CFSS Mode 1 at the same time” and each car’s eligibility map) have already been assigned to CFSS Mode 1 operation or are out-of-service, this output becomes active indicating that any additional CFSS Mode 1 calls must wait for a car to become available. Association column is blank.
  - CFSS - Mode 2 in-use output: When all cars that are available to accept CFSS Mode 2 calls (determined by “Maximum number of cars to operate on CFSS Mode 2 at the same time” and each car’s eligibility map) have already been assigned to CFSS Mode 2 operation or are out-of-service, this output becomes active indicating that any additional CFSS Mode 2 calls must wait for a car to become available. Association column is blank.
• CFSS - Mode 1 system output: This output becomes active when at least one car has been assigned to CFSS Mode 1 operation. Typically used to drive an indicator. Association column is blank.

• CFSS - Mode 2 system output: This output becomes active when at least one car has been assigned to CFSS Mode 2 operation. Typically used to drive an indicator. Association column is blank.

• Emergency Power inputs
  • EP - Emergency power input: iCue will accommodate one or two emergency power generators. An Emergency power input is used to inform iCue when emergency power is active (the Association column selected generator is active). Each elevator controller also has an Emergency power input connected to the generator from which it receives emergency power. Emergency power inputs may be active high or active low as configured when setting up emergency power parameters for iCue and individual elevator controllers. On the group Emergency Power screen, elevators are designated as powered by generator 1 or 2 so that iCue knows which Emergency power input to associate with the car. Select generator in Association column.
  • EP - Auto recall selection switch input: Emergency Power operation proceeds in two phases: Recall - cars are sequentially recalled to their recall floor. Run - cars are allowed to run, typically one car per building vertical transportation sector (group) at a time to ensure adequate power is available. When activated, the Auto recall selection switch input causes iCue to sequentially recall cars to their return floor. If a car is already actively selected to run on emergency power (see EP - Emergency power automatic run input below), the recall phase is bypassed. Select generator ID in Association column.
  • EP - Emergency power automatic run input: When active, this input causes iCue to automatically select cars to run after considering the status of the EP - Emergency power run input (see below). Select generator ID in Association column.
  • EP - Power transfer input: When active, notifies iCue that commercial power has been restored and transfer from emergency to commercial power is pending. A maximum of two Power transfer inputs, one for each emergency generator accommodated, can be configured. Which generator is associated with the input is determined by the (Generator 1 or Generator 2) selection in the Associations column of this table. Activation of this input causes iCue to command all cars not already in Freeze Status to stop at the next available landing and enter Freeze Status. This input must be activated in advance of the transfer from generator to commercial power to allow all cars to safely make a normal stop. When commercial power is restored, iCue will return cars to normal operation. Select generator ID in Association column.
  • EP - Emergency power run input: When active, designates the specified car to have power during the run phase. Select Car ID in the Association column. This per car input overrides the recall phase.

• Emergency Power Outputs
  • EP - Emergency power service output: Activates when the system is not on emergency power. Select generator ID in Association column.
  • EP - Emergency power phase I output: Active during Freeze or Recall phase of emergency power operation. Select generator ID in Association column.
  • EP - Emergency power phase II output: Active during Run phase of emergency power operation. Select generator ID in Association column.
• EP - Car selected for emergency power output: Active when the car is given power during emergency power operation. Essentially this is the combination of outputs EP - Car selected to run and EP - Car selected to recall. If the car is given power to operate at any time during emergency power operation, the output will be activated. Select the Car ID in the Association column.
• EP - Car selected to recall output: Active when the car is given power to Recall during Emergency Power operation. Select the Car ID in the Association column.
• EP - Car selected to run output: Becomes active when the specified car is selected to operate. The output is always cleared during Freeze and Recall phases and during Power transfer activation upon stopping at a floor. Select Car ID in Association column.

Cross Registration: Cross registration is intended for use during modernization projects. It provides an interface between cars in a newly installed iControl group and cars in an existing (legacy) group. The iCue dispatcher will preferentially assign hall calls to iControl cars unless the estimated time of arrival for an iControl car exceeds a limit programmed by the user (Cross Registration screen). In this case, iCue will assign the call to the legacy group dispatcher. Hall Call Eligibility for legacy cars must be programmed into iCue, just as they are in the legacy group, to ensure that only cars that are eligible are dispatched to answer calls.

• Cross registration inputs: The following inputs are used for cross-registration of hall calls.
  • Cross reg - Down aux front input: Select floor in Association column.
  • Cross reg - Down aux rear input: Select floor in Association column.
  • Cross reg - Up aux front input: Select floor in Association column.
  • Cross reg - Up aux rear input: Select floor in Association column.
  • Cross reg - Down main front input: Select floor in Association column.
  • Cross reg - Down main rear input: Select floor in Association column.
  • Cross reg - Up main front input: Select floor in Association column.
  • Cross reg - Up main rear input: Select floor in Association column.
  • Cross reg - Car in-service input. Select Car ID in Association column.

• Cross registration outputs: Used for cross-registration of hall calls.
  • Cross reg - Down aux front output: Select floor in Association column.
  • Cross reg - Down aux rear output: Select floor in Association column.
  • Cross reg - Up aux front output: Select floor in Association column.
  • Cross reg - Up aux rear output: Select floor in Association column.
  • Cross reg - Down main front output: Select floor in Association column.
  • Cross reg - Down main rear output: Select floor in Association column.
  • Cross reg - Up main front output: Select floor in Association column.
  • Cross reg - Up main rear output: Select floor in Association column.

Note: For all the above, the floor selected in the Association column defines the call location for the iCue software.

• Cross reg - Emergency dispatch output: (Notifies legacy group that we are unable to cross-register hall calls because of a serial IO failure or iCue shutdown and that it should put its cars on emergency dispatch operation.) Association column is blank.
• General outputs
  • General - Attendant service output: Active when the specified car is on Attendant Service operation. Select Car ID in Association column.
  • General - Fire service phase I output: Active during Fire Recall Phase I. Association column is blank.

• Manual configuration inputs
  • Manual config - Hall call configuration input: Selects the Hall call eligibility configuration (1 - 8) designated in the Association column to be the currently active configuration.
  • Manual config - Parking configuration input: Selects the Parking configuration (1 - 8) designated in the Association column to be the currently active configuration.
  • Manual config - Parking eligibility configuration input: Selects the Parking eligibility configuration (1 - 8) designated in the Association column to be the currently active configuration.
  • Manual config - Mode of operation configuration input: Selects the Mode of operation configuration (1 - 8) designated in the Association column to be the currently active configuration.
  • Manual config - Security configuration input: Selects the Security configuration (1 - 8) designated in the Association column to be the currently active configuration.

• Active configuration outputs
  • Active config - Hall call eligibility output: Indicates that the Hall call eligibility configuration (1 - 8) designated in the Association column is the currently active configuration.
  • Active config - Parking output: Indicates that the Parking configuration (1 - 8) designated in the Association column is the currently active configuration.
  • Active config - Parking eligibility output: Indicates that the Parking eligibility configuration (1 - 8) designated in the Association column is the currently active configuration.
  • Active config - Mode of operation output: Indicates that the Mode of operation configuration (1 - 8) designated in the Association column is the currently active configuration.
  • Active config - Security output: Indicates that the Security configuration (1 - 8) designated in the Association column is the currently active configuration.

Security: The following inputs control how hall calls to secured floors are handled by the system. They are typically activated from switches or buttons at the building security station so that security personnel can easily and quickly make adjustments to hall call security as a situation demands. They can also be activated by a card reader or keypad, etc.

• Hall call enable 1 (or 2) inputs
  • Hall call enable 1 (2) - Floor input: When active, a valid call for the secured floor can be registered. Select floor number in Association column.
  • Hall call enable 1 (2) - Front input: When active, a valid call for the front opening on the associated secured floor can be registered. Select floor number in Association column.
• Hall call enable 1 (2) - Rear input: When active, a valid call for the rear opening on the associated floor can be registered. Select floor number in Association column.
• Hall call enable 1 (2) - Main front input: When active, valid secured calls at the associated floor, main front riser, can be registered. Select floor number in Association column.
• Hall call enable 1 (2) - Main rear input: When active, a valid call at the associated secured floor, main rear riser, can be registered. Select floor number in Association column.
• Hall call enable 1 (2) - Aux front input: When active, a valid call at the associated secured floor, auxiliary front riser, can be registered. Select floor number in Association column.
• Hall call enable 1 (2) - Aux rear input: When active, a valid call at the associated secured floor, auxiliary rear riser, can be registered. Select floor number in Association column.
• Hall call enable 1 (2) - Down aux front input: When active, a valid call at the associated secured floor, down auxiliary front riser, can be registered. Select floor number in Association column.
• Hall call enable 1 (2) - Down aux rear input: When active, a valid call at the associated secured floor, down auxiliary rear riser, can be registered. Select floor number in Association column.
• Hall call enable 1 (2) - Up aux front input: When active, a valid call at the associated secured floor, up auxiliary front riser, can be registered. Select floor number in Association column.
• Hall call enable 1 (2) - Up aux rear input: When active, a valid call at the associated secured floor, up auxiliary rear riser, can be registered. Select floor number in Association column.
• Hall call enable 1 (2) - Down main front input: When active, a valid call at the associated secured floor, down main front riser, can be registered. Select floor number in Association column.
• Hall call enable 1 (2) - Down main rear input: When active, a valid call at the associated secured floor, down main rear riser, can be registered. Select floor number in Association column.
• Hall call enable 1 (2) - Up main front input: When active, a valid call at the associated secured floor, up main front riser, can be registered. Select floor number in Association column.
• Hall call enable 1 (2) - Up main rear input: When active, a valid call at the associated secured floor, up main rear riser, can be registered. Select floor number in Association column.

NOTE: The inputs above are OR’ed together with the greater permission exerting control.

• CFSS call enable 1 (or 2) inputs
• CFSS call enable 1 (2) - CFSS mode 1 input: When active, a valid CFSS mode 1 call at the associated secured floor, can be registered. Select the floor number in the Association column. (CFSS mode 1 and 2 are user-assignable operating modes typically used for medical emergency calls, attendant calls, etc.)
• CFSS call enable 1 (2) - CFSS mode 1 front input: When active, a valid CFSS mode 1 call at the associated secured floor, front opening only, can be registered. Select the floor number in the Association column. (CFSS mode 1 and 2 are user-assignable operating modes typically used for medical emergency calls, attendant calls, etc.)

• CFSS call enable 1 (2) - CFSS mode 1 rear input: When active, a valid CFSS mode 1 call at the associated secured floor, rear opening only, can be registered. Select the floor number in the Association column. (CFSS mode 1 and 2 are user-assignable operating modes typically used for medical emergency calls, attendant calls, etc.)

• CFSS call enable 1 (2) - CFSS mode 2 input: When active, a valid CFSS mode 2 call at the associated secured floor, can be registered. Select the floor number in the Association column. (CFSS mode 1 and 2 are user-assignable operating modes typically used for medical emergency calls, attendant calls, etc.)

• CFSS call enable 1 (2) - CFSS mode 2 front input: When active, a valid CFSS mode 2 call at the associated secured floor, front opening only, can be registered. Select the floor number in the Association column. (CFSS mode 1 and 2 are user-assignable operating modes typically used for medical emergency calls, attendant calls, etc.)

• CFSS call enable 1 (2) - CFSS mode 2 rear input: When active, a valid CFSS mode 2 call at the associated secured floor, rear opening only, can be registered. Select the floor number in the Association column. (CFSS mode 1 and 2 are user-assignable operating modes typically used for medical emergency calls, attendant calls, etc.)

• Security Override
  • Security override - Master security override input: When active, all secured calls are enabled. All secured car and hall calls will behave as though unsecured. Locked calls will remain locked.
  • Security override - Hall call enable 1 override input: When active, all Enable 1 secured hall calls are unsecured. Locked calls will remain locked.
  • Security override - Hall call enable 2 override input: When active, all Enable 2 secured hall calls are unsecured. Locked calls will remain locked.

• Split bank hall calls: When enabled and active, split bank operation allows a single control group of cars to be controlled as though it were two separate groups. These inputs provide connection points for the auxiliary and main riser hall call buttons for the cars split from the group (Bank B).
  • Bank B hall call - Down aux front
  • Bank B hall call - Down aux rear
  • Bank B hall call - Up aux front
  • Bank B hall call - Up aux rear
  • Bank B hall call - Down main front
  • Bank B hall call - Down main rear
  • Bank B hall call - Up main front
  • Bank B hall call - Up main rear
• Remote User Outputs: Up to 32 outputs may be defined by the user on the Remote Outputs tab. The first four of these outputs may be included in timer tables and triggered by the timer. Outputs may also be manually triggered from the Remote Outputs > Trigger tab. Once defined, the outputs are associated with a physical output address using the System I/O or I/O Boards tab. Outputs may be latching or toggle, active high or low, and are intended to be used to drive system inputs as required by individual sites.
  • Remote (01 - 32)

• User Defined Events: Up to 10 inputs may be used to trigger a specific event message to be posted to the system event log. The user defines the text of the event on the User Events tab, then assigns a physical address (location) to the input using the System I/O tab.
  • User Event 1 (- 10)

• Active Mode of Operation Outputs:
  • Balanced: Active when the system is operating in balanced mode, typically to drive a visual indicator.
  • Lobby Peak: Active when the system is operating in lobby peak mode, typically to drive a visual indicator.
  • Demand Up Peak: Active when the system is operating in demand up peak mode, typically to drive a visual indicator.
  • Demand Down Peak: Active when the system is operating in demand down peak mode, typically to drive a visual indicator.

• Association Column:
  Choices selectable in this column are dependent on the adjoining Input/Output selection as follows:
  • For hall calls, the floor Association selection is presented.
  • For emergency power related functions, generator assignment is presented (Gen1 or Gen2).
  • For recall/car related functions, the car Association selection is presented.

Note

Remember, the above settings are all pre-configured before the controller is shipped from MCE. You should need only to connect inputs and outputs according to your job prints. These settings should not be changed or edited unless hardware affecting these settings is being replaced. In these instances, follow specific instructions provided by MCE.
System I/O - Bus Tab

The Bus tab allows you to see the status of the system busses (1 - 4), create an inventory of devices on the busses and to test device functionality in comparison to the inventory.

Bus Status

LEDs light to indicate the status of each bus.

- Connected: Lights green when the selected bus is properly connected.
- Bus Voltage: Lights green when serial bus voltage is within normal limits.
- Driver VDC: Lights green when Serial Hall Call Driver (J2) voltage is within normal limits.
- Node Control: Lights green when nodes respond correctly.
- Bus Enabled: Lights green when the selected bus is enabled.
- High Current: Lights red when bus current demand is excessive.

Wrapback Option

When enabled, hall call lamps are lighted immediately when the associated hall call button is pressed (rather than waiting for a response from the group controller to light the lamp).
Inventory / Test response

These controls allow you to create an inventory of input and output devices on the system busses (1 - 4) and to test the functionality of the devices against the inventory.

- Select Bus: Select the bus to be inventoried or tested.
- Status (I/O): The LEDs indicate the current status, On or OFF, of the input and/or output at each node address.
- Inventory (I/O): The table displays the results of the last run Input and Output inventory. Typically, you run an inventory after all system bus devices are connected so that the controller learns the connected devices.

Note: You must have write privilege to take an Input or Output inventory or perform an Input or Output test. To acquire write privilege:

1. Select Acquire from the iView Write privilege menu.
2. Press the iBox Yes soft key in response to the request for write privilege.

- Input inventory: To run an input inventory, click the Input inventory button when you are certain all devices are properly connected on the system bus. A check mark will appear in the Input inventory column for every address location at which the controller sees a functioning device. Compare this against your physical inventory to make certain that all devices responded properly.
- Output inventory: To run an output inventory, click the Output inventory button. A check mark will appear in the Output inventory column for every address location at which the controller sees a functioning device. Note that at this time, outputs using an SC-ION board will not be recognized by this software inventory or test and must be observed physically on the board.

When you run an input or output test, the controller compares the responses against the known quantity of the inventory.

- Input test: The Input test sequentially sends a test message to and reads a response from all input devices on the bus. Click the Input test button to initiate the test.
- Output test: The Output test sequentially checks the continuity of the circuit powering each node lamp, buzzer, or other indicator. Click the Output test button to initiate the test.
- Test results: The results of the Input or Output test are displayed in the right hand column of the table. The column label changes depending on the test, e.g. Input test results or Output test results. The possible results include:

  - Found: A green LED indicates that the test results match the inventory at this node address.
  - Missing: A red LED indicates that the test did not find a working device that was previously found at this node address by the inventory. This could indicate a device failure.
  - New: A yellow LED indicates that a device was found at this node address during the test that is not indicated in the inventory. This could indicate a newly installed device or a device programming error.
Configuration Tabs - Timer Tables (System)

This tab allows you to create timers that automatically determine, based on day and time of day, the currently active configuration for Hall Call Eligibility, Parking, Parking Eligibility, Mode of Operation and Security. In addition, timer tables can be used to control the first four Remote outputs.

Features

The timers associated with the type of configuration or operation selected in Features are displayed in the Timers list. For example, in the screen above, Hall Call Eligibility is selected and the timers that automatically determine the currently active Hall Call Eligibility Configuration are displayed. (The configurations that the timer tables select are created through the System Configuration and Security tabs). Timers may be displayed for:

- Hall Call Eligibility
- Parking
- Parking Eligibility
- Mode of Operation
- Security
- Remote 01 - 04
Timer Details
When a timer is selected in the table, details of its settings appear in Timer Details. (You must select a timer and click Edit to change settings, this display is read only.)

Timers
Timers are displayed in the Timers list. If timers overlap (manage the same period of time), the timer appearing higher in the list will have priority (control). To move a timer within the list, click to select it, then click Move Up or Move Down.

Add a Timer
To add a new timer to the list:
1. Click Add. The Add/Edit Timer dialog is displayed.
2. From the Configurations list, select the configuration(s) and/or feature(s) that should be active when this timer is valid (timer day and time are the present day and time).
3. Select the repeat frequency (Recurrence type) of the timer:
   - Daily: This timer is active every day during the specified time period.
• Weekly (Day of the week): This timer is active each week on the specified day or days (i.e., Mondays or Mondays and Tuesdays) or can be set to span days (i.e., Monday through Wednesday).
• Monthly (Day of week): This timer is active each month on the specified week days (i.e., first Monday, third Sunday, etc.) or can be set to span days (i.e., second Sunday through third Saturday, etc.).
• Monthly (Day of month): This timer is active each month during the specified time period, on the specified date or dates or may be set to span dates.
• Yearly (Day of week): This timer is active each year during the specified time period, during the specified month or months, on the specified day or days or may be set to span days across multiple months.
• Yearly (Day of month): This timer is active each year during the specified time period, during the specified month or months, on the specified date or dates or may be set to span dates across multiple months.

4. Enter the timer details using the Recurrence pattern controls. (These controls change depending on the Recurrence type selected.)
   • Enter a descriptive name for the timer (up to 25 characters).
   • Select the start and end time, day(s) or date information required.
5. Click OK.
6. Click Send to send new or changed timer information to iControl.

To remove a timer
1. Select a configuration/feature type from the Features drop down list.
2. Select a timer from the Timers list.
3. Click Remove.

To edit a timer
1. Select a configuration/feature type from the Features drop down list.
2. Select a timer from the Timers list.
3. Click Edit.
4. Make changes using the Add/Edit Timers dialog.
5. Click OK.

To move a timer
A timer’s position in the list determines its priority. If two timers are attempting to control the same configuration at the same time, the timer higher in the list (lower Priority number) will have control. To move a timer:
1. Select the timer from the Timers list.
2. Click Move Up or Move Down.

Note
No valid timer: For a particular configuration/feature, i.e., Parking, Mode of Operation, Auto Stop, etc., if Timed is selected and there is no valid timer (current date and time falls within the timer’s date(s) and times), those configurations/features will default to their #1 configuration or default state.
Configuration Tabs - User Events

The User Events tab is used to assign a name to an Input / User Event. Up to 10 Input / Event Names can be programmed. This event name can then be assigned to a hardware input. An event is logged, on the System Event Log, when the input is activated and again when it is deactivated. System - Input / Event Names are assigned to terminals on an SC-ION Serial Input/Output Board using the System > Configuration > System I/O tab. For information about Controller User Events see “Configuration - Advanced - User Events” on page 9-141.

To configure a System User Event:

1. Display the User Events tab (System > Configuration > User Events tab).
2. Enter the desired Input / Event Name, up to 40 characters.
3. Send the Input / Event name to the controller. The name will then appear under User-Defined Events on the list of inputs used to configure the I/O Boards.
4. Assign the event to a terminal on an SC-ION Serial Input/Output Board using the System > Configuration > System I/O tab. Please refer to “Configuration Tabs - System I/O” on page 10-51.
Configuration Tabs - Remote Outputs

The Remote Outputs tab allows the user to name and configure up to 32 hardware outputs which can be wired to any input or other device as needed. The outputs are turned on and off manually by clicking a graphical switch through iView and/or iMonitor or automatically via a timer. The type of output, latching or toggled, as well as the polarity of the output, active high or active low, are user selectable. And the status of latched outputs may be saved so that they remain in the same state after power is cycled.

To configure a Remote Output:

1. Display the Remote Outputs > Configuration tab.
2. Click the Enable check box for the output you wish to configure.
3. Click in the Remote Output name cell and type the desired name, up to 9 characters.
4. Select the Type of output, Latch or Toggle.
5. For Toggle outputs, set the Time (amount of time that the output will remain ON).
6. Click the Active high check box to set the output’s polarity to active high. Leave it unchecked to set the polarity to active low.
7. If you want the status of a latched output to be saved when power is cycled, click the Save status check box.
8. Send the changes to the controller.
Assigning Remote Outputs to an output terminal:

Remote outputs are available on the Central dispatcher and/or Local/Dispatcher’s System IO. You can assign them to terminals on an SC-ION Serial Input/Output Board using the System > Configuration > System I/O tab. Please refer to “Configuration Tabs - System I/O” on page 10-51. They can also be assigned to terminals on an ICE-MOR Multiple Output Relay Board using the Controller > Configuration > I/O Board tab. The user assigned output names appear on the list of outputs available for terminal assignment. Please refer to “Configuration - I/O Boards” on page 9-102.

Turning Remote Outputs On and Off:

Remote Outputs can be turned On and Off by clicking the graphical switches on the Remote Outputs > Trigger tab. The indicator lights when the output is On (actual output state depends on the active high/low setting). Toggle type outputs will turn themselves Off when the programmed Time expires.

The first four Remote Outputs can also be turned On and Off using a System Timer. Please refer to “Configuration Tabs - Timer Tables (System)” on page 10-62.
Diagnostic Tabs - Event Log

The System Event Log (System > Diagnostics > Event Log tab) provides a way to view the logged events associated with dispatching and group control. This is an essential troubleshooting tool. The System Event Log lists the following for each event logged:

- Type of event, Date, Time and Event

Event Properties

To view greater detail about an event, double-click the event.

Save event log / Open event log

The System Event Log can be saved to a file for future reference. To save a System Event Log to a file:

- Click the Save button on the System > Diagnostics > Event Log tab.
- Navigate to the folder you want to save the file in.
- Name the file and click Save.

The Event Log file can be viewed using iView. To view a previously saved System Event Log file:

- Click the Open file button on the System > Diagnostics > Event Log tab.
- Navigate to the file you want to view and double-click it.
Diagnostic Tabs - Event Log

Print / Print Preview To print the event log or to view a print preview and/or print the event log from the print preview dialog:

- Click the Print button , choose a printer from the Print dialog and click Print.
- Click the Print Preview button and use the controls to display and/or print the desired pages.

Clear All Click the Clear All button to delete all of the events in the Event Log.
System - Hoistway

The hoistway display provides a real time view of all the cars in the group. A typical hoistway view, with an active call registration panel, is shown below.

Initially only one car is displayed. To view other cars:

- Use the horizontal scroll bar at the bottom of the Hoistway window.
- Move the mouse pointer to the left side of the window until the pointer changes to double arrows, then click and drag to the left to view more cars.
The supervisor column of the hoistway screen provides traffic mode and Estimated Time of Arrival information for the group.

**Traffic Mode:** (Balanced in this example) Displays the current operating mode. This mode may be selected manually, by timer, or automatically according to iCue analysis of real-time traffic conditions.

- **Balanced:** All elevator traffic within the building is receiving equal priority from the group.
- **Lobby Peak:** Designated lobby floors are receiving priority attention. Generally active during morning arrival times when traffic is heaviest departing the lobby for other floors.
- **Demand Up Peak:** Upward bound traffic is given priority. If assigned dynamically, made active when approximately 80% of building traffic is in the up direction.
- **Demand Down Peak:** Downward bound traffic is given priority. If assigned dynamically, made active when approximately 80% of building traffic is in the down direction.
- **Automatic:** The traffic mode is being controlled dynamically by iCue according to real time traffic analysis and learned building traffic patterns.

**ETA:** Estimated Time of Arrival. The time, in whole seconds, in which iCue estimates a registered hall call will be serviced. ETA counts in the blue zone indicate a rear hall call. ETA counts in the orange zone indicate a front hall call.

- **Up / Down Columns:** When a hall call is placed, its ETA will be displayed in the Up or Down (as appropriate) hall column next to the floor from which the car was placed. The ETA will count down to the arrival of the responding car.
- **Non-directional:** An ETA in the left-most column indicates a non-directional “hall” call has been placed at this floor. Non-directional calls are calls that do not indicate a requested direction of travel. For example, CFSS calls, EMS calls, etc.
- **ETA Filtering:** Click the ETA button to set up filtering criteria for displayed calls. (Dialog shown with supervisor column illustration.)
Per Car Display

For each car, the Hoistway display provides the following information:

- Comm status: As shown when communication is good. Separated by red slash and offset if communication is lost.
- Car ID: Car label.
- Operating mode: As listed previously.
Call Registration
Clicking the call registration button opens a dialog that allows you to register car and hall calls.

Car Calls
After opening the dialog:
1. Click the Car tab.
2. Select the Car from the drop-down list (if applicable).
3. Select Front or Rear car panel if appropriate.
4. Click a floor number button to register a call.

Note
Multiple calls may be placed if desired. Rear panel calls may be placed only if the panel exists and is configured.

Hall Calls
After opening the dialog:
1. Click the Hall tab.
2. Select the hall call type.
   - Main (Up): Front up hall call.
   - Main (Down): Front down hall call.
   - CFSS1: Configure for Special Services. iControls have two customer assignable configurations. Typically they are used for hospital calls, VIP calls, etc.
   - Auxiliary (Up): Rear up hall call.
   - Auxiliary (Down): Rear down hall call.
   - CFSS2: Configure for Special Services. iControls have two customer assignable configurations. Typically they are used for hospital calls, VIP calls, etc.
3. Click a floor number button to register a call.

Multiple calls may be placed if desired. Only hall call types actually available and configured in the group will be available.
System Performance

This frame captures and graphs elevator performance over the most recent 24-hour period, including:

- Graphical representation of hourly average wait times for up and down hall calls
- Number of up and down hall calls answered each hour
- Average wait time for up and down hall calls for each hour
- Average wait time for up, down, and all hall calls during the last 24 hours

Information may be printed by clicking on the print button.
System - Layouts

With iView, you can move and size tabs to suit the task to be performed. When you find a particularly arrangement to be useful, you can save it as a custom layout (View > Layouts > Save as). You can then display that layout at any time by selecting your custom layout from the View > Layouts > Custom menu.

Some useful layouts have been pre-programmed and are supplied with iView. They include:

- **Configuration**: This layout displays all of the configuration tabs for easy selection.

- **Diagnostics**: Displays all of the diagnostic tabs for easy selection.

- **Default**: Displays the default (initial connection) layout.

- **Custom**: Used to select a custom layout to be displayed. This is the listing of custom layouts created using View > Layouts > Save as.

- **Save As**: Used to create and save a custom layout.
  - Enter the name for the custom layout.
  - Click OK.
About this Section

This section contains detailed information about:

- **iControl AC Specifications** (see page 11-2).
- **Software Test Point Signals**: Descriptions of the signals that can be routed to hardware and software test points (see page 11-3).
- **iBox Field Connections**: Descriptions of field input and output connections on the left side of the iBox, including signal levels in active and inactive states (see page 11-7).
- **Terminal Field Connections** (see page 11-14).
- **System and LAN Ethernet**: Information about TCP/IP addresses (see page 11-15).
- **TORQMAX F5 Parameters Quick Reference**: A listing of TORQMAX F5 drive parameters and their default and typical settings (see page 11-27).
- **PowerBack R6 Parameters Quick Reference**: A listing of PowerBack R6 Regenerative drive parameters and their default and typical settings (see page 11-31).
# iControl AC Specifications

## Table 11.1  iControl AC Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Car Speed</td>
<td>Up to 1800 fpm (9.0 m/s)</td>
</tr>
<tr>
<td>Jerk</td>
<td>15 ft/sec³ (7.62 m/sec³) maximum</td>
</tr>
<tr>
<td></td>
<td>8 ft/sec³ (2.44 m/sec³) nominal</td>
</tr>
<tr>
<td></td>
<td>1 ft/sec³ (0.305 m/sec³) minimum</td>
</tr>
<tr>
<td>Acceleration</td>
<td>10 ft/sec² (3.04 m/sec²) maximum</td>
</tr>
<tr>
<td></td>
<td>4 ft/sec² (1.52 m/sec²) nominal</td>
</tr>
<tr>
<td></td>
<td>1 ft/sec² (0.31 m/sec²) minimum</td>
</tr>
<tr>
<td>Number of Stops</td>
<td>Up to 150 (60 for Simplex operation)</td>
</tr>
<tr>
<td>Number of Cars in Group</td>
<td>Up to 20</td>
</tr>
<tr>
<td>Floor Leveling Accuracy</td>
<td>+/- 0.25 inches (6.35mm) guaranteed</td>
</tr>
<tr>
<td></td>
<td>+/- 0.125 inches (3.18mm) typical</td>
</tr>
<tr>
<td>Minimum Floor to Floor Time</td>
<td>4.8 seconds for 12-foot (3.66m) floor heights if rotating equipment is capable of delivering the necessary torque.</td>
</tr>
<tr>
<td>Environmental Limits</td>
<td>32 to 104 degrees F (0—40 degrees C) ambient</td>
</tr>
<tr>
<td></td>
<td>12,000 ft (3,658m) altitude</td>
</tr>
<tr>
<td></td>
<td>95% relative humidity (non-condensing)</td>
</tr>
</tbody>
</table>
Software Test Point Signals

The iBox allows you to select any one of over fifty signals to display on-screen in iView or on the iBox LCD display at each of two “software test points.” A signal selected on a software test point (Test Point 1, Test Point 2) is also output on the corresponding iBox physical test point (STP 1, STP 2). For example, if you selected Brake Voltage on software Test Point 1, the Brake Voltage value would be displayed on screen and would also be output on iBox test point STP 1. Signals you can choose from are listed in the following table.

Raw signals are unprocessed signals directly from a source. They are frequently too “spikey” to use to read an average value but provide proof of activity and instantaneous reaction to changing conditions.

Filtered values represent the average, filtered value extrapolated from the raw signal to provide a viewable, “smoothed,” signal.

Table 11.2 Test Point Signals

<table>
<thead>
<tr>
<th>Test Signal</th>
<th>Description / Text References</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acceleration (Command)</td>
<td>Post-filter, acceleration command signal.</td>
</tr>
<tr>
<td>Acceleration (Directional)</td>
<td>Directional acceleration signal.</td>
</tr>
<tr>
<td>Acceleration (Filtered)</td>
<td>Pre-filtered acceleration signal.</td>
</tr>
<tr>
<td>Acceleration (Interpolated)</td>
<td>Interpolated (smoothed) acceleration signal.</td>
</tr>
<tr>
<td>Acceleration (Raw)</td>
<td>Raw acceleration signal.</td>
</tr>
<tr>
<td>Acceleration (Slew)</td>
<td>Slew rate limited acceleration signal.</td>
</tr>
<tr>
<td>Armature Active Status</td>
<td>High = armature control enabled.</td>
</tr>
<tr>
<td>Armature Command Control</td>
<td>Filtered armature composite command.</td>
</tr>
<tr>
<td>Armature Command (Damped)</td>
<td>Damped armature composite command.</td>
</tr>
<tr>
<td>Armature Command (Raw)</td>
<td>Raw armature composite command.</td>
</tr>
<tr>
<td>Armature Composite Control</td>
<td>The summation of Armature Command Control and Armature Feed forward Control.</td>
</tr>
<tr>
<td>Armature Current Dampen Feedback</td>
<td>Armature current dampening signal.</td>
</tr>
<tr>
<td>Armature Current Signal</td>
<td>Raw armature current feedback signal.</td>
</tr>
<tr>
<td>Armature Current Synthetic Feedback</td>
<td>Armature current synthetic speed signal used for internal speed reference and for current safety calibration.</td>
</tr>
<tr>
<td>Armature Differential Command</td>
<td>Armature differential command.</td>
</tr>
<tr>
<td>Armature Differential Gain</td>
<td>Armature differential gain.</td>
</tr>
</tbody>
</table>
### Table 11.2  Test Point Signals

<table>
<thead>
<tr>
<th>Test Signal</th>
<th>Description / Text References</th>
</tr>
</thead>
<tbody>
<tr>
<td>Armature Error (Damped)</td>
<td>Dampened armature error signal.</td>
</tr>
<tr>
<td>Armature Error (Raw)</td>
<td>Raw armature error signal.</td>
</tr>
<tr>
<td>Armature Feedforward (Control)</td>
<td>Filtered armature feedforward command.</td>
</tr>
<tr>
<td>Armature Feedforward (Raw)</td>
<td>Raw armature feedforward command.</td>
</tr>
<tr>
<td>Armature Integral Command</td>
<td>Armature integral command.</td>
</tr>
<tr>
<td>Armature Integral Gain</td>
<td>Armature integral gain.</td>
</tr>
<tr>
<td>Armature On Status</td>
<td>High = PID control enabled.</td>
</tr>
<tr>
<td>Armature Proportional Command</td>
<td>Armature proportional command.</td>
</tr>
<tr>
<td>Armature Proportional Gain</td>
<td>Armature proportional gain.</td>
</tr>
<tr>
<td>Armature Voltage Dampen Feedback</td>
<td>Armature voltage dampening signal.</td>
</tr>
<tr>
<td>Armature Voltage Signal</td>
<td>Raw armature voltage feedback signal.</td>
</tr>
<tr>
<td>Armature Voltage Synthetic Feedback</td>
<td>Armature voltage synthetic speed signal used for internal speed reference and for voltage safety calibration.</td>
</tr>
<tr>
<td>Brake Contactor Status</td>
<td>Indicates status (open/closed) of brake contactor. When the signal is high, the contacts are closed. When the contactor is closed AND the brake field module is enabled, the brake will lift.</td>
</tr>
<tr>
<td>Brake Current Feedback</td>
<td>Filtered brake current feedback signal.</td>
</tr>
<tr>
<td>Brake Current Signal</td>
<td>Raw brake current feedback signal.</td>
</tr>
<tr>
<td>Brake Enable Status</td>
<td>Indicates status of signal that enables the brake field module. When high, the module is enabled AND the contactor is closed, the brake will lift.</td>
</tr>
<tr>
<td>Brake Voltage Feedback</td>
<td>Filtered brake voltage feedback signal.</td>
</tr>
<tr>
<td>Brake Voltage Signal</td>
<td>Raw brake voltage feedback signal.</td>
</tr>
<tr>
<td>DAC Offset Status</td>
<td>Indicates whether DAC signal offset is positive or negative.</td>
</tr>
<tr>
<td>Drive Enable Status</td>
<td>Indicates status of signal that enables the motor field module. When high, the module is enabled AND the contactor is closed, the motor will run.</td>
</tr>
<tr>
<td>Drive IOS Limit</td>
<td>This signal represents the hard-coded threshold at which an Inspection Overspeed will be tripped. 150fpm.</td>
</tr>
<tr>
<td>Drive IOS Param Limit</td>
<td>This signal represents the user-configurable threshold (Safety screen) at which an Inspection Overspeed will be tripped.</td>
</tr>
<tr>
<td>Encoder Signal</td>
<td>Raw encoder speed signal.</td>
</tr>
<tr>
<td>Field Active Status</td>
<td>High = motor field control enabled.</td>
</tr>
<tr>
<td>Field Command (Control)</td>
<td>Motor field composite command.</td>
</tr>
<tr>
<td>Field Control Path</td>
<td>MCE internal diagnosis only.</td>
</tr>
<tr>
<td>Field Current Feedback</td>
<td>Filtered motor field current feedback signal.</td>
</tr>
<tr>
<td>Field Current Signal</td>
<td>Raw motor field current feedback signal.</td>
</tr>
<tr>
<td>Field Error</td>
<td>Motor field error signal.</td>
</tr>
<tr>
<td>Field Integral Command</td>
<td>Motor field integral command.</td>
</tr>
<tr>
<td>Field Integral Gain</td>
<td>Motor field integral gain.</td>
</tr>
<tr>
<td>Field Proportional Command</td>
<td>Motor field proportional command.</td>
</tr>
<tr>
<td>Field Proportional Gain</td>
<td>Motor field proportional gain.</td>
</tr>
<tr>
<td>Field Voltage Feedback</td>
<td>Filtered motor field voltage feedback signal.</td>
</tr>
<tr>
<td>Field Voltage Signal</td>
<td>Raw motor field voltage feedback signal.</td>
</tr>
<tr>
<td>Load Weigher (Raw)</td>
<td>Analog load weigher signal, after amplification (adjusted by trimpot LW ADJ), at test point TP_LW on the CTP (cartop) board.</td>
</tr>
<tr>
<td>Load Weigher (Signal)</td>
<td>The controller’s internal representation of the Load Weigher (Raw) signal.</td>
</tr>
<tr>
<td>Test Signal</td>
<td>Description / Text References</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Load Weigher Balanced</td>
<td>This signal is used to determine the amount of pretorque that the controller needs to provide to the motor to help prevent roll-back on takeoff. 0 = balanced load. Please refer to “Pretorque Gain Adjustments” on page 4-17.</td>
</tr>
<tr>
<td>Load Weigher Feedback</td>
<td>This signal represents the smoothed, processed Load Weigher (Signal), captured with doors closed, just before departure.</td>
</tr>
<tr>
<td>Motor Contactor Status</td>
<td>Indicates status (open/closed) of motor contactor. When the signal is high, the contacts are closed. When the contactor is closed AND the motor field module is enabled, the motor will run.</td>
</tr>
<tr>
<td>Over Current Power Threshold</td>
<td>The armature power threshold above which a Loop Over Current fault is generated. Adjusted using Rated Loop Over Current and Loop Over Current Fault Time.</td>
</tr>
<tr>
<td>Over Current Threshold</td>
<td>Armature current signal threshold above which over current power is accumulated. Used for Loop Over Current. Adjusted using Rated Loop Over Current and Loop Over Current Fault Time.</td>
</tr>
<tr>
<td>Pattern (Command)</td>
<td>Post-filtered pattern command signal. Please refer to “Verify Pattern Command and Drive Speed Feedback” on page 2-55. Please refer to “Verifying a One Floor Run” on page 4-5. Please refer to “Pattern Scaling” on page 4-8. Please refer to “Setting Pattern Parameters” on page 4-14.</td>
</tr>
<tr>
<td>Pattern (Directional)</td>
<td>Directional pattern signal.</td>
</tr>
<tr>
<td>Pattern (Filtered)</td>
<td>Pre-filtered pattern signal. Please refer to “Tach Error Tripping Threshold Adjustment” on page 2-57</td>
</tr>
<tr>
<td>Pattern (Interpolated)</td>
<td>Interpolated (smoothed) pattern signal.</td>
</tr>
<tr>
<td>Pattern (Phase)</td>
<td>The numbers displayed represent segments of the speed profile. Please refer to “Shaping the Speed Profile” on page 4-12.</td>
</tr>
<tr>
<td></td>
<td>0 = Idle</td>
</tr>
<tr>
<td></td>
<td>1 = Initial Jerk</td>
</tr>
<tr>
<td></td>
<td>2 = Acceleration</td>
</tr>
<tr>
<td></td>
<td>3 = Low Roll Jerk (during acceleration, high speed is reached)</td>
</tr>
<tr>
<td></td>
<td>4 = Peak (High Speed)</td>
</tr>
<tr>
<td></td>
<td>5 = High Roll Jerk (during acceleration, high speed not reached)</td>
</tr>
<tr>
<td></td>
<td>6 = High/Low Roll Jerk (during deceleration)</td>
</tr>
<tr>
<td></td>
<td>7 = Deceleration</td>
</tr>
<tr>
<td></td>
<td>8 = Flare Jerk (transition from deceleration to leveling)</td>
</tr>
<tr>
<td></td>
<td>9 = Approach Jerk (transition from deceleration to leveling)</td>
</tr>
<tr>
<td></td>
<td>10 = Leveling</td>
</tr>
<tr>
<td>Pattern (Raw)</td>
<td>Raw pattern signal.</td>
</tr>
<tr>
<td>Pattern (Region)</td>
<td>The numbers reflect a simplified representation of the speed profile in comparison to Pattern (Phase).</td>
</tr>
<tr>
<td></td>
<td>0 = Idle</td>
</tr>
<tr>
<td></td>
<td>1 = Acceleration</td>
</tr>
<tr>
<td></td>
<td>2 = Peak</td>
</tr>
<tr>
<td></td>
<td>3 = Deceleration</td>
</tr>
<tr>
<td></td>
<td>4 = Flare</td>
</tr>
<tr>
<td></td>
<td>5 = Leveling</td>
</tr>
<tr>
<td>Pattern (Slew Limited)</td>
<td>Slew rate limited pattern signal.</td>
</tr>
</tbody>
</table>
## Table 11.2 Test Point Signals

<table>
<thead>
<tr>
<th>Test Signal</th>
<th>Description / Text References</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position Bit</td>
<td>This signal represents car position/motion. It is abstracted from the motor velocity encoder or tach signal. The signal toggles low or high with every 32-inches of motor travel. Increasing frequency = increasing rate of position change.</td>
</tr>
<tr>
<td>Pre-Run Status</td>
<td>High = Pre-energizes motor field as doors are closing and demand occurs.</td>
</tr>
<tr>
<td>Pretorque (Command)</td>
<td>This is the actual pretorque signal sent to the drive and used to pretorque the motor. This is filtered representation of the raw pretorque “demand” signal, captured as the doors close and used to pretorque the motor as needed depending on the weight in the car.</td>
</tr>
<tr>
<td>Pretorque (Raw)</td>
<td>This is a representation of the raw pretorque “demand” signal. It will react to car load changes (i.e., doors open, passengers loading/unloading).</td>
</tr>
<tr>
<td>SCR Current Sensor Offset Status</td>
<td>High = SCR current sensor signal offset positive.</td>
</tr>
<tr>
<td>SCR Intg Offset Status</td>
<td>High = SCR integrator signal offset positive.</td>
</tr>
<tr>
<td>Speed Bit</td>
<td>When the car is still, this signal is high. When the car is traveling at a rate in excess of 40fpm, this signal is low.</td>
</tr>
<tr>
<td>Sufficient Field Status</td>
<td>High = sufficient motor field current has been achieved. Different percentage of forcing, depending on mode. Inspection = 60% of forcing. Other, 80% of forcing.</td>
</tr>
<tr>
<td>Synthetic Signal</td>
<td>Speed signal synthesized from armature voltage and current.</td>
</tr>
<tr>
<td>Tach Error Lower Limit</td>
<td>This signal represents the lower margin of tach error allowed at contract speed before a tach fault is generated. Display with Speed Feedback signal to see the margin. If Speed Feedback crosses Tach Error Lower Limit the tach fault will be generated. Please refer to “Tach Error Tripping Threshold Adjustment” on page 2-57. Please refer to “Tach Error Tripping Threshold Adjustment” on page 4-40.</td>
</tr>
<tr>
<td>Tach Error Upper Limit</td>
<td>This signal represents the upper margin of tach error allowed at contract speed before a tach fault is generated. Display with Speed Feedback signal to see the margin. If Speed Feedback crosses Tach Error Upper Limit the tach fault will be generated. Please refer to “Tach Error Tripping Threshold Adjustment” on page 2-57. Please refer to “Tach Error Tripping Threshold Adjustment” on page 4-40.</td>
</tr>
<tr>
<td>Tachometer Signal</td>
<td>Raw tachometer signal.</td>
</tr>
</tbody>
</table>
**iBox Field Connections**

The majority of field connections to the iBox are made through plugable terminal strips along the left edge of the iBox (as you face it). Field connections are control and data connections to and from equipment external to the iBox. For example, connections through the traveler cable to car and hoistway equipment or connections to additional machine room equipment like rope grippers, velocity encoders, governors, etc. In this section, three tables describe connections — iBox connections, expansion board connections, and iControl terminal connections respectively.

### Table 11.3 iBox Field Connections

<table>
<thead>
<tr>
<th>Source</th>
<th>Connection</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TACH</td>
<td>TS</td>
<td>Tach positive signal. Analog. 0 - 30 VDC (15 VDC @ 1000 RPM).</td>
</tr>
<tr>
<td></td>
<td>TC</td>
<td>Tach common (negative in respect to TS when car moving down)</td>
</tr>
<tr>
<td></td>
<td>SHLD</td>
<td>Tach shield connection (connect at iBox-end only)</td>
</tr>
<tr>
<td></td>
<td>DP1+</td>
<td>Positive going, +15V, digital pulse stream from iLand to iLink to iBox (DP1 leads DP2 when car moves up). Please refer to &quot;iLand Landing System&quot; on page 3-2.</td>
</tr>
<tr>
<td></td>
<td>DP1-</td>
<td>Negative going, -15V, digital pulse stream from iLand to iLink to iBox.</td>
</tr>
<tr>
<td></td>
<td>SHLD</td>
<td>Shield connection for twisted-pair DP1+/DP1-</td>
</tr>
<tr>
<td></td>
<td>DP2+</td>
<td>Positive going, +15V, digital pulse stream from iLand to iLink to iBox (DP2 leads DP1 when car moves down)</td>
</tr>
<tr>
<td></td>
<td>DP2-</td>
<td>Negative going, -15V, digital pulse stream from iLand to iLink to iBox</td>
</tr>
<tr>
<td></td>
<td>SHLD</td>
<td>Shield connection for twisted-pair DP2+/DP2-</td>
</tr>
<tr>
<td></td>
<td>A-</td>
<td>Negative going, -12V, digital pulse from motor velocity encoder.</td>
</tr>
<tr>
<td></td>
<td>B+</td>
<td>Positive going, +12V, digital pulse from motor velocity encoder.</td>
</tr>
<tr>
<td></td>
<td>B-</td>
<td>Negative going, -12V, digital pulse from motor velocity encoder.</td>
</tr>
<tr>
<td></td>
<td>Z+</td>
<td>Positive going, +12V, digital pulse from motor velocity encoder.</td>
</tr>
<tr>
<td></td>
<td>Z-</td>
<td>Negative going, -12V, digital pulse from motor velocity encoder.</td>
</tr>
<tr>
<td></td>
<td>VE-</td>
<td>Encoder power return</td>
</tr>
<tr>
<td></td>
<td>VE+</td>
<td>+12 VDC power to encoder (relative to VE-)</td>
</tr>
</tbody>
</table>
### CARTOP LINK

<table>
<thead>
<tr>
<th>Source</th>
<th>Connection</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TX+</td>
<td>iBox transmit, positive going serial communication stream from iBox to iLink. <strong>Connects to iLink ICE-CTP Board terminal RX+.</strong> TX+ and TX- comprise a differential communications pair. Please refer to &quot;Installing iLink&quot; on page 3-13.</td>
<td></td>
</tr>
<tr>
<td>TX-</td>
<td>iBox transmit, negative going serial communication stream from iBox to iLink. <strong>Connects to iLink ICE-CTP Board terminal RX-.</strong></td>
<td></td>
</tr>
<tr>
<td>SHLD</td>
<td>Shield connection for twisted-pair TX+/TX-</td>
<td></td>
</tr>
<tr>
<td>RX+</td>
<td>iBox receive, positive going serial communication stream from iLink to iBox. <strong>Connects to iLink ICE-CTP board terminal TX+.</strong> RX+ and RX- comprise a differential communications pair.</td>
<td></td>
</tr>
<tr>
<td>RX-</td>
<td>iBox receive, negative going serial communication stream from iLink to iBox. <strong>Connects to iLink ICE-CTP board terminal TX-.</strong></td>
<td></td>
</tr>
</tbody>
</table>

### CAR

<table>
<thead>
<tr>
<th>Source</th>
<th>Connection</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DZ</td>
<td>Door Zone Sensor input. Activated = 110 VDC.</td>
<td></td>
</tr>
<tr>
<td>ULM</td>
<td>Up Leveling Marker Sensor input. Activated = 110 VDC.</td>
<td></td>
</tr>
<tr>
<td>DLM</td>
<td>Down Leveling Marker Sensor input. Activated = 110 VDC.</td>
<td></td>
</tr>
<tr>
<td>INCT</td>
<td>Cartop Inspection Station INSP/AUTO Switch input. Activated = 110 VDC.</td>
<td></td>
</tr>
<tr>
<td>ICTU</td>
<td>Cartop Inspection Station UP Button input (includes SAF button). Activated = 110 VDC.</td>
<td></td>
</tr>
<tr>
<td>ICTD</td>
<td>Cartop Inspection Station DN Button input (includes SAF button). Activated = 110 VDC.</td>
<td></td>
</tr>
<tr>
<td>INCP</td>
<td>COP Inspection Station INSP/AUTO Switch input. Activated = 110 VDC.</td>
<td></td>
</tr>
<tr>
<td>ICPU</td>
<td>COP Inspection Station UP Button input. Activated = 110 VDC.</td>
<td></td>
</tr>
<tr>
<td>ICPD</td>
<td>COP Inspection Station DN Button input. Activated = 110 VDC.</td>
<td></td>
</tr>
<tr>
<td>INA</td>
<td>Car Panel (Hoistway) Access Enable switch input. 0 VDC active signal level. Off = 110 VDC.</td>
<td></td>
</tr>
<tr>
<td>ESC</td>
<td>Car Panel Emergency Stop switch input. 0 VDC active signal level stops car. Off = 110 VDC.</td>
<td></td>
</tr>
<tr>
<td>DCL</td>
<td>Door Close Limit input. Door fully closed, input inactive, 0 VAC. Door not closed signal level, 120 VAC.</td>
<td></td>
</tr>
<tr>
<td>DOL</td>
<td>Door Open Limit input. Door fully open, input inactive, 0 VAC. Door not open signal level, 120 VAC.</td>
<td></td>
</tr>
<tr>
<td>DPM</td>
<td>Door Position Monitor input. Door closed, input inactive, 120 VAC. Door not closed, 0 VAC.</td>
<td></td>
</tr>
</tbody>
</table>
Table 11.3  iBox Field Connections

<table>
<thead>
<tr>
<th>Source</th>
<th>Connection</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UNTD</td>
<td>Up Normal Limit</td>
<td>110 VDC = input on/switch closed. 0 VDC = input off/switch</td>
</tr>
<tr>
<td></td>
<td>Direction switch</td>
<td>open.</td>
</tr>
<tr>
<td>UNT5</td>
<td>Up Slowdown Limit</td>
<td>5 input. 110 VDC = input on/switch closed. 0 VDC = input off/switch open.</td>
</tr>
<tr>
<td>UNT4</td>
<td>Up Slowdown Limit</td>
<td>4 input. 110 VDC = input on/switch closed. 0 VDC = input off/switch open.</td>
</tr>
<tr>
<td>UNT3</td>
<td>Up Slowdown Limit</td>
<td>3 input. 110 VDC = input on/switch closed. 0 VDC = input off/switch open.</td>
</tr>
<tr>
<td>UNT2</td>
<td>Up Slowdown Limit</td>
<td>2 input. 110 VDC = input on/switch closed. 0 VDC = input off/switch open.</td>
</tr>
<tr>
<td>UETS</td>
<td>Up Emergency</td>
<td>Terminal Limit switch input. 110 VDC = input on/switch closed. 0 VDC = input off/switch open.</td>
</tr>
<tr>
<td>UNT1</td>
<td>Up Slowdown Limit</td>
<td>1 input. 110 VDC = input on/switch closed. 0 VDC = input off/switch open.</td>
</tr>
<tr>
<td>DNT1</td>
<td>Down Slowdown</td>
<td>Limit switch #1 input. 110 VDC = input on/switch closed. 0 VDC = input off/switch open.</td>
</tr>
<tr>
<td></td>
<td>Limit switch</td>
<td></td>
</tr>
<tr>
<td>DETS</td>
<td>Down Emergency</td>
<td>Terminal Limit switch input. 110 VDC = input on/switch closed. 0 VDC = input off/switch open.</td>
</tr>
<tr>
<td>DNT2</td>
<td>Down Slowdown</td>
<td>Limit switch #2 input. 110 VDC = input on/switch closed. 0 VDC = input off/switch open.</td>
</tr>
<tr>
<td></td>
<td>Limit switch</td>
<td></td>
</tr>
<tr>
<td>DNT3</td>
<td>Down Slowdown</td>
<td>Limit switch #3 input. 110 VDC = input on/switch closed. 0 VDC = input off/switch open.</td>
</tr>
<tr>
<td></td>
<td>Limit switch</td>
<td></td>
</tr>
<tr>
<td>DNT4</td>
<td>Down Slowdown</td>
<td>Limit switch #4 input. 110 VDC = input on/switch closed. 0 VDC = input off/switch open.</td>
</tr>
<tr>
<td></td>
<td>Limit switch</td>
<td></td>
</tr>
<tr>
<td>DNT5</td>
<td>Down Slowdown</td>
<td>Limit switch #5 input. 110 VDC = input on/switch closed. 0 VDC = input off/switch open.</td>
</tr>
<tr>
<td></td>
<td>Limit switch</td>
<td></td>
</tr>
<tr>
<td>DNTD</td>
<td>Down Normal Limit</td>
<td>Direction switch input. 110 VDC = input on/switch closed. 0 VDC = input off/switch open.</td>
</tr>
</tbody>
</table>
ATU Hoistway Access Top Up switch input. When the Car Panel Access Enable switch (INA input) is on, an active input (key switch closure) here (110 VDC) will cause the car to move up the hoistway. A hoistway limit switch electrically between the ATU input and the activating switch will open and stop the car after it has moved the required distance up the hoistway (if installed). Normal/Off state = 0 VDC. Refer also to the -MRW drawing in the job prints.

ATD Hoistway Access Top Down switch input. When the Car Panel Access Enable switch (INA input) is on, an active input (key switch closure) here (110 VDC) will cause the car to move down the hoistway. A hoistway limit switch electrically between the ATD input and the activating switch will open and stop the car after it has moved the required distance down the hoistway (if installed). Normal/Off state = 0 VDC. Refer also to the -MRW drawing in the job prints.

ABU Hoistway Access Bottom Up switch input. When the Car Panel Access Enable switch (INA input) is on, an active input (key switch closure) here (110 VDC) will cause the car to move up the hoistway. A hoistway limit switch electrically between the ABU input and the activating switch will open and stop the car after it has moved the required distance up the hoistway (if installed). Normal/Off state = 0 VDC. Refer also to the -MRW drawing in the job prints.

ABD Hoistway Access Bottom Down switch input. When the Car Panel Access Enable switch (INA input) is on, an active input (key switch closure) here (110 VDC) will cause the car to move down the hoistway. A hoistway limit switch electrically between the ABD input and the activating switch will open and stop the car after it has moved the required distance down the hoistway (if installed). Normal/Off state = 0 VDC. Refer also to the -MRW drawing in the job prints.

### Table 11.3  iBox Field Connections

<table>
<thead>
<tr>
<th>Source</th>
<th>Connection</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATU</td>
<td>Hoistway Access Top Up switch input. When the Car Panel Access Enable switch (INA input) is on, an active input (key switch closure) here (110 VDC) will cause the car to move up the hoistway. A hoistway limit switch electrically between the ATU input and the activating switch will open and stop the car after it has moved the required distance up the hoistway (if installed). Normal/Off state = 0 VDC. Refer also to the -MRW drawing in the job prints.</td>
<td></td>
</tr>
<tr>
<td>ATD</td>
<td>Hoistway Access Top Down switch input. When the Car Panel Access Enable switch (INA input) is on, an active input (key switch closure) here (110 VDC) will cause the car to move down the hoistway. A hoistway limit switch electrically between the ATD input and the activating switch will open and stop the car after it has moved the required distance down the hoistway (if installed). Normal/Off state = 0 VDC. Refer also to the -MRW drawing in the job prints.</td>
<td></td>
</tr>
<tr>
<td>ABU</td>
<td>Hoistway Access Bottom Up switch input. When the Car Panel Access Enable switch (INA input) is on, an active input (key switch closure) here (110 VDC) will cause the car to move up the hoistway. A hoistway limit switch electrically between the ABU input and the activating switch will open and stop the car after it has moved the required distance up the hoistway (if installed). Normal/Off state = 0 VDC. Refer also to the -MRW drawing in the job prints.</td>
<td></td>
</tr>
<tr>
<td>ABD</td>
<td>Hoistway Access Bottom Down switch input. When the Car Panel Access Enable switch (INA input) is on, an active input (key switch closure) here (110 VDC) will cause the car to move down the hoistway. A hoistway limit switch electrically between the ABD input and the activating switch will open and stop the car after it has moved the required distance down the hoistway (if installed). Normal/Off state = 0 VDC. Refer also to the -MRW drawing in the job prints.</td>
<td></td>
</tr>
</tbody>
</table>
## Table 11.3 iBox Field Connections

<table>
<thead>
<tr>
<th>Source</th>
<th>Connection</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GS</td>
<td>Gate Switch input. The gate switch makes up when the elevator doors close. When the switch is made, there will be 110 VDC on this input. When the switch is open, there will be 0 VDC on this input. The gate switch may be wired in series with other switches or locks on the elevator doors (as shown in the job prints) so that if any of the switches do not make, the GS input will remain low and the car will not run.</td>
<td></td>
</tr>
<tr>
<td>DLAT</td>
<td>Door Lock Access Top input. When a top hoistway access is provided (see INA, ATU, and ATD), the hoistway door lock associated with that landing is connected between the #3 bus and this input. When the switch is made, there will be 110 VDC on this input. When the switch is open, there will be 0 VDC on this input and the car will not run unless INA is active and then only in response to the ATU or ATD input.</td>
<td></td>
</tr>
<tr>
<td>DLMS</td>
<td>Door Lock Main String input. If top and bottom hoistway access (see INA, ATU, ATD, ABU, and ABD) is not provided, all hoistway door locks are wired in series between the #3 bus and DLMS. When the switches are made, there will be 110 VDC on this input. When any switch is open, there will be 0 VDC on this input and the car will not run.</td>
<td></td>
</tr>
<tr>
<td>DLAB</td>
<td>Door Lock Access Bottom input. When a bottom hoistway access is provided (see INA, ABU, and ABD), the hoistway door lock associated with that landing is connected between the #3 bus and this input. When the switch is made, there will be 110 VDC on this input. When the switch is open, there will be 0 VDC on this input and the car will not run unless INA is active and then only in response to the ABU or ABD input.</td>
<td></td>
</tr>
<tr>
<td>DCAT</td>
<td>Door Contact Access Top input. When a top hoistway access is provided (see INA, ATU, ATD, and DLAT), the hoistway door contact associated with that landing is connected between the #3 bus and this input. When the switch is made, there will be 110 VDC on this input. When the switch is open, there will be 0 VDC on this input and the car will not run unless INA is active and then only in response to the ATU or ATD input.</td>
<td></td>
</tr>
<tr>
<td>DCMS</td>
<td>Door Contact Main String input. If top and bottom hoistway access (see INA, ATU, ATD, ABU, and ABD) is not provided, all hoistway door contacts are wired in series between the #3 bus and DCMS. When the switches are made, there will be 110 VDC on this input. When any switch is open, there will be 0 VDC on this input and the car will not run.</td>
<td></td>
</tr>
<tr>
<td>DCAB</td>
<td>Door Contact Access Bottom input. When a bottom hoistway access is provided (see INA, ABU, ABD, and DLAB), the hoistway door contact associated with that landing is connected between the #3 bus and this input. When the switch is made, there will be 110 VDC on this input. When the switch is open, there will be 0 VDC on this input and the car will not run unless INA is active and then only in response to the ABU or ABD input.</td>
<td></td>
</tr>
<tr>
<td>GOV</td>
<td>Governor input. The governor is connected between the #3 bus and this input. When the governor switch is made, there is 110 VDC on this input. If the governor switch trips/opens, there is 0 VDC on this input and the car will not run.</td>
<td></td>
</tr>
<tr>
<td>SP 1</td>
<td>Spare input 1. If used, connect as shown in the job prints.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 11.3 iBox Field Connections

<table>
<thead>
<tr>
<th>Source</th>
<th>Connection</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BRAKE</strong></td>
<td>BD</td>
<td>Brake Drive relay indicator. When the BD relay on the iBox IRB board is closed to pick the brake, this LED will light. Monitored by Safety Processor A.</td>
</tr>
<tr>
<td></td>
<td>TB</td>
<td>Brake Triac active indicator. When the brake triac on the iBox IRB board is active (completes circuit for BD relay), this LED will light. Monitored by Safety Processor B.</td>
</tr>
<tr>
<td></td>
<td>BRD</td>
<td>Brake Redundancy indicator. This LED lights when the main brake contactor drops out.</td>
</tr>
<tr>
<td></td>
<td>BDRD</td>
<td>Brake Drive Redundancy indicator. This LED lights when the BD relay drops out.</td>
</tr>
<tr>
<td><strong>DRIVE</strong></td>
<td>MD</td>
<td>Motor Drive relay indicator. When the MD relay on the iBox IRB board is closed to enable the motor, this LED will light. Monitored by Safety Processor A.</td>
</tr>
<tr>
<td></td>
<td>TM</td>
<td>Motor Triac active indicator. When the motor triac on the iBox IRB board is active (completes circuit for MD relay), this LED will light. Monitored by Safety Processor B.</td>
</tr>
<tr>
<td></td>
<td>MRD</td>
<td>Motor Redundancy indicator. This LED lights when the main motor contactor drops out.</td>
</tr>
<tr>
<td></td>
<td>MDRD</td>
<td>Motor Drive Redundancy indicator. This LED lights when the MD relay drops out.</td>
</tr>
<tr>
<td><strong>SAFETY</strong></td>
<td>SAFC</td>
<td>Safety Cartop input. Cartop safety relays and switches are wired in series between SAFH (Safety Hoistway) and SAFC. If any contact in the safety string opens, there will be 0 VDC on this input and the car will not run. If all safety contacts in the string are closed, there will be 110 VDC on this input.</td>
</tr>
<tr>
<td></td>
<td>SAFH</td>
<td>Safety Hoistway input. Hoistway safety relays and switches are wired in series between the #3 bus and SAFH. The path also includes the Governor switch, with the GOV connection providing access to the #3 bus via the governor switch. (#3 to GOV through governor switch, GOV to SAFH through hoistway safety relays and switches). The job prints for the job provide specific wiring instructions. If any contact in the safety string opens, there will be 0 VDC on this input and the car will not run. If all safety contacts in the string are closed, there will be 110 VDC on this input.</td>
</tr>
<tr>
<td><strong>SPARES</strong></td>
<td>SP1 D</td>
<td>Optional input. Job prints will show if and how this is used on a per installation basis.</td>
</tr>
<tr>
<td></td>
<td>SP2 D</td>
<td>Optional Brake Pick switch input. When brake is set = 110 VDC. When brake is picked (brake pick switch open) = 0 VDC.</td>
</tr>
<tr>
<td></td>
<td>SP2</td>
<td>Optional input. Job prints will show if and how this is used on a per installation basis.</td>
</tr>
<tr>
<td></td>
<td>SP3</td>
<td>Optional input. Job prints will show if and how this is used on a per installation basis.</td>
</tr>
<tr>
<td></td>
<td>SP4</td>
<td>Optional input. Job prints will show if and how this is used on a per installation basis.</td>
</tr>
</tbody>
</table>
Table 11.3 iBox Field Connections

<table>
<thead>
<tr>
<th>Source</th>
<th>Connection</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMMON</td>
<td>1</td>
<td>Common Bus connections. 0 V</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>Common Bus connections. 0 V</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>Common Bus connections. 0 V</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>Common Bus connections. 0 V</td>
</tr>
<tr>
<td>120 VAC</td>
<td>2 PI</td>
<td>120 VAC. Fused, 2PI.</td>
</tr>
<tr>
<td></td>
<td>2 PI</td>
<td>120 VAC. Fused, 2PI.</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>120 VAC. Fused, F2.</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>120 VAC. Fused, F2.</td>
</tr>
<tr>
<td>110 VDC</td>
<td>3 HA</td>
<td>110 VDC. Fused, F3HA.</td>
</tr>
<tr>
<td></td>
<td>3 HA</td>
<td>110 VDC. Fused, F3HA.</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>110 VDC. Fused, F3.</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>110 VDC. Fused, F3.</td>
</tr>
</tbody>
</table>

Table 11.4 Expansion Board Connections

<table>
<thead>
<tr>
<th>Board</th>
<th>Connection</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOR</td>
<td>Out 1 - Out 32</td>
<td>The MOR (Multiple Output Relay) board provides 32 outputs customers may use as needed for the particular job. Typical uses include activating chimes, buzzers, lights, etc. Each MOR board is configured according to the job survey for a particular job before the system is shipped. MOR boards may be installed in the iControl cabinet, in the iLink cartop box, or in the iCentral cabinet (for elevator group controller use). Output selection instructions are transmitted serially to the board. The 32 outputs are divided into five groups (1-4, 5-8, 9-16, 17-24, and 25-32). According to need, each group can be connected to provide the required output. Specific connections and output values are specified in the job prints. Please refer to “Input Signal Groups” on page 9-108.</td>
</tr>
<tr>
<td>MIAC</td>
<td>In 1 - In 32</td>
<td>The MIAC (Multiple Input AC) board provides 32 inputs customers may use as needed for the particular job. MIAC boards may be installed in the iControl cabinet, in the iLink cartop box, or in the iCentral cabinet (for elevator group controller use). Typical uses include car call buttons, operating mode switches, etc. Specific connections are detailed in the job prints. Please refer to “Input Signal Groups” on page 9-108.</td>
</tr>
<tr>
<td>SF</td>
<td>CAR 1</td>
<td>Common connection. 0V.</td>
</tr>
<tr>
<td></td>
<td>CAR +24</td>
<td>+24 VDC power to serial fixtures.</td>
</tr>
<tr>
<td></td>
<td>CAR CDATA</td>
<td>Serial data stream to fixtures.</td>
</tr>
<tr>
<td></td>
<td>HALL 1</td>
<td>Common connection. 0V.</td>
</tr>
<tr>
<td></td>
<td>HALL +24</td>
<td>+24 VDC power to serial fixtures.</td>
</tr>
<tr>
<td></td>
<td>HALL HDATA</td>
<td>Serial data stream to fixtures.</td>
</tr>
</tbody>
</table>
Field connections are also made to terminal strips in the iControl cabinet. Terminal connections provided vary from job to job depending upon need. Power distribution connections, beyond the basic three system buses, are specified in the job prints and are not included here.

### Table 11.4 Expansion Board Connections

<table>
<thead>
<tr>
<th>Board</th>
<th>Connection</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQ</td>
<td>EQSP 1</td>
<td>Earthquake spare sensor input.</td>
</tr>
<tr>
<td></td>
<td>ESS</td>
<td>Earthquake Seismic Switch input. Normally at 120 VAC. If seismic switch opens, 0 VDC. Press reset button on IEQ board to reset (after clearing any potential problems caused by quake).</td>
</tr>
<tr>
<td></td>
<td>CW2</td>
<td>Along with CW1, “ring and string” input from counterweight movement sensor. Normally at 24 VDC.</td>
</tr>
<tr>
<td></td>
<td>CW1</td>
<td>Along with CW2, “ring and string” input from counterweight movement sensor. Normally at 24 VDC.</td>
</tr>
<tr>
<td>RG</td>
<td>RG1</td>
<td>24V DC power to rope gripper.</td>
</tr>
<tr>
<td></td>
<td>RG2</td>
<td>Common. 0 VDC.</td>
</tr>
<tr>
<td></td>
<td>RG5</td>
<td>Rope gripper input. Normally at 120 VAC. If rope gripper manual operation is selected, or if rope gripper is triggered, 0 V.</td>
</tr>
<tr>
<td></td>
<td>RG7</td>
<td>120 VAC from #2 bus to rope gripper switches.</td>
</tr>
</tbody>
</table>

### Table 11.5 Controller Terminal Strip Connections

<table>
<thead>
<tr>
<th>Label</th>
<th>Signal Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B1, B2</td>
<td>DC power to motor brake. Voltage across terminals will vary depending upon brake control method (Low Current Brake Board or iField Brake Module). See your job prints. Significant voltage may be present even when brake is not picked.</td>
</tr>
<tr>
<td>MF1, MF2</td>
<td>DC power to motor field. Voltage across terminals will vary. Significant voltage may be present even if motor is not running.</td>
</tr>
<tr>
<td>15A</td>
<td>Final Limit switch. Wired as shown in job prints. 110 VDC when switch is made. 0 VDC when switch in string opens.</td>
</tr>
<tr>
<td>15B</td>
<td>Pit/Final Limit switch. Wired as shown in job prints. 110 VDC when switch is made. 0 VDC when switch in string opens.</td>
</tr>
<tr>
<td>1</td>
<td>System common.</td>
</tr>
<tr>
<td>2</td>
<td>120 VAC bus.</td>
</tr>
<tr>
<td>3</td>
<td>110 VDC bus.</td>
</tr>
</tbody>
</table>
System and LAN Ethernet

Communication between iControl elevator controllers and iCentral group control uses Ethernet TCP/IP (Transmission Control Protocol/Internet Protocol) over the System network. Communication between iControl elevator controllers and/or the iCentral group control and personal computers running iView or other iControl applications is over the LAN (Local Area Network) network. Cables used in the two systems are color-coded for easy recognition. System cables are orange. LAN cables are blue.

The following tables provide in-depth addressing information for the iControl/iCentral system.

**MCE Direct-Connect Port (Links one iBox to one Laptop with iView)**

<table>
<thead>
<tr>
<th>IBox Direct Connect Port</th>
<th>IP</th>
<th>Subnet</th>
<th>Gateway</th>
<th>DNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any iBox</td>
<td>192.168.193.1</td>
<td>255.255.255.0</td>
<td>Blank or 0.0.0.0</td>
<td>Blank or 0.0.0.0</td>
</tr>
<tr>
<td>Any PC / Laptop</td>
<td>192.168.193.2</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>(MCE reserved)</td>
<td>All other addresses</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
</tbody>
</table>

" = same as above
**Elevator LAN Network**

Normally extends throughout a building and may span to other buildings, networks, or locations across the internet/intranet.

<table>
<thead>
<tr>
<th>LAN Network Hub (Blue cables)</th>
<th>IP</th>
<th>Subnet</th>
<th>Gateway</th>
<th>DNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>(IEEE reserved)</td>
<td>192.168.191.0</td>
<td>255.255.255.0</td>
<td>192.168.191.254</td>
<td>192.168.191.254</td>
</tr>
</tbody>
</table>

**Group 1 – LAN Network (Blue cables)**

<table>
<thead>
<tr>
<th>IP</th>
<th>Subnet</th>
<th>Gateway</th>
<th>DNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>iBox – Car 1</td>
<td>192.168.191.1</td>
<td>255.255.255.0</td>
<td>192.168.191.254</td>
</tr>
<tr>
<td>iBox – Car 2</td>
<td>192.168.191.2</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 3</td>
<td>192.168.191.3</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 4</td>
<td>192.168.191.4</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 5</td>
<td>192.168.191.5</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 6</td>
<td>192.168.191.6</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 7</td>
<td>192.168.191.7</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 8</td>
<td>192.168.191.8</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 9</td>
<td>192.168.191.9</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 10</td>
<td>192.168.191.10</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 11</td>
<td>192.168.191.11</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 12</td>
<td>192.168.191.12</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 13</td>
<td>192.168.191.13</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 14</td>
<td>192.168.191.14</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 15</td>
<td>192.168.191.15</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 16</td>
<td>192.168.191.16</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 17</td>
<td>192.168.191.17</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 18</td>
<td>192.168.191.18</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 19</td>
<td>192.168.191.19</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 20</td>
<td>192.168.191.20</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iView</td>
<td>192.168.191.101</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>iView</td>
<td>192.168.191.102</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>iCue</td>
<td>192.168.191.201</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>iCue</td>
<td>192.168.191.202</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

**Group 2 – LAN Network (Blue cables)**

<table>
<thead>
<tr>
<th>IP</th>
<th>Subnet</th>
<th>Gateway</th>
<th>DNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>iBox – Car 1</td>
<td>192.168.191.21</td>
<td>255.255.255.0</td>
<td>192.168.191.254</td>
</tr>
<tr>
<td>iBox – Car 2</td>
<td>192.168.191.22</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 3</td>
<td>192.168.191.23</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 4</td>
<td>192.168.191.24</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 5</td>
<td>192.168.191.25</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 6</td>
<td>192.168.191.26</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 7</td>
<td>192.168.191.27</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 8</td>
<td>192.168.191.28</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 9</td>
<td>192.168.191.29</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 10</td>
<td>192.168.191.30</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 11</td>
<td>192.168.191.31</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 12</td>
<td>192.168.191.32</td>
<td>*</td>
<td>*</td>
</tr>
</tbody>
</table>
### Group 3 – LAN Network (Blue cables)

<table>
<thead>
<tr>
<th>IP</th>
<th>Subnet</th>
<th>Gateway</th>
<th>DNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>iBox – Car 1</td>
<td>192.168.191.41</td>
<td>255.255.255.0</td>
<td>192.168.191.254 *</td>
</tr>
<tr>
<td>iBox – Car 2</td>
<td>192.168.191.42</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 3</td>
<td>192.168.191.43</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 4</td>
<td>192.168.191.44</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 5</td>
<td>192.168.191.45</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 6</td>
<td>192.168.191.46</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>...</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 20</td>
<td>192.168.191.60</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
</tbody>
</table>

### Group 4 – LAN Network (Blue cables)

<table>
<thead>
<tr>
<th>IP</th>
<th>Subnet</th>
<th>Gateway</th>
<th>DNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>iBox – Car 1</td>
<td>192.168.191.61</td>
<td>255.255.255.0</td>
<td>192.168.191.254 *</td>
</tr>
<tr>
<td>iBox – Car 2</td>
<td>192.168.191.62</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 3</td>
<td>192.168.191.63</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 4</td>
<td>192.168.191.64</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 5</td>
<td>192.168.191.65</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 6</td>
<td>192.168.191.66</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>...</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 20</td>
<td>192.168.191.80</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
</tbody>
</table>

### Group 5 – LAN Network (Blue cables)

<table>
<thead>
<tr>
<th>IP</th>
<th>Subnet</th>
<th>Gateway</th>
<th>DNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>iBox – Car 1</td>
<td>192.168.191.81</td>
<td>255.255.255.0</td>
<td>192.168.191.254 *</td>
</tr>
<tr>
<td>iBox – Car 2</td>
<td>192.168.191.82</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 3</td>
<td>192.168.191.83</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 4</td>
<td>192.168.191.84</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 5</td>
<td>192.168.191.85</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 6</td>
<td>192.168.191.86</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>Group 6 – LAN Network (Blue cables)</td>
<td>IP</td>
<td>Subnet</td>
<td>Gateway</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------</td>
<td>-----------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>iBox – Car 1</td>
<td>192.168.191.121</td>
<td>255.255.255.0</td>
<td>192.168.191.254 *</td>
</tr>
<tr>
<td>iBox – Car 2</td>
<td>192.168.191.122</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 3</td>
<td>192.168.191.123</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 4</td>
<td>192.168.191.124</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 5</td>
<td>192.168.191.125</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 6</td>
<td>192.168.191.126</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>...</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 20</td>
<td>192.168.191.140</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iView</td>
<td>192.168.191.111 – 192.168.191.112</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iCue</td>
<td>192.168.191.211 – 192.168.191.212</td>
<td>*</td>
<td>*</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Group 7 – LAN Network (Blue cables)</th>
<th>IP</th>
<th>Subnet</th>
<th>Gateway</th>
<th>DNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>iBox – Car 1</td>
<td>192.168.191.141</td>
<td>255.255.255.0</td>
<td>192.168.191.254 *</td>
<td>192.168.191.254 *</td>
</tr>
<tr>
<td>iBox – Car 2</td>
<td>192.168.191.142</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 3</td>
<td>192.168.191.143</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 4</td>
<td>192.168.191.144</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 5</td>
<td>192.168.191.145</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 6</td>
<td>192.168.191.146</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>...</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 20</td>
<td>192.168.191.160</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iView</td>
<td>192.168.191.113 – 192.168.191.114</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iCue</td>
<td>192.168.191.213 – 192.168.191.214</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Group 8 – LAN Network (Blue cables)</th>
<th>IP</th>
<th>Subnet</th>
<th>Gateway</th>
<th>DNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>iBox – Car 1</td>
<td>192.168.191.161</td>
<td>255.255.255.0</td>
<td>192.168.191.254 *</td>
<td>192.168.191.254 *</td>
</tr>
<tr>
<td>iBox – Car 2</td>
<td>192.168.191.162</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 3</td>
<td>192.168.191.163</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 4</td>
<td>192.168.191.164</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 5</td>
<td>192.168.191.165</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 6</td>
<td>192.168.191.166</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>...</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 20</td>
<td>192.168.191.180</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iView</td>
<td>192.168.191.115 – 192.168.191.116</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iCue</td>
<td>192.168.191.215 – 192.168.191.216</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
</tbody>
</table>
### System and LAN Ethernet

#### Note

#1: This parameter may have a site-dependant value depending on the unique DSL service or internet connection details. The default value shown can be used until a new value is identified. There may be more than one of these values provided.

#### Summary

This is a summary of the entire LAN IP address space including MCE supplied equipment and non-MCE supplied equipment.

<table>
<thead>
<tr>
<th>*<em>LAN Network IP Address Summary Map For Network=192.168.191.</em></th>
<th><strong>IP</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>(IEEE non-usable)</strong></td>
<td>192.168.191.0</td>
</tr>
<tr>
<td><strong>IBox (Groups 1, 2, 3, 4, 5)</strong></td>
<td>192.168.191.1 – 192.168.191.100</td>
</tr>
<tr>
<td><strong>iView</strong></td>
<td>192.168.191.101 – 192.168.191.120</td>
</tr>
<tr>
<td><strong>IBox (Groups 6, 7, 8, 9)</strong></td>
<td>192.168.191.121 – 192.168.191.200</td>
</tr>
<tr>
<td><strong>iCue</strong></td>
<td>192.168.191.201 – 192.168.191.220</td>
</tr>
<tr>
<td><strong>iMonitor</strong></td>
<td>192.168.191.221 – 192.168.191.222</td>
</tr>
</tbody>
</table>

**With Optional Third-party Access**

| **3rd-Party access address** | 192.168.191.223 |

**With Optional Firewall / Router / Modem Dial-in**

| **Static IP addresses** | 192.168.191.246 – 192.168.191.251 |
| **First Dial-in address** | 192.168.191.252 |
| **MCE Reserved** | 192.168.192.253 |
| **Firewall / Router** | 192.168.191.254 |
| **(IEEE non-usable)** | 192.168.191.255 |
## Summary by Group

### Group #1 – Floors ( ) Machine Room Floor ( )

<table>
<thead>
<tr>
<th>Group #1 -iBox Direct Connect Port</th>
<th>IP</th>
<th>Subnet</th>
<th>Gateway</th>
<th>DNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any iBox</td>
<td>192.168.193.1</td>
<td>255.255.255.0</td>
<td>Blank or 0.0.0.0</td>
<td>Blank or 0.0.0.0</td>
</tr>
<tr>
<td>Any PC / Laptop</td>
<td>192.168.193.2</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Group #1 -MCE System Network</th>
<th>(Orange cables)</th>
</tr>
</thead>
<tbody>
<tr>
<td>iBox – Car 1</td>
<td>192.168.192.1</td>
</tr>
<tr>
<td>iBox – Car 2</td>
<td>192.168.192.2</td>
</tr>
<tr>
<td>iBox – Car 3</td>
<td>192.168.192.3</td>
</tr>
<tr>
<td>iBox – Car 4</td>
<td>192.168.192.4</td>
</tr>
<tr>
<td>iBox – Car 5</td>
<td>192.168.192.5</td>
</tr>
<tr>
<td>iBox – Car 6</td>
<td>192.168.192.6</td>
</tr>
<tr>
<td>iBox – Car 7</td>
<td>192.168.192.7</td>
</tr>
<tr>
<td>iBox – Car 8</td>
<td>192.168.192.8</td>
</tr>
<tr>
<td>iBox – Car 9</td>
<td>192.168.192.9</td>
</tr>
<tr>
<td>iBox – Car 10</td>
<td>192.168.192.10</td>
</tr>
<tr>
<td>iBox – Car 11</td>
<td>192.168.192.11</td>
</tr>
<tr>
<td>iBox – Car 12</td>
<td>192.168.192.12</td>
</tr>
<tr>
<td>iBox – Car 13</td>
<td>192.168.192.13</td>
</tr>
<tr>
<td>iBox – Car 14</td>
<td>192.168.192.14</td>
</tr>
<tr>
<td>iBox – Car 15</td>
<td>192.168.192.15</td>
</tr>
<tr>
<td>iBox – Car 16</td>
<td>192.168.192.16</td>
</tr>
<tr>
<td>iBox – Car 17</td>
<td>192.168.192.17</td>
</tr>
<tr>
<td>iBox – Car 18</td>
<td>192.168.192.18</td>
</tr>
<tr>
<td>iBox – Car 19</td>
<td>192.168.192.19</td>
</tr>
<tr>
<td>iBox – Car 20</td>
<td>192.168.192.20</td>
</tr>
<tr>
<td>iCue</td>
<td>192.168.192.201 - 192.168.192.202</td>
</tr>
</tbody>
</table>

**Digi Hall Calls UDP 3000-3007**

<table>
<thead>
<tr>
<th>IP</th>
<th>Subnet</th>
<th>Gateway</th>
<th>DNS</th>
</tr>
</thead>
<tbody>
<tr>
<td>192.168.192.211 - 192.168.192.214</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
</tbody>
</table>

" = same as above
<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>iBox – Car 1</td>
<td>192.168.191.1</td>
<td>255.255.255.0</td>
<td>192.168.191.254 *</td>
<td>192.168.191.254 *</td>
</tr>
<tr>
<td>iBox – Car 2</td>
<td>192.168.191.2</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 3</td>
<td>192.168.191.3</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 4</td>
<td>192.168.191.4</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 5</td>
<td>192.168.191.5</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 6</td>
<td>192.168.191.6</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 7</td>
<td>192.168.191.7</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 8</td>
<td>192.168.191.8</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 9</td>
<td>192.168.191.9</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 10</td>
<td>192.168.191.10</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 11</td>
<td>192.168.191.11</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 12</td>
<td>192.168.191.12</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 13</td>
<td>192.168.191.13</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 14</td>
<td>192.168.191.14</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 15</td>
<td>192.168.191.15</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 16</td>
<td>192.168.191.16</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 17</td>
<td>192.168.191.17</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 18</td>
<td>192.168.191.18</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 19</td>
<td>192.168.191.19</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 20</td>
<td>192.168.191.20</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iView</td>
<td>192.168.191.101 - 192.168.191.102</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iCue</td>
<td>192.168.191.201 - 192.168.191.202</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
</tbody>
</table>
### Group #2 – LAN Network (Blue cables)

<table>
<thead>
<tr>
<th>Device Type</th>
<th>IP Address 1</th>
<th>IP Address 2</th>
<th>IP Address 3</th>
<th>IP Address 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>iBox – Car 1</td>
<td>192.168.191.21</td>
<td>255.255.255.0</td>
<td>192.168.191.254*</td>
<td>192.168.191.254*</td>
</tr>
<tr>
<td>iBox – Car 2</td>
<td>192.168.191.22</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 3</td>
<td>192.168.191.23</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 4</td>
<td>192.168.191.24</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 5</td>
<td>192.168.191.25</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 6</td>
<td>192.168.191.26</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 7</td>
<td>192.168.191.27</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 8</td>
<td>192.168.191.28</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 9</td>
<td>192.168.191.29</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 10</td>
<td>192.168.191.30</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 11</td>
<td>192.168.191.31</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 12</td>
<td>192.168.191.32</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 13</td>
<td>192.168.191.33</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 14</td>
<td>192.168.191.34</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 15</td>
<td>192.168.191.35</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 16</td>
<td>192.168.191.36</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 17</td>
<td>192.168.191.37</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 18</td>
<td>192.168.191.38</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 19</td>
<td>192.168.191.39</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 20</td>
<td>192.168.191.40</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iView</td>
<td>192.168.191.103 -192.168.191.104</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iCue</td>
<td>192.168.191.203 -192.168.191.204</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
</tbody>
</table>
### Group #3 - LAN Network (Blue cables)

<table>
<thead>
<tr>
<th>Device</th>
<th>IP Address</th>
<th>Subnet Mask</th>
<th>Gateway Address</th>
<th>Host Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>iBox - Car 1</td>
<td>192.168.191.41</td>
<td>255.255.255.0</td>
<td>192.168.191.25</td>
<td>192.168.191.125</td>
</tr>
<tr>
<td>iBox - Car 2</td>
<td>192.168.191.42</td>
<td></td>
<td></td>
<td>192.168.191.125</td>
</tr>
<tr>
<td>iBox - Car 3</td>
<td>192.168.191.43</td>
<td></td>
<td></td>
<td>192.168.191.125</td>
</tr>
<tr>
<td>iBox - Car 4</td>
<td>192.168.191.44</td>
<td></td>
<td></td>
<td>192.168.191.125</td>
</tr>
<tr>
<td>iBox - Car 5</td>
<td>192.168.191.45</td>
<td></td>
<td></td>
<td>192.168.191.125</td>
</tr>
<tr>
<td>iBox - Car 6</td>
<td>192.168.191.46</td>
<td></td>
<td></td>
<td>192.168.191.125</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td></td>
<td></td>
<td>192.168.191.125</td>
</tr>
<tr>
<td>iBox - Car 20</td>
<td>192.168.191.60</td>
<td></td>
<td></td>
<td>192.168.191.125</td>
</tr>
</tbody>
</table>

### Group #4 - LAN Network (Blue cables)

<table>
<thead>
<tr>
<th>Device</th>
<th>IP Address</th>
<th>Subnet Mask</th>
<th>Gateway Address</th>
<th>Host Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>iBox - Car 1</td>
<td>192.168.191.61</td>
<td>255.255.255.0</td>
<td>192.168.191.25</td>
<td>192.168.191.125</td>
</tr>
<tr>
<td>iBox - Car 2</td>
<td>192.168.191.62</td>
<td></td>
<td></td>
<td>192.168.191.125</td>
</tr>
<tr>
<td>iBox - Car 3</td>
<td>192.168.191.63</td>
<td></td>
<td></td>
<td>192.168.191.125</td>
</tr>
<tr>
<td>iBox - Car 4</td>
<td>192.168.191.64</td>
<td></td>
<td></td>
<td>192.168.191.125</td>
</tr>
<tr>
<td>iBox - Car 5</td>
<td>192.168.191.65</td>
<td></td>
<td></td>
<td>192.168.191.125</td>
</tr>
<tr>
<td>iBox - Car 6</td>
<td>192.168.191.66</td>
<td></td>
<td></td>
<td>192.168.191.125</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td></td>
<td></td>
<td>192.168.191.125</td>
</tr>
<tr>
<td>iBox - Car 20</td>
<td>192.168.191.80</td>
<td></td>
<td></td>
<td>192.168.191.125</td>
</tr>
<tr>
<td>Group #5 – Floors ( ) Machine Room Floor ( )</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Group #5 - LAN Network (Blue cables)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>iBox – Car 1</td>
<td>192.168.191.81</td>
<td>255.255.255.0</td>
<td>192.168.191.254</td>
<td>192.168.191.254</td>
</tr>
<tr>
<td>iBox – Car 2</td>
<td>192.168.191.82</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
</tr>
<tr>
<td>iBox – Car 3</td>
<td>192.168.191.83</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
</tr>
<tr>
<td>iBox – Car 4</td>
<td>192.168.191.84</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
</tr>
<tr>
<td>iBox – Car 5</td>
<td>192.168.191.85</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
</tr>
<tr>
<td>iBox – Car 6</td>
<td>192.168.191.86</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
</tr>
<tr>
<td>iBox – Car 20</td>
<td>192.168.191.100</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
</tr>
<tr>
<td><strong>iView</strong></td>
<td>192.168.191.109 – 192.168.191.110</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
</tr>
<tr>
<td><strong>iCue</strong></td>
<td>192.168.191.209 – 192.168.191.210</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
<td>&quot;&quot;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Group #6 – Floors ( ) Machine Room Floor ( )</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group #6 - LAN Network (Blue cables)</strong></td>
</tr>
<tr>
<td>iBox – Car 1</td>
</tr>
<tr>
<td>iBox – Car 2</td>
</tr>
<tr>
<td>iBox – Car 3</td>
</tr>
<tr>
<td>iBox – Car 4</td>
</tr>
<tr>
<td>iBox – Car 5</td>
</tr>
<tr>
<td>iBox – Car 6</td>
</tr>
<tr>
<td>...</td>
</tr>
<tr>
<td>iBox – Car 20</td>
</tr>
<tr>
<td><strong>iView</strong></td>
</tr>
<tr>
<td><strong>iCue</strong></td>
</tr>
</tbody>
</table>
### Group #7 - LAN Network (Blue cables)

<table>
<thead>
<tr>
<th>Device</th>
<th>IP Address</th>
<th>Netmask</th>
<th>Gateway</th>
<th>Subnet</th>
</tr>
</thead>
<tbody>
<tr>
<td>iBox – Car 1</td>
<td>192.168.191.141</td>
<td>255.255.255.0</td>
<td>192.168.191.254</td>
<td>192.168.191.254</td>
</tr>
<tr>
<td>iBox – Car 2</td>
<td>192.168.191.142</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 3</td>
<td>192.168.191.143</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 4</td>
<td>192.168.191.144</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 5</td>
<td>192.168.191.145</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 6</td>
<td>192.168.191.146</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 20</td>
<td>192.168.191.160</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
</tbody>
</table>

#### iView

<table>
<thead>
<tr>
<th>IP Address</th>
<th>&quot;</th>
<th>&quot;</th>
<th>&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>192.168.191.113</td>
<td></td>
<td>192.168.191.114</td>
<td></td>
</tr>
<tr>
<td>192.168.191.115</td>
<td></td>
<td>192.168.191.116</td>
<td></td>
</tr>
</tbody>
</table>

#### iCue

<table>
<thead>
<tr>
<th>IP Address</th>
<th>&quot;</th>
<th>&quot;</th>
<th>&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>192.168.191.213</td>
<td></td>
<td>192.168.191.214</td>
<td></td>
</tr>
<tr>
<td>192.168.191.215</td>
<td></td>
<td>192.168.191.216</td>
<td></td>
</tr>
</tbody>
</table>

### Group #8 - LAN Network (Blue cables)

<table>
<thead>
<tr>
<th>Device</th>
<th>IP Address</th>
<th>Netmask</th>
<th>Gateway</th>
<th>Subnet</th>
</tr>
</thead>
<tbody>
<tr>
<td>iBox – Car 1</td>
<td>192.168.191.161</td>
<td>255.255.255.0</td>
<td>192.168.191.254</td>
<td>192.168.191.254</td>
</tr>
<tr>
<td>iBox – Car 2</td>
<td>192.168.191.162</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 3</td>
<td>192.168.191.163</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 4</td>
<td>192.168.191.164</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 5</td>
<td>192.168.191.165</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 6</td>
<td>192.168.191.166</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
<tr>
<td>iBox – Car 20</td>
<td>192.168.191.180</td>
<td>&quot;</td>
<td>&quot;</td>
<td>&quot;</td>
</tr>
</tbody>
</table>

#### iView

<table>
<thead>
<tr>
<th>IP Address</th>
<th>&quot;</th>
<th>&quot;</th>
<th>&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>192.168.191.115</td>
<td></td>
<td>192.168.191.116</td>
<td></td>
</tr>
</tbody>
</table>

#### iCue

<table>
<thead>
<tr>
<th>IP Address</th>
<th>&quot;</th>
<th>&quot;</th>
<th>&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>192.168.191.215</td>
<td></td>
<td>192.168.191.216</td>
<td></td>
</tr>
<tr>
<td></td>
<td>IP Address</td>
<td>Subnet Mask</td>
<td>Gateway Address 1</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------</td>
<td>--------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>iBox – Car 1</td>
<td>192.168.191.181</td>
<td>255.255.255.0</td>
<td>192.168.191.254</td>
</tr>
<tr>
<td>iBox – Car 2</td>
<td>192.168.191.182</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 3</td>
<td>192.168.191.183</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 4</td>
<td>192.168.191.184</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 5</td>
<td>192.168.191.185</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 6</td>
<td>192.168.191.186</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>…</td>
<td>…</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>iBox – Car 20</td>
<td>192.168.191.200</td>
<td>*</td>
<td>*</td>
</tr>
</tbody>
</table>

**iView**

<table>
<thead>
<tr>
<th></th>
<th>IP Address</th>
<th>Subnet Mask</th>
<th>Gateway Address 1</th>
<th>Gateway Address 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>iView</td>
<td>192.168.191.117</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td></td>
<td>192.168.191.118</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
</tbody>
</table>

**iCue**

<table>
<thead>
<tr>
<th></th>
<th>IP Address</th>
<th>Subnet Mask</th>
<th>Gateway Address 1</th>
<th>Gateway Address 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>iCue</td>
<td>192.168.191.217</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td></td>
<td>192.168.191.218</td>
<td>*</td>
<td>*</td>
<td>*</td>
</tr>
</tbody>
</table>
TORQMAX F5 Drive Parameters Quick Reference

This section includes quick reference information for the TORQMAX F5 drive parameters. Please refer to the F5 drive manual provided with the iControl for a detailed explanation.

**Caution**
For Permanent magnet (PM Synchronous) motors, consult the following sections of the TORQMAX F5 Drive manual before roping the machine, 5.5 *PM Synchronous Motors*, 5.8 *Encoder Feedback* and 5.11 *Running the Motor*.

Table 11.6  TORQMAX F5 Drive Parameters Quick Reference for iControl AC

**WARNING:** Do not change drive parameters while the elevator is running. Incorrect drive parameters can cause erratic elevator operation. Parameters with an asterisk (*) must be set correctly for your specific motor/machine. Refer to the drive adjustment manual for detailed information.

<table>
<thead>
<tr>
<th>Digital Operator Display</th>
<th>Parameter Description</th>
<th>Unit</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Factory Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>LF.02</td>
<td>Signal operating mode:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>AbSpd = Absolute Analog Speed</td>
<td></td>
<td></td>
<td>AbSpd</td>
<td></td>
</tr>
<tr>
<td></td>
<td>d Spd = Digital speed control</td>
<td></td>
<td></td>
<td>d Spd</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A tor = Analog torque control</td>
<td></td>
<td></td>
<td>A tor</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A Spd= Analog speed control</td>
<td></td>
<td></td>
<td>A Spd</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SErSP = Serial Com. Speed Control</td>
<td></td>
<td></td>
<td>SErSP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>bnSpd = Binary Speed Selection</td>
<td></td>
<td></td>
<td>bnSpd</td>
<td></td>
</tr>
<tr>
<td></td>
<td>S POS = Serial Position Feedback</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| LF.03                    | Drive configuration:  |      |               |                |                |
|                         | run = run mode        |      |               | run            |                |
|                         | conf = Configuration (5 minute time limit) | |       | confF          | run            |
|                         | Stop = Drive Stopped, Motor cannot run. | |       | Stop           |                |
|                         | S Lrn = activate auto tune | |       | S Lrn          |                |
|                         | I Lrn = Inertia Learn. Learns system inertia. | |       | I Lrn          |                |
|                         | P Lrn = Pole Learn. PM motor pole positions. | |       | P Lrn          |                |
|                         | SPI = Learns absolute encoder position for PM | |       | SPI            |                |
|                         | motor without sheave movement. **** | |       | OStST          |                |
|                         | OStST = Allows car to over speed for one run without changing drive parameters (see also LF.49). **** | |       |                |                |

| LF.04                    | Motor selection: Displays mode selected using US.4 and US.10 | Read only. See US.10 | -             | ***            |
| LF.05                    | Drive fault auto reset | 1 | 0-10 | 5 | 5 |
| LF.08                    | Electronic motor overload protection | - | on/off | off | on |
| LF.09                    | Electronic overload current: PM- Not visible, auto set same as LF.12. | A | 1.0 - 110% Rtd | 8.0 | *_________ |
| LF.10                    | Rated motor power PM- Read only, auto calc. | HP | 0.00 - 125.00 | 5.0 | IM*_________ |
| LF.11                    | Rated motor speed | rpm | 10.0-6000 | 1165 or 150 | *_________ |
| LF.12                    | Rated motor current | A | 1.0 - 110% Drive rated | 8.0 | *_________ |
| LF.13                    | Rated motor frequency | Hz | 4.0 - 100.0 | 60.0 | *_________ |
| LF.14                    | Rated motor voltage IM - Name plate rated voltage (120 - 500V) | V | - | 230/460 | *_________ |
|                         | PM - No-load, phase-to-phase back EMF rms voltage LF.11 (1 - 32000V/krpm) | | | | |
## Table 11.6  TORQMAX F5 Drive Parameters Quick Reference for iControl AC

| LF.15 | IM: Power factor, PM: not visible | 1 | 0.50 - 1.00 | 0.90 | 0.90 |
| LF.16 | IM: Field weakening speed  
PM - not visible | rpm | 0.0-6000.0 | set @ 80% of LF.11 | * |

### Digital Operator Display

<table>
<thead>
<tr>
<th>Parameter Description</th>
<th>Unit</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Factory Setting</th>
</tr>
</thead>
</table>
| LF.17  
Rated motor torque, IM- Read only, auto calc.  
PM- enter motor name plate torque | lb ft | 1 - 10000 | IM - calc  
PM - 18 | IM ***  
PM*______ |
| LF.18  
PM: Motor stator resistance - from data sheet or perform learn procedure (see F5 Drive manual)  
IM: not visible | ohms | 0.0-50.0 | 49.999 | PM*______ |
| LF.19  
PM: Motor leakage inductance - from data sheet or perform learn procedure (see F5 Drive manual)  
IM: not visible | mH | 0.1 - 500.0 | 1.00 | PM*______ |
| LF.20 | Contract Speed | fpm | 0 - 1600 | 0 | *______ |
| LF.21 | Traction sheave diameter (measured value) | inch | 7.0 - 80.0 | 24.00 | *______ |
| LF.22 | Gear reduction ratio | 1 | 1.00-99.99 | 30.00 | *______ |
| LF.23 | Roping ratio | 1 | 1 - 8 | 1 | *______ |
| LF.24 | Load weight | lbs | 0 - 30000 | 0 | *______ |
| LF.25 | Estimated gear ratio (Read only, auto calc.) | .01 | 1.00 - 99.99 | calculated | *** |
| 0.LF.26 | Encoder Interface: Displays feedback type | - | - | - | *** |
| LF.27 | Encoder pulse number | ppr | 256 - 16835 | 1024 |  
For IncIE and SinCo see customer data  
For HIPER set to 1024  
For EndAt set to 2048 |
| LF.28 | Encoder channel swap / direction | 1 | 0 - 3 | 0 | *______  
nothing reversed  
1 encoder A<->B swapped  
2 motor rotation reversed  
3 motor rotation reversed and A<->B swapped |
| LF.29 | Encoder sample time  
(recommend gearless = 4, geared = 8) | mSec | 0.5 - 32 | 4 | 4 or 8 |
| LF.30 | Control mode:  
0, 1 = Open loop induction motor operation  
2 = Closed loop speed control (LF. 2 = A Spd)  
3 = Closed loop speed fcontrol with pre-torque  
4 = Closed loop torque control (LF. 2 = A tor)  
5 = Closed loop speed control with synthesized pre-torque | 1 | 0 - 4 | 0 | *______ |
| A.LF.31 | Kp speed accell: Proportional gain, accel & run | 1 | 1 - 50396 | 3000 | ** 3000 |
| d.LF.31 | Kp speed decell: Proportional gain, decel | 1 | 1 - 50396 | 3000 | ** 3000 |
| P.LF.31 | KP speed torque (Synth. Pretorque) | 1 | 1 - 50396 | 2000 | 2000 |
| A.LF.32 | Ki speed accell: Integral gain, accel & run | 1 | 1 - 26214 | 350 | ** 350 |
| d.LF.32 | Ki speed decell: Integral gain, decel | 1 | 1 - 26214 | 250 | ** 250 |
| P.LF.32 | Ki speed torque (Synth. Pretorque) | 1 | 1 - 26214 | 10000 | 10000 |
| A.LF.33 | Ki speed offset accell: Gain at low speed, accel | 1 | 0 - 8000 | 3000 | ** 3000 |
| d.LF.33 | Ki speed offset decell: Gain at low speed, decel | 1 | 0 - 8000 | 10000 | ** 1000 |
| 0.LF.36 | Maximum torque (auto calculated by the drive) | lb.ft. | 0-500% Trtd | calculated | *** |
| 1.LF.36 | Maximum torque emergency operation (= LF.17) | lb.ft. | 0-500% Trtd | calculated | *** |
### Digital Operator Display

<table>
<thead>
<tr>
<th>Parameter Description</th>
<th>Unit</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Factory Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>LF.41 Leveling speed (Not used, must be set to 0)</td>
<td>fpm</td>
<td>0 - 25</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>LF.42 High speed</td>
<td>fpm</td>
<td>0 - LF.20</td>
<td>0.0</td>
<td>*</td>
</tr>
<tr>
<td>LF.43 Inspection speed (Not used, must be set to 0)</td>
<td>fpm</td>
<td>0 - 150.00</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>LF.44 High leveling speed (Not used, must be set to 0)</td>
<td>fpm</td>
<td>-</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>LF.45 Earthquake speed (Not used, must be set to 0)</td>
<td>fpm</td>
<td>-</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>LF.46 Emerg. power Speed (Not used, must be set to 0)</td>
<td>fpm</td>
<td>-</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>LF.47 Intermediate speed (Not used, must be set to 0)</td>
<td>fpm</td>
<td>-</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>LF.49 Over Speed Function Test: speed setting for Over Speed Test Function (see LF.3 - OStST).</td>
<td>fpm</td>
<td>1 - 2400</td>
<td>100</td>
<td>100</td>
</tr>
</tbody>
</table>

**Note:** Parameters LF.50 through LF.56 default to off when LF.2 is set to AbSpd, A Spd or A Tor.

### Table 11.6  TORQMAX F5 Drive Parameters Quick Reference for iControl AC

<table>
<thead>
<tr>
<th>Parameter Description</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Factory Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.LF.50 Profile 0 - Starting jerk (Not used)</td>
<td>ft/s³</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>0.LF.51 Profile 0 - Acceleration (Not used)</td>
<td>ft/s²</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>0.LF.52 Profile 0 - Deceleration jerk (Not used)</td>
<td>ft/s³</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>0.LF.53 Profile 0 - Deceleration jerk (Not used)</td>
<td>ft/s²</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>0.LF.54 Profile 0 - Approach jerk (Not used)</td>
<td>ft/s³</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>1.LF.50 Profile 1 - Starting jerk (Not used)</td>
<td>ft/s³</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>1.LF.51 Profile 1 - Acceleration (Not used)</td>
<td>ft/s²</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>1.LF.52 Profile 1 - Deceleration jerk (Not used)</td>
<td>ft/s³</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>1.LF.53 Profile 1 - Deceleration jerk (Not used)</td>
<td>ft/s²</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>1.LF.54 Profile 1 - Deceleration jerk (Not used)</td>
<td>ft/s³</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>1.LF.55 Profile 1 - Approach jerk (Not used)</td>
<td>ft/s³</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>2.LF.50 Profile 2 - Starting jerk (Not used)</td>
<td>ft/s³</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>2.LF.51 Profile 2 - Acceleration (Not used)</td>
<td>ft/s²</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>2.LF.52 Profile 2 - Deceleration jerk (Not used)</td>
<td>ft/s³</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>2.LF.53 Profile 2 - Deceleration jerk (Not used)</td>
<td>ft/s²</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>2.LF.54 Profile 2 - Deceleration jerk (Not used)</td>
<td>ft/s³</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>2.LF.55 Profile 2 - Approach jerk (Not used)</td>
<td>ft/s³</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>2.LF.56 Stop jerk (Not used)</td>
<td>ft/s³</td>
<td>see note</td>
<td>see note</td>
</tr>
<tr>
<td>LF.57 Speed following error (0 = off, 1 = on)</td>
<td>-</td>
<td>off, on</td>
<td>on</td>
</tr>
<tr>
<td>LF.58 Speed difference</td>
<td>%</td>
<td>0 - 30</td>
<td>10</td>
</tr>
<tr>
<td>LF.59 Trigger time speed difference: Following error timer</td>
<td>sec</td>
<td>0.0 - 1.0</td>
<td>1.0</td>
</tr>
<tr>
<td>LF.61 Emergency operation mode</td>
<td>-</td>
<td>off</td>
<td>off</td>
</tr>
<tr>
<td>LF.67 Pretorque gain</td>
<td>-</td>
<td>0.25 - 2.00</td>
<td>1.00</td>
</tr>
<tr>
<td>LF.68 Pretorque offset</td>
<td>%</td>
<td>-100 - 100</td>
<td>0.00</td>
</tr>
<tr>
<td>LF.69 Pretorque direction (-1 = -V, 1 = +V)</td>
<td>1</td>
<td>-1, 1</td>
<td>1</td>
</tr>
<tr>
<td>LF.70 Speed pick delay (Delay to turn on DRO).</td>
<td>sec</td>
<td>0.00 - 3.00</td>
<td>0.30</td>
</tr>
<tr>
<td>LF.71 Brake pick delay</td>
<td>sec</td>
<td>0.0 - 3.0</td>
<td>0.05</td>
</tr>
<tr>
<td>LF.76 Encoder resolution multiplier</td>
<td>2 for incremental encoder 8 for Sin/Cos, EnDat or Hiperface encoder</td>
<td>1</td>
<td>0 - 13</td>
</tr>
<tr>
<td>LF.77 Absolute encoder position (measured)</td>
<td>1</td>
<td>0 - 65535h</td>
<td>0</td>
</tr>
</tbody>
</table>
### Table 11.6  TORQMAX F5 Drive Parameters Quick Reference for iControl AC

<table>
<thead>
<tr>
<th>LF.78</th>
<th>Brake drop delay: Time motor will hold full current and control after direction inputs drop.</th>
<th>sec</th>
<th>0.0-3.00</th>
<th>0.50</th>
<th>0.50</th>
</tr>
</thead>
<tbody>
<tr>
<td>LF.79</td>
<td>Current hold time: Delay in turning off the drive (Delay to turn OFF the motor current after the direction is dropped and LF.78 has expired)</td>
<td>sec</td>
<td>0.300 - 3.000</td>
<td>0.300</td>
<td>0.30 - 0.80</td>
</tr>
</tbody>
</table>

#### Diagnostic Parameters (Read only)

<table>
<thead>
<tr>
<th>LF.25</th>
<th>Estimated gear ratio</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>LF.80</td>
<td>Software version</td>
<td></td>
</tr>
<tr>
<td>LF.81</td>
<td>Software date MMDD.Y</td>
<td></td>
</tr>
<tr>
<td>LF.82</td>
<td>X2A-input state see tables in F5 Drive Manual</td>
<td></td>
</tr>
<tr>
<td>LF.83</td>
<td>X2A-output state</td>
<td></td>
</tr>
<tr>
<td>LF.86</td>
<td>Operational mode</td>
<td></td>
</tr>
<tr>
<td>LF.87</td>
<td>Actual inverter load (100% = rated load) %</td>
<td></td>
</tr>
<tr>
<td>LF.88</td>
<td>Motor command speed rpm</td>
<td></td>
</tr>
<tr>
<td>LF.89</td>
<td>Actual motor speed rpm</td>
<td></td>
</tr>
<tr>
<td>LF.90</td>
<td>Actual elevator speed ft/m</td>
<td></td>
</tr>
<tr>
<td>LF.93</td>
<td>Phase current A</td>
<td></td>
</tr>
<tr>
<td>LF.94</td>
<td>Peak phase current A</td>
<td></td>
</tr>
<tr>
<td>LF.95</td>
<td>Actual DC voltage V</td>
<td></td>
</tr>
<tr>
<td>LF.96</td>
<td>Peak DC Voltage V</td>
<td></td>
</tr>
<tr>
<td>LF.97</td>
<td>Actual output frequency Hz</td>
<td></td>
</tr>
<tr>
<td>O.LF.98</td>
<td>Last error</td>
<td></td>
</tr>
</tbody>
</table>

#### US - Parameters

| US. 1  | Password: With different passwords, different parameter groups can be accessed for advanced programming. | - | 0-9999 | - | - |
| US. 3  | Load defaults. Select LoAd and press ENTER to cause all LF parameters to be reset to drive default values. | - | LoAd | - | - |
| US. 4  | Load configuration. Select LoAd and press ENTER to load the configuration selected in US.10. | - | LoAd | - | - |
| US.10  | Select Configuration. User selection of drive mode. | - | I CLSd = Induction motor (closed loop) I 9LSS = Induction motor (closed loop) gearless P CLSd = Synchronous motor (closed loop) P 9LSS = Synchronous motor (closed loop)gearless |

**Loaded using parameter US.04.**

* Parameters are motor/machine/job dependent.
** Recommended but field adjustable.
*** The value is automatically calculated from the motor data or other parameter values.
****Parameters apply to Drive Software Version 1.71 or greater)

Parameters for Drive Software Version (LF.80 = 1.61 or greater), Software date (LF.81 = 2801.9 or later)

<table>
<thead>
<tr>
<th>Job #:</th>
<th>Drive Serial #:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prod. Order #:</td>
<td>Test technician:</td>
</tr>
<tr>
<td>Drive Model #:</td>
<td>Date:</td>
</tr>
</tbody>
</table>
PowerBack R6 Regenerative Drive Quick Reference

This section includes quick reference information for the PowerBack R6 Regenerative AC drive. Please refer to the R6 Regenerative drive manual provided with the iControl for detailed explanation of the parameters.

### Table 11.7 Quick Reference for PowerBack R6 Regenerative Drive

**WARNING:** Do not change drive parameters while the elevator is running. Incorrect values of drive parameters can cause erratic elevator operation.

<table>
<thead>
<tr>
<th>Display</th>
<th>Parameter Description</th>
<th>Setting Range</th>
<th>Resolution</th>
<th>Field/MCE Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>CP. 0</td>
<td>Password input</td>
<td>0...9999</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CP. 1</td>
<td>Status display</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>CP. 2</td>
<td>Main Line Frequency</td>
<td>---</td>
<td>0.1 Hz</td>
<td></td>
</tr>
<tr>
<td>CP. 3</td>
<td>AC-Phase current L1</td>
<td>---</td>
<td>0.1 A</td>
<td></td>
</tr>
<tr>
<td>CP. 4</td>
<td>AC-Phase current L2</td>
<td>---</td>
<td>0.1 A</td>
<td></td>
</tr>
<tr>
<td>CP. 5</td>
<td>AC-Phase current L3</td>
<td>---</td>
<td>0.1 A</td>
<td></td>
</tr>
<tr>
<td>CP. 6</td>
<td>Actual Load</td>
<td>---</td>
<td>1%</td>
<td></td>
</tr>
<tr>
<td>CP. 7</td>
<td>Actual Load / peak value</td>
<td>---</td>
<td>1%</td>
<td></td>
</tr>
<tr>
<td>CP. 8</td>
<td>DC output current</td>
<td>---</td>
<td>0.1 A</td>
<td></td>
</tr>
<tr>
<td>CP. 9</td>
<td>Actual DC voltage</td>
<td>---</td>
<td>1 V</td>
<td></td>
</tr>
<tr>
<td>CP.10</td>
<td>DC voltage / peak value</td>
<td>---</td>
<td>1 V</td>
<td></td>
</tr>
<tr>
<td>CP.11</td>
<td>Heat sink temperature</td>
<td>---</td>
<td>1°C</td>
<td></td>
</tr>
<tr>
<td>CP.12</td>
<td>Over load counter</td>
<td>---</td>
<td>1%</td>
<td></td>
</tr>
<tr>
<td>CP.13</td>
<td>Active power</td>
<td>---</td>
<td>0.1 kW</td>
<td></td>
</tr>
<tr>
<td>CP.14</td>
<td>Total regen kWhr counter</td>
<td>---</td>
<td>0.1 kWh</td>
<td></td>
</tr>
<tr>
<td>CP.15</td>
<td>Total motor kWhr counter</td>
<td>---</td>
<td>0.1 kWh</td>
<td></td>
</tr>
<tr>
<td>CP.16</td>
<td>Total net kWhr counter</td>
<td>---</td>
<td>0.1 kWh</td>
<td></td>
</tr>
<tr>
<td>CP.17</td>
<td>Apparent power / Line input</td>
<td>---</td>
<td>0.1 kVA</td>
<td></td>
</tr>
<tr>
<td>CP.18</td>
<td>Analog output 1 / amplification factor</td>
<td>-20.00...20.00</td>
<td>0.01</td>
<td>1.00</td>
</tr>
<tr>
<td>CP.19</td>
<td>DC bus switching level</td>
<td>+/- 30000.00</td>
<td>0.01</td>
<td></td>
</tr>
<tr>
<td>CP.20</td>
<td>Auto error reset counter</td>
<td>0...10</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>CP.21</td>
<td>Last Error</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>CP.22</td>
<td>Last Error 1</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>CP.23</td>
<td>Last Error 2</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>CP.24</td>
<td>Last Error 3</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>CP.25</td>
<td>Last Error 4</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>CP.26</td>
<td>Last Error 5</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>CP.27</td>
<td>Last Error 6</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>CP.28</td>
<td>Last Error 7</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>CP.29</td>
<td>Software version</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>CP.30</td>
<td>Software date code</td>
<td>DDMM.Y</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>CP.31</td>
<td>Power part ID code</td>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>CP.32*</td>
<td>Pulse off Level</td>
<td>-100kW...0.0kW</td>
<td>0.1kW</td>
<td>-0.8kW</td>
</tr>
<tr>
<td>CP.33*</td>
<td>Operating Mode</td>
<td>0...3</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>CP.34*</td>
<td>Control Angle</td>
<td>0.0...60.0</td>
<td>0.1</td>
<td>29.0</td>
</tr>
</tbody>
</table>

*NEW PARAMETERS in software version 1.3

Job #: Drive Serial #:
Production Order #: Test Technician:
Drive Model #: Date:
Index

Numerics
1 = LAN port 2-5
1 bus, Common bus connections 11-13, 11-14
110 VDC Bus Connections, iBox 11-13
120 VAC Bus Connections, iBox 11-13
15A, Final Limit switch connection 11-14
15B, Pit/Final Limit switch connection 11-14
2 = System port 2-5
2 bus, 120 VAC connections 11-13, 11-14
2 PI bus, 120 VAC connections 11-13
3 = PC port 2-5
3 = PC port connections 2-35
3 bus, 110 VDC connections 11-13, 11-14
3 HA bus, 110 VDC connections 11-13

A
A-, Velocity Encoder input 6-103, 11-7
A+, Velocity Encoder input 6-103, 11-7
ABD, Hoistway Access Bottom Down switch input 6-105, 11-10
ABU, Hoistway Access Bottom Up switch input 6-105, 11-10
AC Drive
car does not reach high speed 4-11
description 1-10
Parameters 4-8, 4-14, 4-28
parameters 2-47
TORQMAX Parameters Quick Reference 11-27
AC supply 5-7
Acceleration (Command) test point, description 11-3
Acceleration (Directional) test point, description 11-3
Acceleration (Filtered) test point, description 11-3
Acceleration (Interpolated) test point, description 11-3
Acceleration (Raw) test point, description 11-3
Acceleration (Slew) test point, description 11-3
Acceleration parameter 4-12, 9-134
Acceleration specification 11-2
accessing online help 8-24
Acquired floor marker heights mismatch configuration 9-147
Acquired floor markers fewer than configuration 9-147
Acquired floor markers more than configuration 9-147
Acquiring floor markers 9-147
acquiring write privilege 1-13, 2-30
Active configuration serial outputs 10-56
Active configurations, setting 9-100
Active Mode - Balanced output 9-125
Active Mode - Demand Down Peak output 9-125
Active Mode - Demand Up Peak output 9-125
Actual direction 9-9
Actual Position 9-9
Actual speed, calibrating 2-55
ADA Car Call Dwell Time 9-42
ADA Hall Call Dwell Time 9-42
ADC, verifying ADC conversion 2-48
Add a timer 9-138, 10-63
Adding a circuit board 6-72
Adjusting
AC Drive parameters 2-47
Brake Calibration 2-51
Brake coordination 4-28
Brake drop delay 4-26
Brake parameters 4-20
Brake picking 2-53, 4-19
Brake release 4-26
Brake Resistance 2-22
Car speed 2-55
Counterweight Balance 3-29
Dead zone 4-27
Emergency slowdown 4-53
Final Approach 4-15, 4-26
Following error 2-58
Leveling speed 4-27
Load thresholds 4-31
Load Weigher 4-30, 4-32
Motor Current Limiting 4-14
overshoot 4-14
Overspeed Margins 4-55
Pattern parameters 4-14
Pretorque 4-16
Releveling 4-29
Ride quality 4-30
Speed 4-11
Speed pick delay 4-7
System 12 Drive 2-48
Tachometer Error tripping threshold 2-59, 4-41
Alarm Button input 9-107
Alarm Buzzer 9-35
Alarm Buzzer output 9-116
Alarm Light 9-35
Alarm Light output 9-116
Alarm Reset input 9-107
Allow hall call to reverse doors on departing car 10-11
ALT SPEED PROFILE 1 message 6-13
ALT SPEED PROFILE 2 message 6-13
Alternate 1 profile 4-14, 9-130
Alternate 2 profile 4-14, 9-130
Alternate Dispatcher selection 10-8
Alternate Fire Switch ON input 9-107
Alternate Floor Smoke input 9-107
ALTERNATE FLOOR SMOKE message 6-13
Alternate Floor Smoke Sensor Recall message 6-13
Alternate Recall floor, Fire service 9-45
Alternate Speed Profile 1 Activated message 6-13
Alternate Speed Profile 1 Deactivated message 6-13
Alternate Speed Profile 1 input 9-107
Alternate Speed Profile 2 message 6-13
Alternate Speed Profile 2 Activated message 6-13
Alternate Speed Profile 2 Deactivated message 6-13
Alternate Speed Profile 2 input 9-107
Alternate Speed Profile 2 message 6-13
Anti-nuisance 9-39
Cancel car calls behind car 9-39
Light load 9-39
Photo Eye 9-39
Anti-nuisance controls 4-31
Approach deceleration parameter 4-13, 9-134
Approach jerk parameter 4-13, 9-134
Armature Active Status test point, description 11-3
Armature Command (Control) test point, description 11-3
Armature Command (Damped) test point, description 11-3
Armature Command (Raw) test point, description 11-3
Armature Composite Control test point, description 11-3
Armature Control Set test point, description 11-3
Armature Current 9-9
Armature Current Dampen Feedback test point, 11-3
Armature Current Signal test point, description 11-3
Armature Current Synthetic Feedback test point, 11-3
Armature Differential Command test point, description 11-3
Armature Differential Gain test point, description 11-3
Armature Error (Damped) test point, description 11-4
Armature Error (Raw) test point, description 11-4
Armature Feedforward (Control) test point, description 11-4
Armature Feedforward (Raw) test point, description 11-4
Armature Integral Command test point, description 11-4
Armature Integral Gain test point, description 11-4
Armature On Status test point, description 11-4
Armature Proportional Command test point, description 11-4
Armature Proportional Gain test point, description 11-4
Armature Voltage 9-9
Armature Voltage Dampen Feedback test point, 11-4
Armature Voltage Signal test point, description 11-4
Armature Voltage Synthetic Feedback test point, 11-4
Arrival Fixtures, parameters 9-34
Ascending Car Overspeed Fault message 6-13
ASCND CAR OVR SPD FLT message 6-13
ATD, Hoistway Access Top Down switch input 6-105, 11-10
Attendant Buzzer output 9-116
Attendant HC Above output 9-116
Attendant HC Below output 9-116
Attendant Service Down input 9-107
Attendant Service Indicator output 9-116
Attendant Service input 9-107
Attendant Service message 6-13
Attendant Service mode 9-5
Attendant Service Non-Stop input 9-107
Attendant Service parameters 9-79
Attendant Service Up input 9-107
Attendant SVC message 6-13
ATU, Hoistway Access Top Up switch input 6-105, 11-10
Auto Stop parameters 9-80
Automatic 10-71
Automatic mode, selecting 10-15
Automatic Stop Input 9-107
Automatic Stop message 6-13
Automatic Swing Operation 9-40
Auto-tuning for induction motors, TORQMAX drive 2-56
Available for fire service output 9-116
Average wait times 10-74
B
B-, Velocity Encoder input 6-103, 11-7
B+, Velocity Encoder input 6-103, 11-7
B1, B2, DC power to motor brake 11-14
Backup Dispatcher, description of 10-4
Backup power direction reversal message 6-13
Backup power recall done output 9-116
Backup power recall input 9-107
BACKUP POWER RECALL message 6-14
Backup power recall OFF message 6-14
Backup power recall ON message 6-14
Backup power recall reverse direction input 9-107
Backup power unit failure activated message 6-14
Backup power unit failure deactivated message 6-14
Backup power unit failure input 9-107
Backup power unit failure message 6-14
Balanced 10-71
Balanced Mode message 6-14
Balanced mode, selecting 10-15
Balancing the Counterweight 3-29
BATTERY VLTG LOW-IMP message 6-14
Battery Voltage Low-IMP message 6-14
BD, Brake Drive relay indicator 11-12
BDRD, Brake Drive Redundancy indicator 11-12
Blocking New Remote Connections message 6-14
BLOCKING REMOTE UIS message 6-14
Blue cables 5-12, 5-13
Brake
adjust to control rollback 2-50
auto calibration procedure 2-51
Brake monitoring 3-20
calibration 2-50–2-53, 9-142
calibration procedure 2-50
configuration 9-24–9-27
Current Reference 9-27
current, on Operational Status tab 9-10
Filters 9-25
iBox connections 11-12
Output connections 9-27
Resistance 2-22

Index-2 Manual # 42-02-2222
setup 9-142
Timers 9-26
verify picking 2-53
Voltage 6-16
voltage, on Operational Status tab 9-10
voltages 9-25, 9-27
wiring 2-23
BRAKE CNT DRV PRF FLT message 6-14
BRAKE CONT PRF FAULT message 6-14
Brake Contactor Driver Proofing Fault message 6-14
Brake Contactor Proofing Fault message 6-14
Brake Contactor Status test point, description 11-4
Brake coordination, adjusting for smooth stops 4-28
Brake Current Feedback test point, description 11-4
Brake current low pass frequency parameter 9-25
Brake Current Resistance 2-22
Brake Current Signal test point, description 11-4
Brake Drop Delay 9-26
adjusting 3-31
BRAKE PICK FAULT message 6-16
Brake Pick Fault message 6-16
Brake Pick Fault Off message 6-16
Brake release time, adjusting for final stop 4-26
Brake Switch input 3-20, 9-113
Brake Triac active indicator 11-12
BRAKE V NOT ON FAULT message 6-16
Brake Voltage Feedback test point, description 11-4
Brake voltage low pass frequency parameter 9-25
Brake Voltage Not On Fault message 6-16
BRD, Brake Redundancy indicator 11-12
Bus 2 Fuse Open message 6-16
Bus 2D Fuse Open message 6-16
Bus 2MC Fuse Open message 6-16
Bus 2PI Fuse Open message 6-16
Bus 3 Fuse Open message 6-16
Bus 3HA Fuse Open message 6-17
Bus Enabled 5-26
Bus Status 5-26
Bus Voltage 5-26
Bypass Jumper, using for troubleshooting 6-3
Bypass status, Fault bypass 9-18
Bypass Timers
  Photo Eye 9-31
  Safe Edge 9-30
Car identifier parameter 4-57, 9-96
Car In Service output 9-117
Car label parameter 9-96, 10-7
Car Not Empty Sensor Input 9-108
Car Operating Panel Connections 3-18
Car Operation
  Attendant Service 9-79
  Auto Stop 9-80
  CFSS 9-74
  Configuration parameters 9-29–9-86
  Devices 9-34
diagnostic flags 9-12
  Doors 9-30
  Earthquake 9-65
  Elevator recall 9-62
  Emergency Medical Service 9-67
  Emergency power 9-71
  Fire Service 9-45
  Flood Operation 9-77
  Independent service 9-60
  Passenger 9-38
  Sabbath operation 9-82
  Shuttle service 9-85
CAR OS DOORS CLOSED message 6-18
CAR OS DOORS CLOSING message 6-18
CAR OS DOORS OPEN message 6-19
CAR OS DOORS OPENING message 6-19
CAR OS DOORS STALLED message 6-19
CAR OS DOORS UNKNOWN message 6-19
Car Out Of Service output 9-117
Car out of service timer 9-39
Car out of service unknown door position message 6-19
Car out of service with doors closed message 6-18
Car out of service with doors opening message 6-19
Car out of service with doors open message 6-19
Car Over Load Activated message 6-19
Car Over Load Deactivated message 6-19
CAR OVERLOAD message 6-19
Car Panel (Hoistway) Access Enable switch input 6-104, 11-8
Car Panel Emergency Stop switch input 6-104, 11-8
Car Panel Insp message 6-20
Car Panel Inspection Disabled message 6-19
Car Panel Inspection Enabled message 6-20
Car Panel Inspection Inputs OK message 6-20
Car Panel Inspection mode 9-5
Car Panel Inspection Operation message 6-20
Car Position
  Actual 9-9
  Logical 9-9
Car Reaction 4-56
Car shut down due to emergency power operation with no supervisor (Activated) message 6-20
Car shut down due to emergency power operation with no supervisor (Deactivated) message 6-20
Car Speed 9-8
Car Speed specification 11-2
Car status messages window 9-10
CAR STOP SWITCH OPEN message 6-20
Car Stop Switch Open message 6-20
Car Top, iBox status LED 7-11
Car/Counterweight Buffer Test 4-46
Car/Counterweight Safety Test 4-45
card reader, call enable device 9-113, 9-114, 10-39, 10-56
Cars, number of parameter 10-7
CAR AUTO UIM FLT message 6-20
Cartop Automatic Unintended Motion Fault message 6-20
CAR AUTO COMM FAULT message 6-21
Cartop Communication Fault message 6-20, 6-21
Cartop Emergency Stop message 6-21
Cartop Emergency Stop switch 3-17
Cartop Exit no Counterweight Configuration Error 6-21
CAR OPEN EXIT message 6-21
Cartop Exit Open message 6-21
Cartop Exit Open Off message 6-21
Cartop Firmware Update Mode message 6-21
CAR FW UPDATE MODE message 6-21
Cartop Insp message 6-22
CAR AUTO INS UIM FLT message 6-22
Cartop Inspection Disabled message 6-21
Cartop inspection DOWN button 3-17
Cartop Inspection Enabled message 6-22
Cartop Inspection Inputs OK message 6-22
Cartop Inspection Output message 6-22
Cartop Inspection mode 9-5
Cartop Inspection Operation message 6-22
Cartop Inspection output 9-117
Cartop Inspection Switches 3-17
Cartop Inspection Unintended Motion Fault message 6-22
Cartop inspection UP button 3-17
Cartop Inspection Wiring 2-29
Cartop interconnections 1-16
Cartop Link Connections, iBox 6-104, 11-8
Cartop Position 9-9
Cartop Power Loss message 6-22
Cartop Processor Board Quick Reference 6-78
Cartop Safety Relay 2-27
Cartop Safety Relay Bypass 2-27, 2-28
Cartop Safety Switches 2-27
CC Eligibility Config x input 9-108
CC Eligibility Config x output 9-117
Central dispatcher, description of 10-4
CFSS 1 at floor message 6-22
CFSS 1 In-car message 6-22
CFSS 1 recall message 6-22
CFSS 2 at floor message 6-22
CFSS 2 In-car message 6-22
CFSS 2 Recall message 6-22
CFSS 2 open door message 6-22
CFSS 2 switch output 6-22
CFSS 2 switch output 6-22
CFSS call enable 1 (2), CFSS mode 1 (2) serial inputs 10-57
CFSS call serial inputs 10-53
CFSS Calls - CFSS 1 (2) outputs 9-125
CFSS Car Buzzer 1 (2) outputs 9-117
CFSS Car Light 1 (2) outputs 9-117
CFSS In Car Switch 1 input 9-108
CFSS In Car Switch 2 input 9-108
CFSS In Use 1 (2) outputs 9-124
CFSS Mode 1 (2) at Floor mode 9-5
CFSS Mode 1 (2) In-car mode 9-5
CFSS Mode 1 (2) In-Use outputs 9-117
CFSS Mode 1 (2) Recall mode 9-5
CFSS Mode 1 (2) System outputs 9-117
CFSS Mode 1 at Floor Activated message 6-22
CFSS Mode 1 In-car Activated message 6-22
CFSS Mode 1 Recall Activated message 6-22
CFSS Mode 2 at Floor Activated message 6-22
CFSS Mode 2 In-car Activated message 6-22
CFSS Mode 2 Recall Activated message 6-22
CFSS operation 10-9
CFSS Recall 9-75
   In-car audible indicator 9-75
   In-car visual indicator 9-75
CFSS serial outputs 10-53
CFSS System 1 (2) outputs 9-124
CFSS tab 10-9
Changing parameters 2-30
Check for shorts to ground 2-16
Checking AC phase 5-7
Checking the Hoist Motor 2-21
Circuit board removing & replacing 6-72
Circuit boards, troubleshooting 6-75–6-112
CNPB Fault, see Brake Contactor Proofing Fault message 6-14
CNPBD Fault, see Brake Contactor Driver Proofing Fault message 6-14
CNPM Fault, see Motor Contactor Proofing Fault 6-54
CNPMB Fault, see Mtr Contactor Driver Proofing Fault 6-54
Cnstr Car Panel Insp message 6-22
Cnstr Cartop Insp message 6-23
Cnstr CP Insp message 6-22
Cnstr CT Insp message 6-23
Cnstr HA Insp message 6-23
Cnstr HA Inspection message 6-23
Cnstr Inspection message 6-23
Cnstr Mach Room Insp message 6-23
Cnstr MR Insp message 6-23
Coincidence call bonus 10-11
Commanded direction 9-9
Commandeer For Special Service params 9-74–9-76, 10-9
Commercial Power output 9-117
Common Bus Connections, iBox 11-13
Computer IP address, setting 2-35–2-38, 8-6
Computer Reset, iBox control 7-4
Computer, iBox status LED 7-11
Configuration 9-24–9-139
   Brake 9-24
   Car Call Enable 9-28
   Car Operation 9-29
   Drive 9-88
   Floor heights 9-95
   General tab 9-96
   I/O Boards 9-101
   Loadweigher tab 9-128
   Pattern 9-130
   Serial I/O 10-51
   Terminal switches 9-136
Configuration File 6-73
Configuration file
   creating 8-20
   editing 8-23
loading 8-22
saving 8-20
Configuration File - Generate Default 8-21
Configured floor markers more than maximum allowed 9-147
Connected 5-26
Connection Status 5-26
Connections 2-35–2-41
   Direct 2-35
Construction Car Panel Inspection mode 9-5
Construction Car Panel Inspection Operation message 6-22
Construction Cartop Inspection mode 9-5
Construction Cartop Inspection Operation message 6-23
Construction Hoistway Access Inspection mode 9-6
Construction Hoistway Access Inspection Operation 6-23
Construction Inspection mode 9-6
Construction Inspection Operation message 6-23
Construction Machine Room Inspection mode 9-6
Construction Machine Room Inspection Operation 6-23
Construction Mode 2-1–2-61, 3-1–3-25
   exiting 3-25
   Faults 2-3
   Overview 2-2
   Required connections 2-3
   Contactor drop delay 9-26
Contract Overspeed Test 4-47
Contract overspeed, Safety parameter 9-151
Contract speed, Safety parameter 9-151
Controller Main Computer Startup message 6-23
Controller Specifications 11-2
Controller Stop switch, iBox control 7-12
Controller View 9-1
Controller view 9-2
COP, iLink serial connection 3-15
Correction profile 4-14, 9-130
Counterweight balancing 9-143
Counterweight balancing, preparing for final adjust 3-29
Counterweight derailment detector 3-21
Counterweight Derailment output 9-117
counterweight learn operation 9-143
Counterweight Learn procedure 3-28
Counterweight position parameter 9-143
Coupling rotational ratio 2-45
CP INSP. DISABLED message 6-19
Creating a Configuration file 8-20
   creating a direct connection 2-39
   Creating a new LAN connection 8-13
Cross Registration 10-55
Cross registration serial inputs 10-55
Cross registration serial outputs 10-55
Crosshead Deflection Load Weigher 4-30
Cross-registration 10-36
CT INSP. DISABLED message 6-21
CTEX NO CWI CFG ERROR message 6-21
Current Limiting 4-14
Custom Outputs 9-126
Custom outputs, configuring 9-141
DAC Offset Status test point, description 11-4
DAC, verifying DAC conversion 2-48
Data trap 9-11
Data Trap Triggering Event 9-11
DCAB, Door Contact Access Bottom input 6-106, 11-11
DCAT, Door Contact Access Top input 6-106, 11-11
DCL, Door Close Limit input 6-104, 11-8
DCMS, Door Contact Main String input 6-106, 11-11
Dead zone distance parameter 9-132
Dead zone, adjusting for final stop 4-27
Deceleration parameter 4-13, 9-134
Deceleration rate, bunching up of 4-15
Default IP Addresses 2-34
  iBox settings 7-9
default parameter settings, saving 8-21
Delayed Mechanically In Service output 9-117
Demand Down Peak 10-71
Demand Down Peak Mode message 6-23
Demand Down Peak mode, selecting 10-15
demand peak detection parameters 10-17
Demand peak options 10-17
Demand peak parameters 10-19
Demand Up Peak 10-71
Demand Up Peak Mode message 6-23
Demand Up Peak mode, selecting 10-15
DETS, Down Emergency Terminal Limit switch 6-105, 11-9
Devices configuration 9-34–9-37
Diagnostic flags
  Car Operation 9-12
  Drive 9-12
  Motion 9-12
  Safety 9-12
Diagnostic Outputs window 9-13
Diagnostics 9-11–9-23
  Data Trap 9-11
  Diagnostic Flags 9-12
  Event Log 9-14
  Fault Bypass 9-17
  Terminal Switches Status 9-19
Direct connections 8-5–8-12
  connecting 8-11
  creating 2-39, 8-9
Direct connections, 3 = PC port 2-35
Direction arrow down 2 output 9-118
Direction Arrow Down output 9-117
Direction arrow up 2 output 9-118
Direction Arrow Up output 9-118
Disable Front Hall Door Buttons input 9-111
Disable Rear Hall Door Buttons input 9-111
Dispatcher = Car ‘n’ message 6-23
Dispatching
  Config tab, Simplex / Swing / Backup Dispatcher 10-12
  Dispatching tab 10-11
  Dispatching, description 1-4
  Display contrast, iBox control 7-4
  DLAB, Door Lock Access Bottom input 6-106, 11-11
  DLAT, Door Lock Access Top input 6-106, 11-11
  DLM, Down Leveling Marker Sensor input 6-104, 11-8
  DLMS, Door Lock Main String input 6-106, 11-11
  DN ETS POSITION FAULT message 6-24
  DN NTSn L1 SPEED FLT message 6-25
  DN NTSn L2 SPEED FLT message 6-25
  DN NTSn POSITION FLT message 6-26
  DNT1, Down Slowdown Limit switch #1 input 6-105, 11-9
  DNT2, Down Slowdown Limit switch #2 input 6-105, 11-9
  DNT3, Down Slowdown Limit switch #3 input 6-105, 11-9
  DNT4, Down Slowdown Limit switch #4 input 6-105, 11-9
  DNT5, Down Slowdown Limit switch #5 input 6-105, 11-9
  DNTD, Down Normal Limit Direction switch 6-105, 11-9
docking and undocking windows in iView 8-35
DOL, Door Open Limit input 6-104, 11-8
Door close delay timer 9-30
Door Close Protection Timer 9-31
Door Dwell Timers 9-42
  ADA Car Call 9-42
  ADA Hall Call 9-42
  Car Call 9-42
  Hall Call 9-42
  Lobby Call Dwell 9-42
  Reopen Dwell 9-42
  DOOR LK CLIPPED G200 message 6-24
  DOOR LK CLIPPED L200 message 6-24
  Door Lock Clipped Greater than 200fpm message 6-24
  Door Lock Clipped Less than 200fpm message 6-24
  Door lock indicators 9-10
  DOOR LOCK OPENED message 6-24
  Door Motor Protection Timers
    Closing 9-31
    Opening 9-31
  Door Open Button Bypass Timer 9-31
  Door Open delay timer to reverse closing doors 9-30
  Door Opening Protection Timer 9-31
  Door operator, preparing for final adjustments 3-28
  Door parameters, verifying 3-24
  Door pre-opening distance parameter 9-131
  Door times 10-22
  Door Zone 3-2
  Door Zone Sensor (DZ) 3-12
Doors configuration 9-30–9-33
  Doors Locked, iBox status LED 7-11
  DOWN DIR LIMIT OPEN message 6-24
  Down Direction Limit Open message 6-24
  Down Emergency Switch Shutdown message 6-25
  Down Emergency Switch Terminal Position Fault 6-24
  DOWN ETS SHUTDOWN message 6-25
  Down Level 3-2
  Down Normal Terminal ‘n’ Level 1 Speed Fault message 6-25
  Down Normal Terminal ‘n’ Level 2 Speed Fault message 6-25
  Down Normal Terminal ‘n’ Position Fault message 6-26
  Down switch, iBox control 7-12
  Down, iBox status LED 7-11
  DP1-, Position Encoder input 6-103, 11-7
  DP1+, Position Encoder input 6-103, 11-7
  DP2-, Position Encoder input 6-103, 11-7
  DP2+, Position Encoder input 6-103, 11-7
  DPM, Door Position Monitor input 6-104, 11-8
  Drawing Name 2-7
  Drawing Number Format 2-7
Drive
  Filters tab 9-92
  Safety tab 9-91
Drive At Speed Fault message 6-26
Drive Calibration
  calibrating offsets 9-144
  Input ADC 9-94
  Output DAC 9-94
Drive Communication Fault message 6-26
Drive Communication Warning message 6-26
Drive Configuration 9-88–9-94
  General tab 9-89
  Pre-Start Sequence parameters 9-89
  Pre-Torque tab 9-93
Drive Configuration parameters 9-88–9-94
Drive Connections, iBox 11-12
Drive Control parameters 9-93
  Pre-torque balance adjustment 9-93
  Pre-torque gain 9-93
  Pretorque position compensation 9-93
DRIVE ENABLE FDBK FLT message 6-26
Drive Enable Feedback Fault message 6-26
Drive Enable Status test point, description 11-4
DRIVE FAULT message 6-27
Drive Fault message 6-27
Drive Inspection Overspeed Fault message 6-27
Drive interface parameter 9-89
DRIVE IOS FAULT message 6-27
Drive IOS Limit test point, description 11-4
Drive IOS Param Limit test point, description 11-4
Drive Offsets calibration parameters
  Input ADC 9-94
Drive On Fault message 6-27
Drive, diagnostic flags 9-12
Driver VDC 5-26
DRO fault 4-19
DRO fault, empty car test 3-31
Drop delay, adjusting for final stop 4-28
Dual Channel QUAD Fault message 6-28
DUAL CHANNEL QUAD FLT message 6-28
Dynamic parking 10-21, 10-26
DZ, Door Zone Sensor input 6-104, 11-8

E
Earthquake (EQ) sensor 3-21
Earthquake board power supply OFF message 6-28
Earthquake board power supply ON message 6-28
Earthquake Board Quick Reference 6-88
Earthquake Buzzer output 9-118
Earthquake Code 9-65
Earthquake Emergency Stop message 6-28
Earthquake Light output 9-118
Earthquake Operation (Counterweight) message 6-28
Earthquake Operation (Seismic Switch) message 6-29
Earthquake Operation Activated message 6-28
Earthquake Operation Deactivated message 6-28
Earthquake parameters 9-65
Earthquake profile 4-13, 9-130
Earthquake Reduce Speed message 6-29
Earthquake reset button OK message 6-29
Earthquake reset button stuck ON message 6-29
EARTHQUAKE RUN message 6-29
Earthquake Run message 6-29
Earthquake Shutdown message 6-29
Earthquake Run Operation (Switch ‘n’) message 6-29
Earthquake recall parameters 9-62
ELEVATOR RECALL SW’n’ message 6-29
EM BK UIM RESET STUCK message 6-31
EMCO Load Weigher Installation 5-51
EMERG ALARM ACTIVATED message 6-30
EMERG BRAK LEG 2 SHORT message 6-31
EMERG BRAKE OK OPEN message 6-31
EMERG BRAKE TRIPPED message 6-31
EMERG BRK LEG 1 SHORT message 6-30
EMERG POWER RECALL message 6-33
EMERG POWER RUN message 6-33
EMERG POWER SHUTDOWN message 6-33
EMERG PWR NO COMM message 6-32
Emerg. Pwr. Car Selected to Recall output 9-118
Emerg. Pwr. Car Selected to Run output 9-118
Emergency Alarm Acknowledged message 6-29
Emergency Alarm Activated (Alarm button) message 6-30
Emergency Alarm Activated (Car delayed doors closed) 6-30
Emergency Alarm Activated (In-car stop switch) 6-30
Emergency Alarm Activated (Safety opened) message 6-30
Emergency Alarm Activated message 6-30
Emergency Alarm Deactivated without Acknowledge 6-30
Emergency Alarm Monitoring 9-35
Emergency Brake Board Quick Reference 6-84
Emergency Brake Log 1 Short Fault message 6-30
Emergency Brake Log 2 Short Fault message 6-31
Emergency Brake OK open message 6-31
Emergency Brake OK open Off message 6-31
Emergency Brake Test - Unintended Motion 4-49
Emergency Brake Test - Unintended Motion for Machine Brake 4-49
Emergency Brake Test - Unintended Motion for Rope Gripper 4-48
Emergency Brake Tripped message 6-31
Emergency Brake UIM Reset Button Stuck message 6-31
Emergency Dispatch input 9-108
Emergency Dispatch message 6-31
Emergency Dispatch Off message 6-31
Emergency Dispatch Override input 9-108
Emergency Exit contact 3-17
Emergency Medical Service Bypassed message 6-31
Emergency Medical Service Deactivated message 6-31
Emergency Medical Service In-Car Activated (Switch 'n') message 6-32
Emergency Medical Service parameters 9-67–9-70
Emergency Medical Service Recall Activated (Switch 'n') 6-32
Emergency power 5-26, 10-33
Emergency Power Activated message 6-32
Emergency Power and no communication with group 6-32
Emergency Power Auto Car Select input 9-108
Emergency Power Auto Recall input 9-108
Emergency Power Car Done Recall output 9-118
Emergency Power Deactivated message 6-33
Emergency Power input 9-108
Emergency power input 9-71
Emergency Power Manual Car Select input 9-108
Emergency Power Manual Override input 9-108
Emergency Power parameters 9-71–9-73
Emergency Power Permission to Run input 9-108
Emergency Power Phase I output 9-118
Emergency Power Phase II output 9-118
Emergency Power Priority Status output 9-118
Emergency power profile 4-13, 9-130
Emergency Power Recall 10-34
Emergency Power Recall message 6-33
Emergency Power Return input 9-108
Emergency Power Run 10-35
Emergency Power Run message 6-33
Emergency Power serial inputs 10-54
Emergency Power serial outputs 10-54
Emergency Power Service output 9-118
Emergency Power Shutdown message 6-33
Emergency rate limited stop parameter 9-90
Emergency slowdown profile 4-13, 4-53, 9-130
Emergency Stop Input 9-109
Emergency Stop Input Activated message 6-33
Emergency Stop Input Deactivated message 6-33
EMERGENCY STOP INPUT message 6-33
Emergency Stop switch 2-28
Emergency Terminal Limit (ETS) 4-9, 9-20
Emergency Terminal Overspeed 4-55
Emergency Terminal Switch Overspeed Tests 4-54
Empty Car Output 9-119
Empty Car Tests, preparing for final adjustments 3-31
Empty load detection 4-30
Empty load input 9-109
Empty Load output 9-119
Empty load threshold 4-31, 4-33
EMS Car Buzzer output 9-118
EMS Car Light output 9-118
EMS Car Switch input 9-109
EMS Hall Light 1 (2) outputs 9-118
EMS Hall Switch 1 input 9-109
EMS Hall Switch 2 input 9-109
EMS In-car (Switch 'n') message 6-32
EMS In-car (Switch 1) mode 9-6
EMS In-car (Switch 2) mode 9-6
EMS Recall (Switch 'n') message 6-32
EMS Recall (Switch 1) mode 9-6
EMS Recall (Switch 2) mode 9-6
Enable switch, iBox control 7-12
Encoder Signal test point, description 11-4
Encoder. See also Velocity Encoder
Entry Keypad 1-8
Environmental Considerations 2-4
Environmental Limits specification 11-2
EP Car Selected to Run or Recall output 9-119
EPI input 10-34
EQ board, Earthquake sensor 3-21
EQ Reset 3-21
Equipment Location 2-4
ESC, Car Panel Emergency Stop switch input 6-104, 11-8
ETA 10-71
Ethernet 1-4, 5-15
Ethernet address verification, iBox 7-10
Ethernet Addresses 2-32, 5-16
Ethernet addresses 5-14
Ethernet addresses, on the iBox 9-127
Ethernet connections 2-5
Event Log
  Event Filter 9-16
  open a saved file 9-14
  save to file 9-14
  View Event properties 9-15
  viewing on iView 9-14
  viewing on the iBox 7-8
Event Properties dialog 9-15
EXCESS BRAKE FDBK FLT message 6-33
EXCESS MF FDBK FAULT message 6-34
EXCESS RELEVELS FAULT message 6-34
EXCESS RESTARTS FAULT message 6-34
Excessive Brake Feedback Fault message 6-33
EXCESSIVE FAULTS message 6-34
Excessive Faults Shutdown message 6-34
Excessive Motor Field Feedback Fault message 6-34
Excessive Motor Noise 4-15
Excessive Relevels Fault message 6-34
Excessive Restarts Fault message 6-34
Excessive Restarts Warning message 6-34
Exercise Operation 9-40
Exercise Operation Activated message 6-34
Exercise Operation Deactivated message 6-35
EXERCISE OPERATION message 6-34
exiting Construction Mode 3-25
F
F DPM OPEN-GS CLOSED message 6-39
F DR CLS FLT REC FAIL message 6-38
Fi help, accessing online help 8-24
Fan and Light Indicator output 9-119
Fault Bypass 9-17
FAULT BYPASS SW ON message 6-35
Fault Bypass Switch On message 6-35
Fault Bypass Switch Timed Out Fault message 6-35
Fault Bypasses 9-18
Fault messages window 9-10
Fault Reset, iBox control 7-4
Fault, iBox status LED 7-11
Fault/Function Bypass switch, iBox control 7-12
Field Active Status test point, description 11-4
Field Command (Control) test point, description 11-4
field connections 11-7–11-13
Field Control Path test point, description 11-4
Field Current 9-10
Field Current Feedback test point, description 11-4
Field Current Signal test point, description 11-4
Field Error test point, description 11-4
Field Integral Command test point, description 11-4
Field Integral Gain test point, description 11-4
Field Module Logic Board Quick Reference 6-85
Field Module Over Temperature Fault message 6-35
FIELD MODULE OVR TEMP message 6-35
Field Proportional Command test point, description 11-4
Field Proportional Gain test point, description 11-4
Field Voltage 9-10
Field Voltage Feedback test point, description 11-4
Field Voltage Signal test point, description 11-4
Field wiring 2-9
Filters, Drive - Filters tab 9-92
Final Approach to Floor 4-15
Fire Code parameters 9-47
Fire I Light output 9-119
Fire II Light output 9-119
Fire Phase II Call Cancel Switch input 9-109
Fire Phase II Hold Conditions 9-54
Fire Phase II Recall Conditions 9-53
Fire Phase II Switch HOLD input 9-109
Fire Phase II Switch OFF input 9-109
Fire Phase II Switch ON input 9-109
Fire Phase II Switch START input 9-109
Fire Recall Alt. message 6-36
Fire Recall Alternate message 6-36
Fire Recall Door Open Main input 9-109
Fire Recall Main input 6-36
Fire Recall output 9-119
Fire Service
   Alternate Recall floor 9-45
   Main Recall floor 9-45
   parameters 9-45–9-59
Fire Service In-car Activated message 6-35
Fire Service In-Car Deactivated message 6-35
Fire Service In-car Hold Operation message 6-35
Fire Service In-car message 6-35
Fire Service In-car mode 9-6
Fire Service In-car Recall Operation message 6-35
Fire Service operation 9-45
Fire Service Override 9-47
Fire Service Phase I Return Complete output 9-119
Fire Service Recall Alternate message 6-36
Fire Service Recall Alternate mode 9-6
Fire Service Recall Deactivated message 6-36
Fire Service Recall Main message 6-36
Fire Service Recall Main mode 9-6
Fire Svc In-car message 6-35
Fire Switch Settings 9-50
Fire Warning Buzzer output 9-119
Fire Warning Light output 9-119
Firefighter’s Panel Unlock output 9-119
Firmware Update screen 8-41
Flare jerk parameter 4-13, 9-134
Flare pattern frequency parameter 9-92
Flood Operation Activated message 6-36
Flood Operation Buzzer output 9-119
Flood Operation Deactivated message 6-36
Flood Operation Input 9-109
FLOOD OPERATION message 6-36
Flood operation parameters 9-77
Flood Operation Status output 9-119
Floor Data Settings 9-97
Floor Data Tab 9-97
Floor Heat Detectors Activated message 6-36
Floor Heat Detectors Deactivated message 6-36
FLOOR HEAT DETECTORS message 6-36
Floor Heights
   Learn procedure 4-2
   Learn tab 9-145
   Learning the 4-2
Floor Heights Configuration parameters 9-95
Floor Heights Learn status message 9-147
Floor label parameter 10-7
Floor Level Sensor Adjustment 3-11
Floor Leveling Accuracy specification 11-2
Floor Location Fault message 6-37
Floor Offset Distance parameter 3-2
Floor offsets, calibrating 4-23, 9-148
Floor Override Input 9-109
Floor Sensor Fault message 6-37
Floor Sub-Address or Call “Type” Jumper 5-33
Floor Synchronization 9-132
Floor Synchronization Fault message 6-37
Floors, number of parameter 10-7
FLT BYP SW TIMED OUT message 6-35
Flux vector technology 1-10
Following error 2-45
Following error, calibrating 2-58
Front (Rear) Closing Warning Light output 9-121
Front (Rear) DCLC Output 9-121
Front (Rear) Disable Hall Door Buttons output 9-121
Front (Rear) Door Car Gong output 9-121
Front (Rear) Door Close Limit output 9-122
Front (Rear) Door Closing Warning Buzzer output 9-121
Front (Rear) Door Disable Automatic Close output 9-121
Front (Rear) Door Enable output 9-122
Front (Rear) Door Hold End output 9-122
Front (Rear) Door Hold Function output 9-122
Front (Rear) Door Left Open output 9-122

Index-9
Front (Rear) Door Lock Power output 9-122
Front (Rear) Door This Car Up output 9-122
Front (Rear) Down Car Lantern output 9-122
Front (Rear) Nudging Audible output 9-122
Front Auxiliary Door Close Button input 9-111
Front Constant Pressure Close (Front Door) input 9-111
Front Constant Pressure Open (Front Door) input 9-111
Front COP2 Door Close Button input 9-111
Front COP2 Door Hold Button input 9-111
Front COP2 Door Open Button input 9-111
Front COP2 Door Stop Button input 9-111
FRONT DOB BYPASSED message 6-38
Front Door Close Button (COP1) input 9-111
Front Door Close Fault message 6-37
Front Door Close Fault Recovery Failure message 6-38
FRONT DOOR CLOSE FLT message 6-37
Front Door Close Time-out message 6-38
FRONT DOOR CNTCT FLT message 6-38
Front Door Contact Fault message 6-38
Front Door Hold Button (COP1) input 9-111
Front Door Open Button (COP1) input 9-111
Front Door Open Button Bypassed message 6-38
Front Door Open Fault message 6-38
Front Door Open Time-out message 6-39
Front Door Stop Button (COP1) input 9-111
FRONT DOORS STOPPED message 6-39
Front Doors Stopped message 6-39
Front DPM Open - GS Closed message 6-39
FRONT HALL DOB BYP message 6-39
Front Hall Door Close Button input 9-111
Front Hall Door Hold Button input 9-111
Front Hall Door Open Button Bypassed message 6-39
Front hall door open button input 9-111
Front Hall Door Stop Button input 9-111
Front Momentary Pressure Close (Front Door) input 9-111
Front Momentary Pressure Open (Front Door) input 9-111
FRONT PHOTO EYE BYP message 6-39
Front Photo Eye Bypassed message 6-39
Front Photo Eye Cut Out input 9-111
FRONT PHOTO EYE FAIL message 6-39
Front Photo Eye Failure message 6-39
FRONT SAFE EDGE BYP message 6-40
Front Safe Edge Bypassed message 6-40
FRONT SAFE EDGE FAIL message 6-40
Front Safe Edge Failure message 6-40
Fuses 2-16, 5-7
Fuses on the iBox 7-13

G
Gate release Solenoid output 9-119
Gateway 7-9, 8-4
Gear Reduction Ration
calculating 2-55
General Configuration parameters 9-96–9-100
   Active configuration settings 9-100
   Car call eligibility 9-98
   Car identifier 9-96
   Car label 9-96
   Floor Data tab 9-97
   Group identifier 9-96
   Simplex car 9-96
General serial outputs 10-56
Generate default configuration file 8-21
Global Parameter Update, Reset Controller message 6-40
Gong Enable Down Front output 9-119
Gong Enable Down Rear output 9-119
Gong Enable Up Front output 9-119
Gong Enable Up Rear output 9-120
GOY SPEED SWITCH FLT message 6-40
GOV, Governor input 6-106, 11-11
GOVERNOR OPEN message 6-40
Governor open message 6-40
Governor Speed Reduction Switch Fault message 6-40
Governor Speed Reduction Switch input 9-113
Grounding 2-14
Group Communication Established message 6-40
Group Communication Lost message 6-40
Group ID 5-25
Group identifier parameter 9-96
Group Info 5-25
GS, Gate Switch input 6-106, 11-11

H
HA INSP. DISABLED message 6-41
Hall call addresses 5-33
HALL CALL BUS 'n' FAIL message 6-40
Hall Call Bus 'n' Failure message 6-40
HALL CALL BYPASS INP. message 6-41
Hall Call Bypass Input 9-109
Hall Call Bypass Input OFF message 6-40
Hall Call Bypass Input ON message 6-41
Hall Call Cross Registration 10-36
Hall Call Driver Testing 5-43
Hall Call Eligibility 10-13
Hall Call Eligibility Config inputs 9-113
Hall Call Eligibility Config outputs 9-124
Hall call enable 1 (or 2) serial inputs 10-56
Hall call enable inputs 9-114
Hall call enclosures 5-33
Hall call jumpers 5-33
Hall Call Restrictions 10-42
Hall Call Security 1 Override input 9-113
Hall Call Security 2 Override input 9-114
Hall Call serial inputs 10-53
Hall Call Service Disabled message 6-41
Hall Call Service Enabled message 6-41
Hall call wiring 5-32
I/O Board Configuration 9-101–9-124
Adding a Circuit Board 9-102
Assign inputs/outputs 9-102
Serial COP boards 9-104
iBox 7-1–7-13
configuring IP addresses using iView 9-127
color switches 7-12
description 1-7, 7-1
display menu tree 7-6
Event Log messages 6-4
front panel controls 7-2
fuses 7-13
keypad controls 7-4
LCD display 1-8, 7-3
LCD display, top line characters 7-4
messages cross-reference 6-4
replacing 6-73
Safety bypass jumper 7-13
setting and verifying the IP address 7-10
status LEDs 7-11
status messages 7-12
view and set parameters 7-5
View/register calls 7-8
viewing factory data 7-8
viewing MAC addresses 7-8
viewing serial numbers 7-8
viewing the Event log 7-8
viewing version info 7-8
iBox field connections 11-7–11-13
ICE-COP Board Diagnostics 6-4
ICE-CTP Cartop Processor Board Quick Reference 6-78
ICE-EB Emergency Brake Board Quick Reference 6-84
ICE-FML Field Module Logic Board Quick Reference 6-85
ICE-IEQ Earthquake Board Quick Reference 6-88
ICE-IMP Main Processor Board Quick Reference 6-90
ICE-IRB Relay Board Quick Reference 6-92
ICE-IRD Rear Door Board Quick Reference 6-95
ICE-MIAC Multiple Input AC Board Quick Reference 6-97
ICE-MIAC-24V Multiple Input AC/DC Board Quick Reference 6-97
ICE-MOR Multiple Output Relay Board Quick Reference 6-99
iCentral 1-19
ICE-RG Rope Gripper Board Quick Reference 6-101
ICE-SAF Safety Board Quick Reference 6-102
ICE-SF Serial Fixtures Board Quick Reference 6-107
iControl
cartop communication 1-18
cartop interconnections 1-16
central monitoring 1-21
description 1-1, 1-5
dispatching interconnections 1-19
layout 1-5
load weighing 1-23
logging and report generating 1-22
system interconnections 1-15
iControl AC Specifications 11-2
iControl messages 6-13–6-71
iControl wiring connections 2-11
iControllers 5-11
ICPD, COP Inspection Station DN Button input 6-104, 11-8
ICPU, COP Inspection Station UP Button input 6-104, 11-8
ICTD, Cartop Inspection Down Button 3-17
ICTD, Cartop Inspection Station DN Button input 6-104, 11-8
ICTU, Cartop Inspection Station UP Button input 6-104, 11-8
ICTU, Cartop Inspection Up Button 3-17
iCue 5-25
   Capabilities 5-3
   Dedicated 5-12
iCue dispatching, description 1-4
iCue GUI 5-25, 5-27
iCue, description 1-1
Idle Swing Car Timer 9-40
iLand Cable Connections 3-11
iLand Landing System 1-17, 3-2–3-12
   accuracy 3-2
   adjustments 3-7
   cartop mounting 3-3
   connections 3-11
   description 1-1, 1-17, 3-2
   installation instructions 3-5
   installing floor leveling magnets 3-9, 3-10
   iView parameter setting 3-12
   magnet positioning 3-6
   pedistal fabrication and mounting 3-4
   Status LEDs 3-12
iLand Mounting on Pedestal 3-4
iLand Pedestal 3-3
iLand Status LEDs 3-12
iLink Cartop Box 3-13–3-19
   car operating panel connections 3-18
   description 1-1
   description of communication 1-18
   enclosure 3-14
   installation 3-13–3-19
   power connections 3-18
   serial connection to iControl 3-17
iMonitor, description 1-1, 1-21
IMP SW FAULT
   EM STOP message 6-42
   FLT BYP message 6-43
   INSP DN message 6-43
   INSP EN message 6-43
   INSP message 6-43
   LEARN message 6-43
   TEST message 6-43
IMP SW FLT
   C DOOR BP message 6-42
   H DOOR BP message 6-43
   WRITE EN message 6-44
IMP Switch Fault - Car Door Bypass message 6-42
IMP Switch Fault - Emergency Stop message 6-42
IMP Switch Fault - Fault Bypass message 6-43
IMP Switch Fault - H. Door Bypass message 6-43
IMP Switch Fault - Inspection DOWN message 6-43
IMP Switch Fault - Inspection Enable message 6-43
IMP Switch Fault - Inspection message 6-43
IMP Switch Fault - Inspection UP message 6-43
IMP Switch Fault - LEARN message 6-43
IMP Switch Fault - None message 6-43
IMP Switch Fault - Write Enable message 6-44
In Group, iBox status LED 7-11
In Use Light output 9-120
INA, Car Panel (Hoistway) Access switch input 6-104, 11-8
In-car CFSS Operation 9-76
In-Car Fire Door Operation output 9-120
In-Car Fire Hold output 9-120
In-Car Fire Recall output 9-120
In-Car Inspection output 9-120
INCP, COP Inspection Station INSP/AUTO Switch input 6-104, 11-8
INCT, Cartop Inspection Station INSP/AUTO Switch input 6-104, 11-8
INCT, Inspection Cartop Enable switch input 2-29, 3-17
Independent Service Indicator output 9-120
Independent Service input 9-110
Independent Service message 6-44
Independent Service mode 9-7
Independent service parameters 9-60
Independent Svc message 6-44
Initial jerk parameter 4-12, 9-134
initial parameter settings 2-43
initial power up 2-19
Input ADC 9-94
Input/Output assignment 2-13
Inputs and Outputs
   terminals 2-13
   wiring 2-12
Inputs, programming 9-107
INSFCNT BRK FDBK FLT message 6-44
INSFCNT MF FDBK FLT message 6-44
INSFCNT MF FORCNG FLT message 6-45
Inspection message 6-44
Inspection mode 2-19, 3-1–3-31, 9-7
Inspection operation
   checking cartop operation 2-61
Inspection Operation message 6-44
Inspection Output 9-120
Inspection Overspeed Fault message 6-44
Inspection Overspeed Test 4-47
Inspection overspeed, Safety parameter 9-151
Inspection profile 4-14, 9-130
Inspection switch, iBox control 7-12
Inspection, iBox status LED 7-11
Install Cabinet 2-9
Installation
   tools and test equipment 2-6
Installing Floor Magnets 3-9
Installing the Velocity encoder 2-24
Insufficient Brake Current Feedback Fault message 6-44
Insufficient Motor Field Feedback Fault message 6-44
Insufficient Motor Field Forcing Feedback Fault 6-45
Insulation test 2-21
INV CNFG INPUT DCMS R message 6-46
INV CNFG INPUT DLMS R message 6-46
INV CNFG INPUT DPM_R message 6-47
INV INVTRY XCHK BALRQ message 6-47
INV INVTRY XCHK DCCOR message 6-47
IP address, setting and verifying on the iBox 7-10
iReport, description of 1-1, 1-22
Isolated Platform Load Weigher 4-31, 5-61
Isolation transformer, grounding 2-15
iSystem Overview 1-2
iView 8-1–8-40
configuration tabs 8-25, 8-31
creating a configuration file 8-20
description 1-1, 8-2
docking and undocking windows 8-35
editing the virtual oscilloscope display 8-39
installing 8-3
Layouts 8-30
pinning and unpinning windows 8-33
printing screens 8-38
programming 1-11
resizing windows 8-34
saving parameters to a configuration file 8-20
Send command 8-19
sending parameters to the controller 8-19
setting parameters 8-18
setting the system’s date and time 8-38
setup tabs 8-25
View menu contents 8-26
windows and tabs 8-25
working offline 8-23
working online 8-17
iView Logged Off message 6-50
iView Logged On message 6-50
iView Lost Connection message 6-50
iView Status Bar 9-3
iView Timed Out message 6-50
iView windows and tabs 9-1–9-127
J
Jerk specification 11-2
Job name parameter 10-7
Job prints 2-7, 5-12, 5-47, 6-99, 6-111
K
Keypad controls, iBox 7-4
keypad, call enable device 9-113, 9-114, 10-56
LAN connections 2-30, 8-13–8-16
connecting 8-15
creating 8-13
deleting 8-16
ingoing 8-16
LAN connections 2-30, 8-13–8-16
connecting 8-15
creating 8-13
deleting 8-16
ingoing 8-16
LAND SYS SENSOR FAULT message 6-50
Landing system 1-1
See iLand Landing System
Verifying position encoder resolution 3-27
Landing System Sensor Fault message 6-50
Latch First Smoke Detector Zone 9-49
Latch Primary Fire Recall Switch 9-48
Latch Secondary Fire Recall Switch 9-49
Latch the fire hat flashing 9-46
Layers, iView screen layouts 8-30
LCD display, iBox 1-8, 7-3, 7-4
LCD Fault message 6-51
LEARN SW TIMED OUT message 6-51
Learn Switch Timed Out Fault message 6-51
Learn switch, iBox control 7-12
Learn U/DNT1-5 and U/DETS Positions message 6-51
Learn U/DNT1-5 and U/DETS Speeds message 6-51
LEARN U/DTS POSITIONS message 6-51
LEARN U/DTS SPEEDS message 6-51
LEARNING EMPTY LOAD message 6-51
Learning empty load values message 6-51
LEARNING FULL LOAD message 6-51
Learning full load values message 6-51
Learning the
Building floor heights 4-2
Counterweight 3-28
Empty and loaded car weights 4-33
ETS and NTS Limit Switches 4-9
Load Weights 4-30
Load weights 9-149
Learning the Safety Configuration 2-46
Level Down Sensor 3-12, 4-5
Level Up Sensor 4-5
Leveling Accuracy specification 11-2
Leveling distance parameter 4-13, 9-132
Leveling Overspeed Test 4-48
Leveling overspeed, Safety parameter 9-151
Leveling sensor indicators 9-10
Leveling speed parameter 4-13, 9-132
Leveling speed, adjusting for final stop 4-27
Light load anti-nuisance 4-30, 9-39
Light Load Antinuisance message 6-51
Light Load Input input 9-110
Light Load Output output 9-120
Light load threshold 4-31, 4-33, 9-129
LIMIT SW CHKSUM FAULT message 6-52
LIMIT SW LEARN FAULT message 6-52
Limit Switches Checksum Fault message 6-52
Limit Switches Learn Fault message 6-52
Load calibration on message 6-52
Load learn process activated message 6-52
Load learn process deactivated message 6-52
Load Weigher 1-23
Cross Head Deflection 1-23, 9-129
installing 3-19
Isolated Platform 1-23, 9-129
Rope tension sensing 9-129
Load weigher
Crosshead deflection 4-30
Empty load threshold 4-31
Heavy load threshold 4-31
Isolated platform 4-31
Light load threshold 4-31
Overload threshold 4-31
Rope tension 4-30
Load Weigher (Raw) test point, description 11-4
Load Weigher Adjustment 4-30
Load Weigher Balanced test point, description 11-5
Load Weigher Feedback test point, description 11-5
Load weigher installation
EMCO Load Weigher 5-51
load weigher learn procedure 9-149
Load Weigher parameters 9-128
Analog Device Configuration 9-129
Heavy load threshold 9-129
Light load threshold 9-129
Load Weighing Device Type 9-128
Over Load Threshold 9-129
Load Weigher Sensor Adjustment 4-16
Load Weigher Signal test point, description 11-4
Load Weigher. See also MCE Load Weigher
Loading parameters from a Configuration file 8-22
Lobby Call Dwell Time 9-42
Lobby floor 9-38
Lobby parking delay 10-21
Lobby peak 10-71
Lobby peak detection parameters 10-15
Lobby Peak Mode message 6-52
Lobby peak mode, selecting 10-15
Lobby peak options 10-16
Lobby peak parameters 10-18
Lobby Shuffle delay 10-21
Local Area Network 8-13
Local car, description of 10-4
Local Dispatcher, description of 10-4
Local Dispatching 10-6
Locked, Security status 10-42, 10-45
Locks/Contacts Connections, iBox 6-106, 11-11
Logical Position 9-9
LOSS OF POS/SPD IND message 6-52
Loss of Position or Speed Indicators message 6-52
Low roll jerk parameter 4-13, 9-134
Low speed parameter 9-134
MAC ADDRESS ERROR message 6-52
Mac Address Error message 6-52
MAC addresses 9-127
viewing on iBox 7-8
Mach Rm Insp message 6-53
Machine mode 9-9
Machine Inspection message 6-53
Machine Room Heat Detectors Activated message 6-52
Machine Room Heat Detectors Deactivated message 6-53
Machine Room Inspection message 6-53
Machine Room Inspection mode 9-7
Machine Room Inspection Operation message 6-53
Machine Room Inspection output 9-120
Machine Room Inspection switch 7-12
Machine Room Inspection, running on 2-54–2-61, 3-26
Machine Room Preparation
Equipment location 2-4
Machine Room Stop Switch Open message 6-53
Main Fire Recall floor 9-45
Main Floor Smoke input 9-110
MAIN FLOOR SMOKE message 6-53
Main Floor Smoke Sensor Recall message 6-53
Main Processor Board Quick Reference 6-90
Manual configuration serial inputs 10-56
Master Security Override input 9-113
MCE 5-18
MCE job number parameter 10-7
MCE Load Weigher 5-61–5-67
adjusting 5-66
installation 5-61
maintaining 5-66
wiring 5-65
MCE Load Weigher. See also Load Weigher
MCE Loadweigher-Isolated Platform 3-19
MCE System hub 5-10, 5-12
MD, Motor Drive relay indicator 11-12
MDRD, Motor Drive Redundancy indicator 11-12
Mechanical Safe Edge 9-30
Mechanically In Service output 9-120
Melina PI display Outputs 9-124
Menu tree, iBox LCD display 7-6
MF FORCING TIMED OUT message 6-54
MF1, MF2, DC power to motor field 11-14
Minimum Floor to Floor Time specification 11-2
Mode of Operation 5-26, 9-5, 10-14
Mode of Operation Config inputs 9-113
Mode of Operation Config outputs 9-124
monitoring Diagnostic Outputs 9-13
Motion
Actual direction 9-9
Category 9-9
Commanded direction 9-9
Motion Start Fault message 6-53
Motion stopped due to IO toggle test message 6-53
MOTION STOPPED-IO TST message 6-53
Motion, diagnostic flags 9-12
Motor blower hold delay parameter 9-89
Motor Blower output 9-124
MOTOR CNTR PROOF FLT message 6-54
Motor Contactor Driver Proofing Fault message 6-54
Motor Contactor Proofing Fault message 6-54
Motor Contactor Status test point, description 11-5
Motor Current Limiting 4-14
Motor Field Forcing Timed Out message 6-54
Motor insulation 2-21
Motor Limit Protection Timer Elapsed message 6-54
MOTOR LIMIT TIMED OUT message 6-54
Motor Limit Timed Out message 6-54
MOTOR LMT TIMED OUT 2 message 6-54
Motor Noise 4-15
Motor Overload Protection, verifying 2-60
Motor Triac active indicator 11-12
MOTR CNTR DRV PRF FLT message 6-54
Move idle car penalty 10-11
Move lobby parked car penalty 10-11
Move non-lobby parked car penalty 10-11
MR HEAT DETECTORS message 6-52
MR INSPI. DISABLED message 6-53
MR STOP SWITCH OPEN message 6-53
MRD, Motor Redundancy indicator 11-12
Multiple Input AC Board Quick Reference 6-97
Multiple Output Relay Board Quick Reference 6-99
Network Info 5-26
Node Control 5-26
Non-interference timer 9-30
Non-lobby parking delay 10-21
Non-lobby shuffle delay 10-21
Non-peak hall call assignment penalty 10-17
Normal and Emergency Terminal Switch Position Tests 4-54
Normal rate limited stop parameter 9-90
Normal rate limited stop, adjusting for final stop 4-26
Normal Terminal Slowdown Limit (NTS) 4-9
Normal Terminal Switch Overspeed Tests 4-53
Nudging 9-38
Nudging Front, NUDGING FRONT message 6-54
Nudging Operation message 6-54
Nudging Rear, NUDGING REAR message 6-54
Number of Cars in Group specification 11-2
Number of Stops specification 11-2
OK Write Privileges 1-13
Online help, accessing 8-24
Operational Status tab 9-8
Orange cables 5-12, 5-35
Oscilloscope
editing displays 8-39, 9-22
Enable/Disable Tracking 9-22
Scale 9-23
Zoom to Fit 9-23
OTHER CARS ALT FIRE message 6-54
Other Cars Alternate Fire Sensor Recall message 6-54
Other Cars Alternate input 9-110
OTHER CARS MAIN FIRE message 6-55
Other Cars Main Fire Sensor Recall message 6-55
Other Cars Main input 9-110
Outputs, programming 9-116
Over Current Power Threshold test point, description 11-5
Over Current test point, description 11-5
Over Current Threshold test point, description 11-5
Over Load Input 9-110
Over Load Threshold 9-129
Overload output 9-120
Overload threshold 4-31, 4-32
Overloaded car detection 4-30
Overshoot correction, Contract speed runs 4-14
Overshoot, adjusting for 4-8
Overspeed 1 9-20
description of 4-55
Overspeed 1 margin, Safety parameter 9-151
Overspeed 2 9-20
description of 4-55

P
PARAM CHNG-RESET CAR message 6-40
Parameter adjustment
using iView 8-18
using the iBox 7-5
Parameter entry screens 1-13, 8-18
parameter settings, verifying initial 2-43
Parameters, Load from Configuration file 8-22
Parameters, Save to File 8-20
Parking 10-20
Parking Config inputs 9-113
Parking Config outputs 9-124
Parking Configurations 10-21
Parking Delay Timers 10-21
Parking Eligibility 10-27
Parking Eligibility Config inputs 9-113
Parking Eligibility Config outputs 9-124
Partial pick voltage 9-25
Pass Code Failure output 9-120
Pass Code Success output 9-120
Passenger configuration 9-38–9-44
Passenger mode 9-7
Passenger Operation, Passenger message 6-55
Passing Floor Gong Enabled input 9-110
Passing Floor Gong Enabled output 9-120
Passing Floor Gong output 9-120
Pattern - Common parameters 9-131
Pattern (Command) test point, description 11-5
Pattern (Directional) test point, description 11-5
Pattern (Phase) test point, description 11-5
Pattern (Raw) test point, description 11-5
Pattern (Region) test point, description 11-5
Pattern (Slew Limited) test point, description 11-5
Pattern Filtered test point, description 11-5
Pattern Interpolated test point, description 11-5
Pattern phase 9-10
Pattern profile 9-10
Pattern profile parameters 4-12, 9-130–9-135
Pattern scaling parameter 9-131
Pattern shape preset 9-134
Pedestal Fabrication 3-4
Per floor parking 10-21
Peripheral hub 5-10, 5-11, 5-13, 5-21
Peripheral TCP/IP 5-11
Photo Eye 9-31
Photo Eye Anti-nuisance 9-39
Photo Eye Antinuisance message 6-55
Photo Eye Bypass Timer 9-31
Pick delay 9-26
Pick voltage 2-51, 2-53, 9-25
Pinging 5-24
pinning and unpinning windows in iView 8-33
PM gearless machines, synchronize with AC drive 2-25, 2-45
Position Bit test point, description 11-6
Position Cartop Offset Fault message 6-55
Position encoder resolution
parameter 9-131
verifying 3-27
Position iBox Connections 6-103, 11-7
Position indicators Binary Outputs 9-123
Position indicators Rotodial Outputs 9-123
Position indicators Single Outputs 9-123
Position Location Error Fault message 6-55
Position Margin 4-55
POSITION QUAD FAULT message 6-55
Position Quadrature Fault message 6-55
Position Quadrature Reversed Fault message 6-55
Position Speed Deviation Fault message 6-56
Position Speed Threshold Fault message 6-56
POSITION SYNC-FLOOR message 6-56
Position Synchronization
Floor 9-132
Preset parameter 9-132
Terminal 9-132
Position Synchronization Fault message 6-56
Position Synchronization parameters 9-132
Position Synchronization Required at Floor message 6-56
Position Synchronization Required at Terminal message 6-56
Position Synchronized at Floor message 6-56
Position Synchronized at Terminal message 6-57
POSITION SYNC-TERMINAL message 6-56
POSITION QUAD RVRSD FLT message 6-55
POSTN SPD THRSHLD FLT message 6-56
Power bus verification 5-9
Power line fluctuation 2-4
Power Transfer input 9-110
Power Transfer Input Activated message 6-57
Power Transfer Input Deactivated message 6-57
Power Transfer, POWER TRANSFER message 6-57
Power Up Position Synchronization Required at Term 6-57
PowerBack R6 Regenerative Drive
Parameters Quick Reference 11-31
Preparing for Final Adjustments 3-28
counterweight balancing 3-29
door operator 3-28
empty car tests 3-31
run testing 3-28, 3-30
Pre-Run Status test point, description 11-6
Index-17

preset profile parameters 9-134
Pre-start Door Lock Fault message 6-57
Pre-Start Sequence 4-35–4-40
diagrams 4-36
parameters 4-35, 9-89
Pretoque (Raw) test point, description 11-6
Pretoque Command test point, description 11-6
Pretoque Gain, adjusting 4-17
Pretoque option 4-17
Pretoque Position Compensation 4-17
PRI FIRE SWITCH BYP message 6-57
PRI FIRE SWITCH ON message 6-57
Primary Fire Switch BYPASS input 9-110
Primary Fire Switch Bypass message 6-57
Primary Fire Switch OFF input 9-110
Primary Fire Switch ON input 9-110
Primary Fire Switch On message 6-57
Printing screens in iView 8-38
Processed pattern frequency parameter 9-92
programmable inputs 9-107
programmable outputs 9-116
Pulses per foot, Safety parameter 9-151

Q
QPRAM Device Error message 6-57
Quadrature Pulse Indicators 3-12
Quadrature Pulse Sequence 3-27
Quadrature Pulse Voltages 3-27
Quadrature Sensor Adjustment 3-3

R
R DPM OPEN-GS CLOSED message 6-59
R DR CLS FLT REC FAIL message 6-58
R6 Regenerative AC drive parameters 11-31
Rated motor RPM parameter 9-90
Raw pattern frequency parameter 9-92
RB resistor, adjusting 2-22
Rear Auxiliary Door Close Button input 9-112
Rear Call CoP2 inputs 9-113
Rear Constant Pressure Close (Rear Door) input 9-112
Rear Constant Pressure Open (Rear Door) input 9-112
Rear CoP2 Door Close Button input 9-111
Rear CoP2 Door Hold Button input 9-111
Rear CoP2 Door Open Button input 9-112
Rear CoP2 Door Stop Button input 9-112
REAR DOB BYPASSED message 6-59
Rear Door Board Quick Reference 6-95
Rear Door Car Gong output 9-121
Rear Door Close Button (COPI) input 9-112
REAR DOOR CLOSE FAULT message 6-58
Rear Door Close Fault message 6-58
Rear Door Close Fault Recovery Failure message 6-58
Rear Door Close Limit input 9-112
Rear Door Close Limit output 9-122
Rear Door Close Time-out message 6-58
Rear Door Closing Warning Buzzer output 9-121
Rear Door Contact Fault message 6-58
REAR DOOR CONTACT FLT message 6-58
Rear Door Disable Automatic Close output 9-121
Rear Door Disable Hall Door Buttons output 9-121
Rear Door Enable output 9-122
Rear Door Hold Button (COPI) input 9-112
Rear Door Hold Function output 9-122
Rear Door Left Open output 9-122
Rear Door Lock Power output 9-122
Rear Door Open Button (COPI) input 9-112
Rear Door Open Button Bypassed message 6-59
Rear Door Open Fault message 6-59
Rear Door Open Limit input 9-112
Rear Door Open Time-out message 6-59
Rear Door Photo Eye input 9-112
Rear Door Stop Button (COPI) input 9-112
REAR DOORS STOPPED message 6-58, 6-59
Rear Doors Stopped message 6-58, 6-59
Rear Down Car Lantern output 9-122
Rear DPM Open - GS Closed message 6-59
REAR HALL DOB BYP message 6-59
Rear Hall Door Close Button input 9-112
Rear Hall Door Hold Button input 9-112
Rear Hall Door Open Button input 9-112
Rear Hall Door Open Button Bypassed message 6-59
Rear Hall Door Stop Button input 9-112
Rear Momentary Pressure Close (Rear Door) input 9-112
Rear Momentary Pressure Open (Rear Door) input 9-112
Rear Nudging Audible output 9-122
REAR PHOTO EYE BYP message 6-60
Rear Photo Eye Bypassed message 6-60
Rear Photo Eye Cut Out input 9-112
REAR PHOTO EYE FAIL message 6-60
Rear Photo Eye Failure message 6-60
REAR SAFE EDGE BYP message 6-60
Rear Safe Edge Bypassed message 6-60
REAR SAFE EDGE FAIL message 6-60
Rear Safe Edge Failure message 6-60
Rear This Car Up output 9-122
Rear Up Car Lantern output 9-122
Recall Switch "x" input (x = 1 - 6) 9-110
Recall Switch "x" Unlatch (x = 1 - 6) 9-110
Recall Switch 1 - 6 output 9-120
Receive Sys Params message 6-60
Reduced Inspection Speed option parameter 9-134
Register a car call 4-4
Relay Board Quick Reference 6-92
Relay output selection 5-47, 6-99, 6-111
Relevel dead zone distance parameter 9-132
Relevel distance parameter 9-132
Relevel door open inhibit timer 9-30
Relevel voltage 9-25
Relevel, iBox status LED 7-11
Relevel, verifying 4-6
Releveling 4-29
Releveling speed parameter 9-132
Remote Monitoring Authorization 10-31
Remote Outputs tab 10-66
Remote User Outputs 10-59
Repick time 9-26
Reset EQ board 3-21
Reset Rope Gripper 2-29
resizing windows in iView 8-34
RESTRICTED message 6-60
Restricted message 6-60
RET CAM PROTECTIN FLT message 6-61
Retask penalty 10-11
RETIRING CAM DLK FLT message 6-61
Retiring Cam Door Lock Fault Activated message 6-61
Retiring Cam Door Lock Fault Deactivated message 6-61
Retiring Cam Door Lock Fault message 6-61
Retiring Cam output 9-121
Retiring Cam Protection Fault Activated message 6-61
Retiring Cam Protection Fault Deactivated message 6-61
Retiring Cam Protection Fault message 6-61
RFI noise, proper grounding 2-14
RFI, Radio Frequency Radiation 2-4
RFI/EMI noise, reducing 2-21
Ride quality, adjusting 4-30
Ring and String circuit 3-21
Rollback adjustment, Speed pick delay 4-7
Rollback, controlling 4-16
Rope Gripper 2-29
Rope Gripper Board Quick Reference 6-101
Rope Gripper Bypass 2-29
Rope Gripper Reset 2-29
Rope Gripper Wiring 2-29
Rope Stretch Releveling 4-29
Rope Tension Load Weigher 4-30
Rotational coupling ratio parameter 9-90
Rough Acceleration or Deceleration 4-15
Run Sequence 10-35
Run testing, preparing for final adjustments 3-30
Run, iBox status LED 7-11
RX-, Cartop Link input 6-104, 11-8
RX+, Cartop Link input 6-104, 11-8
S
Sabbath Operation Activated message 6-61
Sabbath Operation Deactivated message 6-61
Sabbath Operation Indicator output 9-121
Sabbath Operation mode 9-7
Sabbath Operation parameters 9-82
Sabbath Operation Switch input 9-110
Sabbath Operation, SABBATH OPERATION message 6-61
Sabbath Override Input 9-110
SAFC, Safety Cartop input 11-12
SAFC, Safety Cartop input 11-12
Safe Edge Bypass Timer 9-30
Safety 3-25
Safety A Contract Overspeed Fault message 6-61
Safety A IMP Configuration Mismatch message 6-61
Safety A Inspection Leveling Overspeed Fault message 6-62
Safety A Inspection Overspeed Fault message 6-62
Safety A SIB Device Fault message 6-62
Safety A SIB Device Fault Off message 6-62
Safety A UETS Level 2 Speed Fault message 6-62
Safety A Unintended Motion Fault message 6-62, 6-64
Safety A, iBox status LED 7-11
Safety B Contract Overspeed Fault message 6-62
Safety B DETS Level 2 Speed Fault message 6-63
Safety B Fault Activated message 6-63
Safety B Fault Bypass Switch Timed Out message 6-63
Safety B Fault Deactivated message 6-63
SAFETY B FAULT message 6-63
Safety B Inspection Leveling Overspeed Fault message 6-63
Safety B Inspection Overspeed Fault 6-63
Safety B Safety Bypass Jumper Timed Out message 6-63
Safety B SIB Device Fault message 6-63
Safety B SIB Device Fault Off message 6-63
Safety B UETS Level 2 Speed Fault message 6-64
Safety B, iBox status LED 7-11
Safety Board Quick Reference 6-102
Safety Bypass Jumper 1-7, 6-3
Safety Bypass Jumper On message 6-64
Safety Bypass Jumper on the iBox 7-13
Safety Bypass Jumper Time Out message 6-64
Safety C String Open message 6-64
Safety C String Open Off message 6-64
Safety Clamp 3-17
Safety Configuration 9-150
  Contract overspeed 9-151
  Contract speed 9-151
  Inspection overspeed 9-151
  Learning 9-152
  Leveling overspeed 9-151
  Overspeed 1 margin 9-151
  Pulses per foot 9-151
Safety Configuration Checksum Fault message 6-64
Safety Configuration Inventory Cross Check Fault 6-65
Safety Configuration Learn Fault message 6-64
Safety Configuration Mismatch message 6-65
Safety Configuration, learning the 2-46
Safety Connections, iBox 11-12
Safety H String Open message 6-65
Safety H String Open Off message 6-65
Safety Inventory Checksum Fault message 6-65
Safety Inventory Comparison Fault message 6-65
Safety Inventory Creation Fault message 6-65
Safety Inventory Learn Fault message 6-66
Safety OK, iBox status LED 7-11
Safety parameters 9-91
Safety String 2-27
Safety String Bypass Jumper 1-7
Safety String Bypass Jumper, troubleshooting 6-3
Safety String Closed message 6-66
Safety String Open message 6-66
Safety system, description 1-3
Safety Tests 4-43–4-56, 9-155
  Car/Counterweight Buffer 4-46
  Car/Counterweight Safety 4-45
  Contract Overspeed 4-47
  Electrical Governor 4-46
  Emergency Brake - Unintended Motion for Machine Brake 4-49
  Emergency Brake - Unintended Motion for Rope Gripper 4-48
  Emergency Terminal Switch Overspeed 4-54
  Inspection Overspeed 4-47
  Leveling Overspeed Test 4-48
  Normal and Emergency Terminal Switch Position 4-54
  Normal Terminal Switch Overspeed 4-53
Safety, diagnostic flags 9-12
SAFH, Safety Hoistway input 11-12
Saving parameters to a configuration file 8-20
SC/ION board addresses 5-47, 6-111
SC/ION output selection 5-47, 6-99, 6-111
SC-HCDA-ISO Serial Hall Call Driver Isolation Board Quick Reference 6-108
SC-HCE-EM 5-36
SC-HCE-ME 5-36
SC-HCE-ME Serial Hall Call Ethernet - Digi ME Board Quick Reference 6-109
SC-HCN Serial Hall Call Node Board Quick Reference 6-110
SC-ION boards 5-11, 5-45, 6-111
SC-ION Serial Control I/O Board Quick Reference 6-111
SCOP BUSS 'n' COMM FAULT message 6-66
SCOP BUSS 'n' INVENTORY FLT message 6-66
SCR Current Sensor Offset Status test point, description 11-6
SCR Intg Offset Status test point, description 11-6
SEC FIRE SWITCH ON message 6-66
Second Level 5-4, 5-45
Secondary Fire Switch ON input 9-110
Secondary Fire Switch On message 6-66
Sector dispatching 10-25
Sector parking 10-21
Sector parking conditions 10-25
Secured, Security status 10-42, 10-45
Security
  Car call - Mode overrides 10-47
  Car Call restrictions 10-45
  Car Calls - Passcodes 10-48
  Car Calls - Per-passenger passcodes 10-49
description 10-38
  General - Configuration 10-39
  Hall Call restrictions 10-42
  Hall calls - Per-car lock out 10-44
  Hall calls, Per-floor security 10-42
manage passwords 10-40
Security Config inputs 9-113
Security Config outputs 9-124
Security configuration 10-38–10-50
Security Override inputs 10-58
Security Override serial inputs 10-58
Security settings 10-38
Seismic Switch output 9-121
Sending parameter settings to the controller 8-19
Sequential Step Scan Car Call inputs 9-112
Sequential step scan car calls option 9-100
Serial bus, wiring 5-32
Serial Control I/O Board Quick Reference 6-111
Serial COP 3-22, 5-48–??
  connections to iLink 3-15
description of 5-48
diagnostics 6-76
installing 5-50
specifications 5-50
Serial COP Bus 'n' Comm Fault message 6-66
Serial COP Bus 'n' Inventory Fault message 6-66
Serial Driver 5-11, 5-35
Serial Fixture Addresses 5-33
Serial fixtures 9-36
  Flash direction arrow while running 9-36
  programming 9-37
  Serial Messages 9-36
  Start Floor Arrival Announcement 9-36
Serial Fixtures Board Quick Reference 6-107
Serial hall call 5-11
Serial Hall Call Driver 5-30
Serial Hall Call Driver Isolation Board Quick Reference 6-108
Serial Hall Call Driver Testing 5-43
Serial Hall Call Ethernet - Digi ME Board Quick Reference 6-109
Serial Hall Call Node Board Quick Reference 6-110
Serial Hall Call option 5-30–5-34
Serial Hall Call System 3-22
  Bus Voltages 5-30
Serial I/O 10-51–10-61
  configuring I/O 10-53
  Input test 10-61
  Output test 10-61
  System tab 10-51
  Wrapback option 10-60
Serial number, viewing on iBox 7-8
Serial to TCP/IP 5-11, 5-35
Serial-to-Ethernet converters 5-35
Serviceability, description 1-3
Set Time/Date 7-8
Setting PC IP Addresses 5-18
setting the active configuration 9-100
Setting the date and time in iView 8-38
Setup 9-142–9-154
  Brake 9-142
  Counterweight 9-143
  Drive 9-144
  Floor Heights 9-145
  Floor Heights - Floor Offsets tab 9-148
  Load Weigher 9-149
  Safety 9-150, 9-152
  Safety - Inventory 9-153
  Terminal Switches 9-154
SFTY CONFIG CHKSM FLT message 6-64
SFTY CONFIG LEARN FLT message 6-64
SFTY CONFIG MISMATCH message 6-65
SFTY INVTRY CHKSUM FLT message 6-65
SFTY INVTRY COMPARE FLT message 6-65
SFTY VCTR XCHK FLT message 6-65
Sheave Brake Drop Fault message 6-67
SHEAVE BRAKE DROP FLT message 6-67
Sheave Brake Enable output 9-124
Sheave Brake Monitor input 9-113
Sheave Brake Pick Fault message 6-67
SHEAVE BRAKE PICK FLT message 6-67
SHLD, Tach Signal input 6-103, 11-7
Shorts to ground 2-16, 5-7
Shuttle service 9-7
Shuttle Service Activated message 6-67
Shuttle Service Deactivated message 6-67
Shuttle service input 9-111
SHUTTLE SERVICE OFF message 6-67
SHUTTLE SERVICE ON message 6-67
Shuttle service output 9-121
Shuttle service override input 9-111
Shuttle service parameters 9-85
Simplex car parameter 9-96
Simplex car, description of 10-4
Simplex Dispatching 10-6
Single Channel QUAD Fault message 6-67
SNG CHANNEL QUAD FLT message 6-67
Softkeys, iBox controls 7-4
SOFTWARE RECALL ON message 6-67
Software Recall Switch Activated message 6-67
Software Test Points 11-3
SP 1, Spare input 1 6-106, 11-11
SP 1 D, Optional input 11-12
SP 2 D, Optional Brake Pick switch input 11-12
SP 2, Optional input 11-12
SP 3, Optional input 11-12
SP 4, Optional input 11-12
SPA COS FAULT message 6-61
SPA DETS L2 SPEED FLT message 6-61
SPA DETS Level 2 Speed Fault message 6-61
SPA IOS FAULT message 6-62
SPA LOS FAULT message 6-62
SPA Spare Event ‘n’ (n = 1 to 8) message 6-67
SPA UETS L2 SPD FLT message 6-62
SPA UNTD MOTION FLT 6-62
Spare Connections, iBox 11-12
SPB COS FLT message 6-62
SPB DETS L2 SPEED FLT message 6-63
SPB IOS FAULT message 6-63
SPB LOS FAULT message 6-63
SPB Spare Event ‘n’ (n = 1 to 8) message 6-67
SPB UETS L2 SPD FLT message 6-64
SPB UNTD MOTION FLT 6-64
Specifications 11-2
Specifications, iControl AC specifications 11-2
Speed Bit test point, description 11-6
Speed Feedback test point, description 11-6
Speed Feedback, verifying 2-57
Speed partial pick delay 9-26
Speed pick delay 4-7, 4-19, 9-26
adjusting 3-31
speed profiles, adjusting 4-12
Speed Reference
Following error 9-91
Speed reference frequency parameter 9-92
Speed Reference parameters 9-90, 9-91
Speed reference resolution parameter 9-90
Speed reference rotational direction parameter 9-90
Speed reference scaling parameter 9-90
Speed reference type parameter 9-90
Speed Reference, setting 2-57
speed variance, up vs. down 2-55
Split Bank 10-29
Activation 10-29
Deactivation 10-29
Hall call eligibility 10-30
Hall Risers 10-30
Riser connections 10-58
Standard profile 4-13, 9-130
Status display, iBox LEDs 7-11
Status messages on the iBox LCD display 7-12
Stuck Car Panel Inspection Input message 6-68
Stuck Cartop Inspection Input message 6-68
STUCK CP INS. INPUT message 6-68
STUCK CT INS. INPUT message 6-68
STUCK IN. INPUT FLT message 6-68
Stuck Inspection Input Fault message 6-68
Sub-address jumper 5-34
Subnet Mask 2-34, 7-9, 8-4
Sufficient Field Status test point, description 11-6
Support availability 1-3
Swing Automatic Operation input 9-111
Swing car, description of 10-4
Swing Dispatching 10-6
Swing operation
Enable 9-40
parameters 9-40
Swing Operation Activated message 6-68
Swing Operation Deactivated message 6-68
Swing Operation Indicator output 9-121
Swing Operation message 9-68
Swing Operation Switch input 9-111
Switching between PCs 5-2
Switching the monitor 5-2
Symbols 2-8
Synthetic Signal test point, description 11-6
Sys Comm, iBox status LED 7-11
System 12 SCR Drive
auto offset calibration 2-48
initial settings 2-48
System Configurations (Simplex) inputs 9-113
System Configurations (Simplex) outputs 9-124
System Control Switches 1-7
System control switches on the iBox 7-12
System Event Log 10-68
open saved file 10-68
save to file 10-68
System Event log, view details 10-68
System I/O
Input inventory 10-61
Output inventory 10-61
System I/O configuration 10-51
System I/O Troubleshooting 5-36
System monitoring 1-1
System Options 5-1–??
MCE Load Weigher 5-61–5-67
Serial COP 5-48–??
Serial Hall Calls 5-30–5-34
System Performance 10-74
System Status Display 1-7
System status, Fault bypass 9-18
SYSTEM SYNC message 6-67, 6-68
System TCP/IP 5-11
System User Outputs 9-126
System View 9-1
System view 10-2
Tach Error Fault message 6-68
Tach Error Lower Limit test point, description 11-6
Tach Error tripping threshold adjustment 4-41
Tach Error Upper Limit test point, description 11-6
Tach Failure, TACH FAILURE message 6-68
Tachometer iBoxConnections 6-103, 11-7
Tachometer Signal test point, description 11-6
TB, Brake Triac active indicator 11-12
TC, Tach Signal input 6-103, 11-7
TCP/IP 5-11, 5-14, 5-35
TCP/IP Addresses 2-5, 2-30, 2-34, 5-15, 5-18, 8-4
setting in iView 9-127
setting on the iBox 7-9
TCP/IP cables 5-12
Temporary Cartop Wiring 2-29
Temporary CTS Relay Bypass 2-28
TERMINAL LEARN ON message 6-69
Terminal Learn procedure 9-154
Terminal switches configuration 9-136
Terminal switches status 9-19
TERMINAL SYNC FAULT message 6-69
Terminal synchronization 4-3, 9-132
Terminal Synchronization Fault message 6-69
Terminals, input and output wiring 2-13
Test mode 9-7
Test Mode message or Test message 6-69
Test Mode output 9-121
Test point signal descriptions 11-3–11-6
Test switch, iBox control 7-12
THIS CAR ALT FIRE message 6-69
This Car Alternate Fire Sensor Recall message 6-69
This Car Alternate input 9-111
THIS CAR MAIN FIRE message 6-69
This Car Main Fire Sensor Recall message 6-69
This Car Main input 9-111
Time, setting 8-38
Timer tables
configuration 10-62
configuring 9-137
examples 9-139, 10-64
programming 9-137, 10-62
TM, Motor Triac active indicator 11-12
Toggle Output 9-126
TORQMAX Drive 1-10, 3-31
adjusting for motor current limiting 4-14
Auto-tuning for induction motors 2-56
fine tuning 4-11
Synchronizing PM gearless machines 2-25, 2-45
verifying car direction 2-54
TORQMAX Drive Parameters Quick Reference 11-27
TORQMAX Drive, verifying parameters 2-47
Traveling cable 2-9
Troubleshooting
Circuit boards 6-75–6-112
ICE-COP board diagnostics 6-76
ICE-CTP Cartop Processor Board Quick Reference 6-78
ICE-EB Emergency Brake Board Quick Reference 6-84
ICE-FML Field Module Logic Board Quick Ref 6-85
ICE-IEQ Earthquake Board Quick Reference 6-88
ICE-IMP Main Processor Board Quick Reference 6-90
ICE-IRB Relay Board Quick Reference 6-92
ICE-IRD Rear Door Board Quick Reference 6-95
ICE-MIAC Multiple Input AC Board Quick Ref 6-97
ICE-MIAC-24V Multiple Input Board Quick Ref 6-97
ICE-MOR Multiple Output Relay Board Quick Reference 6-99
ICE-RG Rope Gripper Board Quick Reference 6-101
ICE-SAF Safety Board Quick Reference 6-102
ICE-SF Serial Fixtures Board Quick Reference 6-107
iControl messages 6-13–6-71
removing & replacing circuit boards 6-72
replacing the iBox 6-73
SC-HCDA-ISO Serial Hall Call Driver Isolation Board Quick Reference 6-108
SC-HCE-ME Serial Hall Call Ethernet - Digi ME Board Quick Reference 6-109
SC-HCN Serial Hall Call Node Board Quick Reference 6-110
SC-ION Serial Control I/O Board Quick Reference 6-111
Serial Hall Call (and I/O) 5-36
Tools 6-2
Using the Data trap 9-11
using the Safety String Bypass Jumper 6-3
TS, Tach Signal input 6-103, 11-7
TX-, Cartop Link input 6-104, 11-8
TX+, Cartop Link input 6-104, 11-8
UETS, Up Emergency Terminal Limit switch 6-105, 11-9
ULM, Up Leveling Marker Sensor input 6-104, 11-8
Unintended Motion Fault message 6-69
UNINTENDED MOTION FLT message 6-69
Unsecured, Security status 10-42, 10-45
UNT1, Up Slowdown Limit switch #1 input 6-105, 11-9
UNT2, Up Slowdown Limit switch #2 input 6-105, 11-9
UNT3, Up Slowdown Limit switch #3 input 6-105, 11-9
UNT4, Up Slowdown Limit switch #4 input 6-105, 11-9
UNT5, Up Slowdown Limit switch #5 input 6-105, 11-9
UNTD, Up Normal Limit Direction switch input 6-105, 11-9
UP DIR LIMIT OPEN message 6-69
Up Direction Limit Open message 6-69
Up Emergency Terminal Switch Position Fault message 6-70
Up Emergency Terminal Switch Shutdown message 6-70
UP ETS POSITION FAULT message 6-70
UP ETS SHUTDOWN message 6-70
Up Level 3-2
Up Levelling Marker (ULM) 3-12
Up Normal Terminal Switch ‘n’ Level 1 Speed Fault 6-70
Up Normal Terminal Switch ‘n’ Level 2 Speed Fault 6-71
Up Normal Terminal Switch ‘n’ Position Fault message 6-71
Up NT$n L1 SPEED FLT message 6-70
Up NT$n L2 SPEED FLT message 6-71
Up NT$n POSITION FLT message 6-71
Up switch, iBox control 7-12
Up, iBox status LED 7-11
up/down speed difference, adjusting for 4-11
Upgrade Options 8-43
User code accessing an invalid logical indicator (internal event) message 6-71
USER DEF EVENT FAULT message 6-71
User Defined Event 'n' Off message 6-71
User Defined Event 'n' On message 6-71
User Defined Event Fault message 6-71
User Defined Events 10-59
User defined parking 10-21, 10-23, 10-26
User Events 10-65
User-Defined Events inputs 9-116

V
VE-, Velocity Encoder input 6-103, 11-7
VE+, Velocity Encoder input 6-103, 11-7
Vector Checksum Fault 6-71
Vector Comparison Fault 6-71
Vector Creation Fault 6-71
Vector Learn Fault 6-71
Velocity Encoder
  Connections 2-25, 6-103, 11-7
  connections 2-25
  encoder cables 2-26
  installation 2-24
  isolation 2-25
  mounting 2-24
  wiring 2-25
verify releveling 4-6
verifying brake current resistance 2-22
Verifying Correction and Stop 4-3
verifying initial parameter settings 2-43
Verifying Main Line Power 2-18
verifying Motor Overload Protection 2-60
verifying Speed feedback 2-57
Version Info, viewing on iBox 7-8
View and set parameters on the iBox 7-5
View Event Log Details 9-15
View factory data on iBox 7-8
View menu
  contents 8-26
View/register calls using iBox 7-8
Virtual Oscilloscope 1-14
  See also Oscilloscope
Voltage decay time 9-26
Voltage decay time, adjusting for final stop 4-26, 4-28

W
Waiting for learn request 9-147
Waiting for proper start location 9-147
Watchdog 5-27
Watchdog Ordered Control Stop Before Reset message 6-71
Watchdog Ordered Emergency Stop Before Reset 6-71
Weakening delay parameter 4-20, 9-26
Weakening voltage 2-51, 9-25
Windows XP 5-21
wiring
  AC power 2-17
  inputs and outputs 2-12
  the serial hall call fixtures 5-32
  typical connection locations 2-11
  Velocity Encoder 2-25
Wiring the Brake 2-23
Wiring the Hoist Motor 2-21
Working offline, editing a configuration file 8-23
Wrapback, Serial I/O option 10-60
Write Enable switch, iBox control 7-12
Write permission 5-26
Write permission approval 5-26
Write privilege
  Acquire 1-13
  acquiring 2-30, 2-43
  OK 1-13, 2-30, 2-43
Write privilege timeout 5-26

Z
Z-, Velocity Encoder input 6-103, 11-7
Z+, Velocity Encoder input 6-103, 11-7